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Welcome to the User Guide 

This user’s guide covers the following releases: 

 Microsoft Dynamics CRM Online 2016 Update 

 Microsoft Dynamics CRM 2016 (on-premises) 

What’s new 

We’re excited to tell you about the many new features available in Microsoft Dynamics CRM 

Online 2016 Update and Microsoft Dynamics CRM 2016 (on-premises). 

Get started 

Get around 

Get around in Microsoft Dynamics CRM, CRM for Outlook, and mobile devices 

Quick create--Enter new contacts (or other data)--fast! 

Get back to (or pin) the records, views, or dashboards you used most recently 

Stay up-to-date with customer news with the activity feed 

Display your picture on the activity feed 

See account relationships in a hierarchical view 

Print leads, quotes, and other records 

Set personal options 

Search 

Accessibility 

Accessibility for people with disabilities 

Move around CRM by using keyboard shortcuts 

Get around 

 

Get around in Microsoft Dynamics CRM, CRM for Outlook, and mobile devices 

Quick create--Enter new contacts (or other data)--fast! 

Get back to (or pin) the records, views, or dashboards you used most recently 

Stay up-to-date with customer news with the activity feed 

Display your picture on the activity feed 

See account relationships in a hierarchical view 
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Print leads, quotes, and other records 

Set personal options 

Search 

Get around in Microsoft Dynamics CRM, CRM for Outlook, and mobile 
devices 

Pick the app you’re using.  

 

 

 

horizontaltabbed 

Latest version 

 

Main navigation 

Want to take a  quick video tour of the new navigation? 

If your screen looks like this, you’re on the latest version of CRM Online.  

 
 

Quick access items 

These items are always on the nav bar: Recently used, quick create, record search, advanced 

find, and personal options. 

 
 

Form navigation 

If you’re working in a complex form with lots of fields, the form navigation drop-down menu makes 

it easy to get to just the data you need.  

http://go.microsoft.com/fwlink/p/?LinkId=528558
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The preceding illustration shows how to navigate in the latest version of CRM Online: choose the 

Main menu, choose a work area, and then choose an item. 

Older versions 

 

 

Want to take a  quick video tour of the navigation?   

If your screen looks like this, you’re on an earlier version of CRM Online or on-premises CRM 

2013 (or later).  

 

The preceding illustration shows how to navigate in older versions of CRM: choose Microsoft 

Dynamics CRM, choose a work area, and then choose an item. 

Outlook 

 

 

If your screen looks like this, you’re on Dynamics CRM for Outlook.  

 

The preceding illustration shows how to navigate in Dynamics CRM for Outlook: choose a work 

area, choose a folder, and then choose an item. 

Mobile  

 

 

What to take a quick video tour of the navigation? 

If your screen looks like this, you’re on CRM for phones or CRM for tablets.  

 

The preceding illustration shows how to navigate in CRM for phones and CRM for tablets: choose 

the menu to select different items or choose Home to go back to your Home screen. 

http://go.microsoft.com/fwlink/p/?LinkID=317092
http://go.microsoft.com/fwlink/p/?LinkId=544915
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Quick create--Enter new contacts (or other data)--fast! 

The Quick Create command makes it fast and easy to enter almost any type of information into 

the system. The command is on the nav bar, so it’s always available whenever you need to enter 

new info into the system.  

With Quick Create, you need to complete only a few fields. Later, when you have more time or 

more information, you can fill in more details. 

You can quickly create: 

 Contacts 

 Accounts 

 Leads 

 Opportunities 

 Campaign responses 

 Competitors 

 Activities: tasks, phone calls, email, or appointments 

In Microsoft Dynamics CRM 2015 and Microsoft Dynamics CRM Online 2015 Update or later, 

when you add a new sales opportunity to the system by using the Create command on the nav 

bar, you can now create a contact at the same time. In previous versions, you had to create the 

contact before using the Quick Create command to add an opportunity. 

1. On the nav bar, click the plus sign , and then click the item you want. 

2. Fill in the fields, and then click Save. 

3. If you would like to continue adding information, click View Record. To create another 

one, click Create Another. 

 next to the field on the screen means the field is required. 

 next to the field on the screen means your organization recommends that you fill in the field. 

See Also 

Create or edit an account 

Create or edit a contact 

Nurture sales from lead to order 

Keep track of notes, tasks, calls, or email with activities 

Get back to (or pin) the records, views, or dashboards you used most 
recently 

You probably work with the same records all the time. For example, you may access the same 

contact or account on a regular basis. Or you may work with the same lists (views) of data over 

and over. You can quickly get back to recently used records or views from the global navigation 

 

Note  
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bar. You can also pin records and views to make them easier to find. You can even access and 

pin recently used dashboards.  

This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-

premises).  

 

 Interested in getting this feature? Find your CRM administrator or support person This 

feature is not available for Dynamics CRM for Outlook. 

 

1. On the global nav bar, click the Recently Viewed Items button . 

2. Do one of the following: 

 Under Recent Records, choose the record or dashboard you want to go back to. To pin the 

dashboard or record to the top of the Recent Records list, point at the record or dashboard, 

and then click the Pin button . 

 Under Recent Views, choose the view you want to go back to. To pin the view to the top of 

the Recent Views list, point at the view, and then click the Pin button . 

 
 

Pinned items are sorted by when you pin them. Unpinned items are sorted by when you 

access them. 

See Also 

Create or edit an account 

Create or edit a contact 

Stay up-to-date with customer news with the activity feed 

Monitor real-time updates in the activity feed to stay current with fast-moving sales, customer 

projects, and marketing campaigns at your organization. 

Note  

Get back to recently used items 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=513070
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You’ll find the activity feed on your dashboard under the heading What’s new. 

The activity feed includes automatic updates about the work your colleagues are doing. You can 

also choose to “follow” updates for up to 1,000 of the contacts, colleagues, and customer records 

you care most about.  

Like or unlike a post in the activity feed 

1. Under What’s new, point to the post. 

2. Click Like or Unlike. 

Below a post, you’ll see the number of people who have liked it, and the names of people who 

liked the post most recently. Click the counter to see more names. 

Comment on someone’s post in the activity feed 

1. Under What’s new, point to the post. 

2. Click Reply. 

Type your comment. You can use up to 250 characters. 

Follow or unfollow a contact, account, lead, or other customer info 

In addition to seeing any automatic posts in the activity feed, you can follow customers and other 

types of records – to see real-time updates to the Microsoft Dynamics CRM customer information 

you care most about. 

1. Open the contact, account, lead, or other type of record you want to follow. 

2. Click the More Command ( ). 

3. Click Follow or Unfollow. 

Follow or unfollow a colleague 

1. On your dashboard, click Advanced Find. 

2. In the Look for drop-down list, click Users. 

3. In the Show group, click Results. 

4. Click the person’s name. 

5. Click the More Command ( ). 

6. Click Follow or Unfollow. 
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Control which types of posts you see in the activity feed 

At the top of the activity feed, you'll see commands that let you control whether you see posts 

about everything you follow or a smaller subset. 

 Under What’s new, select one of the following:  

 All records, and then select the type of records 

 Both to see automatic posts and posts for the additional things you’re following 

 Auto posts to see only automatic posts 

 User posts to see only the things you’ve chosen to follow 

Change the order that record types are listed in your activity feed 

You can change the order that record types display in your activity feed so that the ones you care 

most about are listed at the top. 

1. Under What’s new, click All records. 

2. Click Modify this list (  ). 

3. In the Filters My Filters dialog box, select the record types you want to change.  

4. Click Move Up or Move Down to change the order the record types are displayed. 

5. Close the dialog box. 

Use keyboard shortcuts in activity feeds 

 
 

To do this Press this 

Submit a post Alt + P 

Post a status update Alt + S 

Follow or unfollow Alt + L 

Delete a selected post or comment Alt + L 

Cancel a deletion Alt + C 

 

See Also 

Display your picture on the activity feed 
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Display your picture on the activity feed 

You can add a picture to your profile if you want other people to see your picture along with your 

posts in the activity feed.  

1. In the activity feed, next to What's New, choose Edit next to the gray image. 

2. Choose Upload a picture from your computer. 

3. Browse to the image file, select it, and then choose Open. 

4. Choose OK. 

See Also 

Administer the activity feed 

Stay up-to-date with customer news with the activity feed 

See account relationships in a hierarchical view 

You can see how info is related or grouped by viewing accounts, products, or users in 

hierarchical charts. You can click a tile in the chart to get the full details and then navigate to the 

info you’re interested in.    

For example, from the hierarchical charts view for accounts, you can:  

 See how an account is doing in overall revenue 

 Drill into tiles for accounts to see where the deals are coming from and how revenue is 

distributed across sub-accounts 

 Find out who is working an account and enlist help from others by sending email or sharing 

the account with other salespeople right from within the chart view 

 View important details about each account, such as credit limit and latest activity posts for the 

account 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

From the hierarchical charts view for products, you can see all the products available to sell, and 

how they're related in bundles or families. Salespeople can avoid missing a potential sale, 

because they can see all related products in one view. 

From the hierarchical charts view for users, you can find out who another team member's boss 

is, or who else is on their team without switching to another app. 

Hierarchical views are also available on mobile. 

To see hierarchies that show the relationships between records, on the list of accounts, products, 

or users, choose the Hierarchies button. You can also choose the View Hierarchy command 

when you’re viewing the screen for an individual account, product, or user. 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=513070
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See Also 

Create or edit an account 

Print leads, quotes, and other records 

When you need a paper copy of a record such as a contact, lead, quote, or invoice, you can print 

records individually or in a list. 

Print an individual record 

1. Go to the record you want to print. For example, to print a lead, go to Sales > Leads and 

select a record. 

2. Choose the Options  button  at the top right corner of the screen. 

(In Dynamics CRM for Outlook, choose File > Print.) 

3. Choose Print preview. 

4. Choose Print…. 

5. Select the print options you want and then choose Print. 

Print a list of records 

1. Go to the list you want to print. For example, to print a list of invoices, go to Sales > Invoices. 

2. Choose the Options  button  at the top right corner of the screen. 

(In Dynamics CRM for Outlook, choose File > Print.) 

3. Choose Print preview. 

4. Choose Print… 

5. Select the print options you want and then choose Print. 

Privacy notice 

When Microsoft Dynamics CRM Online users print CRM data, they are effectively “exporting” that 

data from the security boundary provided by CRM Online to a less secure environment, in this 

case, to a piece of paper.  
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 An administrator has full control (at the user security role or entity level) over the data that can be 

extracted. However, after the data has been extracted it is no longer protected by the security 

boundary provided by CRM Online and is instead controlled directly by the customer. 

 

See Also 

Run a report 

Work with mail merge templates 

Nurture sales from lead to order 

Set personal options 

Personalize your Microsoft Dynamics CRM workspace to suit your requirements or preferences. 

For example, you can choose the page that you want to see as soon as you sign in to CRM. You 

can also personalize many other options such as language, currency, and time zone.  

 If you’re using Microsoft Dynamics CRM for Outlook, you can set options that affect 

synchronization between CRM and Dynamics CRM for Outlook. More information: Set 

personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

 If you’re an administrator, you can set system settings that affect all users in the organization. 

For more information, search for “System Settings dialog box.” 

Set personal options 

1. Click the Settings button  in the upper-right corner of the screen. 

2. Click Options. 

3. Fill in the information, as required.  
 

Tab Options  Description 

General 

 

 

 Select your home page and 

settings for Get Started 

panes 

 

 Default Pane Select the default home pane 

(page) that you want to see 

when you sign in to CRM. For 

example, you can make Service 

your default pane if you work 
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mostly in that area.  

By default, the  Default based 

on user role option is selected, 

which shows the default pane 

based on your user role.   More 

information:  View your user 

profile 

You can only set panes and tabs 

that are available for your user 

role. 

 Default Tab Select the default tab that you 

want to see for the selected 

default pane. For example, 

select the Accounts tab for the 

Services pane. 

 Set the number of records 

shown per page in any list of 

records 

 

 Records Per Page  Select the maximum number of 

records you want to see in a list 

on a page. You can set a value 

from 50 to 250. 

 Select the default mode in 

Advanced Find 

 

 Advanced Find Mode By default, every time you open 

the Advanced Find Mode 

dialog box, the query details are 

hidden. To see the query details 

every time, select Detailed. 

More information:  Create, edit, 

or save an Advanced Find 

search 

 Set the time zone you are in  

 Time Zone  Select the time zone that you 

want to display for your region.    

Note  

If you use Dynamics 

CRM for Outlook, 

set the same time 
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zone in CRM to help 

prevent a mismatch 

in dates and times. 

 Select a default currency  

 Currency Choose the default currency 

value to use in financial 

transactions. Click the Lookup 

button to search for a currency. 

More information:  Manage 

transactions with multiple 

currencies 

 Support high contrast 

settings 

 

 Enable high contrast  Select this check box to enable 

high contrast levels in your CRM 

display.  

Tip  

Set this option if you 

are using high 

contrast settings in 

your browser or 

operating system. 

 Set the default country/region 

code 

 

 Enable country/region code 

prefixing   

Select this check box to enable 

the default calling code for your 

region.  

 Country/Region Code Prefix Enter the value of your region’s 

calling code in the text box. For 

example, enter +1 for the United 

States. 

 View your user information Select this link to view details 

about you. These details are 

displayed to your entire 

organization and include your 

contact information and security 

role. More information:  View 

your user profile 
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Synchronization 

 

 

 Synchronize Microsoft 

Dynamics CRM items with 

Outlook or Exchange 

 

 filters   Choose the records to 

synchronize between CRM  and 

Dynamics CRM for Outlook or 

Exchange (using server-side 

synchronization). More 

information:  Choose the records 

to synchronize between CRM 

and Outlook or Exchange  

 synchronized fields View the fields that are 

synchronized between CRM and 

Dynamics CRM for Outlook so 

you can see where the data is 

coming from. More information: 

 View the fields that are 

synchronized between 

CRM and Outlook 

 Create or modify 

synchronization filters or 

view synchronizing fields 

 

Note  

Only a system 

administrator can 

change the 

synchronizing fields. 

 Manage your offline filters 

and take your information 

offline in CRM for Outlook 

 

 offline filters Choose a subset of CRM data 

that you want to work with when 

you go offline with Dynamics 

CRM for Outlook. More 

information:  Choose records to 
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work with offline in CRM for 

Outlook 

Activities 

 

 

 Default view  

 Default Calendar Select the default view for your 

calendar:  Day, Week, or 

Month.  

 Set your default work hours  

 Start Time and End Time  Select the start and end time to 

indicate your availability for 

services or appointments. 

Formats 

 Current Formats  

 Format preview  Shows the current region and its 

formats for Number, Currency, 

Time, and Date. 

 Customize Choose this option to add a new 

region and formats.  

Email Templates 

 

 

 Create and modify personal 

email templates 

 

 New  Create an email template with 

custom values (such as a date 

or signature), so you don’t have 

to enter the same information, 

repeatedly, when you send an 

email.  

On the command bar, click New 

and enter values for the 

template. More information:  

Create templates for email 

Email 
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 Select if other users can send 

emails for you 

 

 Allow other Microsoft Dynamics 

CRM users to send email on 

your behalf.  

Note  

This option is not 

available in 

Microsoft Dynamics 

CRM (on-

premises). 

Select this option to allow other 

users of CRM to send email on 

your behalf. 

Caution  

If you select this 

option, other users 

can send email on 

your behalf with or 

without your 

consent. Your email 

name will appear as 

the sender.  

 Select the email messages to 

track in Microsoft Dynamics 

CRM 

 

 Track Select the email messages that 

you want to  automatically track 

in CRM.  

Options: 

 All Email messages 

 Email messages in 

response to CRM email 

 Email messages from 

CRM Leads, Contacts 

and Accounts 

 Email messages from 

CRM records that are 

email enabled 

More information:  Set an option 

to automatically track incoming 

Outlook email in CRM for 

Outlook 

 Configure Folder Tracking 

Rules 

Set up folders to automatically 

track incoming email. More 

information:  Track Outlook 
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email by moving it to a tracked 

Exchange folder 

 Automatically create records 

in Microsoft Dynamics CRM 

 

 Create Select this option to allow CRM 

to create leads or contacts 

automatically from the 

information in tracked email 

messages.   

 View your Mailbox Click this link to see your 

mailbox details.  

Privacy 

Note  

This tab is available only in Microsoft Dynamics CRM Online. This tab isn’t 

available if your system administrator has selected the privacy preference 

for the entire organization in System Settings. Talk to your administrator. 

More information: Find your CRM administrator or support person 

 

 

 Select your error notification 

preference 

 

 Options: 

 Ask me for permission 

to send an error report 

to Microsoft. 

 Automatically send 

report to Microsoft 

without asking me for 

permission. 

 Never send an error 

report to Microsoft 

about Microsoft 

Dynamics CRM. 

Specify what you want CRM to 

do when an error occurs. Based 

on your selection, the error 

reports are shared with and used 

by Microsoft for product 

improvements. More information:  

Set privacy preferences for an 

organization 

We recommend that you send 

the error reports to Microsoft so 

that Microsoft can use the 

information for product 

improvements. 

Languages 

 

 Select the language you 

prefer to see Microsoft 
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Dynamics CRM displayed in 

 Base Language Shows the base language. The 

base language is set during the 

CRM installation process. You 

can’t edit this option.  

 User Interface Language Select the language that you 

want to see for labels and dialog 

boxes in the CRM user interface. 

 Help Language Select the language for Help. To 

add an additional language other 

than the base language, your 

admin must install the required 

language packs and enable 

them.  Talk to your administrator. 

More information:  Find your 

CRM administrator or support 

person 

 

4. When you’re done, click OK. 

See Also 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Synchronizing data with Outlook or Exchange FAQ 

View your user profile 

 

Your user profile displays useful information about you to your entire organization; for example, 

your contact information, your organization, and your security role. Depending on your security 

role, you may be able to make changes to your user profile. 

1. Go to Options. 

 In the web app: In the upper-right corner of the screen, choose the Settings button  > 

Options. 

 In CRM for Outlook: Choose File > CRM > Options. 

2. Scroll down to the very bottom of the Set Personal Options dialog box, and then choose 

View your user information.  

3. To check your security role, on the nav bar, choose the down arrow  next to your name, 
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and then choose Security Roles. 

4. To view other profile information, such as Work Hours, Connections, and Services, on the 

nav bar, choose the down arrow  next to your name. 

 

Search 

 

Create, edit, or save an Advanced Find search 

How inline lookup works 

Search for records 

Create, edit, or save an Advanced Find search 

Find the records you want in Microsoft Dynamics CRM by using the Advanced Find command. 

You can also use Advanced Find to prepare data for export to Microsoft Office Excel so that you 

analyze, summarize, or aggregate data, or create PivotTables to view your data from different 

perspectives.     

 

 

1. Go to Advanced Find. (How do I get there?) 

2.  

Specify what to search for. 

 

a. In the Look for list, select a record type. 

b. Click Select to define search criteria: field (for example, Account Name or 

City), the query relational operator (Part of an expression (for example "is 

equal to" or "contains") that defines how a specified attribute should be 

compared with a value.), and the values to locate (for example, "Seattle" or 

"Email"). 

You can select fields from the current record type, or from related records. 

For example, an account might have many related contact records.  

At the bottom of the Select list, the Related section shows related record 

types. For example, most record types have a related Notes record type. To 

select fields from a related record type, select field, and a new Select link 

appears. 

 

3. Specify the columns to include in the search results. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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a. Click Edit Columns, and then click Add Columns. 

b. Select the record type that includes the columns you want to add. 

c. Select the columns you want to add, and then click OK.  

 

4. Specify the sort order. 

 

a. Click Edit Columns. 

b. Click Configure Sorting. 

c. Specify the column to sort on, specify the sort order, and then click OK. 

d. Click OK. 

 

5. Click Results. 

See Also 

Search for records 

How inline lookup works 

Quickly find the record you are looking for by using the inline lookup in Microsoft Dynamics CRM. 

By default, when you click or tap the Lookup button, you see the first 10 results for the specific 

record type.  

You can use the inline lookup fields to search for records by using keywords. As you type, the 

inline lookup shows you the most recently used (recently searched, updated, or created) records 

in the list. The lookup resolves automatically if you enter partial text and tab out of the lookup 

field, and if a single matching record is found. If multiple matching records are found, you’ll see a 

list of matching results you can select a record from.  

The recently used records are shown only in the classic forms. 

When you press Enter or click or tap the Lookup button, the search results that match your 

keyword are shown. Microsoft Dynamics CRM looks for matching records by searching for the 

keyword in columns defined in the quick find view of the entity or in the view that’s set as the 

default view of the entity. Lookup search results show the first three columns that are defined in 

the lookup view of the entity or the view that’s set as the default view of that lookup, including the 

primary field of that entity. More information: TechNet: Create and edit views 

If a lookup field, such as Find Customer, points to two or more record types, the inline lookup 

results will include the results for accounts and contacts because a customer can be an account 

or a contact. You can click or tap Look Up More Records to open the standard Look Up 

Records dialog box to search for more records. 

Note  

https://technet.microsoft.com/library/dn509578.aspx
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If you don’t find a record, you can create a new record by clicking or tapping New in the inline 

lookup area. This lets you quickly create a new record. 

The lookup fields on the classic forms don’t have the option to create a new record. 

See Also 

TechNet: Create and edit views 

Search for records 

To find your records quickly in Microsoft Dynamics CRM, you can search across multiple record 

types all at the same time.  

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

There are two ways to search.  

Normal quick find: 

Begins with - results include records that begin with a specific word. For example, if you want to 

search for “Alpine Ski House”, type alp in the search box; if you type ski, the record won’t 

show up. 

Wildcard - for example: *ski or *ski*   

Full text quick find: 

 Search within - results include records that contain a field with all of the words in the search 

term.  The individual words can appear anywhere in the string and in any order.  For 

example, if you search for “Alpine Ski House”, you could find results for “I left the house today 

to go skiing in the Alpine Meadows.” since all of the search words appear somewhere in the 

string. 

 Wildcards are not required. 

For more information see, TechNet: Configure Quick Find options for the organization. 

Start a search 

1. From the top nav bar, type one or more characters in the search box. 

2. Choose the Search button next to the search box. 

Filter search results 

 To filter results by one record type, on the search screen, choose a record type from the 

Filter with: drop-down box. 

 To search against all record types, choose None in the Filter with: drop-down box 

Note  

Important  

 

 

https://technet.microsoft.com/library/dn509578.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/dn919650.aspx
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See Also 

Create, edit, or save an Advanced Find search 

Edit the quick find view 

Accessibility 

 

Accessibility for people with disabilities 

Move around CRM by using keyboard shortcuts 

Accessibility for people with disabilities 

Microsoft is committed to making its products and services easier for everyone.  More 

information:  Microsoft Accessibility 

Keyboard shortcuts in Microsoft Dynamics CRM 

Microsoft Dynamics CRM offers keyboard shortcuts to address issues faced by people with 

limited dexterity or motion disabilities. Also, people who don’t use a mouse can use a keyboard to 

navigate and complete actions. 

More information: Move around CRM by using keyboard shortcuts 

Accessibility info for browsers 

For accessibility information about your browser, visit the following websites: 

 Internet Explorer 9 accessibility 

 Internet Explorer 10 accessibility 

 Firefox accessibility features 

 Safari accessibility features 

 Google Chrome accessibility technical documentation 

Heighten color contrast of some text and images 

The high contrast setting in Microsoft Windows heightens the color contrast of some text and 

images on your computer screen, making those items more distinct and easier to identify. You’ll 

find this setting on the Ease of Access page in Windows 8 and Windows 7. 

If you’re using the high contrast setting in Microsoft Windows, you should also select Enable high 

contrast in your Microsoft Dynamics CRM personal options. On your dashboard, click or tap  > 

Options. Click or tap the General tab, click or tap Enable high contrast, and then click or tap 

OK. 

Accessibility for users of Microsoft Dynamics CRM Deployment Manager (on-premises) 

Administrators who manage the day-to-day operation of on-premises deployments of Microsoft 

Dynamics CRM using Microsoft Dynamics CRM Deployment Manager, a Microsoft Management 

Console (MMC) application, can find accessibility info in these topics: 

http://www.microsoft.com/enable/default.aspx
http://www.microsoft.com/enable/products/ie9/default.aspx
http://www.microsoft.com/enable/products/ie10/default.aspx
http://support.mozilla.org/kb/accessibility-features-firefox-make-firefox-and-we?redirectlocale=en-US&redirectslug=Accessibility
http://www.apple.com/accessibility/
https://sites.google.com/a/chromium.org/dev/developers/design-documents/accessibility
http://www.microsoft.com/enable/products/windows8/default.aspx
http://www.microsoft.com/enable/products/windows7/default.aspx
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 Navigation in MMC Using the Keyboard and Mouse 

 MMC Keyboard Shortcuts 

See Also 

Microsoft Accessibility 

Move around CRM by using keyboard shortcuts 

Keyboard shortcuts give you an alternate way to do common tasks, instead of using your mouse 

or tapping with your finger. And because many keyboard shortcuts are the same across all 

Microsoft products, some of these might already be familiar to you. 

The shortcut keys described in this section refer to the U.S. keyboard layout. Depending 

on your country/region and layout, you may not have the same keys.  

Form keyboard shortcuts 

The following keyboard shortcuts are included in Microsoft Dynamics CRM.  
 

To Press 

Move to the next option, option group, or field Tab 

Move to the previous option, option group, or 

field 

Shift+Tab 

Complete the command for the active option or 

button 

Enter 

Move between options in an open list, or 

between options in a group of options 

Arrow keys 

Cancel a command, or close a selected list or 

dialog box 

Esc 

Save Ctrl+S or Shift+F12 

Save and Close Alt+S 

Cancel edits and close (Close) Esc 

Open search  Spacebar 

Delete the record (when forms are in Edit 

mode) 

Ctrl+D  

Save and then open a new form (Save and 

New) (when forms are in Edit mode) 

Ctrl+Shift+S 

Open the lookup menu with the most recently Alt+Down Arrow 

Note  

https://technet.microsoft.com/library/cc766527.aspx
https://technet.microsoft.com/library/cc766476.aspx
http://www.microsoft.com/enable/default.aspx
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To Press 

used items in alphabetical order 

Open lookup drop-down list Enter 

Close lookup drop-down list Esc 

Open a new instance of Microsoft Dynamics 

CRM 

Ctrl+K 

Open a record found in lookup with forms in 

Edit mode 

Enter 

Add a step in the business process editor Alt+Shift+N 

Tab to the Command Bar when in the updated 

user experience 

Ctrl+[ or Ctrl+] 

Tab to the Navigation bar  Ctrl+Shift+3 

Add an article to an email Shift+Alt+A 

Apply email template (when editing an email 

message) 

Shift+Alt+T 

 

Access submenus if you use a screen reader 

If you use a screen reader, this section shows you how to access any of the submenus that are 

displayed when you hover the mouse over a navigation link. 

1. Navigate between the menu options using standard link navigation. 

2. Activate the link by pressing Enter or the space key as you would usually do. A list of 

submenus will be displayed. 

3. To access these submenu options, use the accessibility technology (AT) shortcut key to 

navigate to the next button. For example, if you use the NVDA screen reader, you would 

use the “b” shortcut key (NVDA+b). To navigate through all the options, press the key 

repeatedly. 

Important  

There are several areas in the UI that have auto-collapse built in for menus. This 

includes the Navigation Bar and Form Navigation. Both are click to expand, but 

after 30 seconds of inactivity, the items collapse. 

Navigate through stages in a process using the keyboard 

If you’re in a record, a lead, for example, this section shows you the keyboard shortcuts to 

navigate through the different stages in the process to qualify the lead, and how to make 

 



 

 
37 

selections in those stages. For example, if you want to move easily from the Qualify stage 

through to the Close stage, try these keyboard actions: 

 After you select a stage, get to the fields by pressing the down arrow. 

 If a stage is collapsed, just press Enter to expand it. 

The process name is an icon at the bottom of the page, not the top. 

Accessibility keyboard shortcuts 

If you’re running Microsoft Windows, you can set system accessibility options to match the way 

you work. For example, you can use Windows Sticky Keys if you have difficulty holding down two 

or more keys at a time, such as Ctrl+P. Sticky Keys enable you to press the Ctrl key and have it 

remain active until you press the P. 
 

To Press 

Switch Sticky Keys on and off Shift five times 

Switch Filter Keys on and off Right Shift for eight seconds 

Switch Toggle Keys on and off Num Lock for five seconds 

Switch High Contrast on and off Left Alt+Left Shift+Print Screen 

Switch Mouse Keys on and off Left Alt+Left Shift+Num Lock 

Tab into an Active X control Alt+Shift+F10 

 

Mac keyboard shortcuts 

These keyboard shortcuts apply when using a Mac. 
 

Action Windows Keys Mac Keys Notes 

Tab Tab 

Shift+Tab 

Tab 

Shift+Tab 

Enable Tabbing in 

System Preferences and 

Safari Preferences (refer 

to Apple and Safari 

documentation). 

Access keys Alt+Access key Ctrl+Alt+Access key For example, the Next 

button uses N as its 

access key. 

Microsoft Dynamics 

CRM Shortcut keys 

Ctrl+key Ctrl+key For example, move to 

the first tab in the ribbon 

control with Ctrl+{. Save 

Note  
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Action Windows Keys Mac Keys Notes 

using Ctrl+S. 

Activate Control Space/Enter Space/Enter  

Close topmost 

window 

Window+W Command+W Refer to Apple support 

documentation. 

 

See Also 

Accessibility for people with disabilities 

Manage customer records 

 

Create accounts and contacts 

Communicate with customers 

Collaborate with your team 

Import and export data 

Use Bing Maps to view a location 

Use OneDrive for Business to manage your private documents 

Create accounts and contacts 

 

Create or edit an account 

Create or edit a contact 

Assign a record to a user or team 

Deactivate or activate an account or contact 

Create or edit a goal 

Create or edit a competitor record 

Create or edit an account 

If you work mostly with other companies, you’ll probably want to use accounts to keep track of 

them.  

You can also use accounts to keep track of any vendors you do business with.  
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Create an account 

1. Go to Sales > Accounts. (How do I get there?) 

 

2. Choose New. 

3. Fill in your information. Use the handy tooltips as a guide. 

4. Click Save. 

 

Edit an account 

1. Go to Sales > Accounts. (How do I get there?) 

 

2. Open the account and change the information that you want. 

3. Click Save. 

 

 

See Also 

Import accounts, leads, or other data 

Deactivate or activate an account or contact 

Quick create--Enter new contacts (or other data)--fast! 

Keep track of notes, tasks, calls, or email with activities 

Stay up-to-date with customer news with the activity feed 

Assign a record to a user or team 

Run a report 

Use Bing Maps to view a location 

Create or edit a contact 

Use contacts to keep track of the people you do business with. 

 

1. Go to Contacts. (How do I get there?) 

 

 

 

View a contact 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. You’ll see a list of your active contacts. You may need to scroll to see the whole list. 

Tip  

It’s easy to get back to the customer data you were working with most recently. On the nav 

bar, next to Contacts, choose . Choose a name, and then get right back to what you were 

doing. 

3. Click or tap a person’s name to see the details for the contact. 

 

 

1. Go to Contacts. (How do I get there?) 

 

2. Choose New. 

3. Fill in your information. Use the handy tooltips as a guide. 

4. Click Save. 

 

1. Go to Contacts. (How do I get there?) 

 

2. Open the contact and change the information that you want. 

3. Click Save. 

 

See Also 

Run a report 

Import contacts 

Use Bing Maps to view a location 

Assign a record to a user or team 

Deactivate or activate an account or contact 

Quick create--Enter new contacts (or other data)--fast! 

Keep track of notes, tasks, calls, or email with activities 

Stay up-to-date with customer news with the activity feed 

Create a contact 

Edit a contact 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Assign a record to a user or team 

If you would like another person in your organization to handle an account or contact for you, you 

can assign the record to that person. 

You can also assign a record to a team, or to yourself. 

 

1. Go to Accounts or Contacts. How do I get there? 

 

2. In the list of records, select the record that you want. 

In the command bar, click the More Commands button , and then click Assign. 

3. If using the CRM web application:    

 In the command bar, click More Commands ( ), and then click Assign. 

 

 

If using CRM for Outlook: 

 In the Collaborate group, click Assign. 

4. In the Assign dialog box, click: 

 Assign to me 

 

- OR - 

 

 Assign to another user or team 

 

Click Lookup, and then click Look Up More Records. From the Look for drop-down 

list, select User or Team. In the Search box, type the name, click the search icon, 

and then click the name to select it. Click Add. 

 

5. Choose OK. 

 

Deactivate or activate an account or contact 

In Microsoft Dynamics CRM, you deactivate an account or contact rather than deleting it. This 

ensures the integrity of the audit trail associated with that record. 

A deactivated account or contact becomes inactive, which means that it cannot be edited or used 

in establishing new relationships with other records. However, all relationships created with the 

deactivated item are still available. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Deactivated accounts can subsequently be reactivated should the need arise. 

Deactivate an account or contact 

1. Go to Accounts or Contacts. How do I get there? 

 

2. Select the active account or contact that you want to deactivate, click or tap Deactivate, 

and then confirm the deactivation. 

Activate an account or contact 

1. Go to Accounts or Contacts. How do I get there? 

 

2. To view a deactivated account or contact, in the System Views list, select Inactive 

Accounts or Inactive Contacts. 

3. Select the inactive accounts or contacts you want to activate, click or tap Activate, and 

then confirm the activation. 

See Also 

Import contacts 

Create or edit a contact 

Create or edit an account 

Import accounts, leads, or other data 

Create or edit a goal 

Use goals to keep track of your progress on achieving target revenue. 

Create a goal    

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile.  

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. Go to Goals. (How do I get there?) 

 

3. Do one of the following: 

 If you are using the CRM application, click New. 

 If you are using CRM for Outlook, in the Records tab, click New. 

4. On the New Goal form, enter information or observe any noted restrictions or 

requirements as needed. Use the handy tooltips as a guide. 

5. Click or tap Save or Save and Close. 

 

Edit a goal 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Goals. (How do I get there?) 

3. Do one of the following: 

 If you are using the CRM web application, click Edit. 

 If you are using CRM for Outlook, in the Records group, click Edit. 

4. Fill in your information. Use the handy tooltips as a guide. 

5. Click Save and Close. 

See Also 

Create or edit a rollup query 

Progress Against Goals report 

Create or edit a competitor record 

You already know that tracking your competitors and their strengths and weaknesses can help 

you win sales. Microsoft Dynamics CRM lets you store the details about competitors so that you 

and your colleagues can share and stay current with the latest details. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
44 

1. Choose Sales > Competitors. 

If using the CRM web application 

a. On the command bar, choose + New. 

 

If using CRM for Outlook 

a. In the Records group, choose New. 

 

2.  

Fill in your information. Use the handy tooltips as a guide. 

3. Choose Save. 

4. To associate a competitor with an opportunity, in the Opportunity area, choose . In the 

Search box, choose the Lookup icon, and then select an opportunity from the results.  

 

 

See Also 

Competitor Win Loss report 

Communicate with customers 

 

Keep track of notes, tasks, calls, or email with activities 

Place calls with Skype or Skype for Business 

OneNote in CRM FAQs 

Send bulk email to customers 

Keep track of notes, tasks, calls, or email with activities 

In Microsoft Dynamics CRM, you use Activities to keep track of all your customer 

communications. For example, you can take notes, send email, make phone calls, set up 

appointments, assign yourself tasks as you resolve a service case, and stay up-to-date with 

customer news. These actions are all considered types of activities. 
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 To add phone call details, tasks, notes, and more see: Add a phone call, task, email, or 

appointment activity to a case or record.   

 To stay up-to-date with your activity feeds, see: Stay up-to-date with customer news with the 

activity feed. 

See Also 

Collaborate and communicate with Yammer 

Place calls with Skype or Skype for Business 

If your organization is set up to use Skype or Skype for Business, you can click a phone number 

to call your contacts from within Microsoft Dynamics CRM. This capability is called “click to call.” 

Lync has been rebranded as Skype for Business. Currently, you’ll still see references to 

“Lync” in Microsoft Dynamics CRM, but CRM will work with Skype for Business. 

To place calls from within Microsoft Dynamics CRM on your computer, you either need to install 

Skype; or you need to check with your system administrator for steps to install Skype for 

Business. 

To place calls from within CRM for tablets, you’ll need to download the Skype app. If you don’t 

already have the app when you tap a phone number, you’ll have the opportunity to download the 

app before the call is placed. 

These versions of Lync and Skype are supported: 

 Microsoft Lync 2010 or Microsoft Lync 2013 

 Skype 6.0 

See Also 

Set up Microsoft Dynamics CRM to make calls with Skype or Skype for Business 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=246141
http://go.microsoft.com/fwlink/p/?LinkID=246141
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OneNote in CRM FAQs 

Why do OneNote files show a folder icon? 

This is a known issue. Click the file name to open the OneNote as expected. 

Why aren’t my OneNote notebooks showing up in the OneDrive documents area?  

OneNote notebooks saved to the Office 365 Groups OneDrive won’t be shown in Microsoft 

Dynamics CRM Online. 

I get this error message: We can’t find the notebook. The OneNote notebook might have 
been removed or moved to another location. Check the notebook location or contact your 
administrator to update the location record stored in CRM. (Error: 0x80060729) 

1. To fix the issue, go to Settings > Document Management > Document Location Records.  

2. Go to the OneNote view and search for the document location record that is regarding your 

account. 

3. Open that document location record, and then change the corresponding URL to match your 

notebook location. 

Can I edit a OneNote file from with CRM? 

No. This can be done only from the OneNote app that opens when you click the OneNote link. 

I can’t access my CRM OneNote notebook. 

Don’t delete any OneNote .onetoc2 or .one file types in the OneNote section in CRM. If you do, 

you won’t be able to access your CRM OneNote notebook. 

Are section groups supported in CRM? 

Sections groups that keep related sections together in OneNote aren’t supported in CRM. 

Can I rename a section in OneNote Online? 

No. You can only rename a section in the desktop version of OneNote. If you rename a section in 

OneNote Online, you won’t see the updated section name in CRM. 

Why do I see records that should be in the OneNote tab? 

This happens if you deleted all of the sections in the notebook. It’s recommended that you have 

at least one section in your OneNote notebook. To fix the issue do this: 

1. Go to the record where you see the issue. For example, from the main menu click, Sales > 

Accounts > click an account record.  

2. From the main menu click the drop down menu next to the record name, and then click 

Documents.  

3. Click Open in SharePoint and then create a new section using the desktop version of  

OneNote. 

See Also 

Set up and use OneNote in CRM 
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Send bulk email to customers 

You can send the same message to multiple recipients using email templates. This is known as 

direct or bulk emailing. 

Or, you can use mail merge with Microsoft Office Word and Word templates to create the 

message.  

 

1. Go to your work area. (How do I get there?) 

2. Choose the record type you want. For example, choose Contacts. 

3. In the list of records, select the contacts you want to send email to. 

4. Do one of the following: 

a. In the web app: Click the More Commands button , and then click Send Direct Email. 

b. In CRM for Outlook: In the Collaborate group, click Send Direct Email . Or, just click 

Send Direct Email to send email to everyone on the list. 

5. In the Send Direct Email dialog box, select the template you want to use. 

6. Click Send.  

See Also 

Create templates for email 

Work with mail merge templates 

Collaborate with your team 

 

Collaborate and communicate with Yammer 

Collaborate with your colleagues using Office 365 Groups 

Office 365 Groups in CRM FAQs 

View relevant and trending information with Office Delve 

Collaborate and communicate with Yammer 

Yammer gives you one place to have conversations, create and edit documents, and share 

information with your colleagues without sending a single email or attending any meetings.  

If your organization is set up to work with Yammer, you’ll see posts on your Microsoft Dynamics 

CRM dashboard when colleagues update customer info and you can comment on their posts—

asking questions, offering congratulations, and so on. 

 

Important  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Before you can use Yammer within Microsoft Dynamics CRM, your organization needs to 

buy Yammer enterprise licenses. 

 

When you use Yammer within Microsoft Dynamics CRM, here’s what you’ll be able to do: 

 The Yammer newsfeed displays on your dashboard. As you and your colleagues work 

with customers, you’ll stay up to date with the latest news about what’s happening, and you’ll 

be able to join in the conversation. Discuss project deadlines, share the latest files, gather 

feedback – and more. 

 

 Colleagues receive updates on your customer interactions automatically. When you 

create a new lead, convert it to an opportunity, close it, and so on, Yammer displays this 

news in your organization’s newsfeed automatically. 

 

 You can share files and discuss content without ever leaving your browser. Share 

documents, PDFs, images, and videos across teams quickly and easily.  

 

See Also 

Visit the Yammer website 

Collaborate with your colleagues using Office 365 Groups 

Office 365 Groups are a shared workspace for email, conversations, files, and events where 

group members can collectively get stuff done. 

You can use groups to collaborate with people across your company – even if they don’t have 

access to Microsoft Dynamics CRM Online. For example, you can create a group for your sales 

team and invite other Office 365 users to join the group, and then share documents, 

conversations, meeting notes, and OneNote information related to specific accounts or 

opportunities. 

The groups solution works with any entities, even custom ones. 

This feature requires that you have an Office 365 subscription or a subscription to an 

online service such as SharePoint Online or Exchange Online. For more information, see 

What is Office 365 and how does it relate to CRM Online? 

Important  

http://go.microsoft.com/fwlink/p/?LinkID=272440
https://technet.microsoft.com/library/mt169376.aspx
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Collaborate through meetings, conversations, notes, or documents. 

Prerequisites 

 You need to have an Office 365 subscription which includes Exchange Online and 

SharePoint Online.  

 Before you can start using Office 365 Groups, the groups solution needs to be deployed and 

turned on for your CRM CRM entities. For more information, see TechNet: Deploy Office 365 

Groups.  

Create a group 

1. Go to the record that you want to create a group for. For example, Go to Sales > Accounts. 

(How do I get there?) 

2. Choose an account. 

3. On the nav bar, choose the drop down menu next to the account name, and then click Office 

365 Groups. 

4. In the Welcome to Office Groups! section, click Create Group.  

Join a meeting 

Group meetings help all members coordinate their schedules. Everyone in the group 

automatically sees meeting invites and other events. 

 Choose the meeting title to view meeting details.  

https://technet.microsoft.com/library/dn896591.aspx
https://technet.microsoft.com/library/dn896591.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Start a conversation  

Having a group conversation is a way to communicate with group members. The conversations 

section displays each message, where you can read, reply to, and create new conversations.  

 To start a new conversion, in the Start a group conversion box, type in your message. 

 In the Conversations section choose a conversion to read and reply to it.  

Add notes 

Share notes with everyone in your group using the shared OneNote notebook. OneNote lets 

multiple people write in the same notebook, on the same page, at the same time, and it 

automatically merges everyone’s changes.  

 In the Notebook section, choose the group's notebook. When OneNote opens, add your 

notes. 

Share documents 

When you create or upload a file in the group’s OneDrive for Business page, it’s automatically 

shared with all members of the group. When you add members to the group, they automatically 

get shared access to the files. By default, only group members have view and edit access to the 

files. When you create a group in Microsoft Dynamics CRM, it’s set to private, so only the group 

members can see information about the group including files, conversations, or even the group 

itself. 

 To see the latest list of documents, refresh the list using by choosing the refresh icon. 

 To upload or manage all of your documents in OneDrive for Business, click Open OneDrive. 

See Also 

Office 365 Groups in CRM FAQs 

Find more help about Office 365 Groups 

TechNet: Deploy Office 365 Groups 

Office 365 Groups in CRM FAQs 

Where is the Office 365 Groups data stored? 

The Office 365 Groups data is stored in Office 365, not Microsoft Dynamics CRM Online. 

Why can’t I create Office 365 Groups using bulk import? 

Office 365 Groups will only be automatically created if your system administrator has turned on 

auto-create for the record type that you’re attempting to bulk import. In addition, to ensure 

performance and stability for others, Microsoft Dynamics CRM won’t create groups if you try to 

import a large number of records at once. We recommend a maximum of 20 records at a time if 

you need groups to be auto-created. If you import more than this, we can’t guarantee that a group 

is created. If a group wasn’t created due to a large bulk-import, you can manually create a group 

by navigating to that record’s groups page. 

https://support.office.com/Article/Find-help-about-Groups-in-Office-365-7a9b321f-b76a-4d53-b98b-a2b0b7946de1
https://technet.microsoft.com/library/dn896591.aspx
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Why don’t I see all of my group's meetings in CRM? 

At this time we’re unable to show meetings that someone from outside of your company has set 

up and has invited your group to attend. We are working on a solution to this issue, but in the 

meantime you can use the Open Calendar link to check your group's calendar in Microsoft 

Outlook on the web (Outlook Online). 

Why do I get a RetrieveOfficeSettings: 1 error when I navigate to the Office 365 Groups 
page? 

This is a known issue. Refresh the page and the error message will go away.  

Why do I get a (500) Internal Server Error when I navigate to the Office 365 Groups page? 

This is a generic error which could have multiple causes. One common case is that the user who 

is attempting to view the group doesn’t have a valid Office 365 license. 

When should we use Office 365 Groups versus Yammer? 

Groups are a great way to collaborate across your organization. They’re also integrated with 

Microsoft Office 365 products, providing you quick and easy access to all of your conversations, 

meetings, documents, and Microsoft OneNote.  

We recommend using groups for collaborations that requires lots of document sharing and quick 

access to other Office 365 products.  

See Also 

Collaborate with your colleagues using Office 365 Groups 

Find more help about Office 365 Groups 

TechNet: Deploy Office 365 Groups 

Import and export data 

 

Import data 

Export data 

Import data 

 

Import contacts 

Import accounts, leads, or other data 

Download a template for data import 

Upload a data import file 

Review the file upload summary 

Select a data map 

https://support.office.com/Article/Find-help-about-Groups-in-Office-365-7a9b321f-b76a-4d53-b98b-a2b0b7946de1
https://technet.microsoft.com/library/dn896591.aspx
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Map record types 

Map fields 

Review the mapping summary 

Review settings and import data 

Import contacts 

horizontaltabbed 

How to 

Whether your contacts are stored in an email program, a spreadsheet, or on your phone, here’s 

how to import them into Microsoft Dynamics CRM so you have all your business contact 

information in CRM. 

Step 1: Get your import file ready 

First, you export your contacts into a file.  

These file formats are supported: 

 Comma-separated values (.csv) 

 Text (.txt) 

 Compressed (.zip) 

 Excel Spreadsheet 2003 (.xml) 

The maximum file size allowed for .zip files is 32 MB. For the other file formats, the maximum file 

size allowed is 8 MB. 

If you need to import a larger amount of data, see the MSDN: Import Data for additional 

details. 

If you store contacts in more than one program, add your import files to a single .zip file. 

Then import the .zip file to bring in all the files at once. 

Follow the procedure for the program or location where your contacts are stored: 

1. Export the contacts into a comma separated values file (.csv). 

To find specific steps to export contacts from your email program, open the program’s 

Help, and search for “export.” Look for topics that include “exporting contacts” or 

“exporting your address book” or “export wizard” in the title. 

2. Save the file in a location where you can find it easily later. 

1. Open the spreadsheet. 

2. If necessary, edit any column name in the spreadsheet to match exactly with the 

corresponding name shown here.  

Tip  

Export contacts from an email program 

Export contacts from a spreadsheet 

https://msdn.microsoft.com/library/gg328321.aspx
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Warning  

If the spreadsheet doesn’t include all the column names listed, that’s okay. 

However, if a column name does exist, it must match exactly with the 

corresponding name in the list or the import won’t work. Spaces are required. 

Note that the word “Email” doesn’t contain a hyphen. 
 

Column Name in Spreadsheet (spelling must 

match exactly) 

First Name 

Middle Name 

Last Name 

Business Phone 

Mobile Phone 

Job Title 

Business Street 

Business City 

Business State 

Business Postal Code 

Business Country/Region 

Email Address 

 

3. Save the file. 

1. Use a USB cable or an app to export your contacts from your phone to your computer. 

To find specific steps to export contacts for your brand of phone, search for “export 

contacts from my phone” in your favorite search engine (like Bing). 

To find an app, search your phone’s online store. 

Step 2: Import the file 

You’ll use the Import Data wizard to import your contacts.  

1. Go to Settings > Data Management. (How do I get there?) 

 

Export contacts from your phone 

   

http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. Click Imports. 

3. Click Import Data. 

4. Browse to the folder where you saved the file that contains the export of your contacts. 

Select the file, and then click Open. Click Next.  

Tip  

You can import only one file at a time. To bring in more files, run the wizard again 

later, or add all your contacts files to a single .zip file. 

5. Review the file name, and if the file is in .csv or .txt format, verify that the field and data 

delimiters are correct. Click Next. 

Note  

In most cases, you can accept the default delimiters. 

6. Select Default (Automatic Mapping) for the System Data Map. Click Next. 

7. In the Microsoft Dynamics CRM Record Types drop-down list, select Contacts. Click 

Next.  

8. For any record type with an alert icon, map the column from your contacts file to the 

corresponding field in Microsoft Dynamics CRM. Click OK, and then click Next.  

9. Review the summary, and then click Next. 

10. Click Submit. 

11. To verify that the wizard was successful, click Imports, then review the report. 

Otherwise, click Finish. 

Step 3: Check that the contacts imported successfully 

After the wizard finishes, check your list of contacts to make sure they imported correctly. 

1. Select your role (either Sales, Service, or Marketing). Go to Contacts. (How do I get 

there?) 

2. Scroll through the contact list. Check that each person is listed and verify the contents of 

the fields for accuracy. 

Read this eBook 

 

Want to see visuals of importing contacts? Check out this eBook. 

 

See Also 

Import accounts, leads, or other data 

Import accounts, leads, or other data 

Whether your data is stored in spreadsheets, databases, or other systems, you’ll probably want to 

import the data into Microsoft Dynamics CRM so you can keep track of all your customer 

information in one place. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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You can import any type of information, such as accounts, leads, or opportunities – even activities 

or cases. (The different types of information are called “record types.”) 

Your import will fail if you use a template that you exported from CRM, add a new column 

to it, and then try to import the data back into CRM Online. 

Want to import contacts? More information:  Import contacts  

Step 1: Get your import file ready 

First, you’ll need to get your data into a file. 

Make sure your data is as complete and accurate as possible when you create the import file. Fill 

in any missing info, and verify that names and other information are spelled correctly. 

These file formats are supported: 

 Comma-separated values (.csv) 

 Text (.txt) 

 Compressed (.zip)  

 Excel Spreadsheet 2003 (.xml) 

 Excel Workbook (.xlsx) 

The maximum file size allowed for .zip files is 32 MB. For the other file formats, the maximum file 

size allowed is 8 MB. 

If you need to import a larger amount of data, check out MSDN: Import data for additional 

details. 

You can add multiple import files to a single .zip file, and then import the .zip file to bring 

in all the files at once. For example, if several salespeople enter leads from a tradeshow 

into different spreadsheets, you can gather them into one .zip file for import. 

For best results, it’s a good idea to make sure you (or your CRM admin, if that’s someone 

else) have some rules in place to reduce any duplicates when you import the data (called 

“duplicate detection rules”). More information:  Set up duplicate detection rules to keep 

your data clean 

Step 2: Run the Import Data wizard 

You’ll use the Import Data wizard to import the file.  

1. Go to Settings > Data Management. (How do I get there?) 

 

2. Choose Imports > Import Data. 

3. Browse to the folder where you saved the file that contains the import file. Select the file, 

Note  

Note  

Tip  

 

https://msdn.microsoft.com/library/gg328321.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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and then choose Open. Then, choose Next.  

Tip  

You can import only one file at a time. To bring in more files, run the wizard again 

later, or add all your import files to a single .zip file. 

4. Review the file name, and if the file is in .xlsx, .xml, .csv, .txt or .zip format, verify that the 

field and data delimiters are correct. Then, choose Next. 

Note  

In most cases, you can accept the default delimiters. 

5. Select how the wizard determines which fields to use for the data. 

 Select Default (Automatic Mapping) if you want the wizard to determine the 

corresponding fields in Microsoft Dynamics CRM automatically. If the wizard can’t 

find a field, you’ll have the opportunity to “map” it yourself.  

 

-- OR -- 

 

 Select For Generic Contact and Account Data if your import file contains contacts 

and accounts (and contacts are the main type of data).  

 

-- OR -- 

 

 Select For BCM 2010 if your import file contains your contacts from Microsoft 

Outlook 2010 with Business Contact Manager.  

 

-- OR -- 

 

 If available for your organization, select a custom data map. (You’ll see them in the 

list if they’re available to you.) 

 

6. Choose Next. 

7. If prompted, in the Microsoft Dynamics CRM Record Types drop-down list, select the 

type of records you are importing, for example Account or Lead. Then, choose Next.  

8. For any record type with an alert icon, map the field from your import file to a 

corresponding field in Microsoft Dynamics CRM. Scroll to see the whole list. Then, 

choose Next.  

9. Review the summary, and then choose Next. 

10. Select additional import settings. 

 If it’s okay for the Import Data wizard to import duplicate records, in the Allow 

Duplicates section, select Yes.  

Caution  

In most cases, to avoid importing duplicate information, you should keep this 
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option set to No. 

 To set who owns the imported records, in the Select Owner for the Imported Records 

section, choose the Lookup button . Select Look Up More Records, type the person’s 

name, and then choose Add. 

Note  

How do you decide who should “own” the imported data? Usually, the owner 

is the person responsible for taking action on the data. Here’s an example: If 

your import file contains contacts you collected at a trade show and you want 

to assign a user to follow up with these contacts, select that person for the 

owner. To assign someone other than yourself as the owner of the imported 

records, your security role must include permissions to create records for the 

user. If you don’t have sufficient permissions, the wizard assigns you as the 

owner of the imported records by default. 

 To save these import settings so you can use them again, enter a name for the 

settings (called a “data map”). 

The next time you run the Import Data wizard, you’ll see the new data map listed 

under Custom Maps. 

 

11. Choose Submit. 

12. To verify that the wizard was successful, choose Imports, and then review the report. 

Otherwise, choose Finish. 

See Also 

Import contacts 

MSDN: Import data 

Download a template for data import 

Whether your data is stored in spreadsheets, databases, or other systems, you'll want to import 

the data into Microsoft Dynamics CRM so you can keep track of all your customer information in 

one place. You use templates for importing many types of records, such as accounts, leads or 

cases. There is a complete list in the Templates for Data Import wizard. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

https://msdn.microsoft.com/library/gg328321.aspx
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2. Go to Settings > Data Management. (How do I get there?) 

3. Choose Templates for Data Import. 

4. In the Templates for Data Import dialog box, choose the record type that you want to 

download the template for, and then select Download. 

5. In the file download box, click Save or Save as and navigate to a location for the file. 

6. Choose Close. 

 

See Also 

Import accounts, leads, or other data 

Import contacts 

Upload a data import file 

Export data 

 

Export data to Excel 

Export to an Excel PivotTable 

Export to an Excel dynamic worksheet 

Export to an Excel static worksheet 

Analyze your CRM data in Excel Online 

Export data to Excel 

Do you need to analyze your data from Microsoft Dynamics CRM and convert that data into 

actionable items that help you drive more sales?  Now you can do this when you export your data 

to Microsoft Excel or Excel Online to do a quick data analysis. Also, analyzing large datasets is 

not a problem because you can export up to 100,000 rows of data. 

You can choose to export static worksheets or dynamic worksheets, which you can import back 

into CRM. If you need more advanced functions, you can export a dynamic PivotTable, which 

makes it very easy to organize and summarize data.    

Export data to a standard Excel file that that you can use on any device such as your phone, 

tablet, or desktop computer. The data is exported in the same format as you see in CRM. Text 

will remain text, numbers will remain numbers, and dates will remain dates. However, when you 

export data from CRM to Excel the some cell format may change. The table below summarizes 

how you’ll see the data in CRM and how the cell format changes when you export the data to 

Excel. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Cell format when data is exported from CRM to Excel 

Data format in CRM Cell format in Excel 

Text, Ticker Symbol, Phone, Options set, and 

Look Up 

Shows as Text and option set becomes drop-

down list 

Email, URL Shows as General 

Number Shows as Number without group separator 

Currency Shows as Number and does not include “$” 

symbol 

Date only, Date and Time Shows as Date only 

Calculated and Roll up fields  Editable in Excel but can’t be imported back to 

CRM 

Secured fields Editable in Excel but can’t be imported back to 

CRM 

 

 

See which type of export works best for you 

Task Learn more 

Do an ad-hoc or what if analysis without 

modifying CRM data. Or, quick bulk edit to 

multiple CRM records. 

Analyze your CRM data in Excel Online 

Get a snapshot of the data at the current data 

and time or you want to share it with others.   

Export to an Excel static worksheet 

Get the most update-to-date information and be 

able to refresh it in Excel and match what you 

see in CRM at any time. 

Export to an Excel dynamic worksheet  

View CRM data in a pivot table. Export to an Excel PivotTable 

 

 

 When you export data in Excel (.xlsx format) and then add or modify columns, you can’t 

import the data back in to CRM. This is not support for .xlsx file format. 

 If you’re using Excel 2010, \ you may get this error message when you export data from 

Accounts area: “The file is corrupt and cannot be opened.” 

The error message occurs due to a setting in Excel. To fix the issue, do this: 

a. Open Excel 2010 

b. Choose File > Options. 
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c. Choose Trust Center > Trust center settings. 

d. Choose Protected view. Then clear the check boxes for the first two options. 

e. Choose OK and then close the Options dialog box. 

Privacy notice 

If you use Microsoft Dynamics CRM Online, exporting data to a static worksheet creates a local 

copy of the exported data and stores it on your computer. The data is transferred from CRM 

Online to your computer by using a secure SSL connection, and no connection is maintained 

between this local copy and CRM Online. 

 

 When you export to a dynamic worksheet or PivotTable, a link is maintained between the Excel 

worksheet and CRM Online. Every time a dynamic worksheet or PivotTable is refreshed, you’ll be 

authenticated with CRM Online using your credentials. You’ll be able to see the data that you 

have permissions to view. 

 

 An administrator determines whether or not an organization’s users are permitted to export data 

to Excel by using security roles.  

 

See Also 

Analyze your data with Excel templates 

Use the pre-configured Excel templates to analyze your sales data 

Export to an Excel PivotTable 

You can export Microsoft Dynamics CRM data to a Microsoft Office Excel PivotTable to see 

patterns and trends in data. An Excel PivotTable is a great way to summarize, analyze, explore, 

and present your CRM data. You can export up to 100,000 records at a time. 

Prerequisites 

 Microsoft Dynamics CRM for Outlook is required to export data to a PivotTable. 

 On a default Microsoft Dynamics CRM installation, before you export data to an Excel 

PivotTable, make sure that your Microsoft SQL Server allows remote connections. 

 

Allow remote connections to SQL Server 

a. Start Microsoft SQL Server Management Studio. 

b. Connect to the SQL Server instance. 

c. Right-click the SQL Server instance name, choose Properties, choose Connections, 

and then select the Allow remote connections to this server check box. 

 

 Windows Firewall allows remote SQL Server connections. More information: How to: 

Configure a Windows Firewall for Database Engine Access. 

Export to an Excel PivotTable 

https://msdn.microsoft.com/library/ms175043.aspx
https://msdn.microsoft.com/library/ms175043.aspx
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The option to export data to an Excel PivotTable isn’t available in all CRM record types. If you 

don’t see the option, it’s not available for that record. 

1. Open a list of records in the CRM web application or in Dynamics CRM for Outlook. 

Choose Export to Excel. 

2. Choose Dynamic PivotTable. 

3. In the Select PivotTable Columns list, select or clear the check boxes for the fields as 

needed, and then choose Export. 

By default, the PivotTable Field List includes only fields that are displayed in the Select 

PivotTable Columns list. 

4. Choose Save and then save the . xlsx file. Make note of the location where you saved 

the file. 

Note  

If you’re going to edit the data file later, it’s recommended that you save the file 

before you open it. Otherwise, you may get this error message: Excel cannot 

open or save any more documents because there is not enough available 

memory or disk space.  

To fix the issue do this: 

a. Open Excel and go to File > Options > Trust Center  

b. Choose Trust Center Settings, and then choose Protected View. 

c. Under Protected View, clear the check boxes for all three items. 

d. Choose OK, and then OK.  

 

We still strongly recommend that you save and then open the data file, rather 

than disabling protected view, which may put your computer at risk. 

5. Open Microsoft Office Excel and then open the . xlsx file you saved in the previous step. 

6. If you see the security warning External Data Connections have been disabled, 

choose Enable Content. 

7. To refresh data in the file, on the Data tab choose Refresh All. 

8. Drag the fields from the PivotTable Field List to the PivotTable. For more information, see 

Microsoft Office Excel Help. 

Tips 

 If you export a list to a dynamic worksheet or PivotTable that you think will be useful to other 

Microsoft Dynamics CRM users, you can add the list as a report, and then share it with others 

or make it available to all Microsoft Dynamics CRM users. 

 

If the recipients are in the same domain as you, and are Microsoft Dynamics CRM users, you 

can email a dynamic Excel file, or store it as a shared file. When recipients open the dynamic 
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file, they will see data they have permission to view in Microsoft Dynamics CRM, so the data 

they see may be different from what you see. 

 

 In Microsoft Dynamics CRM, money values are exported to Microsoft Office Excel as 

numbers. After you have completed the export, to format the data as currency, see the Excel 

Help topic titled “Display numbers as currency.” 

 The data and time values that you see in Microsoft Dynamics CRM show up as “Date” only 

when you export the file to Microsoft Office Excel but the cell actually shows both the date 

and time.  

 If you’re going to make changes and import the data file back in to CRM, remember that 

secured, calculated, and composite fields (such as Full Name) are read-only and can’t be 

imported in to CRM. You’ll be able to edit these fields in Excel but when you import the data 

back in to CRM these fields won’t be updated. If you want to update these fields such as a 

contact’s name, it’s recommend that you use that view to export your data, update them in 

Excel, and import them back to CRM for changes. 

 Some system views, such as Accounts: No Campaign Activities in Last 3 Months, can be 

exported only to a static Excel worksheet. 

 For anyone who is not on CRM Online 2015 Update 1 or Microsoft Dynamics CRM 2016 and 

you are using the Office 365 Excel web app, you must save the file, open the file using the 

Excel desktop application, and then resave the file to the . xlsx format. You can then reopen 

the Excel document in Excel Online. 

Privacy notice 

If you use Microsoft Dynamics CRM Online, exporting data to a static worksheet creates a local 

copy of the exported data and stores it on your computer. The data is transferred from CRM 

Online to your computer by using a secure SSL connection, and no connection is maintained 

between this local copy and CRM Online. 

 

 When you export to a dynamic worksheet or PivotTable, a link is maintained between the Excel 

worksheet and CRM Online. Every time a dynamic worksheet or PivotTable is refreshed, you’ll be 

authenticated with CRM Online using your credentials. You’ll be able to see the data that you 

have permissions to view. 

 

 An administrator determines whether or not an organization’s users are permitted to export data 

to Excel by using security roles.  

 

See Also 

Export data to Excel 

Running reports and analyzing data 

Data management top links 

Create, edit, or save an Advanced Find search 

data-management-top-links.aspx
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Export to an Excel dynamic worksheet 

Export data to a Microsoft Office Excel worksheet so users can have the latest Microsoft 

Dynamics CRM information any time they view the worksheet. Imagine the CEO of your company 

getting the critical information they need without having to navigate Microsoft Dynamics CRM but 

instead, merely opening the Excel link on their desktop. You can export up to 100,000 records at 

a time. 

Prerequisites 

Dynamics CRM for Outlook is required to export data to a Dynamic PivotTable. 

Export data to an Excel dynamic worksheet 

You can’t export data to a dynamic worksheet in Excel for all CRM record types. If you don’t see 

the option, it’s not available for that record. 

1. Open a list of records in the CRM web application or in Microsoft Dynamics CRM for 

Outlook. Click or tap Export to Excel. 

2. Choose Dynamic worksheet. 

3. Under Common Tasks, configure the column settings and then choose Export. 

4. Choose Save and then save the . xlsx file. Make note of the location where you saved 

the file. 

Note  

If you’re going to edit the data file later, it’s recommended that you save the file 

before you open it. Otherwise, you may get this error message: Microsoft Excel 

cannot open or save any more documents because there is not enough 

available memory or disk space.  

To fix the issue do this: 

a. Open Excel and go to File > Options > Trust Center Settings Center Settings… > 

Protected View. 

b. In Protected View, uncheck all three items. 

c. Then choose OK > OK.  

 

We still strongly recommend that you save and then open the data file, rather 

than disabling protected view which may put your computer at risk. 

5. Open Microsoft Office Excel and then open the . xlsx file you saved in the previous step. 

6. If you see the security warning External Data Connections have been disabled, 

choose Enable Content. 

7. To refresh data in the file, on the Data tab, choose Refresh All. 

Note  

If you have a phone numbers that starts with + or –, for example +1-123-456-

7890, when you refresh the dynamic worksheet the phone number field will not 
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display the number correctly.  

 

To avoid the issue, use a space or parentheses (), like this: +1 123-456-7890 or 

+1 (123)-456-7890 

Tips 

 You can email a dynamic Excel file or store it as a shared file if the recipients are in the same 

domain as you. When recipients open the dynamic file, they’ll see data they have permission 

to view in Microsoft Dynamics CRM, so the data they see may be different from what you 

see. 

 Some system views, such as Accounts: No Campaign Activities in Last 3 Months, can be 

exported only to a static Excel worksheet. 

 In Microsoft Dynamics CRM, money values are exported to Microsoft Office Excel as 

numbers. After you have completed the export, to format the data as currency, see the Excel 

Help topic titled “Display numbers as currency.” 

 The data and time values that you see in Microsoft Dynamics CRM show up as Date only 

when you export the file to Microsoft Office Excel but the cell actually shows both the date 

and time.  

 If you’re going to make changes and import the data file back in to CRM, remember that 

secured, calculated, and composite fields (e.g. Full Name) are read-only and can’t be 

imported in to CRM. You’ll be able to edit these fields in Excel but when you import the data 

back in to CRM these fields will not be updated. If you want to update these fields such as a 

contact’s name then it’s recommend that you use that view to export your data, update them 

in Excel, and import them back to CRM for changes. 

 If you’re not on CRM Online 2015 Update 1 or Microsoft Dynamics CRM 2016 and are using 

the Office 365 Excel web app, you must save the file, open the file using the Excel desktop 

application, and then resave the file to the . xlsx format. You can then reopen the Excel 

document in Excel Online. 

Privacy notice 

If you use Microsoft Dynamics CRM Online, exporting data to a static worksheet creates a local 

copy of the exported data and stores it on your computer. The data is transferred from CRM 

Online to your computer by using a secure SSL connection, and no connection is maintained 

between this local copy and CRM Online. 

 

 When you export to a dynamic worksheet or PivotTable, a link is maintained between the Excel 

worksheet and CRM Online. Every time a dynamic worksheet or PivotTable is refreshed, you’ll be 

authenticated with CRM Online using your credentials. You’ll be able to see the data that you 

have permissions to view. 

 

 An administrator determines whether or not an organization’s users are permitted to export data 

to Excel by using security roles.  

 

See Also 
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Export data to Excel 

Running Reports and Analyzing Data 

Create, edit, or save an Advanced Find search 

Export to an Excel static worksheet 

When you want to present CRM information to an individual who doesn’t have access to 

Microsoft Dynamics CRM, or you have data that doesn’t change often, consider exporting your 

CRM data to a Microsoft Office Excel static worksheet. 

If you’re on CRM Online 2015 Update 1, you can export up to 100,000 records at a time. And by 

default, CRM lists up to 50 records per page. Choose the Page arrows at the bottom of the list to 

view any additional pages. 

Export data to an Excel static worksheet 

You may have the option to export data to an Excel static worksheet in all record types however, 

in some cases the format may be legacy, or the data may not be filtered by what you see in CRM 

view. 

1. Open a list of records in the CRM web application or in Microsoft Dynamics CRM for 

Outlook. Choose Export to Excel, and then choose Static worksheet (Page only). 

2. By default, an exported worksheet includes the fields that are displayed in the list, using 

the same field order, sorting, and field widths. To make changes to the columns in an 

Advanced Find View, choose Edit Columns. More information: Create, edit, or save an 

Advanced Find search 

3. Choose Save and then save the . xlsm file. Make note of the location where you saved 

the file. 

Note  

If you’re going to edit the data file later, it’s recommended that you save the file 

before you open it. Otherwise, you may get this error message: Excel cannot 

open or save any more documents because there is not enough available 

memory or disk space.  

To fix the issue do this: 

a. Open Excel and go to File > Options > Trust Center Settings Center Settings… > 

Protected View. 

b. In Protected View, uncheck all three items. 

c. Then choose OK > OK.  

 

We still strongly recommend that you save and then open the data file, rather 

than disabling protected view, which may put your computer at risk. 

4. Open Microsoft Office Excel and then open the . xlsm file you saved in the previous step. 

By default, an exported worksheet includes the fields that are displayed in the list, using the 
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same field order, sorting, and field widths. 

Tips 

 You can email a static exported worksheet to anyone, or store it in a shared file. Anyone who 

opens the file will see all the data in the file, whether or not they are a Microsoft Dynamics 

CRM user or have privileges to view the data in Microsoft Dynamics CRM. 

 You can’t change the columns for a system view, such as All Active Accounts. You must 

either customize the view, which requires the System Administrator or System Customizer 

security role, or use Advanced Find to create your own view based on the current view. 

 If you’re not on CRM Online 2015 Update 1 and you’re using the Office 365 Excel web app, 

you must save the file, open the file using the Excel desktop application, and then resave the 

file to the . xlsx format. You can then reopen the Excel document in Excel Online. 

 In Microsoft Dynamics CRM, money values are exported to Excel as numbers. After you have 

completed the export, to format the data as currency, see the Microsoft Office Excel Help 

topic titled “Display numbers as currency.” 

 The data and time values that you see in Microsoft Dynamics CRM show up as Date only 

when you export the file to Microsoft Office Excel but the cell actually shows both the date 

and time.  

 If you’re going to make changes and import the data file back in to CRM, remember that 

secured, calculated, and composite fields (e.g. Full Name) are read-only and can’t be 

imported in to CRM. You’ll be able to edit these fields in Excel but when you import the data 

back in to CRM these fields will not be updated. If you want to update these fields such as a 

contact’s name then it’s recommend that you use that view to export your data, update them 

in Excel, and import them back to CRM for changes. 

Privacy notice 

If you use Microsoft Dynamics CRM Online, exporting data to a static worksheet creates a local 

copy of the exported data and stores it on your computer. The data is transferred from CRM 

Online to your computer by using a secure SSL connection, and no connection is maintained 

between this local copy and CRM Online. 

 

 When you export to a dynamic worksheet or PivotTable, a link is maintained between the Excel 

worksheet and CRM Online. Every time a dynamic worksheet or PivotTable is refreshed, you’ll be 

authenticated with CRM Online using your credentials. You’ll be able to see the data that you 

have permissions to view. 

 

 An administrator determines whether or not an organization’s users are permitted to export data 

to Excel by using security roles.  

 

See Also 

Running Reports and Analyzing Data 

Create, edit, or save an Advanced Find search 
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Analyze your CRM data in Excel Online 

horizontaltabbed 

How to 

No need to leave Microsoft Dynamics CRM to analyze your data. Now you can do a quick ad-hoc 

analysis using Microsoft Excel Online in Microsoft Dynamics CRM Online.  

For example, if you’re a sales manager, you might want to analyze the opportunities your team 

owns and review key performance indicators (KPIs) to see how you can assist your team 

members. If you’re a sales rep, you can open your opportunities in Excel and conduct what-if 

analysis for different incentive scenarios. Or, you may want to quickly open the data in Excel 

Online so that you can copy it somewhere else such as an email. 

When you make changes to your data in Excel Online, you can save the updated information in 

CRM. Remember to keep the existing format of the Excel cells to prevent problems during import. 

Adding additional information to the spreadsheet, such as graphs, charts, or colors, will not be 

saved. 

Prerequisites 

 This feature requires CRM Online 2015 Update 1 or later. 

 This feature requires that you have an Office 365 subscription or a subscription to an online 

service such as SharePoint Online or Exchange Online. For more information, see What is 

Office 365 and how does it relate to CRM Online? 

 You need a Microsoft account. 

 You need export to Excel privileges in CRM. 

Open CRM data in Excel Online 

The option to open data in Excel Online isn’t available in all CRM record types. If you don’t see 

the option, it’s not available for that record. 

Updated data in CRM won’t immediately be reflected in Excel Online if the same view 

was opened in the last two minutes in Excel Online. After that timeframe, any updated 

data should show in Excel Online.  

 Open a list of records in CRM Online. Click Export to Excel > Open in Excel Online. 

Note  

https://technet.microsoft.com/library/mt169376.aspx
https://technet.microsoft.com/library/mt169376.aspx
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By default, you can’t open your CRM data in Excel Online in the Advanced Find view. 

However, you can save your advanced find as a personal view and then go to your 

personal view to do an ad-hoc analysis in Excel Online.  

Save your data and import it back to CRM 

1. On the top right, click Save Changes to CRM. 

 The data for ad-hoc analysis with Excel Online is stored temporarily. Any additions, such 

as charts, calculations, and columns won’t be saved from the ad-hoc analysis that you do 

in Excel Online back to CRM. If you need to make lots of changes to your data and 

import it back to CRM, it’s recommended that you export the worksheet in Microsoft 

Excel. 

 The file import might fail if you made a lot of changes or changed the format of the Excel 

file. If you need to make lots of changes to your data and import it back to CRM, it’s 

recommended that you export the worksheet in Excel. 

 By design, you can’t do a File > Save As in Excel Online. If you do, you’ll get a Can’t 

Save Workbook error message.  

2. On the Data Submitted for Import dialog box, click Close.  

Check the status of the data import 

After you save your changes from Excel Online to CRM, verify that the data has been imported 

back in to CRM Online. 

1. In the Data Submitted for Import dialog box, click Imports.  

-OR- 

Go to Settings > Data Management. (How do I get there?) Then click Imports. 

2. In the list of imported files, look for your imported file and check the status.  

Note  

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Watch this video 

 

Find out how to analyze your data and transform it into meaningful knowledge with CRM Online 

Excel integration. 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/NZNvWz9xuZ0" 

frameborder="0" allowfullscreen></iframe> 

To see video captions, click the Closed Caption (CC) button  in the lower-right corner of the 

YouTube window. 

 

Read video transcript 

Do you need to analyze your data from Microsoft Dynamics CRM and transform that data into 

meaningful knowledge that helps to drive sales? 

Dynamics CRM allows you to do just that with your CRM Excel integrations. Quickly export your 

data to either Microsoft Excel for Rich Client or Microsoft Excel Online for easy consumption. The 

new Export to Excel feature is very simple. With a single click you can export data to a standard 

Excel file that can be used on any client: Phone, tablet, desktop, as well as Excel Online. Data is 

exported in the same format as it is in CRM. You don't need to worry about data formats getting 

lost in translation; text will remain text, numbers will remain numbers, and dates will remain dates. 

You can export static or dynamic worksheets, both of which are importable. But what if you need 

more advanced functions? 

You can also export a Dynamic Pivot Table, which makes it very easy to tabulate and summarize 

data. Also, analyzing large data sets is not a problem - CRM can export up to 100,000 rows. 

Sometimes you may need more reports that are not in your standard business analytics tool box. 

You can now quickly perform data analysis on CRM data by using the ad hoc analysis with Excel 

Online. 

Let's demonstrate a quick example.  

Select Export to Excel, open Excel Online, and your data will be immediately available in Excel 

Online. Now let's perform a quick analysis on the data. Let's determine the expected revenue for 

open opportunities. 0h, and my colleague just informed me that the estimated revenue for one 

opportunity went up ten thousand dollars. Let's make the change and send it back to CRM. Okay, 

now let's cover the details about this functionality. Ad hoc analysis with Excel Online is only 

available for CRM Online and does require an Office 365 license. In addition, the user will require 

Export to Excel privileges in CRM. The data for ad hoc analysis with Excel Online is stored only 

temporarily. Any additions, such as charts, calculations, and columns won’t be saved from the Ad 

hoc Analysis Excel Online Editor back to CRM. If you need to perform heavy lifting with the CRM 

data, we recommend you export the worksheet for use in Excel Desktop. 

Enjoy the new data analysis features in Dynamics CRM. We hope that you can leverage your 

data to bring you new insights about your business. Thanks for watching. 

See Also 
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Export data to Excel 

Import accounts, leads, or other data 

Use Bing Maps to view a location 

Bing Maps help you plan customer visits, optimize your routes, calculate mileage for expense 

reports, and see nearby services. When you view the details for contacts, leads, or accounts, 

you’ll see a map that shows where their address is located. Click or tap a map to explore aerial 

and satellite images, check traffic conditions, and get directions. 

Bing Maps may not be available in all countries/regions or languages. Additionally, 

Microsoft Dynamics CRM (on-premises) users may be prompted to enter a license key to 

view Bing Maps. Contact your system administrator for information about your 

organization’s Bing Maps license. 

View a Bing map for a contact, lead, or account  

1. Navigate to a contact, lead, or account. 

2. Scroll down to see the map. If the Address field is blank, enter the address, and then 

click Done. Wait a moment for the map to refresh. 

3. Click the map to view aerial and satellite images, check traffic conditions, and get 

directions. 

Important  
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Privacy notice 

If you use Microsoft Dynamics CRM, the Bing Maps feature automatically sends the address over 

the Internet to the Bing Maps service to display an online map of the address within CRM.  If you 

click on the Bing Maps within CRM, you will be redirected to www.bing.com/maps. Your use of 

Bing Maps is also governed by the Bing Maps End User Terms of Use.  

 

 Your administrator can turn the Bing Maps feature on or off in the Settings > Administration > 

System Settings area. Turning the Bing Maps app off disables the feature within CRM. 

 

 Information sent to Bing Maps is subject to the Bing Maps Privacy Statement.  

 

See Also 

Create or edit a lead 

Create or edit a contact 

Create or edit an account 

http://www.bing.com/maps
http://go.microsoft.com/?linkid=9710837
http://go.microsoft.com/fwlink/p/?linkid=248686
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Use OneDrive for Business to manage your private documents 

With CRM Online, you can use the right storage option for the right situation. For example, store 

your private documents using the new OneDrive for Business option. For collaborative storage, 

you can use Office 365 Groups, and for public documents use SharePoint. 

You might use OneDrive for Business to start and work on a document privately such as for a 

draft sales pitch. When the draft is far enough along, move it to an Office 365 group for team 

collaboration. You have lots of storage space (1 TB or more) with OneDrive for Business and 

documents stored there are automatically synced to your desktop and mobile devices. For 

example, if you put a presentation in CRM that’s stored on OneDrive linked with an opportunity, 

that presentation is synced to all devices running OneDrive. 

Before you can use OneDrive for Business, it must be enabled by your system administrator. For 

more information, see: 

 Find your CRM administrator or support person 

 TechNet: Enable OneDrive for Business 

This feature requires that you have an Office 365 subscription or a subscription to an 

online service such as SharePoint Online or Exchange Online. For more information, see 

What is Office 365 and how does it relate to CRM Online? 

The first time you view your documents 

After OneDrive for Business is enabled, you’ll see the following dialog box when you go to a 

document list to view documents in CRM. 

 
 

  

Important  

http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/c3742b70-863a-488e-beb3-fb9d63c2e6e5
https://technet.microsoft.com/library/mt169376.aspx
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Click Change folder location to pick a new location to store OneDrive documents or click 

Continue to accept the default folder location: \CRM 

View existing OneDrive documents 

Open a view with a document grid.  

For example, 

1. Click Sales > Opportunities 

2. Choose an opportunity from the drop-down menu, and then click Documents. 

 
 

  

CRM now organizes documents in a consolidated view. 

 
 

  

Documents stored in SharePoint and OneDrive are viewed in one list.  
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Click Document Location to filter the document list. 

 
 

  

Select a location as described in the following table. 
 

Document Location Description 

All files All document locations associated with this 

CRM record 

SharePoint site Documents stored in your default SharePoint 

site 

OneDrive Documents stored in OneDrive for Business 

Shared with me Documents others shared with you that are 

associated with this CRM record 

 

  

Create a new document 

To create a new SharePoint or OneDrive document in CRM: 

1. Open a view with a document grid. 

2. Click New  and then choose a document type such as Microsoft PowerPoint or Word. 

3. Enter a document name, choose a location, and then click Save.  

The document is created and opened in the Office 365 Online application. 

Change your OneDrive folder settings 

You can change the location of your OneDrive documents and rename the folder used for 

OneDrive. 

1. Click Settings > Document Management > OneDrive for Business Folder Settings 

2. Enter a new location for CRM to store OneDrive files, and then click OK. 

The OneDrive folder is renamed and all the existing files will now be associated with the 

new folder.  

Note  
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Considerations 

Be aware of the following regarding OneDrive for Business in CRM. 

 OneDrive storage folders are created in the user’s current CRM language. If the language 

changes, new folders will be created in the new language. Old folders will remain in the 

previous language. 

 Folders aren’t supported. Documents in shared folders won’t appear in the document grid. 

 There may be a delay between when the documents are shared in OneDrive and when 

they’re available to other users. 

See Also 

What is OneDrive for Business? 

TechNet: Enable OneDrive for Business 

Work with reports and dashboards 

 

View reports 

Charts and dashboards 

Charts and dashboards 

View reports 

 

Get a list of available reports 

Share a report with other users or teams 

Run a report 

Download a report 

Add a report from outside CRM 

Troubleshoot problems with data not displaying in a report 

Available reports 

Get a list of available reports 

Microsoft Dynamics CRM includes many system reports that you can use to gain insights into 

how your business is doing. You can use these reports as is or customize them for your needs. 

For more information about customized reports, see Customize and organize reports. 

Reports in CRM 
 

https://support.office.com/en-US/article/What-is-OneDrive-for-Business-187f90af-056f-47c0-9656-cc0ddca7fdc2
https://technet.microsoft.com/library/c3742b70-863a-488e-beb3-fb9d63c2e6e5
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Category Description More information 

Account insights Top revenue-generating 

accounts 

Account Distribution report 

 Overview of an account Account Overview report 

 Chronological account 

summary 

Account Summary report 

 Accounts that haven’t been 

contacted 

Neglected Accounts report 

Marketing insights Summary of activities in a 

campaign 

Campaign Activity Status 

report 

 Compare campaigns Campaign Comparison report 

 Progress and status of 

campaigns 

Campaign Performance report 

Sales insights Sales team performance 

against competitors 

Competitor Win Loss report 

 Activity patterns Activities report 

 Sales progress against goals Progress Against Goals report 

 Sales performance of reps Sales History report 

 Potential sales opportunities Sales Pipeline report 

 Compare effectiveness of lead 

sources for generating 

opportunities 

Lead Source Effectiveness 

report 

 Leads that haven’t been 

contacted 

Neglected Leads report 

Product insights Products used by an account Products by Account report 

 Products used by a contact Products by Contact report 

Invoices, quotes, and orders 

details 

Line items of an invoice Invoices report 

 Accounts receivable Invoice Status report 

 Line items of a quote Quotes report 

 Line items of an order Orders report 

Service insights Types of opened and resolved 

cases 

Case Summary Table report 
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Category Description More information 

 Cases with no recent activity Neglected Cases report 

 Amount and length of service 

activities 

Service Activity Volume report 

 Most searched knowledge 

base articles 

Top knowledge base articles 

report 

Administrator reports List of users User Summary report 

 

See Also 

Run a report 

Share a report with other users or teams 

Download a report 

Create, edit, or copy a report using the Report Wizard 

Edit the default filter of a report 

Troubleshoot problems with data not displaying in a report 

Share a report with other users or teams 

When you create a new report, share it with other people on your team or in your organization so 

that they can also benefit from it. There are several ways that you can share your new report with 

other people.  

Share the report with other users or teams 

1. Go to Reports. (How do I get there?) 

2. In the list of reports, select the report. 

If using the CRM web application: 

a. Click More Commands , and then click Share. 

b. In the Share Report dialog box, click Add User/Team. 

c. In the Look Up Records dialog box, select the users or team you want to share the 

report with, and click OK. 

d. In the Share Report dialog box, select the type of share access that you want. The 

available permissions are: Read, Write, Delete, Append, Assign, or Share. 

 

 

If using CRM for Outlook: 

a. In the list of reports, select a report, and in the Collaborate group, click Share. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
78 

b. Specify the users or teams you want to share the report with. 

Share the report with your organization 

If the report would be useful for all users, make it available to the organization. 

1. Go to Reports. (How do I get there?) 

2. In the list of reports, select the report, and on the command bar, click Edit. 

If using the CRM web application: 

a. On the command bar, click Edit. 

b. On the Actions  menu, click Make Report Available to Organization. 

 

 

If using CRM for Outlook: 

a. In the Records group, click Edit. 

b. On the Actions  menu, click Make Report Available to Organization. 

See Also 

Get a list of available reports 

Run a report 

 

Run a report 

Reports help you manage your progress towards your goals by helping you see how you’re 

doing. You can also track trends - which can give you an advantage over your competitors.  

For example it’s important for a sales team to know which product or service is selling and which 

is not doing so well. For a customer service team, it’s important to track the average time it takes 

to resolve an issue.  

To run a report 

1. Go to Reports. (How do I get there?) 

2. Choose the report you want > Run Report. 

Note  

In Report Viewer dialog box, you can leave the search criteria as is, or change it 

as needed. 

 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Privacy notice 

When Microsoft Dynamics CRM Online users print CRM data, they are effectively “exporting” that 

data from the security boundary provided by CRM Online to a less secure environment, in this 

case, to a piece of paper.  

 

 An administrator has full control (at the user security role or entity level) over the data that can be 

extracted. However, after the data has been extracted it is no longer protected by the security 

boundary provided by CRM Online and is instead controlled directly by the customer. 

 

See Also 

Get a list of available reports 

Customizing and Organizing Reports 

Customize your regional settings (number, currency, time, and date) in CRM for Outlook 

Report Writers Guide for Microsoft Dynamics CRM 2015 and Microsoft Dynamics CRM Online 

Download a report 

To edit a default report, you can download the report from Microsoft Dynamics CRM to a 

computer that is set up with the report development environment, and then make the necessary 

changes. 

 

1. Go to Reports. (How do I get there?) 

 

2. On the Actions  menu, click or tap Download Report. 

The RDL file for the report contains tags that specify whether the report is a Fetch-based 

report or an SQL-based report. 

3. Click or tap Save, and specify the location in which to save the file. If you’re creating a 

new report rather than modifying a report, rename the file. 

4. In the Download Complete dialog box, click or tap Close. 

See Also 

Create, edit, or copy a report using the Report Wizard 

Add a report from outside CRM 

If you’ve created a custom report outside of Microsoft Dynamics CRM, you can easily add it to 

CRM. 

 

https://technet.microsoft.com/library/dn531183.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Go to Reports. (How do I get there?) 

 

2. Choose New. 

Add a file created in another application 

a. In the Source section, in the Report Type box, select Existing File. 

b. In the File Location box, enter the path and file name of the file to add, or choose 

Browse to locate the file. 

-OR 

Add a link to a webpage 

a. In the Source section, in the Report Type box, select Link to Webpage. 

b. In the Webpage URL box, enter the URL of the webpage. 

3. Specify the properties for the report on the General tab. 

a. In the Details section, specify a meaningful name and description for the report. 

b. The Parent Report text box displays the parent report of the current report, if one 

exists. 

c. Categories. Choose the Select or change the values for this field   button, and then 

specify the categories to include in this report. 

d. Related Record Types. To have the report appear in the Reports list on a page for specific 

record types, choose the Select or change the values for this field   button, and then 

select record types. 

e. Display In. To specify where reports should be visible, choose the Select or change the 

values for this field   button, and then select one or more of the options. 

If no values are selected, the report won’t be visible to end users. 

4. Edit the report ownership information on the Administration tab: 

 Owner 

This option is only available if you have Assign permission for the report. 

 Viewable By 

Select Organization to make the report organization-owned, and to make it viewable 

by anyone in the organization. Select Individual to make the report viewable only by 

the owner and anyone the owner shares the report with.  

5. Choose Save or Save and Close. 

To share the new report, see the instructions in Share a report with other users or teams. 

See Also 

Create, edit, or copy a report using the Report Wizard 

Customizing and organizing reports  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Report writing with CRM 2015 for online and on-premises 

Troubleshoot problems with data not displaying in a report 

There are several possible reasons why data that you expect to be in a report does not appear: 

 Insufficient security permissions. If you don't have permission in Microsoft Dynamics CRM 

to view a record, it will not appear in the report.  

 Data is not entered. The person entering data may have left fields empty.  

 Data does not match the criteria for the report. Many reports include a default filter that 

displays only active records, or you may have selected criteria that don’t have any matching 

record. Try changing the report filter. More information:  Edit the default filter of a report 

 You may be viewing a cached copy of the report. By default, data in Microsoft Dynamics CRM 

reports is pulled from the database each time you run a report. However, your system 

administrator may have changed a report to run from the cache. If data you entered recently is 

not included in the report, you may have an older version of the report from the cache. To refresh 

the report, on the Report toolbar, click or tap the Refresh button .  

 You may not have permission to read records in a sub-report. If you do not have 

permission to read record types that are included in a sub-report, you will get an error 

message saying that the sub-report could not be displayed.  

 Your Microsoft Internet Explorer privacy settings may block required cookies. For chart 

reports, if instead of seeing the chart, you see a red letter X, your privacy settings may be 

blocking a cookie that is required for the chart control. To fix this problem, in your browser, 

enable cookies for the server that is running Reporting Services.  

 If you are offline, your local data groups may not include all the data. If you are using 

the report from Microsoft Dynamics CRM for Outlook while you are offline, you must have a 

local data group that includes all the data that will be in the report. More information:  

Example of going offline with CRM for Outlook 

Available reports 

 

Account Distribution report 

Account Overview report 

Account Summary report 

Activities report 

Campaign Activity Status report 

Campaign Comparison report 

Campaign Performance report 

Case Summary Table report 

Competitor Win Loss report 

Invoice Status report 

Invoices report 

https://technet.microsoft.com/library/dn531183.aspx
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Lead Source Effectiveness report 

Neglected Cases report 

Neglected Leads report 

Orders report 

Products by Account report 

Products by Contact report 

Progress Against Goals report 

Quotes report 

Sales History report 

Sales Pipeline report 

Service Activity Volume report 

Top knowledge base articles report 

User Summary report 

Neglected Accounts report 

Account Distribution report 

See which account generates the most revenue for your business. Then use the information to 

identify patterns – so that you leverage the information and apply it to accounts that are not so 

doing well. 

 This report is generated from revenue based on opportunities that have been won.  
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See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Account Overview report 

Get a one-page overview of everything that’s happening with an account. The report shows a 

profile of the account, contact information, and a summary of opportunities and case activities. 

  For opportunities, the report shows charts with active opportunities grouped by the 

probability of the opportunities turning into a sale and the state the opportunities are currently 

in. 

 For support cases, the report shows a chart with closed cases grouped by customer 

satisfaction level and also by the case status.  
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See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Account Summary report 

Use this report to see what has happened with an account. This report also shows what is 

scheduled to happen in the future. The report displays a chronological summary for an account, 

including sales and service activities, notes, and records. 

To view the Account Summary report for an account, open the account record. On the 

Account tab, in the Data group, click or tap Run Report, and then click or tap Account 

Summary. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Tip  
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Activities report 

Improve communication for future opportunities and provide better service to your customers. Get 

a quick view of all the activities associated with support cases and opportunities such as phone 

calls, tasks, emails, appointments, closed opportunities,  

and case resolution.  Use the information in this report to look at the details of each activity and 

identify patterns to make improvements in how you communicate with your customers.  

When you run the report, choose Show All to get a detail view of all the activity. Activities can be 

grouped by owner or activity type, or by the record the activity is associated to.  

 
 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Campaign Activity Status report 

Track the details of your campaign. Get a summary of each campaign activity, including planned 

and actual time limits, parent campaign details, and definition status.  

When you run the report, it only displays campaigns with activities or notes that were created 

within the dates that you specified in the report. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 
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Campaign Comparison report 

Find out which of your marketing campaign was more successful.  

Use this report to compare the cost effectiveness and number of responses of two different 

campaigns.  

When you run the report, select the two campaigns that you want to compare. 

 
 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Campaign Performance report 

Find out what’s working and what you need to change in your campaigns. Use the campaign 

performance report to track the progress and status of your campaigns. The report provides a 

detailed view of all the dates, targets, definitions, responses, and financial returns from each 

campaign that has been modified – so you can quickly see the progress of your campaigns. 

See Also 
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Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Case Summary Table report 

 Lower support calls and improve your product or service.  

This report tracks service cases and tells you why customers are contacting support.  

For example, if your company sells cell phones and you find out that majority of  

the support calls are due to a faulty phone battery, you can take this information 

 to the team that makes the phone battery so they can fix the issue.  

This will improve your product and drive support calls down.   

The report provides a list of cases that you can group by 

 owner, customer, status reason, product, priority, subject, origin, case type, satisfaction, service 

level, or severity.  

 

 

 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Competitor Win Loss report 

Use this report to compare how your sales team performs against your competitors. The report 

displays opportunities that have competitors associated, with information on open, closed, won, 

and lost opportunities. 

The report displays only opportunities that have competitors associated that you have permission 

to see, in the country/region and time period that you specify. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Invoice Status report 

Use this report to view your accounts receivable for your active accounts. The chart displays the 

number of invoices grouped by status with the total amount of invoices in each status. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 
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Customizing and Organizing Reports 

Invoices report 

Get a quick overview of an invoice and its line items to see what was ordered. You can also use 

this report to print invoices. 

When you run the invoice report, it returns a report of all invoices. You can also select a specific 

record to get an invoice report for that selected record.  

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Lead Source Effectiveness report 

Find out which type of lead is most beneficial in helping you grow your business. This report helps 

you compare how effective your lead sources are at generating quality opportunities.  

The report lists the percentage of qualified leads, and leads that generate revenue for each lead 

category. 

 
 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Neglected Cases report 

Improve your service team’s KPIs and get your cases closed. Quickly identify and take action on 

cases that haven’t been updated recently. The report also shows the name of the service agent 

assigned to the case - use this information to follow-up with your team and to start resolving these 

cases.   

When you run the report, choose the number of days that cases haven’t been updated. The 

report shows a list of open cases that have no changes to activities, including scheduled activities 

and notes. 
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See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Neglected Leads report 

Keep your sales teams on the alert for possible business opportunities.  

Use this report to have your sales team follow-up on leads that they haven’t contacted in a while.  

When you run the report, specify the number of days that leads have been neglected.  

The report displays a chart of active leads that have had no activities or notes.  

Click Show All to drill down into the report. 

 
 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Orders report 

Use this report see an order and its line items. You can also use this report to print orders. 

If you run this report from a list without selecting any records, the report generates a customer-

ready order for each active order record in the system. If you run this report from within a specific 

record, the report generates a customer-ready order only for the record you were working with. 

See Also 
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Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Products by Account report 

Use this report to see which products are used by an account. For each account, the report lists 

the products associated with the account. 

By default, this report displays only line items for orders that don't have a status of Canceled, and 

line items for opportunities that have a status of Won.  

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Products by Contact report 

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.   

The report shows orders that have not been cancelled and opportunities that you have won. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Progress Against Goals report 

The information in this report helps you see how your sales team is performing against their sales 

goals. This report displays a chart of your target goals and your actual goals.  

The report is generated from data that is rolled up to the goals at a set time. If the data is 

not up-to-date, then wait until the next time the data is rolled up. For more information, 

contact your CRM admin. 

 

 

 

 

 

 

Note  
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See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Quotes report 

Use this report to view quotes and its line items. You can also use this report to print quotes. 

When you run this, results will show a report of all quotes in the system. You can select a specific 

record to get a report for that selected record. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Sales History report 

Use this report to see how your sales reps have performed and how much revenue they have 

generated for your business. See which sales reps closed the most sales – so you can award 
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them for their great work. And also see which opportunities were lost so you can help your sales 

team do better next time.  

The report uses data from closed opportunities that were either won or lost and then calculates 

earned and lost revenue. 

 
 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Sales Pipeline report 

Use the information in this report to forecast future revenue and set goals for your sales team.  

The report helps you see expected potential sales opportunities. The report displays a chart 

 of potential sales grouped by user, sales territory, customer territory, date, products, rating, or 

sales stage.  

When you run the report, on the chart, click Show All to get a detail view of the report.  
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See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Service Activity Volume report 

Use this report to review the patterns in service activity volume.  

The report displays either the duration of or number of service activities grouped by services, 

resources, time periods, and additional criteria. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Top knowledge base articles report 

The information in the report helps you identify which issues your customers are asking about so 

that you can address those problems and improve your product or service. When a service agent 

receives a support call or email, the agent searches the knowledge base to see if there is a KB 

article that can answer the customer’s question. This report tells you which of those KB articles 

are being used the most.  
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You can change the Group by filter to see knowledge base articles grouped by subject of the 

article or case, or by the product associated with the case. 

 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

eBook: Use KB articles to help your customers 

User Summary report 

Keep user information up to date by running a User Summary report.  

Get a list of all your users, including their contact information and security role in Microsoft 

Dynamics CRM.   

 

See Also 

Run a report 

Create, edit, or copy a report using the Report Wizard 

Troubleshoot problems with data not displaying in a report 

Neglected Accounts report 

Use this report to find accounts that haven’t been contacted recently so that you can follow up on 

those accounts.  

When you run the report, select how many days the account has been neglected for. The report 

shows accounts that have no recent activity, including notes. 

See Also 

Run a report 

Troubleshoot problems with data not displaying in a report 

Customizing and Organizing Reports 

Charts and dashboards 

 

Create or edit a chart 

Drill down in a chart 

View relevant and trending information with Office Delve 

http://go.microsoft.com/fwlink/p/?LinkId=394983
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Create or edit a chart 

Present large quantities of data in your organization in a more insightful and graphical way by 

creating useful charts in Microsoft Dynamics CRM. 

Create a chart 

1. Go to your work area. (How do I get there?) 

2. Open the chart designer: 

If using the CRM web application: 

a. On the right side, choose the Charts pane. 

b. In the Charts area, choose New Chart +. 

 

 

If using CRM for Outlook: 

 On the Charts tab, in the Charts group, choose New Chart. 

3. Define the properties of the chart. 

Specify what you want to display on the chart 

a. In the first drop-down box under Legend Entries (Series), select a field to 

display on the series axis. 

b. In the Aggregate drop-down box, choose the option by which you want to 

group the field you selected in Legend Entries (Series). 

For non-numeric fields, you can select only Count: All or Count: Non-

empty. For numeric fields, you can select one of the following aggregation 

options: Count: All, Count: Non-empty, Avg, Max, Min, or Sum. 

NULL values are not considered for computing minimum, maximum, and 

average of data. However, zeros (0) are considered. For example, if you 

have the following data: 
 

Records Potential Customer Established Value 

Opportunity 1 Account 1 Null 

Opportunity 2 Account 1 250 

Opportunity 3 Account 2 0 

Opportunity 4 Account 2 250 

 

The average for Account 1 is 250 because the NULL value wasn’t used. The 

average for Account 2 is 125 because the zero was used. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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c. To create a chart with multiple series, choose the Add a series icon , select 

another field to display on the series axis, and then select an aggregate option for 

that series. 

d. To change the chart type for a series, select the series, choose the Current 

chart type icon for that series, and then select a chart type. 

e. To stack items in a chart, choose the chart type, and then choose Stacked or 

100% Stacked. You can stack items only in a bar, column, or an area chart. 

f. To display only top items on the chart, choose the Top/Bottom Rules icon > 

Top X Rule icon, > Top 3 or Top 5, or Custom to specify a different number. 

For example, to display only the top three opportunities grouped by potential 

customers, choose the Top/Bottom Rules icon > Top X Rule icon > 3. 

-OR- 

To display only the bottom items on the chart, choose the Top/Bottom 

Rules icon > Bottom X Rule icon > choose Bottom 3 or Bottom 5, or 

Custom to specify a different number. 

g. From the list under Horizontal (Category), select the field to display on the 

category axis. 

h. To create a comparison chart with multiple categories, choose the Add a category 

icon , and then select another field to display on the category axis. 

You can add only two category items and one series item to a comparison 

chart. 

i. For fields that are of the datetime type, choose the option by which you want 

to group the field you selected as the category. 

 

The chart is named based on the fields you chose for the series and category axes. 

4. To specify a different name for the chart, choose the chart name to edit it. 

5. To save the chart, in the chart designer, choose Save. 

The chart obtains the data from the view that is selected for a record type. A chart is automatically 

updated every time that you change the view in the list of records. However, if the chart has been 

idle for some time, we recommend that you choose Refresh Chart on the Charts tab, so that the 

chart and the list of records show the synchronized data. 

Edit a chart 

1. Go to your work area. (How do I get there?) 

2. Open the chart designer: 

If using the CRM web application: 

a. On the right side, choose the Charts pane. 

b. In the chart area, choose the chart list, choose the chart you want to edit, and then 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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choose the Edit Chart button. 

 

 

If using CRM for Outlook: 

a. On the Charts tab, in the Layout group, choose Chart Pane > Right or Top. 

b. In the chart area, choose the chart list, choose the chart you want to edit, and then in 

the Charts group, choose Edit Chart. 

3. Modify the properties of the chart. For details, see Step 3 in the Create a chart section. 

See Also 

Manage User Dashboards 

Drill down in a chart 

Drill down in a chart 

You can drill down into a segment on a chart to filter chart data for that segment. For example, 

you can drill down on one segment of a sales pipeline chart. You can also change the chart type 

as you drill down. 

 

1. Open the list of records you want to chart, and then click the chart bar to the right of or 

above the list of records. 

2. Follow the steps for the app you’re using. 

If using the CRM web application 

a. Click the Charts area. 

 

If using CRM for Outlook 

a. In the ribbon, click Chart Pane, and then select where you want the chart to 

be displayed. 

 

 

3. In the chart area, click the arrow next to the chart name, and then click the name of a 

chart. 

4. Click the category area of the chart you want to drill down into. 

5. In the shortcut menu, click Select Field, and then click the field to group by. 

6. Click the button for a chart type. 
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7. Click OK. 

Note  

To go back to the previous chart, click Back. 

See Also 

Create or edit a chart 

View relevant and trending information with Office Delve 

Office Delve in CRM is a new way to find and discover relevant and trending documents across 

your organization. Delve searches across your company and uses Azure Machine Learning to 

provide a view of the documents you are most interested in based on who created, viewed, 

edited, or shared the documents. Delveis a new dashboard component that can be added to any 

user or system dashboard so you can view trending information from within CRM. 

 
 

View trending information important to you. 

To use Delve, the system administrator must first enable it. More information: Enable Office 

Delve. 

This feature requires that you have an Office 365 subscription or a subscription to an 

online service such as SharePoint Online or Exchange Online. For more information, see 

What is Office 365 and how does it relate to CRM Online? 

Add Delve to a dashboard 

You can add Delve to an existing dashboard or create a new dashboard and add it. 

New dashboard 

To add Delve to a new dashboard, follow these steps. 

Important  

https://technet.microsoft.com/library/4c8755d3-dd1e-480e-b077-88b45c787b92
https://technet.microsoft.com/library/4c8755d3-dd1e-480e-b077-88b45c787b92
https://technet.microsoft.com/library/mt169376.aspx
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1. On any dashboard page, click New. 

2. Choose a layout, and then click Create. 

3. Click DELVE, and then drag the DELVE component onto the dashboard and double-click it to 

set the properties. 

4. Add other web components as desired. 

5. Save the dashboard. 

Existing user dashboard 

To add Delve to an existing user-created dashboard, follow these steps. 

1. Open the user dashboard. 

2. Click Edit. 

3. Click DELVE, and then drag the DELVE component onto the dashboard and double-click it to 

set the properties. 

4. Save the dashboard. 

Existing system dashboard 

To add Delve to an existing system dashboard, follow these steps. 

Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

1. Click Settings > Customizations > Customize the System 

2. Under Components, click Dashboards. Select a dashboard and then double-click it to view 

the dashboard components. 

3. Click DELVE, and then drag the DELVE component onto the dashboard and double-click it to 

set the properties. 

4. Save the dashboard. 

Open Office Delve 

From any dashboard with the Delve web component installed, you can open Office Delve in a 

separate browser page. 

1. Open a dashboard with the Delve component installed. 

2. Double-click the Open Office Delve  icon. 

See Also 

Enable Office Delve 

What is Office Delve? 

How does Office Delve know what's relevant to me? 

Office Delve for Office 365 admins 

Create or edit a rollup query 

Use the rollup query to gather data about a given goal, including all its related goals, in one view.  

Note  

https://support.office.com/en-us/article/What-is-Office-Delve-1315665a-c6af-4409-a28d-49f8916878ca?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/How-does-Office-Delve-know-what-s-relevant-to-me-048d502e-80a7-4f77-ac5c-f9d81733c385?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/Office-Delve-for-Office-365-admins-54f87a42-15a4-44b4-9df0-d36287d9531b?ui=en-US&rs=en-US&ad=US
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1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Rollup Queries. How do I get there?  

 

3. To create a new rollup query, in the Records group, click New. 

-OR- 

To edit a rollup query, click Edit. 

4. Fill in your information. Use the handy tooltips as a guide. 

Name.  Enter a name between 1 and 50 characters. 

Entity Type. Select the record type. 

Owner. Click the Lookup icon, and select the user or team who will own this query. 

 

Note  

If you change this selection after you add your query criteria in the Query 

section, your query criteria will be deleted. 

5. In the Query section, add the criteria for your query. The criteria you can add depends on 

the record type. 

6. To see the results for the query, click View Records. 

7. Click Save, Save and Close, or, to create a new rollup query, Save and New. 

8. To view the data for a goal, on the nav bar, click Sales, and then click Goals.  

9. Select the goal you want, and then click More Commands  , and then click Recalculate. 

The values of the actuals are recalculated. You can see the recalculated values in the 

Percentage Achieved, Actual, and In-Progress columns. If you open the goal, under 

Actuals, you can see the Last Rolled Up Date. 

See Also 

Create or edit a goal 

Progress Against Goals report 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Drive more sales 

 

Nurture sales from lead to order 

Create or edit a lead 

Qualify a lead and convert it to an opportunity 

Create or edit an opportunity 

Create or edit a quote 

Create or edit an order 

Create or edit an invoice 

Close an opportunity as won or lost 

Nurture sales from lead to order 

 

The sales process in Microsoft Dynamics CRM can help you close more sales and achieve higher 

customer satisfaction. You can achieve more consistent sales interactions by following the sales 

process as it takes you through each stage, from creating a lead to closing the sale. You also end 

up with a more complete history, which you can refer to later on if you plan to work with your 

customer again in the future, or if your customer needs support. 

Your sales process begins with a lead—someone who is interested in the products or services 

you provide. Your leads might be automatically generated by Microsoft Dynamics Marketing, or 

they might come from other sources, such as website opt-in pages, email queries, or business 

cards you gather at trade shows. 
 

 Great job! You’ve got your 

lead…now what? If your lead 

isn’t already in CRM, start by 

creating your lead in the 

system. 

After you’ve determined that 

your lead is interested in your 

solution and has the appropriate 

purchasing power, qualify your 

lead. Qualifying a lead in CRM 

converts it to an opportunity. 

Create or edit a lead 

Qualify a lead and convert it 

to an opportunity 

 In this stage, you identify 

stakeholders, competitors, and 

Create or edit an opportunity 
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sales team members and come 

up with a proposed solution. 

 Now it’s time to present your 

proposal to your potential 

customer. 

Create or edit an opportunity 

Create or edit a quote 

 Did your opportunity accept or 

reject your proposal? Hopefully, 

congratulations are in order! 

Either way, at this stage you 

need to close your opportunity. 

This can include filling orders, 

preparing invoices, and sending 

follow-up messages, depending 

on how your organization 

handles the end game. 

Create or edit an order 

Create or edit an invoice 

Close an opportunity as won 

or lost 

 

  

  

Your CRM system might look different because it was customized. This walkthrough 

guides you through the basic sales process, but your organization might offer further 

training for your system. 

  

Create or edit a lead 

In Microsoft Dynamics CRM, you use leads to keep track of business prospects that you haven't 

yet qualified through your sales process. A lead can be someone you’ve never done business 

with before, or it could be an existing client. You might get leads from different sources, such as 

advertising, networking, or email campaigns. 

On this page: 

Create a lead 

Edit a lead 

Additional considerations 

Tips and tricks 

Typical next steps 

Create a lead 

1. Go to Sales > Leads. (How do I get there?) 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. Click New. 

3. In the Summary area of the Lead screen, type your lead’s company and contact information. 

4. In the Details area of the Lead screen, type information about your lead’s industry and 

preferred contact method. 

5. Add any notes and activities (for example, phone calls or emails) related to this lead. More 

information: Keep track of notes, tasks, calls, or email with activities 

6. Click the Save button on the bottom right of the screen. 

Edit a lead 

1. Go to Sales > Leads. (How do I get there?) 

2. Click the lead you want to edit. 

3. Add any extra details you have about your lead. 

4. Click the Save button on the bottom right of the screen. 

Additional considerations 

 Nurture your leads through a CRM marketing campaign. More information: Get started with 

CRM marketing 

 Automate your lead generation with coordinated marketing campaigns. More information: 

Microsoft Dynamics Marketing 

 Research leads through social media channels like LinkedIn and Twitter. More information: 

InsideView 

Tips and tricks 

Need a faster way to enter leads? Try one of these: 

 Quick create--Enter new contacts (or other data)--fast! 

 Import accounts, leads, or other data 

Typical next steps 

 Qualify a lead and convert it to an opportunity 

 Nurture sales from lead to order—learn about the sales process 

See Also 

Print leads, quotes, and other records 

Qualify a lead and convert it to an opportunity 

Does your lead have what you’re looking for—and vice versa? Once you’ve identified the 

timeframe, budget, purchase process, and decision makers for the sale, it’s time to qualify your 

lead. Qualifying a lead in Microsoft Dynamics CRM converts it to an opportunity. 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkID=393622
http://go.microsoft.com/fwlink/p/?LinkId=511655
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Ideally, your leads or prospects should have a need that you can provide a solution for, and have 

the budget and influence necessary for making the purchasing decision. In addition, you should 

be able to provide their solution within the time frame they need it. 

On this page:  

Qualify a single lead 

Qualify multiple leads 

Additional considerations 

Typical next steps 

Qualify a single lead 

1. Go to Sales > Leads. (How do I get there?) 

2. Select the lead you want to qualify. 

3. In the Qualify section of the sales process bar, type in all applicable information. 

4. Click Qualify at the top of the Lead screen. 

5. Click the Save button at the bottom right of the screen. 

Qualify multiple leads 

1. Go to Sales > Leads. (How do I get there?)  

2. Select the check box next to all leads that you want to qualify. 

3. Click Qualify at the top of the screen. 

Additional considerations 

 Nurture your leads through a CRM marketing campaign. More information: Get started with 

CRM marketing 

 Automate your lead qualification process with Microsoft Dynamics Marketing. More 

information: Microsoft Dynamics Marketing 

 Qualify leads faster with Insights  

Typical next steps 

 Create or edit an opportunity 

 Nurture sales from lead to order—learn about the sales process 

See Also 

Print leads, quotes, and other records 

Insights for Microsoft Dynamics CRM - powered by InsideView 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkID=393622
insights-for-microsoft-dynamics-crm-powered-by-insideview.aspx
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Create or edit an opportunity 

An opportunity is a lead who is now almost ready to buy—in other words, it’s a deal that you’re 

ready to win. 

At this point in the sales process, you’re most likely in either the Develop or Propose stage. 

More information: Nurture sales from lead to order 

On this page:  

Create an opportunity 

Edit an opportunity 

Additional considerations 

Tips and tricks 

Typical next steps 

Create an opportunity 

If you’re following the sales process from start to finish, you qualify a lead to turn it into an 

opportunity. More information: Nurture sales from lead to order 

If you want to create an opportunity without first creating a lead, do the following: 

1. Go to Sales > Opportunities. (How do I get there?) 

2. Choose New. 

3. In the Summary area of the Lead screen, type your lead’s company and contact information. 

4. In the Details area of the Lead screen, type information about your lead’s industry and 

preferred contact method. 

5. Add any notes and activities (for example, phone calls or emails) related to this lead. More 

information: Keep track of notes, tasks, calls, or email with activities 

6. To add stakeholders, in the Stakeholders area, choose +. 

7. To add sales team members, in the Sales Team area, choose +. 

8. To add competitors, in the Competitors area, choose +. 

9. To add products, in the Products area, choose +. 

10. To add a quote, in the Quotes area, choose +. More information: Create or edit a quote 

11. Choose the Save button on the bottom right of the screen. 

Edit an opportunity 

1. Go to Sales > Opportunities. (How do I get there?) 

2. Choose the opportunity you want to edit. 

3. Add any extra details you have about your lead. 

4. Choose the Save button on the bottom right of the screen. 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Additional considerations 

 A way that might help you increase your sales is to add all products that your customer might 

need. Your CRM system might offer product bundles or product families to make it easier for 

you to choose products for upsell and cross-sell. 

 Be sure to add all stakeholders for your project. A stakeholder is anyone who should 

participate in, review, or approve your proposed solution. 

 If other people in your organization are working on this sale, be sure to add them as sales 

team members. 

 Nurture your opportunities through a CRM marketing campaign. More information: Get 

started with CRM marketing 

Tips and tricks 

Need a faster way to enter opportunities? Try one of these: 

 Quick create--Enter new contacts (or other data)--fast! 

 Import accounts, leads, or other data 

 Qualify leads faster with Insights  

Typical next steps 

 Create or edit a quote 

 Nurture sales from lead to order—learn about the sales process 

See Also 

Run a report 

Use Bing Maps to view a location 

Assign a record to a user or team 

Stay up-to-date with customer news with the activity feed 

Print leads, quotes, and other records 

Insights for Microsoft Dynamics CRM - powered by InsideView 

Create or edit a quote 

One way you might increase your sales is to add all products that your customer might need to 

your quote. Your Microsoft Dynamics CRM system might offer product bundles or product 

families to make it easier for you to choose products for upsell and cross-sell. 

Most sales begin with a price quote, which eventually becomes an order. 

You’ll probably edit a quote multiple times as a sale progresses. Initially, you create a draft, and 

then you need to activate it when it’s ready to go to a customer.  

When the customer accepts the quote, you create an order. Otherwise, you close the quote as 

revised, canceled, or lost. 

insights-for-microsoft-dynamics-crm-powered-by-insideview.aspx
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On this page:  

Create a quote from an opportunity 

Create a quote 

Edit a quote 

Typical next steps 

Create a quote from an opportunity 

1. Go to Sales > Opportunities. (How do I get there?) 

2. Choose the opportunity you want to add a quote to. 

3. In the Quotes area of the Opportunity screen, choose +. 

4. To add products from your opportunity to your quote, click Get Products at the top of the 

Quote screen and choose OK. 

5. Type shipping and payment information in the Shipping Information area of the Quote 

screen. 

6. Type the billing and shipping addresses in the Addresses area of the Quote screen. 

7. Choose the Save button at the bottom right corner of the screen. 

8. When your quote is ready to send to your customer, choose Activate Quote at the top of the 

screen. 

Create a quote 

1. Go to Sales > Quotes. (How do I get there?) 

2. Choose New. 

3. Add your customer’s contact information. 

4. To add products from your opportunity to your quote, choose Get Products at the top of the 

Quote screen and choose OK. 

5. In the Shipping Information area, type shipping details. 

6. In the Addresses area, type shipping and billing addresses. 

7. Choose the Save button at the bottom right corner of the screen. 

8. When your quote is ready to send to your customer, choose Activate Quote at the top of the 

screen. 

Edit a quote 

1. Go to Sales > Quotes. (How do I get there?) 

2. Choose the quote you want to edit. 

3. Add or change any details about your quote. 

4. Choose the Save button at the bottom right corner of the screen. 

5. When your quote is ready to send to your customer, choose Activate Quote at the top of the 

screen. 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Typical next steps 

 Create or edit an order 

 Nurture sales from lead to order—learn about the sales process 

See Also 

Run a report 

Assign a record to a user or team 

Keep track of notes, tasks, calls, or email with activities 

Print leads, quotes, and other records 

Create or edit an order 

Congratulations! Your hard work nurturing your customer has paid off and they’re ready to place 

an order for your products or services. In Microsoft Dynamics CRM, an order can originate from a 

customer's acceptance of a quote, or you can place an order without an accepted quote, 

depending on the situation. 

One way that can help you increase your sales is to add all products that your customer might 

need to your order. Your CRM system might offer product bundles or product families to make it 

easier for you to choose products for upsell and cross-sell. If you’ve already prepared a quote for 

your customer, you can create an order from that quote. 

On this page: 

Create an order from a quote 

Create an order 

Edit an order 

Typical next steps 

Create an order from a quote 

Typically, you convert a quote that you have won into an order. Start with an active quote. Note 

that once a quote is accepted, you won’t be able to revise it. 

1. Go to Sales > Quotes. (How do I get there?) 

2. Select the quote you want to create an order from. 

3. Click Create Order at the top of the Quote screen. 

4. Add a description and indicate whether or not you want to close the opportunity in the Create 

Order window and click OK. 

5. To add products from your opportunity to your quote, click Get Products at the top of the 

screen, select your opportunity, and click OK. 

6. Click the Save button at the bottom right corner of the screen. 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Create an order 

You can create an order that is based on your communication with a customer, instead of an 

accepted quote. 

1.  Go to Sales > Orders. (How do I get there?) 

2. Click New. 

3. Add your customer’s contact information. 

4. To add products from your opportunity to your order, click Get Products at the top of the 

screen, select your opportunity, and click OK. 

You need to enter the tax amount when you add a product to a quote, order, or 

invoice. Microsoft Dynamics CRM does not automatically calculate tax for individual 

products. However, the total tax is calculated automatically based on the sum of the 

tax amounts for all of the individual products in a quote, order, or invoice. 

5. In the Shipping Information area, type shipping details. 

6. In the Addresses area, type shipping and billing addresses. 

7. Click the Save button at the bottom right corner of the screen. 

You close an order by either fulfilling the order or canceling the order. Products or 

services that are shipped are fulfilled. You should cancel orders for any products or 

services that are not shipped. 

You can’t update or change an order after it has been closed or if it has been partially or 

completely fulfilled. 

Edit an order 

1. Go to Sales > Orders. (How do I get there?) 

2. Select the order you want to edit. 

3. Add or change any details about your order. 

4. Click the Save button at the bottom right corner of the screen. 

Typical next steps 

 Create or edit an invoice 

 Nurture sales from lead to order—learn about the sales process 

See Also 

Print leads, quotes, and other records 

Create or edit an invoice 

When a customer places an order, you can create an invoice to bill them for the upcoming sale. 

Note  

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Typically, you convert an order into an invoice. However, you can also create an invoice that does 

not originate from an order. 

On this page: 

Create an invoice from an order 

Create an invoice 

Edit an invoice 

Typical next steps 

Create an invoice from an order 

1. Go to Sales > Orders. (How do I get there?) 

2. Choose the order you want to create an invoice from. 

3. Choose Create Invoice at the top of the screen. 

4. Review the contents of the invoice and make any additions or corrections before sending to 

your customer. 

Create an invoice 

1. Go to Sales > Invoices. (How do I get there?) 

2. Choose New. 

3. Add your customer’s contact information. 

4. Choose Save at the top left to create the invoice record. 

5. To add products from your opportunity to your order, choose Get Products at the top of the 

screen, select your opportunity, and click OK. 

6. To add information about a product on the invoice, in the Products area, choose the Add a 

Product button , and then choose one of the following options:  

Existing Product. A product created in the product catalog that is associated with a price list. 

Write-in Product. A product that is available but not a part of the product catalog. 

Get Products. Select products from a previously created opportunity. 

 

You need to enter the tax amount when you add a product to a quote, order, or invoice. 

Microsoft Dynamics CRM doesn’t automatically calculate tax for individual products. 

However, the total tax is calculated automatically based on the sum of the tax amounts for all 

of the individual products in a quote, order, or invoice. 

7. In the Shipping Information area, type shipping details. 

8. In the Addresses area, type shipping and billing addresses. 

9. Choose the Save button at the bottom right corner of the screen. 

You close an invoice either by canceling the invoice or setting the invoice status as paid. 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Edit an invoice 

1.  Go to Sales > Invoices. (How do I get there?) 

2. Choose the invoice you want to edit. 

3. Add or change any details about your invoice. 

4. Choose the Save button at the bottom right corner of the screen. 

Typical next steps 

 Close an opportunity as won or lost 

 Nurture sales from lead to order—learn about the sales process 

See Also 

Print leads, quotes, and other records 

Close an opportunity as won or lost 

If your customer has accepted your proposal, congratulations! Whether your customer accepted 

or declined your proposal, however, it’s now time to close that opportunity.  

1. Go to Sales > Opportunities. (How do I get there?) 

2. Choose the opportunity you want to edit. 

3. To close your opportunity as won, choose Close as Won at the top of the Opportunity 

screen. 

- OR - 

To close your opportunity as lost, choose Close as Lost at the top of the Opportunity 

screen. 

See Also 

Nurture sales from lead to order 

Print leads, quotes, and other records 

Provide great customer service 

 

Get started with service 

Set up service terms 

Set up and define rules for service 

Set up and define rules for service 

Work with cases 

Create and manage activities 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Manage queue items 

Use the Unified Service Desk 

Get started with service 

 

Key steps to get started with customer service 

Basics of service and service scheduling 

Get started with service management 

Configure the process flow for customer service 

Improve customer service with better automation and tracking 

Use articles in the knowledge base 

View, block, or deactivate a social profile 

Key steps to get started with customer service 

Customer service is an important part of your organization. To help you get started, we’ve created 

an easy to read top tasks list.  
 

Task Description Learn more 

Find support cases that 

are assigned to you 

 

See the support cases 

assigned to you along 

with other cases in the 

support queue. 

Find what's assigned to 

you in a queue 

Track your interaction 

with your customer 

Use the activities area in 

a support case to track 

interaction between you 

and the customer. 

Add a phone call, task, 

email, or appointment 

activity to a case or 

record 

Create and manage a 

support case 

Learn everything you 

need to know about 

working on a support 

case.  

 Create a case 

 Find a solution from 

similar cases 

 Edit or resolve a 

case 

 Reassign or add it 

Create and manage a 

case 

Quick ref card: For 

customer service reps 

eBook: Give create 

customer service 

Video: How to create, 

reactivate, and reassign 

a case (1:47) 

http://go.microsoft.com/fwlink/p/?LinkID=330911
http://go.microsoft.com/fwlink/p/?LinkID=330911
http://go.microsoft.com/fwlink/p/?LinkId=393634
http://go.microsoft.com/fwlink/p/?LinkId=393634
http://go.microsoft.com/fwlink/p/?LinkID=394984
http://go.microsoft.com/fwlink/p/?LinkID=394984
http://go.microsoft.com/fwlink/p/?LinkID=394984
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Task Description Learn more 

back to the support 

queue 

Find information in 

knowledge base articles  

Use the knowledge base 

to get answers to 

common questions, 

solutions to problems, 

and more. 

Use articles in the 

knowledge base 

eBook: Use KB articles 

to help your customers 

 Get reports on support 

trends 

View reports to manage 

your work and identify 

trends and issues.  

Case Summary Table 

report 

Neglected Cases report 

Top knowledge base 

articles report 

 

  

 

 

 

See Also 

eBook: What’s new in customer service 

Basics of service and service scheduling 

Avoid disruptions in service by making sure that your resources are scheduled optimally and 

efficiently. Learn the basics of getting started with managing services and service scheduling in 

Microsoft Dynamics CRM.  

Understand the service terminology 

 Service: A type of work, such as a maintenance activity, performed for a customer by one or 

more resources. Services are schedulable activities. 

 Resource: Users, facilities or equipment, or teams that can be scheduled and have work 

schedules. 

 Resource groups: Groups of resources that can be scheduled interchangeably. 

 Work hours: The hours that a resource is available for scheduling. 

 Site: The location of a resource. Use sites to make sure that the customer and the resource 

are in the same location. 

 Service activity: A schedulable appointment to provide a service to a customer. A service 

activity uses one or more resources to perform a service at a specific time and place. An 

appointment is a schedulable activity that does not use services and does not require a 

resource with work hours. 

http://go.microsoft.com/fwlink/p/?LinkId=394983
http://go.microsoft.com/fwlink/p/?LinkId=394983
http://go.microsoft.com/fwlink/p/?LinkID=393186
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 Scheduling rule: A set of criteria that specifies which personnel, equipment, facilities, or 

resource groups are required to perform a service, or how to select these resources, based 

on parameters like quantity and capacity. 

Select resources for service 

When you add a resource to a service, create a selection rule to determine how resources will be 

selected for service activities. 

You can create a simple rule that selects resources from a list, or a compound rule that selects a 

combination of resources, or a complex tree of selection rules that selects from groups of 

equivalent resources. 

More information:  Create a simple selection rule 

Capacity vs. effort—understand the difference 

You can set up services and resources in Microsoft Dynamics CRM to take into account different-

sized facilities or the experience levels of your users when a service is scheduled. This is known 

as capacity scheduling. Capacity is a relative unit that you define. For example, you could define 

capacity in a bicycle repair shop as the number of bikes the shop has room to accommodate at 

the same time. If a repair bay has room for four bike-repair stations, the repair bay can accept 

four bikes for repair or inspection at the same time. 

Capacity can also measure skill level. For example, a junior bike technician has the ability to 

perform one bike inspection per hour, and a senior technician has the ability to perform four bike 

inspections per hour. If two bikes must be inspected in one hour, it takes either two junior 

technicians, or one senior technician who can perform the inspections in half the time. 

When you add effort required into the selection rule, every time a user searches for an available 

service activity time, the selection rules inspect the resources for capacity available. If the 

resource is scheduled, then that resource's capacity is reduced by the effort required for the 

service. This is repeated every time that a service is scheduled requiring that resource, until the 

capacity is exhausted. 

Capacity is defined in the resource’s working hours. Effort required is defined in the service. You 

can think of capacity as "how much money you have" and effort required as "how much 

something costs." 

For example, the repair bay has a capacity of four. A bike repair requires an effort of one and a 

tandem bike repair requires an effort of two. The first time the repair bay is selected, its capacity 

is reduced to three for that time. The next service activity scheduled is for a tandem bike. This 

reduces the repair bay's capacity by two. The repair bay has the capacity of one left, which 

means it could accept another bike repair, but not a tandem bike repair. 

Add resources to existing services 

You can add as many resources as you want, and they can be a mix of individual users, facilities, 

equipment, and teams. More information:  Create or edit a service 
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Use resource groups 

Use resource groups to group users, facilities, and equipment as part of the selection rules for a 

service. You can add resources to a resource group from the service record. More information:  

Create or edit a resource group 

Test your service 

Before you start using a service, test it. Create a service activity with no criteria other than the 

service. You can use the results to confirm that the service is selecting correctly. The message 

bar will also display any problems with the search. 

1. Click  Microsoft Dynamics CRM > Service > Service Calendar. 

2. Click  Service Activity. This bypasses the scheduling form. 

3. Select the service to test. 

4. Click  Find Available Times. 

See Also 

Key steps to get started with customer service 

Create a service activity without checking for conflicts 

Schedule a service activity 

eBook: What’s new in customer service 

Get started with service management 

Easily set up and manage your customer service tasks from one place by using the Service 

Management page in Microsoft Dynamics CRM. Set up everything related to customer service, 

like defining parent-child case hierarchy, creating queues, routing rule sets, rule for automatic 

case creation, service level agreements (SLAs), entitlements, and customer service schedule.  

Use the links in this topic to learn more about each of these tasks. 

For Microsoft Dynamics CRM Online organizations, some features like service level 

agreements (SLAs), entitlements, and parent and child cases are available if you've 

applied product updates for CRM Online Spring ‘14 or later, or if you’ve installed the CRM 

Online 2015 Update or later. For on-premises CRM organizations, these features are 

available if you've installed CRM 2013 Service Pack 1 (on-premises) or later, or if you’ve 

updated to CRM 2015 or later.  Interested in getting this feature?    Find your CRM 

administrator or support person  

Case settings 

Create or edit a queue 

Define settings for parent and child cases 

Create rules to automatically route cases 

Automatically create a case from an email 

Important  

http://go.microsoft.com/fwlink/p/?LinkID=393186
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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Set up rules to automatically create or update records in CRM 

Service terms 

Define service level agreements (SLAs) 

Create an entitlement to define the support terms for a customer 

Set up a holiday schedule 

Create a customer service schedule and define the work hours 

Templates 

Set up entitlements quickly with templates 

Create templates for email 

Create templates for articles 

Create templates for contracts 

Service scheduling 

Set when your business is closed 

Create or edit a service 

Add facilities and equipment for service scheduling 

Create or edit a resource group 

Edit existing SharePoint site records 

See Also 

eBook: Give great customer service with CRM 

eBook: Use KB articles to help your customers 

Configure the process flow for customer service 

The process flow bar organizes tasks under various stages, which are used to easily lead you 

through the process of case resolution. The process flow bar also highlights the stages and tasks 

that you’ve already completed. You can configure the bar to add or update the stages, steps, and 

fields to suit your business needs. 

For more information about customizing business processes, see eBook: Customize a business 

process. 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions.    

Check your security role 

a. Follow the steps in View your user profile. 

To change stages, steps, and fields in the customer service process 

http://go.microsoft.com/fwlink/p/?LinkId=393634
http://go.microsoft.com/fwlink/p/?LinkId=394983
https://go.microsoft.com/fwlink/p/?LinkID=386368
https://go.microsoft.com/fwlink/p/?LinkID=386368


 

 
117 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. From the case form, click the More Commands  button, and then click Edit Process. 

3. To add a new stage, click + Insert stage under the stage where you want to add the new 

stage. You can add up to 30 stages, and each stage can contain up to 30 steps. 

4. Name the stage anything you like, and then add steps. To move the stage to where you 

want it to appear in the process, click the up and down arrows at the bottom of the form. 

5. To add a step within a stage, click + at the bottom of the Step Name column, name the 

step, and then move it to where you want it to appear in the list of steps using the up and 

down arrows at the bottom of the form. Then click the associated field in the Value 

column and select from the drop-down list. 

6. Click Save. 

See Also 

Create and manage a case 

Improve customer service with better automation and tracking 

Improve customer satisfaction by tracking and recording issues, maintaining service levels, and 

managing service terms through entitlements in Microsoft Dynamics CRM.  

Create queue and route cases 

You can create queues to sort incoming cases according to subject-matter expertise or product or 

services to ensure that a customer service representative (CSR) with the right experience gets 

each case. Use routing rules to automatically route cases that match certain criteria to queues. 

You can also route individual cases manually. More information: Set up queues to manage 

activities and cases 

Automatically create cases from email or social records 

Save your CSRs from having to manually create cases that come in from email or social records 

by setting up Microsoft Dynamics CRM to automatically create cases from multiple channels. You 

can create automatic case creation rules that convert incoming email or social posts targeted to 

specific queues. For cases that are created from email messages, you can also send a response 

to the customer with case details by using a default template. More information: Automatically 

create a case from an email 

Track service levels through SLAs 

Service level agreements (SLAs) let you clearly define the timelines in which your customer 

service or support team is expected to meet the key performance indicators (KPIs) for the service 

you provide to your customers. You can associate a customer service schedule to the SLA to 

make sure that your business hours are considered while tracking the SLA timelines. 
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Help your CSRs see in real time the remaining time or passed time for a KPI on the case records 

by adding a timer control to the case form.  

 More information: Define service level agreements (SLAs) 

Define service terms through entitlements 

Quickly determine what kind of support a customer is eligible for by defining and associating 

entitlements with customers. When a customer gets in touch with the support team, this 

information helps CSRs determine if the customer is eligible for support and whether a case 

should be created for the customer. You can create an entitlement based on the product that the 

customer has purchased. You can also have multiple entitlements for a customer. More 

information: Create an entitlement to define the support terms for a customer  

 Track service agreements and pricing details through contracts 

Find out if a customer has prepaid support for the products or services they’ve purchased by 

using contracts in Microsoft Dynamics CRM. Use contracts and contract lines to define:  

 Prices for the customer service of each product 

 Number of calls allowed or the total number of minutes that can be spent on customer issues 

 Duration for which the service will be valid 

More information: Define support terms for customers by using contracts 

Track customer issues through cases 

When a customer contacts your organization, a CSR opens a case and enters information about 

the customer and the customer's issue.  

CSRs can simplify tracking of cases by associating related cases as parent-child cases. For 

example, a customer reports an issue that needs coordination with other teams. You can create 

child cases to track the individual work items and assign the cases to the individuals. And, create 

a parent case to track the progress of the customer-reported case and any communication done 

with the customer. More information: Define settings for parent and child cases 

 

If the person who opens the case isn’t the one to resolve it, the case can be assigned to a queue 

or to another CSR. By logging activities and time spent on a case, a manager can track 

performance and productivity. Open and resolved cases can be searched. A resolved case can 

be reopened so that additional activities and time can be logged against it, if necessary. More 

information: Create and manage a case 

 

Share information in the knowledge base 

CSRs can share information, including common issues and the approved fixes, product sheets, 

and updates, in the form of searchable articles stored in the knowledge base. After a CSR finds 

the right article, the CSR can email the article directly to the customer and store it with the case 

for review later. More information: Use articles in the knowledge base 
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Create and schedule services 

Improve customer satisfaction by defining clearly what services you’ll provide to them, and 

efficiently and optimally scheduling these services. With scheduling, you can provide a service to 

your customers and ensure that the right combination of personnel, facilities, and equipment are 

available to perform the service. You can also track a customer's preferences for time of day, 

service, and personnel.  

More information: Create or edit a service, Basics of service and service scheduling 

Manage performance and productivity through reports and dashboards 

Reports are an efficient way to stay informed of customer service performance in your 

organization. With this information, you can create more precise schedules, forecast resource 

needs, and manage performance improvements. More information: Customize and organize 

reports 

Microsoft Dynamics CRM introduces new default dashboards for CSRs and customer service 

managers (CSMs). CSRs can use the dashboard to see their cases with details like:  

 Case priority 

 Cases close to running over their SLA 

 Average handling time 

CSMs can use the dashboard to see cases with each CSR (agent) or queue. The CSM can also 

get insight into whether the SLA for cases was met or not. 

See Also 

eBook: What’s new in customer service 

eBook: Give great customer service with CRM 

Use articles in the knowledge base 

Make critical knowledge available to everyone by capturing it in articles in Microsoft Dynamics 

CRM. Create a customized library for business information, product guides, data sheets, and 

other articles with timely and relevant information. 

An administrator sets up a subject tree to categorize articles based on your organization's unique 

needs. New articles can be based on templates that define the structure for individual articles, 

such as the question and answer sections in a FAQ. 

After your organization has some articles in Microsoft Dynamics CRM, you can link them to a 

case or even send them to customers in email.  

A typical knowledge management process consists of the following stages: 

Create and update articles 

Collaborate with colleagues while writing or editing your articles. Review suggestions, corrections, 

and additions in the comments on an article, and then update the article based on these 

comments. When you’re done, send your article to a manager for approval. When approved, it is 

http://go.microsoft.com/fwlink/p/?LinkID=393186
http://go.microsoft.com/fwlink/p/?LinkId=393634
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available in search results, to view, or to share with colleagues and customers after about 15 to 

20 minutes. 

1. Go to Service > Articles. (How do I get there?) 

2. To create a new article: Click +New. 

To edit an article, open the article from the list. 

3. If you are creating a new article, in the Select Template dialog box, select a language 

and template you want to use to create the article, and then click OK.  

Note  

If you need other templates, you can ask your system administrator or 

customizer. 

4. Type or modify information in the text boxes. 

Hovertips provide hints about what to enter. 

All articles are initially created in a Draft state. To publish the articles, a manager needs 

to approve these.  

5. In the Actions group, click Submit. 

Edit, reject, or approve an article 

To make sure the articles that people in your organization use are up to date, someone with 

manager privileges needs to approve any new or revised articles. Similarly, managers can 

remove unneeded articles. 

 To view or edit an unapproved article, on the nav bar, click Microsoft Dynamics CRM > 

Service > Articles, open the Unapproved Articles view, and then click the article. To add 

comments to the article, in the Actions group, click Add Comments. 

 To reject an article, open the article, and in the Actions group, click Reject. Rejected articles 

are returned to the Unapproved Articles view for revision. 

 To approve an article, in the list of unapproved articles, select the article, and then on the 

command bar, click APPROVE.  

When you approve an article, it is automatically published and available for viewing in the 

knowledge base in approximately 15 minutes. After an article is published, if you want to edit 

it, you must first unpublish it. 

Find an article 

Microsoft Dynamics CRM provides several ways to look for articles that people in your 

organization have created. You can search by using keywords, titles, or the text from a published 

article. If you know the exact article number, you can quickly open the article you need. But if you 

aren’t sure what text to use before you begin looking, you can also browse through articles by 

subject. 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Go to Service > Articles. (How do I get there?) 

2. In the Search box, type the keyword, and then click the Search button.  

3. To filter search results, click the Search Tool button, and then select one of the following: 

 Full-Text Search. Looks at all the published articles for the specified keyword. 

 Keyword Search. Compares the keyword you specified with alternate terminology 

assigned to an article to find articles. For example, an article about bicycles might 

use keywords like "bike" or "cycle." 

 Title Search. Looks at the title of all published articles for the keyword you specified. 

 Subject Search. Looks at the subject of all published articles for the keyword you 

specified. 

 Article Number Search. Looks for the number that is assigned to the article when it is 

published. 

 Subject: ‘None’. Looks for articles that have None selected as the subject.  

Select Exact Text to search for the exact words you enter in the Search for box, or select 

Use Like Words to search for similar words. For example, if you enter "run," the search 

will include "running" and "runs." 

See Also 

eBook: Use KB articles to help your customers 

View, block, or deactivate a social profile 

Track the high influencers and the customers for your business, and save them as contacts in 

Microsoft Dynamics CRM with their social profile information. You may want to get in touch with 

these resources later, for marketing or brand building purposes. 

With the social care sample, you can create a social profile and a corresponding contact 

automatically, every time you create a case. You can also create social profiles for the authors of 

the posts who have large number of followers or likes. These  social profiles can be viewed in the 

Services area. If a social profile exists for the author of the post, a new profile is not created. 

Every social profile has a corresponding contact in Microsoft Dynamics CRM. A contact can have 

several social profiles, but a social profile can’t have several contacts. 

The social profile data in Microsoft Dynamics CRM is read-only. You can only view, 

block, define a workflow, or change the owner of the record.   

View a social profile 

1. Go to Service > Social Profiles. (How do I get there?) 

 

The list of social profiles that are created in Microsoft Dynamics CRM appears.   

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=394983
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Note  

Social profiles aren’t available in Microsoft Dynamics CRM for Outlook with 

Offline Access. 

2. Double-click any social profile to see the complete details. 

The social profile form shows the name, profile link of the contact, and the cases 

associated with this social profile. You can also view the influencer score if it is included 

as part of the social feed. 

Block a social profile 

To make sure you receive only actionable social posts and avoid case creation for any 

unnecessary information, based on the social posts, you can block certain social profiles in 

Microsoft Dynamics CRM.  

1. Open the social profile you want to block. 

2. In the Blocked drop-down menu, select Yes.  

3. Click the Save button. 

Deactivate a social profile 

If you no longer work with a social profile, you can deactivate the profile temporarily. To do this, 

from the list of social profiles, select a profile, and click Deactivate on the command bar. 

You can reactivate the profile by selecting it and clicking Activate on the command bar. 

Set up service terms 

 

Define service level agreements (SLAs) 

Disable or enable Service Level Agreements (SLAs) for cases 

Create an entitlement to define the support terms for a customer 

Create a customer service schedule and define the work hours 

Use the workplace calendar 

Set up a holiday schedule 

Set when your business is closed 

Schedule time off 

Create or edit a service 

Create or edit a contract 

Define support terms for customers by using contracts 

Add facilities and equipment for service scheduling 
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Define service level agreements (SLAs) 

Define the level of service or support that your organization agrees to offer to a customer by using 

service level agreements (SLAs) in Microsoft Dynamics CRM. Include detailed items to define 

metrics or key performance indicators (KPIs) to attain the service level. KPIs help you get a timely 

warning on your team’s issues while providing support. 

You can associate an SLA with an entitlement so that when an entitlement is added to a case, the 

associated SLA is also applied. More information:   Create an entitlement to define the support 

terms for a customer 

Alternately, you can set up a default SLA for the organization. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

On this page: 

 Standard vs. enhanced SLAs: What’s the difference? 

 Create a standard SLA 

 Create an enhanced SLA 

 Set the SLA as default 

 Disable the SLA 

 How is the SLA applied? 

 Track SLA status and details 

Standard vs. enhanced SLAs: What’s the difference? 

Microsoft Dynamics CRM lets you create two types of SLAs: Standard and Enhanced. We 

recommend that you use enhanced SLAs, which have some additional capabilities that the 

standard SLAs don’t have. With an enhanced SLA, you can: 

 Pause an SLA when the case is on hold, so that the time the case is on hold isn’t considered 

in SLA calculations. 

 Add success actions to an SLA. For example, you may want to send communication 

internally or outside your organization when the SLA has succeeded. Success actions are 

initiated only when the success condition is met on time, not when it is breached. 

 Track SLA statuses and times right on the case form by default. These details are tracked 

through the SLA KPI Instance record type.  

Create a standard SLA 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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System Customizer security role or equivalent permissions. 

When you activate an SLA, a corresponding workflow is also created. Whatever action 

you do on the SLA, you must have permissions to perform the same action on workflows. 

The SLA is applied in context to the permissions that the owner of the SLA has. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Go to Service Level Agreements. 

4. To create a new SLA, on the command bar, click the New button. 

-OR- 

To edit an SLA, in the list of records, select the SLA, and on the command bar, click Edit. 

5. Fill in your information: 

 Name. 

 Applicable From. Select the case field that specifies the date and time from which 

the SLA items will be calculated. For example, if you click the  Created On field, the 

calculations for service level agreements will start from the time the case is created. 

 Business Hours. Select a customer service schedule record that defines your 

support organization’s business hours. This is useful in the SLA time-tracking 

calculations. If a business hours record (customer service schedule) isn’t selected, 

the work hours are considered as 24 x 7. 

 SLA Type. Select Standard. 

 Allow Pause and Resume. Select Do Not Allow. Because standard SLAs do not 

support pausing and resuming of SLAs, you can set this field to Allow only when 

you’re creating an enhanced SLA.  

 

6. Click Save. 

7. To add SLA details, in the SLA Details section, click the Add button . 

You add SLA details to define the key performance indicators (KPIs) or metrics for the 

service level agreement. You can define any KPI as per your organization’s 

requirements. For example, a KPI could be that all cases for standard customers must be 

resolved within five days of case creation.  

Define success criteria and the failure and warning actions that need to be taken when a 

service level metric isn’t met for a customer case.  

SLA KPIs are performance indicators that you’d like to track, for example First Response 

or Resolve By. SLA items refer to SLA KPIs based on specific conditions. You can add 

multiple SLA items and arrange them in the order that works for you. For any given KPI, 

only the first SLA item that matches the conditions in the Applicable When section is 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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applied. 

Note  

In Microsoft Dynamics CRM, SLA and SLA KPIs (SLA details) use the process 

(workflow) functionality. Although SLA KPIs use workflows, not all of the actions 

available in workflows are available for defining the failure and warning actions. 

The available actions are currently limited to Send Email, Create Record, 

Update Record, Assign Record, and Change Status. More information:  

TechNet: Create and edit processes 

8. Fill in the information in the New SLA Item form: 

 Name. Type a meaningful name. 

 Related Case Field. Select a field of DateTime type of the case record that this SLA 

item refers to. For example, if you are creating a KPI for sending the first response 

within a specified time, select the First Response By option from the drop-down box. 

If required, ask your system customizer to create new fields of type DateTime. 

When a case record is created or updated, in the case record this field is set to the 

date and time when the failure time will be reached for the respective SLA item. For 

example, select First Response By in Related Case Field, and set Failure After to 

2 hours from case creation. If the case is created at 09:00, the First Response By 

field in the case record will be set to 11:00, assuming the business hours are 24*7. 

Tip  

By default, there are four options available in the drop-down box. If you want 

to track other KPIs, ask your system customizer to create case fields of type 

date-time. 

 In the Applicable When section, define the conditions under which the KPI will be 

applicable. The condition can be based on case or related entity fields.  

For example, the conditions could be:  

 

 

Note  

If there are multiple clauses, and you don’t use And or OR grouping, by 

default the clauses will use the AND grouping. 

 In the Success Criteria section, specify the conditions to define when the KPI will be 

considered as met. For example, the conditions could be:  

 

 

 

Note  

Before you specify the SLA failure and warning actions, save the SLA item 

https://technet.microsoft.com/library/dn531144.aspx


 

 
126 

record.  

 Under SLA Item Failure, in the Failure After drop-down box, select when the SLA 

items will be considered as failed. For example, if you select 1 hour, the KPI will be 

considered as failed if the first response is not done within 1 hour of case creation. 1 

hour is calculated based on the value in date/time field that you select in the 

Applicable From field of the SLA record.  

 In the Failure Actions section, click Add Step and specify the actions that will be 

taken when the success criteria isn’t met and the case has exceeded the specified 

failure time. For example, to mark the case for escalation when the KPI has failed, 

click Add Step > Update Record. Then select Case, and click Set Properties. Now 

in the case record, change the value of the Is Escalated field, and close the case 

form. 

 Under SLA Item Warning, in the Warn After drop-down box, select when a warning 

is to be raised for the KPI nearing violation.  

 In the Warning Actions section, click Add Step and specify the actions to be taken 

when the KPI reaches the warning time. For example, to warn the case owner about 

the KPI nearing violation, click Add Step > Send Email. Then select Create New 

Message, and click Set Properties. Now in the email record, specify the email 

details, and close the email form. 

Note  

The time for failure and warning is calculated after considering the business 

hours selected in the SLA record. If a business hours record (customer 

service schedule) isn’t selected, the work hours are considered as 24 x 7. 

9. Click Save and Close. 

Important  

 The failure and warning actions run asynchronously and may not get triggered 

exactly at the failure or warning time. 

 If the failure or warning times are set to less than 1 hour, there can be a delay in the 

processing of failure or warning actions. 

 Make sure you author the SLAs in the best way suitable to your company’s needs. 

For example, in the SLA Applicable When conditions, avoid using case fields that 

are updated too frequently because it may lead to frequent SLA computation and 

impact performance. 

 

Create an enhanced SLA 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

When you activate an SLA, a corresponding workflow is also created. Whatever action 

you do on the SLA, you must have permissions to perform the same action on workflows. 
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The SLA is applied in context to the permissions that the owner of the SLA has. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Go to Service Level Agreements. 

4. To create a new SLA, click the New button. 

-OR- 

To edit an SLA, in the list of records, select the SLA, and on the command bar, click Edit. 

5. Fill in your information 

 Name 

 Applicable From. Select the case field that specifies the date and time from which 

the SLA items will be calculated. For example, if you select the  Created On field, the 

calculations for service level agreements will start from the time the case is created. 

 Business Hours. Select a customer service schedule record that defines your 

support organization’s business hours. This is useful in the SLA time-tracking 

calculations. If a business hours record (customer service schedule) isn’t selected, 

the work hours are considered as 24 x 7. 

 SLA Type. Select Enhanced. 

 Allow Pause and Resume. Select Allow if you want the SLA to pause during the 

time the case is on hold. You can set the case statuses that will be considered “on 

hold” in the Service tab of System Settings dialog box. More information:   System 

Settings dialog box - Service tab. You can set this field to Allow only when you’re 

creating an enhanced SLA. 

 

6. Click Save. 

7. To add SLA details, in the SLA Details section, click the Add button . 

8. Fill in your information in the SLA Item form: 

 Name. Type a meaningful name. 

 SLA KPI. Select the key performance indicator the SLA item is about. For example, if 

you are creating a KPI for sending the first response within a specified time, select 

the First Response By KPI option from the drop-down box.  

For example, select First Response By KPI in the SLA KPI field, and set Failure 

After to 2 hours from case creation. If the case is created at 09:00, the Failure Time 

field of the SLA KPI Instance record is set to 11:00 assuming the business hours are 

24*7.  

Tip  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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By default, there are two options available in the drop-down box. If you want 

to track other KPIs, for enhanced SLAs ask your system customizer to create 

new case fields (of type lookup) that refer to the SLA KPI Instance entity. 

 In the Applicable When section, define the conditions under which the KPI will be 

applicable. The condition can be based on case or related entity fields.  

For example, the conditions could be:  

 

 

 In the Success Criteria section, specify the conditions to define when the KPI will be 

considered as met. For example, the conditions could be:  

 

 

 

Note  

Before you specify the SLA failure and warning details, save the SLA item 

record.  

 In the Success Action section, click Add Step and specify the actions that you want 

CRM to take when the success criteria is met before the violation time. For example, 

click Add Step > Change Status. Then, in the first drop-down box, select Case, and 

in the next drop-down box, select Information Provided. This option is available only 

if you’re creating enhanced SLAs. 

 Under SLA Item Failure, in the Failure After drop-down box, select when the SLA 

items will be considered as failed. For example, if you select 1 hour, the KPI will be 

considered as failed if the first response is not done within 1 hour of case creation. 1 

hour is calculated based on the value in date/time field that you select in the 

Applicable From field of the SLA record.  

 In the Failure Actions section, click Add Step and specify the actions that will be 

taken when the success criteria are not met and the case has exceeded the specified 

failure time. For example, to mark the case for escalation when the KPI has failed, 

click Add Step > Update Record. Then select Case, and click Set Properties. Now 

in the case record, change the value of the Is Escalated field, and close the case 

form. 

 Under SLA Item Warning, in the Warn After drop-down box, select when a warning 

is to be raised for the KPI nearing violation.  

 In the Warning Actions section, click Add Step and specify the actions to be taken 

when the KPI reaches the warning time. For example, to warn the case owner about 

the KPI nearing violation, click Add Step > Send Email. Then select Create New 

Message, and click Set Properties. In the email record, specify the email details and 

close the email form. 

Note  

The time for failure and warning is calculated after considering the business 
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hours selected in the SLA record. If a business hours record (customer 

service schedule) isn’t selected, the work hours are considered as 24 x 7. 

Set the SLA as default 

Make an SLA a default one if you want it to apply to all the cases that don’t have an SLA applied 

through an entitlement. This is useful when a customer wants a service level agreement without 

an entitlement.  

To set an SLA as default, select an active SLA from the list, and click Set as Default on the 

command bar. 

You can only have one default SLA at a time.  

If you deactivate a default SLA, you must activate it again before resetting it as the 

default. 

Disable the SLA 

During maintenance activities or when you’re importing cases and you don’t want the SLAs to 

apply to the cases, you can disable SLAs for the organization. A system administrator can disable 

SLAs from the System Settings. More information:  System Settings dialog box - Service tab 

How is the SLA applied? 

When a case is created, the SLA is applied (default or through entitlement) and the related case 

field values are updated. When the case is modified and any of the case field values change, that 

is, when the fields that are added in the Applicable When conditions of the SLA change, the SLA 

is applied again. For example, if the priority of the case changes from Normal to High, and 

according to the SLA the first response should happen soon, the SLA is reapplied to make sure 

the KPIs are tracked based on the updated values. 

When the SLA is applied again, all the SLA items are evaluated based on the updated case fields 

and the failure or warning actions are initiated if the time has been exceeded. This happens even 

if the failure or warning actions were already initiated before the case was updated. To avoid this, 

you can request that your system customizer add a custom field to the case entity (to track if the 

failure/warning actions were already taken) and add it to the Applicable When condition so that 

the actions aren’t initiated multiple times. 

Apply SLA on demand 

With the enhancements made to SLAs, you can now apply SLAs to case records manually. It is 

also possible to automatically apply SLAs to cases based on your business logic (using workflows 

or custom plugins). 

For example, if your customers are spread across geographies, you can have multiple SLAs with 

different business hours and holiday schedules for different geographies. You can set-up 

business logic to apply SLAs on case records based on the region of the customer to make sure 

that the SLA time calculation happens based on the correct geography.  

Note  
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To create workflows so SLAs are automatically applied, talk to your customer service managers, 

administrator, or customizer. More information: TechNet: Workflow processes 

To apply SLAs on-demand manually, choose the SLA in the SLA field. This field is not available 

by default on the case form. Ask your system administrator to add the field on the case form. 

Track SLA status and details 

You or the CSR working on the case can see the SLA details right on the case form.  

The following table explains what happens when a standard or enhanced SLA applies to a case 

form: 
 

Case form with standard SLA applied Case form with enhanced SLA applied 

Only the failure time is tracked and saved on 

the case record.  

You can request the system administrator or 

customizer to add a timer to the case form. The 

timer shows the time remaining to meet the 

SLA or the time elapsed since the SLA failed. 

More information:   Add a timer control to the 

Case form to track time against an SLA 

When an enhanced SLA is applied to a case, a 

related SLA KPI Instance record is created for 

each SLA KPI that is tracked for that case. In 

the Enhanced SLA Details section of the case 

record, you’ll see a timer and also the SLA KPI 

instances for the case with their statuses and 

failure and warning time. 

When a service rep puts a case on hold, the 

status of the SLA KPI Instance is set to 

Paused. You can see the time for which a case 

was on hold and the last time the case was put 

on hold. These details are not available on the 

case form by default, but your system 

customizer can add these fields on the case 

form for you. The on hold time is the time for 

which the case was set to a status that you 

defined as On-Hold statuses in the System 

settings dialog box. More information:   System 

Settings dialog box - Service tab 

When the service rep resumes a case, the 

status of the SLA KPI Instance record is 

updated. The following details are updated in 

the record if the SLA isn’t violated:  

 Failure time  

 Warning time 

 Total time the case is on hold 

If the service rep puts the case on hold after the 

warning time, then the warning time isn’t 

updated when the case is resumed. 

 

https://technet.microsoft.com/library/dn531067.aspx
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See Also 

Create a customer service schedule and define the work hours 

Create an entitlement to define the support terms for a customer 

Automatically create a case from an email 

Create rules to automatically route cases 

Create and manage a case 

Disable or enable Service Level Agreements (SLAs) for cases 

SLAs include the metrics or key performance indicators (KPIs) required for an agreed-upon 

service level.  

SLAs are enabled by default. You can enable or disable them for cases in your organization. For 

example, you might want to disable SLAs during maintenance activities or when you’re importing 

cases and you don’t want the SLAs to apply to the cases. If you disable an SLA, you can still 

create or change SLA records. However, SLAs won’t be applied to case records. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

Disable or enable SLAs 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Click System Settings. 

4. On the General tab, under Disable SLAs, select Yes to disable SLAs. To enable SLAs, 

select No.  

5. Click OK. 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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See Also 

Define service level agreements (SLAs) 

Create an entitlement to define the support terms for a customer 

Create an entitlement to define the support terms for a customer 

Define what kind of support your customers are eligible for by creating entitlements in Microsoft 

Dynamics CRM. With entitlements, you specify the support term based on number of hours or 

number of cases. The customer’s support level can vary based on the product or service that the 

customer has purchased. Customers who’ve purchased different products can be entitled to 

different support levels. This information helps the customer support agents verify what the 

customers are eligible for and create cases for them. accordingly  

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

Create an entitlement 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Choose Entitlements. 

4. To create a new entitlement from a template, click + New > From Template. In the 

Select Template dialog box, click the entitlement template, and click Select. 

To create a new entitlement from scratch, click + New > Blank Entitlement. 

-OR- 

To edit an entitlement, in the list of records, click the entitlement, and then on the 

command bar, click Edit. 

5. Fill in your information. Use the handy tooltips as a guide. 

 Name. Give the entitlement a meaningful name. 

 Primary Customer. Choose the customer you’re creating this entitlement for. 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 Start Date. Choose the date from which the customer will be entitled for support. 

 End Date. Choose the date after which the customer will no longer be entitled for 

support. 

 Restrict based on entitlement terms. To make sure no cases are created when the 

entitlement term is over, click Yes. When you choose Yes, a customer service agent 

won’t be able to create a case when Remaining Terms is fewer than zero OR when 

the term remaining for a channel is less than zero. 

 SLA. Choose a service level agreement (SLA) record to associate the service levels 

or key performance indicators for the support you’re providing with this entitlement. 

 

Under Entitlement Terms, specify the term details for the entitlement:  

 Allocation Type. Choose whether the entitlement is for number of hours or number 

of cases. 

 Decrease Remaining On. Choose whether to decrease the remaining term on case 

creation or resolution. 

If you decrease the remaining term based on case creation: 

 Creating or updating a case with the associated entitlement decreases 

entitlement terms 

 Canceling a case with the associated entitlement increases entitlement terms 

 Reactivating a canceled case with the associated entitlement decreases the 

entitlement terms 

If you decrease the remaining term based on case resolution: 

 Resolving a case with the associated entitlement decreases the entitlement 

terms 

 Reactivating a resolved case with the associated entitlement increases the 

entitlement terms. 

 Total Term. Specify the total amount of support the customer is entitled for with 

respect to the allocation type. For example, if the allocation type is number of cases 

and you specify 100 in Total Term, the customer is entitled for support up to 100 

cases. 

 The Remaining Term shows the total number of hours or cases remaining for the 

customer’s entitlement. The value decrements every time a case is created or 

resolved (depending on what you select in Decrease Remaining On) against the 

entitlement. 

6. Click Save. 

Add an entitlement channel term 

The Entitlement Channel section specifies the support channel through which the customer can 

reach the organization and seek support.  

Use this section to define the channels your customers are entitled to, and track the customer 

support term for each channel. For example, you can add phone and email as the channels 

through which you’ll offer support. If you want to restrict support through the phone channel to 80 
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hours and email to 20 hours, create individual entitlement channel records and add their total 

terms. 

You must save the entitlement record before you can add entitlement channels to an 

entitlement. 

1. In the Entitlement Channel section, click +. 

2. Specify the total terms that you want to allot to the particular channel. 

The remaining term is auto-calculated and shows the total number of hours or cases 

remaining for the customer’s entitlement. 

Associate a product with the entitlement 

If you want the entitlement to apply to a specific product for a customer, associate the product to 

the entitlement.  

If you don't add a product, the customer will be entitled to support for all the products. 

1. While in the entitlement record, in the Products section, click +. 

2. In the Search box, type the first few letters of the name of the product that you want to 

associate with the entitlement. 

If a product isn’t available, click + New to create a new one. 

Associate a customer contact with the entitlement 

To let only certain contacts of a customer claim the entitlement for a specific product, associate 

the contacts with the entitlement. 

If you don’t add a contact, all the contacts for the specified primary customer will be 

entitled to support. 

1. While in the entitlement record, in the Contacts section, click +. 

2. In the Search box, type the first few letters of the contact that you want to associate with 

the entitlement. This contact record must belong to the account or contact specified in the 

Customer field. 

If a contact isn’t available, click + New to create a new contact record. 

 

Note  

 

Note  

 

Note  
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All active entitlements for a customer appear in the Active Entitlements section of the customer 

record. 

Activate or deactivate an entitlement 

Before you can start applying an entitlement to a case, you must activate it. 

1. While in the entitlement record, on the command bar, click Activate. 

2. In the Confirm Activation dialog box, click Activate. 

Note  

If the start and end date of the entitlement fall in the future, the status of the 

entitlement is set to Waiting. On the start date, the status automatically changes 

to Active. If the end date is in the past, the entitlement is set to Expired.  

When an entitlement is active, you can’t edit it. To deactivate an entitlement so you can edit it, on 

the command bar, click Deactivate. 

Set as default entitlement 

If you’re on Microsoft Dynamics CRM Online 2015 Update 1 or later, you can activate the 

entitlement and then set it as the default entitlement for a customer. The entitlement terms from 

the associated entitlement are automatically decremented. However, if you don’t want the 

entitlement terms to be decremented for a case, click Do not decrement entitlement terms on 

the command bar. 

1. On the command bar, click Set As Default. 

2. In the Confirm set default dialog box, click OK. 

Now the default entitlement will automatically be applied when a case is created or when a 

case is updated depending on what you selected for default entitlements in the system 

settings area. For more information, see the “Automatically apply entitlement” section in step 

4 here, System Settings dialog box - Service tab.  

Associate entitlements to cases 

In a case record, in the Entitlement field, click the Lookup button, and select an entitlement. The 

inline lookup shows only the active entitlement for the customer of the case. 

The Entitlements section in the case record lists all the active entitlements for the customer. More 

information:  Create and manage a case 

Cancel an entitlement 

If the entitlement is no longer valid, you can cancel it. To cancel an active or waiting entitlement, 

open the entitlement, and on the command bar, click Cancel. 
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Renew an entitlement 

To renew a canceled or expired entitlement, open the entitlement, and then on the command bar, 

click Renew.  

The current entitlement will be set to Closed and a new entitlement will be created.  

The start date of this new entitlement is set to the current date and the end date is set to the 

current date plus the number of days between the end date and start date. The data in other 

fields is copied from the old entitlement. 

See Also 

Define service level agreements (SLAs) 

Set up entitlements quickly with templates 

Create and manage a case 

Create a customer service schedule and define the work hours 

To define when your service or support team is available for providing support to customers, 

create a customer service schedule in Microsoft Dynamics CRM. A customer service schedule 

determines the business hours for each day in a week and also the weekly off. Microsoft 

Dynamics CRM uses these details for time tracking of service level agreements (SLAs).  

For SLA time tracking, make sure you add a holiday schedule to the customer service schedule, 

and associate this customer service schedule to the SLA record. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

Create a customer service schedule 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Click Customer Service Schedule. 

4. To create a new customer service schedule, click + New. 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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-OR- 

To edit a schedule that you already have, in the list of records, select the schedule, and 

on the command bar, click Edit. 

5. In the Create Customer Service Schedule dialog box, in the Name box, type a 

meaningful name for the schedule, like “APAC Customer Schedule”, and click Create. 

6. In the Weekly Schedule dialog box, under Set the recurring weekly schedule section, 

follow these steps:  

 

a. For work hours, select one of these options: 

 Are the same each day. The schedule is the same for every day of the week. 

After you select this option, to select the days of the week that the customer 

support is available, click Set Work Hours. 

To set the work hours for the days, click Set Work Hours. For more information, see 

the Define work hours for the customer service schedule section in this topic.  

 Vary by day. The new schedule is different for one or more days of the week. 

After you select this option, select the days of the week that the customer support 

is available, and also specify the work hours for each day. 

 24 x 7 support. The customer support is available 24 hours a day, and all days a 

week. 

b. For Work Days, select the check box for each day that the customer support 

resources will be available and working. 

c. For Holiday Schedule, select Observe to specify when your service organization will 

be closed. 

If you selected Observe, select a holiday schedule from the lookup box. More 

information:  Set up a holiday schedule 

7. Under Select the time zone, in the Time Zone drop-down box, select the time zone in 

which your customer support resources will work.  

8. Click Save and Close. 

Define the work hours for the schedule 

In the Set Work Hours dialog box, complete the following fields, and then click OK: 

 Start 

Select the time the work day starts. 

 End 

Select the time the work day ends. 

To add a break in the work hours, like a lunch break, click Add Break, and then select the start 

and end time of the break. 

See Also 

Set up a holiday schedule 
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Define service level agreements (SLAs) 

Create an entitlement to define the support terms for a customer 

Use the workplace calendar 

Use the calendar to view appointments and service activities you need to participate in. 

 

1. Go to Marketing > Calendar. (How do I get there?) 

2. On the calendar, change the view by doing any of the following: 

 To change the calendar view, under Calendar Views, click one of the views: 

 Month. Shows a monthly calendar. 

 Week. Shows a weekly calendar. 

 Day. Shows a daily calendar. 

 To view a summary of an appointment, on the calendar, place the cursor over the 

appointment.  

 To view or edit the details of an appointment, on the calendar, click the appointment 

link. The appointment form opens. 

3. To change the dates on the calendar, on the calendar control, click the arrows to see 

different months, or click a specific date. 

4. To view today's appointments and service activities, on the calendar control, click Today. 

The calendar displays the hourly list for today. 

The calendar shows canceled and completed appointments and service activities. To 

remove an appointment or service activity from the calendar, delete the record. 

You can create an appointment or service activity from a normal calendar as well as a service 

calendar. More information: Create or edit an appointment,  

See Also 

Create a service activity without checking for conflicts 

Schedule a service activity 

Set up a holiday schedule 

Avoid having your service level agreements (SLAs) affected when your service organization is 

closed by creating a holiday schedule and adding it to your service calendar.  

For example, if your service organization has an SLA to reply to email cases within two business 

days, you can create a holiday schedule and add it to your service calendar. Then, if a customer 

submits an email case on that holiday, your SLA is clear and is not affected by the holiday 

closure.  

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

 Follow the steps in View your user profile.  Don’t have the correct permissions? 

Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Click Holiday Schedule. 

4. Click +New and in the Create Holiday Schedule dialog box, enter a name and 

description for the holiday, and then click Create.  

5. In the list of holidays, click the holiday you created. 

6. When the holiday is open, click New to add the holiday to your customer service 

calendar. 

7. In the Add a Holiday dialog box, specify the name and select the time of the holiday, and 

then click OK. 

The holiday is created and associated with your customer service calendar. After the 

customer service schedule is associated to an SLA,  then your SLA during business hours is 

not affected.  More information:  Define service level agreements (SLAs) 

See Also 

Create a customer service schedule and define the work hours 

Get started with service management 

Set when your business is closed 

Prevent scheduling resources on holidays and other nonworking days by defining business 

closures in Microsoft Dynamics CRM. You can set both the days and times that your organization 

will be closed. 

 

1. Make sure you have the Schedule Manager Security role or equivalent permissions to 

Important  

 

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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update the business closures. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Click Business Closure. 

4. To create a new business closure, on the command bar, click New.  

-OR- 

To edit an existing business closure record, open it from the list. 

5. In the Schedule a Business Closure dialog box, type or modify information in the text 

boxes:  

a. In the Name box, type a name that describes the purpose of the closure. 

The first 12 characters of the name appear on each day of the closure on the 

calendar view of the affected resource's Work Hours. 

b. In the Start Time and End Time boxes, enter the start and end date for the closure. 

c. If you want to enter duration instead of an end time, select the length of the closure in 

the Duration box. Microsoft Dynamics CRM automatically calculates the end time for 

you. 

d. If the closure is an all-day event, select the All Day Event check box. Microsoft 

Dynamics CRM automatically enters the duration of 1 day. 

If you want to enter a specific time period, clear the All Day Event check box. You 

can then specify the hours during which your organization will be closed. 

6. To save this business closure, click OK. 

See Also 

Set work hours for a resource 

Set up a holiday schedule 

Create a customer service schedule and define the work hours 

Schedule time off 

You can schedule a period of time in the middle of a schedule when a resource is not available to 

be scheduled for a service activity. For a user, this could be a sick day or vacation. For a facility 

or equipment, this could be an equipment failure. 

More information on scheduling a resource for business closure or holiday: Set or change work 

hours for a user, facility, or equipment. 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Business Management. (How do I get there?) 

3. Choose Facilities/Equipment. 

4. In the list, open the resource you want to modify. 

5. Under Common, click Work Hours. 

6. On the Monthly View tab, select a date on the calendar. 

7. On the Actions toolbar, click Set Up > Time Off, and then in the Schedule Time Off 

dialog box, enter the following details: 

 Reason. Type a short explanation for the resource’s absence. 

 All Day Event. Select this check box if the resource is unavailable for the entire day 

(midnight to midnight) for all of the days. 

 Start Time and End Time. If you have not selected the All Day Event check box, 

you can set specific start and end times. When the end date is reached, the previous 

schedule continues. 

 Duration. If you don’t want to calculate the end date, select the number of days the 

resource is unavailable.  

 Time Zone. If the resource is in a different time zone, select the time zone. Microsoft 

Dynamics CRM automatically adjusts the times on the calendars. 

8. Click OK. 

In the working hours calendar, affected days are marked with a red block. In the Service 

calendar the time appears as a white block and cannot be scheduled. 

You can update your own working hours or time off, and add yourself to teams and 

resource groups. On the Tools menu, click Options. On the  General tab, at the bottom 

of the page, click the user information link. 

See Also 

Set work hours for a resource 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Create or edit a service 

To make scheduling services quick and easy, it’s helpful to predefine the specifics of the services 

you’d provide to customers. By using the service records in Microsoft Dynamics CRM, you can 

define: 

 How long a service activity would last  

 What resources are available for the service activity, like users, facilities, or equipment 

A service requires at least one selection rule and one or more resources, resource groups, or 

teams before the service can be scheduled with a service activity. 

 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Navigate to the Business  Management area. 

 

3. Go to Settings > Business Management. (How do I get there?) 

4. Click Services. 

5. To create a new service, click New.  

-OR- 

To edit a service, open a service from the list. 

6. Type or modify information in the text boxes.  

a. Under General, enter a name and description to reflect the specifics of the service 

and describe what the service is. Also, specify the initial status of the service activity 

when it is created. If your organization prefers to approve all service activities before 

committing them to the schedule, you can select Requested or Tentative. 

b. Under Scheduling, in Default Duration, select how long the service lasts. This can 

be changed when the service activity is created. The maximum duration of an 

appointment or service activity is 10 days. 

c. In Start Activities Every, select how often service activities can start. This allows the 

start times of service activities to be staggered. 

d. In Beginning At, select the time when the service activities must begin. 

7. In the Required Resources area, define a selection rule: 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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a. Choose a selection rule in the right-hand pane. 

Selection rules appear in the tree beside the Selection Rule button . 

b. Choose one of the items under Common Tasks to define the selection rule by 

indicating how many resources are required and in what combination. 

Add a Selection Rule 

You can add complexity to a rule by adding a subrule to it. 

Add Resources 

Add users, facilities, equipment, or teams as resources to a selection rule. 

Add Resource Groups 

Resource groups are users, facilities, or equipment that can be scheduled 

interchangeably. 

Warning  

You can save a service without defining a selection rule, but you won’t be able to 

schedule that service. 

More information: Create or edit a selection rule  

8. When you’re ready to save your data, click Save. 

Activate or deactivate a service 

You can make a service available on unavailable for scheduling by activating or deactivating it. 

To do this, in the list of service records, select a service, then click More Actions > Activate or 

More actions > Deactivate.  

See Also 

Set the capacity required for a service or resource 

Create or edit a selection rule 

Create or edit a resource group 

Set work hours for a resource 

Create or edit a contract 

Use contracts and contract lines in Microsoft Dynamics CRM to define accurate terms and 

conditions for the support or services to be provided to your customers.  

Create a contract 

Although it is possible, creating a contract from an account is not recommended. The 

contract does not associate with the account correctly and allotments are not recorded. 

1. Go to Service > Contracts. (How do I get there?) 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. Click +New. 

3. In the Select Template dialog box, select a template to base the new contract on. 

4. Type or modify information in the text boxes.  

Hovertips provide hints on what to enter. 

a. In the Header section, enter the details of a contract, such as contract name, 

customer, and contract start and end date. 

When you save the contract, Microsoft Dynamics CRM automatically assigns the 

Contract ID and calculates the duration, in days, based on the contract start and end 

dates.  

b. In the Contract Type section, enter the discount and service level of a contract.  

Discounts for contract lines are given the same discount type that you select here. 

Service levels are defined by your business's guidelines. 

c. In the History section, the following fields are filled automatically: 

 Originating Contract: This is set when you renew an existing contract. 

 Contract Template: This is set based on what you select in the Select Template 

dialog box. 

 Owner 

d. In the Billing Information section, Microsoft Dynamics CRM automatically 

completes most of the fields when the fields in the Header section are entered; 

however, you can change or enter the information as needed. Bill To Address is 

required to change the status of the contract to invoiced. 

5. To add activities or notes, click Activities or Notes. More information: Add a phone call, 

task, email, or appointment activity to a case or record 

Note  

 The contract becomes active when it is invoiced and the start date is reached.  

 You can edit an existing draft contract, but not invoiced, active, expired, canceled, or 

on-hold contracts.  

 The default days and hours of service are defined in the contract template. To 

change the days and hours of service, open the contract, and on the command bar, 

click Set Calendar. 

Add a contract line to a contract 

Use contract lines to define specific dates, the product covered, and how many cases or total 

minutes of allotted support are provided. You can define several contract lines for each contract; 

for example, one line for parts and another for maintenance. 

1. In the contract record, in the Contract Lines section, click +.  

-OR- 

In the contract record, on the nav bar, click the arrow next to the contract name > 
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Contract Lines, and then click Add New Contract Lines. 

2. Type or modify information in the text boxes.  

Hovertips provide hints about what to enter 

a. Under General, enter details about the contract line item, such as the line item name 

and the product that is eligible for service under the contract. 

The start date and end date for the line item is automatically filled based on the 

contract dates; however, you can change the dates as needed. 

b. Under Pricing, type or modify information about the pricing of the contract, such as 

the quantity of product or service, total price, and discount. 

c. Under Administration, the customer field is automatically populated with the 

contract’s customer. You can change it if required. Enter the serial number of a 

product.  

d. Under Allotment Details, type or modify information about the allotment, such as the 

total allotment, and the used and remaining allotments. 

The contract template determines the type of allotment (cases or minutes). As cases 

are opened against this contract, Microsoft Dynamics CRM displays the allotments 

used in the Allotments Used box. 

3. Click Save. 

4. To add a note, under Notes, click Enter a note, type the details, and click Done. 

Note  

You cannot delete a contract line after it is active; instead, you can cancel it. 

You can cancel a contract line only when it is set to Active. By canceling a 

contract line instead of deleting it, you can reuse the contract lines later if you 

renew the contract or create a new contract based on it. In the list of contract 

lines, select the contract line, and on the command bar, click CANCEL 

CONTRACT LINE.  

Invoice a contract 

You must define at least one contract line for the contract before you can change the status of the 

contract to invoiced. You can define several contract lines for each contract; for example, one for 

parts and another for maintenance.  

To invoice a contract, after you add a contract line, on the command bar, click Invoice Contract. 

Hold, renew, or release a contract 

If you want to make changes to an active or invoiced contract, you must either cancel it or put it 

on hold. A canceled contract can be renewed and then edited. When a contract is on hold, no 

cases can be opened against the contract. For example, you might put a contract on hold if there 

is an invoicing dispute, and then release the contract when the dispute is resolved.  

 To put an invoiced contract on hold, in the contract record, on the command bar, click Hold 

Contract. 
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 To release the contract that’s on hold, in the contract record, on the command bar, click 

Release Hold.   

 To renew a canceled contract, in the contract record, on the command bar, click Renew 

Contract. 

See Also 

Define support terms for customers by using contracts 

Define support terms for customers by using contracts 

Effectively track the terms and conditions of support you’ll provide to customers for the products 

they’ve purchased. In Microsoft Dynamics CRM, contracts define information like the duration of 

the contract, how many case incidents or minutes of service the customer has purchased, and 

what hours and days of the week the service or support coverage is available.  

Create contracts 

You can create new contracts based on contract templates. These define some information, such 

as allotment types, before you actually write a contract. You can create contracts only for existing 

accounts and contacts.  

A contract has the status of draft until it is invoiced. Each new contract is assigned a unique ID 

that cannot be used for another contract, unless the contract is being renewed. When renewing a 

contract, the contract is saved as a draft with an ID that corresponds to the original contract.  

 

Invoice and activate a contract 

After a contract has at least one contract line and a billing address, you can mark the contract 

status as invoiced. Changing the status implies that you have accepted the contract.  

Microsoft Dynamics CRM does not automatically invoice the customer or create an invoice record 

unless your business has integrated Microsoft Dynamics CRM with a Microsoft BackOffice 

product.  

The contract status is invoiced until the start date has passed. Then, the status changes to active. 

You cannot delete a contract with an invoiced or active status. 

 

Renew a contract 

After passing the end date of the contract, the contract is expired and cases cannot be opened 

against it. To open a new case against the contract, renew the contract.  

When you renew a contract, a draft copy of the contract is created with the same ID number as 

the original, expired contract. You can make modifications to the new draft contract, including 

adding or modifying contract lines. You have the option of including contract lines that were 

canceled from the original contract. After the original contract expires, invoice and activate the 

renewed contract. 
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A renewed contract has the same ID number as the original contract, reflecting the renewal action 

in the contract's history. The start date is automatically set to the day after the existing contract 

expires. While Microsoft Dynamics CRM gives the renewed contract the same duration as the 

original contract automatically, you can change the duration manually. 

 

See Also 

Create or edit a contract 

Create templates for contracts 

Improve customer service with better automation and tracking 

eBook: What’s new in customer service 

Add facilities and equipment for service scheduling 

Facilities and equipment are resources you’d use to perform services for your customers. 

Facilities could be physical spaces like service bays or conference rooms and equipment could 

be tools or other assets. Add these resources to Microsoft Dynamics CRM to ensure optimal 

services to your customers.  

Add a facility or equipment  

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Service Management. (How do I get there?) 

-OR- 

Go to Settings > Business Management. (How do I get there?) 

3. Choose Facilities/Equipment. 

4. On the command bar, choose New. 

5. Fill in the information as required. 

 Name. Enter the name of the facility or equipment you want to add for service 

scheduling. 

 Business Unit. CRM enters the business unit automatically. To choose a different business 

unit, choose the Lookup button  and then select from the list. 

 

http://go.microsoft.com/fwlink/p/?LinkID=393186
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 Site. Select the location where the facility or equipment is located.  

 

Tip  

Make sure the site and the customer are in the same location. Resources for 

a given service activity should also be located at the same site. 

 Primary Email. Enter the email address of the site manager or equipment manager. 

If there are any updates or cancellations related to the schedule, facilities, or 

equipment, notifications are sent to this email address. 

 Time Zone. Select the appropriate time zone to determine availability for the facility 

or equipment. By default, this is set to the time zone you’ve selected in the General 

tab of the Set Personal Options dialog box. More information: Set personal options 

 Description. Add details about the facility or equipment, such as the numbers, size, 

make, or model. 

 

6. When you’re done, choose Save or Save and Close.  

See Also 

Basics of service and service scheduling 

Set up and define rules for service 

 

Define subjects to categorize cases, products, and articles 

Create a simple selection rule 

Create or edit a resource group 

Use sites to manage your service locations 

Set the capacity required for a service or resource 

Set work hours for a resource 

Restrict a resource from performing a service 

Create or edit a selection rule 

Define subjects to categorize cases, products, and articles 

Microsoft Dynamics CRM includes a subject organizational structure that lets you mark and 

categorize service cases, knowledge base articles, products, and sales literature. By using the 

subject hierarchy, you can classify service cases to quickly provide service to your customer. You 

can also provide the appropriate sales literature. You’ll also be able to better understand gaps in 

your sales literature, evaluate service quality by subject area, and improve reporting on the 

performance of your products.  
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Create or edit a subject 

1. Go to Settings > Business Management. (How do I get there?) Click > Subjects. You 

can also get there by going to Settings > Service Management > Subjects. 

2. To add a subject, under Common Tasks, click Add a Subject. 

-OR- 

To edit a subject, in the Subject Tree, select a subject, and then under Common Tasks 

click Edit Selected Subject. 

3. In the Subject dialog box, enter the required information:  

 Title: Type a name for the subject. This is a required field. 

 

 Parent Subject: To search for and select a parent subject for the new subject, click 

the Lookup button.  

 

-OR- 

 

To make the new subject a parent subject, leave the Parent Subject box empty. 

 

 Description: Type a descriptive statement about the subject. 

 

4. Click OK. 

See Also 

Create and manage a case 

Get started with service management 

Create a simple selection rule 

This procedure assumes that no selection rules have been created previously for this service.  

 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Business Management. (How do I get there?) 

3. Click Services. 

4. In the list of services, open the service to which you want to add a selection rule. 

5. On the Service form, click Required Resources, and then double-click or double-tap the 

first selection rule in the right pane. 

Selection rules appear in the tree beside the Selection Rule button . 

6. In the Edit a Selection Rule dialog box, enter the following information:  

 Quantity 

Select the number of resources required for the service. If you select All, all the 

selected resources are included in the service activity. 

 Description 

Enter any additional information about the scheduling rule you want to include. 

 Selection Site 

This option defines whether the resources must all be from the same site or if they 

can be from any site in the business unit. This option is available only in the top-level 

selection rule.  

7. Click OK.  

8. Under Common Tasks, you can add resources: 

 To add individual users, facilities, equipment or teams to the selection rule, click Add 

Resources. 

In the Look Up Records dialog box, select the records you want to add. You can 

add as many records as you want, and they can be a mix of individual users, 

facilities, equipment, and teams. 

 To add resource groups to the selection rule, click Add Resource Groups. 

In the Look Up Records dialog box, select the records you want to add. You can 

add as many records as you want. 

Tip  

If you select multiple users in the Look Up Records dialog box and click OK, the 

Save the selection as a Resource Group dialog box opens. If you want to 

create a resource group from the selected resources, click Yes, save the 

selection as a resource group with the name, enter a name in the box, and 

then click OK. The new resource group appears in the selection tree. 

9. Click OK. 

10. Click Save or Save and Close. 

Tip  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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After you set up the selection rule, create a service activity for the service rule and check 

the search results to verify that the results are what you expect. 

See Also 

Create or edit a selection rule 

Schedule a service activity 

Create or edit a resource group 

Create or edit a resource group 

Use resource groups to group users, facilities, and equipment as part of the selection rules for a 

service. 

 

1. Go to Settings > Business Management. (How do I get there?) 

 

2. Click Resource Groups. 

3. On the Actions toolbar, click New.  

4. In the Resource Groups form, enter information in the following fields:  

 Name 

You must enter a name for the resource group. Microsoft Dynamics CRM does not 

check that the name is unique. 

 Business Unit 

To locate and select a business unit, click the Lookup button . 

 Description 

You can add a detailed description of this resource group, including the criteria that 

you used to determine which resources to add to the resource group. 

5. Click Save. 

After you save the record, Resources appears under Common. 

6. Click Resources, and then on the Actions toolbar, click Add Resources. 

7. In the Look Up dialog box, select the users, facilities/equipment, teams, or other 

resource groups to add to this resource group. 

Adding other resource groups to a resource group is a good way to manage large 

numbers of resources. For example, you could add the resource groups of "senior 

technicians" and "junior technicians" to a resource group of "technicians." 

8. Click OK to add the selected resources to the resource group.  

9. Click Save or Save and Close. 

Create a resource group 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Navigate to your area. 

Go to Settings > Business Management. (How do I get there?) 

 

2. Click Resource Groups. 

3. Open the resource group you want to change.  

4. In the Resource Groups form, change the information.  

5. Click Save or Save and Close. 

Resource groups are published automatically when you save and close the form. If the 

new resource group doesn’t appear in the list of available resource groups for a service, 

or if changes are not appearing, you can manually publish the change by clicking 

Publish on the Resource Groups page. 

To remove a resource, select the resource you want to remove from the resource group. 

On the Actions toolbar, click More Actions, and then click Remove Resources. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

See Also 

Get started with service 

Set up and define rules for service 

Use sites to manage your service locations 

Create sites to define the locations where you provide service to your customers. When you’re 

scheduling resources, you can define which resources will work on which site. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

 

 

2. Go to Settings > Business Management. (How do I get there?)  

Edit a resource group 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Click Sites. 

4. On the Actions toolbar, click New.  

5. Fill in your information. Use the handy tooltips as a guide. 

6. Click Save. 

7. To add resources, under Common, click Resources, and then click Add Resources. 

8. In the Look Up Records dialog box, in the Look For drop-down list, you can add 

facilities/equipment or users as resources. 

9. From the list of records, double-click a resource, and click Add. 

10. Click Save and Close. 

See Also 

Create or edit a service 

Create a service activity without checking for conflicts 

Find the next available time before creating a service activity 

Set the capacity required for a service or resource 

Define a limit to the number of activities a resource can perform in a stipulated time by setting the 

capacity of the resource and services in Microsoft Dynamics CRM.  

You must set both the capacity of the service and of the resources required for the service. 

When you set capacity of a resource and service, the service calendar doesn’t allow booking the 

resources once they reach their capacity. 

Set the capacity of a service 

1. Before you start, make sure you have the Schedule Manager role assigned or have the 

required permissions for doing the scheduling tasks. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Business Management. (How do I get there?) 

 

3. Click Services. 

4. In the list of services, open the service you want to set the capacity for. 

5. Under Required Resources, in the column on the right, double-click or tap the selection 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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rule you want to modify.  

6. In the Edit a Selection Rule dialog box, expand the Scheduling Details area. 

7. In Select Criteria, to make sure everyone has the same workload, select Least Busy. 

Or, to make sure each member works at full capacity before assigning work to anyone 

else, select Most Busy. 

8. In Capacity Required, specify the capacity required by a resource to perform this 

service.  

For example, a workshop has four work compartments. The capacity of the workshop is 

4, that is, the workshop can have four different services scheduled for the same time. 

You can then add different workers, where the more skilled workers complete two tasks 

at once, so their capacity can be set to 2. They can have two jobs scheduled for the 

same time. 

9. Click OK. 

10.  Save & Close. 

 

Set the capacity of a resource 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Business Management. (How do I get there?) 

3. Click Facilities/Equipment. 

4. In the list of records, open the record you want to set the capacity for. 

5. In the user record, on the nav bar, click the chevron button next to the record name, and 

then Work Hours. 

-OR- 

In the Facilities/Equipment record, under Common, click Work Hours. 

6. On the Monthly View tab, double-click the date on the calendar that is the first day you 

want the new schedule to start, or any date that will be affected by this edit. 

7. In the Edit Schedule dialog box, select one of the following and then click OK: 

a. This date only. This option changes only the date selected. If you select this option, 

skip to step 8. 

b. From <this date> onward. This option changes only the schedule going forward. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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c. Entire recurring weekly schedule from start to end. This option changes this 

entire schedule from the start to end date. Selecting this option might change past 

days, which might affect reports regarding hours worked in the past. 

8. In the Weekly Schedule dialog box, click the work hours link for the schedule you want 

to edit. 

If working hours have not been set previously, the link is displayed as "Set Working 

Hours." You must set up a schedule for a user, facility, or equipment before you can 

continue. More information: Set work hours for a resource 

9. In the Set Work Hours and Service Restrictions dialog box, click Show Capacity, and 

then in the Capacity column, enter the capacity. 

10. Click OK. 

11. Click Save & Close. 

See Also 

Create or edit a selection rule 

Set work hours for a resource 

You can set the hours a user works or set the operating hours for a facility or equipment. By 

default, users, facilities, and equipment are set up for a 7-days-a-week, 24-hour schedule. 

You can edit existing work hours by following steps 1 and 2 to go to the Users or 

Facilities/Equipment area. Then, open the resource you want to edit. Editing a schedule does not 

affect existing service activities created for the resource. 

On this page: 

 Set work hours for a facility or equipment 

 Set work hours for a user 

Set work hours for a facility or equipment 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Business Management. (How do I get there?) 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Click Facilities/Equipment. 

4. In the list, open the resource record you want modify. 

5. Click Work Hours. 

6. On the Monthly View tab, double-click a date on the calendar that is the first day you 

want the new schedule to start, or any date that will be affected by the new schedule. 

7. In the Edit Schedule dialog box, select one of the following, and then click OK.  

 This date only 

This option changes only the date selected. 

Skip to step 10. 

 From <this date> onward 

This option changes only the schedule going forward. 

 Entire recurring weekly schedule from start to end 

This option changes this entire schedule from the start to end date. 

Selecting this option might change past days, which may affect reports regarding 

hours worked in the past. 

8. In the Weekly Schedule dialog box, in the Set the recurring weekly schedule section, 

select one of the following:  

 Are the same each day 

The new schedule is the same for every day of the week. After you select this option, 

select the days of the week that the resource is available. 

 Vary by day 

The new schedule is different for one or more days of the week. After you select this 

option, select the days of the week that the resource is available. 

 None. Resource is not working 

The new schedule includes time that the resource is not working. 

In the Weekly Schedule dialog box, you can also do any of the following: 

 If the schedule is for more than one day, select the days of the week that this 

schedule is effective. 

 If the resource does not work during business closures, select the Observe option. 

 Under Date Range, in the Starting on box, you can change the date the schedule 

starts.  

You cannot change the date the schedule ends. To end a schedule, you must define 

a new schedule on that date. 

9. Choose the work hours link for the schedule you want to modify.  

If work hours have not been set previously, the link is displayed as "Set Work Hours." 

10. In the Set Work Hours and Service Restrictions dialog box, complete the following 

fields, and then click OK:  

 Date 

Select a date from which the work hours for services are to be considered. 
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 Start 

Select the time the work day starts. 

 End 

Select the time the work day ends. 

To add a break in the work hours, such as a lunch break, click Add Break, and then 

select the start and end time of the break. 

11. To define a time when a service will not be available, on the Service Restrictions tab, 

click New. In the Edit a Service Restriction dialog box, select the service, and select the 

start and end time between which the service will be unavailable, and then click OK. 

12. Click Save and Close to close the Weekly Schedule dialog box. 

 You can set the work hours for a single day by double-clicking the day, and then in the Edit 

Schedule dialog box, select This date only, then click OK. Then, perform step 10 in the 

procedure.  

 All of the options may not be available to you for selecting how much of the schedule you 

want to edit. The available options are based on the schedules that are already set up. 

Set work hours for a user 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions.  

2. Go to Settings > Security. (How do I get there?) 

3. Click Users. 

4. Open the user record you want to set work hours for.  

5. On the top, select the arrow next to the name of the user. 

6. Click Work Hours. 

7. From the Set up drop-down list, choose the schedule display as required.. 

Note  

Monthly schedules are the default display; you can choose weekly and daily 

schedules. 

8. Double-click a date on the calendar that is the first day for which you want to set work 

hours.  

9. In the Edit Schedule dialog box, select one of the following and then click OK.  

 This date only 

This option changes only the selected day. 

Skip to step 12. 

 From <this date> onward 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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This option changes only the schedule going forward. 

 Entire recurring weekly schedule from start to end 

This option changes this entire schedule from the start to end date. 

Selecting this option might change past days, which may affect reports regarding 

hours worked in the past. 

10. In the Weekly Schedule dialog box, in the Set the recurring weekly schedule section, 

select one of the following:  

 Are the same each day 

The new schedule is the same for every day of the week. After you select this option, 

select the days of the week that the resource is available. 

 Vary by day 

The new schedule is different for one or more days of the week. After you select this 

option, select the days of the week that the resource is available. 

 None. User is not working 

The new schedule includes time that the resource is not working. 

In the Weekly Schedule dialog box, you can also do any of the following: 

 If the schedule is for more than one day, select the days of the week this schedule is 

effective. 

 If the resource does not work during business closures, select the Observe option. 

 Under Date Range, in the Starting on box, you can change the date the schedule 

starts.  

You cannot change the date the schedule ends. To end a schedule, you must define 

a new schedule on that date. 

11. Choose the work hours link for the schedule you want to modify.  

If work hours have not been set previously, the link is displayed as "Set Work Hours." 

12. In the Set Work Hours and Service Restrictions dialog box, complete the following 

fields, and then click OK:  

 Date 

Select a date from which the work hours for services are to be considered. 

 Start 

Select the time the work day starts. 

 End 

Select the time the work day ends. 

To add a break in the work hours, such as a lunch break, click Add Break, and then 

select the start and end time of the break. 

13. To define a time when a service won’t be available, on the Service Restrictions tab, 

click New. In the Edit a Service Restriction dialog box, select the service, and select the 

start and end time between which the service will be unavailable, and then click OK. 

14. To close the Weekly Schedule dialog box, click Save and Close. 
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See Also 

Set the capacity required for a service or resource 

Set when your business is closed 

Add and manage users, and set security roles 

Restrict a resource from performing a service 

You can restrict a resource from performing a service and define the service capacity for the 

resource. You can also restrict when a resource is available to be scheduled for a specific 

service. The resource is still available for scheduling service activities for other services. 

 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions.  

Check your security role  

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Administration. (How do I get there?) 

3. Click Users. 

If using the CRM web application  

a. In the list, open the resource record you want to modify. The resource name 

appears in the nav bar. Click the arrow beside the resource name and select 

Work hours.  

If using CRM for Outlook  

a. In the list, open the resource record you want to modify. 

b. Under Common, click Work Hours.  

4. On the Monthly View tab, double-click a date on the calendar that is either the first day 

you want to restrict the resource from performing the service or a date in a recurring 

schedule. 

5. In the Edit Weekly Schedule dialog box, select one of the following options, and then 

click OK. 

 This date only 
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This option changes only the date selected. 

If you select this option, skip to step 8. 

 From <this date> onward 

This option only changes the schedule going forward. 

 Entire recurring weekly schedule from start to end 

This option changes the entire schedule from the start to end date. 

Selecting this option might change past days, which may affect reports regarding 

hours worked in the past. 

6. In the Weekly Schedule dialog box, click the work hours link for the schedule you want 

to modify. 

7. In the Work Day dialog box, click the Service Restrictions tab. 

8. On the Actions toolbar, click New. 

9. In the Service Restrictions dialog box, find and select a Service. Click the Lookup button 

 to search for a record. 

10. In the Start time and End time lists, set the time when the facility or equipment is not 

available, and then click OK. 

11. Click OK, to close the Work Day dialog box. 

12. Click Save or Save and Close. 

 You can set up service restrictions in your own work schedule. 

 All of the options may not be available to you for selecting how much of the schedule you 

want to edit. The available options are based on the schedules that are already set up. 

See Also 

Set work hours for a resource 

Create or edit a selection rule 

Before you can add a resource to a service, you must define a selection rule to determine how 

resources are selected for service activities.  

You can create a simple rule that selects resources from a list, and nest selection rules and sub-

rules to create compound and complex rules.  A compound rule selects a combination of 

resources, and a complex tree of selection rules selects from groups of equivalent resources. 

You can also add resources to existing selection rules. 

See Also 

Create a simple selection rule 

Set the capacity required for a service or resource 

Note  
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Set up case and queue settings 

 

Define settings for parent and child cases 

Create rules to automatically route cases 

Automatically create a case from an email 

Set up rules to automatically create or update records in CRM 

Create or edit a queue 

Set up queues to manage activities and cases 

Add a timer control to the Case form to track time against an SLA 

Define status reason transitions for incident (case) management 

Define settings for parent and child cases 

In Microsoft Dynamics CRM,  you can track multiple issues for a customer, or track the same 

issue that's affecting multiple customers, using parent and child cases.  

For example, you could track a case where work needs to be done by other departments. 

The primary case or issue is called the parent case. Any related cases are called a child 

cases.  Before your service team can start using this feature, you'll need to go into the settings 

area and set up a few rules about how information will be inherited. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

Set parent and child case attributes 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

 Follow the steps in View your user profile. Don’t have the correct permissions? 

Contact your system administrator. 

 

2. Follow the steps for the app you’re using. 

If using the CRM web application 

a. On the nav bar, choose Microsoft Dynamics CRM > Settings. 

Important  
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b. Choose Settings > Service Management.  

 

If using CRM for Outlook 

a. In the Navigation Pane, choose Settings > Business > Service 

Management. 

 

 

3. Click Parent and Child case settings. 

4. On the Case Settings dialog box, select the attributes that the child case will be inherit 

from the parent case.  

5. Using the Parent and Child case settings, specify the information that will be inherited 

from a parent case to the child case. You can also select a case closure setting that 

defines how parent and child cases are closed. Select one of the case closure preference 

for parent and child cases: 

 Close all child cases when parent case is closed: The parent case can’t be closed 

until all the child cases are closed. 

 Don’t allow parent case closure until all child cases are closed: The parent case 

can’t be closed until all the child cases are closed. 

Note  

If you don’t make a selection, parent and child cases are closed independently of 

each other. This is the default setting. 

6. When you’re done, click OK. 

See Also 

Get started with service management 

Create and manage parent and child cases 

eBook: What’s new in customer service 

eBook: Give great customer service with CRM 

Create rules to automatically route cases 

Use routing rules in Microsoft Dynamics CRM to automatically route cases to the right people at 

the right time without any manual intervention. You can also use routing rules to route cases that 

are escalated to specific queues. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=393186
http://go.microsoft.com/fwlink/p/?LinkId=393634
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 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

On this page: 

  Create a routing rule set 

  Apply a routing rule set 

Create a routing rule set 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

When you create and activate a routing rule set, internally a corresponding workflow is 

also created. Whatever action you do on the routing rule set, like creating or assigning 

the rule, you must have privileges to perform the same action on workflows. For the rule 

to work, you must have sufficient privileges to run a workflow. The routine rule set is 

applied in context of the privileges that the owner of the routing rule set has. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

 

3. Click Routing Rule Sets. 

4. To create a new routing rule set, click New.  

-OR- 

To edit a routing rule set that you already have, in the list of records, click the rule that’s 

in the Draft state, and then on the command bar, click Edit. 

5. Fill in your information. Use the handy tooltips as a guide. 

6. After you enter information in all the required fields, click Save. 

7. In the Rule Items section, click the Add Rule Item button + to specify conditions for 

routing cases to a queue. 

You can add multiple conditions here and arrange them in the desired order. The rule 

items are run in the same order. As soon as an applicable rule item (based on the If 

Conditions) is applied on the case, the other rule items are not run on the case.  

 

a. In the Rule Item form, type a descriptive name for the rule item. 

b. Under Rule Criteria in the If Conditions section, specify the conditions for 

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
164 

which the case will be routed. 

For example, to route all cases that have the IsEscalated field set to Yes to 

the Tier 2 support queue, specify the conditions as shown here:  

 

c. Under Then Conditions, specify the queue to which the cases will be routed 

or the user or team to which the cases will be assigned if the conditions in 

the If Conditions section are met. 

 

 

Tip  

To group conditions in the criteria, use the Group And or Group Or options.  

8. Click Save and Close. 

9. In the Routing Rule Set record, click Activate so that the rule set is applied to the cases 

matching the conditions in the rule. 

 Only one routing rule set can be active at any point of time. If you try to activate another rule 

when one rule is already active, it will deactivate the currently active rule. You can activate or 

deactivate only the rules that you own. 

 You can’t edit an active routing rule set. Therefore, if you’re importing a solution that includes 

an active routing rule set into an organization where the rule already exists with the same ID, 

the solution import will fail.  

Apply a routing rule set 

An active routing rule set automatically applies to all automatically-created cases.  

To manually apply the rule to existing or manually-created cases, in the list of cases, select the 

cases that you want to route using this rule, and on the command bar, click Apply Routing Rule. 

If you’re importing bulk records, and you don’t want the routing rules to apply to the cases 

that you’re importing, add a column “Route Case” to your spreadsheet, and add the value 

“No” for all the cases that you don’t want to route. 

See Also 

Create and manage a case 

Automatically create a case from an email 

Create or edit a queue 

Note  

Note  
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Automatically create a case from an email 

Reduce the need for manually creating cases from incoming emails and increase the efficiency of 

customer service agents by creating automatic case creation rules in Microsoft Dynamics CRM. 

The conditions in these rules automatically convert emails to support cases. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

Create cases automatically using rules 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

When a case creation rule is activated, a corresponding workflow is created 

automatically. If you create or assign a rule, you must have permissions to perform the 

same action on workflows. The case creation rule is applied and a case is created in 

context to the permissions that the owner of the case creation rule has. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Click Automatic Case Creation Rules. 

4. To create a new case creation rule, click New.  

-OR- 

To edit an existing rule, in the list of rules, select a rule, and then on the command bar, 

click Edit.  

5. Type or modify information in the fields. 

Hover over the field labels to see what to enter. 

 Name. Type the name of the queue the rule is defined for. 

 Source Type. Select Email to indicate that cases will be created automatically from 

email messages. 

 Queue. Select the queue that the rule applies to. For example, if you want to convert 

email messages and then send them to the Support queue, select that queue here.  

Note  

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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You can associate only one rule per source type to a specific queue. If you’re 

creating a rule to convert an email to a case, make sure you specify an email 

address for this queue.  Otherwise, automatic case creation for email won’t 

work. More information: Create or edit a queue 

 

6. In the Specify Conditions for Case Creation section, select the conditions for creating 

the case automatically. You can add multiple conditions here and arrange them in the 

desired order. The conditions are considered in the same order. Only one item that has 

conditions matching the incoming email is applied. 

Specify conditions for email to case creation 

a. Create cases for email from unknown senders. If you select this check 

box, all email messages from unknown senders (a sender whose email 

address is not present in any CRM records) are converted to cases. A 

contact record is also created for this unknown sender. 

Note  

If this option is not selected, cases are created only for email 

messages that have a CRM contact or account as the senders. 

Email messages from sender that are present as other record types 

in CRM won’t be converted to cases. 

This option, in conjunction with the Automatically create records in 

Microsoft Dynamics CRM option in the rule owner’s Personal Options, 

determines whether a case and contact record is created (see Set personal 

options): 

This table shows if a contact and case record is created based on the values 

set for the Automatically create records in Microsoft Dynamics CRM field 

in Personal Options and the Create cases for email from unknown 

senders check box in the automatic case creation rule: 
 

 “Automatically create 

records in Microsoft 

Dynamics CRM” option is 

set to:  

If “Create case from 

unknown sender” 

option in this rule is 

set to: 

Contact or case 

created? 

Create Lead Selected Both, contact and 

case, created 

Create Lead Not selected None 

Create Contact Selected Both, contact and 

case, created 

Create Contact Not selected Only contact created 
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None Selected Both, contact and 

case, created 

None Not selected None 

 

b. Create case if a valid entitlement exists for the customer. If you select this 

check box, Microsoft Dynamics CRM creates a case only if an active 

entitlement exists for the customer. 

If the sender of the email is a contact with a parent account, Microsoft 

Dynamics CRM creates a case if the contact’s parent account has a valid 

entitlement, and the contact is listed in the Contacts section of the 

entitlement or if the Contacts section is empty (which means the entitlement 

is applicable to all contacts for the customer). 

c. Create cases for activities associated with a resolved case. If you select 

this check box, Microsoft Dynamics CRM creates a case if the email is 

related to a resolved case. If the email is related to an active case, a new 

case won’t be created. 

d. Create case when the case associated with the activity is resolved 

since. If you select the Create cases for activities associated with a 

resolved case check box, select the duration here. Microsoft Dynamics 

CRM creates a case only if the case is resolved earlier than the duration you 

specify. If the incoming email is related to a case resolved later than the 

specified duration, Microsoft Dynamics CRM only associates the incoming 

email with the existing resolved case; a new case won’t be created. 

e. Under Specify Autoresponse Settings, select the Send automatic email 

response to customer on case creation check box if you want to 

automatically send email responses to the sender of the email after a case 

for the email is created.  

Select email template to respond to customer.  If you select the Send 

automatic email response to customer on case creation check box, 

select an email template (global email template or email template of case 

entity type). If you don’t select a template, an automatic response won’t be 

sent. 

 

7. Click Save. 

8. In the Specify Case Details section, define the conditions for creating a case and specify 

the case properties. 

By default, the Title field of the new case is set to the subject of the email and the 

Customer field is set to the sender of the email. If the sender of the email is a contact with 

a parent account, the Customer field is set to the parent account, and the Contact field is 

set to the sender of the email. 

Specify case details 
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a. In the Specify Case Details section, click +, and define the conditions for 

creating a case and specify the case properties. 

b. In the Conditions section, specify when the case should be created. 

Here’s how: 

 

c. In the Case Properties section, set the properties for the case. The following 

example shows how to set the priority of all the automatically created cases 

to High: 

 
 

Once a case is created, the incoming email is removed from the queue. 

If there’s no routing rule to route the newly created case to another user or queue, the 

user who’s the owner of the case creation rule will be set as the owner of the case, too.  

Activate or deactivate a case creation rule 

Cases are created automatically only when the case creation rule is active. To activate a rule, 

open it, and on the command bar, click Activate. 

Once the rule is active, you can’t change it. To change a rule, first open the rule and on the 

command bar, and click Deactivate. You can then edit the rule. 

Manage automatic case creation from a queue form 

You can create or manage an automatic case creation rule from a queue form, too. To do this, 

open the queue record, and on the command bar, click Email to Case Settings.  

See Also 

Create rules to automatically route cases 

Create or edit a queue 

eBook: What’s new in customer service 

Set up rules to automatically create or update records in CRM 

horizontaltabbed 

Overview  

Every organization has multiple applications to capture customer interactions. The ability to 

channel external data into Microsoft Dynamics CRM records can significantly improve the 

efficiency of your sales, marketing, and service teams, and increase the quality of your data. You 

can now direct this data from various applications and external sources into Microsoft Dynamics 

CRM with the help of record creation and update rules. 

By using record creation and update rules in Microsoft Dynamics CRM, you can automatically 

create or update system or custom records from incoming CRM activities, such as emails, social 

activities, or custom activities, without writing any code. Not just that, you can set up the rule to 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=393186
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convert the incoming activity into multiple CRM records. For example, you can create a case and 

a lead from a single social activity.  

A record creation and update rule consists of rule items that define the conditions for creating or 

updating records, and also defines what actions or steps to take on the newly-created records. 

The rule also contains channel properties that are used to define conditions for rules, and also for 

setting properties of the record you’re creating or updating. 

To enable the rule to update records, you must add an Update step to the rule. Only the entity 

that you select in the Update step is updated based on the properties you set. 

This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-

premises).  

 

 Interested in getting this feature? Find your CRM administrator or support person 

On this page: 

 Activities and entities supported by record creation and update rules 

 Capture data from external sources 

 Activate or deactivate a rule 

 How do record creation and update rules work with queues? 

 Rules in solutions 

Activities and entities supported by record creation and update rules 

By default, CRM supports creating records from the following activities, also called source types 

in the context of record creation and update rules: 

 Email 

 Social activity 

 Task 

 Phone call 

 Appointment 

 Service activity 

 Custom activity 

These activities can be converted to any default (system) entity records or custom entity records. 

For example, you could create a lead, opportunity (system record), or incident (custom record) 

from an incoming email. 

Capture data from external sources 

You can also capture additional valuable customer information provided by an external 

application in the form of JSON (a collection of name-value pairs), and use it to enhance the 

quality of the target records and set various conditions in the record creation and update rules. 

Every default (out-of-the-box) activity or custom activity has an Additional Parameters attribute. 

This attribute stores the JSON payload received from an external application.  

Important  

http://go.microsoft.com/fwlink/p/?LinkID=513070
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To capture this information in CRM, you can define channel properties and associate them with a 

particular rule or share them across multiple rules of the same source type. For example, along 

with a social post, you can capture important information about the post, such as sentiment value. 

Sentiment value is the property of social activity, so you can use this property in any other record 

creation and update rule of type Social Activity. 

Here’s the correct format in which CRM should receive the JSON payload (data received as a 

name-value pair in JSON format) from the external application: 

{“PropertyName1”:”Propertyvalue1”; “PropertyName2”:”Propertyvalue2”} 

Any configuration done in the channel properties is only valid if those name-value pairs 

exist in the JSON payload. Also, you must only use parameters received from the 

external application in the rule item conditions and as record properties.  

Activate or deactivate a rule 

For any record creation and update rule to apply to a matching incoming activity, after you add 

the rule items, you must activate the rule. 

When a record creation and update rule is activated, a corresponding workflow is created 

automatically. You can use channel properties to define a workflow’s conditions and operators in 

mapping the target entity attribute values. For complex scenarios, you may configure child 

workflows. 

More information:  TechNet: Configure workflow steps  

How do record creation and update rules work with queues? 

In a record creation and update rule, when you specify a queue for a source type, any incoming 

activity from that source is added as a queue item for that specified queue. That is, if a rule for a 

particular source activity and queue combination is active, the rule processes the incoming 

activity on that queue to create or update records. 

For an email source type, specifying a queue is mandatory. For all other source types including 

custom activities, it is optional. 

Rules in solutions 

The record creation and update rules can be packaged as a part of a CRM solution. Customizers 

and developers distribute solutions so organizations can use Microsoft Dynamics CRM to install 

and uninstall the business functionality defined by the solution. 

Keep the following things in mind about using rules in solutions: 

 Any rule that you created in Microsoft Dynamics CRM Online 2015 Update 1 or later can’t be 

exported to an earlier release. 

 Any rules upgraded to and edited in Microsoft Dynamics CRM Online 2015 Update 1 or later 

can’t be exported back to an earlier release.  

How to 

 

On this page: 

Note  

https://technet.microsoft.com/library/dn531057.aspx
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 Prerequisites 

 Set up a rule to create and update records automatically 

 Set up channel properties 

 Activate a record creation and update rule 

 Manage automatic record creation and update from a queue form 

 Upgrade considerations 

Prerequisites 

 

 This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-premises).  

 

 Interested in getting this feature? Find your CRM administrator or support person 

 Before you can use automatic record creation rules, be sure your external application/social 

engagement system is already integrated with your CRM instance.  

If your CRM instance meets the prerequisites, all you need to do is set up rules in CRM that 

will automatically create or update a support case, lead, opportunity, appointment, task, and 

more from incoming activities. 

Set up a rule to create and update records automatically 

 

1. Make sure that you have the customer service, sales manager, or marketing manager 

role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management or Business Management. (How do I get 

there?) 

3. Click Automatic Record Creation and Update Rules. 

4. To create a record creation and update rule, click New.  

-OR- 

To edit an existing rule, in the list of rules, open the rule you want to edit.  

5. Type or modify information in the fields. 

Hover over the field labels to see what to enter. 

 Name. Type the name of the rule. 

 Source Type. From the drop-down list, select the activity that’s the source of the 

record. 

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 Queue. Select the queue the rule applies to. Incoming activity arrives in the queue, 

and then the valid rule and rule item applies for creation or update of records.  

Here are a few things to consider: 

 For all activities and custom activities, except email, specifying a queue is 

optional. For all such activities you can have only one rule with an associated 

queue and one rule without an associated queue active at any given time. For 

example, for a Social Activity source type, you can have two active rules, one 

with a queue specified, and one without a queue. 

 If you selected Email as the source type for this rule, you can’t activate the rule 

unless you select a queue. 

Note  

You can associate only one rule per source type to a specific queue. If you’re 

creating a rule to convert an email to a case, make sure you specify an email 

address for this queue. Otherwise, automatic record creation for email won’t 

work. More information: Create or edit a queue 

 

6. Click Save. 

7. Under Channel Properties, in the Additional Properties box, click a channel property 

group.  

Note  

When you select a property group for a record creation and update rule, you can 

use the channel property group’s property items in the rule item conditions or 

while setting properties for the target record. After you activate a rule, you can’t 

remove or change the selected property group. You can select another property 

group only after you remove the referenced property items of the previous 

property group from the rule items. When you try to select a new property group 

without removing the property references of the previous property group, you’ll 

see an error.  

To learn more about creating channel property groups and adding properties to them, 

see the Set up channel properties section in this topic. 

8. If the source type for the rule is set to Email, specify the conditions for converting the 

email to the target record. 

Specify the following details 

a. Create records for email from unknown senders. If you select this check 

box, all email messages from unknown senders (a sender whose email 

address isn’t present in any CRM records) are converted to new records 

(based on the conditions you define). A contact record is also created for this 

unknown sender. 

Note  
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CRM determines what record to create based on the entity you 

select in the Create Record step under Actions. 

If you don’t select this check box, records are created only for email 

messages that have a CRM contact or account as the senders.  

This option, in conjunction with the Automatically create records in 

Microsoft Dynamics CRM option in the rule owner's Personal Options, 

determines whether a case and contact record is created (see Set personal 

options). 

b. Create case if a valid entitlement exists for the customer. If you select 

this check box, CRM creates a case only if an active entitlement exists for 

the customer. 

If the sender of the email is a contact with a parent account, CRM creates a 

record if the contact’s parent account has a valid entitlement, and the contact 

is listed in the Contacts section of the entitlement or if the Contacts section 

is empty (which means the entitlement is applicable to all contacts for the 

customer). 

c. Create cases for activities associated with a resolved case. If you select 

this check box, CRM creates a case if the email is related to a resolved case. 

If the email is related to an active case, a new case won’t be created. 

d. Create case when the case associated with the activity is resolved 

since. If you select the Create cases for activities associated with a 

resolved case check box, select the duration here. CRM creates a case only 

if the case is resolved earlier than the duration you specify. If the incoming 

email is related to a case resolved later than the specified duration, CRM 

only associates the incoming email with the existing resolved case; a new 

case won’t be created. 

e. Send automatic email response to customer on record creation. Select 

this check box if you want to automatically send email responses to the 

sender of the email after a target record for the email is created. 

f. Select email template to respond to customer.  If you select the Send 

automatic email response to customer on record creation check box, 

select an email template (global email template or email template of any 

entity type). If you don’t select a template, an automatic response won’t be 

sent. 

 

 

9. If the source type for the rule is set to Social Activity, specify the conditions for converting 

the social activity to the target record. 

Specify the following details 

a. Create records for blocked social profile. If you select this check box, 

CRM creates or updates a target record for the social posts (social activities) 
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from social profiles that are blocked by you. 

Note  

Social posts appear in CRM as social activities. 

b. Create records for direct messages only. If you select this check box, 

CRM creates the target record only when the social posts are sent as direct 

or private messages. If you clear the check box, records are created for all 

social posts including public messages (timeline). 

Note  

CRM determines what record to create based on the entity you 

select in the Create Record step under Actions. 

 

10. In the Specify Record Creation and Update Details section, click  to define the 

conditions for creating or updating a record and specify the properties of the record. 

 

a. In the Name box, enter a meaningful name for the rule item. 

b. In the Conditions section, select the record, channel properties, fields, and 

relational query operators to specify when a target record should be created 

or updated. 

For example, to create a record from a social post (social activity) with a 

sentiment value of less than 3, an influence score greater than 60, and 

hashtags containing SilverCreditCard, you can add the following conditions: 

 

 

 

 

You can also use channel properties in your conditions. 

 

 

 

Here’s the rule item after you add all the conditions: 

 

 

 

c. Add steps to create or update records for the incoming activity that matches 

the conditions you defined earlier. 
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i. Under Actions, click Add Step > Create record. 

ii. In the Create box, select the record type for the record you 

want to create from the incoming activity. For example, if you 

want to create a case from the social activity, select Case. 

Note  

If the incoming activity has a regarding object set, 

and if the regarding object entity and the entity 

selected in the Create Record step aren’t the same, 

no workflow is applied and the actions defined in the 

rule are not executed. 

iii. Click Set Properties. 

The entity form is displayed. You can map the target entity 

fields to the social activity record data, including channel 

properties. Some of the mappings are available out of the box: 

Case title, Customer, and Origin (highlighted in yellow). The out-

of-the-box mappings can be changed and new mappings can be 

added using the Form Assistant control. 

 

 

 

The new record that is created will be automatically set as the 

regarding record of the incoming activity record. There is only 

one regarding object to the social activity, so, only one Create 

record action is possible in the Actions section. 

iv. To add more actions, under Specify Other Actions, click 
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Add Step > <Action>. The available actions are: Create 

Record, Update Record, Send Email, or Start Child 

Workflow.  

Learn more about each of these actions in TechNet: Configure 

workflow steps. 

 

 

d. Click Save and Close. 

 

Note  

 Data types "Option Set" and "Two Option" are not supported in string type conditions. 

 The property items for each of the supported data types need to have a default value. 

This requirement is important in scenarios where the configured property line items 

have a blank incoming web request. In such cases, the property line item will take the 

default value when referred to in a workflow.  

11. Turn on the rule so that CRM can start creating or updating records for incoming activities 

based on the defined conditions. More information: Activate a record creation and update 

rule. 

Tip  

Developers can also apply rules retroactively to the incoming CRM records that 

might have been skipped while a rule was edited. More information:  MSDN: 

ApplyRecordCreationAndUpdateRuleRequest Class 

Set up channel properties 

Every default or custom activity has an Additional Parameters attribute. This attribute stores the 

JSON payload received from an external application.  

You can find these parameters in the Additional Parameters field of any incoming activity. 

To capture this information in CRM and associate it with the record creation or update rule, you 

can define channel properties in a channel property group and associate them with a rule or 

share them across multiple rules. For example, along with a social post, you can capture 

important information about the post, such as rating or influencer score. Rating and influencer 

score are the properties of social channel. 

1. After you save the record creation and update rule form, under Channel Properties 

section, in the Additional Properties box, click the lookup button, and then click New.  

 

 

 

Create channel property groups and add channel properties 

https://technet.microsoft.com/library/dn531057.aspx
https://technet.microsoft.com/library/dn531057.aspx
https://msdn.microsoft.com/library/microsoft.crm.sdk.messages.applyrecordcreationandupdaterulerequest.aspx
https://msdn.microsoft.com/library/microsoft.crm.sdk.messages.applyrecordcreationandupdaterulerequest.aspx
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A channel property group form opens. 

Important  

A property group record contains multiple property items.  

To fix this issue, first delete the properties from the conditions and steps that use 

the record, and then save or activate the rule. 

2. Enter a meaningful name for the property group, so you can easily identify it while adding 

it to any record creation or update rule. 

3. The Source Type field will be automatically set to the source type of the record creation 

and update rule. 

4. Click Save.  

5. In the Channel Properties section, click + to add in the group-specific channel 

properties. 

6. In the Channel Property form, enter the following: 

a. Name. Type the property name as it appears in the activity’s payload.   

Note  

The name can contain only alphanumeric and underscore characters and 

shouldn’t be longer than 300 characters.  

To see properties received for an activity, go to Sales or Service or Marketing > 

Activities, and open the activity, and see the Additional Parameters field. 

Note  

This field isn’t available on the activity form by default. A system customizer 

can add the field to the activity forms. The field will have the JSON payload 

only when the external application sends it for the activity. 

 

 

 

Important  

 Create a channel property for each name from the name-value pair that you want to 

use in your record creation and update rule. For example, you could use 

influenceScore as a property name.  

 The information in the JSON payload isn’t very easy to read. To make it more 

readable, you can use online JSON parser that will provide a better output. 

 The property group doesn’t support adding nested values in a JSON payload as 

channel properties. The following sample shows the "FollowersCount" under the user 

node as a nested JSON key-value pair. 

 

http://json.parser.online.fr/
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b. Data Type. Select a data type for the channel property. For example, if the property 

is influence score, use the data type as Whole Number because its value can’t be in 

decimals.  

The selected data type will determine the relational query operators when you use 

the property to define conditions in the record creation and update rule items. CRM 

supports creating properties only of the following data types: Floating Point Number, 

Single Line of Text, and Whole Number. 

Note  

 Option Set and Two option data types are supported in conditions of type string. 

You’ll have to type out the option set value in the conditions.  

 CRM sets a default value for property items for each of the supported data types. 

This is for scenarios when a channel property is used in a workflow but the incoming 

payload has no value provided from the external channel; the workflow conditions in 

which the property is referred use a least the following default value: String: “”, Whole 

Number: -2,147,483,648, Float: -1e+011. 

c. Application Source. Type the name of the application that this property is related to, 

for example, Microsoft Social Engagement. 

d. Description. Type details to further explain what the property is for. 

7. When you’re done, click Save & Close. 

You can see all the properties in the channel property group form. 

 

 

 

Activate a record creation and update rule 
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For any record creation and update rule to apply to a matching incoming activity, after you add 

the rule items, you must activate the rule. 

1. Go to Settings > Business Management or Service Management. (How do I get 

there?) 

2. Click Automatic Record Creation and Update Rules. 

3. Open the rule you want to activate, and on the command bar, click Activate.  

Note  

You can have two record creation and update rules active at a time for any 

source type, except email—one with queue and one without a queue. You can 

have only one record creation and update rule active for the source type Email, 

and this rule should have a queue specified.  

After the rule is active, the only way to change the rule is to first deactivate it. Open the 

rule, and on the command bar, click Deactivate. 

Manage automatic record creation and update from a queue form 

You can create or manage an automatic record creation and update rule from a queue form, too. 

To do this, open the queue record, and on the command bar, click Email Activity Conversion 

Settings or Social Activity Conversion Settings.  

More information:   Create or edit a queue 

Upgrade considerations 

Here are a few things you should know if you’re upgrading to Microsoft Dynamics CRM Online 

2015 Update 1 or later from an earlier release, and have existing case creation rules for email 

and social activity.  

 
 

Existing rules prior to upgrade What happens to the rules after upgrade? 

A rule that has rule items with conditions and 

properties defined 

 The rule and rule items are upgraded and 

the properties and conditions in the existing 

rule items are preserved. 

  A new rule item is created with blank 

conditions. A new Create Record step (with 

Case selected) is added with out-of-the-box 

property mapping. The rule items are 

applied in an order and the newly-created 

rule item is considered last in the order. 

A rule that has a rule items with conditions , but 

no properties defined 

 The rule and rule items are upgraded and 

the conditions in rule items are preserved. 

  A new rule item is created with blank 

To activate a record creation and update rule 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Existing rules prior to upgrade What happens to the rules after upgrade? 

conditions. A new Create Record step (with 

Case selected) is added with out-of-the-box 

property mapping. The rule items are 

applied in an order and the newly-created 

rule item is considered last in the order. 

A rule that has a rule items with no conditions 

or properties defined 

 The rule and rule items are upgraded. 

  A new rule item is created with blank 

conditions. A new Create Record step (with 

Case selected) is added with out-of-the-box 

property mapping. The rule items are 

applied in an order and the newly-created 

rule item is considered last in the order. 

A rule that has a rule items with properties, but 

no conditions defined 

 The rule and rule items are upgraded and 

the properties in the rule items are 

preserved. 

  A new rule item is created with blank 

conditions. A new Create Record step (with 

Case selected) is added with out-of-the-box 

property mapping. The rule items are 

applied in an order and the newly-created 

rule item is considered last in the order. 

A rule with no rule items  The rule is upgraded. 

  A new rule item is created with blank 

conditions. A new Create Record step (with 

Case selected) is added with out-of-the-box 

property mapping. The rule items are 

applied in an order and the newly-created 

rule item is considered last in the order. 

An active case creation rule for social or email 

source types, with a queue specified 

All such rules will be upgraded in an active 

state. 

An active case creation rule for social or email 

source types, without a queue specified 

All such rules will be upgraded and deactivated. 

This is because even in Microsoft Dynamics 

CRM Online Spring ‘14, a case creation rule 

without a queue did not apply and create any 

record.  

 

 

See Also 

Create rules to automatically route cases 
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Create or edit a queue 

Create or edit a queue 

Make sure that activities or unresolved cases are acted upon faster by using queues in Microsoft 

Dynamics CRM.  

Queues can be useful in: 

 Having a centralized list of pending work that needs attention 

 Sorting tasks by type or by the people assigned to complete them 

 Use queues to categorize and prioritize your activities and cases. You can categorize based on:   

 Different products or services 

 Different subscription levels (regular, premium customers) 

 Various activity categories 

 Different geography 

Create or edit a queue 

1. Make sure that you have the Sales or Marketing Manager, Customer Service Manager, 

System Administrator, or System Customizer security role or equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Service Management or Business Management.  

3. Choose Queues. 

4. To create a new queue, click New.  

-OR- 

To edit a queue, in the list of queues, click the queue, and then on the command bar, 

click Edit.  

5. Type or change information in the text boxes. 

Hovertips provide hints about what to enter. 

 In the Summary section, complete the required fields. 

 In the Name field, type the name of the queue.  

 In the Type field, choose if the queue is a private or public queue. You can use a 

private queue to allow only a specific set of people to work on activities in this queue.  

If you’re creating a private queue, you’ll need to add members to this queue 

manually. In the Members section, click the Add button + to add members to the 
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queue. Only these members will be able to work on the items in this queue. 

Note  

The email address you enter in the Incoming Email field receives all 

messages sent to the queue. 

 In the Email Settings section, in the Convert to email activities drop-down list, 

choose which messages to track as activities. 

 In the Mailbox field, a mailbox record for the queue is automatically created and 

selected as soon as you save the queue record. To update the mailbox details, click 

the mailbox name. More information:   TechNet: Create forward mailboxes or edit 

mailboxes 

 In the Record creation and update rules section, add a Record Creation and 

Update Rule record. By using these rules, you can automatically create or update 

system or custom records from incoming CRM activities, such as emails, social 

activities, or custom activities.  More information: Set up rules to automatically create 

or update records in CRM 

This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-

premises).  

 

 Interested in getting this feature? Find your CRM administrator or support person 

Important  

This is a central place to manage rules across all supported activities 

including out-of-the-box and custom activities associated with the queue. 

The Record creation and update rules section displays rules that have 

been created in CRM Online 2015 Update 1, using the Email Activity 

Conversation Setting  or Social Activity Conversation Setting and that 

have the same queue ID as the queue.  

If you used Email to Case or Social to Case rules from earlier versions, 

such as CRM Online Spring ‘14 or CRM 2013 Service Pack 1 (on-premises), 

then you will be able to see your rules in this section when you upgrade to 

CRM Online 2015 Update 1.  

Multiple rules with the same source type and same queue can exist. 

Therefore, when you click Email Activity Conversion Settings or Social 

Activity Conversion Settings, the rule with the latest Last Modified On 

date is applied.  

6. Click Save. 

View queue items 

In the Queue Items section, all activities that are either routed to this queue automatically by the 

routing rules or the activities that are manually assigned to this queue will be listed here. 

https://technet.microsoft.com/library/dn832085.aspx
https://technet.microsoft.com/library/dn832085.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
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Additional actions 

To create records for this queue, on the command bar, click Email Activity Conversation 

Settings or Social Activity Conversation Settings. 

More information:    Set up rules to automatically create or update records in CRM or 

Automatically create a case from an email 

See Also 

Create and manage a case 

Find what's assigned to you in a queue 

Set up queues to manage activities and cases 

eBook: What’s new in customer service 

Set up queues to manage activities and cases 

Use queues to organize, prioritize, and monitor the progress of your work. In Microsoft Dynamics 

CRM, queues are containers used to store anything that needs to be completed or requires an 

action, for example completing a task or closing a case.  

For CRM Online organizations, the private and public queues or automatic case creation 

functionality is available only in organizations that have applied product updates for CRM 

Online Spring ‘14 or later or have installed the CRM Online 2015 Update or later.  For 

CRM on-premises organizations, these features are available if they have installed CRM 

2013 Service Pack 1 (on-premises) or later, or have updated to CRM 2015 or later. 

Interested in getting this feature? More information:   Find your CRM administrator or 

support person 

Create queues 

By default, a queue is created for each user and team in Microsoft Dynamics CRM. You can use 

this default queue to track all your work items, or you can set up queues to reflect your 

organization's structure, business processes, or both. How you set up queues depends on how 

your business works. For example, you could create separate queues for First Tier and Second 

Tier product support teams that reflect their differing levels of expertise, or Gold and Silver 

queues to reflect differing priorities based on service contracts that customers have with your 

organization. 

Microsoft Dynamics CRM lets you create two types of queues: private or public. Create private 

queues with limited sets of members to let only those members view the items in the queue.  

Create public queues to let everyone in the organization view the items in a queue. 

Route items to queues 

For all cases that are automatically created from incoming email and social posts, create routing 

rules to route the cases to queues. Then assign the items in the queue to appropriate CSRs or 

users. Alternatively, you can manually add cases and activities to queues.  

Note  

http://go.microsoft.com/fwlink/p/?LinkID=393186
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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Assign items in the queue to work 

Queues share cases or activities as a group until these are taken out of the queue, or accepted, 

by a customer service representative (CSR) who assumes responsibility for handling them. CSRs 

can pick the items for themselves, or a customer service manager (CSM) can manually route 

these cases to the CSRs or to other queues, users, or teams.  

See Also 

Create or edit a queue 

Find what's assigned to you in a queue 

Create rules to automatically route cases 

Automatically create a case from an email 

Add a timer control to the Case form to track time against an SLA 

You can add a timer control to the Case form to help customer service representatives gauge the 

amount of time they have to complete a task—typically associated with a service level agreement 

(SLA). The timer control initially displays a count-down timer to show the time remaining to 

complete the task. 

The timer control can show any of the following, depending on the actions of the customer service 

representative (CSR) and what you specify when you set up the timer control: 

 If the CSR completes the task within the time remaining, the control shows the word 

Succeeded. 

 If the CSR doesn’t complete the task within the time remaining, the control shows the word 

Expired. 

 As the timer counts down, the color changes to yellow as the time remaining nears non-

compliance. If the time remaining expires, the timer shows the word Expired. Then the timer 

color changes to red and the timer starts counting up to show the elapsed time since the task 

should have been completed. This behavior is optional. 

 If a condition causes the milestone to be canceled, the control shows the word Canceled. 

This behavior is optional. 

 If either of the required fields in the Timer Control dialog box do not have a value in the 

record, the control shows the words Not Set.  
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Add a timer control to the Case form 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. Click Customize the System. 

4. In the solution explorer, in the left nav pane, expand Entities, expand the Case entity, 

click Forms, and then open the Case form. 

5. Click on the form where you want to place the control. You can add it anywhere except 

the form header or footer. 

6. On the Insert tab, in the Control group, click Timer. 

 
 

7. In the Timer Control dialog box: 

 

a. In the General section, enter a name and label for the control. 

b. Under Data Source, next to Failure Time Field, select the date-time field 

that represents the time when a milestone should be completed. For 

example, select the First Response By field. 

c. Next to Success Condition, select a field to use to evaluate the success of 

the milestone, and then select the condition that indicates success. For 

example, select the First Response Sent field, and then select Yes to 

indicate the success criteria of the First Response metric. This setting is 

required. 

d. Next to Warning Condition, enter the condition that will cause the timer 

control to display a warning when the time is about to expire. For example, in 

the first list next to Warning Condition, select First Response SLA Status. 

In the list to the right, select Nearing Noncompliance. This setting is 

optional. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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e. Next to Cancel Condition, select a field to evaluate whether the 

achievement of the milestone should be canceled. Then choose the option 

that indicates the milestone is canceled. This setting is optional.  

 
 

 

8. Click OK to add the control to the form.  

 

Notes 

 The timer control refreshes on the OnChange form event, and also when the form is loaded. 

 You can add a timer control to a form based on any record type (entity), including custom 

record types.  

 You can add multiple timer controls for different key performance indicators (KPIs). 

 You can add a timer control to any Main form, but timer controls are not displayed in 

Microsoft Dynamics CRM for tablets. 

See Also 

Define service level agreements (SLAs) 
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TechNet: Common field properties 

TechNet: Special field properties 

Define status reason transitions for incident (case) management 

There’s new capability to specify status reason transitions for the Case record type (entity) or 

custom record types. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person   

If you’re in charge of incident management for an organization, it’s important to provide a simple 

model for customer service representatives responsible for entering and updating case status. In 

CRM, there are two fields that work together to provide information about case status: the Status 

field and the Status Reason field. The Status field for the Case record type has three possible 

values: Active, Resolved, or Canceled. The Status Reason field stores a reason for a specific 

status value. For example, for a case with an Active status, a status reason could be In 

Progress, On Hold, Waiting for Details, or Researching. 

Big organizations often have a large number of combinations for the Status and Status Reason 

fields. This can make it difficult for customer service reps to choose the correct next status 

reason. You can define status reason transitions to add another level of filtering for what the 

status reason value can be changed to for each status reason. Limiting these values to just 

allowed status reasons can help customer service representatives make the right choices. 

 
 

 

 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

Important  

 

https://technet.microsoft.com/library/dn531185.aspx#BKMK_FieldProperties
https://technet.microsoft.com/library/dn531185.aspx#BKMK_SpecialFieldProperties 
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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2. Go to Settings > Customizations. (How do I get there?) 

3. Click Customize the System. 

4. In the solution explorer, in the left navigation pane, expand Entities, expand the Case 

entity, and then double-click Fields. 

5. Go to the second page of fields, and then open the statuscode (Status Reason of Case) 

field. 

6. In the Field: Status Reason dialog box, click Edit Status Reason Transitions at the top 

of the dialog box. 

 
 

7. In the Status Reason Transitions dialog box, under New Status Reasons, click one of the 

Enter Value buttons  corresponding with one of the existing status reasons. 

8. In the Select Status Reason dialog box, in the Available Values list, select the values you 

want to add, and then click the chevron button  to add to the Selected Values list. Click 

OK when you’re done with that status reason. 

9. Click another Enter Value button  to modify other status reasons. When you’re done, click 

OK. 

Note  

Each status reason option for an active status must allow at least one path to an 

inactive status. Otherwise, you could create a condition where it would not be 

possible to resolve or cancel a case. 

10. In the Status Reason Transitions dialog box, select the Enable Status Reason 

Transitions check box to apply the defined status reason transitions to case records. 

http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
189 

The list of available status reasons will be filtered for each case record based on the 

defined transitions.  

See Also 

TechNet: Define status reason transitions 

Create or edit entity fields 

Work with cases 

 

Create and manage a case 

Merge similar cases 

Create and manage parent and child cases 

Add a phone call, task, email, or appointment activity to a case or record 

Create or edit an appointment 

Create and manage a case 

Keep track of your customer requests and issues by creating support cases in Microsoft 

Dynamics CRM. When a customer contacts support with a question or problem, you can quickly 

check if there is an existing case or open a new case and start tracking the issue. You can also 

escalate, reassign, or put a case back into the service queue if you don’t have enough 

information or time to work on it. 

Before you provide support, you can also check the customer’s entitlements. Entitlements are like 

contracts that tell you what kind of support a customer is eligible for. You can see if the support 

terms are based on number of hours or cases, support channel, or based on the product or 

service that the customer has purchased.   

To help you select the right status of a case, your admin may have set things up so that you only 

see a limited set of statuses based on the current status of a case. For more information on the 

available list of case statuses, contact your administrator.  

 

 

 

Create a case 

1. Go to Service > Cases. (How do I get there?) 

2. Click New Case. 

3. Find the customer:  

 

https://technet.microsoft.com/library/dn660979.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
190 

a. Click the Customer lookup button. By default, this field shows both account and 

contact records. Or, type a few letters and press Enter to search for records that 

contain the letters. When you select an existing customer, the customer details will 

show the contact details, along with recent cases and activities for the customer.  

b. If a customer record doesn’t exist, click New in the inline lookup results to create a 

new record.  

 

4. Click the Contact lookup button and select an existing contact for the case or click New 

in the inline lookup results to create a new contact record. 

5. Before you create a new case, check if there is an existing case:  

a. From the Identify area of the process bar, click the Find Case lookup button and 

then select a case from the list of cases. 

b. If a case doesn’t exist, click New in the inline lookup results to create a new case 

record. 

 

6. In the Case title field, type a subject or descriptive name to identify the case. 

7. To track your conversation with the customer, add activities. More information:  Add a 

phone call, task, email, or appointment activity to a case or record 

8. To see what kind of support you should provide the customer, click the Entitlements 

lookup button and select an active entitlement.  

Important  

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-

premises).  

 Interested in getting this feature?  Find your CRM administrator or support 

person.  

Note  

 If your manager has set default entitlements for a customer, a default entitlement is 

automatically associated with a case when: 

 A case is created 

 A case is updated and the customer, contact, or product field has changed 

 When a case is created and an entitlement is applied to it (or when the case gets 

resolved), the entitlement terms from the associated entitlement are decremented. 

However, if you don’t want the entitlement terms to be decremented for a case, from 

the command bar click Do not decrement entitlement terms. 

 

9. Fill in the other details that apply to the case, and then click Save. 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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Find a solution from similar cases 

You can look at resolved cases to see if they can help you resolve the open case you’re working 

on. For example, if the subject of the case you’re working on is “Service outage,” you could look 

for resolved cases with the same subject to get help with your current case.  

1. Go to Service > Cases. (How do I get there?) 

2. In the list of active cases, open the case you’re looking for. 

3. When the case is open, to find similar cases, click Case Relationships to expand the 

menu.  

4. For Similar Cases, click (+) Add Connection record.  

5. From the Find Similar Cases dialog box, use the search to find similar cases. 

Select a different subject to see the cases with that subject. You can also search for 

cases by typing the keyword in the searc box, and then click the Search button. When 

you use a search keyword, it searches on the title of the case and shows the matching 

results. 

 

6. When you find a similar case, click the case to review the case activities, posts, and 

notes. 

Typically, a phone call, task, or case resolution activity has the information about how the 

case was resolved.  

7. Once you find the case that has the information you need, click the case, and then click 

Found a Solution. 

The case you select is added to the Similar Cases area for the case you’re working on. 

Resolve a case 

For information about how to resolve parent and child cases, see “Resolve a case with a parent 

and child relationship” section in Create and manage parent and child cases. 

1. Go to Service > Cases. (How do I get there?) 

2. In the list of active cases, open the one you want to resolve. 

3. On the command bar, click Resolve case.  

Important  

Before you resolve a case, make sure that all the case activities are closed. 

Otherwise, you’ll get a message saying that you still have open activities 

associated with the case, which will be canceled if the case is resolved. 

4. In the Resolve Case dialog box, in the Resolution Type list, select how the case was 

resolved. 

5. In the Resolution box, type a short explanation of the resolution. 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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The actual time spent on all activities for this case, as recorded in the Duration box in 

each activity, is filled out automatically in the Total Time box. 

6. In the Billable Time list, select the amount of time spent on the case to be billed to the 

customer. 

If this case is linked to a contract or entitlement, the billable time will be subtracted from 

the allotted minutes for that contract. 

7. Click Resolve. 

A case resolution activity is created and shown in the Activities area. The resolution 

activity contains information about a resolved case, including the resolution and total time 

spent on the case. You can reactivate a resolved case at any time. 

Edit a case 

1. Go to Service > Cases. (How do I get there?) 

2. From the list of cases, open the case you want to edit. 

3. When the case is open, make the necessary updates to the case. 

4. When you’re done, click Save. 

Cancel a case 

All case activities must to be closed before you can cancel a case. 

1. Go to Service > Cases. (How do I get there?) 

2. In the list of active cases, open the case that you want to cancel, and then on the 

command bar, click Cancel Case.  

3. In the Confirm Cancellation dialog box, select the case status:  

 Canceled: This means the case is canceled and it will no longer be assigned to you. 

 Merged: This means the case is merged into another case. When the case is 

merged, the case activities will be moved to the case it was merged into. 

 

4. Click Confirm. 

Reassign a case 

If you don’t have enough information to resolve a case, or if you think another member in your 

team has expertise on the subject, you can assign the case to another user or team. 

1. Go to Service > Cases. (How do I get there?) 

 

 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. Select the case that you want to reassign. 

3. Do one of the following: 

a. If using the web app: On the command bar, click More Commands  and select Assign.  

b. If using CRM for Outlook: In the Collaborate group, click Assign. 

4. Click the Lookup button , and select who you want to assign the case to. 

5. Click Assign. 

Add a case to a queue 

 If you think another group in your team has the expertise on the subject, you can move the case 

to a queue so that someone else can pick it up. 

1. Go to Service > Cases. (How do I get there?) 

 

2. Select the case that you want to add to a queue. 

3. Do one of the following: 

a. If using the web app: Click the More Commands icon , and select Add to Queue. 

b. If using CRM for Outlook: In the Collaborate group, click Add to Queue. 

4. Click the Lookup button , select the queue that you want to add the case to, and then 

click Add.  

Save and route a case 

When you create a new case, you can save it and route it with a single click using the Save & 

Route button. 

1. Go to Service > Cases. (How do I get there?) 

 

2. Open a case record.  

3. On the command bar, click Save & Route. 

4. In the Route Case dialog box, click Route.  

The case is routed based on the active routing rule set. 

Important  

 The Save & Route button is available only on active cases. 

 The Apply Routing Rule button that was earlier available on the case form is now 

available in the list of records for applying the routing rule on multiple cases.  

See Also 

Video: How to create, reactivate, and reassign a case (1:47) 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkID=394984
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eBook: Give great customer service with CRM 

Quick ref card for customer service reps 

Merge similar cases 

Create and manage parent and child cases 

Find what's assigned to you in a queue 

Merge similar cases 

Eliminate redundancies between similar cases in Microsoft Dynamics CRM by merging them into 

one case. When a customer opens multiple cases about the same issue (through different 

support channels), or when multiple customers from the same account call in about the same 

issue, you can merge those cases into one case so everything’s visible in one place. 

For example, when a customer or multiple customers from the same account submit a case on 

the web and also call in about the same issue, you can merge the cases into one case instead of 

keeping track of multiple cases. 

When a case is merged, the state of the case is changed to canceled, and the status is changed 

to merged. This is because it is merged into another case and all of the open case activities, 

emails, and attachments are now associated with the case it was merged into. By default you can 

merge up to 10 cases at a time.  

A few things to remember when you merge cases with parent and child relationships: 

 When you merge a case that has child cases, those child cases become child cases of the 

parent case they were merged into. 

 You can only merge a child case into another child case if both of the child cases have the 

same parent case. 

More information:  Create and manage parent and child cases 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

 

 

1. Go to Service > Cases. (How do I get there?) 

2. In the list of active cases, select the cases you want to merge. You must select at least 

two active cases. 

3. On the command bar, click Merge Cases.  

4. In the Merge Cases dialog box, from the list of cases, select the case the other cases will 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=393634
http://go.microsoft.com/fwlink/p/?LinkID=330911%20
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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be merged into, and then click Merge. 

5. To see the merged case, open the case it was merged into, and you’ll find the merged 

case listed under Case Relationships > Merged Cases. 

See Also 

Create and manage a case 

Create and manage parent and child cases 

Video: How to create, reactivate, and reassign a case (1:47) 

eBook: Give great customer service with CRM 

Quick ref card for customer service reps 

Create and manage parent and child cases 

You can manage multiple cases more efficiently if you use parent and child cases in Microsoft 

Dynamics CRM. When you need to track a case where work needs to be done by other 

departments or when you need to track the same issue for multiple customers, you can open a 

primary case called the parent case, and then create secondary cases called child cases. 

For example, if you get a service request to install new electrical and gas connections, this 

requires work to be done separately by the gas and electric department. In this situation, you can 

open two child cases, one for the gas and the other for the electric department. The original case 

is marked as the parent case. Once the child cases are resolved, you can then close the parent 

case.  

Similarly, you can create parent and child cases when multiple customers call in about the same 

issue, for example, a network outage. Instead of creating a new case for each customer, you can 

create a parent case to track the main network outage with the Network Operations team, and 

then create child cases when customers call in about the issue. 

Note, a child case can’t have a child case. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

 

Create a new child case 

When you need to create a child case for the case you’re working on, you can quickly do this 

from the case form. 

 A case can only have up to 100 child cases. 

Important  

Important  

http://go.microsoft.com/fwlink/p/?LinkID=394984
http://go.microsoft.com/fwlink/p/?LinkId=393634
http://go.microsoft.com/fwlink/p/?LinkID=330911%20
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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1. Go to Service > Cases. (How do I get there?) 

2. When the case form is open, do one of the following: 

 On the command bar at the top, click Create Child Case. 

 Or, choose to expand Case Relationships, and next to Child Case, click (+) Add 

Case record. 

 

3. Next, fill in the necessary case information for the child case, and then click Save. 

4. To see the child case that was just created, from the parent case, click Case 

Relationships, and you’ll see the child case listed under  Child Cases.  

Associate a parent case to a child case 

You can create a case and then associate it as child case. 

A child case can’t have a child case. 

1. Go to Service > Cases. (How do I get there?) 

 

2. Then, do one of the following: 

From your active list of cases, do this:  

a. Select the cases that you want to associate as parent and child case(s). You 

must select at least two cases. 

b. On the command bar at the top, click Associate Child Cases.  

c. In the Set Parent Child Relationship dialog box, from the list of cases, 

select the case that you want to make the parent case, and then click Set.  

 

From an open case, do this: 

a. From the open case form, choose to expand Case Relationships, and next 

to Child Case, click (+) Add Case record. 

b. Click the Lookup button, and then find the case you want associate as the 

child case. 
 

Associate a child case to a parent case  

You can associate a parent case to a case from the case form. 

 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Go to Service > Cases. (How do I get there?) 

2. Open the case that you want to link a parent case to. 

3. From the case form, click the Parent Case and use the search to find a case that you 

want to associate as the parent case for this case.  

Resolve a case with a parent and child relationship  

Depending on your settings, a case with a parent and child relationship can be closed in one of 

the following ways:  

Sometimes, resolving a case action might be blocked based on your current case status. 

This is because your admin may have set things up so that you only see a limited set of 

statuses to choose from based on the current status of a case. For more information 

about the available list of case statuses, contact your administrator. 

 When all the child cases are resolved, you can then close the parent case. 

 When you resolve the parent case, it will then resolve all the active associated child cases. 

 A parent and child case can be closed independently of each other. This is the default 

setting. 

1. Go to Service > Cases. (How do I get there?) 

2. In the list of active cases, open the one you want to resolve. 

3. On the command bar, click Resolve case. 

Important  

Before you resolve a parent case with active child cases, make sure that all the 

case activities are closed. Otherwise, you’ll get a warning stating that you need to 

manually close the open activities or the system will automatically cancel the 

open activities when the case is resolved. Also, performance may be slow when 

you close a parent case with lots of active child case associated with it.  

4. In the Resolve Case dialog box, in the Resolution Type list, select how the case was 

resolved. 

5. In the Resolution box, type a short explanation of the resolution. 

The actual time spent on all activities for this case, as recorded in the Duration box in 

each activity, is filled out automatically in the Total Time 

6. In the Billable Time list, select the amount of time spent on the case to be billed to the 

customer. 

If this case is linked to a contract or entitlement, the billable time will be subtracted from 

the allotted minutes for that contract. 

 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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7. Click Resolve. 

A case resolution activity is created and shown in the Activities area. A case resolution 

activity contains information about a resolved case, including the resolution and total time 

spent on the case. You can reactivate a resolved case at any time. 

See Also 

Create and manage a case 

Merge similar cases 

eBook: Give great customer service with CRM 

Quick ref card for customer service reps 

Video: How to create, reactivate, and reassign a case (1:47) 

Add a phone call, task, email, or appointment activity to a case or record 

The activity and notes area helps you keep track of all the interactions with your customers. 

Record all important conversations with the customer or the communication with your team 

members regarding a record in Microsoft Dynamics CRM. Add a phone call, task, notes, email, or 

appointments right within the case, account, contact, lead, or opportunity records without 

navigating to a different area and opening another form. 

All activities that you add from within a record appear in the Activities area. If the Regarding 

field of an activity is set, the activity appears in the activity wall of the regarding record. You can 

filter the list to show just the activities that are in progress or the ones that are overdue. Click or 

tap the inline Complete link to close the activity as Completed. 

 

Add a phone call 

1. Open the record you want to add the activity to. 

2. If you do not see the Add Phone Call area open in the middle of the page, click Activities > 

Add Phone Call.  

3. In the Description area, provide a summary of the conversation with the customer. You must 

fill in this area before you can save the phone call. 

The Call With field is automatically populated with the customer name you select in the 

account or contact field. You can select a different contact, account, lead, or user record if 

required.  

4. By default, the direction is set to Outgoing. You can change it to Incoming by clicking or 

tapping the Phone Support button in the list of case records. To select multiple records, click 

Look Up More Records, and then in the Look Up Records dialog box, select the records. 

5. Select the Left voice mail check box if you make an outgoing call to a customer and leave a 

voice mail for them. You can also select this check box if a customer leaves a voice mail 

message when they call you. 

6. Click OK to save the activity. 

http://go.microsoft.com/fwlink/p/?LinkId=393634
http://go.microsoft.com/fwlink/p/?LinkID=330911%20
http://go.microsoft.com/fwlink/p/?LinkID=394984
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By default, every phone call activity that you add in context of a record is marked 

Completed when the record is saved at least once. However, if you add a phone call 

activity to an unsaved record, or if you create a new activity and then set the Regarding 

field of the activity to another entity record, the activity is set to an Open state. You can 

click the Complete link to close the activity as Completed. The Complete link is 

available only after you save the case record at least once. 

Add a task 

1. Open the record you want to add the activity to. 

2. In the middle of the page, click Activities > Add Task.  

3. Fill in your information. Use the handy tooltips as a guide. 

4. The Owner field is set to the current user by default. If you want to reassign the task, click the 

lookup icon, and then select another user or team. 

5. Click OK to save the task. 

Add an email 

To add an email activity to a record, you must first save the record you are adding the activity to. 

1. Open the record you want to add the activity to. 

2.  In the middle of the page, click Activities > More Commands  > Email.  

3. Fill in your information. Use the handy tooltips as a guide. 

4. To save the record, click Save. 

5. To add an attachment to the email, under Attachments, on the right, click +. 

6. To use a template for the email body, in the email editor, click Insert Template, and then 

select the template.  

7. To attach an article to the email, in the email editor, click Insert Article, and then add the 

article. 

8. Click Save. 

Add an appointment 

To add an appointment activity to a record, you must first save the record you are adding the 

activity to. 

1. Open the record you want to add the activity to. 

2. In the middle of the page, click Activities > More Commands  > Appointment. 

3. Fill in your information. Use the handy tooltips as a guide. 

4. To save the record, click Save. 

Add notes 

You can also easily add notes in the activities area. And if you’re on the latest version of Microsoft 

Dynamics CRM Online, you have the benefits of using OneNote to take or review customer notes 

Note  
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from within your CRM records. For more information on OneNote, see: Set up and use OneNote 

in CRM. 

This doesn’t replace the current Notes feature, but gives you another way to access notes stored 

in OneNote. 

 

 
 

 

1. Open the record you want to add the activity to. 

2. In the middle of the page, click Notes or OneNote. Then do one of the following: 

 In the Notes area, start typing your notes. 

 In the OneNote area, select a notebook to make entries. 
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The notebook is stored in the associated SharePoint folder for the record. If there is 

more than one associated folder, the notebook is created in the first folder. For more 

information see, Set up and use OneNote in CRM. 

Create an activity and associate it with a customer 

You can also create an activity from the Activity area and then link it to a customer or support 

case. 

1. Go to your work area.  

2. Go to Activities. (How do I get there?) 

3.  On the command bar, select and add an activity. Fill in your information. Use the handy 

tooltips as a guide. 

4. Use the Regarding field on the activity form to associate it with a customer or support case. 

 

See Also 

Set up and use OneNote in CRM 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Create and manage a case 

Create or edit an appointment 

Block time to meet or talk to your customers by using appointments. You can modify any of the 

information in an open appointment. If you change the date and times of the appointment, 

Microsoft Dynamics CRM will recheck for schedule conflicts.  

The calendar displays canceled and completed appointments and service activities. To remove 

an appointment or service activity from the calendar, delete the record. 

1. Do one of the following: 

To create an appointment or a recurring appointment on the Service Calendar, on the 

nav bar: Go to Service > Service Calendar. (How do I get there?) 

To create an appointment or recurring appointment in the Activities area, on the nav bar: 

Go to Sales > Activities. (How do I get there?) 

2. On the command bar, click Appointment. 

3. Type or change information in the text boxes. You can point to a field to get a tip on what 

data to enter.  

4. If this is a recurring appointment, click Recurrence, and then select the time, pattern, and 

date range you want. 

5. Click Save. 

If any participants have a schedule conflict, a warning appears. You can click Ignore and 

Save to save the appointment anyway. 

6. If you want to add an attachment, make sure you save the appointment first. Then, in the 

Attachments section, click the Add attachment record button  (you may have to scroll to 

the right to see the button) and browse for the file. The attachment size limitation is the same 

as the email attachment size limitation, which can be changed by your system administrator. 

More information:  System Settings dialog box - Email tab 

Note  

You can’t insert attachments in a recurring appointment. 

If you plan to include appointments in solutions, we strongly recommend that you don’t 

include only appointments and only recurring appointments in separate solutions. If you 

install and uninstall separate solutions with different appointment types, you’ll encounter 

a SQL Server error and you’ll have to recreate the appointments.  

 

 

If you’re using CRM for Outlook 

 

Important  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Keep the following in mind if you’re using Microsoft Dynamics CRM for Outlook in addition to the 

web application: 

 If you’re using the Microsoft Dynamics CRM Online 2015 Update or later, Microsoft Dynamics 

CRM 2015 or later, or Microsoft Dynamics CRM 2015 for Outlook or later, you can 

synchronize appointment attachments between Microsoft Dynamics CRM and Dynamics 

CRM for Outlook if your system administrator has enabled attachment synchronization. You 

can insert the attachments in CRM or Dynamics CRM for Outlook.  

 Appointments created in the web application and synchronized with Dynamics CRM for 

Outlook automatically set a 15-minute reminder and appear on the Microsoft Outlook 

calendar. You can change the reminder in Dynamics CRM for Outlook. 

 Service calendar items aren’t added to your Outlook calendar. 

See Also 

Navigate the service calendar 

Keep track of notes, tasks, calls, or email with activities 

Track Outlook appointments in CRM for Outlook 

Create and manage activities 

 

Schedule a service activity 

Navigate the service calendar 

Find the next available time before creating a service activity 

Create a service activity without checking for conflicts 

Schedule a service activity 

Use this form to search for an available time for a service activity. You can either search for an 

open time using search criteria that, at a minimum, includes selecting a service, or you can define 

a more complex set of criteria. You can also create a service activity without checking for conflicts 

in the scheduled service. The service activity appears as a color block on the service calendar  

You can’t create a recurring service activity. Create individual service activities as needed. 

See Also 

Find the next available time before creating a service activity 

Create a service activity without checking for conflicts 

Navigate the service calendar 

In the Service calendar, you can do the following tasks and activities: 

 View your organization's daily, weekly, and monthly schedule of appointments and service 

activities. 
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 View work schedules and service activity schedules for a variety of resources. 

 Create new appointments and schedule service activities. 

 Change the status of an existing service activity. 

 Search for conflicts in the schedule. 

You can’t customize the Service calendar or change the default view with the application. 

However, you can ask your system administrator to change the colors of the time blocks.  

 

1. 0.1. Go to Service > Service Calendar. (How do I get there?) 

 

2. A list of resources is displayed on the left side of the calendar in alphabetical order. To 

view the resources, appointments, and service activities for anyone in your organization, 

in the Type list, select Resource, and then in the View list select the resource view. 

3. To find a specific resource, in the Search box, enter the first few letters of a name. 

4. To view the details of any resource, appointment, or service activity, select the record in the 

list to the left of the calendar, and then at the bottom of the calendar, under the Zoom scale, 

click the Expand button  to expand the preview pane. You can also double-click a record to 

open it. 

5. The Calendar pane appears on the right side of the calendar. It can be collapsed or 

expanded. To change the date, click a date in the calendar. Use the arrows on either side 

of the month to change the month displayed. 

6. To change the number of days that are displayed in the linear calendar, click any of the 

calendar options in the Calendar pane.  

7. To change how much of the calendar is available to view, use the Zoom scale. Select 

specific date ranges to view in the From and To lists.  

Legend of colors and statuses 

Appointments and service activities appear in the linear calendar as labeled color blocks. Move 

your mouse over these blocks to see the status of the appointment or service activity. 

 

See Also 

Create a service activity without checking for conflicts 

Schedule a service activity 

Create or edit an appointment 

Basics of service and service scheduling 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Find the next available time before creating a service activity 

Avoid conflicts while scheduling services by finding the time the resources are available 

beforehand. 

 

1. Make sure you have the Scheduler role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Service > Service Calendar. (How do I get there?) 

3. Click Schedule. 

4. On the Schedule Service Activity form, type or change information in the text boxes. 

Hovertips provide hints about what to enter. 

 Under Requested Time, select criteria for the times you want: 

 To search for a time on a specific date, in Start Date, select Specific Date, and 

then enter the date you want.  

 To search within a range of dates, select Range of Dates, and then enter the On 

or After and On or Before dates. You can also select specific days of the week. 

 You can also search for times based on dates relative to the current date, such 

as Today, Tomorrow, This Week, Next Week, or Next Month. 

 Similarly, to search within specific range of time, in Start Time, select Specific 

Time, Range of Times, or Morning, Evening, Afternoon. 

 Do not clear the Use Default Duration check box and change the duration unless 

you want to schedule more time than the default duration of the service. The 

maximum duration of a service activity is 10 days. 

5. Click Find Available Times. The next available times are shown. 

6. Under Available Times, select the time for which you want to schedule the service 

activity, and then click Schedule. 

The Schedule Service Activity form closes, and Microsoft Dynamics CRM fills in the 

information from the selected time in the Service Activity form. 

7. Type or modify information in other text boxes, as required. 

Hovertips provide hints about what to enter. 

8. When you’re ready to save your data, click Save. 

The service activity appears as a color block on the Service calendar. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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If you want to find an available time without any time restriction, do not specify any 

criteria under Requested Time, and click Find Available Times.  

See Also 

Create a service activity without checking for conflicts 

Navigate the service calendar 

Create a service activity without checking for conflicts 

Make sure you provide timely and efficient service to your customers by creating a service activity 

that defines who will perform the service and when. In Microsoft Dynamics CRM, a service 

activity uses one or more resources to perform a service at a specific time and place. You can 

create a service activity by finding the next available times of resources for a service or simply 

without checking for conflicts. 

You can force a service activity into a time slot to squeeze another service activity into the 

leftover time from a previous service activity. 

If you save a service activity without finding available times in the schedule, then Microsoft 

Dynamics CRM displays the service activity in the schedule without checking for conflicts. 

One reason to force a service activity into a time slot is to squeeze another service activity into 

the leftover time from a previous service activity. 

 

1. Make sure you have the Scheduler security role or equivalent permissions in Microsoft 

Dynamics CRM. 

2. Go to Service > Service Calendar. (How do I get there?) 

3. On the command bar, click Service Activity. 

4. On the Service Activity form, type or change information in the text boxes. 

Hovertips provide hints on what to enter. 

5. When you’re ready to save your data, click Save. 

You can record a customer's preferences for a specific time, day, service, facility, 

equipment, and customer service representative in the customer record on the 

Administration tab. As you are scheduling a service activity, the customer's preference 

is displayed in the Form Assistant pane. 

Tip  

 

Tip  

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
207 

 If at any time before you save this service activity you want to search the schedule for an 

available time, you can click Schedule in the Actions group to open the Schedule Service 

Activity dialog box. 

 To check the schedule for conflicts, in Service Calendar, in the Actions group, click 

Conflicts. 

See Also 

Navigate the service calendar 

Find the next available time before creating a service activity 

Basics of service and service scheduling 

Create or edit a service 

Manage queue items 

 

Assign an activity to a user or queue 

Find what's assigned to you in a queue 

Assign an activity to a user or queue 

If you want another person in your organization to work on an activity, you can assign the activity 

to that person or move it to another queue.  

Assign to another user or team 

1. Go to Activities. (How do I get there?) 

 

2. If using the CRM web application: In the list of activities, select the activity you want, and on 

the command bar, click More Commands , and then click Assign. 

If using CRM for Outlook: Expand My Work, and then click Activities. 

a. In the list of records, click the record you want. 

b. In the Collaborate group, click Assign. 

3. In the Assign to another user or team field, click Lookup, and select the user or team 

you want to assign the activity to. 

If you don’t see the user or team you are looking for, click Lookup, and then click Look 

Up More Records. From the Look for drop-down list, select User or Team. In the 

Search box, type the name, click the search button, and then click the name to select it. 

Click Add. 

4. Click Assign. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Add to a queue 

1. Go to Activities. (How do I get there?) 

 

2. If using the CRM web application: In the list of activities, select the activity you want, and on 

the command bar, click More Commands , and then click Add to Queue. 

If using CRM for Outlook:  

a. In the list of activities, select the activity you want, and on the command bar, click More 

Commands , and then click Add to Queue. 

b. In the Collaborate group, click Add to Queue. 

3. In the Queue field, click Lookup, and select the queue you want to route the activity to, 

and then click Add. 

 

Find what's assigned to you in a queue 

Quickly see the items assigned to you or that are available to work on by using queues in 

Microsoft Dynamics CRM. Think of them as to-do lists that help you organize your work. 

For Microsoft Dynamics CRM Online organizations, some features like picking or 

releasing items are available if you've applied product updates for CRM Online Spring ‘14 

or later, or if you’ve installed the CRM Online 2015 Update or later. For on-premises 

CRM organizations, these features are available if you've installed CRM 2013 Service 

Pack 1 (on-premises) or later, or if you’ve updated to CRM 2015 or later.  

Interested in getting this feature?   Find your CRM administrator or support person  

Find the queue items 

Use the View list and Queue list to filter and find items in queues. 

1. Go to Service > Queues. (How do I get there?) 

2. Select a view and a filter to see the items that you want. 

 

Find all cases in selected queues 

a. To see all cases from the selected queue, in the View list, click All Cases in 

Selected Queues. 

b. In the Queue list, choose one of the following options to filter cases based on 

queues: 

 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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 <Individual Queues> 

 All Queues 

 All Public Queues.  

 Queues I’m a member of 

 

Find all items in queues 

a. To see all cases from the selected queue, in the View list, click All Items in 

Selected Queues. 

b. In the Queue list, choose one of the following options to filter cases based on 

queues: 

 <Individual Queues> 

 All Queues 

 All Public Queues.  

 Queues I’m a member of 

 

Find cases that are available to work on 

a. To see only the cases that no one else is working on, in the View list, click 

Cases Available to Work On. 

b. In the Queue list, choose one of the following options to filter items based on 

queues: 

 <Individual Queues> 

 All Queues 

 All Public Queues 

 Queues I’m a member of 

 

Find cases that you’re working on 

a. To see only the cases that you’re currently working on, in the View list, click 

Cases I am Working on. 

b. In the Queue list, choose one of the following options to filter the cases 

based on queues: 

 <Individual Queues> 

 All Queues 

 All Public Queues 

 Queues I’m a member of 
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Find items available to work on 

a. To see only items (activities and cases) that no one else is working on, in the 

View list, click Items available to work on. 

b. In the Queue list, choose one of the following options to filter items: 

 <Individual Queues> 

 All Queues 

 All Public Queues 

 Queues I’m a member of 

 

Find items that you’re working on 

a. To view only items that you’re currently working on, in the View list, click 

Items I am working on. 

b. In the Queue list, choose one of the following options to filter items: 

 <Individual Queues> 

 All Queues 

 All Public Queues 

 Queues I’m a member of 
 

Pick an activity or case to work on 

1. In the View list, select one of the views that show the items or cases available to work on. 

2. Select the case or item that you want to work on, and on the command bar, click Pick. 

You also have an option to remove the item from the queue once you pick it up. 

When you pick an activity or a case, it gets assigned to you. The Worked By field (in the list of 

queue items) is also set to you if you leave the activity or case in the queue.  

Release an item or case that you’re working on so someone else can pick it up 

1. In the View list, select one of the views that show the items or cases you’re working on. 

2. Select the case or item that you want to release, and on the command bar click Release. 

When you release an item, your name is removed from the Worked By field, and the item is no 

longer assigned to you; it’s assigned to the queue owner. 

Route an activity or case to another queue or assign to a different user or team 
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1. Select the case that you want to move to another queue, and on the command bar click 

Route. 

2. To move an activity or case to a different queue, click Route, and select a queue.  

Important  

If you’re using CRM 2013 SP1 or CRM Online Spring ‘14, and you click Look Up 

More Records, you’ll only see business queues, which is the default view. 

Business queues only include user-created queues and leave out all user and 

team queues. You can’t set a different view as the default view. To choose a 

different queue, in the Look Up Records dialog box, in the Look in list, click the 

All Queues view.  

-OR- 

To assign the activity or case to another user or team to work on, click User/Team, and 

select the user or team. When you assign the activity or case to someone else to work 

on, the Worked By field is set to that user or team. You also have the option to remove 

the item from the queue.  

Remove an activity or case from a queue 

1. In the View list, select one of the views that show the items you want to remove. 

2. Select the activity or case, and on the command bar, click Remove. 

 

See Also 

Create and manage a case 

Add a phone call, task, email, or appointment activity to a case or record 

Video: How to create, reactivate, and reassign a case (1:47) 

eBook: Give great customer service with CRM 

Quick ref card for customer service reps 

Use the Unified Service Desk 

 

Unified Service Desk Base package 

Unified Service Desk for  CRM 2013 SP1 with product updates package 

Unified Service Desk for CRM 2013 SP1 package 

Set up and use Unified Service Desk for customer service 

 

http://go.microsoft.com/fwlink/p/?LinkID=394984
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Unified Service Desk Base package 

Unified Service Desk is a desktop application that helps your customer service agents provide 

phone, email, and chat support to your customers. Unified Service Desk provides a configurable 

framework to quickly build an Agent Desktop application that’s integrated with Microsoft 

Dynamics CRM. With Unified Service Desk you can quickly make a customized Agent Desktop 

application by leveraging the User Interface Integration (UII) framework. 

 

With the Unified Service Desk Base sample application package, the following components are 

installed: 

 User Interface Integration Solution 

 Unified Service Desk Solution 

 Data required for Microsoft Dynamics CRM and customizations 

The sample applications are not supported for production use. 

For more information on how to set up and administer Unified Service Desk see the, TechNet: 

Unified Service Desk Administration guide.  

 

Here’s what you’ll see when you install the Base package: 

1. Left Nav: Opens the left navigation area that you can open or collapse. 

2. Dashboards: Opens the CRM customer service dashboard. 

3. My Work: Shows a list of all active cases assigned to a service rep. 

4. Search: Opens search for navigating through various entities. For this package you can 

search for accounts and contacts. 

5. Session tabs: When you have multiple customer sessions open, each tab shows a different 

session. The tabs make it easy for an agent to work on multiple customer cases. 

6. Session overview: Shows relevant information about the customer. 

7. Call Script: Shows call scripts that the service agent can use when they’re working on a 

case. The scripts help guide the agent by giving them step-by-step instructions on how to 

handle the case. 

8. Notes: This is the area to take notes in regarding the case. 

 

 

View active cases 

 

From the toolbar, click My Work to see all of your active cases, and then select a case to work 

on. When you open a case, a new session opens. 

Important  

https://technet.microsoft.com/library/dn499779.aspx
https://technet.microsoft.com/library/dn499779.aspx
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Create a case 

 

1. Look up the contact information by clicking Search on the toolbar. 

2. In the Search field, enter the contact information. 

3. When you find the contact information, click the record to open a new session. 

4. In the left nav Call Script area, use the list of call scripts to guide you through the support 

case. When you click a call script, a green check mark indicates the action has been 

performed. 

5. Enter your case notes in the Notes area. To attach your notes to the case, click Update 

notes from call scripts. 

Search for solutions 

To help resolve the case, use the knowledge base articles or Bing search to find a solution. 

1. From the Call script area, click the Search for solutions call script. 

2. Then click on one of the following:  

 

 KB articles: Use the search to find articles that can help you resolve the case. 

 Bing search: The title automatically populates in the Bing search box. 

Send an email 

 

From the list of call scripts, click the Send email call script, and then select a template that 

automatically populates the body of the email. 

Resolve a case 

 

To resolve a case, from the Call Script area, click the Resolve Case call script.  

See Also 

TechNet: Unified Service Desk Administration guide 

Unified Service Desk for  CRM 2013 SP1 with product updates package 

Unified Service Desk is a desktop application that helps your customer service agents provide 

phone, email, chat, and social media support to your customers. It provides a configurable 

framework to quickly build an agent desktop application that’s integrated with Microsoft Dynamics 

CRM. With Unified Service Desk you can quickly make a customized agent desktop application 

by leveraging the User Interface Integration framework. 

 

With the Unified Service Desk for Microsoft Dynamics CRM 2013 Service Pack 1 (SP1) with 

product updates sample application package, the following components are installed: 

https://technet.microsoft.com/library/dn499779.aspx


 

 
214 

 User Interface Integration Solution 

 Unified Service Desk Solution 

 Customizations for this package 

 Data required for Microsoft Dynamics CRM and customizations 

 KPI Custom Control 

 Customer Information System 

This package automatically populates sample data for the new features introduced through 

product updates, such as: 

 Entitlements 

 Service level agreements (SLAs) 

 Routing rules 

 Automatic case creation rules 

 Customer service schedule 

The sample applications are not supported for production use. 

For more information on how to set up and administer Unified Service Desk, see the TechNet: 

Unified Service Desk Administration guide  

 

Here’s what you’ll see when you install Unified Service Desk: 

1. Left Nav: Opens the left navigation area that you can open or collapse. 

2. Dashboards: Opens the CRM customer service dashboard. 

3. My Work: Shows a list of all the active cases assigned to a service rep. 

4. Search: Opens search for navigating through various entities. For this package you can 

search for accounts, contacts, cases, activities, and queues. 

5. Reminder: Shows a list of your activity reminders.  

6. Applications: Shows custom applications for this package. When you’re working on a 

customer session, this shows global applications and session-specific applications. 

7. Session tabs: When you have multiple customer sessions open, each tab shows a different 

session. The tabs make it easy for an agent to work on multiple customer cases. 

8. Session overview: Shows relevant information about the customer. 

9. Call Script: Shows call scripts the service agent can use when they’re working on a case. 

Scripts help guide the agent by giving them step-by-step instructions on how to handle the 

case. 

10. Notes: This is the area to record notes regarding the case. 

11. KPI Control: Shows Key Performance Indicators (KPIs) like Average Case Resolution Time, 

Number of Cases Resolved, and Customer Satisfaction.  

12. Session timer: Shows how long a service rep has been on the session. 

Important  

https://technet.microsoft.com/library/dn499779.aspx
https://technet.microsoft.com/library/dn499779.aspx
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View your activities 

 

From the toolbar, click My Work to see all of your activities. 

Create a case 

 

1. To look up the contact information, from the toolbar, click Search. 

2. In the Search field, enter the contact information. 

3. When you find the contact information, click the record to open a new session. 

4. In the left nav Call Script area, use the list of call scripts to guide you through the support 

case. When you click a call script, a green check mark displays to indicate that the action has 

been performed.  

5. Enter your case notes in the Notes area. To attach your notes to the case, click Update 

notes from call scripts. 

Locate a customer 

When you’re working on a customer session, if you want to find your customer’s location, use 

Bing Maps. 

From the toolbar click or tap, Applications > Locate the customer. Then use Bing Maps to look 

up the customer’s location. This will open Bing Maps and automatically populate the customer’s 

address in the Search field.  

Search for solutions 

To help resolve the case, you can use knowledge articles or Bing search to find a solution. 

1. From the Call script area, click the Search for solutions call script. 

2. Then click one of the following:  

 

 KB articles: Use the search to find articles that can help you resolve the case. 

 Bing search: The title automatically populates in the Bing search box. 

Send an email 

 

From the list of call scripts, click the Send email call script, and then select a template that 

automatically populates the body of the email. 

Resolve a case 

 

To resolve a case, from the Call Script area, click the Resolve Case call script.  
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When the case is resolved, the time spent on the case gets updated in the Actual Service Unit 

field of the case form. The KPI control is also updated with the number of cases and average 

handling time. 

See Also 

TechNet: Unified Service Desk Administration guide 

Unified Service Desk for CRM 2013 SP1 package 

Unified Service Desk (USD) is a desktop application that helps your customer service agents 

provide phone, email, chat, and social media support to your customers. USD provides a 

configurable framework to quickly build an Agent Desktop application that’s integrated with 

Microsoft Dynamics CRM. With USD you can quickly make a customized Agent Desktop 

application by leveraging the User Interface Integration framework. 

 

With the Unified Service Desk for Microsoft Dynamics CRM 2013 Service Pack 1 sample 

application package for Unified Service Desk, the following components are installed: 

 User Interface Integration Solution 

 Unified Service Desk Solution 

 Customizations for this package 

 Data required for Microsoft Dynamics CRM and customizations 

 KPI Custom Control 

 Customer Information System 

The sample applications are not supported for production use. 

For more information on how to set up and administer USD, see the TechNet: Unified Service 

Desk Administration guide.  

 

Here’s what you’ll see when you install USD: 

1. Left Nav: Opens the left navigation area that you can open or collapse. 

2. Dashboards: Opens the CRM customer service dashboard. 

3. My Work: Shows a list of all the active cases assigned to a service rep. 

4. Search: Opens search for navigating through various entities. For this package you can 

search for accounts contacts, cases, activities, and queues. 

5. Reminder: Shows a list of your activity reminders. 

6. Applications: Shows custom applications for this package. When you’re working on a 

customer session, this shows global applications and session-specific applications. 

7. Session tabs: Each tab shows a different session when you have multiple customer 

sessions open. The tabs make it easy for an agent to work on multiple customer cases. 

Important  

https://technet.microsoft.com/library/dn499779.aspx
https://technet.microsoft.com/library/dn499779.aspx
https://technet.microsoft.com/library/dn499779.aspx
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8. Session overview: Shows relevant customer information. 

9. Call Script: Shows call scripts the service agent can use when they’re working on a case. 

The scripts help guide the agent by giving them step-by-step instructions on how to handle 

the case. 

10. Notes: Shows an area to take notes in regarding the case. 

11. KPI Control: Shows Key Performance Indicators (KPIs) such as Average Case Resolution 

Time, Number of Cases Resolved, and Customer Satisfaction.  

12. Session timer: Shows how long a service rep has been on the session. 

 

 

View your activities 

 

From the toolbar, click or tap My Work to see all of your activities. 

Create a case 

 

1. Look up the contact information. From the toolbar, click or tap Search. 

2. In the Search field, enter the contact information. 

3. When you find the contact information, click or tap the record to open a new session. 

4. In the left nav Call Script area, use the list of call scripts to guide you through the support 

case. When you click or tap a call script, a green check mark indicates the action has been 

performed. 

5. Enter your case notes in the Notes area. To attach your notes to the case, click or tap 

Update notes from call scripts. 

Locate a customer 

When you’re working on a customer session, if you want to find your customer’s location, use 

Bing Maps.  

From the toolbar, click or tap  Applications > Locate the customer. Then use Bing Maps to look 

up the customer’s location. This opens Bing Maps and automatically populates the customer’s 

address in the Search field.  

Search for solutions 

To help resolve a case, use the knowledge base articles or Bing search to find a solution. 

1. From the Call script area, click or tap the Search for solutions call script. 

2. Then click or tap one of the following:  

 

 KB articles: Use search to find articles that can help you resolve the case. 

 Bing search: A title automatically populates in the Bing search box. 
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Send an email 

 

From the list of call scripts, click or tap the Send email call script, and then select a template that 

automatically populates the body of the email. 

Resolve a case 

 

To resolve a case, from the Call Script area, click or tap the Resolve Case call script.  

When the case is resolved, the time spent on the case gets updated in Actual Service Unit field 

of case form. The KPI control is also updated with number of cases and average handling time. 

Set up and use Unified Service Desk for customer service 

Give your customer service reps immediate access to business critical information so they can 

quickly engage with customers and address questions and issues using Unified Service Desk for 

Microsoft Dynamics CRM. Unified Service Desk gives you a configurable framework to quickly 

build applications for call centers so agents get a unified view of the customer data stored in 

CRM. You can aggregate customer information from different areas in CRM into one integrated 

desktop that provides a 360° view of customer interactions. For more information, see Overview 

of Unified Service Desk. 

Hosted controls 

Unified Service Desk Hosted Controls 

Create or edit a hosted control 

Toolbars 

Toolbars in Unified Service Desk 

Configure toolbars in your application 

Action calls 

Action calls 

Events 

Events 

Entity searches 

Search data using entity searches in Unified Service Desk 

Window navigation rules 

Use window navigation rules in Unified Service Desk 

Session lines 

Configure session information 

https://technet.microsoft.com/library/dn646899.aspx
https://technet.microsoft.com/library/dn646899.aspx
https://msdn.microsoft.com/library/dn864918.aspx
https://msdn.microsoft.com/library/dn864921.aspx
https://msdn.microsoft.com/library/dn865008.aspx
https://msdn.microsoft.com/library/dn864912.aspx
https://msdn.microsoft.com/library/dn864883.aspx
https://msdn.microsoft.com/library/dn865001.aspx
https://msdn.microsoft.com/library/dn864995.aspx
https://msdn.microsoft.com/library/dn864949.aspx
https://msdn.microsoft.com/library/dn864914.aspx


 

 
219 

Agent scripts 

Guide customer interactions with agent scripts 

Configure and manage agent scripts 

Scriptlets 

Execute scripts using scriptlets in Unified Service Desk 

Forms 

Create and design forms 

Options 

Manage Options for Unified Service Desk 

User settings 

Configure client caching in Unified Service Desk  

Customization file 

Distribute custom host controls using Customization Files 

Configuration 

Manage access using Unified Service Desk configuration 

Audit & diagnostic settings 

Configure auditing in Unified Service Desk 

See Also 

TechNet: What's new in Unified Service Desk 

Use interactive service hub for dashboards 

 

The new interactive experience for customer service 

User's guide for the new interactive service hub 

The new interactive experience for customer service 

We bring to you a new intuitive and interactive experience for managing your customer service in 

the CRM interactive service hub. It’s loaded with richer dashboards and redesigned forms that 

pull together key information so you can focus on what’s more important and get things done 

faster. 

Want to know more? Go through this article. 

https://msdn.microsoft.com/library/dn864904.aspx
https://msdn.microsoft.com/library/dn864991.aspx
https://msdn.microsoft.com/library/dn864905.aspx
https://technet.microsoft.com/library/dn531143.aspx
https://msdn.microsoft.com/library/dn864946.aspx
https://technet.microsoft.com/library/dn646861.aspx
https://technet.microsoft.com/library/22e677e6-5d00-43da-9c24-52eacd0a3c70.aspx
https://technet.microsoft.com/library/dn646885.aspx
https://technet.microsoft.com/library/dn633604.aspx
https://technet.microsoft.com/library/dn798673.aspx
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Get started 

Learn the basics 

Track your issues efficiently and act on them quickly 

The redesigned forms in the interactive service hub include components that help customer 

service representatives quickly handle all their important stuff from a single place: 

 The customer card in the forms gives a complete view of your customer’s touch points  

 The timeline gives a unified view of your customer’s interactions across channels, and lets 

you act on them quickly 

 The related pane lets you search and act on related records without losing context of 

customer data and interactions 

You can manage only those record types that are enabled for use in the interactive service hub. 

These are the default record types: accounts, contacts, cases, activities, knowledge articles (new 

native CRM knowledge management), social profiles, and queue items. In addition to this, your 

system customizer can enable custom entities or activities for an interactive experience. 

Create and manage a case with ease in the interactive service hub 

Manage activities from the timeline 

See and manage related records using the Related pane 

Reduce call handling times with rich knowledge articles 

The new knowledge management solution in CRM guides you through the process of creating 

rich articles in the interactive service hub, getting them reviewed, and publishing them. It also 

provides translation and versioning capabilities to support the knowledge lifecycle. 

Knowledge management process in CRM 

 Create a knowledge article 

Create and manage article versions 

Translate a knowledge article into multiple languages 

Track knowledge article views 

Gain insights with dashboards 

The new dashboards provide interactive chart-based visual filters, and offer users an all-in-one-

place view of their workload through streams. These dashboards help CSRs effectively organize 

their time, focus on the issues at hand, and get more work done. 

Use interactive dashboards to effectively manage your work 

Monitor knowledge articles with dashboards 

 

For admins and customizers 

Create and design interactive forms 

Configure interactive dashboards 

http://go.microsoft.com/fwlink/p/?LinkId=624391
http://go.microsoft.com/fwlink/p/?LinkId=624392
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User's guide for the new interactive service hub 

The new interactive service hub is designed to simplify your day-to-day job, and is specifically 

optimized for customer service. It shows you all your vital information in one place, and lets you 

focus on things that require your attention.  

 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

On this page: 

Learn the Basics 

Track your cases efficiently and act on them quickly 

Reduce call handling times with knowledge articles 

Use interactive dashboards to effectively manage service cases 

Learn the Basics 

The interactive service hub’s intuitive interface unifies vital information in one place, and lets you 

focus on things that require your attention.  

In this section: 

 Interactive service hub application requirements 

 Access the interactive service hub 

 Manage different record types 

 Navigate to a record 

 Switch to the record type dashboard from the list of records 

 Navigate through records and pages 

 See recent items 

 Create new records or find existing ones 

 Know your new forms 

 

Interactive service hub application requirements 

Here’s a list of operating systems and browsers that are supported by the interactive service hub: 

 Operating systems. Windows 7, Windows 8, Windows 8.1, Windows 10 

 Browsers. Microsoft Edge, Internet Explorer 10, Internet Explorer 11, Google Chrome, 

Mozilla Firefox 

Although you may be able to use Internet Explorer 8 or Internet Explorer 9, those 

web browsers are not recommended and are not supported with this version of the 

interactive service hub. 

Important  

Important  

http://go.microsoft.com/fwlink/p/?LinkID=513070
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 Screen resolution. The interactive service hub requires at least a 1024 x 768 effective 

browser resolution. The effective browser resolution is determined by the screen resolution, 

browser zoom, and the operating system’s zoom percentage. If the browser is resized to a 

resolution lower than the minimum supported, some content will be cropped. 

Here’s a list of things that the interactive service hub doesn’t support: 

 Clients. The interactive service hub is not supported on Microsoft Dynamics CRM for Outlook, 

Microsoft Dynamics CRM for phones, and tablets and touch devices. 

 Right-to-left (RTL) languages: Hebrew and Arabic. 

 Accessibility options. The interactive service hub doesn’t support third-party accessibility aids, 

such as screen readers, and other accessibility features such as use of a keyboard to 

navigate through the user interface and complete actions. 

 

 

Access the interactive service hub 

There are two ways for you to open the interactive service hub. You can either click Experience 

it now in the notification bar as shown here.  

 

 

 

Or, you can directly access it by entering a URL in your browser. The URL is different depending 

on whether you’re using CRM Online or CRM (on-premises) as follows: 

 Microsoft Dynamics CRM (on-premises): In your browser, type <your CRM 

Server>/<orgname>/engagementhub.aspx, and then press Enter. For Internet-facing 

deployments use https://< hostname[:port]>/engagementhub.apsx. 

If more than one organization is available, and you don’t specify one, the default organization 

will be used. 

 Microsoft Dynamics CRM Online users: Type https://<CRM Server>. 

crm#.dynamics.com/engagementhub.aspx, and press Enter.  

Any time your administrator makes configuration changes and you reload the interactive service 

hub, you’ll be prompted to download the metadata configuration. After you click Download now, 

it may take some time to load. If you click Ask me later, no changes (customization changes 

done in the CRM web application) will be downloaded, and you can continue to use the app 

without them. 

 

 

To learn about the network requirements for using the Microsoft Dynamics CRM interactive 

service hub, see Web application requirements for Microsoft Dynamics CRM. 

Important  

Important  

https://technet.microsoft.com/library/6404db68-f66b-4128-ac2f-84258503bc82.aspx
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 You can’t access the interactive service hub using private browsing. 

 If you’re using Internet Explorer, and you see a message asking for additional storage on 

your local computer, click Yes. If you click Not for this site, the interactive service hub 

application won’t load. 

 

 

 

 If the interactive service hub still fails to load, please talk to your system administrator.  

 

 

Manage different record types 

In the interactive service hub, you can work with record types that are enabled for the interactive 

experience. By default, the following record types, which you’ll most commonly use to manage 

your customer service, are enabled:  

 Accounts 

 Contacts 

 Cases 

 Activities: Email, Task, Appointment, Phone Call, Social Activity 

 Queue items 

 Dashboards 

 Social profiles 

You can also see interactive dashboards in the interactive service hub.  

Any record types that are enabled for mobile are also available for use in the interactive service 

hub. However, these records are read-only. For example, the entitlements are enabled for mobile, 

so you can see the entitlements data in the case form, but you can’t create or edit an entitlement 

in the interactive service hub. 

 Your customizer can enable other custom entities and custom activities for the interactive 

experience. 

 The navigation bar for the interactive service hub is different than the navigation bar in the 

CRM web application. Any changes to the representations of the other navigation bars aren’t 

reflected in the interactive service hub. For more details, contact your customizer.  

 The navigation bar in the interactive service hub doesn’t support the global Search box and 

the Settings menu.  

 

 

Navigate to a record 

 

1. On the Main Menu, click a work area, and then click an item.  

Note  
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You’ll see only the record types that are enabled for the interactive experience in the 

navigation bar of the interactive service hub. 

When you click an item, you’ll see the list of records. You can search for records in the list 

using the Search for Records box.  

The search only looks for the keywords in the primary field of the record type. 

2. From the list of records, click the record you want. 

 

 

Switch to the record type dashboard from the list of records 

When you’re in the list of records of a specific record type, use the Switch to Dashboard button 

 to switch to the default dashboard for that entity. 

More information:  Use interactive dashboards to effectively manage service cases 

 

 

Navigate through records and pages 

 When you’re in a record, use the Next Record and Previous Record buttons to see the next 

or previous records in the record set. A record set is the total number of records on a single 

page. For example, if you have 50 total records, by default, you’ll see 25 records on the first 

page, and 25 on the second page. When you open a record from the first page, you’ll be able 

to move between these 25 records by using the Next Record and Previous Records 

buttons.  

 

 

 To go the previous page in the interactive service hub, click the Back button before the title of 

the record.  

 

 

 

Your browser’s Back button will take you to the previously visited website.  

 

 

See recent items 

There are two ways you can see the items you’ve recently worked on. 

 On the Main Menu, click the down arrow next to the record type, for example, next to Cases 

to show the recently used records.  

Note  

Note  
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 On the Main Menu, click the Recently Viewed Items button to see recently viewed records 

and views. 

 

 

 

 

Create new records or find existing ones 

1. To create records quickly by filling in only the most basic information, on the nav bar, click the 

Quick Create button  .  

 

 

2. To find all of your records from multiple record types quickly, click the Search button . To filter 

results by one record type, click a record type from the filter drop-down list next to the Search 

box. 

 

You can only search for record types that are enabled for the interactive experience. 

 

 

Know your new forms 

See how the different components of the new form help you quickly handle all your important 

tasks and actions from a single place. 

Business processes 

In the interactive service hub, the case and knowledge article forms have a process bar, which is 

collapsed by default. When you click a process stage, it opens as a flyout showing relevant steps 

for that stage. A flag on a stage indicates the stage you’re currently on. When you click an active 

stage, you can see the Next Stage button move to the next stage in the process.  

If there is more than one process to use, you can switch between the processes by clicking More 

> Switch Process on the command bar, and then selecting the process you want to use. 

Certain fields, like Find Case or Similar Cases, aren’t available on the process bar of a 

case form in the interactive service hub.  

 

A tab is a group of sections on a page. Each Main form is composed of one or more tabs. By 

default, the Summary tab shows information about the customer, interactions with the customer, 

Note  

Important  
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and other related records. You can click the different tabs to enter or see other miscellaneous 

details of a record. 

Here’s an example of how the tabs appear on the case form.  

 

 

This table lists the default tabs for each record type that’s enabled for the interactive experience. 
 

Record type Default tabs 

Case  Summary. Includes the customer card, 

interaction timeline, and the Related 

section. 

 Details. Tracks additional details and social 

response details of the case. 

 Case Relationships. Shows a Merged 

Cases and Child Cases list. You can add a 

new child case to the current case from the 

Child Cases list. It also shows a list of 

knowledge articles associated with the 

case. 

 SLA. Shows the related SLA KPI Instance 

records that are created for each SLA KPI 

that is tracked for the case. 

 

Account  Summary. Includes the customer card, 

interaction timeline, and the Related 

section. 

 Details. Tracks additional details like 

company profile, marketing details, contact 

preferences, and billing and shipping.  

 

Contact  Summary. Includes the customer card, 

interaction timeline, and the Related 

section. 

 Details. Tracks additional details like 

personal information, marketing details, 

contact preferences, and billing and 

shipping. 

 

Activities Activity forms don’t have tabs. The form shows 

general information and details in different 
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Record type Default tabs 

columns. 

Knowledge Articles  Content. Lets you create content for the 

article, and move it through to publishing.  

 Summary. Tracks basic settings, publishing 

settings, and related records. 

 Analytics. Shows the number of views, and 

a list of cases using the article. 

Social Profile Social Profile tab 

 

 

See a complete view of your customer’s touch points in the customer card. This card is available 

in the General Information section of the Summary tab.  

 

 

You can add a picture to the account or contact record in the CRM web application, and it will 

appear on this card.  

For account records, the customer card shows contact details for the primary contact. For contact 

records, the customer card shows details of the account the contact belongs to.  

 

See a combined view of your customer’s interactions across various channels, such as phone, 

email, or even social activities in the timeline. It also shows any related notes or system posts. 

The timeline is available on the Summary tab of account, contact, and case records. For 

knowledge articles, the timeline appears on the Content tab. 

 

 

Here are a few things you can do in the timeline: 

 Filter the timeline for a specific activity type or find an activity by searching for a specific 

keyword. 

Search and filter work in combination or in isolation. For example, you can first filter the 

activities to just show emails, and then use the Search option to search for email messages 

with a specific keyword. 

 Refresh the timeline so you can see the updated list of activities. 

 Click the title of an activity to open the activity record. 

 Take quick actions on an activity from the timeline, such as marking an activity complete, 

assigning it to others, adding it to a queue, converting it to a case, or deleting it. All actions 

that are available on a form command bar for any given record type are available here. 
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In the Related section (also called a reference panel), use the vertical tabs to see related records 

for the current record or search for knowledge articles. This section is enabled by default for 

account, contact, case, and knowledge article records. Your customizer can add this section for 

custom entities that are enabled for the interactive experience.  

By default, the first tab in the Related section of a case record shows the recent cases and 

entitlements for the current case record you’re working on. When you open a record from the list, 

it appears in a horizontal tab in the Related section. 

If you see data for any record type that isn’t enabled for interactive experience, you won’t 

be able to open or edit the record from the list. This is also the case for fields of type 

lookup, for example the entitlement field on the case form. 

 

 

For account and contact records, the Related section shows recent opportunities, recent 

cases, and active entitlements. For knowledge articles, this section shows related 

versions, related translations, related articles, and related products. Your system 

administrator or customizer can choose what related data to show in this section for each 

form.  

The second tab in the Related section is the Knowledge Articles Search tab. This tab gives 

knowledge article suggestions based on the title of the record, and also lets you search for a 

knowledge article containing specific keywords. When you open a record from the list, it appears 

in a horizontal tab in the Related section. 

 

 

 

For information on how to configure the interactive forms, see TechNet: Create and design 

interactive forms 

 

 

Track your cases efficiently and act on them quickly 

 

 

Creating and managing a case can’t be any simpler. With the intuitive case form in the interactive 

service hub, you can do all your important tasks and actions without navigating to different parts 

of the application.  

You can capture important information about customers, interactions you’ve had with them, and 

all related records of the current case in once single place. 

Note  

Note  

https://technet.microsoft.com/library/b6df6d11-9272-4c68-b516-e12c6e701622.aspx
https://technet.microsoft.com/library/b6df6d11-9272-4c68-b516-e12c6e701622.aspx
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In this section: 

 Create a case 

 Manage activities from the timeline 

 See and manage related records in the Related section 

 Resolve a case 

 Cancel a case 

 Reassign a case 

 Add a case to a queue 

 Save and route a case 

 

 

Create a case 

1. Make sure that you have the Customer Service Manager or Customer Service 

Representative role, or equivalent permissions. 

2. In the interactive service hub, go to Service > Cases. 

3. On the command bar, click New. 

4. In the Case Title field, type a subject or descriptive name to identify the case.  

5. Find the customer:  

a. Click the Identify area of the process bar.  

b. Click the Find Customer lookup button. By default, this field shows both account and 

contact records. Or, type a few letters and press Enter to search for records that 

contain the letters. After you select an existing customer and save the record, the 

Customer Details section (blue tile) will show the contact details, along with recent 

cases and activities for the customer in the Related and Timeline section.  

c. If a customer record doesn’t exist, click New in the inline lookup results to create a 

new record.  

 

6. Click the Find Contact lookup button, and then select an existing contact for the case or 

click New in the inline lookup results to create a new contact record. 

7. In the Subject field, select a subject. Associating cases with subjects helps you search 

for cases with similar issues and find related articles. If you don't see the subject you 

want in the list, ask your system administrator to add it. 

8. In the Origin field, select the channel through which this case was initiated. 

9. In the Product field, select the product this case is about. You can’t add a product family, 

a draft product, or a draft product bundle.  

10. To see what kind of support you should provide the customer, click the Entitlements 
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lookup button and select an active entitlement. The list shows all entitlements in CRM 

regardless of the customer you’ve selected for the case.  

Note  

 If you’re on CRM Online 2015 Update 1, and your manager has set default 

entitlements for a customer in CRM, when a case is created or when a case is 

updated and the customer, contact, or product field has changed, a default 

entitlement is automatically associated with the case.  

 When a case is created and an entitlement is applied to it (or when the case gets 

resolved), the entitlement terms from the associated entitlement are decremented. 

However, if you don’t want the entitlement terms to be decremented for a case, on 

the command bar click Do not decrement entitlement terms. 

 

11. Click on the other tabs to enter or see additional information about the case. 

 

 

 The Details tab tracks additional details and social response details of the case. 

 The Case Relationships  tab shows a Merged Cases and Child Cases list. You 

can add an existing child case to the current case from the Child Cases list. If you 

want to create a new child case for the current case, on the command bar, click 

Create Child Case. You can’t merge cases in the interactive service hub.  

The Case Relationships  tab also shows a list of knowledge articles associated with 

the case. 

 The SLA tab shows the related SLA KPI instance records for each SLA KPI that’s 

tracked for the case.  

Note  

The SLA timer for standard or enhanced SLA is not supported in the 

interactive service hub. 

 

12. When you’re done, click Save.  

 

 

 

 

Manage activities from the timeline 

Capture all interactions and communications you’ve had with your customer by adding them as 

activities in the Timeline section. The timeline section gives you a unified view of everything that's 

happening on a case, like email received, a follow-up task that you created, system posts that are 

automatically generated when the cases is created, or any notes you take while talking to the 

customer. 
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When you update an activity, it moves up in the Timeline because Timeline is sorted from latest 

to the oldest. This is the default and only order of sorting. 
 

To Do this  

Create a new activity 
 

1. In the Timeline section, click +, and 

then select an activity type: Email, 

Task, Note, Appointment, or Phone 

Call. 

 

 

2. Fill in your details in the activity form, 

and then click Save.  

Tip  

If you want to create an email 

activity, you can now use the 

new rich text editor in the 

interactive service hub, which 

has more formatting options 

than the one in the CRM web 

application. More information:  

Use the rich text editor to 

create knowledge articles and 

emails 

 

 

 

Search for a specific 

activity  

1. In the Timeline section, click the Show 

Search button . 

2. In the Search for Records box, type 

the word that you want to look for in 

the title and content of the activities. 
 

 

Filter activities 
 

1. In the Timeline section, click the Show 

Filters button . 

2. Click Till Date to filter the activities 

based on date filters. The available 

 



 

 
232 

date filters are: To Date, Today, 

Yesterday, This Week, Last Week, 

This Month, Last Month, Month To 

Date, and Custom Time Frame. 

3. Click All Items to filter activities based 

on the activity type. 

 

 

Take actions on an 

activity  

1. In the Timeline section, click the Quick 

Actions button  

2. Select the action you want to take. 

The list of quick actions you’ll see for 

any activity is the same as the ones 

that are available for the activity at a 

form level (on the command bar). For 

example, for an email activity, you will 

see actions like Reply, Reply All, or 

Forward. Custom actions may also be 

available.  
 

 

 

 

 

See and manage related records in the Related section 

The Related section in a case record provides you quick access to important information related 

to the primary case that would help you in solving the case.  

See recent cases and entitlements 

Click the Recent Cases and Entitlement tab to see: 

 A list of recent cases for the customer associated with the current case.  

 A list of entitlements for the customer associated with the current case. 

When you click a record in the list, it opens as a horizontal tab in the Related section. 

Search for knowledge articles 

The Knowledge Base Search tab lets you search for relevant knowledge articles to resolve a 

case. Click the Knowledge Base Search tab to see search results automatically populated 

based on a field your administrator configured in the Knowledge Base Search control properties. 

For a case, this is the title of the case record.  

Important  
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The knowledge base search in the interactive service hub shows relevant knowledge 

articles only when your organization is set up to use the native CRM knowledge 

management capability. For more information, talk to your administrator. 

 

 

 

 Type a different keyword to search for other knowledge articles. The following fields of a 

knowledge article are searched for the keywords that you type: Title, Content, Keywords, 

Description, and Article Public Number. 

 To see knowledge articles in specific states, use the filters. You can filter search results to 

see all draft, published, or approved articles. 

 To choose how you want to sort your search results, click Relevance. You can sort the 

knowledge articles on relevance, number of views, newest first, or oldest first.  

 Click the article title to see its full content. The article opens as a horizontal tab in the Related 

section. 

 To associate the knowledge article to the current case, click the Link the KB Article button. 

You can also dissociate the article from the case by choosing the Unlink the knowledge article 

from the current record button . 

 To send an email with a link to the knowledge article on a portal, or the content of the knowledge 

article in an email, click the Quick Actions button , and then click Email Link. An email form 

opens with the link to the article populated in the email body. The fields are automatically 

populated based on the case and customer details. Add other information as needed, and then 

on the command bar, click Send. If your administrator hasn’t selected the Use an external portal 

check box in the Embedded Knowledge Search setup, the content of the article is copied to the 

email body instead of the link.  

If the article is published, an external link is copied to the email body. 

This action is available only for Published and Expired articles. 

 To copy the external URL of the article so you can share it with your customers over channels like 

chat or email, click the Copy Link button .  

This option is available only if your organization is using an external portal to publish 

the knowledge articles and your administrator has selected the Use an external 

portal check box in the Embedded Knowledge Search setup. If you use a browser 

other than Internet Explorer, this option isn’t available. 

 

 

Resolve a case 

Note  

Note  
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1. In the list of active cases, open the one you want to resolve. 

2. On the command bar, click Resolve case.  

Make sure you close all the case activities. If there are open activities associated with the 

case, you’ll see a message saying that the open activities will be canceled if you resolve 

this case. To continue, click Confirm.  

3. In the Resolve Case dialog box, in the Resolution Type list, select how the case was 

resolved. 

4. In the Resolution box, type a short explanation of the resolution. 

The total time spent on all activities for this case, as recorded in the Duration box in each 

activity, is filled out automatically in the Total Time box. 

5. In the Billable Time list, enter the amount of time spent on the case to be billed to the 

customer. 

If this case is linked to an entitlement, the billable time will be subtracted from the allotted 

minutes for that entitlement. 

6. Click Resolve. 

 

 

Cancel a case 

All case activities must be closed before you can cancel a case. 

1. In the list of active cases, open the case you want to cancel, and then on the command 

bar, click Cancel Case.  

2. In the Confirm Cancellation dialog box, select the case status:  

 Canceled: This means the case is canceled and it will no longer be assigned to you. 

 Merged: This means the case is merged with another case. When the case is 

merged, the case activities will be moved to the case it was merged with. 

 

3. Click Confirm. 

 

 

Reassign a case 

If you don’t have enough information to resolve a case, or if you think another member in your 

team has expertise on the subject, you can assign the case to another user or team. 

1. In the list of cases, select the case that you want to reassign, and on the command bar, 

click Assign. 
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2. In the Assign to Team or User dialog box, in the Assign To field, select User or Team, 

and then in the User or team field, select who you want to assign the case to. 

3. Click Assign. 

 

 

Add a case to a queue 

 If you think another group in your team has expertise on the subject, you can move the case to a 

queue so that someone else can pick it up. 

1. Go to Service > Cases. (How do I get there?) 

 

2. In the list of cases, select the case that you want to add to a queue. 

3. On the command bar, click Add to Queue.  

4. In the Queue field, select the queue that you want to add the case to, and then click Add.  

 

 

Save and route a case 

To save a case record and route it to a queue in a single click, use the Save & Route button.  

1. From the list of cases, open a case record.  

2. Make the changes as required, and on the command bar, click Save & Route. 

3. In the Route Case dialog box, click Route.  

The case is routed based on the active routing rule set. 

Important  

The Save & Route button is available only on active cases.  

 

 

Reduce call handling times with knowledge articles 

 

 

With the new CRM knowledge management solution, you can create and manage knowledge 

articles that your users may be looking for. Knowledge articles can include instructions about 

using your products or answers to questions customers frequently have. Use the rich text editor 

to format your content or embed videos and images.  

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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The ability to create and format knowledge articles with the rich text editor is available 

only in the interactive service hub. The articles that are created in the interactive service 

hub will be available in the CRM web application as read-only records.  

 

In this section: 

 Knowledge management process 

 Create a knowledge article 

 Use the rich text editor to create knowledge articles and emails 

 Mark a knowledge article for review 

 Review and reject or approve a knowledge article 

 Update knowledge articles to capture feedback 

 Associate a related knowledge article 

 Create and manage article versions 

 Translate a knowledge article in multiple languages 

 Schedule or publish an article 

 Track knowledge article views 

 Monitor knowledge articles with dashboards 

 

 

Knowledge management process 

The following diagram describes the default process for creating and using knowledge articles in 

the interactive service hub. 

 

 

 

 

Create a knowledge article 

Turn your customer questions, issues, and feedback into knowledge articles, so other service 

reps can benefit from them. Add images and videos to your articles to explain things better and 

make the articles engaging. 

1. Make sure that you have Create and Read permissions on the Knowledge Article entity. 

By default, these permissions are added to the Knowledge Manager, Customer Service 

Manager, or Customer Service Representative role. 

2. In the interactive service hub, go to Service > Knowledge Articles. 

Important  
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3. On the command bar, click New. 

You’ll be on the Content tab of the knowledge article. 

 

 

 

4. In the Article Content section, fill in the following details: 

 

a. Title. Type a descriptive title that communicates the subject and purpose of 

the article in a concise manner. 

b. Keywords. Type keywords for the article. These keywords are used for 

searching the knowledge base for articles. Separate keywords with commas. 

c. Description. Type a short overview of the article. This appears in the search 

results and is used for search engine optimization. 

 

 

 

 

5. In the Content section, add the content for your knowledge article. 

Note  

As soon as you click inside the editor space, the rich text editor command bar 

appears. Use the command bar options to format and style your content. More 

information: Use the rich text editor to create knowledge articles and emails 

6. On the process bar, click Author. 

7. In the Article Subject drop-down list, choose the subject of the article to help with article 

searches. 

8. In the Assign Primary Author drop-down list, choose a person who is responsible for 

maintaining the article content. By default, the user who creates the article is the primary 

author. 

9. When you’re done adding the content, click Save. 

Posts about knowledge article-related activities will begin appearing in the Timeline 

section. 

 

 

Use the rich text editor to create knowledge articles and emails 

Create rich and well-formatted content for email or knowledge articles using the new rich text 

editor in the interactive service hub. The editor brings common word processor features like 

advanced styling, linking, find and replace, and insert images and tables. 
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You can choose a specific format or style for the content you’re writing.  

 
 

Command Use 

1. Formatting Styles Apply predefined sets of formatting features to 

make it easier to keep the presentation of the 

text consistent. To make the choice easier, the 

style names are displayed in a style that they 

represent, giving you a preview of what the text 

will look like. 

Note  

This option is available in the expanded 

mode only. 

2. Paragraph Format Apply predefined block-level combinations of 

various formatting options. A paragraph format 

can only be applied to a block-level element, 

like a paragraph or a div element. 

Note  

This option is available in the expanded 

mode only. 

3. Font Name Choose a font for the selected text.  

4. Font size Choose a font size for the selected text. 

5. Bold Apply bold formatting to the selected text. 

6. Italic Apply italic formatting to the selected text. 

7. Underline Underline the selected text. 

8. Strikethrough Mark selected text for deletion. 

9.  Text Color Choose a text color for the selected text. 

10. Background Color Choose a background color for the selected 

text. 

11. Align Left Left align the text. When you align your text left, 

the paragraph is aligned with the left margin 

and the text is ragged on the right side. 

Note  

This option is available in the expanded 

mode only. 
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Command Use 

12. Center Center align the text. When you center align the 

text, the paragraph is aligned symmetrically 

along the vertical axis and the text is ragged on 

the both sides. 

Note  

This option is available in the expanded 

mode only. 

13. Align Right Right align the text. When you align your text 

right, the paragraph is aligned with the right 

margin and the text is ragged on the left side. 

Note  

This option is available in the expanded 

mode only. 

14. Insert/Remove Numbered List Create a numbered list. 

15. Insert/Remove Bulleted List Create a bulleted list. 

16. Increase Indent Increase the margin on the left side of text. 

17. Decrease Indent Decrease the margin on the left side of the text. 

18. Paste as Plain Text Paste the clipboard data as plain text, without 

the source formatting and styling. 

19. Paste From Word Paste content from Microsoft Office Word with 

the original content formatting.  This will retain: 

 Spacing and line breaks 

 Ordered and unordered lists 

 Tables 

 Font styles and colors 

Note  

Images won’t be copied from Word 

Microsoft Office Word. 

20. Insert Table Insert a table, and specify the table properties. 

 

21. Image Insert an image. 
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Command Use 

1. Choose Insert Image. 

2. In the Image Info tab, specify the web 

address of the image, and also specify 

properties to define how the image will 

appear in the email or article. 

Note  

If the image is located on the 

external server, use the full 

absolute path. If the image is 

located on a local server, you 

can use a relative path. 

3. If you want the image to be a clickable 

link, in the Link tab, add a URL for the 

image. You can also specify if you want 

the targeted page to open in a new 

window, topmost window, same 

window, or parent window. 

4. To configure additional image options, 

use the Advanced tab. This is meant 

for advanced users with knowledge of 

HTML and CSS, and lets you change 

the presentation of the image. 

 

 ID. Type a unique identifier for an 

image element in the document (id 

attribute). 

 Language Direction. Choose the 

direction of the text. 

 Language Code. Type the 

language of the image element 

specified. 

 Long Description URL. Type the 

web address of an HTML page 

containing a longer description of 

the image. 

 Stylesheet Classes. Enter the 

class of the image element (class 

attribute). Note that an image 

element might be assigned more 

than one class. If this is the case, 

separate class names with spaces. 
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Command Use 

 Advisory Title. Enter the text of 

the tooltip that is shown when the 

mouse cursor hovers over the 

image. 

 Style. Enter the CSS style 

definitions. Note that each value 

must end with a semicolon and 

individual properties should be 

separated with spaces. 
 

22. Link Add clickable hyperlinks or email addresses to 

your documents. In the Link dialog box choose 

the type of link you’d like to insert.  

The Link Info tab allows you to choose the link 

type as well as set the link protocol and URL. 

The Target tab is only available for the URL 

link type. It specifies the location where the link 

will open after you click it.  

23. Create Div Container Create a div container to apply formatting to a 

larger document fragment that extends beyond 

one block. 

The General tab lets you manually add a 

stylesheet class that is applied to the div 

element. 

The Advanced tab lets you configure additional 

div element options such as assigning it an ID, 

a language code, a text direction, an advisory 

title, or CSS style properties.  

Note  

This option is available in the expanded 

mode only. 

24. Source Open the HTML source code for the content. 

To embed videos and IFrames, video and 

iframe tags can be used in HTML source code 

mode. 

 

You can’t use client-side code (script tags or JavaScript) in articles and emails. If you 

want to associate CSS or JavaScript, use web resources. 

Important  
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Mark a knowledge article for review 

To make sure the content you’ve created is accurate, have someone review it. 

You can mark an article for review or directly assign it to a specific person or queue. When you 

mark an article for review, it starts appearing in the knowledge manager’s dashboard. The 

knowledge manager can then assign the article to specific team members or a queue for review. 

1. In the article you want to mark for review, in the Status Reason drop-down list, click 

Needs Review. 

2. On the process bar, click Author. 

3. In the Mark for Review field, click Mark Complete. 

4. To assign the knowledge article to another reviewer or team, on the command bar, click 

Assign and select the user or a team. 

5. To add the article to a queue so reviewers can pick it from there, on the command bar, 

click More > Add to Queue, and then select the queue. 

 

 

Review and reject or approve a knowledge article 

It’s important to review articles for accuracy before they’re published or made available to others. 

To approve a knowledge article, you must have Approve permissions for the knowledge 

article record type. This permission is added by default to the Knowledge Manager, 

Customer Service Manager, Customer Service Representative, or System Administrator 

role or equivalent permissions. 

 
 

To Do this 

Pick an article assigned to you Go to Service > My Knowledge Dashboard, 

and then see the My Active Articles stream. 

-OR- 

In the interactive service hub, go to Service > 

Queue Items, and then select the Items 

available to work on view. 

To suggest review feedback 
 

1. On the process bar, in the Review 

 

Important  
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To Do this 

stage, in the Review field, select 

Reject. 

2. In the Timeline section, click +, and 

then click Note to add details about the 

changes you want in the knowledge 

article. 

 

The article is automatically assigned to the 

primary author of the knowledge article. 

Approve the content of the article When you approve the content of an article, it 

means that the content is ready to be 

consumed by other customer service reps, and 

also ready to be published. 

On the process bar, in the Review stage, in the 

Review field, select Approve. 

The article is automatically assigned to its 

primary author. 

 

 

 

Update knowledge articles to capture feedback 

Make sure that your articles are up to date and accurate at all times by updating them based on 

feedback you receive. 

1. In the interactive service hub, go to Service > Knowledge Articles. 

2. Click the article you want to edit. 

If the reviewer has suggested any changes from their review, you can see them in the 

Timeline section. 

3. Update the article based on the feedback. 

4. Click Save. 

5. To assign the article back to the reviewer for approval or publishing, on the command 

bar, click Assign, and then select a user or a team  

 

 

Update published knowledge articles 
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When a knowledge article is in the Published state, only the users who have the Publish privilege 

can update it.  

1. In the interactive service hub, go to Service > Knowledge Articles. 

2. Click the published article you want to edit. 

3. On the command bar, click Update. 

4. Update the article based on the feedback. 

5. Click Save. 

 

 

 

If the article has information that complements an existing knowledge article, associate the 

existing article with the current knowledge article. 

1. In the knowledge article, on the command bar, click More > Relate Article.   

2. In the Select Article to Associate field, click the Lookup button, select an existing 

article, and then, click Associate. 

The associated article appears in the Related Articles list in the Related Information 

section of the Summary tab. 

 

 

Create and manage article versions 

Article versioning helps you manage updates to your knowledge articles. By creating major and 

minor versions of a knowledge article, you can keep your articles up to date with the latest 

information while keeping track of changes throughout the lifecycle of your products and services.  

This capability helps you to keep accurate records of the features your organization provides and 

go back to previous versions if you need to.  

1. In the interactive service hub, click Services and choose Knowledge Articles.  

2. Open the article you want to create a new version for. 

3. In the knowledge article, click Create Major Version or Create Minor Version. 

An example of a major version would be when your documentation changes to detail a 

new feature or functionality, while a minor version might be a change to the user interface 

with no change to functionality. 

The new version of your article will contain all of the same content, information, and 
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permissions as the current version. The Version Major or Version Minor field will 

automatically update to reflect the new version number.  

Note  

You won’t able to make any changes to the Major Version Number, Minor 

Version Number, Language, or Article Public Number fields when creating a 

new major or minor version of an article. 

4. After you have reviewed the article, make any changes that you want to the new version. 

You can update the article title, content, keywords, and description to reflect any changes 

to your products, features, or services. 

 

 

Review and publish your new version 

When you are done making changes, you can push the new version of your article through your 

standard article workflow. When you are finished reviewing and are ready to publish, on the 

command bar, click More > Publish, and then choose how and when you want to publish your 

new version. You can publish your new version immediately, schedule it to publish at a future 

date, or leave it as a draft to manually publish later. More information: Schedule or publish an 

article 

 

 

Manage article versions 

Managing your article versions means publishing and archiving different versions of each article 

to provide the most accurate information to your customers and internal employees. Keep in mind 

that only one version of an article can be published at a time; it’s important to keep track of the 

changes that are made to each version and publish them when it is appropriate. 

1. In the knowledge article, click the Summary tab. 

2. In the Related Information section, click the Related Versions button to display a list of 

all major and minor versions of the article. 

3. In the Related versions list, open the version you want to delete. 

4. Click the More button, and then click Send to Trash.  

5. When prompted, click OK. 

Deleting an article version is permanent and can’t be undone. You won’t be able to go 

back to that version of the article, so make sure that you don’t need any of the 

information. It’s a good idea to create a local backup of any versions you delete. 

 

 

Translate a knowledge article in multiple languages 
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Your knowledge content needs to reach all of your customers, no matter what market or region 

they are from. The knowledge management capability in CRM helps you translate your articles so 

that you can provide the same self-help content in multiple languages without having to manage 

multiple copies of the same article. By using the translation feature, you can quickly and efficiently 

provide 24-hour service to all of your customers. 

1. Open the article you want to translate, and on the command bar, click Translate. 

2. In the Create new translation dialog box, in the Pick a language drop-down list, choose 

the language you want.  

3. In the Create new version field, choose whether to create a new major or minor version 

for your translation. 

You can translate articles into any language that’s supported by the interactive service 

hub.  

4. Click Create. 

5. Enter your translated text in the appropriate fields. You can enter translated text for the 

following fields: 

 Title 

 Keywords 

 Article Description 

 Content 

6. When you are finished reviewing and are ready to publish, click More > Publish. Choose 

how and when you want to publish your new version. You can publish your new version 

immediately, schedule it to publish at a future date, or leave it as a draft to manually 

publish later. More information:Schedule or publish an article 

 

 

Manage article translations 

After you have published a translation for an article, you can manage it and any other translations 

by clicking the Summary tab of the knowledge article. 

1. In the Related Information section, click Related Translations. 

2. Open the translation you want to view. Keep in mind that there may be multiple versions 

for each language. You can sort the translations by clicking the column headers of the 

Related Translations section. 

From here, you can: 

 Edit or update a translation 

 Create a new major or minor version of a translation 

 Delete a translation or version of a translation 
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Schedule or publish an article 

After the content in the article is complete and reviewed, you can publish the article to the portal 

to make it available to your customers.  

If your organization is using a portal for publishing the knowledge articles, your 

customizer can write a plug-in that can pick the published articles and post on your portal, 

and also capture the article views back. 

1. Make sure that you have the Publish and Update permission on the Knowledge Article 

record type. These permissions are added by default to the Knowledge Manager, 

Customer Service Manager, Customer Service Representative, or System Administrator 

role. 

2. In the interactive service hub, go to Service > Knowledge Articles. 

3. Open a knowledge article that’s in the Approved state.  

4. To make it easy to find knowledge articles related to specific products, associate the 

knowledge article with a product. 

 

a. On the command bar, click More > Relate Product. 

b. In the Select Product to Associate with field, click the Lookup button, elect 

a product this article is about, and then, click Associate. 

The associated article appears in the Related Products list in the Related 

Information section of the Summary tab. 

 

5. On the process bar, click the Publish stage. 

6. In the Set Product Associations field, click Mark as Complete.   

7. If you want to schedule the article to publish on a later date, on the Summary tab, in the 

Publish On field, select a date and time to publish the article. 

8. On the command bar, click More > Publish. 

 

a. In the Publish field, select whether you want to publish the knowledge article 

right away or in the future. To publish the article in the future, in the 

Publishing Date Time field, select a date and time. 

b. In the Published Status field, select what status the article should be in after 

it is published. By default, Published is selected. 

c. In the  Expiration Date field, select a date and time when you want the 

Important  
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published article to expire. Expired articles are no longer available in 

searches. 

d. If you’ve set an expiration date, in the Expiration Status field, select the 

status the knowledge article should be set to after it expires. 

e. To publish all approved related translated articles with the article, in the 

Publish Approved related translations with Article, click Yes.  

f. Click Publish. 

 

 

 

Track knowledge article views 

Tracking your content helps you and your authoring team assess its value to your organization 

and your customers. Knowing and understanding when, where, and how many times an article 

was viewed tells you how much your customers and team members rely on the information that it 

contains. This data is extremely useful when creating future content curation plans and can help 

you decide what content you will deliver in the future, as well as how you deliver it, where you 

deploy it, and what style or structure you use to write it. 

To view an article’s view counts and other statistics, open the article you want to track, and then 

click the Analytics tab. 

 Views section. Shows you the total number of times that this article has been viewed. This 

figure represents the total views of all versions and all translations of this article combined. It 

also shows individual article views on specific days. You can click the column headers to sort 

by chronological order or by the number of views. 

 Cases section. Shows a list of the cases that have used this article. Double-click a case to 

view its details. 

By reviewing cases that have used your articles, you can gain valuable insights into the 

questions that customers are asking, as well as what avenues they tried before asking for 

help. This data can help you expose your knowledge articles better and provide more useful 

information to your customers and team members.  

 

 

Monitor knowledge articles with dashboards 

Knowledge managers and authors can now monitor the status of knowledge articles using the 

two new default dashboards available in the interactive service hub. 

If these dashboards don’t offer what you need, you can create new interactive 

dashboards. More information: Configure interactive service hub dashboards 

 

 

Note  

https://technet.microsoft.com/%20library/d1446a95-14bf-4b15-a905-72fce07f4c76.aspx
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My knowledge dashboard 

This dashboard is designed for authors to give them a visual snapshot of the number of 

knowledge articles they’re working on and their status. It helps them quickly know things like 

article expiring in the month and articles in review. 

 

 

 

 Streams show data from views or queues. In the knowledge dashboard, the stream shows 

the active articles assigned to the author. 

 Charts provide a count of relevant records in the streams, such as articles by status reason, 

articles by owner, or articles by subject. They also act as visual filters. You can drill down in a 

chart to see data that interests you the most.   

 Tiles give authors an aggregated view of data in the streams and help them monitor the 

volume of their knowledge articles. 

 

 

Knowledge manager 

This dashboard is designed specifically for knowledge managers. As a knowledge manager, you 

can quickly know the most popular articles, articles that need review, or articles that are about to 

expire, and take necessary actions on the articles right from here.  

 

 

More information: Use interactive dashboards to effectively manage service cases 

 

 

Use interactive dashboards to effectively manage service cases 

Microsoft Dynamics CRM interactive experience dashboards are a one-stop workplace where you 

review your workload and take actions. The information in the interactive dashboard is shown in 

real time, coming from various views and queues. The interactive dashboards with their modern 

and intuitive interface are optimized for the customer service experience. For example, instead of 

paging through the application looking for a particular case, you’ll be able to open and update the 

case right from the dashboard. This will save you time, help to focus on tasks at hand, and get 

more work done. You’ll need sufficient permissions to use the interactive dashboards. The 

permissions will be assigned to you by an administrator. 

In this section: 

Interactive experience dashboards overview 

Interactive tiles 

Visual filters (interactive charts) 

Global filter 
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Clear the filters 

Timeframe filter 

Collapse or expand work item description in the stream 

Show quick actions 

Edit stream properties 

Change the sort order in the data stream 

Color-coded data in streams and charts 

Information for customizers 

 

 

Interactive experience dashboards overview 

The interactive dashboards come in two flavors: multi-stream and single-stream. 

When you sign in to the interactive service hub, you’re looking at the Tier 1 multi-stream default 

dashboard. A multi-stream dashboard displays data in real time over multiple data streams. The 

data in a stream is based on an entity’s view or a queue, such as My Activities, My Cases, or 

Cases in the Banking Queue. While a stream always contains information only about one entity, 

each stream on the dashboard may contain information about a different entity. For example, you 

may be tracking cases in one stream and accounts in the other stream, but, you can’t track cases 

and accounts in the same stream. In a multi-stream dashboard all streams may be displaying 

data based on the same entity.  

You also could be using a multi-stream entity-specific dashboard, such as the Cases dashboard. 

To open a dashboard like this, you’ll need to navigate to Service and down to a specific entity, 

such as Cases, as shown here.  
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The default Cases grid is displayed. To open the Cases dashboard, click the square button in the 

bottom left corner of the page, as shown here.   

 

 

 
 

 

Multi-stream dashboards target Tier 1 support, where customer service representatives handle 

many support cases at the same time. An entity-specific dashboard can be useful for Tier 1 

representatives or Tier 2 customer representatives that look at fewer, but, more complex cases. 

In the multi-stream dashboard, you can easily switch from a standard view to the tile view. The 

interactive tiles show an aggregated view of the data across the queues or views. You can also 

click the tile to drill down to the underlying records. The interactive dashboard application opens 

with the Tier 1 interactive dashboard. However, you can make another selection from the 

available dashboards, as shown here. 

 
 

 

Single-stream dashboards display real-time data over one stream based on a view or queue. The 

tiles are positioned on the right side of the dashboards and are always shown. Single-stream 

dashboards are helpful to Tier 2 leads or managers, who monitor fewer, but more complex or 

escalated cases in a single view or queue.  
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Multi-stream and single-stream dashboards contain interactive charts that give you a count of 

relevant records, such as cases by priority or by status. These charts also act as visual filters.  

You can apply additional filtering with global filters and timeframe filters. The global filter works on 

streams and charts in the dashboard. You can sort the data in a stream based on different 

criteria, such as the priority, status, or the date when the record was created. 

 The illustrations here show multi-stream and single-stream dashboards with the header pane. 

Below the header you see visual filters and streams. In the single-stream dashboard, you also 

see tiles. The dashboard header shown here contains the following controls and clickable 

buttons, from left to right: dashboard selector, refresh, visual filter (interactive chart) button, global 

filter button, and timeframe filter. 

 
 

 

 

Multi-stream dashboard standard view 

In the multi-stream dashboard, you see a row of visual filters (interactive charts) at the top with 

the data streams below.   

 
 

Multi-stream dashboard tile view 

The same dashboard, only in the tile view.  
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Multi-stream entity specific dashboard standard view 

The following illustration shows the entity specific dashboard for the Case entity.  

 
 

Single-stream dashboard 

The single-stream dashboard contains the data stream on the left and visual filters (interactive 

charts) and tiles on the right.  
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Interactive tiles 

Interactive tiles provide an aggregated view of the information in the streams, across queues or 

views that interest you most. They help you monitor the volume of cases and quickly drill down to 

a particular case. In the multi-stream dashboard, you can switch from the standard view to the tile 

view using the switcher, a control at the bottom right corner of the dashboard, as shown here. In 

the single-stream dashboard, the tiles are always shown and there is no switcher on the 

dashboard. 

 

 
 

If you have five streams in the multi-stream dashboard in the standard view, after you switch to 

tiles, you’ll see five tiles. If a view that tracks your active cases contains 30 items, the 

corresponding My Active Cases tile will display a numerical number 30 in the center of the tile. 

To drill down to a particular case, click the tile anywhere or More (…) in the right bottom corner. A 

flyout window will open. If there are too many cases to show, the window will have a scrollbar. 

You can navigate and click a particular case in the list, which will take you straight to the case 

form. The illustration shows the tiles and underlined cases in the list.  
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Visual filters (interactive charts) 

Interactive charts provide a visual snapshot of key metrics, such as cases by priority or by origin. 

They also act as visual filters (interactive charts) to help remove clutter from the screen and 

display information that interests you most. For example, if you click the High Priority circle in the 

“Cases by Priority” chart, the dashboard will refresh and you’ll see only high priority cases in your 

data streams. You can find different types of charts on your dashboard, such as pie, bar, 

doughnut, or tag chart. Visual filters (interactive charts) and tiles help you see the changes and 

patterns in data, and act quickly to address the most important issues. To display the charts on 

the dashboard, click the visual filter (interactive chart) button in the dashboard header, as shown 

here. The clickable button acts as a toggle switch, to show or hide the visual filters (interactive 

charts) on the dashboard. On the single-stream dashboard, the visual filters (interactive charts) 

are always shown and can’t be hidden from the view.  

 
 

 

The following illustration shows the multi-stream dashboard without visual filters  
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The following illustration shows the multi-stream dashboard with visual filters (interactive charts) 

depicting left to right: pie chart, doughnut chart, bar chart, and tag chart.   

 
 

 

 

Global filter 

 

To add granularity to filtering data, you can use the global filter. For example, you can apply the 

global filter to show only escalated cases and the cases that are marked as “Request.”  

The global filter button is shown in the dashboard header to the right of the chart button, as 

shown here. 

 
 



 

 
257 

 

When you click the global filter button, the filter flyout window opens. The entity fields that are 

preconfigured by your administrator appear in alphabetical order in the flyout window. You can 

select multiple values in a field, as well as values from multiple fields. In our example, we 

checked Yes for the IsEscalated field and checked the cases of type Request. Click Apply for 

the action to take place.  

 
 

After you apply global filters, the dashboard refreshes to show you only the escalated and 

requested cases in charts, streams, and tiles that are based on the filter entity (the filter entity is 

the entity that is used in the charts). By applying the visual filter for critical cases and the global 

filter for escalated cases, with just a few clicks, you went from a long list of cases to only a few 

cases that really matter to you. 

 

 

Clear the filters 
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Filtering helps remove the clutter on the screen and show only the work items that you want to 

focus on. However, if you want to see the entire unfiltered workload, it takes only a click of the 

mouse to clear a particular filter or all filters at once. The applied filters are conveniently shown in 

the dashboard header and you can clear the filters by clicking the Clear button next to each filter 

or clear all filters by clicking the Clear button next to the global filter button as shown here. 

 
 

 

 

Timeframe filter 

You can also apply the timeframe to display cases in a specified period of time. For example, you 

can choose to view data from last month, last week, a particular date, or today.  

 
 

 

 

Collapse or expand work item description in the stream 

To learn more about the case, you can expand the work item description area. Click the small 

arrow in the bottom right corner of the work item to expand or collapse the text, as shown here. 

 
 

 

 

Show quick actions 
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You can select the check box in the top right corner of the work item to open the quick actions 

menu. From this menu, you can directly resolve or cancel a case, or assign the case to someone 

else, as shown here.  

 
 

 

To see more menu items you can use the More (…) button on the quick actions menu, or toggle 

the check box. The illustration shows the Assign menu selection.  

 
 

 

 

Edit stream properties 

You can edit the stream properties by clicking More (…) in the stream header, as shown here.  
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For example, you can choose to sort the cases by priority, instead of the date the case was 

created or modified. When you click Edit Properties, the flyout dialog opens, in which you can 

make a new selection, such as sort by Priority, as shown here. After you change the sort criteria, 

the dashboard refreshes and you see the cases sorted by the priority in the stream.  

 
 

 

Note  



 

 
261 

By default, sorting is initially based on the Modified On field. If you change the default 

sorting from Modified On to something else, and the Modified On selection isn’t in the 

Sort By list in the flyout, you won’t be able to go back to sorting by that field again.  

 

 

Change the sort order in the data stream 

You can easily toggle the sort order in the stream by clicking the field name on which the data 

sorted, such as Priority or Modified On. You can sort the data to see high priority cases first, as 

shown here.  

 
 

 

 

Color-coded data in streams and charts 

The information in the charts and streams is color coded for the fields that contain a set of 

options. For example, a case type can be “Question,” “Problem,” or Request.” Or, a case can be 

escalated (“Yes”), or not escalated (“No”). Each of these options can be assigned a specific color. 

For example, cases that are questions can be shown in yellow, cases that are requests in purple, 

and problem cases can be shown in red. In the streams, the color is shown in the thin vertical line 

to the left of the work item description. The doughnut charts and tag charts don’t show information 

in color. They depict information in white, gray, and black shades. You can work with your 

administrator to choose the colors you like for your dashboard data.  

 

 

Information for customizers 

For information on how to configure the interactive dashboards, see TechNet: Configure 

interactive experience dashboards 

https://technet.microsoft.com/library/d1446a95-14bf-4b15-a905-72fce07f4c76.aspx
https://technet.microsoft.com/library/d1446a95-14bf-4b15-a905-72fce07f4c76.aspx
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Maximize marketing campaigns 

 

Get started with CRM marketing 

Create a marketing list in the CRM marketing work area 

Create or edit a campaign in the CRM marketing work area 

Create a quick campaign in the CRM marketing work area 

Add an activity to a campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

View and manage marketing communications with the Microsoft Dynamics Marketing Seller 

Portal 

Get started with CRM marketing 

Promote your business and improve sales with targeted marketing campaigns in Microsoft 

Dynamics CRM. Create activities for each campaign and assign them to different team members. 

Track customer response and costs for each campaign. Follow this step-by-step guide to get 

started with your marketing campaigns. 

The Marketing work area within CRM provides basic marketing features and gets you 

started with running marketing campaigns. Microsoft Dynamics Marketing takes you to 

the next level by providing deep customer insights and behavioral data to help plan and 

analyze your campaigns, greater functionality for automation and collaborating with team 

members, and social media integration. More information: Microsoft Dynamics Marketing 

Help Center 

Import contacts, accounts, and leads 

Get your customer records into Microsoft Dynamics CRM, and add these to marketing lists so you 

can target your campaigns. More information: Import accounts, leads, or other data 

Create marketing lists 

Group accounts, contacts, or leads into a targeted marketing list. You can create a marketing list 

easily with the search functionality in Microsoft Dynamics CRM, so you find all of your customers 

in a particular area, for example, and add them to the member list. More information: Create a 

marketing list in the CRM marketing work area 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
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Understand the difference between a campaign and a quick campaign 

In Microsoft Dynamics CRM, use standard campaigns to manage the end-to-end process of a 

complete marketing campaign, like managing campaign and planning activities, distributing the 

activities to other team members, and tracking how the campaign did. Campaigns include 

extensive tracking features, including detailed information, reports, and multiple marketing lists. 

In contrast to standard campaigns, use quick campaigns to automatically distribute a single 

activity to selected accounts, contacts, or leads, or to a single marketing list. The effects of a 

quick campaign are immediate. 
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Create a campaign or a quick campaign 

Depending on your requirement, track your marketing activities through a campaign or a quick 

campaign. More information: Create or edit a campaign in the CRM marketing work area, Create 

a quick campaign in the CRM marketing work area 

Track a campaign response 

Record the replies you get from the potential customers in response to a specific marketing 

campaign to make sure your team can act on the responses. Measure the success of specific 

campaign activities based on their response rates. More information:  Track a campaign response 

in the CRM marketing work area 

See how your campaigns are doing with default marketing reports 

Use one of the following reports to assist you in monitoring and analyzing marketing activities: 

 Campaign Activity Status: Use this report to track a campaign. The report displays a 

summary for one campaign. 

 Campaign Comparison: Use this report to identify your most and least successful 

campaigns. 

 Campaign Performance: Use this report to track the progress and status of your campaigns. 

Let your customers unsubscribe from marketing communications 

You can enable customers to unsubscribe from email marketing communications your 

organization sends them. 

More information: System Settings dialog box - Marketing tab 

Note that you cannot add unsubscribe functionality to direct email or email templates. 

See Also 

Create a marketing list in the CRM marketing work area 

Create or edit a campaign in the CRM marketing work area 

Create a quick campaign in the CRM marketing work area 

Add an activity to a campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Create or edit a campaign template in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

http://go.microsoft.com/fwlink/p/?LinkId=394324
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Create a marketing list in the CRM marketing work area 

Your marketing list is the core of running a successful marketing campaign. It can include any 

one type of customer record, such as leads, accounts, or contacts. 

You can create two types of marketing lists: 

 Static   Use a static list if you prefer to add and update members manually. 

 Dynamic   Use a dynamic marketing list if you want the list to return a list of members 

dynamically when needed, based on search criteria you set. For example, if you want to run a 

campaign to members of a specific city, use a dynamic list. A dynamic marketing list retrieves 

the updated list of members each time you open the list, create a quick campaign from the 

list, or distribute a campaign activity for a campaign associated with the list. 

Create a marketing list 

1. Go to Marketing >  Marketing Lists. (How do I get there?) 

2. Click New. 

3. Add or change the information in the Summary area. This screenshot provides an 

example. 

 
 

Note  

To look up records in the Owner field, first click Save, or you’ll lose your 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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changes. 

4. Click Save so you can enter information in other areas of the form. 

5. Add any other information that applies to your marketing list in the Notes area. 

6. Click Save. 

Add members to a marketing list 

 

Add members to a static marketing list 

1. In any marketing list record, in the Members area, click the Add  button.  

2. In the Manage Members dialog box, select one of the following options, and then click 

Continue. 

Add using Lookup 

a. In the Look Up Records dialog box, select your search criteria. 

b. Select the records that you want to add, click Select, and then click Add. 

 

Add using Advanced Find 

a. In the Add Members dialog box, click Select, and then select the field on 

which you want to search, such as Account Name or City. You can select 

fields from the current record type, or from related record types. When you 

select a related record type, a new line appears with another Select list for 

the related record type. 

b. Click Equals, and then select a query relational operator (for example 

Contains or Begins With). 

c. Click Enter Text, and then type the value that you want to locate. 

d. To specify the columns to include in the search results, click Edit Columns, 

and then Add Columns. Then select the columns that you want to add, and 

click OK. 

e. Click Find. 

f. Select the members that you want to add, select one of the following, and 

then click Add to Marketing List. 

 Add only the selected members to the marketing list 

 Add all the members returned by the search to the marketing list 

 

Remove using Advanced Find 
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a. In the Add Members dialog box, click Select, and then select the field on 

which you want to search, such as Account Name or City. You can select 

fields from the current record type, or from related record types. When you 

select a related record type, a new line appears with another Select list for 

the related record type. 

b. Click Equals, and then select a query relational operator (for example 

Contains or Begins With). 

c. Click Enter Text, and then type the value you want to locate. 

d. To specify the columns to include in the search results, click Edit Columns, 

and then click Add Columns. Then select the columns that you want to add, 

and click OK. 

e. Click Find. 

f. Select the members that you want to remove, select one of the following, and 

then click Remove from Marketing List. 

 Remove only the selected members from the marketing list 

 Remove all the members returned by the search from the marketing list 

 

Evaluate using Advanced Find 

a. In the Add Members dialog box, click Select, and then select the field on 

which you want to search, such as Account Name or City. You can select 

fields from the current record type, or from related record types. When you 

select a related record type, a new line appears with another Select list for 

the related record type. 

b. Click Equals, and then select a query relational operator (for example 

Contains or Begins With). 

c. Click Enter Text, and then type the value you want to locate. 

d. To specify the columns to include in the search results, click Edit Columns, 

and then click Add Columns. Then select the columns that you want to add, 

and click OK. 

e. Click Find. 

f. Select the members that you want to keep, select one of the following, and 

then click Update Marketing List. 

 Keep only the selected members in the marketing list 

 Keep all the members returned by the search in the marketing list 
 

Define the member selection criteria for a dynamic marketing list 

1. In any marketing list, in the Members area, click the Add  button. 

2. In the Manage Members dialog box, click Select, and then select the field on which you 
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want to search, such as Account Name or City. You can select fields from the current 

record type, or from related record types. 

When you select a related record type, a new line appears with another Select list for the 

related record type. 

3. Click Equals, and then select a query relational operator. 

4. Click Enter Value, and then type the value that you want to locate (for example, "Seattle" 

or "Email"). 

For some values, you can click the Lookup icon to open the Select Values dialog box 

and select the value you want. 

5. To specify the columns to include in the search results, click Edit Columns, and then 

Add Columns. Select the columns that you want to add, and click OK. 

6. Click Use Query to add the matching records to your dynamic marketing list. 

Associate campaigns or quick campaigns to a marketing list 

After you have created a campaign or quick campaign, you can associate it to your marketing list. 

You can also create a new campaign or quick campaign from your marketing list. 

1. In the Campaigns or Quick Campaigns area, click the Add  button. 

2. Search for the campaign or quick campaign you want to associate to this marketing list. 

Note  

If you don’t have any campaigns, or if you want to create a new one, you can 

click + New. 

If you don’t have any quick campaigns, the Quick Campaign Wizard will start. 

 

This topic applies to the Marketing work area within Microsoft Dynamics CRM. The 

Dynamics CRM Marketing work area provides a way for your sales force to run sales-

driven marketing activities. If you use Microsoft Dynamics Marketing along with Dynamics 

CRM, you might be looking for a similar topic for that product. Dynamics Marketing 

provides a full-scale set of functionality, automation, and analytical insights for multistage 

and multichannel campaigns.  More information: Microsoft Dynamics Marketing Help 

Center 

See Also 

Get started with CRM marketing 

Create or edit a campaign in the CRM marketing work area 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
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Create a quick campaign in the CRM marketing work area 

Add an activity to a campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

Create or edit a campaign in the CRM marketing work area 

Promote your business, expand your reach to new customers, and improve sales by using 

campaigns in Microsoft Dynamics CRM. Use campaigns to store all your marketing information 

and activities, and to measure the success of your efforts. Campaigns contain planning tasks and 

campaign activities you need to manage for the marketing campaigns. 

Add strategic campaign information to your campaign, such as: 

 Budgets and expenses 

 Promotion codes 

 Target products 

 Marketing collateral, including sales literature 

 Target marketing lists 

Campaigns can include whatever planning activities you want to perform before you launch the 

campaign, and also the campaign activities you want to manage as part of the campaign. More 

information: Add an activity to a campaign in the CRM marketing work area 

 

 

 

1. Go to Marketing > Campaigns. (How do I get there?) 

2. To create a new campaign, click New. 

- OR - 

To edit a campaign, open a campaign from the list. 

3. Add or change information in the text boxes. 

a. In the Campaign section, enter the campaign details such as, name, type, and the 

expected response rate. 

b. In the Schedules section, enter the proposed and actual start and end dates of the 

campaign. 

c. Under Financials, enter details about the cost of the campaign and campaign 

activities, and the budget and revenue of the campaign. 

d. To track conversations in the planning phase of the campaign, in the Activities area, 

add activities. More information:  Add a phone call, task, email, or appointment 

 

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=525636
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activity to a case or record 

4. When you’re ready to save your data, click Save. 

5. To add a marketing list to the campaign, in the Marketing Lists area, click +, and in the 

Look Up Records dialog box, find and select a marketing list. 

6. To create planning and campaign activities for your campaign, for example, identifying 

advertising channels or prepare campaign communications to send to the members on 

the marketing lists, see Add an activity to a campaign in the CRM marketing work area. 

 

This topic applies to the Marketing work area within Microsoft Dynamics CRM. The 

Dynamics CRM Marketing work area provides a way for your sales force to run sales-

driven marketing activities. If you use Microsoft Dynamics Marketing along with Dynamics 

CRM, you might be looking for a similar topic for that product. Dynamics Marketing 

provides a full-scale set of functionality, automation, and analytical insights for multistage 

and multichannel campaigns.  More information: Microsoft Dynamics Marketing Help 

Center 

See Also 

Create or edit a campaign template in the CRM marketing work area 

Create a marketing list in the CRM marketing work area 

Create a quick campaign in the CRM marketing work area 

Add an activity to a campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

Create a quick campaign in the CRM marketing work area 

Send an e-mail blast to customers who fit a specific demographic, a mail campaign to clients in a 

specific region, or perhaps a phone call campaign to previous buyers of a particular product by 

using a quick campaign in Microsoft Dynamics CRM. A quick campaign is a single campaign 

activity geared toward a targeted audience. Track the success of your quick campaign through 

campaign responses, and convert the positive responses into new leads, quotes, orders, or 

opportunities. 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
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If you need to perform more than one activity for your campaign, such as an email blast and a 

mailing, create a new campaign instead. More information: Create or edit a campaign in the CRM 

marketing work area 

 

1. Go to Marketing >  Marketing Lists. (How do I get there?) 

2. Open a record, and then in the Quick Campaigns area, click the Add button . 

3. In the Quick Campaign Wizard, read the instructions on the Welcome page, and click 

Next. 

4. Specify a name for the quick campaign. 

5. Select the type of activity you want to create. 

You can also select who you want Microsoft Dynamics CRM to assign the activity to and 

whether CRM should perform the activity automatically for appropriate activities, such as 

sending email messages. For example, if you are creating a phone call activity for all the 

sales representatives, you can select the phone call activity, and then select The owners 

of the records that are included in the quick campaign. Each sales representative 

can then see the activity and take action on it. However, if you are creating a large 

number of email activities that CRM will perform automatically, you can assign the email 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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activity to yourself instead of the record owners. 

6. Add or change information in the text boxes in the activity form, and click Next. 

7. Click Create. 

Note  

You can’t add records to a quick campaign after you create it. 

 

This topic applies to the Marketing work area within Microsoft Dynamics CRM. The 

Dynamics CRM Marketing work area provides a way for your sales force to run sales-

driven marketing activities. If you use Microsoft Dynamics Marketing along with Dynamics 

CRM, you might be looking for a similar topic for that product. Dynamics Marketing 

provides a full-scale set of functionality, automation, and analytical insights for multistage 

and multichannel campaigns.  More information: Microsoft Dynamics Marketing Help 

Center 

See Also 

Get started with CRM marketing 

Create a marketing list in the CRM marketing work area 

Create or edit a campaign in the CRM marketing work area 

Add an activity to a campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

Add an activity to a campaign in the CRM marketing work area 

Make your marketing campaigns successful by creating, distributing, and assigning planning and 

campaign activities in Microsoft Dynamics CRM. Planning activities are those you want to perform 

before you launch the campaign, and campaign activities are those you want to manage as part 

of the campaign. Examples of planning and campaign activities you can add include: 

 Identify advertising channels and supporting materials 

 Contact media channels to reserve time or space for advertising 

 Create or refine target marketing lists 

 Contact a design agency to request creation of collateral pieces and advertising materials 

By default, a campaign targets an activity to the group of marketing lists that you select for the 

campaign. If you want to run a campaign activity on a subset of your marketing lists, you can 

distribute the activity to certain members instead. 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
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Add a planning activity to a campaign 

1. Go to Marketing > Campaigns. (How do I get there?) 

2. In the campaign record you want to add the planning activity to, on the nav bar, click the 

down arrow  next to the campaign you’re working on and then click Planning Activities. 

3. To add a new activity, click Add New Activity, and then select the type of activity you 

want to create. 

-OR- 

To add an existing activity, click Add Existing Activity. In the inline lookup field, search 

for and select the activity. 

4. In the new activity form, add or change information in the text boxes. 

5. When you’re ready to save your data, click Save. 

Add a campaign activity to a campaign 

1. Go to Marketing > Campaigns. (How do I get there?) 

2. In the campaign record you want to add the campaign activity to, on the nav bar, click the 

down arrow  next to the campaign you’re working on and then click Campaign Activities. 

3. Click Add New Campaign Activity. 

4. Type in all the information you can, and then click Save. This creates the campaign 

activity so you can do more things with it, like add marketing lists.  

5. To add a marketing list, click +. In the Look Up Records box, type in your search and 

click the Search button, select one or more marketing lists, and click Add. 

6. To distribute the new campaign activity, on the command bar, click Distribute Campaign 

Activity. 

7. In the activity form, type or modify information in the text boxes, and click Distribute. 

8. Choose who will own the activities, and click Distribute. 

Note  

You can only distribute campaign activities of type “mail merge” to marketing lists 

that contain the same type of record. For example, if one marketing list contains 

accounts and a second marketing list contains leads, the mail merge campaign 

activity will fail. Create a separate mail merge campaign activity for each group of 

marketing lists with the same record type. 

9. After all the distributed activities are closed, you can close the campaign activity. To close 

the campaign activity, open the campaign activity record, and on the command bar, click 

Close Campaign Activity. Set an appropriate status for the activity, and click OK. 

10. When the activity is completed, update the campaign activity record with the actual costs. 

Open the campaign activity and update the Actual Cost field. This can help guide you in 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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planning future campaign activities. 

 

This topic applies to the Marketing work area within Microsoft Dynamics CRM. The 

Dynamics CRM Marketing work area provides a way for your sales force to run sales-

driven marketing activities. If you use Microsoft Dynamics Marketing along with Dynamics 

CRM, you might be looking for a similar topic for that product. Dynamics Marketing 

provides a full-scale set of functionality, automation, and analytical insights for multistage 

and multichannel campaigns. More information: Microsoft Dynamics Marketing Help 

Center 

See Also 

Get started with CRM marketing 

Create a marketing list in the CRM marketing work area 

Create or edit a campaign in the CRM marketing work area 

Create a quick campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

Add a marketing list, sales literature, or product to a campaign 
in the CRM marketing work area 

Add all items to your campaign that your need in this marketing context. Usually you need to add 

marketing lists, but you might also want to refer campaigns to products and related campaigns, or 

you might want to add sales literature that documents sales procedures. 

 

1. Go to Marketing > Campaigns. (How do I get there?) 

2. Choose the name of the campaign that you want to add a list, product, or sales literature 

to. In the nav bar, click the down arrow next to your campaign. 

 

The following table shows what you need to do to add each type of item. 
 

To add Do this 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=525636
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A marketing list Click Target Marketing Lists, and then 

click Add Existing Marketing List. 

A product Click Target Products, and then click 

Add Existing Product. 

Sales literature Click Sales Literature, and then click Add 

Existing Sales Literature. 

A related campaign Click Related Campaigns, and then click 

Add Existing Campaign. 

 

 

3. Select the type of record you want in the Look Up Records dialog box, in the Look for 

list. 

4. Type the first few letters of the name of the record to narrow your search in the Search box, 

and then click the Find button . 

5. Select the check boxes for the records that you want to add in the list of records that 

appears, click Add, and then click OK. 

6. Click Save or Save and Close. 

Note  

To verify that the item you selected was added to the campaign, reopen the 

campaign. Under Marketing, click Target Marketing Lists, or under Sales click 

either Target Products or Sales Literature. The information you added appears 

in the list. 

 

This topic applies to the Marketing work area within Microsoft Dynamics CRM. The 

Dynamics CRM Marketing work area provides a way for your sales force to run sales-

driven marketing activities. If you use Microsoft Dynamics Marketing along with Dynamics 

CRM, you might be looking for a similar topic for that product. Dynamics Marketing 

provides a full-scale set of functionality, automation, and analytical insights for multistage 

and multichannel campaigns.  More information: Microsoft Dynamics Marketing Help 

Center 

See Also 

Get started with CRM marketing 

Create a marketing list in the CRM marketing work area 

Create or edit a campaign in the CRM marketing work area 

Create a quick campaign in the CRM marketing work area 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
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Add an activity to a campaign in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

Track a campaign response in the CRM marketing work area 

Record the replies you get from potential customers in response to a specific marketing campaign 

to make sure your team can act on the responses. Measure the success of specific campaign 

activities based on their response rates. You can manually create campaign responses in 

Microsoft Dynamics CRM or have CRM generate them automatically. 

Create campaign responses manually 

1. Go to Marketing > Campaigns. (How do I get there?) 

2. Select the campaign that you want to add campaign responses to, and under Responses, 

click Add  . 

3. Add information in the Campaign Response form. 

4. Click Save. 

Create campaign responses automatically 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Administration. (How do I get there?) 

3. Click the System Settings > Marketing tab. 

4. Set the Create campaign responses for incoming email option to Yes. 

 

This topic applies to the Marketing work area within Microsoft Dynamics CRM. The 

Dynamics CRM Marketing work area provides a way for your sales force to run sales-

driven marketing activities. If you use Microsoft Dynamics Marketing along with Dynamics 

 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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CRM, you might be looking for a similar topic for that product. Dynamics Marketing 

provides a full-scale set of functionality, automation, and analytical insights for multistage 

and multichannel campaigns. More information: Microsoft Dynamics Marketing Help 

Center 

See Also 

System Settings dialog box - Marketing tab 

Get started with CRM marketing 

Create a marketing list in the CRM marketing work area 

Create or edit a campaign in the CRM marketing work area 

Create a quick campaign in the CRM marketing work area 

Add an activity to a campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Create or edit a campaign template in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

View and manage marketing communications with the Microsoft 
Dynamics Marketing Seller Portal 

Stay up-to-date with communications that your Marketing department has sent to your contacts 

with the Seller Portal in Microsoft Dynamics Marketing. Access the Seller Portal from within 

Microsoft Dynamics CRM to stay well-informed about communications your customers have 

received from Microsoft Dynamics Marketing or to remove them from campaigns that don’t apply 

to them. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

This feature also requires Microsoft Dynamics Marketing 2015 Update or later. 

For more information about working with the Seller Portal in Microsoft Dynamics Marketing, see 

Use the Seller Portal to see and manage which messages are reaching your contacts. 

If you’re a CRM administrator who wants to enable the Seller Portal for your users, see Dynamics 

Marketing for Dynamics CRM users. 

View the Seller Portal for selected accounts 

1. Go to Sales > Accounts. (How do I get there?) 

2. Select the accounts for which you want to view marketing communications in Microsoft 

Dynamics Marketing. 

3. Click the More button … at the top of the screen and then click View Marketing Portal. 

4. Sign in to Microsoft Dynamics Marketing if prompted. 

http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=513887
http://go.microsoft.com/fwlink/p/?LinkId=513888
http://go.microsoft.com/fwlink/p/?LinkId=513888
http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
278 

View the Seller Portal for selected contacts 

1. Go to Sales > Contacts. (How do I get there?) 

2. Select the accounts for which you want to view marketing communications in Microsoft 

Dynamics Marketing. 

3. Click the More button … at the top of the screen and then click View Marketing Portal. 

4. Sign in to Microsoft Dynamics Marketing if prompted. 

See Also 

Use the Seller Portal to see and manage which messages are reaching your contacts 

Use Outlook with CRM 

 

CRM for Outlook User's Guide (full app) 

CRM App for Outlook User's Guide (lightweight app) 

CRM for Outlook User's Guide (full app) 

 

 

 

 

 

 

 

Setup and configuration 

Set up CRM for Outlook 

Configure another organization to use with CRM for Outlook 

What’s new 

What's new 

Get ready for the next release 

Learn about the new lightweight email tracking app (CRM App for Outlook) in the latest Release 

Preview Guide 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=513887
http://go.microsoft.com/fwlink/p/?LinkID=624861
http://go.microsoft.com/fwlink/p/?LinkID=624861
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Get started 

Do your CRM work in Outlook 

Overview of tracking records in CRM for Outlook 

Work offline with CRM for Outlook 

Tracking records 

Overview of tracking records in CRM for Outlook 

Track Outlook email by moving it to a tracked Exchange folder 

Track Outlook email by choosing a button in CRM for Outlook 

Track Outlook contacts in CRM for Outlook 

Use a wizard to add and track multiple Outlook contacts in CRM for Outlook 

Track Outlook appointments in CRM for Outlook 

Track Outlook tasks in CRM for Outlook 

Synchronizing data 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

View the fields that are synchronized between CRM and Outlook 

Choose the records to synchronize between CRM and Outlook or Exchange 

Choose records to work with offline in CRM for Outlook 

Synchronize records manually with CRM for Outlook 

Control field synchronization between CRM and Outlook or Exchange 

Synchronizing data with Outlook or Exchange FAQ 

Working offline 

Work offline with CRM for Outlook 

Choose records to work with offline in CRM for Outlook 

Example of going offline with CRM for Outlook 

Setting personal options 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Set an option to automatically track incoming Outlook email in CRM for Outlook 

Set address book options in CRM for Outlook 

Customize your regional settings (number, currency, time, and date) in CRM for Outlook 
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Troubleshooting and FAQ 

Synchronizing data with Outlook or Exchange FAQ 

Troubleshooting CRM for Outlook issues 

Get help from experts 

Search forums and communities 

Watch videos 

Search the Microsoft Dynamics CRM team blog 

Set up and configure 

 

Set up CRM for Outlook 

Configure another organization to use with CRM for Outlook 

Set up and configure CRM for Outlook from Office 365 

The Outlook email address should be the same as the CRM email address 

Set up CRM for Outlook 

horizontaltabbed 

CRM 2016 for Outlook 

If you’re like many people, you use Microsoft Office Outlook as your communications, scheduling, 

and contact management hub for business. You can continue to use the familiar Outlook interface 

and integrate Microsoft Dynamics CRM at the same time by using Microsoft Dynamics CRM 2016 

for Outlook. Dynamics CRM 2016 for Outlook can also provide access to CRM data while you’re 

offline. More information: Do your CRM work in Outlook 

To install and use Dynamics CRM 2016 for Outlook, your organization must be running 

Microsoft Dynamics CRM 2016 Server.  

Step 1: Review installation prerequisites 

 To install Dynamics CRM for Outlook, you must be able to sign in to your computer as a 

user with Local Administrator privileges.  

In smaller companies, Dynamics CRM for Outlook is often installed manually, on a 

computer-by-computer basis. Administrators or individual users who have Local 

Administrator privileges and who possess a general familiarity with installing software can 

do these installations. 

Important  

Sign in as a Local Administrator 

Review software requirements 

https://technet.microsoft.com/librarY/hh699813.aspx
http://go.microsoft.com/fwlink/p/?LinkID=391331&q=Outlook&ds=f
http://go.microsoft.com/fwlink/p/?LinkID=395147
http://go.microsoft.com/fwlink/p/?LinkID=395148
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 TechNet: Get information on software requirements 

 TechNet: Get information on hardware and network requirements 

 Before you install Dynamics CRM for Outlook, make sure you have all the latest Microsoft 

Office updates, including all security updates from Microsoft Update. Go to Microsoft 

Update. 

 To install Dynamics CRM 2016 for Outlook, you must have the appropriate security 

permissions. TechNet: Learn about permissions. 

Step 2: Download the software 

Before you or your users install Dynamics CRM 2016 for Outlook, please note the following: 

 Make sure you have completed your desired CRM customizations. If your users will use 

Dynamics CRM 2016 for Outlook in offline mode, for best performance, enable only the 

minimum required record types (entities) and views for offline use. For more information, see 

TechNet: Customize your CRM system. 

 Group Policy Folder Redirection with offline files is not supported in Dynamics CRM for 

Outlook. If your CRM data is stored with redirected offline files, users may be unable to use 

Dynamics CRM for Outlook. More information: TechNet: Using Folder Redirection 

 For synchronization to work correctly, we recommend that you turn on Cached Exchange 

Mode in Outlook. More information: Office: Turn Cached Exchange mode on or off 

1. In CRM, click the Settings icon , and then click Apps for Dynamics CRM.  

2. On the Apps for Dynamics CRM page, click Download from Microsoft Download 

Center. 

Tip  

If you prefer, you can download the software from this web page. 

3. If you see one or more Security Warning dialog boxes, click Run in each. 

The software will start downloading and you’ll see the following dialog box: 

Review hardware and network requirements 

Install updates 

Verify permissions 

Download the software 

https://technet.microsoft.com/library/hh699818(v=crm.8).aspx
https://technet.microsoft.com/en-us/library/hh699680(v=crm.8).aspx
http://go.microsoft.com/fwlink/p/?LinkId=165705
http://go.microsoft.com/fwlink/p/?LinkId=165705
https://technet.microsoft.com/library/dn832110(v=crm.8).aspx
https://technet.microsoft.com/library/dn531158(v=crm.8).aspx
https://technet.microsoft.com/library/cc753996.aspx
https://support.office.microsoft.com/article/Turn-on-or-off-Cached-Exchange-Mode-e8966ca4-6ecd-4bdd-ade2-64993dda432b
http://go.microsoft.com/fwlink/p/?LinkId=690396
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4. In the Getting Started with CRM for Outlook dialog box, under 2. Configure, click 

Copy to copy your organization’s URL to your computer’s Clipboard. You’ll paste this 

URL in the following Configure step. 

5. Click Run, when prompted, to download the software. 

6. In the Browse For Folder dialog box, select a folder to store the extracted Outlook files. 

We recommend that you store the extracted files in a separate folder (choose the Make 

New Folder option in the dialog box to create a folder without exiting the wizard).  

7. On the License Agreement page, if you accept the license agreement, select I accept 

the license agreement, and then click Next. 

8. Do one of the following:  

 To install Dynamics CRM for Outlook without offline capability, click Install Now. 

 To install Dynamics CRM for Outlook with offline capability, click Options, select the 

Offline Capability check box on the Customize Installation page, and then click 

Install Now. If you don’t install offline capability during installation, you can add it 

later by choosing Go Offline in Dynamics CRM for Outlook. 

Important  

If you aren’t able to install offline capability, check to make sure you don’t 

have any pending Windows updates. Learn more about Windows updates 

9. When prompted, restart Outlook. 

Step 3: Configure CRM for Outlook 

After restarting Outlook, you’ll see the following dialog box: 

http://go.microsoft.com/fwlink/p/?LinkID=399355
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1. Press Ctrl+V to paste the URL you copied in the preceding Download the software 

step, and then click Connect. You can also enter a Server URL or a Discovery URL. 

2. If you’re prompted for a password, enter the password. 

Tip  

If you want to add another organization, you can run the Configuration Wizard 

again after you have successfully configured the first organization. To run the 

Configuration Wizard, in the Windows 8 Start screen, search for Configuration 

Wizard and run it. In earlier versions of Windows, click Start > All Programs > 

Microsoft Dynamics CRM, and then click Configuration Wizard.  

CRM 2015 for Outlook 

If you’re like many people, you use Microsoft Office Outlook as your communications, scheduling, 

and contact management hub for business. You can continue to use the familiar Outlook interface 

and integrate Microsoft Dynamics CRM at the same time by using Microsoft Dynamics CRM 2015 

for Outlook. Dynamics CRM 2015 for Outlook can also provide access to CRM data while you’re 

offline. More information: Do your CRM work in Outlook 

 Watch a video on setup, configuration, and upgrading (5:19) 

 To install and use Dynamics CRM 2015 for Outlook, your organization must be running 

Microsoft Dynamics CRM Server 2015.  

  Microsoft Dynamics CRM 2013 for Microsoft Office Outlook is not compatible with Microsoft 

Dynamics CRM Server 2015. At a minimum, you must update CRM 2013 for Outlook to UR1 

to use it with Microsoft Dynamics CRM Server 2015. More information: TechNet: Upgrading 

from CRM 2013 for Outlook to CRM 2015 for Outlook 

Step 1: Review installation prerequisites 

 To install Dynamics CRM for Outlook, you must be able to sign in to your computer as a 

 

Important  

Sign in as a Local Administrator 

http://go.microsoft.com/fwlink/p/?LinkId=522526
https://technet.microsoft.com/library/hh699711.aspx
https://technet.microsoft.com/library/hh699711.aspx
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user with Local Administrator privileges.  

In smaller companies, Dynamics CRM for Outlook is often installed manually, on a 

computer-by-computer basis. Administrators or individual users who have Local 

Administrator privileges and who possess a general familiarity with installing software can 

do these installations. 

 TechNet: Get information on software requirements 

 TechNet: Get information on hardware and network requirements 

 Before you install Dynamics CRM for Outlook, make sure you have all the latest Microsoft 

Office updates, including all security updates from Microsoft Update. Go to Microsoft 

Update. 

 To install Dynamics CRM 2015 for Outlook, you must have the appropriate security 

permissions. TechNet: Learn about permissions. 

Step 2: Download the software 

Before you or your users install Dynamics CRM 2015 for Outlook, please note the following: 

 Make sure you have completed your desired CRM customizations. If your users will use 

Dynamics CRM 2015 for Outlook in offline mode, for best performance, enable only the 

minimum required record types (entities) and views for offline use. For more information, see 

TechNet: Customize your CRM system. 

 Group Policy Folder Redirection with offline files is not supported in Dynamics CRM for 

Outlook. If your CRM data is stored with redirected offline files, users may be unable to use 

Dynamics CRM for Outlook. More information: TechNet: Using Folder Redirection 

 For synchronization to work correctly, we recommend that you turn on Cached Exchange 

Mode in Outlook. More information: Office: Turn Cached Exchange mode on or off 

1. In the CRM user interface, click Get CRM for Outlook on the message bar.  

 
 

Tip  

If you prefer, you can download the software from this page. 

Review software requirements 

Review hardware and network requirements 

Install updates 

Verify permissions 

Download the software 

https://technet.microsoft.com/library/hh699818.aspx
https://technet.microsoft.com/library/hh699818.aspx
http://go.microsoft.com/fwlink/p/?LinkId=165705
http://go.microsoft.com/fwlink/p/?LinkId=165705
https://technet.microsoft.com/library/dn832110.aspx
https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/cc753996.aspx
https://support.office.microsoft.com/article/Turn-on-or-off-Cached-Exchange-Mode-e8966ca4-6ecd-4bdd-ade2-64993dda432b
http://go.microsoft.com/fwlink/p/?LinkID=403030
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2. If you see one or more Security Warning dialog boxes, click Run in each. 

The software will start downloading and you’ll see the following dialog box: 

 
 

3. In the Getting Started with CRM for Outlook dialog box, under 2. Configure, click 

Copy to copy your organization’s URL to your computer’s Clipboard. You’ll paste this 

URL in the following Configure step. 

4. Click Run, when prompted, to download the software. 

5. In the Browse For Folder dialog box, select a folder to store the extracted Outlook files. 

We recommend that you store the extracted files in a separate folder (choose the Make 

New Folder option in the dialog box to create a folder without exiting the wizard).  

6. On the License Agreement page, if you accept the license agreement, select I accept 

the license agreement, and then click Next. 

7. Do one of the following:  

 To install Dynamics CRM for Outlook without offline capability, click Install Now. 

 To install Dynamics CRM for Outlook with offline capability, click Options, select the 

Offline Capability check box on the Customize Installation page, and then click 

Install Now. If you don’t install offline capability during installation, you can add it 

later by choosing Go Offline in Dynamics CRM for Outlook. 

Important  

If you aren’t able to install offline capability, check to make sure you don’t 

have any pending Windows updates. Learn more about Windows updates 

8. When prompted, restart Outlook. 

Step 3: Configure CRM for Outlook 

After restarting Outlook, you’ll see the following dialog box: 

http://go.microsoft.com/fwlink/p/?LinkID=399355
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1. Press Ctrl+V to paste the URL you copied in the preceding Download the software 

step, and then click Connect. You can also enter a Server URL or a Discovery URL. 

2. If you’re prompted for a password, enter the password. 

Tip  

If you want to add another organization, you can run the Configuration Wizard 

again after you have successfully configured the first organization. To run the 

Configuration Wizard, in the Windows 8 Start screen, search for Configuration 

Wizard and run it. In earlier versions of Windows, click Start > All Programs > 

Microsoft Dynamics CRM, and then click Configuration Wizard.  

CRM 2013 for Outlook  

If you’re like many people, you use Microsoft Office Outlook as your communications, scheduling, 

and contact management hub for business. You can continue to use the familiar Outlook interface 

and integrate Microsoft Dynamics CRM at the same time by using CRM 2013 for Outlook. 

Dynamics CRM for Outlook can also provide access to CRM data while you’re offline. More 

information: Do your CRM work in Outlook 

If you’re using Microsoft Dynamics CRM 2011 (on-premises), don’t update to the 

Microsoft Dynamics CRM 2013 for Outlook client; continue to use the Microsoft Dynamics 

CRM 2011 for Outlook client. 

If you’re using CRM 2013 (on-premises) or CRM Online, you can upgrade to CRM 2013 

for Outlook or you can use Microsoft Dynamics CRM 2011 for Outlook if you’re not ready 

to upgrade yet. If you use Microsoft Dynamics CRM 2011 for Outlook with CRM 2013 for 

Outlook or CRM Online, you can’t use the Outlook client in offline mode, however. We 

recommend that you update to CRM 2013 for Outlook at your earliest convenience. 

Step 1: Review installation prerequisites 

 

Important  

Sign in as a Local Administrator 



 

 
287 

 To install Dynamics CRM for Outlook, you must be able to sign in to your computer as a 

user with Local Administrator privileges.  

In smaller companies, Dynamics CRM for Outlook is often installed manually, on a 

computer-by-computer basis. Administrators or individual users who have Local 

Administrator privileges and who possess a general familiarity with installing software can 

do these installations. 

 TechNet: Get information on software requirements 

 TechNet: Get information on hardware and network requirements 

 Before you install Dynamics CRM for Outlook, make sure you have all the latest Microsoft 

Office updates, including all security updates from Microsoft Update. Go to Microsoft 

Update. 

Step 2: Download the software 

Before you or your users install CRM 2013 for Outlook, please note the following: 

 Make sure you have completed your desired CRM customizations. If your users will use CRM 

2013 for Outlook in offline mode, for best performance, enable only the minimum required 

record types (entities) and views for offline use. For more information, see TechNet: 

Customize your CRM system. 

 Group Policy Folder Redirection with offline files is not supported in Dynamics CRM for 

Outlook. If your CRM data is stored with redirected offline files, users may be unable to use 

Dynamics CRM for Outlook. More information: TechNet: Using Folder Redirection 

 For synchronization to work correctly, we recommend that you turn on Cached Exchange 

Mode in Outlook. More information: Turn Cached Exchange Mode on or off  

1. Run the Microsoft Dynamics CRM 2013 for Outlook Setup to download the software. You 

can start the Setup from any of the following places: 

 From the message bar in CRM:  In the CRM user interface, click Get CRM for 

Outlook on the message bar. If you see one or more Security Warning dialog 

boxes, click Run in each. 

 
 

 From the web: Go to the download page, and then download and run the 

appropriate executable file (32-bit or 64-bit), depending on your system and the 

Review software requirements 

Review hardware and network requirements 

Install updates 

Download the software 

https://technet.microsoft.com/library/hh699818.aspx
https://technet.microsoft.com/library/hh699680.aspx
http://go.microsoft.com/fwlink/p/?LinkId=165705
http://go.microsoft.com/fwlink/p/?LinkId=165705
https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/cc753996.aspx
http://go.microsoft.com/fwlink/p/?LinkID=512447
http://go.microsoft.com/fwlink/p/?LinkID=393787
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version of Outlook you use. 

 From a DVD: Double-click SetupClient.exe in the appropriate Microsoft Office 

installation folder (32-bit or 64-bit). 

2. In the Browse For Folder dialog box, select a folder to store the extracted Outlook files. 

We recommend that you store the extracted files in a separate folder (choose the Make 

New Folder option in the dialog box to create a folder without exiting the wizard).  

3. On the License Agreement page, if you accept the license agreement, select I accept 

the license agreement, and then click Next. 

4. In the Select the installation page, do one of the following:  

 To install Dynamics CRM for Outlook with offline capability, click Options, select the 

Offline Capability check box on the Customize Installation page, and then click 

Install Now. If you don’t install offline capability during installation, you can add it 

later by choosing Go Offline in Dynamics CRM for Outlook. 

Important  

If you aren’t able to install offline capability, check to make sure you don’t 

have any pending Windows updates. Learn more about Windows updates 

 To install Dynamics CRM for Outlook without offline capability, click Install Now. 

CRM installs Dynamics CRM for Outlook. You may need to restart your computer to 

complete the installation. 

5. On the final page of the wizard, click Close. 

Step 3: Configure CRM for Outlook 

You must configure Dynamics CRM for Outlook after installing it. When you restart Outlook after 

installing, the Configuration Wizard starts automatically.  

If the Configuration Wizard doesn’t start automatically, in the Start screen, search for 

Configuration Wizard and run it. In earlier versions of Windows, click Start > All 

Programs > Microsoft Dynamics CRM, and then click Configuration Wizard.  

1. In the Configuration Wizard, you’ll see a Server URL drop-down list. Click the arrow next 

to the drop-down list, and then do one of the following: 

 To connect to a CRM Online organization, select CRM Online. If you don’t know if 

you’re using the online or on-premises version of CRM, look in your browser at the 

web address for Microsoft Dynamics CRM. If the web address contains 

“dynamics.com” after the name of your organization, you’re using the online version. 

Otherwise, it’s the on-premises version. 

 To connect to a CRM 2013 (on-premises) organization, there are two types of URLs, 

depending on whether your computer is connected to the Internet or not: 

 For internal deployments (not connected over the Internet), type the Microsoft 

Dynamics CRM server or discovery service URL using the following format: 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=399355
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http://crmserver or http://crmserver:5555.  

 To connect over the Internet, use the discovery service URL using the following 

format: https://dev.crmserver.contoso.com.  

Note  

If you’re unsure of what url to use, check with your CRM administrator. 

1f71e2d9-5f51-46cf-aabc-f45d0f4a4a85 
 

2. Click Test Connection. This adds organizations to the Organization Information list. If 

you’re prompted for credentials, select from the following options: 

 For a CRM Online organization, do one of the following: 

 If your organization connects through Office 365, enter your Microsoft online 

services user name and password, and then click OK. This information was sent 

to you in email when your account was created.  

 If you’re connecting with an earlier online services platform, enter your Microsoft 

account (formerly Windows Live ID) and password, and then click OK. This 

information was sent to you in email when your account was created. 

 For a CRM on-premises organization, you may not be prompted because CRM uses 

your Active Directory domain credentials. 

3. In the Organization list, select the CRM organization you want to connect to, and then 

click OK. Then click Close.  

Tip  

If you have problems installing and configuring Dynamics CRM for Outlook, try 

Configuration Troubleshooting Wizard.  

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

http://go.microsoft.com/fwlink/p/?LinkID=394362
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track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM for Outlook, when you go offline, a copy of the data you are 

working on is created and stored on your local computer. The data is transferred from CRM 

Online to your computer by using a secure SSL connection, and a link is maintained between the 

local copy and CRM Online. The next time you sign in to CRM Online, the local data will be 

synchronized with CRM Online.  

 

 An administrator determines whether or not an organization’s users are permitted to go offline 

with Microsoft Dynamics CRM for Outlook by using security roles.  

 

 Users and administrators can configure which entities are downloaded via Offline Sync by using 

the Sync Filters setting in the Options dialog box. Alternatively, users and Administrators can 

configure which fields are downloaded (and uploaded) by using Advanced Options in the Sync 

Filters dialog box. 

 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Do your CRM work in Outlook 

TechNet: Set up CRM for Outlook 

TechNet: Upgrade to Microsoft Dynamics CRM 2015 for Outlook 

TechNet: Install CRM for Outlook for Microsoft Dynamics CRM 2013 

TechNet: Upgrade Microsoft Dynamics CRM 2011 for Outlook to Microsoft Dynamics CRM 2013 

for Outlook 

TechNet: Troubleshooting and things to know about Microsoft Dynamics CRM for Outlook 

Configure another organization to use with CRM for Outlook 

If you’re a member of more than one Microsoft Dynamics CRM organization, and you’re using 

Microsoft Dynamics CRM 2015 for Outlook or later, you can use this procedure to configure each 

organization. 

 

https://technet.microsoft.com/library/dn832060.aspx
https://technet.microsoft.com/library/hh699711.aspx
https://technet.microsoft.com/library/hh699713(v=crm.6).aspx
https://technet.microsoft.com/library/hh699723(v=crm.6).aspx
https://technet.microsoft.com/library/hh699723(v=crm.6).aspx
https://technet.microsoft.com/library/hh699813.aspx
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1. Close Outlook. 

2. Do one of the following: 

 In Windows 8 or Windows 10, choose Start, search for Configuration Wizard, and 

then press Enter. 

 In earlier versions of Windows, choose Start, point to All Programs, choose 

Microsoft Dynamics CRM 2015 or Microsoft Dynamics CRM 2016> 

Configuration Wizard. 

3. In the Microsoft Dynamics CRM 2015 for Outlook Configuration Wizard or Microsoft 

Dynamics CRM 2016 for Outlook Configuration Wizard dialog box, choose the Add 

button to add a new organization. 

You’ll see the following (or similar) dialog box: 

 
 

4. Do one of the following: 

 If you’re using CRM Online, select CRM Online from the list. 

 If you’re using CRM 2015 on-premises or later version, open a browser, log in to your 

CRM organization’s website, copy the URL address (copy the whole address) from 

the address bar, and then paste it in the Add a Microsoft Dynamics CRM 

Organization dialog box. 

5. Choose Connect. 
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6. If prompted, enter your credentials. 

7. Repeat steps 2 through 5 for each organization you want to add. 

8. If you want to change the organization that synchronizes email messages, appointments, 

contacts, and tasks, select the row for the organization, and then choose Synchronize.  

When you’re prompted about whether you want to change your synchronizing or primary 

organization, choose OK. 

Note  

You can synchronize information with only one organization. You can connect to 

or work with more than one organization. If you connect to more than one 

organization, they are both listed in the Dynamics CRM for Outlook Navigation 

Pane. 

9. Choose OK. 

10. In the wizard, choose Close. 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  
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 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Do your CRM work in Outlook 

Set up CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Set up and configure CRM for Outlook from Office 365 

You can use Microsoft Dynamics CRM for Outlook together with Microsoft Dynamics CRM to 

access CRM data while you’re working within the familiar Outlook interface. Dynamics CRM for 

Outlook can also provide access to CRM data while you’re working offline. Learn more about 

doing your CRM work in Outlook. 

You can install Dynamics CRM for Outlook directly from the Office 365 dialog box, but before you 

install the add-in, review the following installation prerequisites and configuration instructions.  

Step 1: Review installation prerequisites 

 To install Dynamics CRM for Outlook, you must be able to log on to your computer as a 

user with Local Administrator privileges. 

 TechNet: Get information about software requirements 

 TechNet: Get information about hardware and network requirements 

 Install all the latest Microsoft Office updates, including all security updates, from Microsoft 

Update. Go to Microsoft Update. 

 To ensure that you stay up-to-date with future releases of Dynamics CRM for Outlook, it 

is highly recommended that you ensure that Windows Update is enabled on your 

computer. Learn how to turn on automatic updates. 

Step 2: Install and configure CRM for Outlook 

1. If you haven’t already done so, choose Install in the Office 365 dialog box to install 

Logging on as a Local Administrator 

Software requirements 

Hardware and network requirements 

Installing updates 

 

http://go.microsoft.com/fwlink/p/?LinkID=394774
http://go.microsoft.com/fwlink/p/?LinkID=394774
https://technet.microsoft.com/library/hh699818.aspx
https://technet.microsoft.com/library/hh699680.aspx
http://go.microsoft.com/fwlink/p/?LinkId=165705
http://go.microsoft.com/fwlink/p/?LinkID=518633
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Dynamics CRM for Outlook. 

2. When prompted, restart Outlook. This will automatically start the Configuration Wizard 

and you’ll see the following dialog box: 

 
 

Note  

If the Configuration Wizard doesn’t start automatically, in the Start screen, search 

for Configuration Wizard and run it.  

3. In the list, select CRM Online, and then choose Connect. 

Privacy notice 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 
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between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

TechNet: Software compatibility 

Do your CRM work in Outlook 

The Outlook email address should be the same as the CRM email address 

You’re seeing the following error message: 

“To track emails and perform synchronization, your Outlook email address should be the 

same as your email address in Microsoft Dynamics CRM.”  

This message is common when you have multiple Microsoft Office Outlook email addresses or 

have access to more than one CRM organization. For example, your company may use multiple 

CRM organizations for testing or upgrade purposes.  

You may also see this error message if you are configuring Microsoft Dynamics CRM for Outlook, 

but you don’t have an Outlook email address, or you haven’t set the primary email address field in 

CRM. 

To fix this, start by finding the primary Outlook email address: 

Find the primary Outlook email address 

1. In Outlook, choose File. 

2. Under Account Information, choose Account Settings, and then select Account Settings 

from the list. 

In the Account Settings dialog box, you’ll see a check mark next to the primary email 

address. Make a note of the exact address. 

  

You must use the exact email address that you see in the Account Settings dialog 

box. For example, the following email addresses are not equivalent: 

nanderson@contoso.com 

nancy.anderson@contoso.com 

Then, pick one of the following methods. 

Change the email address in CRM to match the Outlook address 

1. Follow the steps in View your user profile. 

Important  

Check your security role 

https://technet.microsoft.com/library/dn832152.aspx
http://go.microsoft.com/fwlink/p/?LinkID=394774
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2. Don’t have the correct permissions? Contact your system administrator. 

 

3. Go to Settings > Security. (How do I get there?) 

4. Choose Users. 

5. Under Enabled Users, choose a user. 

6. In the Primary Email field, enter the Outlook email address. Make sure you use the primary 

Outlook email address. Most people have just one Outlook email address. This should 

probably be a company email address and not a personal email address. 

7. Save the changes. 

Change the email address in Outlook to match the address in CRM 

1. In Outlook, choose the File menu. 

2. Under Account Information, choose Add Account, and then enter the account information. 

3. Restart Outlook. 

You’ll need to set the new email account to be the default account. 

1. In Outlook, choose the File menu. 

2. Under Account Information, choose Account Settings > Account Settings… 

3. Select the new account, and then choose Set as Default. 

4. Choose Close. 

Get started with CRM for Outlook 

 

Do your CRM work in Outlook 

Overview of tracking records in CRM for Outlook 

Customize the Reading Pane in CRM for Outlook 

Create a Microsoft Word mail-merge document with CRM for Outlook 

Do your CRM work in Outlook 

If you’re like many people, you use Microsoft Outlook as your communications, scheduling, and 

contact management hub for business. You can continue to use the familiar Outlook interface and 

integrate Microsoft Dynamics CRM at the same time by using Microsoft Dynamics CRM for 

Outlook, an Outlook client provided by Microsoft Dynamics CRM. 

On this page: 

What CRM for Outlook offers 

Explore CRM for Outlook 

What Outlook features are unavailable in CRM for Outlook? 

Privacy notices 

What CRM for Outlook offers 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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When you use Dynamics CRM for Outlook, you can access all the CRM core functionality directly 

from Outlook. Dynamics CRM for Outlook also provides extra functionality that isn’t available in 

the web client. For example, you can: 

 Track Outlook email, appointments, contacts, and tasks. When you track a record in 

Dynamics CRM for Outlook, a copy of that record is “pushed” to CRM and the two records 

are synchronized. After a record is tracked, you can update it in Dynamics CRM for Outlook 

or in CRM. Tracking provides a great way to keep your personal information separate from 

your business information, because only the information you manually track is pushed to 

CRM. Dynamics CRM for Outlook also automatically synchronizes records you own from 

CRM to Dynamics CRM for Outlook. More information: Overview of tracking records in CRM 

for Outlook  

 Apply CRM email templates, or attach sales literature and Knowledge Base articles from 

CRM when you are sending an Outlook email message to customers. 

 Take advantage of native Outlook functionality to customize views of CRM data. For 

example, you can sort, filter, format, group, and categorize views the same way you manage 

views in Outlook, and you can open multiple views at once. You can also add conditional 

formatting and set follow-ups. 

 Access your CRM data on the go by working in offline mode. Dynamics CRM for Outlook 

provides offline synchronization filters that you can modify before you go offline so you take 

just the data you need with you. When you’re offline, changes are stored to your local drive. 

When you go back online, Dynamics CRM for Outlook automatically synchronizes the data 

again with the CRM server. More information: Work offline with CRM for Outlook 

 Create Microsoft Word mail-merge documents to send form letters or form email messages to 

contacts, accounts, or marketing mailing lists. You can also use mail merge to create faxes 

and quotes. More information: Create a Microsoft Word mail-merge document with CRM for 

Outlook 

If people in your organization share the same computer by using different user accounts, 

each person can install and use Dynamics CRM for Outlook for their own account. 

Explore CRM for Outlook 

When you Install CRM for Outlook, the software adds several user interface elements to your 

Outlook screen. 

Navigation pane 

You’ll see a folder for your organization in the navigation pane on the left side of the screen. 

Under your organization name, you’ll see a list of CRM folders. Use these folders to navigate to 

your area and open different record types. 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=512584
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If you connect to more than one organization, you’ll see a separate folder for each organization in 

the navigation pane. 

Ribbon 

You access commands in Dynamics CRM for Outlook through the ribbon. The ribbon displays 

different buttons and features depending on context. For example, if you view a list of 

opportunities, the ribbon displays buttons that apply to opportunities. For appointments, contacts, 

and tasks, you’ll see a special CRM section on the ribbon. 

 
 

 

 

Lists, views, and the reading pane 

When you use the navigation pane to open a folder for a type of record (Accounts, for example), 

you’ll see a list of records. The list is determined by the view you’re in and any search criteria or 

filter you have applied.  

When you select a record in a list, the details for that record are displayed in the reading pane 

below the list. Data in the reading pane is read only—it’s a quick way to view the contents of a 

record. If you want to edit the data in CRM, just double-click the record in the list. 
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You can change the location of the reading pane or turn it off or on. You can also customize what 

you see in the reading pane. More information: Customize the Reading Pane in CRM for Outlook 

What Outlook features are unavailable in CRM for Outlook? 

Microsoft Dynamics CRM uses standard Internet Explorer controls, so some Outlook features are 

unavailable in Dynamics CRM for Outlook. Use the workarounds in the following table for features 

that aren’t available. 
 

Feature Workaround 

Email signatures Use a global email template or use native email 

signatures in Outlook. 

Full-text editing features Use standard editing controls. For example, 

press Enter for double-spaced lines and 

Shift+Enter for single-spaced lines.  

Attach files during creation Save an email activity before attaching files. 

Move records by dragging and dropping. There’s no workaround for dragging and 

dropping records. Dragging and dropping 

records causes data loss.  

Reminders After synchronization with Outlook, 15-minute 

reminders are created for appointments and 

service activities created in the Microsoft 
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Feature Workaround 

Dynamics CRM folders or in the web 

application. 

Microsoft Dynamics CRM Service calendar The CRM Service calendar isn’t available by 

default, but you can ask your system 

administrator to add it. 

 

 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Overview of tracking records in CRM for Outlook 
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Work offline with CRM for Outlook 

Create a Microsoft Word mail-merge document with CRM for Outlook 

Customize the Reading Pane in CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

TechNet: CRM for Outlook compatibility 

Overview of tracking records in CRM for Outlook 

 You can use Microsoft Dynamics CRM for Outlook to track email messages, contacts, tasks, and 

appointments. When you track an email message, contact, task, or appointment record, a copy of 

that record is saved as an activity in Microsoft Dynamics CRM and synchronized with the Outlook 

record. You can then view and edit that record in Dynamics CRM for Outlook or CRM. If you sync 

Outlook on your mobile device, you can also access these records on that device. 

Tracking records in CRM for Outlook is a manual process. This gives you the ability to keep your 

personal Outlook records separate from your CRM records.  

 If you want, you can set an option to track email automatically. More information: Set an 

option to automatically track incoming Outlook email in CRM for Outlook 

 If your organization synchronizes records through server-side synchronization, you can track 

email messages through folder tracking. Folder tracking is a powerful and intuitive way to 

track email directly from virtually any device. More information: Track Outlook email by 

moving it to a tracked Exchange folder.  

 

 

On this page: 

Using the Track button vs. the Set Regarding button 

Using the tracking pane 

What can you do after you track a record? 

Other things to know about tracking records 

Using the Track button vs. the Set Regarding button 

To track a record in Dynamics CRM for Outlook, you click or tap the Track button or the Set 

Regarding button for the record you want to track. 

 
 

You can use either button to track a record, but it’s almost always better to use the Set 

Regarding button. When you use the Set Regarding button, you can link an email message, 

appointment, or task to a specific CRM record such as an account or opportunity, or even a 

Tip  

https://technet.microsoft.com/library/dn832152.aspx
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custom record type (entity). Some organizations also use the Set Regarding button to track 

projects. 

Using the tracking pane 

When a record is tracked, a Microsoft Dynamics CRM pane (also known as the “tracking pane”) 

appears at the bottom of the record. This pane shows: 

 Whether the item is tracked 

 The regarding record, if set 

 The name of the parent account for contacts, if set 

 Links to CRM records for email recipients. This is very useful when you want to quickly 

access the CRM contact record of an email recipient or see other information stored in CRM. 

 Related records, along with a symbol that identifies the record type in CRM 

 Whether email addresses, names, or distribution lists in an email message are CRM records 

For example, the following screen shot shows the tracking pane for a tracked task linked to the 

Adventure Works account: 

 
 

You can open the regarding record, parent record for a contact, or related records directly from 

the tracking pane. The tracking pane also includes an Options button that provides quick access 

to personal tracking options. 

If you track an email message without first expanding a distribution list, the tracking pane 

displays the name of the distribution list. To track the individual email addresses, expand 

the distribution list before you track the message. 

What can you do after you track a record? 

After you track a record, you can use the buttons on the Dynamics CRM for Outlook ribbon to do 

the following tasks. 
 

To do this task Choose Applies to 

Open the record directly in 

CRM 

 Email, appointments, 

contacts, and tasks 

Add a connection between 

the record and any CRM 

record capable of tracking 

connections  

 Email, appointments, 

contacts, and tasks 

Convert the record into a  Email, appointments, and 

Note  
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CRM opportunity, lead, or 

case 

tasks 

Insert a CRM template  Email 

Insert a CRM Knowledge 

base article 

 Email 

Attach CRM sales literature  Email 

 

If these buttons aren’t available, it may be that the record marked to be tracked isn’t 

synchronized yet. This can happen if your organization uses server-side synchronization 

to synchronize email, appointments, contacts, and tasks, but the synchronization hasn’t 

happened yet. If the View in CRM button is enabled, the record has been synchronized. 

You can also use the tracking pane (as described previously) to determine whether the 

record has been synchronized.  

Other things to know about tracking records 

 Using multiple computers. You can use multiple computers to track items using Dynamics 

CRM for Outlook. For example, you might use a desktop computer and a laptop. Only one 

computer can be the synchronizing computer, however. Changes or updates to synchronized 

records will not show up in CRM if the synchronizing computer is not connected to the CRM 

server. More information: Set personal options that affect tracking and synchronization 

between CRM and Outlook or Exchange 

 Choosing data to store locally. The CRM data stored on your local computer is determined 

by online synchronization filters. You can edit, deactivate, or delete these filters. More 

information: Choose the records to synchronize between CRM and Outlook or Exchange 

 Deleting tracked records. When records are tracked, special rules apply when deleting 

records. More information: Deleting records that have been tracked with CRM for Outlook 

 Delegating access. If you’ve delegated access to your Outlook account, the delegate can 

track items on your behalf. These items won’t synchronize with CRM until you connect to the 

CRM server. More information: Allow someone else to manage your mail and calendar  

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

Tip  

http://go.microsoft.com/fwlink/p/?LinkId=201849
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 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Track Outlook email by moving it to a tracked Exchange folder 

Track Outlook email by choosing a button in CRM for Outlook 

Track Outlook appointments in CRM for Outlook 

Track Outlook contacts in CRM for Outlook 

Track Outlook tasks in CRM for Outlook 

Deleting records that have been tracked with CRM for Outlook 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Synchronizing data with Outlook or Exchange FAQ 

Customize the Reading Pane in CRM for Outlook 

When you use Microsoft Dynamics CRM for Outlook, you can choose the sections in Microsoft 

Dynamics CRM records that are displayed in the Reading Pane so that you don't have to open 

the record to see the details. 

1. In the Dynamics CRM for Outlook Navigation Pane, click your organization.  

2. Click the area that contains the records you want to work with (for example, Service), and 

then click the record type. 
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3. Click the View tab, and then in the List group, click Customize Reading Pane. 

By default, all the sections that you can add or remove are listed in the Displayed 

Sections box. 

4. To remove a section, in the Displayed Sections box, click the section, and then click 

Remove. 

5. To add a section, in the Available Sections box, click the section, and then click Add. 

6. To change the order of the sections in the Reading Pane, in the Displayed Sections 

box, click the section, and then click the Move Up or Move Down button.  

7. Click OK. 

See Also 

Do your CRM work in Outlook 

Overview of tracking records in CRM for Outlook 

eBook: CRM for Outlook Basics 

Create a Microsoft Word mail-merge document with CRM for Outlook 

You can use Microsoft Dynamics CRM for Outlook with Microsoft Office Word to create 

documents for your customers that display Microsoft Dynamics CRM data. 

With mail merge, you can: 

 Create new templates or use an existing template to generate form letters for yourself or, with 

the appropriate permissions, for the whole organization. 

 Send form letters or form email messages to contacts, accounts, or marketing mailing lists. 

 Resend old letters to new recipients. 

 Create faxes. 

 Create quotes. 

In Dynamics CRM for Outlook, only one mail merge can be run at a time. If you receive the 

message "Microsoft Dynamics CRM Mail Merge is already running" and want to discontinue a 

mail merge, close and then reopen Microsoft Office Word or Internet Explorer. 

To use mail merge, your email format must be HTML. 

Record types that use mail merge: 

 Account 

 Campaign 

To use mail merge with a campaign, you must first distribute a mail campaign activity to a 

selected marketing list. 

 Contact 

 Lead 

 Opportunity 

 List Member in Marketing List 

 Quick Campaign 

http://go.microsoft.com/fwlink/p/?LinkID=524512
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In Dynamics CRM for Outlook, you can create a mail merge, and then at the end of the 

process, create a quick campaign. 

 Quote 

With mail merge, you can print only one quote at a time. 

1. In Dynamics CRM for Outlook, open the list of records you want. 

Tip  

This list can be the results of an Create, edit, or save an Advanced Find search. 

2. In the list, select the record you want to add to the mail-merge recipient list. 

3. On the Add tab, in the Marketing group, click or tap Mail Merge. 

4. If you have other languages installed, you can select a language to filter the list of 

templates.  

In the Mail Merge dialog box, select the type of document you want to use. 

5. Choose whether you want to start with a blank document or a template. If you select a 

template option, click or tap the Lookup button  to select a template. 

New mail merge templates are created in the Settings area. More information: Work with 

mail merge templates  

6. If necessary, you can add or delete data fields. 

Microsoft Office Word supports up to 62 data fields, of which  Dynamics CRM for Outlook 

reserves two data fields to store the primary key and the record owner. 

7. Click or tap Download. 

Microsoft Dynamics CRM automatically opens a  Word document. You may need to 

select Microsoft Office Word in the task bar. 

This is not your mail-merge document. This is an interim page.  

8. In the Mail Merge Recipient dialog box, verify that the list is accurate, and then click or 

tap OK.  

9. To continue the mail merge, follow the instructions provided by the Mail Merge pane. For 

more information, see the Microsoft Office Word Help documentation for mail merge. 

Tip  

 To display the information you want and select the format, in the Mail Merge wizard, 

click or tap Address Block and then Greeting Line. 

 To add data fields to display more information, click or tap More Items. You can use 

up to 62 data fields. 

10. If you have either created a new template or updated an existing template, you can 

upload the template. 

 To save the document as a template, on the Complete the merge pane, click or tap 

Upload Template to CRM. 

11. If you have saved the document as a template, you can go back and edit the template 

Create a mail merge document 
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with Settings > Business > Templates. Click or tap your template to review and edit it. 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Work with templates 

Send bulk email to customers 

Track email, appointments, contacts, and tasks 

 

Track Outlook email by moving it to a tracked Exchange folder 

Track Outlook email by choosing a button in CRM for Outlook 
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Set an option to automatically track incoming Outlook email in CRM for Outlook 

Track Outlook contacts in CRM for Outlook 

Use a wizard to add and track multiple Outlook contacts in CRM for Outlook 

Track Outlook tasks in CRM for Outlook 

Track Outlook appointments in CRM for Outlook 

Deleting records that have been tracked with CRM for Outlook 

Track Outlook email by moving it to a tracked Exchange folder 

horizontaltabbed 

How to 

Track customer interactions wherever you are, and from virtually any device by using folder 

tracking. After you set up a tracked folder, you can drag or move email to that folder to track it 

automatically in Microsoft Dynamics CRM. Additionally, if you set a regarding record (such as a 

specific account or opportunity record) for the folder, CRM automatically links all email in that 

folder to that specific record. Tracked folders work in Dynamics CRM for Outlook, Exchange 

Online, Outlook on the web, or any other mobile app that supports Exchange. 

 

 

 
 

 

 

Tracked folders work with Exchange Inbox rules. This makes it easy to automatically 

route email messages to a particular folder. For example, set up an Exchange rule that 

automatically routes email from a Contoso contact to a tracked Contoso folder, which is 

linked to a specific Contoso opportunity. Tell me more about setting up rules. 

Tip  

http://go.microsoft.com/fwlink/p/?LinkID=528086
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On this page: 

Requirements for using tracked folders 

Set up a tracked folder 

Best practices for folder tracking 

What happens when you untrack, move, delete, or rename folders, or change the regarding 

record? 

Requirements for using tracked folders 

 This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-premises).  

 

 Interested in getting this feature? Find your CRM administrator or support person 

 The tracking folders feature must also be enabled by your administrator. For more 

information, contact your CRM administrator. For admin information on enabling tracked 

folders, see TechNet: Configure folder-level tracking. 

 Your organization must use server-side synchronization as your email synchronization 

method. If you don’t know which synchronization method your organization uses, contact 

your CRM administrator. For admin information about setting up server-side synchronization, 

see TechNet: Set up server-side synchronization. 

Set up a tracked folder 

1. Go to Options: 

 In the web app: On the nav bar, click Options . 

 In Dynamics CRM for Outlook: Click File > CRM > Options. 

2. In the Set Personal Options dialog box, click the Email tab, and then under Select the 

email messages to track in Microsoft Dynamics CRM, click Configure Folder 

Tracking Rules. 

3. In the Folder-Level Tracking dialog box, under Exchange Folder, click + New Folder 

Mapping, click the down arrow in the box that appears, and then select the folder you 

want to track. 

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/dn946907.aspx
https://technet.microsoft.com/library/dn531109.aspx
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Note  

You can only track folders or subfolders inside your Exchange Inbox. Only the 

folder you select will be tracked. For example, if you select a folder that includes 

subfolders, the subfolders aren’t tracked unless you specifically select them in 

this dialog box. The maximum number of folders you can track is 25. 

4. If you want to link the folder to a specific record—for example, an account or opportunity—

under Regarding Record in CRM, click the Lookup button , and then search for the 

record. 

5. Repeat steps 3 and 4 for any additional folders you want to track and (optionally) link to 

regarding records. 

6. When you’re done adding and linking folders, click Save. 

Best practices for folder tracking 

 Make sure to take advantage of folder tracking on your mobile devices. If your device 

supports Exchange email, folder tracking will work automatically. You don’t need to install 

anything. Just drag or move email to a tracked folder to automatically track that email in 

CRM. 

 Whether you set a regarding record for a folder or not depends on how you plan to use the 

folder: 

 If you receive a small volume of email from many different customers, you may want to 

create a single folder called “Track in CRM” (or similar name) that isn’t linked to a 
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particular record. That way, you can drag messages to that folder to track them 

automatically. If you later want to link an email message in that folder to a specific CRM 

record, open that activity record in CRM, and then fill in the Regarding field. 

 If you receive large volumes of email from a particular customer, create a folder (or use 

an existing folder) just for that customer and link it to a specific record. For example, 

create a Contoso folder and set the regarding record to a Contoso account record or 

opportunity record. 

 You can set up multiple folders that link to the same regarding record. For example, you 

could link a Contoso Sales Proposal folder and a Contoso Legal Matters folder to the same 

Contoso account record. 

 It’s best not to use the same folder for different records over a period of time. For example, 

let’s say you’re tracking email communications for an opportunity with Customer 1, but you’ve 

won the opportunity, and now you don’t need to track further communications with that 

customer. You may be tempted to simply change the regarding record for that folder to a new 

customer (Customer 2) you’re working with. If you do that, however, all email in that folder, 

including the email pertaining to Customer 1, will be associated with Customer 2. So it’s best 

in this case to create a new folder associated with Customer 2, and then set the regarding 

record for that new folder to Customer 2. Then you can delete the regarding record for the 

Customer 1 folder.  

 You can include an untracked folder inside a tracked folder. For example, let’s say you want 

to store personal email from a Contoso contact. You can create a Personal subfolder under 

the Contoso folder and leave it untracked. 

 If you no longer need to track a folder, it’s a good idea to untrack it for performance reasons. 

To untrack a folder, remove it from the Folder-Level Tracking dialog box. 

What happens when you untrack, move, delete, or rename folders, or change the 

regarding record? 

The following table shows what happens when untrack, move, or delete folders, or change the 

regarding record linked to a tracked folder. 
 

Action Result 

Untrack a folder by deleting it from the Folder-

Level Tracking dialog box 

All email messages previously included in that 

folder will still be tracked, and the regarding 

record will still be linked to those email 

messages. New email messages you add to 

that folder won’t be tracked.  

Delete a folder from Outlook or Exchange All email messages included in that folder will 

be deleted from Outlook or Exchange Online. 

Email messages already tracked through that 

folder will not be deleted from Microsoft 

Dynamics CRM, however. 

Move a folder in Outlook or Exchange The folder and all its contents will continue to 

be tracked. If you move a folder outside your 
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Inbox, folder-level tracking rules will be 

disabled. 

Rename a folder in Outlook or Exchange The folder and all its contents will continue to 

be tracked. 

Tip  

When you rename folders, the software 

uses the Exchange folder ID for 

tracking purposes – it’s not dependent 

on the actual name of the folder. This is 

important to know if you delete a folder, 

and then rename a new folder with the 

same name as the deleted folder. For 

example, let’s say you delete Folder 1, 

create Folder 2, and then rename 

Folder 2 to be Folder 1. The tracking 

information for the original Folder 1 

won’t be retained in this case. 

Remove the link between a tracked folder and 

a specific record by deleting the link in the 

Folder-Level Tracking dialog box 

All messages in that folder that were previously 

linked will continue to be linked. New messages 

added to that folder won’t be linked. 

Move an email message in a tracked folder 

that’s linked to a specific record to a different 

folder 

If the new folder doesn’t have a regarding 

record, the email message will continue to be 

linked to the original record. If the new folder 

has a regarding record, the email message will 

be linked to that regarding record. 

Manually change the regarding record for an 

email message that’s linked to a different 

regarding record through a tracked folder 

The tracked folder rule takes precedence. 

When the folder is synchronized, the email 

message will be re-linked to the record 

specified in the folder tracking rule, even if you 

change the regarding record manually. To 

change the regarding record in this case, do 

one of the following: 

 Move the message to a tracked folder 

linked to the record you want. 

 Remove the  link to the regarding record  in 

the Folder-Level Tracking dialog box 

before you manually change the regarding 

record. 

 Move the specific email message outside 

the tracked folder, and then manually 
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change the regarding record for that email 

message. 

Two users move the same email message to 

separate folders that have different regarding 

records 

You can only set one regarding record for an 

email message. In this case, the record that’s 

processed first is linked to the regarding record. 

 

Watch this video 

 

Want to see folder tracking in action? This demo puts it all together for you. 

<iframe width="500" height="364" src="https://www.youtube.com/embed/HiNpINvFKq8" 

frameborder="0" allowfullscreen></iframe> 

To see video captions, click the Closed Caption (CC) button  in the lower-right corner of the 

YouTube window. 

 

 

 

 

 

Video transcript 

A big part of working in Microsoft Dynamics CRM is creating and recording different types of 

activities that revolve around a sales or service process, such as sending emails, creating 

opportunities, and assigning tasks. If you want to associate an activity with a more specific record 

and opportunity for example, you can set the regarding record for that activity.  

By using folder-level tracking, you can easily track and set the regarding record for an email by 

dragging or moving it into an Exchange folder.  

Let's take a look at a scenario with folder-level tracking.  

Nancy, a dedicated sales rep, finds and qualifies leads. Nancy has just started to work on a new 

opportunity called Northwind Traders. She wants to track and associate all the emails that relate 

to this opportunity.  

First, Nancy needs to create a folder in Exchange. She already has folders for her current 

accounts and opportunities, so she simply creates a new folder under the Opportunities folder. 

Then she needs to map the Exchange folder she has just created to CRM.  

Nancy clicks Options, and clicks the Email tab. She clicks Configure and creates a new 

mapping between the Exchange folder and the requested CRM record ‒ Northwind Traders in our 

example. Now, whenever Nancy gets an email that relates to Northwind Traders, she can simply 

drag and drop the email into the folder she created.  

The new email will be associated to the Northwind Traders opportunity within CRM. Also, Nancy 

can track emails while she's on the go by using her mobile device. She can simply move the 

email to the Northwind Traders folder using her native email application.  
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Finally, since Morgan is the main contact person in Northwind Traders, all the emails from him 

relate to this opportunity. Instead of manually copying the emails from Morgan, Nancy can create 

an Exchange rule that will automatically copy all the emails that Morgan sends to the Northwind 

Traders' folder.  

By doing so, the emails will be automatically tracked in CRM and will be associated to the 

Northwind Traders opportunity.  

Folder-level tracking allows you to easily track and associate emails to CRM, manually from any 

device, or automatically by setting Exchange rules. 

See Also 

Track Outlook email by choosing a button in CRM for Outlook 

Overview of tracking records in CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

TechNet: Set up and manage email processing 

TechNet: Configure folder-level tracking 

Track Outlook email by choosing a button in CRM for Outlook 

To get the most out of Microsoft Dynamics CRM, it’s important to keep track of all your customer 

interactions, and email communications are key. Create a central repository of your Outlook email 

communications by “tracking” them in Microsoft Dynamics CRM for Outlook. When you track an 

email message in Dynamics CRM for Outlook, the email is saved as an activity record in CRM. 

Then you, or anyone who has access to your activity records, can view that email message along 

with all other customer activities in CRM, Dynamics CRM for Outlook, or on a mobile device.  

 
 

 

 

Tracking email in Dynamics CRM for Outlook is a manual process. This gives you the ability to 

keep your personal email separate from your customer email. You can also set an option to 

automatically track email messages. More information: Set an option to automatically track 

incoming Outlook email in CRM for Outlook 

Tip  

https://technet.microsoft.com/library/dn832099.aspx
https://technet.microsoft.com/library/dn946907.aspx
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If your organization synchronizes email through server-side synchronization, you can 

track email automatically by dragging it to a tracked folder. Folder-level tracking is a 

powerful and intuitive way to track email messages directly from virtually any device. 

More information: Track Outlook email by moving it to a tracked Exchange folder 

On this page: 

Requirements for tracking email messages 

Which records are associated with the email activity? 

Track an email message 

What else to I need to know about tracking email records? 

Requirements for tracking email messages 

To track email in Dynamics CRM for Outlook, your Outlook email address must match your CRM 

email address. You can’t synchronize to or from multiple email addresses. 

Which records are associated with the email activity? 

By default, when you track an email message, Dynamics CRM for Outlook uses the CRM 

address book to link the message to CRM contacts on the To, From, and Bcc lines. You can also 

link the email message to a more specific record, such as a specific account, opportunity, or 

case. It’s usually best to link a message to a more specific record, if possible. This will make the 

record easier to find. 

Track an email message 

1. In Dynamics CRM for Outlook, select the email message you want to track. 

2. Do one of the following: 

 To track the email message without linking it to a particular record in CRM, on the 

Home tab, in the CRM group, click Track. 

-Or- 

 To track the email message and link it to a particular record in CRM, on the Home 

tab, in the CRM group, click Set Regarding, click More, and then search for the 

record in the Look Up Record dialog box. After you find the record you want, click 

Add. 

When you click the Track button or the Set Regarding button, a Microsoft Dynamics 

CRM pane (also known as the “tracking pane”) appears at the bottom of the email record. 

This pane shows that the record is tracked and provides links to related records. If you 

set a “regarding” record, the tracking pane also provides a link to that record. More 

information: Overview of tracking records in CRM for Outlook 

You can also tell that a record is tracked by looking in the Outlook folder. You’ll see the 

Tracked in CRM symbol  next to any tracked records. 

3. To modify the CRM activity record (for example, to change the regarding record), open 

the email message in Outlook, and then, in the CRM group, click View in CRM. 
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What else to I need to know about tracking email records? 

 CRM address book. The address book is installed automatically when Dynamics CRM for 

Outlook is installed. This makes it possible to search for a CRM contact from the To field of 

an email message or appointment when you create it. By default, Dynamics CRM for Outlook 

only searches for contacts you own. You can set a personal option to broaden this search. 

More information: Set address book options in CRM for Outlook 

 Working offline. Email messages you track when you’re offline are saved as activities when 

you go back online. More information: Work offline with CRM for Outlook 

 Replies to tracked messages. You can set whether replies to tracked messages are also 

tracked. More information:  Set personal options that affect tracking and synchronization 

between CRM and Outlook or Exchange 

 Editing tracked email messages. After an email message has been sent, you can’t edit it, 

but you can set or change a regarding record for it. 

 Attachments. Any tracked email message can be accessed by anyone who has permission 

to view your activities. If the email has attachments, the attachments are included in the 

activity. If you don’t want to make an attachment available, delete it from the email activity. 

Your administrator can block messages from being saved if they contain attachments of 

specific file types, such as .exe files. Any messages stored in locations other than the default 

Microsoft Exchange location can’t be linked.  

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 
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between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Track Outlook email by moving it to a tracked Exchange folder 

Overview of tracking records in CRM for Outlook 

Deleting records that have been tracked with CRM for Outlook 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Create templates for email 

Synchronizing data with Outlook or Exchange FAQ 

Set an option to automatically track incoming Outlook email in CRM for Outlook 

When you use Microsoft Dynamics CRM for Outlook to track an email message, a copy of the 

email record is saved as an activity in Microsoft Dynamics CRM and synchronized with the 

Outlook record. More information: Overview of tracking records in CRM for Outlook 

By default, tracking email is a manual process—you have to choose the Track button or the Set 

Regarding button for each email message you want to track. Manual tracking provides a way for 

you to keep your personal email separate from your customer email. As an alternative, you can 

set an option to track email messages automatically.  

You can use Exchange folder tracking as an alternate method for tracking messages 

automatically. With folder tracking, you can track messages directly from virtually any 

device. More information: Track Outlook email by moving it to a tracked Exchange folder 

Automatically track email messages 

1. In Dynamics CRM for Outlook, on the File tab, choose CRM, and then choose Options. 

2. In the Set Personal Options dialog box, on the Email tab, in the Select how Dynamics 

CRM for Outlook should integrate email with Microsoft Dynamics CRM section, 

select the Check incoming email in Outlook and determine whether an email should 

be linked and saved as a Microsoft Dynamics CRM record option. 

 

3. To specify whether to track all email messages or only certain types, in the Select the 

email messages to track in Microsoft Dynamics CRM section, in the Track list, select 

one of the following options: 

Tip  
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 All email messages. Tracks all email messages (sent and received) related to CRM 

email messages. If you select this option, CRM will track junk mail as well as 

business conversations, so choose this option carefully. 

 Email messages in response to CRM email. Only replies to or forwards of email 

messages that have already been tracked will be saved as email activities. This is the 

most common option. 

 Email messages from CRM Leads, Contacts, and Accounts. Tracks email 

messages only if they originate from someone with a Microsoft Dynamics CRM lead, 

contact, or account record.  

 Email messages from Microsoft Dynamics CRM records that are email enabled. 

Tracks email messages from all record types (including custom record types) that 

contain an email address field. 

Note  

Keep in mind that the more you use the same email address for tracking 

purposes, the less useful it becomes since it will be mapped to many records. 

4. If you want to automatically create contract or lead records for tracked email messages, 

in the Automatically create records in Microsoft Dynamics CRM section, choose the 

Create check box, and then choose Contacts or Leads from the list. When this check 

box is selected, Dynamics CRM for Outlook will try to match the email address of 

recipients to an email address in CRM. If it can’t find a matching record, it will 

automatically create a contact or lead record.  

Note  

Contact and lead records won’t be created if you don’t have the appropriate 

security permissions. More information: TechNet: How security affects 

synchronization between CRM and Outlook 

 

More than one custom record type can contain the same email address. When this 

happens, Microsoft Dynamics CRM links the email messages received from this email 

address to the custom record type created first. For example, let’s say a Patient record 

type created in January lists the email address someone@example.com. A Doctor record 

type created in February lists the same email address. Microsoft Dynamics CRM links the 

email messages received from someone@example.com to the Patient record type only. 

Sending an email message to someone@example.com links the email message to the 

Patient record type and the Doctor record type, however. 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

Note  

https://technet.microsoft.com/library/dn832097.aspx
https://technet.microsoft.com/library/dn832097.aspx
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 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Track Outlook email by moving it to a tracked Exchange folder 

Track Outlook email by choosing a button in CRM for Outlook 

Overview of tracking records in CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

Track Outlook contacts in CRM for Outlook 

When you track a contact in Microsoft Dynamics CRM for Outlook, a copy of that contact record 

is saved in Microsoft Dynamics CRM and synchronized with the Outlook record. After your 

contacts are tracked, you’ll be able to see any email, tasks, appointments, and account records 

associated with those contacts. You can access the records in Dynamics CRM for Outlook or 

CRM.  

Tracking contacts in Dynamics CRM for Outlook is a manual process. This gives you the ability to 

keep your personal contacts separate from your CRM contacts. Synchronization of contacts from 

CRM to Dynamics CRM for Outlook is automatic, however. Any contacts that you own in CRM 

will automatically be available in Dynamics CRM for Outlook. If you sync Outlook on your mobile 

device, you can also access your CRM contact records on that device. 
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1. In Dynamics CRM for Outlook, choose People in the navigation pane, and then select up 

to 20 contacts. 

Tip  

If you want to select more than 20 contacts, or if you want to track all your 

Outlook contacts in CRM, you can use the Add Contacts wizard. More 

information: Use a wizard to add and track multiple Outlook contacts in CRM for 

Outlook 

2. To track the contact, do one of the following: 

 To track the contact record without linking it to a parent (account) record in CRM, on 

the Home tab, in the CRM group, choose Track. 

-Or- 

 To track the contact and link it to a parent (account) record in CRM, on the Home 

tab, in the CRM group, choose Set Parent, and then search for the parent record in 

the Look Up Record dialog box. After you find the record you want, choose Add. 

When you choose the Track button or the Set Parent button, a Microsoft Dynamics 

CRM pane (also known as the “tracking pane”) appears at the bottom of the contact 

record. This pane shows that the contact is tracked and provides links to related 

records. If you choose the Set Parent button, Dynamics CRM for Outlook also 

provides a link to the parent record. Tell me more about how tracking works 

In Dynamics CRM for Outlook, the Tracked in CRM icon  is displayed next to any tracked 

contacts. 

3. To add additional information about the contact to the Contact form in Microsoft 

Dynamics CRM, choose the contact, and then in the CRM group, choose View in CRM. 

Notes 

 To add additional information about the contact to the Contact form in Microsoft Dynamics 

CRM, choose the contact, and then in the CRM group, choose View in CRM. 

 If the contact is linked to a parent record, you can open the parent record from the Outlook 

contact record in Dynamics CRM for Outlook. In the contacts list,  open the record. In the 

CRM group, choose View Parent (or select the link in the tracking pane). 

 The Company field for an Outlook contact is not automatically added to the parent account of 

the new Microsoft Dynamics CRM contact. More information:. Set personal options that affect 

tracking and synchronization between CRM and Outlook or Exchange 

Avoiding duplicate contact records 

When you track contacts, CRM checks for duplicate records. CRM also checks for duplicates 

when you synchronize records manually or go online if you’re been working offline.  

If CRM detects that a contact might be a potential duplicate, instead of saving the contact, CRM 

displays the Duplicates Detected dialog box. 

 

http://go.microsoft.com/fwlink/p/?LinkID=510100
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Here’s what you need to do if this happens: 

1. In the Potential duplicate records list, double-click or tap the record. 

2. If your new or updated record is not a duplicate, to create the new record, choose Save 

Record.  

 

- OR - 

 

If your new or updated record is a duplicate, to cancel your changes, choose Cancel. 

3. If the duplicate-detection rule identified potential duplicate records in other record types, 

review records from each record type listed. 

Duplicate detection can take place only if duplicate detection is enabled and if at least 

one duplicate-detection rule exists for the record type.  

Privacy notices  

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

Important  
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 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Overview of tracking records in CRM for Outlook 

Deleting records that have been tracked with CRM for Outlook 

Use a wizard to add and track multiple Outlook contacts in CRM for Outlook 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Synchronizing data with Outlook or Exchange FAQ 

Use a wizard to add and track multiple Outlook contacts in CRM for Outlook 

You can track your Microsoft Office Outlook contacts in Microsoft Dynamics CRM for Outlook. 

When you track a contact, a copy of that contact’s record is saved in Dynamics CRM for Outlook 

and synchronized with the Outlook record. After your contacts are tracked, you’ll see any CRM 

email, task, or appointment activities associated with those contacts. If you sync Outlook on your 

mobile device, you can also access your contact records on that device. 

Tracking contacts in Dynamics CRM for Outlook is a manual process. You can track up to 20 

contacts at one time by choosing the Track button or the Set Parent button in Dynamics CRM for 

Outlook. If you want to add more than 20 contacts at one time, or if you want to add all your 

Outlook contacts to CRM, you can use the Add Contacts wizard. The wizard can also help you 

set a number of options. For example, you can specify if future communications with the tracked 

contacts should be synchronized with Dynamics CRM for Outlook. 

To track contacts in Dynamics CRM for Outlook, your Outlook email address must match 

your CRM email address. You can’t synchronize to or from multiple email addresses. 

Step 1: Get ready 

Before you add your Outlook contacts: 

 For best results, make sure your Outlook contact data is as complete and accurate as 

possible. Fill in any missing info and verify that people’s names are spelled correctly. 

 Because you will have the opportunity to “map” the company names in your Outlook contact 

list to an account name in Microsoft Dynamics CRM, make sure the accounts have the same 

spelling in both applications. 

Step 2: Run the wizard 

1. Choose File > CRM > Import Contacts > Add Contacts.  

 

2. Choose Next. 

3. Confirm the folder where your Outlook contacts are stored, and then choose Next. 

Important  
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Note  

 The wizard determines the folder, usually called Contacts. You can select or clear 

subfolders in the Contacts folder. 

 If you allow someone else to manage your email (called a “delegate”), you can’t add 

contacts from that person’s contacts folder. 

4. Select how to group your contacts. The groups are: 

 Company Name. Group the contacts by the matching account name in Microsoft 

Dynamics CRM. The wizard lists the number of contacts associated with each 

account. Choose the link to verify the list of names for each account. 

 Email Domain. Group the contacts by email domain. The email domain is the part of 

the address after the @ symbol. For example, in the email address 

someone@contoso.com, "contoso.com" is the domain. Choose the link to verify the 

list of names in each domain. 

 Categories. Group the contacts by the category you use to organize contacts in 

Outlook, if applicable. Choose the link to verify the list of names for each category. 

 

If you don’t want to add all the groups, clear the check boxes to the left of any groups you 

don’t want. 

Note  

The Number of Contacts column displays a color to indicate how many of the 

contacts are already linked to Microsoft Dynamics CRM:  

Green. All of the contacts are already in Microsoft Dynamics CRM.  

Yellow. More than 50% of the contacts are already in Microsoft Dynamics CRM.  

Red. At least one contact is already in Microsoft Dynamics CRM. 

Tip  

You may find that the groupings have many variations if the company names 

don’t match exactly. If so, it may be best to cancel the wizard, correct the 

company names in Outlook, and then run the wizard again. 

5. Verify that Use Company Name to be the Account is selected (recommended). 

Otherwise, if you want to associate an account name with each contact later in Microsoft 

Dynamics CRM, clear this check box. 

6. Select Track all communications for added contacts to track the messages, 

appointments, and tasks associated with these Outlook contacts in Microsoft Dynamics 

CRM.  

 

7. To manually select the accounts to associate the contacts with, choose Advanced. In the 

Set Account column, choose the row for the contact. From the drop-down list, select one 

of the following: 

 Leave the field blank (Not Set) to associate the contacts with an account later in 

Microsoft Dynamics CRM. 
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 Select Use Company Name to associate the contacts with a Microsoft Dynamics 

CRM account using the company name.  

 Select Pick Existing Account, select an account or contact, and then choose OK. 

 

8. In the Include Communication column, clear the check box for any grouping for which 

you don’t want to track email messages, appointments, or tasks in Microsoft Dynamics 

CRM. 

9. Choose Add Contacts. 

10. Review the Summary page and view any errors, if applicable. Then choose Close. 

 

See Also 

Track Outlook contacts in CRM for Outlook 

Overview of tracking records in CRM for Outlook 

Deleting records that have been tracked with CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

Track Outlook tasks in CRM for Outlook 

When you track a task in Microsoft Dynamics CRM for Outlook, a copy of the task record is saved 

as an activity in Microsoft Dynamics CRM and synchronized with the Outlook record. You can 

then work on the task in Dynamics CRM for Outlook or CRM. If you sync Outlook on your mobile 

device, you can also access your task records on that device. 

Tracking tasks in Dynamics CRM for Outlook is a manual process. This gives you the ability to 

keep your personal tasks separate from your CRM tasks. Synchronization of tasks from CRM to 

Dynamics CRM for Outlook is automatic, however. You can use Dynamics CRM for Outlook to 

view any task records you own that were created in CRM. 

To synchronize tasks between Dynamics CRM for Outlook and CRM, your Outlook email 

address must match your CRM email address. You can’t synchronize to or from multiple 

email addresses. 

Track a task 

1. In Dynamics CRM for Outlook, create a task or open an existing task. 

 To create a task, click Tasks on the navigation bar, and then click New Task. 

 To open an existing task, click Tasks on the navigation bar, and then double-click the 

task to open it. 

2. In the Task dialog box, if it’s a new task, enter a subject in the Subject box. If it’s an 

existing task, the Subject box will already be filled out. 

Important  
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3. If you haven’t already done so, fill out other fields such as Start date, Due date, and 

Priority.  

Note  

When a task is created in Outlook, the system assigns the task a reminder time. 

Reminder information is not synchronized from Outlook to CRM. However, when 

a task has a Due date time set in CRM, it will be synchronized to reminder time 

in Outlook. 

If there is a Start date value but no Due date value in Outlook, the Due date 

value will automatically be set to the Start date value whenever you change the 

start date directly in Outlook. Likewise, if there is a Start date value but no Due 

date value in CRM, the Due date value will automatically be set to the Start date 

value. These changes are controlled by Outlook or CRM independently. They 

don’t have anything to do with synchronization or synchronization direction.  

4. If you want to make it a recurring task, click Recurrence, and then specify how often you 

want the task to occur. 

5. To track the task, do one of the following: 

 To track the task record without linking it to a particular record in Dynamics CRM, on 

the Task tab, in the CRM group, click Track. 

Note  

To track the task record as a phone call, letter, or FAX, click the down arrow 

on the Track button, and then select the appropriate item. It will then show 

up as a phone call, letter, or FAX on your Activities list. 

-Or- 

 To track the task and link it to a particular CRM record (for example, a specific 

opportunity or case), on the Task tab, in the CRM group, click Set Regarding, click 

More, and then search for the record in the Look Up Record dialog box. After you 

find the record you want, click Add. 

When you click the Track button or the Set Regarding button, a Microsoft Dynamics 

CRM pane (also known as the “tracking pane”) appears at the bottom of the task 

record. This pane shows that the record is tracked and provides links to related 

records. If you set a Regarding value, Dynamics CRM for Outlook also provides a link 

to the Regarding record. Tell me more about how tracking works. 

http://go.microsoft.com/fwlink/p/?LinkID=510100
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6. To save the task, click the down arrow on the Actions button, and then click Save & 

Close. 

Dynamics CRM for Outlook adds the People symbol  to the task to show that it’s tracked. 

Note  

If you want to stop tracking a task, open the task record, and then on the Task 

tab, in the CRM group, click Untrack. It’s best to untrack items one at a time. 

Assigning tasks 

If you’re using Microsoft Dynamics CRM 2015 for Outlook or later, you can also track assigned 

tasks if your administrator has enabled this capability. Learn more about enabling tracking of 

assigned tasks 

To track a task, you must be the owner of the task. You own a task that you create until you 

assign it to someone else. After you assign the task, the person you assign it to owns the task. 

When a task is tracked, the task owner can work on the task in Dynamics CRM for Outlook or 

CRM. The person who assigns the task can follow the progress of the task in either tool. 

When a task owner updates a task, all copies of the task are updated, including copies owned by 

prior owners. When a task owner completes a task, a status report is automatically sent to the 

person who originally assigned the task, all other prior owners, and anyone else who requests a 

report. 

The following limitations apply when tracking assigned tasks: 

 You can’t assign a task to someone in another organization. 

 You can’t track an assigned task if you go offline with Dynamics CRM for Outlook. 

 You can’t track recurring tasks. 

1. Create a task or open an existing task as described in the previous procedure. 

2. On the Task tab, in the Manage Task group, click Assign Task. 

 
 

3. In the Task dialog box, in the To box, enter the name or email address of the person you 

want to assign the task to. To select from a list, click the To button. 

Note  

Assign a task 

http://go.microsoft.com/fwlink/p/?LinkID=512487
http://go.microsoft.com/fwlink/p/?LinkID=512487
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Note  

You can’t track tasks assigned to more than one person. 

4. Select both the Keep an updated copy of this task on my task list check box and the 

Send me a status report when this task is complete check box.  

Important  

You must select both of these check boxes to track an assigned task. 

5. If you want to track the task before assigning it, click the Track button or the Set 

Regarding button as described earlier in this topic. 

Note  

With assigned tasks, you must track the task record specifically as a task. You 

can’t track it as a phone call, letter, or FAX by selecting from the drop-down list 

on the Track button.  

6. When you’re ready to assign the task, click Send. 

When you click Send, ownership of the record passes to the person you’re assigning the 

task to. If the person you assign the task to declines the task, you’ll receive a declined 

task message. To reclaim ownership, open the message and click Return to Task List. 

After reclaiming ownership, you can reassign the task to someone else. 

1. If someone assigns a task to you in Dynamics CRM for Outlook, you have three options: 

 On the Task tab, in the Respond group, click Accept. If you accept the task, you 

become the owner of the task. 

 On the Task tab, in the Respond group, click Decline. If you decline the task, 

ownership of the task passes back to the person who assigned the task to you. 

 On the Task tab, in the Manage Task group, click Assign Task. If you reassign the 

task, ownership of the task passes to the person you assign the task to. 

Important  

Dynamics CRM for Outlook can’t track tasks that are reassigned. If a task is 

already tracked and you reassign the task, the task will be untracked and 

deleted from CRM.  

Accept, decline, or reassign a task assigned to you 
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You can’t reassign a task by forwarding it. 

2. To track a task after accepting it, click the Track button or the Set Regarding button as 

described earlier in this topic. 

Note  

With an assigned task, you must track the task specifically as a task. You can’t 

track the task record as a phone call, letter, or FAX by selecting the down arrow 

on the Track button. 

1. Open the task. 

2. Make sure that Status and % Complete is current. 

3. On the Task tab, in the Manage Task group, click Send Status Report. 

4. In the To or Cc boxes, enter the names or email addresses of the people you want to 

send the status report to. 

5. In the body of the message, type any information you want to include in the status report. 

6. Click Send. 

 To follow the progress of tasks you assign, select either or both of the following check 

boxes when you assign the task: 

 
 

 To view tasks that you have assigned to others: 

a. Go to Tasks. 

b. On the View tab, in the Current View group, click Change View, and then click 

Assigned. 

 To view the list of people who receive updated copies of an assigned task: 

a. Open the assigned task. 

b. On the Task tab, in the Show group, click Details, and then review the names in the 

Update list box. 

See Also 

Overview of tracking records in CRM for Outlook 

Deleting records that have been tracked with CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

Send a status report about a task assignment 

Follow the progress of tasks you assign 
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Track Outlook appointments in CRM for Outlook 

You can track an appointment in Microsoft Dynamics CRM for Outlook to save a copy of that 

appointment record as an activity in Microsoft Dynamics CRM. Dynamics CRM for Outlook 

synchronizes the CRM record with the Outlook record so you can view or edit the appointment in 

either tool. If you sync Outlook on your mobile device, you can also access your appointment 

records on that device. 

Tracking appointments in Dynamics CRM for Outlook is a manual process. This gives you the 

ability to keep your personal appointments separate from your CRM appointments. 

Synchronization of appointments from CRM to Dynamics CRM for Outlook is automatic, however. 

You can use Dynamics CRM for Outlook to view any appointment records that you own that were 

created in CRM. 

If you’re using Microsoft Dynamics CRM 2015 for Outlook or later, you can also synchronize 

appointment attachments if your system administrator has enabled this capability. You can then 

view and update the attachments in Dynamics CRM for Outlook or CRM. 

To synchronize appointments between Dynamics CRM for Outlook and CRM, your 

Outlook email address must match your CRM email address. You can’t synchronize to or 

from multiple email addresses. 

 

1. In Dynamics CRM for Outlook, create an appointment as you normally would in Outlook. 

2. If you want to insert an attachment, click the Insert tab, and then select an attachment. 

Note that some file extensions may be blocked by your system administrator. More 

information: System Settings dialog box - General tab 

Dynamics CRM for Outlook doesn’t support inline attachments (attachments included in 

the body of the message). Tell me more about inline attachments and how to convert 

them. 

Note  

The maximum size for an attachment is 5MB, although this can be increased to 

32 MB by a system administrator.   

3. To track the appointment, do one of the following: 

 To track the appointment without linking it to a particular record in CRM, on the 

Appointment tab, in the CRM group, click Track. 

-Or- 

 To track the task and link it to a particular CRM record (for example, a specific 

account), click Set Regarding, click More, and then search for the record in the 

Look Up Record dialog box. After you find the record you want, select Add. 

When you click the Track button or the Set Regarding button, you’ll see a Microsoft 

Dynamics CRM pane (also known as the “tracking pane”) at the bottom of the 

Important  

Track an appointment 

http://go.microsoft.com/fwlink/p/?LinkID=510099
http://go.microsoft.com/fwlink/p/?LinkID=510099
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appointment record. This pane shows that the record is tracked and provides links to 

related records. If you set a Regarding value, Dynamics CRM for Outlook also provides a 

link to the Regarding record. Tell me more about how tracking works. 

Notes 

 To stop tracking an appointment, open the appointment record, and then click the Untrack 

button. 

 After an appointment attachment is synchronized, if different users update the attachment in 

Dynamics CRM for Outlook and CRM, the latest update will be saved. 

 After an appointment is synchronized, if you or another user changes the subject of the 

appointment in Dynamics CRM for Outlook or CRM, the appointment will be untracked (no 

longer synchronized).  

 You can’t synchronize attachments in recurring appointments or service appointments in 

Dynamics CRM for Outlook. 

See Also 

Overview of tracking records in CRM for Outlook 

Deleting records that have been tracked with CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

Deleting records that have been tracked with CRM for Outlook 

You can use Microsoft Dynamics CRM for Outlook to track email messages, contacts, tasks, and 

appointments. When you track an item, a copy of that record is saved as an activity in Microsoft 

Dynamics CRM and synchronized with the Outlook record. More information: Overview of 

tracking records in CRM for Outlook.  

The following rules apply whether you synchronize records with Dynamics CRM for Outlook or 

server-side synchronization. 

Email messages 

 Deleting a tracked email message in Outlook does not delete the email message from 

Microsoft Dynamics CRM. 

 Deleting an email message in Microsoft Dynamics CRM does not delete the tracked message 

from Outlook.  

 If you stop tracking an email message in Outlook, Dynamics CRM for Outlook asks whether 

you want to delete the email message in Microsoft Dynamics CRM. 

Appointments 

Deleting a tracked appointment in Outlook deletes the appointment in Microsoft Dynamics CRM. 

Deleting a tracked appointment in Microsoft Dynamics CRM deletes the appointment in Outlook if 

the following is true: 

 The appointment is current. 

 You are the owner or organizer of the appointment record. 

http://go.microsoft.com/fwlink/p/?LinkID=510100
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If you stop tracking an appointment, Dynamics CRM for Outlook asks whether you want to delete 

the appointment from Microsoft Dynamics CRM. The appointment record is deleted in Microsoft 

Dynamics CRM if the following is true:  

 The appointment is current. 

 You are the owner of the appointment record. 

Contacts 

 Deleting a tracked contact in Outlook does not delete the contact record from Microsoft 

Dynamics CRM. 

 If you are not the owner of the contact record, deleting a contact from Microsoft Dynamics 

CRM deletes the tracked contact from Outlook. 

 If you are the owner of the contact record, deleting a contact from Microsoft Dynamics CRM 

does not delete the contact from Outlook. 

 If you are the owner of the contact record, and you stop tracking the contact, Dynamics CRM 

for Outlook asks whether you want to delete the contact record from Microsoft Dynamics 

CRM. 

 If you are not the owner of the contact record and you stop tracking the contact, Microsoft 

Dynamics CRM deletes the contact record. 

Tasks 

 Deleting a tracked task in Outlook deletes the task activity record in Microsoft Dynamics 

CRM. 

 Deleting the task activity record in Microsoft Dynamics CRM deletes the task in Outlook if the 

task is current. 

 If you stop tracking the task, Dynamics CRM for Outlook asks whether you want to delete the 

task in Microsoft Dynamics CRM. 

 

See Also 

Overview of tracking records in CRM for Outlook 

Track Outlook email by choosing a button in CRM for Outlook 

Track Outlook appointments in CRM for Outlook 

Track Outlook contacts in CRM for Outlook 

Track Outlook tasks in CRM for Outlook 

Synchronize data 

 

Synchronizing data with Outlook or Exchange FAQ 

Choose the records to synchronize between CRM and Outlook or Exchange 

View the fields that are synchronized between CRM and Outlook 

Synchronize records manually with CRM for Outlook 
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Control field synchronization between CRM and Outlook or Exchange 

Which fields can be synchronized between CRM and Outlook? 

How security affects synchronization between CRM and Outlook or Exchange 

System Settings dialog box - Synchronization tab 

Create or modify synchronization filters or view synchronizing fields 

Synchronizing data with Outlook or Exchange FAQ 

What does “synchronization” mean in Microsoft Dynamics CRM or CRM for Outlook? 

One of the main reasons people use Microsoft Dynamics CRM is to store customer emails so 

anyone with the appropriate permissions can see all relevant customer communications in one 

place. To store email and other messaging items (such as appointments, contacts, and tasks) in 

CRM, you need to synchronize your email system with CRM. More information: TechNet: 

Integrate your email system with CRM 

What is CRM App for Outlook? Can I track my email through that app? 

Yes. Microsoft Dynamics CRM App for Outlook is a lightweight email tracking app you can use 

together with Microsoft Outlook on the web, or with the Microsoft Outlook desktop application. 

With Dynamics CRM App for Outlook, CRM information appears inline next to a user’s Outlook 

email messages. For example, people can preview information about contacts and leads stored 

in CRM and add CRM contacts directly from an email message. They can also track incoming 

and outgoing email messages and (optionally) link them to new or existing CRM records. To use 

Dynamics CRM App for Outlook, you must synchronize email with server-side synchronization. 

More information: CRM App for Outlook User's Guide (lightweight app) 

Should I synchronize records through CRM for Outlook, server-side synchronization, or 
the Email Router? 

There are three ways to synchronize email. You can use Dynamics CRM for Outlook (also known 

as “Outlook sync”), server-side synchronization (also known as “Exchange sync”), or the Email 

Router. In most cases, server-side synchronization is the best synchronization method. Note that 

you must be an administrator to synchronize email with server-side synchronization or the Email 

Router. TechNet: Learn more about the benefits of server-side synchronization. 

Can I track records in CRM for Outlook or CRM App for Outlook if I synchronize records 
through server-side sync? 

Yes, you can continue to use the Track button or the Set Regarding button in Dynamics CRM for 

Outlook to manually track records if your organization uses server-side synchronization. These 

buttons provide a convenient way to push records from Outlook to CRM. Note that if your 

organization uses server-side synchronization, records don’t get created in CRM immediately; 

they’re created when server-side synchronization processes synchronization for the mailbox, 

which can take up to 15 minutes. 

You can also use Dynamics CRM App for Outlook (lightweight email tracking app) to track email if 

you synchronize records through server-side synchronization. More information: CRM App for 

Outlook User's Guide (lightweight app) 

https://technet.microsoft.com/library/dn832099.aspx
https://technet.microsoft.com/library/dn832099.aspx
https://technet.microsoft.com/library/dn832099.aspx


 

 
333 

If I synchronize records through server-side synchronization, what filters are used to 
determine the records that are synchronized? 

Server-side synchronization uses the same filters as Dynamics CRM for Outlook to determine the 

synchronized records. You can modify these filters or create new filters through Dynamics CRM 

for Outlook. More information: Choose the records to synchronize between CRM and Outlook or 

Exchange 

How often are records synchronized? 

Dynamics CRM for Outlook. If you synchronize records through Dynamics CRM for Outlook, 

records are synchronized every 15 minutes by default. You can adjust the synchronization 

interval through personal options. More information: Set personal options that affect tracking and 

synchronization between CRM and Outlook or Exchange 

If you need to synchronize right away, you can synchronize records manually. More information: 

Synchronize records manually with CRM for Outlook.  

Server-side synchronization. If you synchronize records with server-side synchronization, the 

process is dynamic and unique for each user’s mailbox. The synchronization algorithm ensures 

that mailboxes are synced according to dynamic parameters such as the number of email 

messages and the activity within the mailbox. Normally, email synchronization occurs every 5 

minutes. When a mailbox has many email messages, the interval can be reduced dynamically to 

2 minutes. If the mailbox is less active, the interval can be increased up to 12 minutes. Generally 

speaking, you can assume that a mailbox will be synced at least once every 12 minutes. Note 

that you can’t manually synchronize records through server-side synchronization. 

How do I change the synchronizing computer (client) when synchronizing with CRM for 
Outlook? 

If you use Dynamics CRM for Outlook to synchronize records, and if you have Dynamics CRM for 

Outlook installed on more than one computer, you have to select one computer as the 

synchronizing computer for email, appointments, contacts, and tasks. To change the 

synchronizing computer: 

1. In Dynamics CRM for Outlook, on the File menu, choose CRM, and then choose Options. 

2. On the Set Personal Options page, choose the Synchronization tab. 

3. In the Set synchronization client section, select Set this computer to be the client to 

perform synchronization between Outlook and your primary Microsoft Dynamics CRM 

organization. 

This option only appears when you have multiple computers connected to the same 

organization. 

Can I view or control the fields that are synchronized between CRM and Outlook? 

You can view the synchronizing fields and determine whether fields are synced one way (from 

Outlook to CRM), two ways (back and forth between Outlook and CRM), or not at all. More 

information: View the fields that are synchronized between CRM and Outlook.  

If you’re a system administrator, you can also control field synchronization and sync direction. 

More information: TechNet: Control field synchronization between CRM and Outlook or Exchange 

Note  

https://technet.microsoft.com/library/dn832150.aspx
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This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-

premises). 

Do security permissions affect synchronization? 

Yes. If a system administrator has implemented security for particular fields or records, it can 

affect the data that’s synchronized between CRM and Outlook or Exchange. More information: 

TechNet: How field security affects synchronization between CRM and Outlook or Exchange 

This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-

premises). 

Where can I find information on troubleshooting server-side synchronization issues? 

You can find information on troubleshooting and known issues on Technet: Troubleshooting and 

things to know about server-side synchronization. 

Privacy notice 

If you use Microsoft Dynamics CRM, when you use server-side sync, CRM contacts and activities 

(including emails, appointments, contacts, and tasks) are synchronized to your specified email 

system (such as Exchange).  

 

 An administrator can configure server-side sync functionality to specify which users have the 

ability to send emails or appointments from CRM or synchronize activities and contacts between 

CRM and the user’s mailbox. Both the administrator and end users can further customize filter 

criteria, and administrators can even define which entity fields synchronize.  

 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

Note  

Note  

https://technet.microsoft.com/library/dn832097.aspx
https://technet.microsoft.com/library/hh699813.aspx
https://technet.microsoft.com/library/hh699813.aspx
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and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

See Also 

CRM for Outlook User's Guide (full app) 

CRM App for Outlook User's Guide (lightweight app) 

Track Outlook email by moving it to a tracked Exchange folder 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

TechNet: Integrate your email system with CRM 

Choose the records to synchronize between CRM and Outlook or Exchange 

Microsoft Dynamics CRM uses online synchronization filters to determine which records to 

synchronize between CRM and Microsoft Outlook (using Microsoft Dynamics CRM for Outlook), 

or Exchange (using server-side synchronization). You can modify the existing online 

synchronization filters or create new filters to synchronize certain types of records. You can also 

delete, deactivate, or activate filters. You use the same set of filters (accessed through Dynamics 

CRM for Outlook) whether you’re synchronizing through Dynamics CRM for Outlook or server-

side synchronization. 

The synchronization filters for appointments only apply when synchronizing through 

Dynamics CRM for Outlook, not server-side synchronization.  

Email is not included in the synchronization filters because email is controlled by when the email 

is created in CRM, whether the user is on the recipient list or not. This is true for all email 

processing methods: Dynamics CRM for Outlook, server-side synchronization, or Email Router.  

CRM also includes offline synchronization filters that you can use to choose records to 

work with offline in Dynamics CRM for Outlook. More information: Choose records to 

work with offline in CRM for Outlook  

Create or modify online synchronization filters 

Important  

Tip  

https://technet.microsoft.com/library/dn832099.aspx
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1. Go to Options:  

 In the web app: In the upper-right corner of the screen, click the Settings button  > 

Options. 

 In Dynamics CRM for Outlook: Click File > CRM > Options. 

 

2. In the Set Personal Options dialog box, click the Synchronize tab. 

3. Under Synchronize Microsoft Dynamics CRM items with Outlook or Exchange, click 

the filters link. 

CRM displays the Synchronization Settings for Outlook or Exchange dialog box with 

the User Filters tab selected. You can use this tab to create or edit a filter, or to delete, 

activate, or deactivate a filter. 

 
 

Note  

If you’re a system administrator, you can create or modify organization-wide 

filters (system filters) through the SDK. More information: MSDN: Tell me more 

about system filters 

4. Do one of the following: 

 To open an existing filter, click the filter. 

 To create a new filter, click New. 

 

https://msdn.microsoft.com/library/gg328205.aspx
https://msdn.microsoft.com/library/gg328205.aspx
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Create or modify filter criteria 

You use a criteria row to create or modify criteria in an offline synchronization filter. Each criteria 

row contains three values: the field to use in the filter (for example, City), an operator (for 

example, Equals or Contains), and the value to filter on (for example, WA). 

 
 

 

1. In the Look for list, select a record type. 

2. Point to Select in the criteria grid, and then select the field to filter on from the list. 

3. Select an operator from the list. 

4. Enter a value to filter on. 

 

1. For each row you want to group, click the down arrow to the left of the field name, and 

then click Select Row. 

To remove a row from a group, click the down arrow to the left of the field name, and then 

click Delete. To clear all rows from the criteria grid, click Clear. 

2. Click Group AND or Group OR. 

After creating a group, you can click the down arrow next to the And or Or to select from different 

options. You can select a group, ungroup the group, change a Group AND to a Group OR or vice 

versa, add a clause, or delete a group. 

 

Add a criteria row 

Group rows of criteria 
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See Also 

Choose records to work with offline in CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

View the fields that are synchronized between CRM and Outlook 

In Microsoft Dynamics CRM 2015 for Outlook or later, you can view the appointments, contacts, 

and tasks fields that are synchronized between Microsoft Dynamics CRM and Outlook so you can 

see where the data is coming from. You can also determine whether the fields: 

 Are synchronized one way (from Outlook to CRM or from CRM to Outlook) 

 Are synchronized two way (from Outlook to CRM and from CRM to Outlook) 

 Aren’t synchronized 

For example, if the fields are synchronized one way, from CRM to Outlook, you can update the 

field in Outlook and save the change, but your changes won’t be synced with CRM, and will be 

overwritten if the same field value is changed in CRM. So if fields are synced one way, there’s no 

need to change the value in the synchronized field. 

View the synchronized fields 

1. In Dynamics CRM for Outlook, click File, and then click CRM. 

2. On the Synchronize button, click the down arrow, and then click Review 

Synchronization Settings. 

 
 

3. In the Synchronization Settings for Outlook or Exchange dialog box, click the 

Synchronization Fields tab. 
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4. In the Entity Type list, select the record type you want to view.  

Outlook fields are displayed on the left and the corresponding CRM fields are displayed 

on the right. The blue arrows show the sync direction: 
 

This indicator Shows that the fields 

 Are synced one way from Outlook to CRM 

 Are synced one way from CRM to Outlook 

 Are synced two way 

 Aren’t synced 

 

Note  

Field synchronization direction can be impacted by security settings configured 

by your system administrator. For example, if you don’t have read privileges for a 

field, it won’t be synchronized in Outlook even if the field is configured for two-

way synchronization. To determine whether you have read privileges for a field, 

click the View in CRM button to open the record in CRM. If you see the Lock 

icon, you can’t access the field. 

See Also 

Synchronizing data with Outlook or Exchange FAQ 
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TechNet: What fields can be synchronized between CRM and Outlook or Exchange? 

TechNet: Control field synchronization between CRM and Outlook or Exchange (admins) 

TechNet: How security affects synchronization between CRM and Outlook or Exchange 

Synchronize records manually with CRM for Outlook 

By default, changes made in Microsoft Dynamics CRM are synchronized with Microsoft Dynamics 

CRM for Outlook every 15 minutes. You can set personal options in Dynamics CRM for Outlook 

to change how often data is synchronized, but you can’t synchronize data more frequently than 

every 15 minutes. If you need to synchronize right away, you can do a manual synchronization. 

 

 In Dynamics CRM for Outlook, click File > CRM > Synchronize > Start 

Synchronization. 

Note  

If you receive the error message "CRM server Not Found", verify that you have 

Internet connectivity and that the Microsoft Dynamics CRM server is running. 

Then try synchronizing again. 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

 

https://technet.microsoft.com/library/dn832089.aspx
https://technet.microsoft.com/library/dn832150.aspx
https://technet.microsoft.com/library/dn832097.aspx
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Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Choose the records to synchronize between CRM and Outlook or Exchange 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Synchronizing data with Outlook or Exchange FAQ 

Control field synchronization between CRM and Outlook or Exchange 

If you’re a system administrator, you can control synchronization of appointments, contacts, and 

tasks fields between Microsoft Dynamics CRM and Outlook (using Dynamics CRM for Outlook) or 

Exchange (using server-side synchronization). You can:  

 View and modify the fields that are synchronized between CRM and Outlook or Exchange. 

 Control whether a specific pair of fields is synchronized: 

 In one direction - from Outlook or Exchange to CRM  or from CRM to Outlook or 

Exchange 

 In both directions - from Outlook or Exchange to CRM  and from CRM to Outlook or 

Exchange 

You can also disable field synchronization between a pair of fields. 

For more information about controlling field synchronization, see TechNet: Control field 

synchronization between CRM and Outlook or Exchange  

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

See Also 

View the fields that are synchronized between CRM and Outlook 

TechNet: Which fields can be synchronized between CRM and Outlook? 

TechNet: How field security affects synchronization between CRM and Outlook 

System Settings dialog box - Synchronization tab 

Synchronizing data with Outlook or Exchange FAQ 

Overview of tracking records in CRM for Outlook 

Note  

https://technet.microsoft.com/library/dn832150.aspx
https://technet.microsoft.com/library/dn832150.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/dn832089.aspx
https://technet.microsoft.com/library/dn832097.aspx
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Which fields can be synchronized between CRM and Outlook? 

Microsoft Dynamics CRM administrators can control field synchronization between Microsoft 

Dynamics CRM and Microsoft Dynamics CRM for Outlook. For example, admins can control the 

synchronization direction between pairs of fields. For information about which fields can be 

synchronized between  Microsoft Dynamics CRM and Dynamics CRM for Outlook, see TechNet: 

Which fields can be synchronized between CRM and CRM for Outlook. 

See Also 

View the fields that are synchronized between CRM and Outlook 

How security affects synchronization between CRM and Outlook or Exchange 

Synchronization of data between Microsoft Dynamics CRM and Microsoft Dynamics CRM for 

Outlook or Exchange can be affected by security settings determined by your CRM administrator. 

For example, you may not be able to synchronize data from CRM to Dynamics CRM for Outlook 

for a particular field if you don’t have read privileges for that field. For more information, see 

TechNet: How field security affects synchronization between CRM and CRM for Outlook. 

See Also 

Synchronizing data with Outlook or Exchange FAQ 

Which fields can be synchronized between CRM and Outlook? 

System Settings dialog box - Synchronization tab 

Use the settings on this page to determine how data is synchronized between Microsoft 

Dynamics CRM and Microsoft Dynamics CRM for Outlook. For example, you can control 

synchronization between pairs of fields or enable or disable synchronization of additional mailing 

addresses, assigned tasks, or appointment attachments.  

The Synchronization tab was introduced in Microsoft Dynamics CRM Online 2015 

Update and Microsoft Dynamics CRM 2016 (on-premises).  

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

Important  

Open the System Settings dialog box (if it’s not already open) 

https://technet.microsoft.com/library/dn832089.aspx
https://technet.microsoft.com/library/dn832089.aspx
https://technet.microsoft.com/library/dn832097.aspx
https://technet.microsoft.com/library/dn832089.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Choose the System Settings > Synchronization tab. 

 

 

 
 

Settings Description 

Synchronize Microsoft Dynamics CRM 

items with Outlook or Exchange 

 

Manage system filters for your entire 

organization to determine the CRM records that 

are synchronized to Outlook or Exchange 

folders. 

This setting provides access to the User Filters 

tab in the Synchronization Settings for 

Outlook or Exchange dialog box. You may 

want to view this tab to see the default online 

synchronization filter settings for users in your 

organization. More information: Choose the 

records to synchronize between CRM and 

Outlook or Exchange 

Manage the synchronized fields of Outlook or 

Exchange items including appointments, 

contacts, and tasks for your entire organization. 

This setting provides access to the 

Synchronization Fields tab in the 

Synchronization Settings for Outlook or 

Exchange dialog box. Use this tab to view how 

appointments, contacts, and tasks fields are 

mapped between CRM and Outlook, and to 

change the synchronization direction or restrict 

synchronization for contacts and tasks fields. 

For example, if you want the contents of the 

contacts Notes field to be private, you can keep 

that field from synchronizing. More information: 

TechNet: Control field synchronization between 

CRM and Outlook or Exchange 

Manage your offline filters and take your 

information offline in CRM for Outlook 

 

Manage system offline filters for your entire 

organization to determine what CRM data 

users can take with them when they go offline 

in Dynamics CRM for Outlook. 

This setting provides access to the User Filters 

tab in the Go Offline Settings dialog box. You 

may want to view this tab to see the default 

offline synchronization filter settings for users in 

your organization. More information: Choose 

records to work with offline in CRM for Outlook 

Configure general synchronization rules for 

your entire organization for appointments, 

 

https://technet.microsoft.com/library/dn832150.aspx
https://technet.microsoft.com/library/dn832150.aspx
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Settings Description 

contacts, and tasks 

Appointments  

Synchronize appointment attachments with 

Outlook or Exchange 

Attachments take up database space, so 

synchronization of appointment attachments is 

turned off by default. Choose the check box to 

turn on synchronization of attachments.  

Important  

Synchronization of appointment 

attachments is not supported for 

recurring appointments or service 

activities. 

More information: Track Outlook appointments 

in CRM for Outlook 

Contacts  

Synchronize mailing address only in Outlook 

contact 

Synchronize all three addresses (Business, 

Home, Other) in Outlook contact 

By default, just one Outlook mailing address 

field is synchronized between CRM and 

Outlook. This is sufficient for most 

organizations. If you want to synchronize all 

three Outlook mailing address fields (Business, 

Home, and Other fields) choose the 

Synchronize all three addresses in Outlook 

contact option. 

Warning  

Be cautious when enabling this option 

as it can cause data loss in some 

situations if you have existing data. 

This is due to the remapping of the 

attributes for existing tracked contacts. 

The best practice is to do in-house 

testing to understand how the re-

mapping affects your environment and 

data. In most cases, you should have 

the full data in one side (normally in 

CRM) and sync to the other side 

(normally Outlook or Exchange).  

Tasks  

Synchronize tasks that are assigned in Outlook Outlook tasks are synchronized by default, but 
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Settings Description 

synchronization of assigned tasks is turned off 

by default. Most companies don’t require this 

feature because tasks would usually be 

assigned directly in CRM by changing 

ownership in CRM. 

You may want to enable this feature, however, 

if your company’s business processes involve 

creating and sending tasks in Outlook instead 

of CRM. More information: Track Outlook tasks 

in CRM for Outlook 

 

See Also 

Choose the records to synchronize between CRM and Outlook or Exchange 

Choose records to work with offline in CRM for Outlook 

Track Outlook tasks in CRM for Outlook 

Track Outlook appointments in CRM for Outlook 

TechNet: Control field synchronization between CRM and Outlook or Exchange 

TechNet: Which fields can be synchronized between CRM and Outlook? 

Create or modify synchronization filters or view synchronizing fields 

Looking for help on the Synchronization Settings for Outlook or Exchange  dialog box or the 

Go Offline Settings dialog box? 

 Synchronization Settings for Outlook or Exchange dialog box. This dialog box has three 

tabs: 

 User Filters. Use this tab to choose the records that are synchronized between CRM 

and Outlook or Exchange when you’re online. More information: Choose the records to 

synchronize between CRM and Outlook or Exchange 

 System Filters. System administrators can programmatically modify online 

synchronization filters for an entire organization. More information:  MSDN: Offline and 

Outlook filters and templates 

 Synchronization Fields. Use this tab to view the fields that are synchronized between 

CRM and Outlook, and to view the synchronization direction (one-way or two-way 

synchronization). More information: View the fields that are synchronized between CRM 

and Outlook 

 Go Offline Settings dialog box. This dialog box has two tabs: 

 User Filters. Use this tab to choose the records to work with when you go offline with 

Dynamics CRM for Outlook. More information: Choose records to work with offline in 

CRM for Outlook 

https://technet.microsoft.com/library/dn832150.aspx
https://technet.microsoft.com/library/dn832089.aspx
https://msdn.microsoft.com/library/gg328205.aspx
https://msdn.microsoft.com/library/gg328205.aspx
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 System Filters. System administrators can programmatically modify offline 

synchronization filters for an entire organization. More information:  MSDN: Offline and 

Outlook filters and templates 

See Also 

Choose the records to synchronize between CRM and Outlook or Exchange 

Choose records to work with offline in CRM for Outlook 

View the fields that are synchronized between CRM and Outlook 

Work offline with CRM for Outlook 

Work offline 

 

Work offline with CRM for Outlook 

Choose records to work with offline in CRM for Outlook 

Example of going offline with CRM for Outlook 

Work offline with CRM for Outlook 

You can use Microsoft Dynamics CRM for Outlook to access your Microsoft Dynamics CRM data 

when you’re on the go. For example, if you travel to a customer’s site, you can look up your CRM 

contacts, review and add new notes, and more without connecting to the Internet.  

When you go offline with Dynamics CRM for Outlook, the software copies a subset of CRM data 

to your computer’s hard drive. Changes you make while you’re offline are stored locally. When 

you connect to the server again, the changes are automatically synchronized with the CRM 

server. 

On this page: 

Before you go offline 

Go offline 

Go back online 

What features are unavailable offline? 

Other things to know about going offline 

Before you go offline 

Dynamics CRM for Outlook uses offline synchronization filters to determine the subset of data to 

copy to your local hard drive when you go offline. Before you go offline, you can modify these 

filters or create new filters to synchronize just the data you need. You can also delete, deactivate, 

or activate filters. More information: Choose records to work with offline in CRM for Outlook 

The first time you go offline, it can take a significant amount of time to synchronize your 

local data with the CRM server if you have a lot of data. For example, in customer service 

situations, a parent case may have thousands of child cases. CRM isn’t available when 

Tip  

https://msdn.microsoft.com/library/gg328205.aspx
https://msdn.microsoft.com/library/gg328205.aspx
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Dynamics CRM for Outlook is synchronizing. You can shorten the time by using the 

offline synchronization filters to limit the amount of synchronized data. 

Go offline 

When you’re ready to go offline, in Dynamics CRM for Outlook, choose File > CRM > Go Offline. 

When you choose Go Offline, Dynamics CRM for Outlook syncs your data to your local 

computer using the offline sync filters. When synchronization is complete, you can disconnect 

your computer from the network.  

You can tell if you’re offline by using any of the following indicators: 

 The CRM toolbar displays the Go Online button. 

 The CRM menu displays the Go Online option. 

 If you’re using Outlook 2010 or Outlook 2013, the CRM tab displays the Go Online 

button. 

Go back online 

1. Make sure you’re connected to your organization’s network.  

2. Choose File > CRM > Go Online. 

What features are unavailable offline? 

 

Not available offline 

 Assigning records  

 Posts 

 Converting quotes to sales orders 

 Converting sales orders to invoices 

 Managing system administration 

 Updating system configuration 

 Managing service activities 

 Managing services 

 Using the Service calendar and Workplace calendar 

 Editing articles  

 Editing or managing sales literature 

 Changing organizations 

 Sharing records 

 Detecting duplicate records 

 Managing system jobs 

 Running some diagnostic tests 

 Running workflow rules 

 Create quick campaign and related activities from a mail merge 

 Tracking assigned tasks 

Tip  
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 Revise quote functionality 

 Follow or unfollow in the activity feed 

 Custom themes 

Limited availability offline 

 Creating or viewing reports (based on local data groups and offline data) 

 Running some custom business processes (plug-ins) 

Can be viewed, but can’t be edited offline 

 Articles 

 Sales literature 

 Mail-merge templates 

Other things to know about going offline 

 Shared use of a computer. Any users who log on locally to a computer that has Dynamics 

CRM for Outlook installed can potentially access CRM data stored in the offline database. 

Shared use of a computer running Dynamics CRM for Outlook is not supported. 

 How CRM handles changes from multiple users. CRM applies additions and changes to 

the CRM server in the same order they’re entered. If you make a change to a record while 

you’re offline, and another user changes the same record during that time, when you go back 

online, your change will overwrite the changes that the other user made while you were 

offline. 

 Workflows. When you work offline, CRM disables workflow notifications. If the changes you 

make offline are set to trigger an automated workflow process or a system job, the process is 

automatically triggered when you go back online. 

 Duplicate detection. CRM disables duplicate detection when you’re offline. Duplicate 

detection is automatically re-enabled when you go back online. You can set a personal option 

to determine how duplicate records are handled during synchronization. More 

information:.Set personal options that affect tracking and synchronization between CRM and 

Outlook or Exchange 

 Undelivered messages. Email messages can fail to be delivered if the mail server is down, 

or can be blocked if the recipient doesn’t want to receive the email. If this happens, Outlook 

saves the email message to your Drafts folder, but Microsoft Dynamics CRM creates a 

closed activity. In Microsoft Dynamics CRM, use the Pending E-mail view to see unsent 

messages. 

When you’re working offline, email messages that you send are saved to your Outlook offline 

queue. When you go online, Microsoft Dynamics CRM automatically tries to send them and 

create the activities. If an email message can’t be sent, Microsoft Dynamics CRM saves it as 

a draft activity, but it does not appear in your Drafts folder in Outlook.  

 Offline security permissions. You have the same security permissions offline as when 

you’re online. 

 Adding a related record type using the Add  button (+). If you’re offline, you can’t add a 

related record type by using the Add button (+). Add the related record type while you’re 

online, and then go offline. 

Privacy notices 
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To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM for Outlook, when you go offline, a copy of the data you are 

working on is created and stored on your local computer. The data is transferred from CRM 

Online to your computer by using a secure SSL connection, and a link is maintained between the 

local copy and CRM Online. The next time you sign in to CRM Online, the local data will be 

synchronized with CRM Online.  

 

 An administrator determines whether or not an organization’s users are permitted to go offline 

with Microsoft Dynamics CRM for Outlook by using security roles.  

 

 Users and administrators can configure which entities are downloaded via Offline Sync by using 

the Sync Filters setting in the Options dialog box. Alternatively, users and Administrators can 

configure which fields are downloaded (and uploaded) by using Advanced Options in the Sync 

Filters dialog box. 

 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 
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to Outlook by using security roles. 

 

See Also 

Set up CRM for Outlook 

Choose records to work with offline in CRM for Outlook 

Example of going offline with CRM for Outlook 

Choose records to work with offline in CRM for Outlook 

Choose a subset of Microsoft Dynamics CRM data to take with you when you go offline with 

Microsoft Dynamics CRM for Outlook by using offline synchronization filters. By default, these 

filters copy the appointments, contacts, and tasks records you own to your local drive. You might 

want to modify the filters to take a smaller subset of data with you or to synchronize particular 

records. For example, you might want to synchronize all reports since reports you don’t own 

wouldn’t normally be synchronized.  

You can modify the existing filters or create new filters. You can also delete, deactivate, or 

activate filters. You can reset the filters every time you go offline. 

To synchronize data and go online and offline more quickly, you can decrease the 

interval for automatic synchronization. More information: Set personal options that affect 

tracking and synchronization between CRM and Outlook or Exchange 

Create or modify offline synchronization filters 

1. Do one of the following:  

In the web app: 

 Choose the  Options button  in the upper-right corner of the window, and then 

choose Options. 

 In the Set Personal Options dialog box, choose the Synchronize tab. 

In CRM for Outlook: 

 On the File menu, choose CRM. 

 Choose Options, and then in the Set Personal Options dialog box, choose the 

Synchronize tab. 

 

2. Under Manage your offline filters and take your information offline in Dynamics 

CRM for Outlook, choose the offline filters link. 

CRM displays the Go Offline Settings dialog box with the User Filters tab selected. You 

can use this tab to create or edit a filter, or to delete, activate, or deactivate a filter. 

Tip  
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Note  

If you’re a system administrator, you can create or modify organization-wide 

filters (system filters) through the SDK. More information: MSDN: Tell me more 

about system filters 

3. Do one of the following: 

 To open an existing filter, choose the filter. 

 To create a new filter, choose New. 

Creating or modifying filter criteria 

You use a criteria row to create or modify criteria in an offline synchronization filter. Each criteria 

row contains three values: the field to use in the filter (for example, City), an operator (for 

example, Equals or Contains), and the value to filter on (for example, WA). 

 
 

 

https://msdn.microsoft.com/library/gg328205.aspx
https://msdn.microsoft.com/library/gg328205.aspx
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1. In the Look for list, select a record type. 

2. Point to Select in the criteria grid, and then select the field to filter on from the list. 

3. Select an operator from the list. 

4. Enter a value to filter on. 

 

1. For each row you want to group, choose the down arrow to the left of the field name, 

and then choose Select Row. 

To remove a row from a group, choose the down arrow to the left of the field name, and 

then choose Delete. To clear all rows from the criteria grid, choose Clear. 

2. Choose Group AND or Group OR. 

After creating a group, you can click the down arrow next to the And or Or to select from different 

options. You can select a group, ungroup the group, change a Group AND to a Group OR or vice 

versa, add a clause, or delete a group. 

 
 

See Also 

Work offline with CRM for Outlook 

Example of going offline with CRM for Outlook 

Choose the records to synchronize between CRM and Outlook or Exchange 

Synchronizing data with Outlook or Exchange FAQ 

Example of going offline with CRM for Outlook 

Salespeople can make critical customer information available and up-to-date on business trips 

with filters. By specifying only the data you need to synchronize with your laptop, you can avoid 

wasting valuable laptop memory, stay current with the head office, and keep information on your 

laptop fresh. Meanwhile, managers and co-workers are up-to-date.  

Using Dynamics CRM for Outlook, you can set up and activate filters with criteria similar to 

Advanced Find by specifying the criteria for the Microsoft Dynamics CRM records that you want 

Add a criteria row 

Group rows of criteria 
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to be available when you go offline. In addition, you can change what data will be available when 

you synchronize by activating and deactivating the filters.  

To see what data filters are being applied to your offline synchronization, in Outlook, on the File 

menu, click or tap CRM > Go Offline > Manage Offline Filters.  

You can have more than one active filter so you can take larger, combined sets of data 

offline.  

Select the data you need with filters 

To leverage local data, consider a trip to regional offices in the USA in Washington and Oregon. 

You would want to define needed information in the Microsoft Dynamics CRM database that 

applies to customers in these states.  

First, create a filter of the data for a record type. Save this filter as your “master,” and call it “My 

Active Accounts”, for example. Second, modify this filter to create different versions for your 

business needs.  

 To edit an existing filter, on either tab, double-click or tap the item in the list. To keep the 

original data group, make a copy using Save As, and add additional criteria, such as 

“Address 1: State/Province equals WA”. Save it with a new name such as “My Accounts in 

Washington.”  

 Using Save As again, change the criteria to “Address 1: State/Province equals OR”, and 

name your new data group “My Accounts in Oregon.”  

Before your trip, deactivate all filters, except those that apply to the customers in the first 

area you are visiting. 

 

Deactivate or activate filters 

 To deactivate a filter, on the User Filters tab, select one or more filters. On the tool bar, click 

or tap the Deactivate button (a red circle with a red square).  

 To activate a filter, on the User Filters tab, select one or more filters and then click or tap the 

Activate button (a green circle with a green triangle). 

 

Take your data offline and synchronize your data 

 In Outlook, on the CRM menu, click or tap Go Offline.  

While you are offline, you can add new contacts and accounts or update the accounts and 

contacts on your laptop. When connecting to your company's network again, you can synchronize 

your data.  

Users who log on locally to a device that has Microsoft Dynamics CRM for Outlook 

installed can potentially access CRM data stored locally. Shared use of a device running 

Dynamics CRM for Outlook is not supported. 

Note  

Important  

Important  
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Go back online and synchronize your data 

 In Outlook, on the CRM menu, click or tap Go Online.  

Any updated data from your laptop will be synchronized with your company's Microsoft Dynamics 

CRM database. You can now deactivate and activate a new set of filters for your next visits, using 

the procedures explained earlier in this article.  

 

Combine data filters to take more information with you 

Because filters are additive, you can have more than one active filter. For example, if you are 

going to the Northwest United States, you can activate the Washington and Oregon data filters 

you created and take both sets of data with you.  

 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 
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to Outlook by using security roles. 

 

See Also 

Work offline with CRM for Outlook 

Choose records to work with offline in CRM for Outlook 

Set options 

 

Set address book options in CRM for Outlook 

Customize your regional settings (number, currency, time, and date) in CRM for Outlook 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Set address book options in CRM for Outlook 

With Microsoft Dynamics CRM for Outlook, when you compose an email message or set up a 

meeting, you can search for a CRM contact directly from the To field of the email message or 

appointment. By default, only the contacts that are synchronized with CRM for Outlook and other 

record types that you own (such as accounts and leads) appear in the address book. Use this 

process if you want to synchronize all CRM contacts, including contacts that you don’t own or to 

synchronize additional record types that you don’t own.  

The address book synchronizes with CRM automatically when you start Dynamics CRM 

for Outlook, and then once every 24 hours. 

 

1. In Dynamics CRM for Outlook, choose File, and then choose CRM > Options. 

2. In the Set Personal Options dialog box, choose the Address Book tab. 

Note  

This tab is not available in the CRM web application. 

3. For Contacts, select one of the following: 

 Match only against contacts synchronized to Microsoft Dynamics CRM. This 

option is selected by default. Leave as is if you only want to be able to access the 

contacts that are synchronized through the online synchronization filters. More 

information:  Choose the records to synchronize between CRM and Outlook or 

Exchange 

 

 Match all contacts in Microsoft Dynamics CRM. Select this option if you want all 

CRM contacts to be available in the address book. 

Note  

 



 

 
356 

 

4. For Other record types, select one of the following: 

 Do not match. Select this option if you do not want to sync other record types, such 

as accounts or leads. 

 

 Match only the items I own.  This is the default option. Leave as is if you don’t want 

to sync additional record types that you don’t own. 

 Match all items in Microsoft Dynamics CRM. Select this option if you want to sync 

all record types, including record types you don’t own. 

 

5. If your address book is slow or if there are record types you want to exclude from your 

address book, under Change the record types being synchronized to your Address 

Book, choose the Select or change the values for this field button . 

6. Add or remove record types, and then choose OK. 

7. To save your changes and close the dialog box, choose OK. 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 

but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 



 

 
357 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Choose the records to synchronize between CRM and Outlook or Exchange 

Track Outlook contacts in CRM for Outlook 

Set personal options that affect tracking and synchronization between CRM and Outlook or 

Exchange 

Synchronizing data with Outlook or Exchange FAQ 

Customize your regional settings (number, currency, time, and date) in CRM for Outlook 

You can change how Microsoft Dynamics CRM displays number, currency, time, and date 

formats to match your company’s regional settings. 

The Set Personal Options dialog box is only accessible in CRM for Outlook. 

 

1. In Outlook 2010 or Outlook 2013, on the File tab, click or tap CRM > Options. 

2. In the Set Personal Options dialog box, on the Formats tab, in the Current Format list, 

select the name of the language and country or region for the format that you want to 

personalize, and then click or tap Customize. 

In the Customize Regional Options dialog box, you can change the default settings for 

the format that you selected by selecting one of the following tabs: 

 Number. Set options for the decimal symbol, digit grouping symbol, digit groups, and 

negative numbers. 

 

Important  

Some negative numbering options always display numbers within 

parentheses, for example (100.00), regardless of the preferred setting in 

some countries/regions. Additionally, some long numbers will not appear with 

commas as they should, for example 10000. This issue will be corrected in a 

future release. 

 Currency. Set options for the currency format, negative currency amounts, and 

number of decimal places. 

 Time. Set options for the time format, time separator, and notation for morning and 

afternoon. 

 Date. Set options for the type of calendar, whether or not to show week numbers in 

Note  
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calendar views, and formats for long and short dates. 

 

3. On each of the tabs, use the lists to change the default settings for the format that you 

selected, viewing the changes that you make in the preview boxes. 

4. To apply the changes you have made to the default formats and continue working in the 

dialog box, click or tap Apply. 

-  OR - 

To apply the changes you have made to the default formats and close the dialog box, 

click or tap OK. 

 

Set personal options that affect tracking and synchronization between CRM and Outlook 
or Exchange 

You can use the Set Personal Options dialog box in Microsoft Dynamics CRM for Outlook or in 

Microsoft Dynamics CRM to set many options that affect tracking and synchronization. 

To open the Set Personal Options dialog box: 

 In Dynamics CRM for Outlook, on the File menu, click CRM, and then click Options. 

-Or- 

 In CRM, click the Settings button  in the upper-right corner of the screen, and then click 

Options. 

The following table summarizes the tracking and synchronization options available in the Set 

Personal Options dialog box. The Available column indicates whether the option is available in 

Dynamics CRM for Outlook, CRM, or both. This column also indicates if the option is available for 

Outlook synchronization, server-side synchronization (also known as “Exchange 

synchronization”), or both. More information: Synchronizing data with Outlook or Exchange FAQ 

Some of the options on the Synchronization tab are available only if you’re using CRM 

2015 or later or if you’re using CRM Online. 

 
 

To On this tab In this section See this 

option 

Available 

View or modify 

the online 

synchronization 

filters used to 

determine the 

CRM records 

copied to your 

local hard drive 

Synchronization Synchronize 

Microsoft 

Dynamics CRM 

items with 

Outlook or 

Exchange 

View or 

manage the 

filters that 

determine the 

CRM records 

that are 

synchronized to 

your Outlook or 

 From Dynamics 

CRM for Outlook or 

from CRM 

 For Outlook sync or 

server-side sync 

Note  
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Exchange 

folders.  

More 

information: 

Choose the 

records to 

synchronize 

between CRM 

and Outlook or 

Exchange 

View or modify 

the offline 

synchronization 

filters used to 

determine the 

CRM records 

copied to your 

local hard drive 

when you go 

offline 

Synchronization Manage your 

offline filters 

and take your 

information 

offline in CRM 

for Outlook 

Manage your 

offline filters 

to determine 

what CRM data 

you need with 

you when you 

go offline.  

More 

information: 

Choose records 

to work with 

offline in CRM 

for Outlook 

 From Dynamics 

CRM for Outlook or 

from CRM 

 For Outlook sync or 

server-side sync 

View the fields 

that are 

synchronized 

between 

Outlook and 

CRM 

Synchronization   View or 

manage the 

synchronized 

fields of 

Outlook or 

Exchange 

items, including 

appointments, 

contacts, and 

tasks.  

More 

information: 

View the fields 

that are 

synchronized 

between CRM 

and Outlook 

 From Dynamics 

CRM for Outlook or 

from CRM 

 For Outlook sync or 

server-side sync 

Overwrite the Synchronization Update the Update  From Dynamics 
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names in the 

Outlook 

contacts 

Company field 

with the parent 

account from 

CRM contacts 

company field 

for Outlook 

contacts 

Company fields 

with parent 

account names 

CRM for Outlook 

only 

 For Outlook sync or 

server-side sync 

Set the 

synchronization 

client that 

synchronizes 

records 

between 

Outlook and 

Dynamics CRM 

Synchronization Set 

synchronization 

client 

Set this 

computer to be 

the client to 

perform 

synchronization 

between 

Outlook and 

your primary 

Microsoft 

Dynamics CRM 

organization 

 From Dynamics 

CRM for Outlook 

only 

 For Outlook sync 

only.  

Note  

This option 

only appears 

when you 

have 

multiple 

Outlook 

clients that 

are 

connected to 

the same 

organization. 

Set the 

synchronization 

interval for 

synchronizing 

CRM items  

Synchronization Schedule 

automatic 

synchronization 

with Outlook 

Synchronize 

the CRM items 

in my Outlook 

folders every 

 From Dynamics 

CRM for Outlook 

only 

 For Outlook sync 

only 

Enable CRM to 

send email 

using Dynamics 

CRM for 

Outlook 

Email Select how 

Microsoft 

Dynamics CRM 

for Outlook 

should 

integrate email 

with Microsoft 

Dynamics CRM 

Allow Microsoft 

Dynamics CRM 

to send email 

using Microsoft 

Dynamics CRM 

for Outlook 

From Dynamics CRM for 

Outlook only 

Track incoming 

email 

automatically 

Email Select how 

Microsoft 

Dynamics CRM 

for Outlook 

Check 

incoming email 

in Outlook and 

determine 

From Dynamics CRM for 

Outlook only 



 

 
361 

should 

integrate email 

with Microsoft 

Dynamics CRM 

whether an 

email should be 

linked and 

saved as a 

Microsoft 

Dynamics CRM 

record.  

More 

information: Set 

an option to 

automatically 

track incoming 

Outlook email 

in CRM for 

Outlook 

Track incoming 

email 

automatically 

Email Select the 

email 

messages to 

track in 

Microsoft 

Dynamics CRM 

Track 

More 

information: Set 

an option to 

automatically 

track incoming 

Outlook email 

in CRM for 

Outlook 

From Dynamics CRM for 

Outlook or from CRM 

Track incoming 

email 

automatically 

Email Select the 

email 

messages to 

track in 

Microsoft 

Dynamics CRM 

Configure 

Folder Tracking 

Rules 

More 

information: 

Track Outlook 

email by 

moving it to a 

tracked 

Exchange 

folder 

 From Dynamics 

CRM for Outlook or 

from CRM 

 For server-side sync 

only 

Automatically 

create contact 

or lead records 

if the sender of 

the email 

message or 

Email Automatically 

create records 

in Microsoft 

Dynamics CRM 

Create 

More 

information: Set 

an option to 

automatically 

track incoming 

From Dynamics CRM for 

Outlook or from CRM 
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meeting 

invitation 

doesn’t already 

have a record 

in CRM 

Outlook email 

in CRM for 

Outlook 

Select how 

email recipients 

are matched to 

Dynamics CRM 

records 

Address Book Select how 

email recipients 

are reconciled 

with Microsoft 

Dynamics CRM 

records 

All options 

More 

information: Set 

address book 

options in CRM 

for Outlook 

From Dynamics CRM for 

Outlook only 

Set the 

synchronization 

interval for 

updating your 

local data when 

you go offline 

Local Data Set how often 

to update local 

data 

Update local 

data every 

Note: You may 

not be able to 

change the 

interval if your 

administrator 

has restricted 

changes. 

From Dynamics CRM for 

Outlook only 

Select how 

duplicate 

records should 

be handled 

when going 

from offline to 

online 

Local Data Select how 

duplicate 

records should 

be handled 

during 

synchronization 

Enable 

duplicate 

detection 

during offline to 

online 

synchronization 

From Dynamics CRM for 

Outlook only 

 

 

 

Privacy notices 

To use Microsoft Dynamics CRM for Outlook, you are required to sign in by using your 

credentials (an email address and password). You may choose to save this information locally so 

that you are not prompted for your credentials each time you open Outlook. If you do choose to 

save this information locally, CRM for Outlook will automatically connect to Microsoft Dynamics 

CRM Online every time you open Outlook.  

 

 After the first time you sign in and use CRM for Outlook, the connection between your computer 

and CRM Online will always be open when you have access to the Internet. You may choose to 

turn off the connection between your computer and CRM only by using a configuration setting, 
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but if you do turn off the connection, CRM for Outlook may exhibit decreased performance.  

 

 If you use CRM for Outlook to track email, the email thread will be visible to users in your 

organization who have permission to view it.  

 

For every email you receive, CRM for Outlook will send CRM Online the sender’s email address, 

the recipient’s email address, and the subject line of the message. This allows CRM Online to 

validate whether or not a particular mail should be stored by the CRM Online service. When you 

track an item, a copy of that item will be maintained by the CRM service and will be visible to 

other users in your organization who have the appropriate permissions. When you untrack an 

item, that copy is automatically deleted from CRM Online only if you own the item. 

If you use Microsoft Dynamics CRM Online, when you use the Sync to Outlook feature, the CRM 

data you are syncing is “exported” to Outlook. A link is maintained between the information in 

Outlook and the information in CRM Online to ensure that the information remains current 

between the two. Outlook Sync downloads only the relevant CRM record IDs to use when a user 

attempts to track and set regarding an Outlook item. The company data is not stored on the 

device.  

 

 An administrator determines whether your organization’s users are permitted to sync CRM data 

to Outlook by using security roles. 

 

See Also 

Track Outlook email by moving it to a tracked Exchange folder 

Track Outlook email by choosing a button in CRM for Outlook 

Synchronizing data with Outlook or Exchange FAQ 

Set up email processing through server-side synchronization 

CRM App for Outlook User's Guide (lightweight app) 

Microsoft Dynamics CRM App for Outlook is a lightweight  app that you can use to view Microsoft 

Dynamics CRM information and track email from within Outlook on your desktop and phone. In 

Dynamics CRM App for Outlook, CRM data appears right in your Outlook Inbox. 
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You can use Dynamics CRM App for Outlook on any of the following: 

 Desktop (Outlook 2013, Outlook 2016, Outlook on the web, Microsoft Outlook for Mac) 

 Tablet (Windows 8.1, Apple iPad, and Android)  

 Phone (Windows Phone, Apple iPhone, and Android)  

Dynamics CRM App for Outlook is not the same thing as Dynamics CRM for Outlook. 

This topic discusses the differences between the two apps. 

 

 

On this page: 

What CRM App for Outlook offers 

How is Dynamics CRM App for Outlook different from Dynamics CRM for Outlook? 

Prerequisites for installing and using Dynamics CRM App for Outlook 

Install the app after it has been deployed 

Track an incoming email message from an unknown sender 

Preview information about a sender that’s already stored in CRM as a lead or contact 

Change the regarding record for a tracked email message 

Open a CRM record from CRM App for Outlook 

 

 

What CRM App for Outlook offers 

With Dynamics CRM App for Outlook, you can: 

 Tap the power of CRM while working in the familiar Outlook environment. 

Important  
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 Track incoming or outgoing email wherever you are, as long as you have access to a 

browser. 

 Link an incoming or outgoing email record to an existing record in CRM. For example, you 

might want to link an email message to a specific account or opportunity. If a record doesn’t 

exist, you can create it right from within the app! 

 Find out whether an email message is already tracked, and change the regarding record (the 

CRM record that the message is linked to). 

 Create CRM contact or lead records for people on the From list that aren’t already included 

in the CRM database. You can also create new CRM records for any entity (record type), as 

long as the entity has been enabled for mobile and for multi-entity search. 

 Preview information about contacts and leads stored in CRM. For example, you can find a 

number or company name for a contact or lead, or preview the last and next activities for a 

contact or lead. 

 Open CRM records directly to find or enter more detailed information. 

 

 

How is Dynamics CRM App for Outlook different from Dynamics CRM for 
Outlook? 

Dynamics CRM for Outlook (sometimes called the “Outlook client”) is a full-featured add-in for the 

desktop version of Microsoft Outlook. With Dynamics CRM for Outlook, you can do all your CRM 

work within the familiar Outlook interface. You can even work offline. Dynamics CRM App for 

Outlook, on the other hand, is a lightweight app that enables you to easily track email wherever 

you are. 

The following table contrasts Dynamics CRM App for Outlook with Dynamics CRM for Outlook: 
 

Feature Dynamics CRM App for 

Outlook 

Dynamics CRM for Outlook 

What you can track Email only Email, appointments, contacts, 

and tasks 

Works with Outlook on the web Yes No 

Works with Outlook for the 

desktop 

Yes Yes 

Open and create CRM records 

directly 

Yes Yes 

Apply custom forms and 

business logic 

Yes Yes 

Work offline No Yes 
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Apply CRM email templates, 

and attach sales literature or KB 

articles 

No Yes 

Sort, filter, format, group, and 

categorize lists (views) 

No Yes 

Create Word mail-merge 

documents 

No Yes 

Control field synchronization No Yes 

 

 

 

For more information on Dynamics CRM for Outlook capabilities, see the CRM for Outlook User's 

Guide (full app) 

 

 

Prerequisites for installing and using Dynamics CRM App for Outlook 

Your CRM system administrator must deploy Dynamics CRM App for Outlook to your 

organization before you can access it. To deploy Dynamics CRM App for Outlook: 

 Your organization must use CRM Online, and CRM Online 2015 Update 1 or later must be 

installed. 

 Your organization must use Exchange Online for email processing. 

 Your organization must synchronize email through server-side synchronization. 

 Your organization must synchronize appointments, contacts, and tasks through server-side 

synchronization. 

 The system administrator must set up specific security roles. 

 The system administrator must add Dynamics CRM App for Outlook to your Exchange Online 

service. 

For more information, see the following topics on TechNet: 

 Add and enable CRM App for Outlook 

  Set up server-side synchronization 

 

 

Supported browsers for Outlook on the web 

You can use Dynamics CRM App for Outlook with Outlook on the web on the following browsers: 

 Internet Explorer 10, Internet Explorer 11, or Microsoft Edge 

 Google Chrome version 41 or later 

 Firefox version 40 or later 

https://technet.microsoft.com/library/dn946901.aspx
https://technet.microsoft.com/library/dn531109.aspx
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 Apple Safari version 6 or later 

 

 

Supported operating systems for desktop Outlook  

 You can use Dynamics CRM App for Outlook with Outlook 2013 and Outlook 2016 on 

Windows 7, Windows 8, Windows 8.1, or Windows 10. 

 You can use Dynamics CRM App for Outlook with Outlook for Mac on Mac OS X Mavericks 

or Yosemite. 

 

 

Accessing Dynamics CRM App for Outlook after it’s been deployed 

After Dynamics CRM App for Outlook has been deployed by a system administrator, the app 

appears as a Dynamics CRM tab in the Outlook reading pane. Just click the tab to access your 

CRM data. 
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If you don’t see the Dynamics CRM tab, you need to enable the app. 

If you’re using desktop Outlook: 

1. Click File > Manage Apps. 

2. Sign in, click General > Manage add-ins, and then select the check box for Dynamics CRM. 

If you’re using Outlook on the web: 

1. Click the Settings menu  > Manage add-ins. 

2. Click General > Manage add-ins and select the check box for Dynamics CRM. 

 
 

Install the app after it has been deployed 

After the app has been deployed by your administrator, you can install it directly from Microsoft 

Dynamics CRM. If you’re not sure whether it has already been deployed, contact your 

administrator.  

1. Click the Settings icon , and then click Apps for Dynamics CRM.  

2. On the Apps for Dynamics CRM page, under Dynamics CRM App for Outlook, click 

Add app to Outlook. 

Track an incoming email message from an unknown sender 

1. Select the email message in your Inbox, and then click the Dynamics CRM tab. 

When an email message is from an unknown sender (the sender isn’t already a contact 

or lead in CRM), you’ll see the following screen: 

 

 

Install the app 
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2. Click Create new contact. 

3. The First Name, Last Name, and Email fields are already filled in for you. The Phone 

Number field will be filled in if it’s available. 

In the Create Contact form, fill in other fields (as much or as little as you like), and then 

click Save when you’re done entering info, or click Edit to open the CRM contact form to 

enter more details. 
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Note  

If you want to enter information for a lead instead of a contact, don’t fill in any 

information in the Create Contact form. You can track the email regarding a new 

lead instead. Skip to the next step to learn how. 

When you click Save in the Create Contact form, the app displays contact card 

information, as well as empty sections for Next Activity, Last Activity, and the first two 

lists on the contact form. By default, these lists are Case Associated View and 

Opportunity Associated View. These sections are empty because the contact doesn’t 

have any related records in CRM yet. 
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4. To track the email, click Track. 

 
 

5. Do one of the following: 

 If you don’t want to link the email message to an existing CRM record, click Or, track 

without setting a regarding record. 

 

 

 
 

 

 

 To link the email message to an existing record in CRM, in the search box, enter a keyword 

(for example, a company name), click Lookup , and then select one of the records in the 

resulting list. 

 



 

 
372 

 

 
 

 

 

When you select a record, the record appears next to To be tracked regarding. To 

open the record in CRM, click the link. 

 

 

 
 

 

 

Note  

When you click Track, syncing with CRM can take up to 15 minutes. If 

syncing doesn’t occur after 15 minutes, ask your administrator to verify that 

server-side synchronization is working for sending and receiving email from 

CRM. 

 To create a new record in CRM (for example, to create a lead record instead of a 

contact record) and link it to the email activity record:  

i.  .i. Click New  next to any enabled entity.  

ii. In the quick create form, fill out the fields. 

iii. Click Save to save the record if you’re done adding information. To enter more 

detailed information, click Save and edit in CRM. 
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Note  

The entities shown on the tracking page have been enabled for mobile and 

enabled for multi-entity search. For more information on enabling entities, 

see TechNet: Entities and CRM for phones and CRM for tablets. 

 

 

Preview information about a sender that’s already stored in CRM as a lead 
or contact 

 Select the email message in your Inbox, and then click the Dynamics CRM tab. 

The information you’ll see includes:  

 Contact information about the person (lead or contact) the email message is from 

 Next and last activities 

 Other related records, which include records from lists on the associated entity’s main 

form 

The related records you see may vary based on whether your system has been 

customized. Dynamics CRM App for Outlook displays two records from each view. If 

you want to see all records related to a contact or lead, click the contact or lead name 

in the contact card. 

 
 

Note  

https://technet.microsoft.com/library/dn531128.aspx#BKMK_PhoneEntities
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Change the regarding record for a tracked email message 

1. Open the email message, and then click the Dynamics CRM tab. 

2. Click Change. 

 

 

 
 

3. Do one of the following: 

 To untrack the record, click Or track without setting a regarding record. 

 To select a different CRM record, enter a keyword (for example, a company name) in the 

search box, click Lookup , and then select a record from the results list. 

 To create a new record in CRM and link it to the email activity record: 

i. Click New  next to any enabled entity. 

ii. In the quick create form, fill out the fields. 

iii. Click Save to save the record if you’re done adding information. To enter more 

detailed information, click Save and edit in CRM. 

 

 

Open a CRM record from CRM App for Outlook 

You can open CRM forms directly for contacts and other records. To open CRM records, click 

any of the following links: 

 The name of the lead or contact 

 The Pop Out button  

 The name of the regarding record (once the email has been tracked) 

 Any record or activity tile 

 

 

See Also 

TechNet: Add and enable CRM App for Outlook 

TechNet: Set up server-side synchronization 

CRM for Outlook User's Guide (full app) 

 

https://technet.microsoft.com/library/dn946901.aspx
https://technet.microsoft.com/library/dn531109.aspx
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Go mobile 

 

Get started with CRM for phones and tablets 

Admin and troubleshooting for CRM for phones and tablets 

Get started with CRM for phones express 

Get started with CRM for phones and tablets 

 

Install CRM for phones and tablets 

Sign in to CRM for phones and tablets 

Sign out of or reconfigure CRM for phones and tablets 

Work offline in CRM for phones and tablets 

Get around in CRM for phones and tablets 

Track your progress with charts in CRM for phones and tablets 

Pin your favorites in CRM for phones and tablets 

Email and call customers in CRM for phones and tablets 

Search in CRM for phones and tablets 

Manage accounts, contacts, leads, and opportunities in CRM for phones and tablets 

Manage activities in CRM for phones and tablets 

Nurture leads through the sales process in CRM for phones and tablets 

Track customer service cases in CRM for phones and tablets 

Use Cortana voice commands in CRM for phones 

Get help for CRM for phones and tablets 

Install CRM for phones and tablets 

 

Keep track of your contacts, leads, and activities on the go with the Microsoft Dynamics CRM for 

phones and Microsoft Dynamics CRM for tablets apps. You get the same intuitive experience on 

both your phone and tablet. 

First things first: Is your mobile device supported? 

If your CRM admin already told you your device can run CRM for phones or tablets, you’re good 

to go. If you’re not sure— 

Check the list of supported devices on TechNet  

Install the app from your device’s app store 

https://technet.microsoft.com/library/dn531131.aspx
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Choose the download link for your device: 
 

CRM for phones app 

 

 

 

CRM for tablets app 

 

 

 

 

Looking for a different version of the CRM for phones app? 

If your organization isn’t ready to use the latest CRM for phones app, you can still use the earlier 

version, which is now called CRM for phones express. CRM for phones express is only supported 

for versions of CRM earlier than Microsoft Dynamics CRM Online 2016 Update and Microsoft 

Dynamics CRM 2016 (on-premises). 

Get CRM for phones express  

Having trouble with your app? 

If you’re having trouble with your mobile app, it’s a good idea to contact your IT department. If you 

want to do some troubleshooting on your own, try these resources: 

 Start up error on a tablet   If you got an error while starting CRM for tablets that looks like 

this: “Additional steps may be needed to configure Microsoft Dynamics CRM for this 

organization. Please contact your system administrator,” you need to notify your CRM 

administrator that you received this error. 

If you’re an admin trying to diagnose this error, see Troubleshoot a CRM for Windows app 

start-up error. 

 The app’s not working well on your device   If your app isn’t working well on your mobile 

device, be sure to check the compatibility information in TechNet: Support for CRM for 

phones and CRM for tablets. 

 Something else is wrong   For all other problems, see TechNet: Troubleshooting and things 

to know about CRM for phones and tablets. 

Microsoft Dynamics CRM for phones is available for Microsoft Dynamics CRM Online 

2015 Update 1 and later and Microsoft Dynamics CRM 2016 on-premises or later. If your 

organization hasn’t yet updated, you can still use the previous version of the phone app, 

Microsoft Dynamics CRM for phones express. More information: Get started with CRM 

for phones express. 

 

  

  

 User’s Guide 

Sign in  

  

Note  

get-started-with-crm-for-phones-express.aspx
https://technet.microsoft.com/library/dn531131.aspx
https://technet.microsoft.com/library/dn531131.aspx
https://technet.microsoft.com/library/dn660982.aspx
https://technet.microsoft.com/library/dn660982.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
sign-in-to-crm-for-phones-and-tablets.aspx
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Privacy notice 

Licensed Dynamics CRM Online users with specific Security Roles (CEO – Business Manager, 

Sales Manager, Salesperson, System Administrator, System Customizer, and Vice President of 

Sales) are automatically authorized to access the service by using CRM for tablets, as well as 

other clients.  

 

 An administrator has full control (at the user security role or entity level) over the ability to access 

and the level of authorized access associated with the tablet client. Users can then access CRM 

Online by using CRM for tablets, and Customer Data will be cached on the device running the 

specific client.  

 

 Based on the specific settings at the user security and entity levels, the types of Customer Data 

that can be exported from CRM Online and cached on an end user’s device include record data, 

record metadata, entity data, entity metadata, and business logic. 

 

See Also 

Mobile CRM User’s Guide 

TechNet: Phone and tablet support 

Sign in to CRM for phones and tablets 

 

Now that you’ve installed your app, let’s get started! First, you need to sign in. You’ll need your 

Microsoft Dynamics CRM web address, user name, and password. If you don’t have any of these, 

contact your CRM admin. 

Find your CRM administrator or support person  

  

1. Open your app, type in your CRM web address, and tap . 

  

 

  

2. On the next screen, type in your user name and password, and tap Sign in. 

A few basic navigation tips appear while your app starts up. Be sure to stay on this screen while 

your app starts up so any changes can download successfully to your device. If you switch to 

another app during this time, the processing will restart when you open this one again. 

Microsoft Dynamics CRM for phones is available for Microsoft Dynamics CRM Online 

2015 Update 1 or later, or Microsoft Dynamics CRM 2016 on-premises or later. If your 

Note  

crm-for-phones-and-tablets-user-s-guide.aspx
https://technet.microsoft.com/library/dn531131.aspx
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organization hasn’t yet updated, you can still use the previous version of the phone app, 

Microsoft Dynamics CRM for phones express. More information: Get started with CRM 

for phones express 

 

  

  

 Install the app 

Work offline  

See Also 

Mobile CRM User’s Guide 

Sign out of or reconfigure CRM for phones and tablets 

If you share a tablet with another person, or if you need to sign in to a different organization or 

CRM server (for example, if you need to sign in to a test installation), you don’t have to uninstall 

and reinstall the CRM for phones and tablets app. You can use either the sign out or the 

reconfigure options instead. 

Sign out of the CRM for tablets app 

If you share a tablet with another person, this is the option you should use so you can sign out 

and another person can sign in. 

1. From your Home page, tap . 

2. Tap Settings. 

3. Tap Sign Out. 

You can sign in again as the same or different user, or you can sign in to a different organization. 

Reconfigure the CRM for tablets app 

If you’re an admin, tester, or trainer, this is most likely the best option for you, so you can sign into 

a different environment, like a CRM sandbox installation. 

1. Tap . 

2. Tap Settings. 

3. Tap Reconfigure. 

You can now sign in to a different server or organization. 

What’s the difference between sign out and reconfigure? 

Sign out 

Signing out deletes data and authentication tokens from the cache, and it also deletes 

cookies on iPad and Android tablets. Signing out doesn’t delete metadata. This means that if 

a user signs in again after signing out, a metadata sync is not required before using the 

application again, which can save a few minutes when you sign in. 

install-crm-for-phones-and-tablets.aspx
work-offline-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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CRM for tablets makes a best effort to delete data and authentication tokens from the 

cache; it is not guaranteed that this will occur in every situation. 

Reconfigure 

Reconfiguring deletes all data and metadata from the cache. 

If you sign out from one organization and sign in to another, and use the Reconfigure option 

on the second one, your metadata will still remain for the first organization. If you want to 

remove your metadata from the first one, you’ll need to sign in to it and use the Reconfigure 

option there, as well. 

CRM for tablets makes a best effort to delete data and metadata from the cache; it is 

not guaranteed that this will occur in every situation. 

A note about pinned tiles 

If you’re using a Windows 8 or Windows 8.1 phone or tablet and had pinned tiles on your 

Start screen, those tiles will remain whether you use the Sign Out or Reconfigure option. 

These tiles will only work for users who have access to that record or view, however. For 

example, if you sign in as user1 from org1 and pinned a tile to Start, someone who signs in 

as user2 from org2 and taps that tile will receive an error message saying the record isn’t 

available. 

 

  

  

 Work offline 

Get around  

  

  

See Also 

Mobile CRM User’s Guide 

Work offline in CRM for phones and tablets 

horizontaltabbed 

How to 

Stay productive when your phone doesn’t have service, or when your tablet’s not connected to 

the Internet. The mobile apps keep records that you’ve used recently, so you can still access 

them when you’re disconnected. 

Caution  

Caution  

work-offline-in-crm-for-phones-and-tablets.aspx
get-around-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx


 

 
380 

You can also capture new information by creating drafts of new records like accounts, contacts, 

and activities. When you’re connected again, save the records that you created while you were 

offline. 

Your offline experience might look a little different than when you’re connected, because charts 

and some images aren’t available offline. 

Reconnect your device to CRM 

Once you have phone service or Internet again, tap the offline indicator on your device to 

reconnect. 

  

 

  

You’ll need to save your drafts to make them available in the CRM system. 

Save your drafts to make them available 

You can view and create records as you normally would, but your records are saved as drafts. 

Once you’re reconnected, the app tells you that you have unsaved drafts. Be sure to review and 

save them as soon as you can. Any drafts you don’t save are only available to you on your mobile 

device. 

1. From the menu, tap Draft Records. 
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2. Select each record individually, review the record and make any necessary changes, and 

then tap Save. 

A few limitations for creating draft records 

There are a few things you should know about working with offline drafts in the mobile apps: 

 While offline, you can only create new records. To edit existing records, you need to be 

connected. However, you can edit records that you created while you were offline. 

 While disconnected, you can only create standalone records or associate records to those 

that are available for offline access on your device. For example, you can create an 

opportunity for an account only if that account was created before you went offline, and if it’s 

available for offline access. You can’t create an opportunity for an account while offline if you 

also created the account while offline. 

 When you’re offline, you can’t set the value for lookup fields. If you create a record that is 

associated with another record, such as adding a phone call to a contact, some lookup fields 

might populate automatically (in this case, the To and From fields might pre-populate). You 

need to fill these fields in once you re-connect while you review and save your drafts. 

About cached data on your device 

The records you’ve recently used are kept on your mobile device, and are also known as cached 

data. Cached data is specific to your device, so if you use both the phone and tablet apps, the 

cached data on each device will be different, depending on the records you’ve viewed on each 

one. 
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Cached data is not encrypted. You can use BitLocker to encrypt the entire hard drive on 

a Windows 8 or Windows 10 device. 

If you’re prompted to sign in while you’re disconnected 

If you’re prompted to sign in to CRM while you’re disconnected, and if you tap the Back button on 

the sign-in page, you’ll still be able to work in offline mode on iPad and Windows 8 tablets until 

you can reconnect. On all phones and Android tablets, however, you can no longer work in offline 

mode and will be redirected to the Let’s get started page until you can reconnect and sign in 

again. 

Working offline with on-premises CRM deployments 

If you’re using your CRM for tablets app with Microsoft Dynamics CRM 2015 (on-premises) or 

later, you can continue to use CRM for tablets while disconnected. However, with the Windows 8 

app, once you close CRM for tablets (like when you start another app), you can’t use CRM for 

tablets until you can connect to the Internet. With the Windows 8.1 app, you can continue to 

access your data even if you close the app. If you’re not sure whether your organization has an 

on-premises deployment, contact your CRM admin to find out. 

Find your CRM administrator or support person  

  

  

Before installing the Windows 8.1 app, you need to make sure that your organization is 

ready for you to install it. If your organization isn’t ready, you can still use the Windows 8 

app on a Windows 8.1 tablet. 

Install the Windows 8 app on your tablet  

 

  

  

 Sign in 

Sign out  

Watch the video 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

See Also 

Mobile CRM User’s Guide 

Warning  

Note  

http://go.microsoft.com/fwlink/p/?LinkID=313642
sign-in-to-crm-for-phones-and-tablets.aspx
sign-out-of-or-reconfigure-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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Get around in CRM for phones and tablets 

horizontaltabbed 

How to 

When you first sign in to CRM for phones and tablets, you’ll see your home page for CRM for 

tablets, which provides a quick overview of your CRM data, including different views and charts. 

Navigation is intuitive, and it’s easy to view or create new records right from your Home screen or 

dashboard. Just swipe left and right to view more items. 

Display the menu 

When you want to view all of your accounts, contacts, leads, or other records, use the menu. 

Tap the menu icon on the top of the page (on the right in the phone app, and on the left in the 

tablet app), and then select the type of record you want to work with. 

 

Display the command bar 

You can add a new record, change views, or do other tasks from the command bar. 

Just tap  on the bottom right-hand corner of the page. 

You can also press and hold an item to display the command bar. 

 
 

  

The command bar is context-sensitive, and the available commands change depending on where 

you are in the app. When you display the command bar for a specific item (when you press and 

hold the item), the commands that appear are relevant to that item. 

Switch to a different dashboard 

If you want to use a different dashboard, it’s easy to switch back and forth. 

Tap Dashboards in the menu and then select the dashboard you want to use. 

When you want to go back to your Home screen, tap Home. 

To create new dashboards in CRM and enable them for use in CRM for phones and tablets, see 

Create a dashboard. 

Use your browser if you need a feature not in the CRM for tablets app 

The following features in the web application aren’t available in CRM for phones and tablets: 

 Yammer and activity feeds 

 Bing Maps integration 

 Parature, from Microsoft knowledge base integration 

If you need to use these features or want to view a record in the web application, you can do that 

in your tablet’s browser. (You can only do this in the tablet app.) 

create-a-dashboard-aspx
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1. Press and hold the record or view you want to see. 

2. Tap Open in browser. 

3. Sign in to the web application when it appears. The web app goes right to the record that 

you were working on in the mobile app. 

A note about using the mobile app on Android tablets 

Navigation on Android tablets is a little different than on iPad or Windows tablets. 

When you scroll on an Android tablet by swiping left or right, the app scrolls a whole page at a 

time instead of a partial page. You can also use the arrow buttons at the bottom of the screen to 

scroll left or right. 

 
 

Depending on where you are in the app, the Android  Back button takes you to the previous form, 

cancels dialog boxes or error messages, closes the keyboard, or performs other actions 

depending on context. 

 

  

  

 Sign out 

Manage records  

Watch the video 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

See Also 

Mobile User’s Guide 

 

sign-out-of-or-reconfigure-crm-for-phones-and-tablets.aspx
manage-accounts-contacts-leads-and-opportunities-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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Track your progress with charts in CRM for phones and tablets 

horizontaltabbed 

How to 

Your charts give you a quick view of how you’re tracking to your goals. They’re interactive, so you 

can tap an area of a chart to see the data for that area, or you can tap the area outside the chart 

to see the data for the entire chart. In the phone app, swipe left and right to view the chart and its 

associated records. 

 

Tap any of the records to see more information. 

Change the chart view 

Changing the chart view shows you a different breakdown of your data, such as opportunities 

opened within a specific time period. 

1. On the command bar, tap Select View. 

 
 

  

2. Select the view you want. 
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Show a different chart 

You can change the chart to show data for a different type of record in much the same way. 

1. Tap Select Chart on the command bar. 

2. Select the chart you want to display. 
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 Search 

Manage activities  

Watch the video 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

See Also 

Mobile User’s Guide 

Pin your favorites in CRM for phones and tablets 

horizontaltabbed 

How to 

Pinned tiles provide quick access to your records, contacts, views, and dashboards. You can pin 

as many tiles as you want to the Pinned Tiles section of your Home screen or to the Start screen 

or menu of Windows 8 and Windows 10 devices. 

With Microsoft Dynamics CRM 2015 or later, you can also pin dashboards to your Home screen 

or to the Start screen of Windows 8 and Windows 10 devices. 

Press and hold the item you want to pin, or display the command bar while viewing a record, and 

then tap Pin to Home. 

 
 

Create a communication card 

Communication cards provide a quick way to email or call your contact just by tapping the email 

address or phone number on the card. Communication cards appear on contact forms, but you 

can also create a communication card from a contact in the Pinned Tiles section of your Home 

screen by expanding the pinned tile. 

search-in-crm-for-phones-and-tablets.aspx
manage-activities-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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Press and hold a contact tile that’s pinned to the dashboard, and then tap Larger on the 

command bar. 

  

 
 

 

  

  

 Sales process 

Email and call  

Watch the video 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

See Also 

Mobile User’s Guide 

Email and call customers in CRM for phones and tablets 

horizontaltabbed 

How to 

Call or send email to your customers easily from the mobile apps. Tap any phone number in a 

record to start a call, or on the communication card for a contact, tap the email button to send an 

email, or the phone button to start a call. 

 

In CRM for tablets, tapping the phone button starts a Skype call. In CRM for phones, it starts a 

phone call. 

When you’re finished with your call, the app prompts you to enter details about the call. If you’re 

using a Windows 8 or later tablet, you can enter details while you’re on the call, because Skype 

snaps to the screen next to the CRM for tablets app. 

 

  

nurture-leads-through-the-sales-process-in-crm-for-phones-and-tablets.aspx
email-and-call-customers-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx


 

 
389 

  

 Pin your favorites 

Search  

Watch the video 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

See Also 

Mobile CRM User’s Guide 

Search in CRM for phones and tablets 

horizontaltabbed 

How to 

To launch a search, tap  on the top of the page, type one or more letters in the search box, and 

tap  next to the search box. The following image shows where you can find search in Microsoft 

Dynamics CRM for phones.  

pin-your-favorites-in-crm-for-phones-and-tablets.aspx
search-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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Search results include only records that begin with the letters you type. For example, if you want 

to search for “Alpine Ski House,” type alp in the search box. If you type ski, the record won’t 

show up. 
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Although you can use wildcard characters in your search (such as *ski), it’s best to avoid 

wildcards due to possible performance issues. 

Filter search results 

To filter results by record type, choose a record type from the Filter with: drop-down box. 

 
 

 

  

  

 Email and call 

Use charts  

Watch the video 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

 

 

See Also 

Mobile CRM User’s Guide 

Manage accounts, contacts, leads, and opportunities in CRM for phones 
and tablets 

horizontaltabbed 

How to 

As a sales professional, you’ll be working a lot with the following types of records: 

 Accounts   Account records contain information about the companies you do business with. 

Important  

email-and-call-customers-in-crm-for-phones-and-tablets.aspx
track-your-progress-with-charts-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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 Contacts   Contact records contain information about the people you know and work with. 

Usually, multiple contacts are associated with one account. Contacts could include people 

responsible for making purchasing decisions, people in charge of paying invoices, support 

technicians, or anyone you work with at the company. 

 Leads   Leads are potential sales, and you or your company can get leads from many 

different sources. For example, you can generate sales leads from marketing campaigns, 

inquiries from your website, mailing lists, social media posts, or in person at a trade 

convention. 

 Opportunities   When you qualify a lead, it becomes an opportunity, or a deal that you’re 

getting ready to close. 

CRM is easy to customize to match the way your organization does business, so it’s possible you 

might see different types of records in your CRM system. 

Here are a few quick tips to view, add, or change records in CRM for phones and tablets. 

Work with records on the dashboard 
 

To do this: Do this: 

View all the records for a record type on the 

dashboard in CRM for tablets (for example, 

Leads). 

Tap the header of the list. This opens your 

records in a grid view on your tablet. 

Open the form for a record on the dashboard. Tap the record. 

Create a new record from the dashboard. Tap the + on the right side of the header of the 

type of record you want to create (for example, 

My Activities). 

 

Change views for a list on the dashboard 

 In CRM for tablets, press and hold the name of the list and tap Select View on the 

command bar. 

 In CRM for phones, tap … and tap Select View on the command bar. 

Create or edit stakeholders or sales team members 

1. In Stakeholders or Sales Team for a lead or opportunity, tap the New Item button +. 

2. Enter a contact name to look up in the dropdown that appears. 

3. Either select from the contacts that appear or, if it’s a new contact, tap the Add button 

and complete the information in the form that appears. 

4. Select a role for the contact. 
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Resize columns 

You can resize columns in a grid in the CRM for tablets app, and the app will remember your 

settings the next time you view that grid. 

1. On the command bar, tap Resize Columns. 

2. Drag the column handles that appear above the grid to the width you want. 

 
 

 

Sort items 

You can also sort items in a grid in the CRM for tablets app: 

 To sort in ascending order by a column, tap that column’s header. 

 To sort in descending order, tap the column’s header again. 

 

  

  

 Get around 

get-around-in-crm-for-phones-and-tablets.aspx
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Sales process  

Export records to Excel 

In Microsoft Dynamics CRM for phones and CRM for tablets, you can export records to Microsoft 

Excel, just like you can in the web app. From a grid view in CRM for tablets or a list of records in 

CRM for phones, tap … to open the command bar and then tap Export to Excel. 

 

More information: Export data to Excel 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

Email a link to a page from your app 

Want to share information about a client with one of your colleagues while you’re out on the road? 

Email a link to a page. From any page in your mobile app, tap … to open the command bar and 

then tap Email Link. 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

View SharePoint and OneDrive documents in CRM for phones and tablets 

If your organization has set up SharePoint integration with CRM, you can open your SharePoint 

documents (including OneDrive documents) from the mobile apps. Just tap the Documents tile to 

open a list of the documents associated with the record you’re viewing, and then tap the 

document in the list to view it. 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

Watch the video 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

See Also 

Mobile User’s Guide 

Manage activities in CRM for phones and tablets 

 

Important  

Important  

Important  

nurture-leads-through-the-sales-process-in-crm-for-phones-and-tablets.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
crm-for-phones-and-tablets-user-s-guide.aspx
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Use activities to keep track of all your customer communications. For example, during the course 

of a sale, you might send emails, make phone calls, set up appointments, or assign tasks. All of 

these are considered activities, and the CRM for phones and tablets apps help you track them so 

you don’t miss an important follow-up activity. 

On your dashboard, My Activities shows your activities that are past due or due today in a 

darker color than those that aren’t. You can do the following from your activity feed: 

 To view an activity, select it from your My Activities feed on the dashboard. 

 To add an activity, tap + at the top of your My Activities feed. 

 To mark an activity complete, tap the check box next to the activity in the feed. 

 To see a subset of your activities: 

 On a tablet, press and hold My Activities and tap Select View on the command bar. 

 On a phone, tap Select View on the command bar. 

 

 

  

  

 Use charts 

Track customer service cases  

See Also 

Mobile User’s Guide 

Nurture leads through the sales process in CRM for phones and tablets 

horizontaltabbed 

How to 

Move customers through the sales process, from lead to close, with the process bar in the CRM 

for phones and tablets apps. You complete each step in the process by entering data or marking 

a step complete in the process bar. When you’ve completed all the steps in one stage, you can 

move on to the next one. The process bar highlights the stage you’re in so you know where you 

are in the process, and shows you what to do next. 

  

Track-your-progress-with-charts-in-crm-for-phones-and-tablets.aspx
track-customer-service-cases-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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For example, in the preceding illustration, you start the process with a lead. In the first stage 

(Qualify), you qualify or disqualify the lead based on criteria established by your company. If you 

qualify the lead, it’s converted to an opportunity. The process bar then walks you through the rest 

of the stages: Develop, Propose, and Close. 

The process bar helps you and everyone on your sales team follow best practices. The process 

bar that your company uses might have different stages than the one illustrated, to match the way 

you do business. 

Qualify a lead 

To qualify a lead and convert it to an opportunity, tap Qualify on the command bar.  

Disqualify a lead 

To disqualify and close a lead, tap Disqualify on the command bar and then select a reason. 

Re-open a lead you thought wasn’t interested 

To reopen a closed lead, tap Reopen Opportunity on the command bar. 

 

  

  

 Manage records 

Pin your favorites  

Watch the video 

 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MgvdfRkVheY" 

frameborder="0" allowfullscreen></iframe> 

See Also 

Mobile User’s Guide 

manage-accounts-contacts-leads-and-opportunities-in-crm-for-phones-and-tablets.aspx
pin-your-favorites-in-crm-for-phones-and-tablets.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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Track customer service cases in CRM for phones and tablets 

 

As a Customer Service Manager, use the CRM for phones and tablets app to keep track of 

activities in your customer service organization while on the go. The app's dashboard lets you 

track your team's performance, monitor high priority cases, and route cases from your mobile 

device. 

Open a case in the web app to work on it in more detail 

If you need to perform more actions on a case than you can in the mobile app, you can easily 

open the case in your browser. 

1. On the case screen, open the command bar. 

2. Tap Open in browser. 

3. Sign in to the web application when it appears. The web app goes right to the case you 

had open in the mobile app. 

Differences in the customer service area between the web app and the mobile apps 

CRM for phones and tablets is optimized for Customer Service Managers who are always on the 

move and need to keep track of activities in their customer service organization. Due to these 

optimizations, the service areas in the mobile apps have a different appearance and functionality 

than the web app in some cases, as shown in the following table. 
 

Web app feature Difference in the mobile apps 

Merge cases Not available. 

KB article lookup Not available (appears as locked in the app). 

Queue filter in Queue Items list Not available. However, you can change the 

view so that it filters items by queues. More 

information: TechNet: Customize CRM for 

phones and tablets 

Queue Item Details button on forms for items 

that you can route to a queue; for example, 

cases 

Not available. 

Similar Cases area on the case form Not available. 

Customer contact card on the case form Tap the customer name on the case form to 

view the customer record and communication 

card. 

Case origin icons on the Cases list The Cases list shows the list of cases without 

the icons. The case origin appears on the 

 

https://technet.microsoft.com/library/dn531159.aspx
https://technet.microsoft.com/library/dn531159.aspx
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Web app feature Difference in the mobile apps 

individual case form. 

Subject lookup in Case Details area Instead of selecting from a tree view, type in 

letters to start a search. 

Find Case step in Identify, Similar Cases step 

in Research, and Resolve Case step in 

Resolve case business process flow 

These actions don’t appear in the case 

process. However, to resolve a case, you can 

use Resolve in the command bar. 

Entitlement lookup You can’t filter results in entitlement lookup. 

Parature, from Microsoft knowledge base 

integration 

Not available in the mobile apps. 

 

 

  

  

 Manage activities 

Use Cortana voice commands  

See Also 

Mobile CRM User’s Guide 

Use Cortana voice commands in CRM for phones 

 

 

 

You can use the following CRM voice commands with Cortana if you’re using Cortana on 

Windows 8.1 phones or later. Cortana voice commands for CRM are only available in English at 

this time. 

These commands work with either the CRM for phones app or the previous phone app, CRM for 

phones express. 
 

To do this in CRM Say this 

Open an item CRM open <item> called <item name>. 

Example: 

“CRM open account called Contoso.” 

Variation: 

“CRM open account named Contoso.” 

manage-activities-in-crm-for-phones-and-tablets.aspx
use-cortana-voice-commands-in-crm-for-phones.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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To do this in CRM Say this 

 

Show a view CRM show <view name>. 

Example: 

“CRM show my active accounts.” 

Variation: 

“CRM show me my active accounts.” 

Search for an item CRM find <item> called <name>. 

Example: 

“CRM find account called Contoso.” 

Variation: 

“CRM find account named Contoso.” 

Create a new item CRM create <item type> called <item name>. 

Example: 

“CRM create contact called Maria Campbell.” 

Variation: 

“CRM add new contact named Maria 

Campbell.” 

Create a phone call activity CRM remind me to call <call name>. 

Example: 

“CRM remind me to call Maria Campbell to set 

up appointment.” 

Create an appointment CRM schedule meeting to <subject>. 

Example: 

“CRM schedule meeting to discuss quote with 

Maria Campbell.” 

Create a task CRM remind me to <task name>. 

Example: 

“CRM remind me to email Maria Campbell.” 

Variations: 

“CRM follow up Maria Campbell.” 

“CRM follow up with Maria Campbell.” 

“CRM follow up on Contoso.” 

Open task list CRM what should I do next? 
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To do this in CRM Say this 

Example: 

“CRM what should I do next?” 

 

 

The create commands work only with Microsoft Dynamics CRM 2015 and Microsoft 

Dynamics CRM Online 2015 Update or later. The other commands work with Microsoft 

Dynamics CRM 2013 and Microsoft Dynamics CRM Online as well as Microsoft 

Dynamics CRM 2015 and Microsoft Dynamics CRM Online 2015 Update or later. 

For more information about using Cortana, see Meet Cortana. 

 

  

  

 Track customer service cases 

Get help  

  

  

Privacy notice 

Cortana does not have access to the data stored in the CRM database. Cortana only captures 

your voice commands. When you make a voice command through Cortana, in order to both 

understand the request and improve Microsoft speech recognition-related products and services, 

Microsoft uses proprietary technologies such as, for example, acoustic and natural language 

processing models to record and interpret your user’s request. Voice-dictated Bing search 

queries are treated like other text-based search requests and may be used to improve Bing 

search results; however, the CRM-voice-dictated commands listed here are not used to provide 

advertising. For more information about privacy and Cortana, see Cortana and my privacy FAQ.  

 

 If you are an administrator, you can manage enterprise access to Cortana with the 

PolicyManager configuration service provider through a separate device management service. 

The policy for this is set at the phone level and can’t be set just for the CRM for phones app. For 

more information, see the MSDN topic PolicyManager configuration service provider. 

See Also 

Mobile User’s Guide 

Meet Cortana 

Get help for CRM for phones and tablets 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=401573
track-customer-service-cases-in-crm-for-phones-and-tablets.aspx
get-help-for-crm-for-phones-and-tablets.aspx
http://www.windowsphone.com/en-us/how-to/wp8/cortana/cortana-and-my-privacy-faq
https://msdn.microsoft.com/library/dn499739.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
http://go.microsoft.com/fwlink/p/?LinkID=401573
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Get help while using the app 

If you ever need to get help while you’re in the mobile app, just tap Help on the command bar.  

Get deployment and troubleshooting help 

If you’re an admin looking for resources to help you set up or troubleshoot CRM for phones and 

tablets, try these resources: 

TechNet: Set up CRM for phones and tablets 

TechNet: Set up CRM for phones express 

TechNet: Create and edit mobile forms 

TechNet: Troubleshoot problems with CRM for tablets 

TechNet: Troubleshoot problems with CRM for phones express 

Troubleshoot a CRM for Windows app start-up error 

 

  

  

 Use Cortana voice commands 

See Also 

Mobile CRM User’s Guide 

Admin and troubleshooting for CRM for phones and tablets 

 

Customize CRM for phones and tablets 

Use InTune management with the CRM mobile apps 

Secure your mobile data with Microsoft Dynamics CRM for Good 

iFrame and web resource support in CRM for tablets 

Troubleshoot a CRM for Windows app start-up error 

Troubleshoot error code 800c0019 on Windows Phones 

Customize CRM for phones and tablets 

With Microsoft Dynamics CRM, you can design once and deploy everywhere. You customize the 

interface for the mobile apps while you’re in the web app. Changes you make to dashboards or 

forms in the web app can also appear in the mobile apps. 

To see how you can customize the home page, forms, and entities that display in the mobile 

apps, see TechNet: Customize CRM for phones and tablets. 

https://technet.microsoft.com/library/dn531128.aspx
https://technet.microsoft.com/library/dn531085.aspx
https://technet.microsoft.com/library/dn531080.aspx
https://technet.microsoft.com/library/dn660982.aspx
https://technet.microsoft.com/library/dn660977.aspx
use-cortana-voice-commands-in-crm-for-phones.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
https://technet.microsoft.com/library/dn531159.aspx
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Use InTune management with the CRM mobile apps 

You can use Microsoft Intune to manage Microsoft Dynamics CRM for phones and CRM for 

tablets on Apple and Android tablets and phones. Intune provides mobile device management, 

mobile application management, and PC management capabilities from the cloud. 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

For more information about using CRM for phones and CRM for tablets with Intune, see Secure 

and manage CRM for phones and tablets. 

If your device and CRM mobile app is managed by Intune, you may be prompted to sign 

in to Intune, enter a PIN when you start the app, both, or neither, depending on how your 

admins set up Intune for your organization. 

More information:  Microsoft Intune 

See Also 

Microsoft Intune 

Secure your mobile data with Microsoft Dynamics CRM for Good 

Microsoft Dynamics CRM for Good, integrated with Good Dynamics, protects your CRM data 

even if you lose or leave your mobile device somewhere. For example, if you leave your device in 

a taxi cab and can’t get it back right away, your CRM data is protected by Good encryption. If you 

lose your device entirely, just notify your admin, who can remotely wipe your Microsoft Dynamics 

CRM for Good data from your device. 

This app is intended for use only with Good Dynamics server software and services from Good 

Technology. If you’re not using Good Dynamics, download Microsoft Dynamics CRM for phones 

or Microsoft Dynamics CRM for tablets instead from the Apple App store. 

Download the Microsoft Dynamics CRM for Good app 

You can download the Microsoft Dynamics CRM for Good app from the Apple App store. You can 

also find the app on the Good Dynamics Marketplace. 

Microsoft Dynamics CRM for Good requires iOS 7.0 or later. To use the app on an iPad, 

you need Microsoft Dynamics CRM 2015 or later. To use the app on an iPhone, you 

need Microsoft Dynamics CRM Online 2015 Update 1 or later or Microsoft Dynamics 

CRM 2016. 

Important  

Note  

Important  

http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/59af6fe5-f6e0-43d0-addc-044009bc0a23
https://technet.microsoft.com/library/59af6fe5-f6e0-43d0-addc-044009bc0a23
../../server-cloud/products/microsoft-intune/overview.aspx
../../server-cloud/products/microsoft-intune/overview.aspx
http://go.microsoft.com/fwlink/p/?LinkID=313645
http://go.microsoft.com/fwlink/p/?LinkID=524762
http://go.microsoft.com/fwlink/p/?LinkId=524809
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Start and sign in to the Microsoft Dynamics CRM for Good app 

1. Open the Microsoft Dynamics CRM for Good app. 

2. When prompted, type in your email address and Good access key. (If you don’t have a 

Good access key, contact your Good admin to get one.) Instead, the sign-in screen might 

ask for your Auth Delegate or password for other Good apps you might have installed for 

easy activation. 

3. When prompted, select a Good security password. 

4. On the Let’s get set up! screen, enter your company’s CRM web address.  

 
 

 

5. Tap the Arrow button in the lower right corner to continue. 

6. When prompted, type in your CRM credentials. 

Now that you’re signed in to the Microsoft Dynamics CRM for Good app, check out the CRM for 

Phones and Tablets User’s Guide to find out all you can do. 

Accessing email and other apps through Microsoft Dynamics CRM for Good 

If you get an alert when you try to use email or other apps through Microsoft Dynamics CRM for 

Good, your admin may be controlling communication to these apps for security purposes. Contact 

your Good admin to find out which apps your company uses in conjunction with Microsoft 

Dynamics CRM for Good, along with any settings that need to be configured. 

Information for admins 

For a list of supported phones and tablets, see the compatibility information in TechNet: Support 

for CRM for phones and CRM for tablets. 

For information on what your enterprise needs to do before using Microsoft Dynamics CRM for 

Good, see TechNet: Set up CRM for phones and CRM for tablets. 

If you’re having problems with the app, see TechNet: Troubleshooting and things to know about 

CRM for phones and tablets. 

See Also 

CRM for Phones and Tablets User’s Guide 

 

crm-for-phones-and-tablets-user-s-guide.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
https://technet.microsoft.com/library/dn531131.aspx
https://technet.microsoft.com/library/dn531131.aspx
https://technet.microsoft.com/library/dn531128.aspx
https://technet.microsoft.com/library/dn660982.aspx
https://technet.microsoft.com/library/dn660982.aspx
crm-for-phones-and-tablets-user-s-guide.aspx
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iFrame and web resource support in CRM for tablets 

You can add iFrames and web resources in forms and dashboards in the Microsoft Dynamics 

CRM web app, and they will appear in CRM for tablets as well. For example, if you add a news 

feed to a dashboard in the web app, the news feed will also appear in the tablet app. For more 

information about using iFrames and web resources, see MSDN: Create web resources and 

iFrame content for use with the CRM for tablets client. 

iFrames and web resources are supported on Apple iPad, Android, and Windows 10 

tablets. Tablets running Windows 8.1 and earlier are not supported. 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

Known issues 

 You can’t use popups for authentication or other purposes from within iFrames and web 

resources on CRM for tablets. 

 Authentication for embedded sites isn’t available. 

 Errors and memory leaks in iFrames and web resources can cause CRM for tablets to stop 

responding, and can cause client side data loss. 

 Some iFrames and web resources can adversely affect application performance. 

 Microsoft Silverlight and image web resources aren’t available on CRM for tablets. 

See Also 

MSDN: Create web resources and iFrame content for use with the CRM for tablets client 

Troubleshoot a CRM for Windows app start-up error 

Did you receive this error? 

Additional steps may be needed to configure Microsoft Dynamics CRM for this 

organization. Please contact your system administrator. 

If you’re using a computer or tablet 
 

Users: Notify your CRM administrator that you 

received this error. 

Admins: To enable the Microsoft Dynamics CRM for 

Windows 8.1 app for on-premises CRM 

deployments, you need to make some 

configuration changes. More information:  

TechNet: Set up CRM for phones and tablets 

Note  

Important  

https://msdn.microsoft.com/library/dn858562.aspx
https://msdn.microsoft.com/library/dn858562.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
https://msdn.microsoft.com/library/dn858562.aspx
https://technet.microsoft.com/library/dn531128.aspx
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Important  

Windows Phones aren’t currently 

supported for on-premises CRM 

deployments. 

 

If you’re using a Windows phone 

You received this error because you’re trying to connect to an on-premises deployment of CRM, 

which is currently not supported on Windows Phones. More information: TechNet: Support for 

CRM for phones and tablets 

See Also 

Install CRM for phones and tablets 

TechNet: Support for CRM for phones and tablets 

TechNet: Set up CRM for phones and tablets 

Troubleshooting and things to know about CRM for phones and tablets 

Troubleshoot error code 800c0019 on Windows Phones 

If you get error code 800c0019 when you try to sign in to your Microsoft account while using the 

Microsoft Dynamics CRM for phones or CRM for phones express apps, chances are that you 

have the wrong date and time settings on your Windows 8 phone. This can occur after updating 

your Windows 8 phone, removing and replacing the battery, or after a time change. 

In most cases, your phone’s date and time is set automatically by your mobile operator. If it’s not, 

you need to set it manually so you can sign in to your Microsoft account successfully. Here’s how: 

 

1. On Start, flick left to the App list and tap Settings. 

2. Tap Date+time. 

3. Turn off Set automatically. 

4. Set the correct values for Time zone, Date, and Time. 

See Also 

TechNet: Troubleshooting and things to know about CRM for phones express 

TechNet: Troubleshooting and things to know about CRM for phones and tablets 

Get started with CRM for phones express 

Microsoft Dynamics CRM for phones express is the previous version of the phone app for 

Microsoft Dynamics CRM. If you’re looking for the most recent, full-featured version of the phone 

app, see the CRM for Phones and Tablets User's Guide. 

https://technet.microsoft.com/library/dn531131.aspx
https://technet.microsoft.com/library/dn531131.aspx
https://technet.microsoft.com/library/dn531131.aspx
https://technet.microsoft.com/library/dn531128.aspx
https://technet.microsoft.com/library/dn660982.aspx
https://technet.microsoft.com/library/dn660977.aspx
https://technet.microsoft.com/library/dn660982.aspx
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CRM for phones express helps you stay connected and productive wherever you are. Stay up to 

date with your customer info—even when you’re on the go. Arrive prepared for every 

appointment, and update your notes, tasks, contacts, accounts, leads, and opportunities while the 

details are still fresh in your mind. 

You can do the following with the CRM for phones express app: 

 See your CRM data quickly displayed and optimized for a mobile screen. 

 Add and modify contacts, tasks, and notes as well as other relevant sales data. 

 View activity feeds and see addresses on Bing Maps (Windows Phone only). 

 Get back to recently viewed records even when you’re not connected (Windows Phone only). 

 

The following articles provide more information about how to install and use CRM for phones 

express: 

 Install the CRM for phones express app 

 Take a tour of CRM for phones express 

 Use Cortana voice commands in CRM for phones 

 eBook: Go mobile with CRM for phones express 

See Also 

TechNet: Troubleshooting and things to know about CRM for phones express 

TechNet: Set up CRM for phones 

TechNet: Create and edit mobile forms 

Install the CRM for phones express app 

While on the go, you can use Microsoft Dynamics CRM on your mobile phone with the Microsoft 

Dynamics CRM for phones express app. 

CRM for phones express is the previous version of the phone app for Microsoft Dynamics CRM. If 

you’re looking for the most recent, full-featured version of the phone app, see the CRM for 

Phones and Tablets User's Guide. 

Before you can use the app, you need to check to make sure your CRM admin has set up CRM 

for phones express for you. Your admin might have provided you with instructions on how to 

install and start the app, but if not, you can use these instructions. 

Install CRM for phones 

If your admins have told you to download the CRM for phones express app, choose the link in the 

following table for your phone. The link will take you to the app in your phone’s app store. 
 

Phone App link 

Windows Phone Windows Store 

http://go.microsoft.com/fwlink/p/?LinkId=395076
https://technet.microsoft.com/library/dn660977.aspx
https://technet.microsoft.com/library/dn531085.aspx
https://technet.microsoft.com/library/dn531080.aspx
http://go.microsoft.com/fwlink/p/?LinkID=328765
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Phone App link 

Apple iPhone Apple App store 

Android phone Google Play 

 

Start CRM for phones express 

1. Open the CRM for phones express app. 

2. On the Get Started screen, type your company’s CRM web address.  

 
 

 

3. Tap Go to continue. 

Having trouble with your app? 

If you’re having trouble with your CRM for phones express app, it’s a good idea to contact your IT 

department. If you want to do some troubleshooting on your own, try these resources: 

 If your app isn’t working well on your phone, be sure to check the compatibility information in 

TechNet: Mobile phone support for Microsoft Dynamics CRM. 

 For specific problems and error messages, see TechNet: Troubleshooting and things to know 

about CRM for phones express. 

Privacy notice 

Licensed Dynamics CRM Online users with specific Security Roles (CEO – Business Manager, 

Sales Manager, Salesperson, System Administrator, System Customizer, and Vice President of 

Sales) are automatically authorized to access the service by using CRM for phones, as well as 

other clients.  

 

http://go.microsoft.com/fwlink/p/?LinkID=328968
http://go.microsoft.com/fwlink/p/?LinkID=328969
https://technet.microsoft.com/library/dn531170.aspx
https://technet.microsoft.com/library/dn660977.aspx
https://technet.microsoft.com/library/dn660977.aspx
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 An administrator has full control (at the user security role or entity level) over the ability to access 

and the level of authorized access associated with the phone client. Users can then access CRM 

Online by using CRM for phones, and Customer Data will be cached on the device running the 

specific client.  

 

 Based on the specific settings at the user security and entity levels, the types of Customer Data 

that can be exported from CRM Online and cached on an end user’s device include record data, 

record metadata, entity data, entity metadata, and business logic.  

 

See Also 

Get started with CRM for phones express 

Take a tour of CRM for phones express 

TechNet: Troubleshooting and things to know about CRM for phones express 

TechNet: Set up CRM for phones express 

Take a tour of CRM for phones express 

If you’re new to Microsoft Dynamics CRM for phones express, check out this quick tour to see 

how to navigate or work in the app. 

When you first open CRM for phones express, you’ll see a list of record types such as accounts, 

contacts, and leads. 

 
 

Follow the instructions here to navigate, search, and do other common tasks. 

https://technet.microsoft.com/library/dn660977.aspx
https://technet.microsoft.com/library/dn531085.aspx
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Use Cortana on Windows 8 phones 

You can speak your CRM for phones express commands if you’re using Cortana on Windows 8.1 

phones. 

For a list of commands you can use with Cortana, see Use Cortana voice commands in CRM for 

phones. 

For more information about using Cortana, see Meet Cortana. 

For more information about privacy and Cortana, see Cortana and my privacy FAQ. 

Display a list of records 

 From the list of record types, tap the one you want, for example Contacts. 

 
 

Search for records from a list 

1. Tap the Search button  at the bottom of the screen. Type in the text to search for. 

 

 

http://go.microsoft.com/fwlink/p/?LinkID=401573
http://go.microsoft.com/fwlink/p/?LinkID=522360
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2. Tap the Search button . 

 
 

 

Search for records from a lookup field 

1. In a lookup field, tap the Search button . 
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2. Tap Look Up More Records. 

 
 

 

3. Enter a few characters to search and tap Find. 
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4. Select the record and tap Done. 

 
 

 

Change the current view 

 Tap the view name and select the view you want. 
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Scroll down to see more records if you don’t see the one you want. 

Start a call or email 

 Tap a phone number or email address to start a call or launch your email app. 
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Mark activities complete 

Follow the steps for the app you’re using. 

 On a Windows Phone, tap the check  button. 

 
 

 On an iPhone or Android, tap the more button, and then tap MarkActivityAsComplete. 

Windows Phone 

iPhone or Android phone 
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Add an attachment to a record 

 Tap the attachment button and select the document, picture, or other item that you want 

to attach. 
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Use additional features in the Windows Phone app 

The CRM for phones express app for Windows Phone includes the following added features: 

 Activity feeds 

 Record panorama (you can swipe to view additional information or related records) 

 Offline experience (you can see recently viewed data while disconnected from the network, 

but you can’t edit it) 

 Ability to synchronize customizations by clearing the local cache 

View activity feeds 

 Tap what’s new and view the posts. 

 
 

 

Use the record panorama 

 To view additional information, swipe left and right. 
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Synchronize customizations by clearing the local cache 

1. From time to time, your CRM administrator might make changes to the system. While the 

app will automatically check for changes every eight hours or so and synchronize them, 

you can manually start a synchronization if you need it sooner. To synchronize 

customizations to the app, tap the gear button on the home page. 
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2. Tap clear local cache. 

 
 

 

See Also 

Cortana voice commands for Microsoft Dynamics CRM for phones 

eBook: Go mobile with CRM for phones express 

Get started with CRM for phones express 

Install the CRM for phones express app 

TechNet: Troubleshooting and things to know about CRM for phones express 

http://go.microsoft.com/fwlink/p/?LinkId=395076
https://technet.microsoft.com/library/dn660977.aspx
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TechNet: Set up CRM for phones express 

For admins and customizers 

 

New releases 

Manage your subscription 

Add and manage users, and set up security 

Regional and other business management settings 

Integrate other apps with CRM 

Create dashboards, charts, and reports 

Manage data 

Enable or manage auditing 

System Settings Dialog Box Reference 

Customize CRM 

New releases 

 

What's new 

Get ready for the next release 

After you update: next steps to success 

Emails about update readiness for Dynamics CRM Online 

What are Preview features and how do I enable them? 

What's new 

horizontaltabbed 

New in 2016 

We’re excited to announce new features for Microsoft Dynamics CRM Online 2016 Update and 

Microsoft Dynamics CRM 2016 (on-premises). If you’re an administrator, be sure to check out this 

page as well: TechNet: What’s new for administrators and customizers 

Track email from anywhere with new CRM App for Outlook  

Microsoft Dynamics CRM App for Outlook is a lightweight email tracking app that surfaces 

contextual information from Microsoft Dynamics CRM right inside your Outlook Inbox.  

https://technet.microsoft.com/library/dn531085.aspx
https://technet.microsoft.com/library/dn531078(v=crm.8).aspx
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You can use Dynamics CRM App for Outlook together with: 

 Outlook on the web (included with Office 365) from a desktop or on your phone 

 The Outlook desktop application 

 Microsoft Outlook for Mac 

Track incoming or outgoing email, add contacts from an email message, or even create CRM 

records. You can also track an email message to a new or existing CRM record.  

More information: CRM App for Outlook User's Guide (lightweight app) 

Use pre-formatted Excel templates to create Excel documents directly from CRM 

If you find that you frequently create the same Microsoft Office Excel documents in CRM, you can 

use Excel templates to speed up document creation. For example, use a pre-formatted template 

to forecast sales, or to monitor sales and project cash flow (pipeline analysis). After a template is 

uploaded by a system administrator, it can be shared with team members.  

 

Use Word templates to quickly create the documents your organization depends on 

Standardized documents are a cornerstone for business dealings—from quotes and contracts to 

work orders and invoices. Now you can automatically generate standardized documents from 

CRM data using Microsoft Office Word templates. Use Word templates to enhance productivity, 

reduce human error, and ensure consistent communication across the company. 

 

Store and manage your private documents in OneDrive for Business, directly from CRM 

Now you can use the right storage option for the right situation. For example, store your private 

documents using the new OneDrive for Business option. For collaborative storage, use Office 365 

Groups (introduced in Microsoft Dynamics CRM Online 2015 Update 1), and for documents you’ll 

share more widely, or with the whole company, use Microsoft SharePoint. 

More information: Use OneDrive for Business to manage your private documents 

Let CRM find trending documents for you (CRM Online only) 
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Get content that’s most relevant to what you’re working on, and what’s trending around you. Add 

Office Delve to your dashboards to automatically search through documents and find that one 

document that helps you close the sale.  

 

More information: View relevant and trending information with Office Delve 

View SharePoint documents in CRM for phones and tablets 

If your organization has integrated SharePoint with CRM, you can now open your SharePoint 

documents from the mobile apps. 

 

More information: TechNet: Integrate SharePoint with CRM 

Export data to Excel from CRM for phones and tablets 

You can now export data to Excel from the mobile apps. After you've exported the data you want 

to work with, you can open it in the Excel app on your mobile device. 

Email a link to a page from CRM for phones and tablets 

Want to share information about a client with one of your colleagues while you’re out on the road? 

Email a link to a page. 

Mobile apps now support Windows 10 and iOS 9 

The mobile apps are now compatible with Windows 10 and iOS 9 for Apple iPhone and iPad. 

New interactive service hub dashboards and forms help you prioritize workloads 

CRM 2016 includes a new interactive service hub with completely redesigned dashboards and 

forms that help you prioritize your workload and complete your most urgent tasks. Interactive 

charts provide a visual snapshot of important metrics related to work items, and also double as 

visual filters. You can add an additional level of filtering through global filters. You can also take 

action (for example, reassign a case) directly from a dashboard. 

This release of the interactive service hub is optimized for customer service scenarios 

and use cases. Because this is the first release, not all customer service scenarios are 

covered. 

 

The new interactive service hub forms help you maintain context while addressing customer 

issues. For example, use the following sections on the Case form’s Summary tab to quickly find 

the info you need: 

 General Information section. Get a quick summary of the case and customer contact 

information, such as email address and phone number. 

 Timeline section. See all activities related to a record and take action on an activity. 

 Related section. Search for knowledge base (KB) records. The search pane shows 

suggested KB articles based on case title. You can also use this section to quickly find and 

open related cases. The related record opens in a new tab within this section so you don’t 

lose the context of the case you’re working on. 

Important  

https://technet.microsoft.com/library/b066f14a-e1a8-4a35-8f46-98ce79c38af3(v=crm.8).aspx
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When you select a particular stage in the process bar, the stage opens as a popup. You can fill in 

details required for that stage, and then click Next stage to move to the next one.  

 
 

 

 

If you’re an administrator, you can customize the interactive service hub dashboards and forms, 

or create dashboards and forms.  More information: User's guide for the new interactive service 

hub 

Reduce case call-handling time with rich knowledge management articles 

With the new interactive service hub, you can also turn customer feedback and issues into rich 

knowledge articles that include embedded videos, images, and more. The rich text editor offers 

common word-processor features like advanced styling, linking, paste from Word, find and 

replace, and tables.  

 

Make sure your articles are accurate by moving them through the review and approval process, 

and then use versions to track changes. You can work on multiple revisions while the currently-

approved content stays published. When you’re ready, make the team-approved content 

available to all CRM users. 

You can add the knowledge base search component to any entity to give salespeople, account 

managers, and customer service representatives access to a single source of product 

information, sales coaching documents, FAQs, troubleshooting steps, and solutions. When 

knowledge is shared with customers, it’s automatically recorded so you can see top content 

easily.  

More information: User's guide for the new interactive service hub 

Enable service level agreements (SLAs) on demand 

With new SLA enhancements, you can now apply SLAs to case records manually. You can also 

apply SLAs automatically to cases based on business logic by using workflows or plug-ins. 
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For example, if your customers are spread across geographies, you may have multiple SLAs with 

different business hours and holiday schedules. Set up business logic to apply SLAs on case 

records based on customer region to make sure the SLA time calculation happens correctly for 

their region. 

More information: Define service level agreements (SLAs) 

CRM Online 2015 Update 1 features now apply to CRM 2016 (on-premises) 

The following CRM Online 2015 Update 1 features are now included in CRM 2016 on-premises. 

Get around and find the info you need, fast! 

With the new navigation bar, it's easier and faster to find the information you need. When you 

click the Main Menu from the nav bar, you can get to your work areas, records, or other items 

with less scrolling and fewer clicks than before. 

 
 

 Take a short video tour (less than one minute) of the new navigation 

 

 

Use the Recently Viewed Items button  on the new nav bar to get back to your most recently 

viewed and pinned items. With this global tool, you can access recently viewed records, views, 

and even dashboards. Pin the items you use all the time to move them to the top of the list. 

 
 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=528558
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If you’re working in a complex form with lots of fields, the new form navigation drop-down list 

makes it easy to get to just the data you need. Click the drop-down list next to the form title, and 

then select the section of the form you want to go to. 

 

 

 
 

 

 

Add a logo or change the color scheme using themes 

Create a uniform look and feel across all your applications with themes. For example, add a 

company logo or change default colors for entities or links. Preview your custom theme, and then 

publish it for the whole team when you’re ready. No code required! You must be a CRM 

administrator to create a custom theme. 
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Watch a short video (2:45) about themes 

 

 

More information: TechNet: Change the color scheme or add a logo to match your organization’s 

brand  

 

 

Track Exchange email activities automatically with folder tracking 

Microsoft Dynamics CRM Online 2015 Update 1 provides a new and intuitive way to track 

incoming Exchange email activities. You can set up a tracking folder—use any Exchange folder in 

your Inbox—and then drag an incoming email message to that folder to track it. You can 

associate a tracked folder with a specific record, such as an account or opportunity, so when you 

move a message to that folder, it's automatically linked to that specific record.  

Tracked folders work with Exchange Inbox rules, which makes it even easier to manage and track 

incoming email. For example, you could set up an Exchange Inbox rule that automatically routes 

email from a Contoso contact to a tracked Contoso folder, linked to a specific opportunity. 

Tracked folders work on any device that supports Exchange, so you can track email from virtually 

any device.   

 

 

http://go.microsoft.com/fwlink/p/?LinkId=529568
https://technet.microsoft.com/library/21a166a0-d25e-4260-a1e4-2ddc528787c2.aspx
https://technet.microsoft.com/library/21a166a0-d25e-4260-a1e4-2ddc528787c2.aspx
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To use tracked folders, your organization must use server-side synchronization as your email 

synchronization method. Tracked folders must also be enabled by a system administrator.  

 Watch a short video (2:37) about folder-level tracking 

More information: 

 Track Outlook email by moving it to a tracked Exchange folder 

 TechNet: Tell me more about server-side synchronization 

 TechNet: Configure folder-level tracking 

 

 

Export to Excel completely redesigned 

We’ve redesigned exporting to Excel from the bottom up to provide for a much smoother 

experience. With a single click in the web client or in Dynamics CRM for Outlook, you can export 

your data as an Excel document, which can be opened anywhere, including the desktop version 

of Excel (2007 and later), Excel Online, and other Excel clients. When you export, all formatting is 

preserved, so you can do your calculations in Excel, and then reimport the data to CRM. You can 

export up to 100,000 records at a time (previous limit was 10,000).  

More information: Export data to Excel 

 

 

Enjoy the same great mobile experience, whether you’re using a phone or tablet 

The CRM for phones app now provides the same process-driven experience as CRM for tablets. 

Nurture your leads and opportunities through the sales process with the new intuitive interface. If 

http://go.microsoft.com/fwlink/p/?LinkId=534781
https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/ae069f91-8cd7-446e-b13b-05aec2e9b95c.aspx
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you have a Windows Phone, use Cortana voice commands to get to your CRM data hands-free. 

More information:  

 

 

 
 

 Watch a short video (5:02) about the new CRM for phones app 

 

 

The previous version of the CRM for phones app is still available in app stores, but it's now called 

CRM for phones - Express.  

 

 

Secure your mobile data with Microsoft Dynamics CRM for Good 

The Microsoft Dynamics CRM for Good app works with the Good Technology mobile security 

platform to protect your CRM data even if you lose or leave your tablet somewhere. For example, 

if you leave your tablet in a taxi cab and can’t get it back right away, your CRM data is protected 

by Good encryption. If you lose your tablet, your admin can remotely wipe your CRM for Good 

data from your tablet. More information: Secure your mobile data with Microsoft Dynamics CRM 

for Good 

 

 

Speed up customer service with default entitlements 

Customer service representatives use entitlements to verify the type of support a customer is 

eligible for and to provide the correct level of support. Now service managers or admins can set 

an entitlement as the default entitlement for a customer. When a rep creates a case, the default 

entitlement is automatically associated with the case, saving time for the rep. 

http://go.microsoft.com/fwlink/p/?LinkId=529571


 

 
428 

For cases where service organizations do not want entitlement terms to be deducted (a faulty part 

is installed, for example), service reps can also credit back entitlement terms so the customer 

isn’t charged. 

 

 

Define rules for creating or updating CRM records from incoming activities 

In previous versions of Microsoft Dynamics CRM, Service Managers could set up rules to 

automatically create cases from incoming email or social channels. Now sales, marketing, and 

service teams can use these same rules to automatically create or update one or more records 

from any single incoming activity, such as an email, social, or custom activity.  

More information: Set up rules to automatically create or update records in CRM 

 

 

CRM Online 2015 Update 1 

 

Get around and find the info you need, fast! 

With the new navigation bar, it's easier and faster to find the information you need. When you 

click the Main Menu from the nav bar, you can access your work areas, records, or other items 

with less scrolling and fewer clicks than before. 

 
 

 Take a short video tour (less than one minute) of the new navigation 

 

 

Use the Recently Viewed Items button on the new nav bar to get back to your most recently 

viewed and pinned items. With this global tool, you can access recently viewed records, views, 

and even dashboards. Pin the items you use all the time to move them to the top of the list. 

http://go.microsoft.com/fwlink/p/?LinkId=528558
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If you’re working in a complex form with lots of fields, the new form navigation drop-down list 

makes it easy to get to just the data you need. Click the drop-down list next to the form title, and 

then select the section of the form you want to go to. 

 

 

 
 

 

 

Add a logo or change the color scheme using themes 

Create a uniform look and feel across all your applications with themes. For example, add a 

company logo or change default colors for entities or links. Preview your custom theme, and then 

publish it for the whole team when you’re ready. No code required! 
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 Watch a short video (2:45) about themes 

 

 

More information: TechNet: Change the color scheme or add a logo to match your organization’s 

brand  

 

 

Track Exchange email activities automatically with folder tracking 

Microsoft Dynamics CRM Online 2015 Update 1 provides a new and intuitive way to track 

incoming Exchange email activities. You can set up a tracking folder—use any Exchange folder in 

your Inbox—and then drag an incoming email message to that folder to track it. You can 

associate a tracked folder with a specific record, such as an account or opportunity, so whenever 

you move a message to that folder, it's automatically linked to that specific record.  

Tracked folders work with Exchange Inbox rules, which makes it even easier to manage and track 

incoming email. For example, you could set up an Exchange Inbox rule that automatically routes 

email from a Contoso contact to a tracked Contoso folder, linked to a specific opportunity. 

Tracked folders work on any device that supports Exchange, so you can track email directly from 

virtually any device.   

 

 

http://go.microsoft.com/fwlink/p/?LinkId=529568
https://technet.microsoft.com/library/21a166a0-d25e-4260-a1e4-2ddc528787c2.aspx
https://technet.microsoft.com/library/21a166a0-d25e-4260-a1e4-2ddc528787c2.aspx
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To use tracked folders, your organization must use server-side synchronization as your email 

synchronization method. Tracked folders must also be enabled by a system administrator.  

 Watch a short video (2:37) about folder-level tracking 

More information: 

 Track Outlook email by moving it to a tracked Exchange folder 

 TechNet: Tell me more about server-side synchronization 

 TechNet: Configure folder-level tracking 

 

 

Track incoming email wherever you are with the new CRM App for Outlook 

Microsoft Dynamics CRM already includes a full-featured CRM add-in for Microsoft Office Outlook 

called Microsoft Dynamics CRM for Outlook. Now you have the choice of using Dynamics CRM 

for Outlook or the new Dynamics CRM App for Outlook Preview to track incoming email.  

 

 

http://go.microsoft.com/fwlink/p/?LinkId=534781
https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/ae069f91-8cd7-446e-b13b-05aec2e9b95c.aspx
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Dynamics CRM App for Outlook is a light-weight Office app that you can use together with the 

desktop version of Outlook on the web (included in Office 365) or Outlook 2013 to: 

 Track incoming email and set a regarding record. 

 Determine whether a record is already tracked and view the regarding record. 

 Preview information about CRM contacts or leads. 

 Create contact or lead records if the person on the From line isn’t already included in the 

CRM database. 

 View information about last and next activities, as well as other related records. 

 Open CRM forms directly if you need more detailed information. 

Dynamics CRM App for Outlook is offered as a preview feature and must be enabled by a system 

administrator. For more information about setting up and using Dynamics CRM App for Outlook, 

see the  CRM App for Outlook User's Guide (lightweight app). 

 

 

Do quick analysis with Excel Online, right from CRM Online 

Millions of people use Microsoft Office Excel to analyze corporate data and create reports. Now 

you can use Microsoft Excel Online to do quick analysis, right from CRM Online. For example, if 

you’re a sales manager, you might want to analyze the opportunities your team owns and review 

Key Performance Indicators (KPIs) to see how you can assist your team members. If you’re a 

sales rep, you can open your opportunities in Excel and do what-if analysis for different incentive 

scenarios.  
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 Watch a short video (2:45) about doing a “What if” analysis with Excel Online 

You must have an Office 365 subscription to edit Excel documents in Excel Online. 

More information: Analyze your CRM data in Excel Online 

 

 

Export to Excel completely redesigned 

We’ve redesigned exporting to Excel from the bottom up to provide for a much smoother 

experience. With a single click in the web client or in Dynamics CRM for Outlook, you can export 

your data as an Excel document, which can be opened anywhere, including the desktop version 

of Excel (2007 and later), Excel Online, and other Excel clients. When you export, all formatting is 

preserved, so you can do your calculations in Excel, and then reimport the data to CRM. You can 

export up to 100,000 records at a time (previous limit was 10,000).  

More information: Export data to Excel 

 

 

New Power Query connector streamlines connections to CRM Online 

With the new Power Query connector, you can connect more easily to CRM Online data from 

Power Query to do self-service Business Intelligence (BI). After selecting the From Dynamics 

CRM Online connector in Power Query, just supply a URL feed, and then enter your credentials. 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=534788
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Power Query connects and retrieves the list of tables and entities from CRM Online. You can also 

schedule data refreshes of your dashboard from Power BI for Office 365. 

More information: 3 updates to Excel Power Query 

 

 

Collaborate with team members, even if they don’t have access to CRM Online 

Office 365 users can use Office 365 Groups to collaborate across Office products. An Office 365 

Group is a workspace that team members can use to share files, email messages, conversations, 

calendars, and Microsoft OneNote notes. Office 365 Groups are a great way to collaborate with 

team members, even if they don’t have access to CRM Online. For example, create an Office 365 

Group for your sales team, invite other Office 365 users to join the Group, and then share 

documents, email, conversations, meeting information, and OneNote notes related to specific 

opportunities.  

Office 365 Groups are offered as a preview feature. 

More information: 

 Collaborate with your colleagues using Office 365 Groups 

 Tell me more about Office 365 Groups 

 What are Preview features and how do I enable them? 

 TechNet: Enable Office 365 Groups 

 

 

Take notes in OneNote, directly from CRM Online 

Take advantage of all that Microsoft OneNote has to offer, directly from CRM Online. For 

example, when you’re on the go at a customer site, take notes on your Microsoft Surface or other 

mobile device while you’re viewing opportunity details. Capture photos, take voice notes, do free-

form drawings and more. Everything is automatically linked with the opportunity record in CRM 

Online.  

 

 

http://blogs.office.com/2015/03/05/3-updates-excel-power-query/
http://blogs.office.com/2014/09/25/delivering-first-chapter-groups-office-365/
https://technet.microsoft.com/library/d3646c17-1344-490f-9612-6c8cb63e213f
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 Watch a short video (2:12) about OneNote integration in Dynamics CRM 

 

 

More information: Set up and use OneNote in CRM 

 

 

Enjoy the same great mobile experience, whether you’re using a phone or tablet 

The CRM for phones app now provides the same process-driven experience as CRM for tablets. 

Nurture your leads and opportunities through the sales process with the new intuitive interface. If 

you have a Windows Phone, use Cortana voice commands to access your CRM data hands-free. 

More information:  

 

 

http://go.microsoft.com/fwlink/p/?LinkId=534833
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 Watch a short video (5:02) about the new CRM for phones app 

 

 

The previous version of the CRM for phones app is still available in app stores, but it's now called 

CRM for phones - Express.  

 

 

Secure your mobile data with Microsoft Dynamics CRM for Good 

The Microsoft Dynamics CRM for Good app works with the Good Technology mobile security 

platform to protect your CRM data even if you lose or leave your tablet somewhere. For example, 

if you leave your tablet in a taxi cab and can’t get it back right away, your CRM data is protected 

by Good encryption. If you lose your tablet, your admin can remotely wipe your CRM for Good 

data from your tablet. More information: Secure your mobile data with Microsoft Dynamics CRM 

for Good 

 

 

Share the knowledge (base) with Parature 

We introduced Parature, from Microsoft, in the 2015 spring wave of releases. Now if you’re a 

customer service agent, you can take advantage of rich Parature knowledge base (KB) 

capabilities to reduce issue handling time, directly from CRM Online. For example, while you’re 

working on a case record, you can:  

 View system-suggested KB articles 

 Search for relevant KB articles 

 Read the content of KB articles inline, including embedded images or videos 

 Send KB article links to customers 

http://go.microsoft.com/fwlink/p/?LinkId=529571
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More information: Find knowledge articles from within a record in CRM 

 

 

Speed up customer service with default entitlements 

Customer service agents use entitlements to verify the type of support a customer is eligible for 

and to provide the right level of support. Now service managers or admins can set an entitlement 

as the default entitlement for a customer. When an agent creates a case, the default entitlement 

is automatically associated with the case, saving time for the agent. 

For cases where service organizations do not want entitlement terms to be deducted (a faulty part 

is installed, for example), service agents can also credit back entitlement terms so the customer 

isn’t charged. 

 

 

Define rules for creating or updating CRM records from incoming activities 

In previous versions of Microsoft Dynamics CRM, Service Managers could set up rules to 

automatically create cases from incoming email or social channels. Now sales, marketing, and 

service teams can use these same rules to automatically create or update one or more records 

from any single incoming activity, such as an email, social, or custom activity.  

More information: Set up rules to automatically create or update records in CRM 
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Forms load much faster with new form rendering engine 

In Microsoft Dynamics CRM Online 2015 Update 1, you’ll notice that forms are much snappier 

than in earlier versions. You don’t have to do anything to take advantage of faster forms — 

they’re turned on by default. If you have forms that include unsupported customizations, however, 

and you encounter errors as a result, you may want to temporarily turn off form enhancements 

while you update your scripts. More information: System Settings dialog box - General tab 

 

 

Updates are driven by you  

Microsoft Dynamics CRM Online 2015 Update 1 includes a new opt-in update model that 

provides flexibility for applying updates, depending on your organization’s needs. For simplicity, 

all updates are managed through a single central portal. For more information, see TechNet: 

Update policy 

 Watch a short video (3:38) on customer-driven updates 

 

 

 

If you’re an administrator, be sure to check out this page as well: TechNet: What’s new 

for administrators and customizers  

New in 2015 

 

Improvements to product selling features help increase sales 

Improvements to the product selling experience help sales operations managers and salespeople 

manage and sell your company’s products more effectively: 

 Sales operations managers can easily add products to the system and bundle related 

products together so that salespeople can increase sales by encouraging customers to buy 

a group of products instead of single items. For example, you can pair a top-selling product 

with a less popular one, create groups of products to maximize the benefits for customers 

when they buy, and offer special discounts on bundled products. 

 Sales operations managers can provide tailored pricelists based on a salesperson’s 

territory, or on the customer segment they’re assigned to. 

 Sales operations managers or customizers can localize the product catalog for 

different regions with localization tools. Export and import field translations, and localize 

product attributes and metadata to make product details available to salespeople in their 

preferred language.  

 

 Salespeople can visualize all the products and product bundles your company sells by 

viewing products in hierarchical charts (similar to org charts). When pulling together an 

order, you can see all the products that are available to sell, and how they’re related in a 

Tip  

https://technet.microsoft.com/library/dn308237.aspx#BKMK_Policy
https://technet.microsoft.com/library/dn308237.aspx#BKMK_Policy
http://go.microsoft.com/fwlink/p/?LinkId=533947
https://technet.microsoft.com/library/dn531078.aspx
https://technet.microsoft.com/library/dn531078.aspx
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visual way. When you can see all product possibilities in one view, you’re less likely to miss a 

potential sales opportunity. 

 Salespeople can see suggestions for cross-selling and up-selling, and get 

recommendations for accessories or substitutes. 

Cortana support lets you speak CRM commands on Windows 8.1 phones 

Now you can speak your commands to CRM if you are using Cortana on a Windows 8.1 phone. 

For a list of the CRM commands you can use with Cortana, see Cortana voice commands for 

Microsoft Dynamics CRM for phones. 

Improvements to quick find make it easier to find customer records on the web app 

Improved search capabilities provide a quick way for users to search across multiple record types 

on the web app. Now, by entering keywords in the search box on the nav bar, you can quickly 

find and navigate to a record from anywhere in the web app.  

In previous versions, quick find across multiple record types was available only on the CRM for 

tablets app. 

The search box supports using an asterisk (*) as a wildcard character.  

 
 

To only see matches for a certain type of record, on the search results page, you can select the 

name of the record type from the drop-down list. Click the tile for a search result to open it. 
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To do more sophisticated searches, click the new Advanced Find button, which is now on the 

nav bar. 

Microsoft Social Engagement is now available for on-premises systems 

With this release, you can access Microsoft Social Engagement from within Microsoft Dynamics 

CRM, whether your organization uses Microsoft Dynamics CRM Online or CRM 2015 (on-

premises). 

New way to view accounts, products, and users helps you see how info is related 

With this release, users can see how info is related or grouped by viewing accounts, products, or 

users in hierarchical charts. You can click a block of info to get more details and navigate to the 

info you’re interested in. 

For example, from the hierarchical view for accounts, you can:  

 See how an account is doing in overall revenue 

 Drill into tiles for sub-accounts to see where the deals are coming from 

 Find out who is working on an account and enlist help from others by sending email or 

sharing the account with other salespeople 

 View important details about each account, such as credit limit and latest activity posts for the 

account 

From the hierarchical view for products, you can see all the products available to sell, and how 

they're related in bundles or families. Salespeople can avoid missing a potential sale, because 

they can see all related products in one view. 

From the hierarchical view for users, you can find out who another team member's boss is, or 

who else is on their team, without switching to another app. 

Hierarchical views are also available on mobile. 

 To see hierarchies that show the relationships between records, on the list of accounts, 

products, or users, click the hierarchies button. You can also click the View Hierarchy 

command when you’re viewing the screen for an individual account, product, or user. 

 
 

The CRM Basics guide helps users learn common tasks even if their system is customized 
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In friendly, bite-sized servings that are never any longer than a single page, the new CRM Basics 

helps new users learn how to get around the system using tiles, enter customer data, search for 

records, keep track of interactions with customers by adding notes and tasks, stay on top of their 

progress with dashboards — and more. The CRM Basics includes sections targeted at sales and 

service, so new users also get the run-down on the basics tailored for their role. 

Because the guide covers common tasks that apply to anyone who uses Microsoft Dynamics 

CRM, it’s relevant even if the system has been customized. 

The CRM Basics is a great resource for training new users. You’ll find an editable version in the 

Training & Adoption Kit for Microsoft Dynamics CRM that you can customize to create your 

own training materials. 

You’ll see the CRM Basics whenever you access help from any system that’s not connected to 

the internet. Or, download the eBook: CRM basics for sales pros and service reps (applies to 

2015). 

Improvements to Quick Create let you add a contact within an opportunity 

Now, when a salesperson adds a new sales opportunity to the system by using the Create 

command on the nav bar, the salesperson can also create a new contact at the same time. In 

previous releases, the salesperson needed to create the contact before using the Quick Create 

command to add an opportunity. 

New Outlook Configuration Wizard makes it easy to set up and configure CRM for Outlook  

With the new Outlook Configuration Wizard, which has been completely redesigned for 2015, 

configuring Dynamics CRM for Outlook is as easy as copy and paste. The new Configuration 

Wizard also makes it easy to add and manage additional CRM organizations. If you’re an 

administrator, you’ll appreciate new security features like multi-factor authentication. More 

information: TechNet: What’s new for administrators and customizers in Microsoft Dynamics CRM 

2015 and CRM Online 

Synchronize more types of information between CRM and Outlook 

Teams that use Dynamics CRM for Outlook as their centralized information hub can synchronize 

more types of information now, including: 

 Additional contacts and tasks fields 

 Assigned tasks 

 Appointment attachments 

Users can easily view the fields that are synchronized, which provides confidence about where 

the data comes from and how it’s shared. If you’re an administrator, you can configure field 

synchronization direction to control exactly how data is synchronized. More information: TechNet: 

What’s new for administrators and customizers in Microsoft Dynamics CRM 2015 and CRM 

Online 

Business processes now allow you to “branch” to different steps based on rules and 

conditions 

Now, business processes let you take a different “branch” (and handle a customer differently), 

based on things like the person’s budget, the type of products the person buys, when the person 

http://go.microsoft.com/fwlink/p/?LinkID=534755
http://go.microsoft.com/fwlink/p/?LinkID=534755
https://technet.microsoft.com/library/dn531078.aspx
https://technet.microsoft.com/library/dn531078.aspx
https://technet.microsoft.com/library/dn531078.aspx
https://technet.microsoft.com/library/dn531078.aspx
https://technet.microsoft.com/library/dn531078.aspx
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plans to buy your products, or other conditions. For example, let’s say that in the process of 

qualifying a lead you learn that the person plans to buy next quarter, which means that you’ll 

need to pull together a sales proposal and get the right approvals. The business process you’re 

following guides you through the right steps to handle this prospect, with no guesswork. 

For a step-by-step guide to changing a business process to match the way your organization 

does things, check out the eBook: Customize a business process. This eBook is intended for 

administrators or managers. 

Create custom Help (training) designed just for your users 

If you customize Microsoft Dynamics CRM extensively, you may want to replace the default Help 

content with Help and training designed just for the people who use your system. You can replace 

Help (by redirecting to a URL) for the whole organization or just for lists and forms for specific 

record types (entities). The page you redirect to can be any valid URL you can paste into a 

browser: a page on a SharePoint site or a webpage on the Internet; even your team Wiki page, 

Intranet site, Word document or PDF file. For more information, see TechNet: What’s new for 

administrators and customizers in Microsoft Dynamics CRM 2015 and CRM Online. 

Earlier version? 

Updating from an earlier on-premises version of Microsoft Dynamics CRM? If so, there are many 

more exciting new features for you to take advantage of now, including a brand new user 

interface.  

Find out more about differences between the new tiled interface and older versions that use a 

ribbon: eBook: What’s changed in CRM 2013? 

 

 

 

eBook: SLAs and entitlements 

 

Get started in CRM (2:16) 

Navigate easily with the redesigned user interface 

The new user interface makes doing common tasks quicker and easier: 

  No more Navigation Pane. To move around in the web application, you’ll use the nav bar at 

the top of the page. The nav bar includes “breadcrumbs” that remind you about where you’re 

working in the system. More information:   eBook: Start working in CRM            

 

  It’s easier to enter data. Look for the Create command in the nav bar at the top of the 

page. Just click the command, and then enter data in a few fields to get new information into 

the system. More information: Quick create--Enter new contacts (or other data)--fast!            

 

You can add products quickly to opportunities, quotes, and orders — and update details like 

price, quantity, and discounts right on the screen where you’re working. Plus, you can look up 

http://go.microsoft.com/fwlink/p/?LinkID=386368
https://technet.microsoft.com/library/dn531078.aspx
https://technet.microsoft.com/library/dn531078.aspx
http://go.microsoft.com/fwlink/p/?LinkID=321497
http://go.microsoft.com/fwlink/p/?LinkID=394707
http://go.microsoft.com/fwlink/p/?LinkID=317092
http://go.microsoft.com/fwlink/p/?LinkID=314191
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and add key stakeholders and see at a glance who is involved and what their role is. More 

information: Create or edit an opportunity            

 

  Click or tap to contact someone. Stay in touch with your customers by selecting a phone 

number to make calls via Lync or Skype. Click an email address to send an email. In addition, 

you can see addresses on Bing Maps. More information:   Place calls with Skype or Skype 

for Business            

Lync has been rebranded as Skype for Business. Currently, you’ll still see references 

to “Lync” in Microsoft Dynamics CRM, but CRM will work with Skype for Business. 

 

 Microsoft Dynamics CRM is ideal for touch-enabled monitors as well as for monitors that require 

a mouse. 

 

The Training & Adoption kit gives you a jump start on creating training materials for users 

To help you get your organization up and running, there’s a Training & Adoption Kit with eBooks, 

help, and videos that you can customize to match your system and style.   

More information: Training & Adoption Kit for Microsoft Dynamics CRM 

Deliver great service everywhere 

The many new customer service features help you build customer loyalty and retain customers 

for life. These new features can help you: 

 Respond quickly to service issues, whether they come in from phone calls, email, or social 

media. 

 Tie entitlements to service level agreements (SLAs) to provide quality service until a case is 

resolved. 

 See all entitlements for a customer at a glance, and assign entitlements to customers and 

products automatically. 

 Use case timers to track key performance indicators (KPIs) for service level agreements 

(SLAs) to ensure customer commitments are met. 

 Monitor social media conversations to identify and resolve emerging issues before they 

escalate. 

 Define case relationships to stay on top of details for all related cases and work more 

efficiently. 

Take a look at these two new eBooks to learn more: eBook: Meet your service goals with SLAs 

and entitlements and eBook: What’s new in CRM customer service? 

The new customer service features are included with product updates, so if you don’t see 

them in your system, updates may not have been applied yet. Check with your system 

administrator. 

Important  

Important  

http://go.microsoft.com/fwlink/p/?LinkID=394707
http://go.microsoft.com/fwlink/p/?LinkID=394707
http://go.microsoft.com/fwlink/p/?LinkID=393186
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Set up and manage service features in the new Service Management area 

In the new Service Management area, a customer service manager can configure all service-

related features from a single location. To check out this new area:  Go to Settings > Service 

Management. (How do I get there?)  

Some new ways to manage customer service through the Service Management area include: 

 Define case relationships so that parent and child cases automatically inherit settings when 

closed. 

 Use routing rules so that cases are automatically assigned to agents or queues.  

 Specify the level of support and types of entitlements for multiple channels. 

 Define and track service KPIs through SLAs. 

 Define support hours and associate schedules with service level agreements. 

The new customer service features are included with product updates, so if you don’t see 

them in your system, updates may not have been applied yet. Check with your system 

administrator. 

Gain insights from social networks like Facebook and Twitter with Microsoft Social 

Engagement 

Microsoft Social Engagement is a powerful new analytics service that enables your organization 

to monitor social media channels like Twitter and Facebook. Use Social Engagement to track 

products, brands, competitors, and campaigns globally, and in real time, to gain a true 

understanding of your customers and your business across the social web. 

With Social Engagement, you can scour the web to see what people are saying about your 

company and products. You can track sentiment across channels, identify top influencers, stay on 

top of the latest information and trends, get competitive insights, and more. 

 See how the total volume of posts is trending over time. Social Engagement captures the 

information you need in easy-to-read charts.  

You can track information in 19 languages across Twitter, Facebook, blogs, and videos. 

 Get a true understanding of sentiment. At a glance, see how people perceive your 

product, service, or brand. To figure out which posts are positive, negative, or neutral, Social 

Engagement analyzes keywords and phrases in the native languages, which means it also 

picks up on cultural cues. 

 Follow spikes in positive or negative sentiment. Use the information gleaned from Social 

Engagement to seize an opportunity or to proactively work to change the social conversation 

in your favor. 

 Track how your marketing or service campaign is doing. After rolling out a campaign, 

listen for reactions on Facebook, Twitter, blogs, and in videos to see what’s working and what 

isn’t. Then make adjustments to your campaign based on the social conversation. 

 Gain social insights. Analyze social media conversations about your competitors, 

customers, and prospects. 

New CRM apps for Windows Phone, iPhone, and Android 

Important  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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With the new smartphone apps, you can now access important customer information from your 

phone. 

Download the app from Windows Marketplace, Apple Store, or Google Play, or check with your 

CRM admin (if that's someone other than you) for instructions for your organization. 

Key features: 

 See your CRM data quickly displayed and optimized for a mobile screen. 

 Add and modify contacts, tasks, and notes as well as other relevant sales data. 

 View activity feeds and see addresses on Bing Maps. Windows Phone only. 

 Get back to recently viewed records even when you’re not connected. Windows Phone only. 

 All this with no additional license fees. 

New CRM apps for Windows 8 mobile devices or your iPad  

 Microsoft Dynamics CRM for tablets helps you stay connected and productive wherever you are. 

Use your Windows 8 device or iPad to stay up to date with your customer info — even when 

you’re on the go. Arrive prepared for every appointment, and update your notes, tasks, contacts, 

accounts, and leads while the details are still fresh in your mind. 

Download the app from Windows Marketplace or the Apple Store, or check with your CRM admin 

(if that’s someone other than you) for instructions for your organization. 

 Works with:        

  Windows 8 (including Microsoft Surface Pro or Surface RT) 

  iPad (4th Gen) 

  iPad (3rd Gen) 

 Key features:        

 Access your activities, accounts, contacts, leads, and opportunities from an easy-to-use 

dashboard. 

 Quickly enter customer data with only a few taps. 

 Use charts to track progress on key performance indicators. 

 Use Skype to communicate with your contacts. 

 Access your personalized views of lists to see the data that’s most important to you. 

 Pin tiles to the app dashboard to get to the info you need quickly. 

 All this with no additional license fees. 

New business processes help you follow best practices for common scenarios 

Check out the Microsoft Dynamics Marketplace for several business process solutions that help 

organizations like yours follow best practices for common scenarios. These solutions help you 

save time by giving you a great starting point for creating business processes that match the way 

you do business. More information: Business process templates for CRM     

The system also comes with several business processes already installed. You can use them as-

is or edit them as needed. More information: Add ready-to-use business processes  

For a short, easy-to-read intro to business processes, check out the eBook: Business processes. 

This eBook is designed to help users get up and running quickly. 

http://go.microsoft.com/fwlink/p/?LinkID=321480
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For a step-by-step guide to changing a business process to match the way your organization 

does things, check out the eBook: Customize a business process. This eBook is intended for 

administrators or managers. 

Announcing Social Insights powered by InsideView 

With Social Insights, powered by InsideView, your Microsoft Dynamics CRM account information 

goes from static to dynamic with constant updates to three essential types of information — data, 

insights, and connections. InsideView applies proprietary triangulation and validation techniques 

across 30,000+ sources and millions of company and people profiles to deliver relevant, accurate 

company and contact information that helps sellers find more leads, win more deals, and retain 

and grow customer accounts.  Microsoft Dynamics CRM  brings Social Insights to you with every 

Microsoft Dynamics CRM Online Professional license at no additional charge (U.S. only). 

Learn more about Social Insights  

New Power Query connector streamlines connections to CRM Online 

With the new Power Query connector, you can connect more easily to Microsoft Dynamics CRM 

Online data from Power Query. After selecting the From Dynamics CRM Online connector in 

Power Query, just add a URL feed, and then enter your credentials. Power Query connects and 

retrieves the list of tables and entitles from CRM. It’s as easy as that. 

Get ready for the next release 

New features are continually becoming available! If you administer, configure, or install Microsoft 

Dynamics products and services, watch this page for information about ongoing releases — and 

how to prepare your organization. 

horizontaltabbed 

Fall 2015 

The Microsoft Dynamics CRM 2016 release, and the Microsoft Dynamics Marketing 2016 Update 

are available now. Microsoft Social Engagement 2016 Update 1 will continue to roll out over the 

upcoming months.  
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Support 

http://go.microsoft.com/fwlink/p/?LinkID=386368
http://www.insideview.com/microsoft-social-insights
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New features 

Here are a few highlights: 

Microsoft Dynamics CRM 2016 

Productivity: 

 Dynamics CRM App for Outlook (CRM Online only): This new lightweight email tracking app 

makes it easy to track incoming or outgoing email and preview relevant CRM information 

right in your Inbox. Add contacts or create new CRM records to track email. Dynamics CRM 

App for Outlook works with Microsoft Outlook on the web (included in Office 365), Outlook for 

the desktop, or Outlook for Mac. It also works with phones and tablets. 

 Office Delve (CRM Online only): Get content that's most relevant to what you're working on 

and what's trending around you. Add Delve to your dashboards to automatically search 

through documents and find that one document that helps you close a sale. 

 Cortana integration (CRM Online only): CRM 2016 takes Cortana integration to the next level, 

by embedding sales activities, accounts, and opportunities, to surface what’s most relevant to 

salespeople at any time. This feature is coming after the CRM 2016 release. 

Cortana integration will be available as a preview feature for CRM Online 2016 

Update customers. Preview features are not supported by Microsoft and will be 

available on an opt-in basis.  

 Excel integration: View sales data in familiar Excel templates, perform what-if analysis, and 

upload the changes, all from CRM. Export and analyze data in Excel from your mobile device 

with added support for the CRM mobile apps (tablets and phones).    

 OneDrive for Business: You can use the right storage option for the right situation. For 

example, store your private documents using the new OneDrive for Business option. For 

collaborative storage, use Office 365 Groups (CRM Online only), and to share documents 

with a larger team or the whole company, use SharePoint. 

OneDrive for Business is currently available only in SharePoint Online and will be 

available on-premises in SharePoint 2016.  

 Document generation: Building personalized sales documents based on CRM data just got 

easier with document generation. With one click you can easily generate a document from 

CRM using predefined Word and Excel templates. 

Mobility: 

 Task flows (CRM Online only): Bring data from multiple entities together into a single user 

experience. For example, when you want to reach out to a contact on a deal, all relevant data 

is brought together in a coherent fashion so that you don't have to visit all the involved 

records (opportunities, contacts, and accounts).  

Note  

Note  

Note  

crm-app-for-outlook-user-s-guide.aspx
view-relevant-and-trending-information-with-office-delve.aspx
analyze-your-data-with-excel-templates.aspx
use-onedrive-for-business-to-manage-your-private-documents.aspx
using-word-templates-in-crm.aspx
preview-feature-create-a-new-task-flow.aspx
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Task flows will be available on phones and tablets as a preview feature for CRM 

Online 2016 Update customers. Preview features are not supported by Microsoft and 

will be available on an opt-in basis.  

 Document management: View documents in the context of opportunities, cases, or any other 

entity, right in the CRM mobile apps. Seamlessly open various Office documents stored in 

SharePoint or OneDrive for Business from within the CRM mobile apps (tablets and phones).   

 Modern mobile friendly experience: We’re adding a variety of modern user interface (UI) 

controls, such as slider and calendar controls, for mobile apps. These new UI controls work 

across all mobile clients (tablets and phones) providing an engaging and immersive mobile 

experience.  

 Preview forms: With the new mobile form previewer, see your mobile forms before deploying 

to CRM mobile apps (tablets and phones). Configure once and deploy everywhere.  

 Mobile Management: Manage just about any device with Microsoft Intune, which provides 

mobile device management, mobile application management, and PC management 

capabilities from the cloud.  

 App-to-app deep linking:Enables other mobile apps (such as email or your custom web-

based app) to link and directly navigate to a record, view, or dashboard in CRM mobile apps.  

Service: 

 Interactive service hub: Dashboards and forms have been completely redesigned for the 

interactive service hub. Visual filtering and applied filtering in the new dashboards will help 

you prioritize your workloads and complete your most urgent tasks. The interactive service 

hub comes with a multi-stream dashboard for use by, for example, Tier 1 agents, and a 

single-stream dashboard for use by, for example, Tier 2 agents.  

 Knowledge management: With the new interactive service hub, you can also turn customer 

feedback and issues into knowledge articles. Use the rich text editor to create and manage 

articles that include embedded videos and images. 

 Field services: Field services allow you to more effectively manage distributed services where 

technicians and mobile resources are on the road delivering service and support for your 

customers. 

 Survey designer: With the new Voice of the Customer survey designer you can create and 

send out questionnaires to collect feedback from customers about your products or services. 

Customers can take a survey on a phone, tablet, or computer. When a customer completes a 

survey, you can use rules to trigger follow-up actions that occur immediately. This feature is 

coming after the CRM 2016 release. 

An Azure subscription is required to host surveys. 

 Unified Service Desk 2.0: Experience an improved setup that includes prerequisite 

installation, an updated wizard, and unattended support. We’ve added centralized auditing 

and diagnostics management. We also included the ability to distribute custom controls by 

using customization files. For more information, see What’s new in Unified Service Desk for 

administrators. To learn more about how to extend and integrate Unified Service Desk 2.0, 

see the developer guide.  

Note  

manage-accounts-contacts-leads-and-opportunities-in-crm-for-phones-and-tablets.aspx
https://technet.microsoft.com/library/dn531078(v=crm.8).aspx
https://technet.microsoft.com/library/d53fed89-9cbc-4f1d-b5ef-044bfd34b02f(v=CRM.8).aspx
use-intune-management-with-the-crm-mobile-apps.aspx
https://msdn.microsoft.com/library/gg309589(v=crm.8).aspx#BKMK_OpenwithURL
user-s-guide-for-the-new-interactive-service-hub.aspx
user-s-guide-for-the-new-interactive-service-hub.aspx
FieldOne-from-Microsoft.aspx
https://technet.microsoft.com/en-us/library/dn798673(v=usd.2).aspx
https://technet.microsoft.com/en-us/library/dn798673(v=usd.2).aspx
https://technet.microsoft.com/en-us/library/dn798673(v=usd.2).aspx
https://msdn.microsoft.com/en-US/library/dn864923(v=usd.2).aspx
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 Service intelligence: An interactive Power BI dashboard provides Customer Service 

Managers (CSMs) with an aggregate view of customer service performance. This feature is 

coming after the CRM 2016 release. 

Platform: 

 Hybrid server-side synchronization(CRM Online only): If you currently use CRM Online and 

Exchange Server (on-premises), and you synchronize email, appointments, contacts, and 

tasks with CRM, or if you synchronize email with the Email Router, you can synchronize 

using server-side synchronization. 

 No-code business rules: Business analysts can now define their own business logic, which 

makes it less costly to define and maintain rules. 

 Solution segmentation: Get tighter control over distribution of solutions and solution patches 

by exporting selected components instead of entire entities. 

 For full details about new features for developers, check out the CRM 2016 SDK. 

Many CRM Online 2015 Update 1 features now apply to CRM 2016 (on-premises). 

For a summary of CRM Online features that now apply to CRM 2016 (on-premises), 

see What's new for administrators and customizers in Microsoft Dynamics CRM and 

CRM Online. 

 Want to know more? 
 

See what’s new 

See what’s new for administrators and 

customizers 

Download the Release Preview Guide 

Read the Blog post: Microsoft Dynamics CRM 

2016 – Delivering the Next Generation of 

Intelligent Customer Engagement  

Check out the video demo of the new features 

Read about preview features and how to enable 

them 

 

 

Dynamics Marketing  

 SMS marketing: Create powerful Short Message Service (SMS) text message campaigns as 

well as integrate SMS marketing in your multichannel campaigns. Dynamics Marketing will 

support both outbound and inbound SMS marketing in select markets. Configure inbound 

SMS campaigns with keywords to get opt-ins, maintain a database of opt-in and opt-out 

preferences of your marketing contacts, send outgoing promotional text messages to opted in 

contacts for SMS, and track performance of your campaigns. This feature is available in the 

U.S., U.K., Singapore, and Canada. 

 Email marketing: You’ll see enhanced email editor features that make it easier to use for 

marketers including new capabilities to see the generated HTML in emails. With 

Note  

https://technet.microsoft.com/library/40615715-8b68-4152-918d-aa7498a28553(v=CRM.8).aspx
https://technet.microsoft.com/library/5c05f683-e1bd-4885-be23-b6973128773f(v=CRM.8).aspx
https://msdn.microsoft.com/library/gg309589(v=crm.8).aspx
https://technet.microsoft.com/library/dn531078(v=crm.8).aspx
https://technet.microsoft.com/library/dn531078(v=crm.8).aspx
what-s-new.aspx
https://technet.microsoft.com/library/dn531078(v=crm.8).aspx
https://technet.microsoft.com/library/dn531078(v=crm.8).aspx
http://go.microsoft.com/fwlink/p/?LinkId=624861
http://go.microsoft.com/fwlink/p/?LinkId=624862
http://go.microsoft.com/fwlink/p/?LinkId=624862
http://go.microsoft.com/fwlink/p/?LinkId=624862
http://go.microsoft.com/fwlink/p/?LinkId=624863
http://go.microsoft.com/fwlink/p/?LinkId=624864
http://go.microsoft.com/fwlink/p/?LinkId=624864
http://go.microsoft.com/fwlink/p/?LinkId=698469
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improvements in the advanced editing experience, it will also be possible to use the media 

library directly from the HTML code.  Additionally, we’re making service enhancements to 

scale our service in the backend. This will improve our service’s ability to handle high email 

volume, improve email deliverability, provide fault tolerance, and facilitate logging and 

auditing. For information about the new view-generated-code feature, see Create or view 

email marketing messages. For details about the code editor with the new media library 

feature, see Design message content using the text-based code editor 

For a complete list of new features in this update, see What’s new in Microsoft Dynamics 

Marketing. 

Social Engagement  

 Social listening and social analytics: In addition to Twitter, Facebook, blogs (such as 

WordPress and Tumblr), videos (such as YouTube) and news, you'll be able to add custom 

sources via RSS, including internal non-public sources.  

 Intelligent social: To increase team efficiency for sales and service organizations, Social 

Engagement will automatically detect potential leads versus cases. This will increase sales 

performance through suggestions on leads coming in from social channels as well as 

increase team efficiency for service organizations by identifying potential cases coming in 

through social channels. Through adaptive sentiment, Social Engagement will learn from 

curations of sentiment values to create domain-specific models.  

 Group collaboration: Define and set up groups to provide a more streamlined cross-group 

collaboration experience similar to Office 365. 

 Social center: Publish tweets and Facebook posts from within a social center, including rich 

multimedia content. Author lookup provides additional information regarding the post author, 

including the number of followers and followings. 

 Sentiment and localization languages:  In addition to English, French, German, Italian, 

Portuguese and Spanish, Social Engagement will be adding nine additional languages: 

Danish, Dutch, Finnish, Greek, Norwegian, Polish, Russian, Swedish, and Turkish.    

For information about the new release of Social Engagement, see What's new in Microsoft Social 

Engagement. 

Release timing 

Please visit this page periodically to get the most current information about the upcoming 

versions. 

How to get the updates 

Dynamics CRM Online  

 You'll be able to schedule the specific date when your update occurs. We call this a 

customer-driven update since you “drive” the timing of the update to be the most suitable for 

your organization. For more information about our update policy and how this works for CRM 

Online, read TechNet: Manage Microsoft Dynamics CRM Online updates.   

Dynamics CRM 

 Microsoft Dynamics CRM 2016 will be delivered for both online and on-premises customers 

except where noted. 

Dynamics Marketing  

http://go.microsoft.com/fwlink/p/?LinkId=698581
http://go.microsoft.com/fwlink/p/?LinkId=698581
http://go.microsoft.com/fwlink/p/?LinkId=698582
http://go.microsoft.com/fwlink/p/?LinkID=518219
http://go.microsoft.com/fwlink/p/?LinkID=518219
http://go.microsoft.com/fwlink/p/?LinkId=400706
http://go.microsoft.com/fwlink/p/?LinkId=400706
https://technet.microsoft.com/library/dn308237.aspx
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 The customer-driven update process will give admins better control over when new updates 

of Dynamics Marketing will be rolled out for your organization. For more information about 

how this works, read Manage Dynamics Marketing updates. 

Social Engagement  

 The listed administrator within your organization will be notified by email about the specific 

timing of your update to the next version. These updates will happen automatically and 

Microsoft will send several reminder communications, with the details, as the scheduled 

update approaches.   

How to prepare for updates 

Test the updates in a sandbox environment. We always advise that you preview and test new 

versions in a non-production environment before you update your live production instances. This 

will give you the opportunity to verify the compatibility of any customizations that you may have 

made, or any third-party customizations that are installed. Additionally, testing will also allow you 

to assess the impact of the upcoming changes on your organization and your users. If you 

haven't already done so, we strongly advise obtaining a non-production instance. 

 Manage CRM Online sandbox instances   

How to stay informed 

 Keep checking this page.  

 We update this page with more information for administrators and users on the specific 

features as the release dates approach.  

 Keep others in the know.  

 Add more recipients to receive communications from within the CRM Online Administration 

Center. For more information, read TechNet: Manage email notifications. 

 Visit these resources for info about current versions:  

Microsoft Dynamics CRM Help Center  

Microsoft Dynamics Marketing  Help Center 

Microsoft Social Engagement Help Center 

Microsoft Dynamics CRM eBooks and videos 

Service communications 

Want more information about the types of emails we send you? Check out TechNet: Policies and 

Communications for CRM Online Updates. 

Support 

Connect with Support resources  or browse questions and answers in the Microsoft Dynamics 

CRM Forum — or you can always contact your partner. 

Spring 2015 

Microsoft Dynamics CRM Online 2015 Update 1, Microsoft Dynamics Marketing 2015 

Update 1 and 1.1,  Microsoft Social Engagement 2015 Update 1and 1.1 (formerly Microsoft 

Social Listening), and Parature, from Microsoft 15.2. 

 

http://go.microsoft.com/fwlink/p/?LinkId=524776
https://technet.microsoft.com/library/eac51914-ed22-4ed1-86c0-c21ece97ddb2.aspx
https://technet.microsoft.com/library/dn467369.aspx
http://go.microsoft.com/fwlink/p/?LinkID=296269
http://go.microsoft.com/fwlink/p/?LinkID=398097
http://go.microsoft.com/fwlink/p/?LinkID=394325
http://go.microsoft.com/fwlink/p/?LinkID=616806
https://technet.microsoft.com/library/mt126100.aspx
https://technet.microsoft.com/library/mt126100.aspx
http://go.microsoft.com/fwlink/p/?LinkId=511507
http://go.microsoft.com/fwlink/p/?LinkId=511669
http://go.microsoft.com/fwlink/p/?LinkId=511669
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New features 

These are just a few of the highlights: 

Dynamics CRM Online 

 Improved navigation and user interface options: Increase adoption with an improved user 

experience, including new UI themes and faster navigation to records. 

 Track email by folder: Folder tracking provides a new and intuitive way to track incoming 

email activities on any device that supports Exchange. Now you can track your email directly 

from virtually any device. Watch a short video (2:37) about Exchange folder tracking. 

 Track incoming email wherever you are: Use the new Microsoft Dynamics CRM App for 

Outlook to track incoming email and view CRM information about the people sending you 

email. You can use the new app with the desktop version of Outlook on the web (included in 

Office 365) or Outlook 2013. For more information, see the CRM App for Outlook User's 

Guide (lightweight app). 

This preview feature is available for CRM Online customers. Preview features are not 

supported by Microsoft and will be available on an opt-in basis. 

 Immersive Excel experience: Now you can use Microsoft Excel Online to do quick analysis 

right from CRM Online. Watch a short video (2:45) about doing “What if” analysis with Excel 

Online. 

 Excel export completely redesigned: With a single click, you can export to Excel anywhere, 

including the desktop version of Excel (2007 and later), Excel Online, and other Excel clients. 

For more information, see Export data to Excel. 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=534781
http://go.microsoft.com/fwlink/p/?LinkId=534788
http://go.microsoft.com/fwlink/p/?LinkId=534788
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 New Power Query connector: Use the new connector to easily retrieve data from CRM Online 

for self-service business intelligence (BI). 

 Create Office 365 Groups: Collaborate with team members who don’t have access to CRM 

Online with Office 365 Groups. For example, create a group for your sales team, invite other 

Office 365 users to join the group, and then share documents, email, OneNote notes, and 

more. For more information, see TechNet: Deploy Office 365 Groups. 

 Embedded OneNote: Capture photos, take voice notes, do free-form drawings, and more. 

Everything is automatically linked with the record in CRM Online. Watch a short video (2:12) 

about OneNote integration in Dynamics CRM. 

 Social sales: Define rules for creating or updating CRM records from incoming activities. For 

example, you can now generate leads or opportunities from social posts. For more 

information, see Set up rules to automatically create or update records in CRM. 

 Mobile sales: With the new Microsoft Dynamics CRM for phones app, enjoy the same great 

mobile experience on your phone as you do on your tablet. Nurture your leads and 

opportunities through the sales process with the new intuitive interface. Watch a short video 

(5:02) about the new CRM for phones app. 

 Secure your mobile data: Microsoft Dynamics CRM for Good, integrated with Good 

Dynamics, protects your CRM data even if you lose or leave your tablet somewhere. For 

more information, see Secure your mobile data with Microsoft Dynamics CRM for Good. 

Additional fees apply. 

 Integrated Parature knowledge base: Empower agents with knowledge base integrated into 

daily service interactions, including the ability to both search and receive automated 

suggestions. For more information, see Find knowledge articles from within a record in CRM. 

 Significantly improved form performance: A newly built form rendering engine provides fast 

form load while maintaining compatibility. You don’t have to do anything to take advantage of 

faster forms — they’re enabled by default. If you think you have forms that include 

unsupported customizations, see the How to prepare for updates section. 

 Want to know more? 
 

Read the Release Preview Guide 

TechNet: What’s new for administrators and 

customizers 

What's New in Microsoft Dynamics CRM 

Get around in Microsoft Dynamics CRM, CRM 

for Outlook, and mobile devices 

Read about Preview features and how to 

enable them 

 

 

Dynamics Marketing 

Update 1: 

https://technet.microsoft.com/library/d3646c17-1344-490f-9612-6c8cb63e213f
http://go.microsoft.com/fwlink/p/?LinkId=534833
http://go.microsoft.com/fwlink/p/?LinkId=534833
http://go.microsoft.com/fwlink/p/?LinkId=529571
http://go.microsoft.com/fwlink/p/?LinkId=529571
http://go.microsoft.com/fwlink/p/?LinkId=395093#bkmk_HowPrepCarina
http://go.microsoft.com/fwlink/p/?LinkId=529439
https://technet.microsoft.com/library/dn531078.aspx
https://technet.microsoft.com/library/dn531078.aspx
what-s-new.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
what-are-preview-features-and-how-do-i-enable-them.aspx
what-are-preview-features-and-how-do-i-enable-them.aspx
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 Separation of service bus namespace for SDK and Connector: You can now configure 

Microsoft Dynamics Marketing SDK and Microsoft Dynamics Marketing Connector for 

Microsoft Dynamics CRM with different service bus namespaces. 

 Microsoft-owned queues for CRM Online integration: Microsoft Dynamics Marketing now 

provides managed service buses for CRM Online integration. You don’t need to have a 

Microsoft Azure subscription and service bus namespace for CRM Online integration.  

 Double opt-in for email marketing: Send an opt-in link to incoming contacts to verify them. 

Double opt-in helps you to maintain lead quality and remain compliant with regional 

regulations. Watch a short video (2:50) about double opt-in capabilities.  

 Duplicate detection in email messages: Configure your instance so that email messages are 

delivered only once per email inbox and avoid sending multiple emails to duplicate contact 

records.  

 Assets & media improvements: Tag your assets using multiple keywords and use the 

improved keyword based search to filter them.  

 Expanded Analytics with OData and Excel with Power BI: Create beautiful, informative 

reports based on real-time data drawn directly from Dynamics Marketing. With this release, 

we continue to add expanded support for more OData feeds and Power BI features. In 

addition, Dynamics Marketing now provides an all-new collection of dashboard widgets that 

enable you to embed specially targeted Power BI data and graphs right on your home page, 

widget dock, company records, and/or campaign records. Watch a short video (3:13) about 

using PowerBI to connect to Microsoft Dynamics Marketing 

Update 1.1: 

 Connector wizard for Microsoft Dynamics CRM (on-premises): The Microsoft Dynamics 

Marketing Connector for Microsoft Dynamics CRM now includes a connector wizard that 

makes it easier to install or update the connector when you use it with Microsoft Dynamics 

CRM (on-premises). The wizard is not necessary when you set up a connection to Microsoft 

Dynamics CRM Online. 

 Improved reporting during campaign automation:  The campaign automation canvas now 

displays the last-run and next-run times for each tile and for the campaign itself, so you can 

see how recently each tile ran and the next time it will run. In addition, the email tile now 

shows sent, opened, bounced, and blocked statistics. More information: Automate campaigns 

with the campaign canvas  

 Improved email delivery reporting: In addition to the ability to view detailed delivery and 

performance statistics for each marketing email, the display now offers even more details 

about delivery, including issues related to duplicate detection, cross-campaign rules, and 

contact settings. In each case, you can drill down to view a list of specific affected contacts. 

More information: Track blocked and unsubscribed email messages    

For more information about the update, see What's New in Microsoft Dynamics Marketing. 

Social Engagement 

Update 1: 

 User Interface: Completely redesigned UI throughout the application for an even more 

intuitive and simplified user experience with visual contextual filtering capabilities.  

http://go.microsoft.com/fwlink/p/?LinkID=615553
http://go.microsoft.com/fwlink/p/?LinkId=615554
http://go.microsoft.com/fwlink/p/?LinkId=615554
http://go.microsoft.com/fwlink/p/?LinkId=622982
http://go.microsoft.com/fwlink/p/?LinkId=622982
http://go.microsoft.com/fwlink/p/?LinkId=622984
http://go.microsoft.com/fwlink/p/?LinkID=518219
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 Social Analytics: Richer data with new visualizations, such as tag clouds, top hashtags, and 

geo-location for greater insights. 

 Social Center: User-specific configurable and shareable streams display social posts as they 

come in and allow you to proactively engage with both your fans and critics from Facebook 

and Twitter. 

 Social Profiles: You can now add authenticated Twitter and Facebook accounts, which allow 

users to interact with their audience on social posts coming from Twitter and Facebook. 

 Search Topic setup: Setting up search topics is easier and more flexible than ever. You can 

define rules by the following criteria: keyword, Facebook page, and Twitter handle. The 

projected quota usage is displayed, as well as a preview of Twitter posts, to give you an idea 

of the type of results you can expect. 

 Language & Geographic Availability:  Microsoft Social Engagement is available in 110 

markets and 19 languages. 

Update 1.1: 

 Visualize posts in real-time with activity maps: Create and manage activity maps to see real-

time visualizations of posts with location information. Show this on a large screen and let your 

audience know where your topics are being discussed in the world.   

 Analyze posts with unified sentiment: Sentiment values are no longer target specific, so you 

don't need to select a search topic to see sentiment values for the posts anymore. The 

sentiment value of a post is now determined regardless of the keywords that you chose while 

setting up your search topics.  

 Administer Social Engagement with a redesigned Settings area: All pages in the Settings 

area now adapt to the screen size of tablets. Additionally, Solution Defaults are now called 

Global Settings. 

 Download data to Excel: Widgets in the Analytics area of Social Engagement now let you 

export data points to a downloadable Excel file. Along with the visualized data points, 

additional details regarding the configuration of the data set are shared.  

 Expand the Authors widget to full view: You can now expand the Authors widget in the 

Analytics area to see, and work with, up to 100 records. You can remove authors in bulk from 

your solution's data acquisition and add quick filters to include several authors at once.  

 Provide delegated administration privileges to Microsoft cloud service providers: Customers 

can now delegate the administration of their Social Engagement solution to a cloud service 

provider, without adding the service provider as a licensed user. 

For information about the new release of  Microsoft Social Engagement, download your copy of 

Prepare for Microsoft Social Engagement and share it with your organization’s users. You can 

also watch a short video (3:55) about updates to Social Engagement. 

Parature 

 Unified portal: Enterprise organizations with a single public-facing brand presence can now 

easily deliver online support and self-service knowledge for a variety of departments or 

product lines, all while using a single service desk to consistently manage the brand’s 

customer support. 

http://go.microsoft.com/fwlink/p/?LinkId=532520
http://go.microsoft.com/fwlink/p/?LinkId=613104
http://go.microsoft.com/fwlink/p/?LinkId=613104
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 Enhanced knowledge search capabilities: Advanced search capabilities in the Parature 

knowledge base deliver more relevant results, with added search filters to search for 

knowledge based on highest feedback ratings, document type, date added or updated, etc. 

 Multi-lingual service and globalization:  Enable assisted service in local languages with 

routing based on customer language preference and real-time chat translation.  Provide 

translations for Knowledgebase articles and portal strings to empower customers with self-

service in local languages. 

 Portal specific metrics for reports: Create more accurate reports with metrics provided for 

each Portal Alias. Capture Key Point Indicators to help identify the efficacy of each Portal 

Alias. 

For more information, download the Parature Spring '15 Release Preview Guide.  

Technical Changes 

From time to time, we must add and remove items from our supported configurations list to keep 

current with technology and allow us to provide you the best product possible. Stay tuned for 

important information about any changes to supported configurations. 

Release Timing 

The updates for Dynamics CRM Online, Dynamics Marketing, Microsoft Social Engagement, and 

Parature are available now. Please visit this page periodically to get the most current information 

about the upcoming versions. 

How to get the updates 

Dynamics CRM Online 

 Updates for online customers: You’ll be able to schedule the specific date when your update 

occurs. We call this a customer-driven update since you “drive” the timing of the update to be 

the most suitable for your organization. For more information about our update policy and 

how this works for CRM Online, read TechNet: Manage Microsoft Dynamics CRM Online 

updates or watch a short video about Customer Driven Updates in CRM Online 2015 Update 

1. 

Dynamics Marketing 

 The listed administrator within your organization will be notified by email about the specific 

timing of your update to the next version. Microsoft will send several reminder 

communications as the scheduled update approaches. 

 The new customer-driven update process will give admins better control over when new 

updates of Dynamics Marketing will be rolled out for your organization. For more information 

about how this works, read Manage Dynamics Marketing updates. 

Social Engagement 

 The listed administrator within your organization will be notified by email about the specific 

timing of your update to the next version. These updates will happen automatically and 

Microsoft will send several reminder communications, with the details, as the scheduled 

update approaches.   

Parature 

http://go.microsoft.com/fwlink/p/?LinkId=522047
https://technet.microsoft.com/library/dn308237.aspx
https://technet.microsoft.com/library/dn308237.aspx
http://go.microsoft.com/fwlink/p/?LinkId=532844
http://go.microsoft.com/fwlink/p/?LinkId=532844
http://go.microsoft.com/fwlink/p/?LinkID=524776
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 The listed administrator within your organization will be notified by email about the specific 

timing of the update to the next version. Microsoft will send several reminder communications 

as the scheduled update approaches. 

How to prepare for updates 

 Test the updates in a sandbox environment. We always advise that you preview and test new 

versions in a non-production environment before you update your live production instances. This 

will give you the opportunity to verify the compatibility of any customizations that you may have 

made, or any third-party customizations that are installed. Additionally, testing will also allow you 

to assess the impact of the upcoming changes on your organization and your users. If you 

haven't already done so, we strongly advise obtaining a non-production instance.  

 Video: Learn how to get access to a testing (sandbox) environment for Dynamics CRM 

 Learn how to get access to a testing (sandbox) environment for Parature, from Microsoft  

For questions, please contact Parature Support  

Manage customizations for CRM. With the newly built form rendering engine, unsupported 

customizations will likely fail. We encourage you to test your customizations, solutions, and 

scripts to ensure proper functionality with the improved form engine. 

More information: 

 Review important details about the new form rendering engine in the Microsoft Dynamics 

CRM team blog. 

 For JavaScript best practices, the Custom Code Validation Tool, and whether your scripts will 

work with all supported browsers, see MSDN: Use JavaScript with Microsoft Dynamics CRM. 

 To ensure your forms customization follow the recommended practices, check out TechNet: 

Create and design forms. 

Browser support for Parature. Parature supports all major browsers and their latest versions, 

including Internet Explorer, Google Chrome, and Mozilla Firefox. To make sure that you can take 

advantage of all the enhancements to the Service Desk and Support Portal, make sure that you 

update your browser to the latest version.  

Pricing and licensing 

 

 Microsoft Dynamics CRM Online solutions 

 Microsoft Dynamics CRM (on-premises) 

 Microsoft Dynamics Marketing 

 Microsoft Social Engagement 

 Parature, from Microsoft 

How to stay informed 

 Keep checking this page. 

We update this page with more information for administrators and users on the specific 

features as the release dates approach.   

 Keep others in the know.  

 Add more recipients to receive communications from within the CRM Online Administration 

Center. For more information, read TechNet: Manage email notifications. 

http://go.microsoft.com/fwlink/p/?LinkID=396524
http://go.microsoft.com/fwlink/p/?LinkID=522021
http://go.microsoft.com/fwlink/p/?LinkID=522215
http://go.microsoft.com/fwlink/p/?LinkID=544882
http://go.microsoft.com/fwlink/p/?LinkID=544882
https://msdn.microsoft.com/library/hh771584.aspx#BKMK_JavaScriptBestPractices
https://technet.microsoft.com/library/dn531143.aspx
https://technet.microsoft.com/library/dn531143.aspx
http://go.microsoft.com/fwlink/p/?LinkID=396442
http://go.microsoft.com/fwlink/p/?LinkId=396443
http://go.microsoft.com/fwlink/p/?LinkId=513086
http://go.microsoft.com/fwlink/p/?LinkId=401462
http://go.microsoft.com/fwlink/p/?LinkID=394691
https://technet.microsoft.com/library/dn467369.aspx
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 Visit these resources for info about current versions: 

Microsoft Dynamics CRM Help Center 

Microsoft Dynamics Marketing Help Center 

 Microsoft Social Engagement Help Center 

Parature, from Microsoft product page 

Microsoft Dynamics CRM eBooks and videos 

Microsoft Dynamics CRM video channel 

Microsoft Dynamics CRM Readme 

  

Service Communications 

Want more information about the types of emails we send you? Check out TechNet: Policies and 

Communications for CRM Online Updates. 

Think you missed an email about the latest update? Check out the communications we’ve sent 

for this release. 

FAQ 

Q: Do I need to be running a recent version of CRM Online to update to the newest 

version? 

A: Each customer scenario is different.  For detailed information about updates, please read our 

Update Policy. 

Q: I just purchased a new organization, but it is not scheduled. How do I make that 

happen? 

A: Don’t worry if you haven’t been contacted yet. Every week we schedule the new subscriptions 

into the update process, and notify you when your organization is scheduled. 

Q: How do I determine which version of CRM I have? 

A: Sign in to CRM, and in the upper right side of the screen, choose the Settings button.( )  > 

About. 

Q: How do I know which update scenario is best for my organization? 

A:  Your CRM Online update process depends on what version you have and how you’d like to 

update. Read more about update scenarios in TechNet: Manage Microsoft Dynamics CRM 

Online updates. 

Q: How do I see the status of my updates? 

A: If you’re a CRM admin, you can see the latest status of updates and incidents on the Office 

365 service health page. To learn how to get to the Office 365 service health page, see View the 

status of your services. 

Support 

Connect with Support Resources or browse questions/answers in the Microsoft Dynamics CRM 

Forum— or you can always contact your partner. 

For questions about Parature, please contact Parature Support.  

 

 

Fall 2014 

http://go.microsoft.com/fwlink/p/?LinkID=296269
http://go.microsoft.com/fwlink/p/?LinkID=398097
http://go.microsoft.com/fwlink/p/?LinkId=394325
http://go.microsoft.com/fwlink/p/?LinkID=522023
http://go.microsoft.com/fwlink/p/?LinkId=616806
http://go.microsoft.com/fwlink/p/?LinkId=518244
http://go.microsoft.com/fwlink/p/?LinkID=507692
https://technet.microsoft.com/library/mt126100.aspx
https://technet.microsoft.com/library/mt126100.aspx
emails-about-update-readiness-for-dynamics-crm-online.aspx
emails-about-update-readiness-for-dynamics-crm-online.aspx
http://go.microsoft.com/fwlink/p/?LinkId=544714
https://technet.microsoft.com/library/dn308237.aspx#BKMK_Scenarios
https://technet.microsoft.com/library/dn308237.aspx#BKMK_Scenarios
http://go.microsoft.com/fwlink/p/?LinkID=533345
http://go.microsoft.com/fwlink/p/?LinkID=533345
http://go.microsoft.com/fwlink/p/?LinkId=511507
http://go.microsoft.com/fwlink/p/?LinkId=511669
http://go.microsoft.com/fwlink/p/?LinkId=511669
http://go.microsoft.com/fwlink/p/?LinkID=522215
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Microsoft Dynamics CRM 2015, Microsoft Dynamics CRM Online 2015 Update, Microsoft 

Dynamics Marketing 2015 Update, and Parature 

 

The 2015 releases for Microsoft Dynamics CRM, Microsoft Dynamics Marketing, and Parature 

have arrived! These updates add enhancements to sales, marketing, and customer service 

functionality, and will also add features to facilitate marketing and sales team collaboration. 

 

 

 

 

 

 

On this page: 

Products updated 

New features 

Technical changes 

Release timing 

How to get the updates 

How to prepare for updates 

Pricing and licensing 

How to stay informed 

FAQ 

Support 

Products updated 

These products were affected by the 2015 release: 

 Microsoft Dynamics CRM online and on-premises versions  

 Microsoft Dynamics CRM for Outlook 

 Microsoft Dynamics CRM for tablets 

 Microsoft Dynamics CRM for phones 

 Microsoft Dynamics Marketing 

 Parature 

 

New features 

These are just a few of the highlights in the 2015 release: 

 Microsoft Dynamics CRM Online and on-premises  

 Create product families: Boost selling effectiveness with the ability to bundle products and 

recommend related products for cross-selling/up-selling opportunities.  
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 Use sales hierarchies:  Manage and report on your sales data in a way that maps to your 

business. New hierarchical visualizations and roll-ups bring real-time territory and forecasting 

data to your fingertips. 

 Mobile sales improvements: Increase field sales productivity with flexible, role tailored 

dashboards and analytics, personalized home pages and the ability to navigate by hierarchy.  

This version of the tablet app also includes improved support for disconnected scenarios. 

 Access CRM records on the go via voice commands: Cortana is now part of Microsoft 

Dynamics CRM! For customers with Windows Phone 8.1, you can now use conversational 

voice commands to seamlessly create follow-up appointments, tasks, and phone calls; 

quickly find information; view your customer lists; and more. Note: This feature will be 

available in English only in markets where Cortana is available. Read about Cortana voice 

commands for CRM in the topic Take a tour of CRM for phones express. 

 Enhanced sales processes: Guide sellers toward desired outcomes with enhanced branching 

logic within your sales processes. Increase impact via automation of business processes and 

enforcement of business rules across all devices.  

 Expanded case management functionality: Enable agents to provide differentiated levels of 

support with flexible Service Level Agreements (SLAs). Gain insight into service effectiveness 

with the ability to track and analyze key metrics like SLAs and thresholds. 

 Microsoft Social Engagement availability for Microsoft Dynamics CRM Online customers: 

With a minimum of 10 Professional users, you automatically have access to Social 

Engagement as part of your subscription at no additional charge. If you have an Enterprise 

subscription you also have access to Social Engagement, but with no minimum user 

requirement. To learn more, read Integrate Microsoft Social Engagement to Dynamics CRM. 

 Microsoft Social Engagement for on-premises CRM customers: You can now access Social 

Engagement directly from within Microsoft Dynamics CRM 2015 - even as an on-premises 

customer - and may also be eligible for a discounted rate. Contact your Microsoft Dynamics 

partner for more information. 

 Improvements in Dynamics CRM for Outlook:  Set up Dynamics CRM for Outlook quickly and 

easily with the completely redesigned Configuration Wizard. With Microsoft Dynamics CRM 

2015 for Outlook, users can sync assigned tasks and appointment attachments. Admins can 

control synchronization between pairs of fields, which provides confidence about where data 

is coming from and how it’s shared. For more information, see Set up CRM for Outlook. 

 Customizable help:  Personalize the user assistance by tailoring the in-product Help content 

to match the specifics of your Dynamics CRM implementation. You can modify what displays 

under the Help question-mark icon at either an entity-specific or organization-wide level. 

Please read TechNet: Customize the Help experience. 

For more detailed information about the 2015 release, see What's New in Microsoft Dynamics 

CRM. 

Microsoft Dynamics Marketing 

 Sales and marketing collaboration: Strengthen your marketing and sales synergies with the 

new Sales Collaboration Panel, which allows sellers to provide input into campaigns and 

targeting. 

 Manage multi-channel campaigns: Streamline campaign creation and improve segmentation 

with graphical email editing, A/B testing, integrated offers, and approval workflows. 

http://go.microsoft.com/fwlink/p/?LinkId=524279
https://technet.microsoft.com/library/dn832079.aspx
what-s-new.aspx
what-s-new.aspx
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 Improve B2B marketing: Deepen your lead management capabilities with webinar integration 

and improved lead scoring, including the ability to introduce multiple lead scoring models.   

 Enhanced marketing resource management: Gain unprecedented visibility into your 

marketing plan with the new Interactive Marketing Calendar and improve collaborative 

marketing with Lync click-to-call and webinars. 

 Gain social insights within Microsoft Dynamics Marketing: Display social information collected 

with Microsoft Social Engagement about your brand, campaigns, and more, all within 

Microsoft Dynamics Marketing. 

 Additional language & geographic availability:  Microsoft Dynamics Marketing is now 

available in Japanese and Russian, bringing the total to 12 languages and 37 

countries/regions currently supported. Find more information in the Microsoft Dynamics 

Marketing Translation Guide. 

For more information about the update, see What’s New in Microsoft Dynamics Marketing  

Parature 

There are many exciting new capabilities in Parature, including:  

 Knowledgebase management and reporting improvements 

 Comprehensive service desk configurations 

 Support ticketing enhancements 

 Insights into customer self-service/portal usage 

 Mobile service desk enhancements 

 New social channel monitoring 

 Real-time chat translation 

 Further integration with Microsoft Dynamics CRM 

 And more 

For more information, download the Parature, from Microsoft Spring ’15 Release Preview Guide.  

Technical changes 

We want to keep you apprised of new features in the 2015 releases, but you also need to know 

about technical changes that could have an impact on your organization.  For example, as with 

previous releases of Microsoft Dynamics CRM, we add and remove items from our supported 

configurations list to keep current with technology and allow us to provide you the best product 

possible. 

For more information, please read: 

 TechNet: What's new for administrators in Microsoft Dynamics CRM 2015 and CRM Online 

 Important information about supported configurations in Microsoft Dynamics CRM 

 TechNet: Manage Microsoft Dynamics CRM Online updates 

 CRM admin top links 

 Video: Upgrading from Microsoft Dynamics CRM 2013 to 2015 

 TechNet: What's new in Marketing Connector for Microsoft Dynamics CRM 

 Parature, from Microsoft – Latest Release Notes 

Release timing 

http://go.microsoft.com/fwlink/p/?LinkId=401458
http://go.microsoft.com/fwlink/p/?LinkId=401458
http://go.microsoft.com/fwlink/p/?LinkID=518219
http://go.microsoft.com/fwlink/p/?LinkId=522047
https://technet.microsoft.com/library/dn531078.aspx
http://go.microsoft.com/fwlink/p/?LinkId=521429
https://technet.microsoft.com/library/dn308237.aspx
http://go.microsoft.com/fwlink/p/?LinkId=524096
https://technet.microsoft.com/library/dn841366.aspx
http://go.microsoft.com/fwlink/p/?LinkId=522020
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The 2015 release for Microsoft Dynamics CRM, Microsoft Dynamics Marketing, and Parature is 

available now. Please visit this page periodically to get the most current information about the 

upcoming versions.   

How to get the updates 

Microsoft Dynamics CRM: 

 Updates for online customers: You’ll be able to schedule the specific date when your update 

occurs. We call this a customer-driven update since you “drive” the timing of the update to be 

the most suitable for your organization. It will be necessary for the CRM administrator to 

formally approve the update before the update can occur. If you haven’t yet updated to the 

Spring ’14 version, features that were added then will also be enabled during this 

update.  For more information about how this works for Microsoft Dynamics CRM, read 

TechNet: Manage Microsoft Dynamics CRM Online updates or watch a short video about the 

Update process enhancements with Microsoft Dynamics CRM Online 2015 Update (3:33). 

 Updates for on-premises customers: Customers who are current on their Microsoft Software 

Assurance Plan or Business Ready Enhancement Plan will be able to get updates after the 

final product release. Learn more about Microsoft Dynamics Service Plans. 

Microsoft Dynamics Marketing: 

 The listed administrator within your organization will be notified by email about the specific 

timing of your update to the next version. Microsoft will send several reminder 

communications as the scheduled update approaches. 

 Should this scheduled date not be suitable for your organization, you will have an opportunity 

to reschedule the date through a service request.   

 Keep looking for emails with more specific instructions for updating Microsoft Dynamics 

Marketing. 

Microsoft Social Engagement: 

 The listed administrator within your organization will be notified by email about the specific 

timing of your update to the next version. These updates will happen automatically and 

Microsoft will send several reminder communications, with the details, as the scheduled 

update approaches.   

Parature: 

 The listed administrator within your organization will be notified by email about the specific 

timing of the update to the next version. Microsoft will send several reminder communications 

as the scheduled update approaches. 

How to prepare for updates 

 Test the updates in a sandbox environment. We always advise that you preview and test new 

versions in a non-production environment before you update your live production instances. This 

will give you the opportunity to verify the compatibility of any customizations that you may have 

made, or any third-party customizations that are installed. Additionally, testing will also allow you 

to assess the impact of the upcoming changes on your organization and your users. If you 

haven't already done so, we strongly advise obtaining a non-production instance.  

 Video: Learn how to get access to a testing (sandbox) environment for Dynamics CRM 

 TechNet: Manage Microsoft Dynamics CRM Online instances 

https://technet.microsoft.com/library/dn308237.aspx
http://go.microsoft.com/fwlink/p/?LinkId=519047
http://go.microsoft.com/fwlink/p/?LinkID=396552
http://go.microsoft.com/fwlink/p/?LinkID=396524
https://technet.microsoft.com/library/dn308237.aspx
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 Read TechNet: Before you upgrade: issues and considerations (applies to on-premises only) 

 Learn how to get access to a testing (sandbox) environment for Parature, from Microsoft  

For questions, please contact Parature Support  

Upgrading to a new version of Microsoft Dynamics Marketing. We have designed the 

upgrade process to be as quick, easy, and trouble-free as possible, but you should still be aware 

of the process and some possible issues. If you are upgrading from a previous version of 

Microsoft Dynamics Marketing, find out what to expect by reading Upgrading from an earlier 

version. 

Browser support for Parature. Parature supports all major browsers and their latest versions, 

including Internet Explorer, Google Chrome, and Mozilla Firefox. To make sure that you can take 

advantage of all the enhancements to the Service Desk and Support Portal, make sure that you 

update your browser to the latest version.  

Manage customizations for Dynamics CRM. Three deprecated form scripting methods have 

been removed; you’ll want to make sure your code isn’t using those methods before you update. 

There’s also a tool that a developer can run before an update to identify scripts that should be 

evaluated. For specifics, see MSDN: Deprecated form script methods removed (part of MSDN: 

What’s new for Developers). 

Browser support for Parature.  Parature supports all major browsers and their latest versions, 

including Internet Explorer, Google Chrome, and Mozilla Firefox. To make sure that you can take 

advantage of all the enhancements to the Service Desk and Support Portal, make sure that you 

update your browser to the latest version.  

Upgrading to a new version of Microsoft Dynamics Marketing. We have designed the 

upgrade process to be as quick, easy, and trouble-free as possible, but you should still be aware 

of the process and some possible issues. If you are upgrading from a previous version of 

Microsoft Dynamics Marketing, find out what to expect by reading Upgrading from an earlier 

version. 

Pricing and licensing 

 

 Microsoft Dynamics CRM Online solutions 

 Microsoft Dynamics CRM (on-premises) 

 Microsoft Dynamics Marketing 

 Microsoft Social Engagement 

 Parature, from Microsoft 

How to stay informed 

 Keep checking this page. 

We update this page with more information for administrators and users on the specific 

features of the 2015 updates as the release dates approach.   

 Keep others in the know.  

 Add more recipients to receive communications from within the CRM Online Administration 

Center. For more information, read TechNet: Manage email notifications. 

https://technet.microsoft.com/library/hh699765.aspx
http://go.microsoft.com/fwlink/p/?LinkID=522021
http://go.microsoft.com/fwlink/p/?LinkID=522215
https://msdn.microsoft.com/library/gg309589.aspx#BKMK_ClientAPIChanges
https://msdn.microsoft.com/library/gg309589.aspx
https://msdn.microsoft.com/library/gg309589.aspx
http://go.microsoft.com/fwlink/p/?LinkID=518667
http://go.microsoft.com/fwlink/p/?LinkID=518667
http://go.microsoft.com/fwlink/p/?LinkID=396442
http://go.microsoft.com/fwlink/p/?LinkId=396443
http://go.microsoft.com/fwlink/p/?LinkId=513086
http://go.microsoft.com/fwlink/p/?LinkId=401462
http://go.microsoft.com/fwlink/p/?LinkID=394691
https://technet.microsoft.com/library/dn467369.aspx
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 Visit these sites for info about current versions: 

Microsoft Dynamics CRM Help Center 

Microsoft Dynamics Marketing Help Center 

 Microsoft Social Engagement Help Center 

Parature, from Microsoft product page 

Microsoft Dynamics CRM video channel 

  

FAQ 

Q: I just purchased a new organization, but it is not scheduled. How do I make that 

happen? 

A: Don’t worry if you haven’t been contacted yet. Every week we schedule the new subscriptions 

into the update process, and notify you when your organization is scheduled. 

Q: If I have a sandbox or test organization on Microsoft Dynamics CRM Online Fall ‘13 and 

update to CRM Online 2015 Update, how do I reset it to go to Microsoft Dynamics CRM 

Online Fall ‘13 and go through the update again?  

A: Starting from the Admin UI, you can (as an administrator) select prior versions for the sandbox 

to be reset. 

Q: What happens if my update fails during the update to CRM Online 2015 Update?  

A: Microsoft makes a backup prior to attempting to update your organization. In the event we are 

not able to update your organization, it reverts by design. No request needs to be made for this to 

happen. 

Q: How do I determine what version of CRM I have? 

A: Sign in to CRM, and in the upper right side of the screen, choose the Settings button ( )  > 

About. 

Support 

Connect with Support Resources or browse questions/answers in the Microsoft Dynamics CRM 

Forum—or you can always contact your partner. 

For questions about Parature, please contact Parature Support.  

 

 

Previous Updates 

 

 

On this page 

Spring 2014 

Fall 2013 

Spring 2014 

The Spring 2014 wave of updates included a number of great new services and features. 

 Microsoft Social Engagement to help people across your organization tap into the social 

conversation. 

http://go.microsoft.com/fwlink/p/?LinkID=296269
http://go.microsoft.com/fwlink/p/?LinkID=398097
http://go.microsoft.com/fwlink/p/?LinkId=394325
http://go.microsoft.com/fwlink/p/?LinkID=522023
http://go.microsoft.com/fwlink/p/?LinkId=518244
http://go.microsoft.com/fwlink/p/?LinkId=511507
http://go.microsoft.com/fwlink/p/?LinkId=511669
http://go.microsoft.com/fwlink/p/?LinkId=511669
http://go.microsoft.com/fwlink/p/?LinkID=522215
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 Microsoft Dynamics Marketing to help marketers engage customers, build sales pipelines, 

and demonstrate impact. 

 Microsoft Dynamics CRM updates to help customer service teams earn loyalty, drive 

resolution, and delight customers. 

 

 

 

Great service with CRM 

 

Get started in CRM (2:16) 

What’s new in this wave of releases? 

  

Get an overview of the new features and functionality in the upcoming release 

Watch this short video overview of Dynamics CRM Spring ’14 (02:47) 

Visit the What’s New page in Microsoft Dynamics CRM Help & Training 

Listen to your customers with Microsoft Social Engagement 

With Microsoft Social Engagement, you can scour the web to see what people are saying about 

your company and products. You can track sentiment across channels, identify top influencers, 

stay on top of the latest information and trends, get competitive insights, and more. 

What is social engagement all about? 

 For sales: Learn how social engagement can help your sales team spot new opportunities 

and respond to competitive threats with precision.  

 eBook: “Social is for Closers” 

 For marketing: See how marketing efforts and brand management can be enhanced 

dramatically through social engagement.  

eBook “Your Brand Sux” 

 For customer service: Discover how listening to your customers can lead to amazing 

service experiences.  

eBook: “Wow Service” 

What will Microsoft Social Engagement let us do? 

 Analyze what people are saying. Social Engagement helps you understand what people 

are saying on social media in easy-to-read charts. See how the volume posts are changing 

over time, and compare where the posts are coming from. You can capture posts in 19 

languages on Twitter, Facebook, blogs, news, and videos. 

http://go.microsoft.com/fwlink/p/?LinkID=393634
http://go.microsoft.com/fwlink/p/?LinkID=317092
http://go.microsoft.com/fwlink/p/?LinkId=401027
http://go.microsoft.com/fwlink/p/?LinkId=398538
http://go.microsoft.com/fwlink/p/?LinkId=394677
http://go.microsoft.com/fwlink/p/?LinkId=394688
http://go.microsoft.com/fwlink/p/?LinkId=394679
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 Get a true understanding of sentiment. At a glance, see how people perceive your 

product, service, or brand natively in six languages – English, German, Spanish, French, 

Portuguese, and Italian.  

 
 

 Follow spikes in positive or negative sentiment. To figure out which posts are positive, 

negative, or neutral, Social Engagement analyzes keywords and phrases in six native 

languages, which means it also picks on cultural cues. Use the information collected to seize 

an opportunity or to proactively work to change the social conversation in your favor. 
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 Gain social insights. See on a map where in the world social conversations are happening, 

and analyze by geography. 

 
 

 Track how your marketing or service campaign is doing. After rolling out a campaign, 

you can measure reactions on Facebook, Twitter, blogs, news, and videos to see what’s 

working and what isn’t. Then make adjustments to your campaign accordingly. 

 Gain social insights. Analyze social media conversations beyond your company, brand, and 

products; see what conversations are happening around your competitors, customers, and 

prospects. 

Want to know more? 

Watch how Microsoft Social Engagement can 

help you listen to the pulse of your customers 

Get an overview of Microsoft Social 

Engagement 

Visit the Microsoft Social Engagement Help 

Center 

 

Start planning for Microsoft Social Engagement 

 Think about what you want to listen to. Compile a list of keywords and phrases, as well as 

the Twitter accounts and Facebook pages you want to monitor. 

 Decide who your system administrators will be. Who will be able to make changes to the 

searches you set up? 

http://go.microsoft.com/fwlink/p/?LinkId=396422
http://go.microsoft.com/fwlink/p/?LinkId=396422
http://go.microsoft.com/fwlink/p/?LinkId=394675
http://go.microsoft.com/fwlink/p/?LinkId=394675
http://go.microsoft.com/fwlink/p/?LinkID=394325
http://go.microsoft.com/fwlink/p/?LinkID=394325
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 Identify business processes that can take advantage of social engagement and assign 

owners. For example, if you identify that a customer requires service, who will engage that 

customer via social media to resolve the issue? If you incorporate social media analytics, 

what are your key metrics? Will they be buzz, sentiment, top influencers, or campaign 

impact? Start assigning owners for each of these processes. 

 Define an early warning system. What situations do you want to be alerted about? And who 

should receive the email alerts? For example, if there’s a spike in negative sentiment about a 

specific product, you can automatically notify your customer care team. What is the process 

once someone has been alerted? 

Visit the Microsoft Social Engagement Help Center. 

Geographic availability 

Microsoft Social Engagement is available in 6 languages: English, French, German, Portuguese 

(Portugal), Spanish, and Italian. Language availability depends on the language settings chosen 

by your system administrator. 

In addition to the 6 core languages, Microsoft Social Engagement includes features and 

functionality designed to listen, monitor, identify, and query publicly available social content, 

documents, and posts in 13 additional languages: Arabic, Chinese, Danish, Dutch, Greek, 

Finnish, Hebrew, Japanese, Norwegian, Polish, Russian, Swedish, and Thai. The social 

conversation, documents, and posts will remain in their original languages and they will not be 

translated by Microsoft Social Engagement. Native sentiment detection is available in English, 

French, German, Portuguese (Portugal), Spanish, and Italian. 

Find more details in the Microsoft Social Engagement Translation Guide. 

Market smarter with Microsoft Dynamics Marketing 

Marketers are pressured to generate customer insights, deliver impact, and validate investments. 

Organizations need the ability to plan, carry out, and measure end-to-end campaigns. Our new 

service offering, Microsoft Dynamics Marketing, added to the marketing functionality within 

Microsoft Dynamics CRM, helps today’s Chief Marketing Officers (CMOs) and marketing teams 

create and deliver amazing customer experiences. 

What’s coming to help marketers? 

 Additional marketing automation functionality. On top of what is already in Microsoft 

Dynamics CRM, the Microsoft Dynamics Marketing service delivers insights to help 

marketers be smarter and to more effectively engage with their customers. 

 Creating campaigns is a snap with a new visual campaign designer, helping CMOs reach 

their customers across multiple campaign channels. 

 New lead management and scoring capabilities, scalable email marketing capabilities 

(over 10 million messages per day), and deep marketing analytics allow for better 

measurement of campaign effectiveness. 

Visit the Microsoft Dynamics Marketing Help Center. 
 

Want to know more? 

 Check out our eBook: Increase your impact 

http://go.microsoft.com/fwlink/p/?LinkID=394325
http://go.microsoft.com/fwlink/p/?LinkId=391086
http://go.microsoft.com/fwlink/p/?LinkID=398097
http://go.microsoft.com/fwlink/p/?LinkId=394499


 

 
469 

Want to know more? 

with Microsoft Dynamics Marketing 

 Watch a high level overview of Microsoft 

Dynamics Marketing 

 Get an overview of Microsoft Dynamics 

Marketing 

 Visit the Microsoft Dynamics Marketing Help 

Center 

 

Want to connect Microsoft Dynamics Marketing with Microsoft Dynamics CRM? 

Visit the Microsoft Dynamics Marketing Setup & Administration page 

Geographic availability 

Microsoft Dynamics Marketing will be launched to 35 markets in 10 languages, far beyond the 

geographic coverage of most marketing automation solutions. It will be available later this spring.  

Find more details in the Microsoft Dynamics Marketing Translation Guide 

Provide amazing customer care with Microsoft Dynamics CRM 

Providing responsive, relevant, and effective service improves customer loyalty. This release of 

Microsoft Dynamics CRM focuses many of its new features on facilitating the delivery of amazing 

customer service experiences. Our acquisition of Parature, a leading provider of customer service 

functionality, added to the new features of Microsoft Dynamics CRM, makes for an unbeatable 

combination! 

What’s coming to help customer service teams? 

 A number of core enhancements to the marketing functionality within Microsoft Dynamics 

CRM provide you with strong enterprise-level case management capabilities including 

managing Service Level Agreements and Entitlements. This new functionality helps 

ensure that high quality and personalized service is delivered at every touch point. To learn 

more, visit the Service top links page. 

 Deeper connections with Yammer enable agents to effectively collaborate to address 

important customer inquiries. 

 Enhanced Mobility. You pick your device; we’ll keep you connected with your customers. 

This release includes support for Windows 8.1 and Android and adds more functionality than 

ever before.  

  A new Unified Service Desk (USD) within Microsoft Dynamics CRM serves as the single 

place where call center agents can do their work. It easily integrates with legacy and third-

party systems to surface key information from these systems seamlessly.  Unified Service 

Desk for Microsoft Dynamics CRM requires an Enterprise subscription (launching later this 

spring) for each subscriber using this functionality. TechNet: Read the Administration Guide 

for Unified Service Desk for Microsoft Dynamics CRM. 

 Our recent acquisition of Parature enables customer service organizations to become a more 

strategic part of a business by helping add insights toward customers, creating high 

performance service teams, and delivering more effective customer interactions. Parature 

http://go.microsoft.com/fwlink/p/?LinkId=394499
http://go.microsoft.com/fwlink/p/?LinkId=401416
http://go.microsoft.com/fwlink/p/?LinkId=401416
http://go.microsoft.com/fwlink/p/?LinkId=404229
http://go.microsoft.com/fwlink/p/?LinkId=404229
http://go.microsoft.com/fwlink/p/?LinkID=398097
http://go.microsoft.com/fwlink/p/?LinkID=398097
http://go.microsoft.com/fwlink/p/?LinkID=398096
http://go.microsoft.com/fwlink/p/?LinkId=401458
http://go.microsoft.com/fwlink/p/?LinkId=396551
http://go.microsoft.com/fwlink/p/?LinkId=396551
https://technet.microsoft.com/library/dn499779.aspx
https://technet.microsoft.com/library/dn499779.aspx
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allows you to provide a 24/7 customer support center that is tied into your organization’s 

website. This web-based help center gives your customers easy and convenient access to an 

intuitive, searchable knowledge base that delivers quick answers to their most commonly-

asked service and support questions. Parature can be subscribed to as a separate service. 

Learn more about what Parature can do for your organization.  

To learn more, visit the Microsoft Dynamics CRM Help Center 

Get updated information with Social Insights powered by InsideView 

With Social Insights, powered by InsideView, your Microsoft Dynamics CRM account information 

goes from static to dynamic with constant updates to three essential types of information – data, 

insights, and connections. InsideView applies proprietary triangulation and validation techniques 

across more than 30,000 sources and millions of company and people profiles to deliver relevant, 

accurate company and contact information. This can help sellers find more leads, win more deals, 

and retain and grow customer accounts. Microsoft Dynamics CRM brings Social Insights to you 

with every Microsoft Dynamics CRM Online Professional license at no additional charge 

(currently available in the U.S. only). 

Create compelling customer interactions. Access more degrees of connection for every prospect. 

Social Insights helps sellers to be more efficient and effective, while driving CRM adoption, 

because it gives them the real-time insights they need to succeed all in one place; all within 

Microsoft Dynamics CRM. Learn more about Social Insights. 

Pricing and licensing 

General Information 

Some of the new functionality in these releases may require a separate license and may incur an 

additional subscription fee for each member of your team who uses that functionality. 

Video: CRM Online License Management (04:27) 

Learn more about Microsoft Dynamics CRM Online pricing and licensing options 

Learn more about Microsoft Dynamics CRM on-premises licensing options 

Learn more about Microsoft Dynamics CRM global pricing 

Microsoft Social Engagement subscription pricing 

Microsoft Dynamics CRM Online subscribers 

 Microsoft Dynamics CRM Online Professional customers with a minimum of 10 users 

automatically have access to Social Engagement as part of their subscription at no additional 

charge. 

 A Microsoft Dynamics CRM Online Professional subscription is $65 (USD) per user per 

month. 

 Microsoft Dynamics CRM Online Professional customers with a minimum of 10 users 

automatically receive a complimentary quota of 10,000 posts per month for their organization. 

A “post” is any tweet, Facebook post, blog post, and so on that contains the keywords or 

phrases you configure the system to search for. For example, if you define a search topic to 

look for the keyword “Contoso”, every post that contains “Contoso” counts towards that 

month’s quota. 

Learn more about purchasing Microsoft Social Engagement 

http://go.microsoft.com/fwlink/p/?LinkId=394691
http://go.microsoft.com/fwlink/p/?LinkId=394323
http://go.microsoft.com/fwlink/p/?LinkId=396550
http://go.microsoft.com/fwlink/p/?LinkId=402274
http://go.microsoft.com/fwlink/p/?LinkId=396442
http://go.microsoft.com/fwlink/p/?LinkId=396443
http://go.microsoft.com/fwlink/p/?LinkId=396679
http://go.microsoft.com/fwlink/p/?LinkId=401462
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Learn more about Microsoft Dynamics CRM global pricing 

Microsoft Dynamics CRM 2013 on-premises customers 

Microsoft Dynamics CRM  Professional CAL customers with active Software Assurance can add 

Microsoft Social Engagement for up to 80% off the price of purchasing it by itself. Contact your 

partner for more details. 

Learn more about purchasing Microsoft Social Engagement 

Microsoft Social Engagement (standalone) 

 Customers can purchase a standalone subscription to Social Engagement for US $100 per 

user per month. 

 The organization receives an initial quota of 10,000 posts per month with this purchase. 

Purchasing additional post quotas 

Customers can purchase additional post quotas as shown here: 
 

Number of posts per month Amount (US$) 

10,000 $100 

100,000 $900 (10% discount) 

1,000,000 $8,000 (20% discount) 

 

 

 

You must purchase the full quota up front to receive the discount. For example, you won’t receive 

a 10% discount if you purchase 10 bundles of 10,000 posts. You can’t roll over posts from one 

month to the next. 

Example: Your organization has a Microsoft Dynamics CRM Online Professional subscription for 

100 users and you want to purchase an additional quota of 100,000 posts per month in addition 

to the complimentary bundle of 10,000 posts per month. The total price includes the Microsoft 

Dynamics CRM Online subscription of US $6,500 per month (100 users x $65 per user) + $900 

per month for the additional quota of posts for a total of US $7,400 per month. 

Adding a Microsoft Social Engagement subscription 

You can add Microsoft Social Engagement subscriptions to an existing Microsoft Dynamics CRM 

Online Professional or Enterprise subscription via the Office 365 Administrative Portal. Microsoft 

Dynamics CRM Online customers with a minimum of 10 Professional users automatically have 

access to Social Engagement as part of their subscription at no additional charge.  Customers 

who have purchased an Enterprise USL will have access to Microsoft Social Engagement with no 

minimum requirement for those Enterprise users.  

If you purchased your product via the Microsoft Volume Licensing program, please contact your 

Microsoft partner or your reseller to add a Microsoft Social Engagement subscription. 

Microsoft Dynamics Marketing subscription pricing  

http://go.microsoft.com/fwlink/p/?LinkId=396679
http://go.microsoft.com/fwlink/p/?LinkId=401462
http://go.microsoft.com/fwlink/p/?LinkId=390981
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Microsoft Dynamics Marketing requires a separate license and may incur an additional 

subscription fee for each member of your team that uses this functionality. 

Learn more about Microsoft Dynamics Marketing pricing and licensing options 

Learn more about Microsoft Dynamics CRM global pricing 

Parature subscription pricing  

Features from the Parature service are available directly from Parature. Learn more about what 

Parature can do for your organization. 

Access to product updates and new services 

Updating Microsoft Dynamics CRM Online 

With this update, you have the option to “opt in” and receive the new Enterprise Case 

Management features of Microsoft Dynamics CRM any time before the next formally-scheduled 

release. For more information, review the Microsoft TechNet article TechNet: Install Product 

Updates. 

“Ask the SME” video – why, when, and how to use Sandbox instances for testing and training (3 

minutes) 

 Installing product updates is a one-way process. Once installed, the product 

updates can’t be uninstalled.  

Typically, about once a year, we release an update that requires a scheduled date to receive the 

update. We call this a Customer Driven Update (CDU).  Microsoft Dynamics CRM Online Fall ‘13 

fell under the CDU-type update. Microsoft Dynamics CRM Online Spring ‘14 does NOT require a 

scheduled date. 

Regardless of how you receive an update – “opt in” or CDU - we always advise testing before 

upgrading your production instances. While we strive to minimize the impact of updates on your 

organization, occasionally changes that we make to Microsoft Dynamics CRM may impact 

custom code that you’ve added. We’ll communicate with your CRM administrator if we believe 

there may be an impact.  Video: Learn how to get access to a testing environment 

Updating Microsoft Dynamics CRM on-premises 

Updates for our on-premises customers who are current on their Microsoft Software Assurance 

Plan will be available via a service pack. 

Learn more about Microsoft Dynamics Software Assurance plans 

Before deploying to your production environment, read “Get and Install Microsoft Dynamics CRM 

Service Pack 1”. 

Adding Microsoft Social Engagement subscriptions 

Microsoft Social Engagement is offered as part of Microsoft Dynamics CRM Online Professional 

subscriptions at no additional charge for customers with 10 seats or more. Customers who have 

purchased an Enterprise USL will have access to Microsoft Social Engagement with no minimum 

requirement for those Enterprise users. Customers with fewer than 10 seats can either increase 

their seat count to 10 or add Social Engagement as a standalone subscription. Both Social 

Important  

http://go.microsoft.com/fwlink/p/?LinkId=513086%20
http://go.microsoft.com/fwlink/p/?LinkId=396679
http://go.microsoft.com/fwlink/p/?LinkId=394691
http://go.microsoft.com/fwlink/p/?LinkId=394691
https://technet.microsoft.com/library/dn659859.aspx
https://technet.microsoft.com/library/dn659859.aspx
http://go.microsoft.com/fwlink/p/?LinkId=401026
http://go.microsoft.com/fwlink/p/?LinkId=401026
http://go.microsoft.com/fwlink/p/?LinkID=396524
http://go.microsoft.com/fwlink/p/?LinkId=396552
http://go.microsoft.com/fwlink/p/?LinkID=395016
http://go.microsoft.com/fwlink/p/?LinkID=395016
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Engagement and Microsoft Dynamics Marketing are offered as online services. These 

subscriptions can be added to an existing Microsoft Dynamics CRM Online Professional or 

Enterprise subscription via the Office 365 Administrative Portal. 

Special pricing for a Microsoft Social Engagement subscription is available to on-premises 

customers who have Professional CAL Software Assurance. Please contact your partner or 

reseller for more information. 

Adding Microsoft Dynamics Marketing subscriptions 

Microsoft Dynamics Marketing is included as part of the Microsoft Dynamics CRM Online 

Enterprise subscription. It’s also available to our Microsoft Dynamics CRM Online Professional 

subscribers and our on-premises customers as a standalone subscription.  Both Microsoft Social 

Engagement and Microsoft Dynamics Marketing are offered as online services. These 

subscriptions can be added to an existing Microsoft Dynamics CRM Online Professional or 

Enterprise subscription via the Office 365 Administrative Portal. 

Technical resources for developers and administrators 

 

Microsoft Dynamics CRM 

Microsoft Dynamics CRM Developer Center 

Deploying and Administering Microsoft Dynamics CRM 

“Ask the SME” video – why, when, and how to use Sandbox instances for testing and training (3 

minutes) 

Microsoft Dynamics Marketing 

Microsoft Dynamics Marketing Developer Center 

Microsoft Dynamics Marketing Setup and Administration 

FAQ 

Q: I just purchased a new organization, but it is not scheduled. How do I make that 

happen? 

A: Don’t worry if you haven’t been contacted yet. Every week we schedule the new subscriptions 

into the update process, and notify you when your organization is scheduled. 

How do I determine which version of CRM I have? 

A: Don’t worry if you haven’t been contacted yet. Every week we schedule the new subscriptions 

into the update process, and notify you when your organization is scheduled. 

Product availability and pricing 

 

How will these new capabilities and services be made available to me? 

 New Enterprise Case Management customer care capabilities (managing entitlements, 

service level agreements, dynamic case routing, Yammer collaboration, and so on) will be 

available within Microsoft Dynamics CRM for Professional and Enterprise subscriptions. 

Microsoft Dynamics CRM Online subscribers will be given an opportunity to “opt in” to these 

changes, allowing them to control the timing of the update. We will make these updates 

available to on-premises customers via a service pack release in the future. 

http://go.microsoft.com/fwlink/p/?LinkId=390981
http://go.microsoft.com/fwlink/p/?LinkId=390981
http://go.microsoft.com/fwlink/p/?LinkID=272188
http://go.microsoft.com/fwlink/p/?LinkID=393438
http://go.microsoft.com/fwlink/p/?LinkId=401026
http://go.microsoft.com/fwlink/p/?LinkId=401026
http://go.microsoft.com/fwlink/p/?LinkID=398101
http://go.microsoft.com/fwlink/p/?LinkID=398096
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 Unified Service Desk functionality is available in Microsoft Dynamics CRM with an 

Enterprise subscription (available later this spring). 

 Microsoft Social Engagement and Microsoft Dynamics Marketing are offered as online 

services. These subscriptions can be added to an existing Microsoft Dynamics CRM Online 

Professional or Enterprise subscription via the Office 365 Administrative Portal. 

 Special pricing for a Microsoft Social Engagement subscription is available to on-

premises customers who have Professional CAL Software Assurance. 

 Microsoft Dynamics Marketing is available as a standalone subscription to on-premises 

customers. 

Can I roll back changes after installing the service pack or updating CRM Online? 

No, that is not possible. With this update, once you opt in to receive the new features in the 

product update, you won’t be able to uninstall them. Read more in the previous section, “Access 

to product updates and new services.” 

 Installing product updates is a one-way process. Once installed, the product 

updates can’t be uninstalled.  

How will the new customer care capabilities within Microsoft Dynamics CRM be offered to online 

and on-premises customers? 

The new Enterprise Case Management customer care capabilities (managing entitlements, 

service level agreements, dynamic case routing, Yammer collaboration, and so on) are available 

within Microsoft Dynamics CRM for Professional and Enterprise subscriptions. Unified Service 

Desk functionality is available with an Enterprise subscription.  

Features from the Parature service are available directly from Parature. Learn more about what 

Parature can do for your organization. 

If I have Microsoft Dynamics CRM on-premises, how do I purchase Microsoft Social 

Engagement? 

If you purchased your product via the Microsoft Volume Licensing program, please contact your 

Microsoft partner or your reseller to add a Microsoft Social Engagement subscription.  If you 

acquired Microsoft Dynamics CRM via the Dynamics price list or have a Microsoft Dynamics 

CRM Online subscription, you can contact your partner or you can add to an existing Professional 

or Enterprise subscription via the Office 365 Administrative Portal. 

Microsoft Social Engagement 

 

What kinds of things can I listen for on social media? 

You can listen for product names, brand names, competitors, and campaigns. 

I thought Facebook pages were private. Where does the data come from? 

Facebook profiles from individual users are usually private. Social Engagement only aggregates 

publicly available Facebook data—private data and conversations between friends aren’t 

included. With Social Engagement, you can select pages and get all relevant data from that page, 

or get data from public posts, but there is no way to sign in or otherwise access private data. 

Important  

http://go.microsoft.com/fwlink/p/?LinkId=390981
http://go.microsoft.com/fwlink/p/?LinkId=394691
http://go.microsoft.com/fwlink/p/?LinkId=394691
http://go.microsoft.com/fwlink/p/?LinkId=390981
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Can I respond to someone’s Facebook or Twitter post? 

You can respond to Twitter posts, but not Facebook posts for now. You’ll be able to respond to 

Facebook posts in future releases. 

Can I compare how many posts are on Facebook vs. Twitter? 

Yes. The main dashboard shows the volume of posts by channel, sentiment, and language 

(English, French, German, Portuguese (Portugal), and Spanish). 

How do I get the information? Does it come in a long report? 

Social Engagement offers a number of easy-to-read graphs and charts so the data is easy to 

aggregate, understand, and share. 

Can you measure whether people are saying positive, negative, or neutral things on the web? 

Yes, this is called “sentiment analysis.” Posts are scanned for keywords and phrases to 

determine a sentiment rating of positive, negative, or neutral. Social Engagement offers natural 

language processing for sentiment analysis so it can pick up on cultural cues that could be 

missed if the sentiment is translated to English first. Most other providers don’t offer natural 

language processing - or they charge extra for this service. 

What operating systems and web browsers does Microsoft Social Engagement run on? 

Microsoft Social Engagement is supported on the same set of operating systems and web 

browsers as Microsoft Dynamics CRM Online. TechNet: Learn more about web browser support.  

When will Microsoft Social Engagement be available? 

Microsoft Social Engagement is available as of April 1, 2014. Microsoft Dynamics CRM Online 

customers with 10 or more Professional licenses were recently notified via email of their eligibility 

to add-on Microsoft Social Engagement for no additional charge as a part of their current 

subscription. The Microsoft Dynamics CRM Administrators within an organization will soon 

receive an additional email with information on how to add the Microsoft Social Engagement 

service to their Microsoft Dynamics CRM Online subscription via the Microsoft Online Portal.  

If I have Microsoft Dynamics CRM on-premises, how do I purchase Microsoft Social 

Engagement? 

If you purchased your product via the Microsoft Volume Licensing program, please contact your 

Microsoft partner or your reseller to add a Microsoft Social Engagement subscription.  If you 

acquired Microsoft Dynamics CRM via the Dynamics Price list or have a Microsoft Dynamics 

CRM Online subscription, you can contact your partner or you can add to an existing Professional 

or Enterprise subscription via the Office 365 Administrative Portal. 

Fall 2013 

 

Microsoft Dynamics CRM 2013 Fall updates 

 If you haven’t updated to Microsoft Dynamics CRM 2013, see what you’re missing! 

Microsoft Dynamics CRM Release Preview Guide 

 

 

https://technet.microsoft.com/library/dn531055.aspx
http://go.microsoft.com/fwlink/p/?LinkId=390981
http://go.microsoft.com/fwlink/p/?LinkId=390981
http://go.microsoft.com/fwlink/p/?LinkId=327559
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 Watch these videos to get an overview of the new user experience: 

Getting Started with Microsoft Dynamics CRM Online (2:16) 

Microsoft Dynamics CRM 2013 User Experience Overview (8:19) 

 

 

 Watch this video to learn how to use CRM with Windows 8 tablets to help build relationships 

with your customers, even while you’re on the go: 

Microsoft Dynamics CRM 2013 for Tablets (4:14) 

 

 

 Connect your internal business processes to help turn your system into an outcome-driven 

tool: 

Microsoft Dynamics CRM 2013 Business Process Overview (10:35) 

 

 

 Check out these short, friendly eBooks to help you get familiar with features in the new 

version: 

What’s changed in CRM 2013? 

Introduction to business processes in CRM 

 

 

 Want to try out Microsoft Dynamics CRM Online Fall ‘13 before you update? 

Take a test drive! 

Prepare your organization for CRM 2013 

Use the following sections to get everyone ready for the upcoming release of Microsoft Dynamics 

CRM: 

CRM administrators 

 Get your team ready for the new version: 

Prepare for the change 

 

 

 Watch this video to see how to migrate your organization to the new on-premises version of 

Microsoft Dynamics CRM 2013: 

Upgrading to Microsoft Dynamics CRM 2013 from CRM 2011 (on-premises) (19:56) 

 

 

 Some things to consider before and after the upgrade: 

How to prepare for the Microsoft Dynamics CRM 2013 upgrade (on-premises) 

http://go.microsoft.com/fwlink/p/?LinkID=317092
http://go.microsoft.com/fwlink/p/?LinkId=324563
https://www.youtube.com/embed/1H23cYvQcys
http://go.microsoft.com/fwlink/p/?LinkId=327558
http://go.microsoft.com/fwlink/p/?LinkID=321497
http://go.microsoft.com/fwlink/p/?LinkID=321480
http://go.microsoft.com/fwlink/p/?LinkID=330425
http://go.microsoft.com/fwlink/p/?LinkId=327820
http://go.microsoft.com/fwlink/p/?LinkId=327827
http://go.microsoft.com/fwlink/p/?LinkId=323494
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 Plan, install, configure, customize, and maintain Microsoft Dynamics CRM 2013: 

Deploying and Administering Microsoft Dynamics CRM 

 

 

CRM developers 

 Learn how the changes in the new version may affect your software development: 

MSDN: Changes in CRM 2013 

 

 

 Download this SDK package to get documentation, tools, assemblies, and sample code for 

CRM 2013: 

Microsoft Dynamics CRM 2013 Software Development Kit (SDK) 

Explore pricing and licensing options 

Review licensing options for CRM 2013 

CRM 2013 Pricing and Licensing Guide 

Manage customizations 

Learn how the upcoming changes to CRM may affect your custom code, and download a tool to 

help identify items that may need attention: 

Managing your CRM custom code 

Review update readiness communications 

 Review past email about update readiness to ensure you have the information you need for a 

successful update: 

Prior communications 

 

 

 Read these tips to help ensure the correct people receive email about the update: 

Routing update communications 

After you update—next steps to success 

Here’s a roundup of top tips, tools, training materials, and ways to best understand and use new 

features. After you update to CRM 2013 -- next steps to success 

After you update: next steps to success 

Here are some useful resources to help your organization transition to the new versions of 

Microsoft Dynamics CRM, Microsoft Social Engagement, and Microsoft Dynamics Marketing.   

http://go.microsoft.com/fwlink/p/?LinkId=327825
https://msdn.microsoft.com/library/dn265924(v=crm.6).aspx
http://go.microsoft.com/fwlink/p/?LinkId=327829
http://go.microsoft.com/fwlink/p/?LinkId=327819
http://go.microsoft.com/fwlink/p/?LinkId=327822
http://go.microsoft.com/fwlink/p/?LinkId=397233
http://go.microsoft.com/fwlink/p/?LinkId=327818
http://go.microsoft.com/fwlink/p/?LinkId=389593
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Haven’t updated yet?  See the “Get ready for the next release” page. 

  

Learn about the new features included in the latest release of Microsoft Dynamics CRM ─ visit 

the Dynamics CRM Help Center. 

 

Learn how to make Microsoft Social Engagement help you hear what your customers are saying 

─ visit the Social Engagement Help Center. 

 

Learn how to make Microsoft Dynamics Marketing help your marketing teams create and deliver 

amazing customer experiences ─ visit the Dynamics Marketing Help Center. 

 

eBook guides & minute-or-less videos 

CRM video guides on YouTube 

Dynamics CRM Training & Adoption kit – templates you can use to train your teams 

Emails about update readiness for Dynamics CRM Online 

Previously sent emails 

The Microsoft Dynamics CRM Online Team sent the following emails to administrators of CRM 

Online organizations to help them Get Ready for the next release. 

We are providing them here for your reference: 
 

http://go.microsoft.com/fwlink/p/?LinkId=395093
http://go.microsoft.com/fwlink/p/?LinkId=394323
http://go.microsoft.com/fwlink/p/?LinkID=394325
http://go.microsoft.com/fwlink/p/?LinkId=394324
http://go.microsoft.com/fwlink/p/?LinkID=522322
http://go.microsoft.com/fwlink/p/?LinkId=518244
http://go.microsoft.com/fwlink/p/?LinkID=395151
http://go.microsoft.com/fwlink/p/?LinkId=395093%20
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For CRM Online 

CRM Online update emails - English 

CRM Online update emails - Dutch 

CRM Online update emails - French 

CRM Online update emails - German 

CRM Online update emails - Japanese 

CRM Online update emails - Spanish 

 

What are Preview features and how do I enable them? 

Preview features are features that aren’t complete, but are made available on a “preview” basis 

so customers can get early access and provide feedback. Preview features: 

 Are subject to separate Supplemental Terms of Use. 

 Are not supported by Microsoft Support. 

 May have limited or restricted functionality. 

 Aren’t meant for production use. 

 May be available only in selected geographic areas. 

What preview features are included in Microsoft Dynamics CRM 2016? 

The following table lists preview features included in Microsoft Dynamics CRM 2016 as well as 

learning resources for each feature. 
 

Preview feature Learning resource 

Task flows in Microsoft Dynamics CRM for 

phones and Microsoft Dynamics CRM for 

tablets (CRM Online only) 

Preview feature: Create a new task flow 

 

 

 

How do I enable a preview feature? 

 

To enable a preview feature, you must be a CRM administrator. 

1. Go to Settings > Administration. (How do I get there?) 

2. Choose System Settings, and then click the Previews tab. 

 

http://go.microsoft.com/fwlink/p/?LinkId=329985
http://go.microsoft.com/fwlink/p/?LinkId=329984
http://go.microsoft.com/fwlink/p/?LinkId=329983
http://go.microsoft.com/fwlink/p/?LinkId=329980
http://go.microsoft.com/fwlink/p/?LinkId=329986
http://go.microsoft.com/fwlink/p/?LinkId=329981
http://go.microsoft.com/fwlink/p/?LinkId=511446
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Read the license terms, and if you agree, select the I’ve read and agree to the license 

terms check box. 

4. For each preview feature you want to enable, click Yes. 

How do I report an issue or provide other feedback? 

If you’d like to provide feedback, offer suggestions, or report issues for a Preview feature, please 

go to Microsoft Connect. This website provides a collaboration platform for gathering actionable 

feedback to build and improve products and services.  

See Also 

Preview feature: Create a new task flow 

Manage your subscription 

 

Manage your CRM subscription 

Add user licenses to your subscription 

Add storage in CRM Online 

Remove storage from your subscription 

Add License Wizard and Add Storage Wizard errors 

CRM Online maintenance and update schedules 

Manage your CRM subscription 

There are a number of tasks associated with managing your Microsoft Dynamics CRM Online 

subscription.  To learn how to manage licenses, create users, assign security roles, grant user 

access, manage storage, and more, see TechNet: Manage your Microsoft Dynamics CRM Online 

subscription. 

Add user licenses to your subscription 

If you manage your subscription to Microsoft Dynamics CRM Online through the Microsoft Online 

Services environment using the Office 365 admin portal, you create a user account for every user 

who needs access to CRM Online. The user account registers the user with Microsoft Online 

Services environment. In addition to registration with the online service, the user account must be 

licensed in order for the user to have access to the service. For more information about user 

licensing and subscriptions, see TechNet: Manage subscriptions, licenses, and user accounts  

Add storage in CRM Online 

Check and manage your Microsoft Dynamics CRM Online storage through Microsoft Office 365. 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=511446
https://connect.microsoft.com/dynamicssuggestions
https://technet.microsoft.com/library/jj679903.aspx
https://technet.microsoft.com/library/jj679903.aspx
https://technet.microsoft.com/library/jj191604.aspx
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This topic applies to users who are on the Microsoft Online Services environment. 

Monitor the amount of storage your organization is using 

If your Microsoft Dynamics CRM organization is consuming 100% of your available storage, users 

in your organization won’t be able to enter data or create records, although they will be able to 

view data. 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Click Resources in Use. 

Review your storage used. 

 

To get more storage 

 Free up storage consumed by unneeded data. More information: TechNet: 10 ways to free 

storage space in Microsoft Dynamics CRM 

 Purchase additional storage from the Office 365 Admin portal page. More information: 

TechNet: Manage storage for Microsoft Dynamics CRM 

 

See Also 

TechNet: Manage storage for Microsoft Dynamics CRM 

TechNet: 10 ways to free storage space in Microsoft Dynamics CRM 

Remove storage from your subscription 

You may find that you don’t need extra storage and choose to remove it from your subscription. 

By removing storage capacity, you are reducing the amount of storage space available to your 

organization. Storage can’t be removed if it’s being used, or if you have the minimum amount of 

storage required by your subscription. More information:  TechNet: Manage storage for Microsoft 

Dynamics CRM Online 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn683569.aspx
https://technet.microsoft.com/library/dn683569.aspx
https://technet.microsoft.com/library/jj191611.aspx
https://technet.microsoft.com/library/jj191611.aspx
https://technet.microsoft.com/library/dn683569.aspx
https://technet.microsoft.com/library/jj191611.aspx
https://technet.microsoft.com/library/jj191611.aspx
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See Also 

TechNet: Free storage space in Microsoft Dynamics CRM 

CRM Online maintenance and update schedules 

horizontaltabbed 

About 

 

Microsoft regularly maintains and updates Microsoft Dynamics CRM Online to ensure security, 

performance, and availability, and to provide new features and functionality. From time to time, 

Microsoft also responds to service incidents. For each of these activities, the CRM admin for your 

organization receives email notifications. During a service incident, a CRM Online customer 

service representative may also call and follow up with an email. 

If you’re not sure who your CRM admin is, see Find your CRM administrator or support person. 

If you want to change who receives email communications, see TechNet: Manage email 

notifications in Microsoft Dynamics CRM Online. 

If you’re a CRM admin, you can also see the latest status of updates and incidents in the 

Microsoft Office 365 service health page. To learn how to get to the Office 365 service health 

page, see View the status of your services. 

To learn more about each type of maintenance and update activity, as well as the 

communications your organization receives, click one of the following links, or scroll down to the 

section: 

Planned maintenance 

Unplanned maintenance 

Security updates 

Service updates 

Service incidents 

Major service incidents 

Planned maintenance 

Planned maintenance includes updates and changes to the CRM Online service to provide 

increased stability, reliability, and performance. These changes can include: 

 Hardware or infrastructure updates 

 Integrated services, such as a new version of Office 365 or Microsoft Azure 

 CRM Online service changes and software updates 

 Minor service updates to CRM Online that occur about 10 times per year 

How do I find out about planned maintenance? 

https://technet.microsoft.com/library/dn683569.aspx
https://technet.microsoft.com/library/dn467369.aspx
https://technet.microsoft.com/library/dn467369.aspx
https://support.office.com/article/View-the-status-of-your-services-932ad3ad-533c-418a-b938-6e44e8bc33b0
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Your organization receives a “Planned Maintenance” email five days before the planned 

maintenance. These emails go out to all CRM Online System Administrators in every CRM Online 

instance that is scheduled for the planned maintenance. 

You can also see the schedule and status of planned maintenance activities on the Office 365 

service health page. To learn how to get to the Office 365 service health page, see View the 

status of your services. 

Unplanned maintenance 

From time to time, CRM Online inevitably encounters unplanned issues that require changes to 

ensure availability. Microsoft strives to provide as much notification as possible during these 

events. Because these events can’t be predicted, they are not considered planned maintenance. 

How do I find out about unplanned maintenance? 

Your organization receives an “Unplanned Maintenance” email. These emails go out to all CRM 

Online System Administrators in every CRM Online instance that is affected by the unplanned 

maintenance. 

You can also see the status of current unplanned maintenance activities on the Office 365 service 

health page. To learn how to get to the Office 365 service health page, see View the status of 

your services. 

Security updates 

The CRM Online team regularly performs the following to ensure the security of the system: 

 Scans of the service to identify possible security vulnerabilities 

 Assessments of the service to ensure that key security controls are operating effectively 

 Evaluations of the service to determine exposure to any vulnerabilities identified by the 

Microsoft Security Response Center (MSRC), which regularly monitors external vulnerability 

awareness sites 

The CRM Online team identifies and tracks any identified issues, and takes swift action to 

mitigate risks when necessary. 

How do I find out about security updates? 

Because the CRM Online team strives to apply risk mitigations in a way that doesn’t require 

service downtime, CRM administrators usually don’t receive emails for security updates. If a 

security update does require service downtime, it is considered planned maintenance. 

For more information about CRM Online security, see Microsoft Dynamics CRM Trust Center. 

Service updates 

CRM Online typically releases two major service updates per year. These updates provide new 

features and functionality to CRM Online. 

Improvements in the update process put the power in your hands for scheduling your 

organization’s service updates. You can choose from a list of available dates. Service updates 

are only applied after they are approved by the CRM Online admin. This helps you to plan well in 

advance for your upgrade path, while using your sandbox organization to properly test and 

evaluate the service updates with your existing production code. 

How do I find out about service updates? 

https://support.office.com/article/View-the-status-of-your-services-932ad3ad-533c-418a-b938-6e44e8bc33b0
https://support.office.com/article/View-the-status-of-your-services-932ad3ad-533c-418a-b938-6e44e8bc33b0
https://support.office.com/article/View-the-status-of-your-services-932ad3ad-533c-418a-b938-6e44e8bc33b0
https://support.office.com/article/View-the-status-of-your-services-932ad3ad-533c-418a-b938-6e44e8bc33b0
http://www.microsoft.com/en-us/dynamics/crm-trust-center.aspx
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The CRM Online team preschedules customers for the service update and emails CRM Online 

admins 90 days before the scheduled update. CRM Online admins receive additional emails at 30 

days, 15 days, 7 days, day of, and post upgrade. 

In the email, you have the opportunity to either approve the scheduled date or reschedule the 

update from a list of dates. All customers are updated during the defined service update release 

period, usually over a three-month window. 

To find out more about rescheduling service updates, see TechNet: Manage Microsoft Dynamics 

CRM Online updates. 

To find out what’s new and how to prepare for the next release, check out the following 

resources: 

 What’s new in CRM Online 

 Get ready for the next release 

Also be sure to watch this video about improvements to the update process. 

<iframe width="500" height="364" src="https://www.youtube.com/embed/7f3KTlFaQ64" 

frameborder="0" allowfullscreen></iframe> 

Service incidents 

A service incident occurs when your organization is inaccessible or you’re unable to use the 

service or one of its components. Examples include: 

 Getting a “page not found” or 404 error when you try to access CRM Online. 

 All of your users are unable to sign in to your organization. 

 Your users can sign in, but can’t save their changes. 

 Users can sign in, but see a blank screen. 

How do I find out about service incidents? 

If you open a case to report a service incident, a Microsoft customer support representative will 

call your CRM admin and follow up with an email when the service incident is resolved. 

Major service incidents 

A major service incident occurs when multiple organizations can’t access the service. 

How do I find out about major service incidents? 

Microsoft’s policy is to send email updates to the CRM admins of affected customers within 15 

minutes of a major service incident, and a final email once the issue is considered resolved. 

You can also see the status of major service incidents in your Office 365 service health page. To 

learn how to get to the Office 365 service health page, see View the status of your services. 

In addition, five business days after the incident resolution, the CRM Online team publishes a 

post-incident report (PIR) to the Office 365 service health page. This report summarizes the 

following details about the incident: 

 Description 

 Root cause 

 Customer impact 

 Start date and time 

https://technet.microsoft.com/library/dn308237.aspx
https://technet.microsoft.com/library/dn308237.aspx
what-s-new.aspx
https://support.office.com/article/View-the-status-of-your-services-932ad3ad-533c-418a-b938-6e44e8bc33b0
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 Resolution date and time 

 Next steps 

If the service incident breaches your Service Level Agreement, you can claim a billing credit 

according to the conditions of your Service Agreement. If you need help with this, see Billing 

FAQs for CRM Online. 

Updates video 

 

Schedule updates for a time that works for you. Find out how. 

<iframe width="500" height="364" src="https://www.youtube.com/embed/Hnqsc8hGHz8" 

frameborder="0" allowfullscreen></iframe> 

  

  

To see video captions, click the Closed Caption (CC) button in the lower right corner of the 

window. 

See Also 

CRM Online Service Blog 

Service Level Agreement 

Service Agreement 

Add and manage users, and set up security 

 

Security overview 

Add and manage users, and set security roles 

Understand security roles 

Assign a security role to a user 

Create or edit a business unit to control access to records 

Enable or disable hierarchy security 

Create a position to use in hierarchy security 

Create or edit a team 

Assign security roles to a form 

Enable or disable security for a field 

Set up security permissions for a field 

Use field level security in a calculated field 

Secure sensitive data by enabling encryption 

View your user profile 

https://port.crm.dynamics.com/portal/static/1033/sla.htm
https://port.crm.dynamics.com/portal/static/1033/tos.htm
https://community.dynamics.com/crm/b/crmonlineservice/default.aspx
https://port.crm.dynamics.com/portal/static/1033/sla.htm
https://port.crm.dynamics.com/portal/static/1033/tos.htm
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About team templates 

Security overview 

The Security screen in the Settings work area gives you all your security-related admin settings 

in one place. 

Select the links in this table to learn more about each CRM security setting. 
 

Security setting Related topics 

Users Add and manage users, and set security roles 

View your user profile 

Security Roles Understand security roles 

Assign a security role to a user 

Assign security roles to a form 

Field Security Profiles Enable or disable security for a field 

Set up security permissions for a field 

Positions Create a position to use in hierarchy security 

Teams Create or edit a team 

Business Units Create or edit a business unit to control access 

to records 

Hierarchy Security Enable or disable hierarchy security 

Access Team Templates Create a team template and add to an entity 

form 

 

Add and manage users, and set security roles 

How you manage users depends on which version of Microsoft Dynamics CRM you’re using: 

 To manage users in CRM Online using the Office 365 admin portal, see TechNet: Create 

users and assign Microsoft Dynamics CRM Online security roles. 

 To manage users in Microsoft Dynamics CRM on-premises, see TechNet: Manage users. 

 To manage work hours of users in Microsoft Dynamics CRM, see Set work hours for a 

resource. 

Create or edit a team 

You can create two types of teams: Owner or Access. If you want to assign a record to the team, 

choose the team type “Owner.” If you want to share a record with the team, choose the team type 

“Access.”  

https://technet.microsoft.com/library/jj191623.aspx
https://technet.microsoft.com/library/jj191623.aspx
https://technet.microsoft.com/library/dn531106.aspx
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For information about the two team types, see About team templates. 

On this page:  

Create a team 

Edit a team 

Create a team 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Security. 

(In Microsoft Dynamics CRM for Outlook, go to Settings > System > Security.) 

3. Click Teams. 

4. On the Actions toolbar, click the New button, complete the required fields, and then click 

Save. 

If you don’t select the business unit to which the team will belong, by default, the root 

business unit is selected. The root business unit is the first business unit created for an 

organization. 

Edit a team 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Security. 
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(In Dynamics CRM for Outlook, go to Settings > System > Security.) 

 

3. Click Teams. 

4. In the Teams dropdown list, select All Teams or another appropriate view. 

5. In the grid, select the team you want to edit. 

6. On the Actions toolbar, click Edit, change the desired fields, and then click Save. 

See Also 

Create a team template and add to an entity form 

About team templates 

Print leads, quotes, and other records 

About team templates 

Using teams in Microsoft Dynamics CRM is optional, however, teams give you an easy way to 

share information and collaborate with users across business units. A team is a group of users. 

As a group, you will be able to track information about the records and perform assigned tasks in 

much more efficient and coordinated way. While a team belongs to only one business unit, it can 

include users from other business units. A user can be associated with more than one team.  

There are two types of teams that you can work with: owner and access. 

 An owner team owns records and has security roles assigned to the team. The team’s 

privileges are defined by these security roles. In addition to privileges provided by the team’s 

security roles, users have the privileges defined by their individual security roles and by the 

roles from other teams in which they are members. A team has full access rights on the 

records that the team owns. 

 An access team doesn’t own records and doesn’t have security roles assigned to the team. 

The users have privileges defined by their individual security roles and by the roles from other 

teams in which they are members. The records are shared with an access team and the team 

members are granted access rights on the records, such as Read, Write, or Append.  

An access team can be created manually (user-created) or automatically (system-managed). You 

can share multiple records with a user-created access team. A system-managed team is created 

for a specific record and other records can’t be shared with this team. For system-managed 

teams, you have to provide a team template that the system uses to create a team. In this 

template, you define the entity type and the access rights on the record that are granted to the 

team members when the team is created. A team template is displayed on all record forms for the 

specified entity as a list. When you add the first user to the list, the actual access team for this 

record is created. You can add and remove members in the team using this list. The team 

template applies to the records of the specified entity type and the related entities, according to 

the cascading rules. To give team members different access on the record, you can provide 

several team templates, each template specifying different access rights. For example, you can 

create a team template for the account entity with the Read access right, which allows the team 
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members to view the specified account. For another team that requires more access to the same 

account, you can create a team template with Read, Write, Share and other access rights. 

Only entities that are enabled for system-managed access teams can be specified in the 

template.  

If you change access rights in the team template, the changes are only applied to new system-

managed access teams. The existing teams aren’t affected.  

For information about how to create a team template, enable an entity for system-managed 

access teams and how to customize the entity form to add the team template, see Create a team 

template and add to an entity form. 

See Also 

TechNet: Manage teams 

Create a team template and add to an entity form 

Create or edit a team 

Access Teams in Microsoft Dynamics CRM 

Create or edit a business unit to control access to records 

A business unit is a logical grouping of related business activities. Use business units together 

with security roles to control data access so people see just the information they need to do their 

jobs. 

Keep the following in mind when creating business units: 

 The organization (also known as the root business unit) is the top level of a Microsoft 

Dynamics CRM business unit hierarchy. CRM automatically creates the organization when 

you install or provision CRM. You can’t change or delete the organization name. 

 Each business unit can have just one parent business unit. 

 Each business unit can have multiple child business units.  

 You must assign every user to one (and only one) business unit. 

 You can assign a team to just one business unit, but a team can consist of users from one or 

many business units. Consider using a team if you have a situation where users from 

different business units need to work together on a shared set of records. 

On this page: 

Create a new business unit 

Change the settings for a business unit 

Create a new business unit 

1. Make sure you have the System Administrator or System Customizer role. 

Check your security role 

 

https://technet.microsoft.com/library/dn531089.aspx
http://download.microsoft.com/download/E/9/0/E9009308-CA01-4B37-B03C-435B8ACB49B4/Access%20Teams%20with%20Microsoft%20Dynamics%20CRM%202013.pdf
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a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Security. (How do I get there?) 

3. Choose Business Units. 

4. On the Actions bar, choose New. 

5. In the Business Unit dialog box, type a name for the new business unit. CRM 

automatically fills in the Parent Business field with the name of the root business unit. 

 
 

6. If you want to change the parent business unit, choose the Lookup button , choose Look 

Up More Records, and then do one of the following: 

 Select an existing business unit from the list, and then choose Add. 

 To create a new parent business unit: 

i. Choose New, and then add the information for the new parent business unit in 

the Business Unit dialog box. 

ii. When you’re done adding information, choose Save and Close in the Business 

Unit dialog box. 

iii. In the Look Up Record dialog box, choose Add. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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7. In the Business Unit dialog box, fill in any of the other optional fields, such as the 

division, contact information, website, bill to address, or ship to address. 

8. Choose Save or Save and Close. 

Change the settings for a business unit 

1. Make sure you have the System Administrator or System Customizer role. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Security. (How do I get there?) 

3. Choose Business Units. 

4. Choose a business unit name to open the Business Unit dialog box. 

5. In the Business Unit dialog box, do one or more of the following: 

 Modify the data in one or more fields. 

Note  

You can’t change the name of a business unit or delete a business unit after 

it has been created. You can disable a business unit or change the parent, 

however. When you disable a business unit, all users and teams associated 

with the business unit are also disabled. 

 Choose Actions on the Actions bar, and then select a command. For example, to 

change the parent business unit, choose Actions, and then choose Change Parent 

Business. 

Note  

When you change the parent business unit, CRM removes security roles for 

users and teams associated with the business unit. You must reassign them. 

 Under Organization, choose a record type to see a list of related records. For 

example, choose Users to view a list of users in the selected business unit or to add 

users to the business unit. 

6. When you’re done making changes, choose Save or Save and Close. 

See Also 

TechNet: Security concepts in Microsoft Dynamics CRM 

TechNet: Manage users 

TechNet: Manage teams 

Enable or disable security for a field 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/hh699698.aspx
https://technet.microsoft.com/library/dn531106.aspx
https://technet.microsoft.com/library/dn531089.aspx
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Print leads, quotes, and other records 

Enable or disable hierarchy security 

Reduce the time you spend maintaining security roles for users by using hierarchy security. With 

hierarchy security, you can give upper-level users, such as managers or vice presidents, certain 

levels of access to their direct reports’ records and lesser levels of access to their non-direct 

reports’ records. Find out more about hierarchy security and how to set it up on TechNet. 

TechNet: Hierarchy security  

Create a position to use in hierarchy security 

Reduce the complexity of managing security roles by creating a position hierarchy. Then define 

jobs or positions in your company and assign them to different places in your position hierarchy. 

Higher level positions in the hierarchy have Read, Write, Update, Append, and AppendTo access 

to their direct reports’ records. They also have Read-only access to the records of non-direct 

reports in their hierarchy. Learn more about hierarchies and positions on TechNet. 

TechNet: Manager hierarchy and position hierarchy security models  

Assign security roles to a form 

Control form and field access by assigning different security roles to different forms you create. 

More information:  TechNet: Security concepts for Microsoft Dynamics CRM 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile.. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Choose Customize the System. 

4. Enable security roles. 

a. Under Components, expand Entities, and then expand the entity you want. 

b. Choose Forms. In the list, choose a form to edit it if it has a form type of Main. 

c. On the Home tab, in the Form group, choose Enable Security Roles. 

 

https://technet.microsoft.com/library/dn832142.aspx
https://technet.microsoft.com/library/dn832142.aspx#BKMK_Managerandpositionhierarchies
https://technet.microsoft.com/library/hh699698.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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5. Assign security roles. 

a. In the Assign Security Roles dialog box, select the security roles to which this form 

will be available. 

b. To make this the fallback form, select the Enabled for fallback check box. 

At least one form per entity must be a fallback form (the form that is displayed to a 

user when no other form is available for that user's security role). 

c. Choose OK. 

 

6.  Preview the main form. 

a. On the Home tab, choose Preview, and then select Create Form, Update Form, or 

Read-Only Form. 

b. To close the Preview form, on the File menu, choose Close. 

7. When you’re ready to save your data, choose Save and Close. 

8. Publish your customization. 

 To publish just the edited component, choose Save > Publish on the Home tab. 

 To publish all unpublished components at one time, choose Publish All 

Customizations. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

Enable or disable security for a field 

Field-level security lets you set which fields users can see or edit. For example, if want to prevent 

users from accidentally changing an account name, you can restrict them from editing that field. 

In Microsoft Dynamics CRM 2013, you could only set field-level security for custom fields, but in 

Microsoft Dynamics CRM 2015 or later, you can also set field-level security for default fields. 

More information: TechNet: Field-level security 

To set which users and teams have read or write access to fields, see Set up security 

permissions for a field. 

You can’t change the permissions on a field that you don’t have permission to access. 

 

1. Go to Settings > Customizations. (How do I get there?) 

2. Click Customize the System. 

3. Under Components, expand Entities, expand the entity that has the field you want to 

Note  

Note  

 

https://technet.microsoft.com/library/dn832104.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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secure, and then click Fields. 

4. In the list of fields, double-click the field you want to secure. 

5. In the Field window, on the General tab, to the right of Field Security, specify whether to 

Enable or Disable security for the field. 

6. Click Save or Save and Close. 

7. When your customizations are complete, publish them: 

 To publish customizations for only the entity that you are currently editing, in the 

navigation pane, select the entity, and then click Publish. 

 To publish customizations for all unpublished entities at one time, in the navigation 

pane, click Entities, and then on the command toolbar, click Publish All 

Customizations. 

See Also 

TechNet: Field level security 

Set up security permissions for a field 

Set up security permissions for a field 

You can restrict access to a field by creating a field security profile. After you create the profile, 

you assign users and or teams to that profile, and set up specific read, create, or write 

permissions for the field.  

More information: TechNet: Security concepts for Microsoft Dynamics CRM 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Security. (How do I get there?) 

3. Click Field Security Profiles, and then on the command bar, click New. 

4. Enter a name and a description (optional) and click Save. 

5. Under Common, click Field Permissions. 

6. Select a field, and then click Edit. 

7. Select the permissions that you want to assign to users or teams, and then click OK. 

8. To add users or teams: 

a. Under Members, click Teams or Users. 

 

https://technet.microsoft.com/library/dn832104.aspx
https://technet.microsoft.com/library/hh699698.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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b. On the command bar, click Add. 

c. In the Look Up Records dialog box, select a team or user from the list (or search for 

a team or user), and then click Select. 

d. Repeat the preceding steps to add multiple teams or users, and then click Add. 

See Also 

Enable or disable security for a field 

Use field level security in a calculated field 

To create a calculated field you must have the Write privilege on the Field Security Profile 

entity. If the calculated field uses secured fields in a calculation, you should consider securing the 

calculated field to prevent users from attempting to access data they don’t have permissions for. 

If you create a calculated field that uses secured fields in a calculation, the calculated field editor 

gives you a warning and suggests that you secure the field. More information: 

 TechNet: Field level security 

 TechNet: Define calculated fields 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

 

 

 

See Also 

TechNet: Field level security 

TechNet: Define calculated fields 

Secure sensitive data by enabling encryption 

To provide an additional layer of security, you can encrypt the data in some fields that contain 

sensitive data, including user names and passwords. When you enable encryption, even 

database administrators can’t see the password data. 

Microsoft Dynamics CRM users who have the System Administrator security role can enable data 

encryption or change the encryption key after enabling data encryption. More information: 

TechNet: Data encryption 

 Follow the steps in View your user profile. 

 Don’t have the correct permissions? Contact your system administrator. 

Important  

Check your security role 

https://technet.microsoft.com/library/dn832104.aspx
https://technet.microsoft.com/library/dn832103.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/dn832104.aspx
https://technet.microsoft.com/library/dn832103.aspx
https://technet.microsoft.com/library/dn531199.aspx
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Once you enable data encryption, you can’t turn it off. 

See Also 

TechNet: Data encryption 

Regional and other business management settings 

 

Customize regional options (admins) 

Enable or disable languages 

Work with fiscal year settings 

Set privacy preferences for an organization 

Manage transactions with multiple currencies 

Set up sales territories to organize business markets by geographical area 

Set up Business Management options 

Change auto-numbering prefixes for contracts, cases, articles, quotes, orders, invoices, and 

campaigns 

Customize regional options (admins) 

You can customize how numbers, currencies, times, and dates appear to everyone in your 

organization. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Click System Settings. 

4. Click the Formats tab. 

Important  

 

https://technet.microsoft.com/library/dn531199.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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5. From the Current Format list, select the language and country or region, and then click 

Customize. 

6. In the Customize Regional Options dialog box, you can change the default settings for 

the selected format. View how the changes will look in the preview boxes. 

 Click the Number tab to change the decimal symbol, digit grouping symbol, digit 

groups, and negative numbers. 

 Click the Currency tab to change the currency format, negative currency amounts, 

and number of decimal places. 

 Click the Time tab to change the time format, time separator, and notation for 

morning and afternoon. 

 Click the Date tab to set the type of calendar, first day of the week, first week of the 

year, formats for long and short dates, and whether or not to show week numbers in 

calendar views. 

 Click Apply to apply the changes and continue working in the dialog box, or click OK 

to save the changes and close the dialog box. 

7. Click OK. 

See Also 

System Settings dialog box - Formats tab 

Enable or disable languages 

You can enable or disable languages in Microsoft Dynamics CRM to address your business 

requirements. However, you can’t disable the base language. 

If you’re running Microsoft Dynamics CRM for Outlook, before you can enable additional 

languages, you must download one or more Language Packs on the same computer. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

  

Important  

 

http://www.microsoft.com/download/details.aspx?id=40340
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Choose Languages. 

4. Select the languages you want to enable and clear those you want to disable. 

5. Choose Apply. 

6. When you’re finished enabling and disabling languages, choose Close. 

See Also 

TechNet: Install and enable a Language Pack 

Work with fiscal year settings 

You can set the fiscal year period, and how it’s displayed, for your organization. 

After you set the fiscal year options, you can’t change them. Fiscal year options affect the 

way in which your organization's data is stored in Microsoft Dynamics CRM. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile.. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Business Management. (How do I get there?) 

 

3. Click Fiscal Year Settings. 

4. Type information in the text boxes. 

a. In the Start Date box, select the date to start the fiscal year. 

b. In the Fiscal Period Template drop-down list, select how your fiscal year is divided. 

c. In the Fiscal Year drop-down list, select how you want to display the fiscal year. 

d. In Name Based On drop-down list, select whether the fiscal year name is displayed 

on the start or end of the fiscal year. 

e. In the Fiscal Period drop-down list, select how you want to display the fiscal period. 

f. In the Display As drop-down list, select how you want the fiscal year abbreviation 

and the year to appear. 

5. Click OK. 

Important  

 

https://technet.microsoft.com/library/hh699736.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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See Also 

Set up sales territories to organize business markets by geographical area 

Set privacy preferences for an organization 

Manage users’ data privacy by controlling when to send error notifications, and also let users 

know how their privacy is protected by displaying your organization’s own privacy statement 

instead of the one from Microsoft. 

This feature was introduced in CRM Online 2015 Update 1 and CRM 2016 (on-

premises).  

 

 Interested in getting this feature? Find your CRM administrator or support person 

Set error reporting preferences for the organization  

When errors occur in the product, data about the problem is sent to Microsoft. This data – an 

error report - allows Microsoft to track and address errors relating to Microsoft Dynamics CRM. 

You can help Microsoft improve products and services when you allow the system to send these 

error reports. 

By default, individual users in Dynamics CRM have a measure of control over whether to send 

error reports to Microsoft. But you, as an administrator, can override their preferences and set up 

the error reporting preferences for the entire organization.  

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose Privacy Preferences. 

4. Under Select your error notification preferences, choose Specify the Web 

application error notification preferences on behalf of users, and then select one of 

the options. 

 

 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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When you use this setting, you can control error reporting for the entire organization by: 

 Not allowing users to make changes in how error reporting occurs. 

 Changing the default behavior for how error reporting happens. 

 

Replace the privacy statement for the organization  

By default, the Microsoft privacy statement is always shown to users with an administrator role 

only, and not to other (business) users. As an administrator, you can add a link to specify your 

organization's privacy statement, which is then shown to other users in your organization. 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose Privacy Preferences. 

4. Under Select your privacy statement link preferences, choose Show a link to the 

privacy statement, and then, in the Privacy statement URL box, type the link of the 

webpage you want to show.  

 

 

5. To make sure the link is correct, choose Test URL.  

After you add the privacy statement URL, the link directs all Microsoft Dynamics CRM users to 

the specified link. 

Any user with the System Administrator security role will always see the Microsoft privacy 

statement and not the organization’s privacy statement. 

See Also 

Get Help from the Microsoft Dynamics CRM Community 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkID=511675
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Manage transactions with multiple currencies 

Currencies determine the prices for products in the product catalog and the cost of transactions, 

such as sales orders. If your customers are spread across geographies, add their currencies in 

Microsoft Dynamics CRM to manage your transactions. Add the currencies that are most 

appropriate for your current and future business needs. 

Add a currency  

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Business Management. (How do I get there?) 

3. Click Currencies. 

4. Click New. 

5. Fill in the information, as required.  
 

Field Description 

Currency Type  System - Select this option if you want to 

use the currencies available in CRM. To 

search for a currency,  click the Lookup 

button   next to Currency Code. When 

you select a currency code, Currency 

Name and Currency Symbol are 

automatically added for the selected 

currency. 

 

 Custom - Select this option if you 

want to add a currency that's not 

available in CRM. In this case, you 

must manually enter the values for 

Currency Code, Currency 

Precision, Currency Name, 

Currency Symbol, and Currency 

Conversion.  

Currency Code Short form for the currency. For example, 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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USD for United States Dollar. 

Currency Precision Type the number of decimals that you want 

to use for the currency.  You can add a 

value between 0 and 4. 

Note  

If you’ve set a precision value 

in the System Settings dialog 

box, that value will appear 

here. More information: System 

Settings dialog box - General 

tab.  

Currency Name If you selected a currency code from the list 

of available currencies in CRM, the 

currency name for the selected code is 

displayed here. If you selected Custom as 

the currency type, type the name of the 

currency. 

Currency Symbol If you selected a currency code from the list 

of available currencies, the symbol for the 

selected currency is displayed here. If you 

selected Custom as the currency type, 

enter the symbol for the new currency.  

Currency Conversion Type the value of the selected currency in 

terms of one US dollar. This is the amount 

at which the selected currency converts to 

the base currency. 

Important  

 Make sure you update this 

value as frequently as required 

to avoid any inaccurate 

calculations in your 

transactions.  

 

6. When you’re done, on the command bar, click Save or Save and Close. 

Tip  

To edit a currency, click the currency, and then enter or select the new values. 
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Delete a currency 

1. Click Settings > Business Management. 

2. Click Currencies. 

3. From the list of currencies displayed, select the currency to delete. 

4. Click Delete . 

5. Confirm the deletion. 

You can’t delete currencies that are in use by other records; you can only deactivate 

them. Deactivating currency records doesn’t remove the currency information stored in 

existing records, such as opportunities or orders. However, you won’t be able to select 

the deactivated currency for new transactions. 

See Also 

System Settings dialog box - General tab 

Set personal options 

Set up sales territories to organize business markets by geographical area 

Improve sales potential and revenues by creating territories for customer and market segments in 

Microsoft Dynamics CRM. Then assign appropriate sales people to handle the sales and revenue 

opportunities for those territories. 

Sales territories improve the sales potential because the members of a territory are focused on 

the services or sales within that territory. You can associate the financials directly with a territory 

and its members, which simplify business analysis. Also, based on the sales territory type and 

size, you can define sales methodologies and the training required for those locations. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Business Management. (How do I get there?) 

 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Choose Sales Territories. 

4. On the command bar, choose New.  

5. Fill in your information. 

 Name. Enter the geographical name for the territory such as the name of a city, 

country/region, or a state. 

 Manager. Enter the name of the user who is the manager for this territory. This 

person would typically assign leads to salespeople. 

 

Important  

You can’t allocate the same user to multiple territories. If you need to assign 

a user to a larger area (more than one existing territory), create a new 

territory that includes the existing territories, and then assign the user to that 

new territory.  

 Description. Enter any details that you’d like to include for this territory, for example, 

“Sales territory created for education and training.” 

 

6. When you’re done, on the command bar, choose Save or Save and Close. 

7. To assign members to a sales territory, open the territory, and then in the left pane, under 

Common, choose Members.  

8. On the Users tab, in the Records group, choose Add Members.  

9. In the Look Up Records dialog box, select a user, and then choose Add.  

To make your salesperson’s job easier, you can also set a default price list for a territory. 

More information: Create price lists and price list items to define pricing of products 

See Also 

Nurture sales from lead to order 

Set up Business Management options 

Click one of the following links for information about settings on the Business Management 

Options page: 
 

Work with fiscal year settings Create or edit a goal 

Set when your business is closed Add facilities and equipment for service 

scheduling 

Create or edit a queue Create or edit a resource group 

Set up sales territories to organize business 

markets by geographical area 

Create or edit a service 

Tip  
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Use sites to manage your service locations Define subjects to categorize cases, products, 

and articles 

Manage transactions with multiple currencies Create connections to view relationships 

between records 

Set up a relationship role to define family, 

social, or business relationships 

Set up rules to automatically create or update 

records in CRM 

 

 

 

Change auto-numbering prefixes for contracts, cases, articles, quotes, 
orders, invoices, and campaigns 

Contracts, cases, articles, quotes, orders, invoices, and marketing campaigns are automatically 

numbered by Microsoft Dynamics CRM. If your organization has standard numbering formats, 

you can change the default three-character prefixes and number format to match your 

organization. 

 

1. Go to Settings > Administration > Auto-Numbering. 

2. In the Set Auto-Numbering dialog box, select the record type that you want to change. 

3. In the Prefix box, enter up to three characters, symbols, or numbers. 

Prefixes are system-wide and are used for all system-generated numbers for the selected 

record type. If you change the prefix for a record type, it won’t change the prefix of 

numbers that are already assigned. 

The prefix of the tracking token for email messages is set in the System Settings area. 

More information: System Settings dialog box - Email tab  

4. In the Number box, enter the starting number.  

If you haven’t set a numbering format before, the Number box displays 1000. After you 

set the numbering format and save your settings, this field is set to read-only and you 

can’t modify it. If a custom auto-numbering solution was used, you won’t be able to 

change the number. 

5. Select a suffix length. 

Articles don’t have suffixes. The suffix is used for records that were created while you 

were offline and for which the number can’t be guaranteed to be unique. 

6. Click OK to save your settings. 
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See Also 

Edit a solution publisher 

Integrate other apps with CRM 

 

Outlook or other email 

SharePoint document management 

Microsoft Social Engagement (social data) 

Parature, from Microsoft (knowledge base) 

OneNote 

Skype or Skype for Business 

Set up an activity feed or Yammer 

Enable Office Delve 

Insights for Microsoft Dynamics CRM - powered by InsideView 

Outlook or other email 

 

Synchronize email using server-side sync 

Synchronize email using server-side sync 

 

Set up email processing through server-side synchronization 

Troubleshooting and monitoring server-side synchronization 

Server-side synchronization isn't working for your mailbox 

To use folder tracking, server-side synchronization must be enabled 

Set up email processing through server-side synchronization 

You can use server-side synchronization to set up email processing. Server-side synchronization 

connects Microsoft Dynamics CRM with one or more Exchange servers or POP3 servers for 

incoming email, and one or more SMTP or Exchange servers for outgoing email. With server-side 

synchronization, you can centrally manage mailboxes and profiles, configure email for users and 

queues, and track errors about email processing.  

You can also use server-side synchronization to synchronize appointments, contacts, and tasks 

between CRM and Outlook. 

To learn more about setting up server-side synchronization, see TechNet: Set up server-side 

synchronization of email, appointments, contacts, and tasks. 

See Also 

https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/dn531109.aspx
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Synchronizing data with Outlook or Exchange FAQ 

Troubleshooting and monitoring server-side synchronization 

If your organization uses server-side synchronization for email processing, you can use the 

improved Server-Side Synchronization Performance Dashboard to monitor the health of 

mailboxes in your organization, and quickly troubleshoot problems. More information: TechNet: 

Troubleshooting and monitoring server-side synchronization. 

See Also 

Synchronizing data with Outlook or Exchange FAQ 

Server-side synchronization isn't working for your mailbox 

You’re trying to track email using Exchange folder tracking, but server-side synchronization isn’t 

working for your mailbox. Folder tracking requires that your email be synchronized using server-

side synchronization. Contact your CRM administrator for help. More information: Find your CRM 

administrator or support person 

For Admins 

In addition to setting up server-side synchronization, you need to make sure the synchronization 

method for the user’s mailbox is set to Server-Side Synchronization or Email Router for 

incoming email.  

More information: 

 For information about Exchange folder tracking, see Track Outlook email by moving it to a 

tracked Exchange folder. 

 For admin information about setting up server-side synchronization, see TechNet: Set up 

server-side synchronization. 

 

 

 

 

See Also 

Track Outlook email by moving it to a tracked Exchange folder 

TechNet: Set up server-side synchronization 

To use folder tracking, server-side synchronization must be enabled 

To use Exchange folder tracking, your email must be synchronized using server-side 

synchronization. Contact your CRM administrator for help. More information: Find your CRM 

administrator or support person 

 

 

For Admins 

The following table shows requirements for folder tracking and where to go to find more 

information. 
 

https://technet.microsoft.com/library/dn850386.aspx
https://technet.microsoft.com/library/dn850386.aspx
track-outlook-email-by-moving-it-to-a-tracked-exchange-folder.aspx
track-outlook-email-by-moving-it-to-a-tracked-exchange-folder.aspx
https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/dn531109.aspx
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Requirement Resource 

Set up server-side synchronization for email TechNet: Set up server-side synchronization 

Set the synchronization method for the user’s 

mailbox record for incoming email to Server-

Side Synchronization or Email Router 

TechNet: Set up server-side synchronization 

Configure Exchange folder tracking TechNet: Configure Exchange folder tracking 

 

 

 

 

 

See Also 

Track Outlook email by moving it to a tracked Exchange folder 

SharePoint document management 

 

Set up SharePoint document management 

Upgrade to server-based SharePoint integration 

Enable SharePoint document management for specific entities 

Create or add a location for the first time 

Edit existing SharePoint site records 

Create or edit document location records 

Set up SharePoint document management 

You can store the documents related to your Microsoft Dynamics CRM records in Microsoft 

SharePoint folders and manage the folders and documents in Microsoft Dynamics CRM. 

Integrating SharePoint document management with CRM makes it easier to access and share 

documents associated with your CRM records. 

For information about setting up SharePoint integration by using a wizard, see TechNet: Set up 

SharePoint integration with Microsoft Dynamics CRM 

See Also 

TechNet: Set up SharePoint integration with Microsoft Dynamics CRM 

Enable SharePoint document management for specific entities 

Upgrade to server-based SharePoint integration 

If you’re using the Microsoft Dynamics CRM List Component to integrate SharePoint document 

management with CRM Online, you can upgrade to server-based SharePoint integration. Server-

https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/ae069f91-8cd7-446e-b13b-05aec2e9b95c.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
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based SharePoint integration provides an immersive document management experience 

consistent with the look and feel of Microsoft Dynamics CRM. The new integration displays the 

documents in the native CRM grids and users can access SharePoint actions directly from the 

CRM command bar. More information: TechNet: Set up SharePoint integration with Microsoft 

Dynamics CRM 

See Also 

TechNet: Set up SharePoint integration with Microsoft Dynamics CRM 

Enable SharePoint document management for specific entities 

Enable SharePoint document management for specific entities 

Store the documents related to Microsoft Dynamics CRM entity records in Microsoft SharePoint 

and quickly access, share, and manage these documents from Microsoft Dynamics CRM by 

enabling document management on the specific entities. 

If you’re using Microsoft Dynamics CRM Online, and you haven’t set up server-based 

SharePoint integration, you may want to do that before enabling document management 

for specific entities. For more information, see TechNet: Set up SharePoint integration 

with Microsoft Dynamics CRM 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. Or verify that you have Read and Write privileges on all record 

types that are customizable. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Document Management. (How do I get there?) 

3. Choose Document Management Settings. 

4. Select the entities that you want to use to manage SharePoint documents.  

5. Enter the URL of the site where the document locations and folders for storing 

documents will be created, and then choose Next.  

If you’re on CRM Online with server-based integration turned on 

a. If you want the document libraries and folders to be automatically created, 

specify a valid SharePoint Online URL, and make sure the site is under the 

same Office 365 tenant as your CRM instances. For more information on 

Tip  

 

https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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server-based integration, see TechNet: Set up SharePoint integration with 

Microsoft Dynamics CRM 

 

If you’re on CRM on-premises or CRM Online without server-based integration 

a. If you want the document libraries and folders to be created automatically, 

specify a valid SharePoint Server 2010 or SharePoint Server 2013 site URL, 

and make sure the site has the Microsoft Dynamics CRM List Component for 

SharePoint Server installed. Note, this will also work if you specify a 

SharePoint online site URL. 

Note  

The list component has been deprecated as of Microsoft Dynamics 

CRM Online 2015 Update 1. For information on converting from the 

List Component, see TechNet: Switching from the list component or 

changing the deployment. 

b. The remaining steps are described assuming that the specified site is on 

SharePoint Server 2010 or SharePoint Server 2013 and the site collection for 

this site has the Microsoft Dynamics CRM List Component installed. 

 

 

By default, a folder for each record is created under the corresponding document library 

for the entity. For example, for an opportunity record “100 Bikes”, a document library 

“opportunity” is created, and in it, a folder “100 Bikes” is created. The path is 

../opportunity/100 Bikes. 

6. To have the folders created under the parent account or contact, select the Based on 

entity check box. In the list next to the check box, choose Account or Contact. 

When you select this option, the folders are created under the related account or contact 

folder.  

The structure is:.../account/Margie's Travel/opportunity/100 Bikes where “account” is the 

document library for the referenced entity that you selected from the list, and “Margie's 

Travel” is the folder for the referenced record of the selected entity, which in this case it 

the Opportunity entity. 

7. Choose Next. 

Microsoft Dynamics CRM creates document libraries for the selected entities on 

SharePoint. Microsoft Dynamics CRM also creates the corresponding document location 

records that contain the links to these document libraries. The Document Management 

Settings wizard shows the creation status of the document libraries.  

See Also 

Edit existing SharePoint site records 

TechNet: Set up SharePoint integration with Microsoft Dynamics CRM 

https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn946910.aspx
https://technet.microsoft.com/library/dn946910.aspx
https://technet.microsoft.com/library/dn531154.aspx
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Create or add a location for the first time 

Before you can manage documents for a record from Microsoft Dynamics CRM, you must create 

a location record in Microsoft Dynamics CRM that points to libraries and folders on SharePoint 

where the documents will be stored. 

 

1. Open the Microsoft Dynamics CRM record that has the documents you want to manage.  

2. Under Related, click or tapDocuments. 

3. If a location isn’t associated, CRM displays the Add Document Location dialog box or 

Create SharePoint Location dialog box. The following table shows the possible 

scenarios. Depending upon what you see, perform the steps in the “Next steps” column.   

 

Scenario What appears  Next steps 

There is at least one site 

record in Microsoft Dynamics 

CRM that points to a site 

collection in SharePoint, and 

the site record has the List 

component is installed check 

box selected. 

Add Document Location 

opens with an option to 

specify either an absolute 

URL or a relative URL. 

1. In the Name box, verify or 

type the name. The 

document location record 

is created in Microsoft 

Dynamics CRM with this 

name.  

2. In the Document 

Location box, enter the 

URL of the SharePoint 

folder to which the location 

record points. This location 

is associated with the 

Microsoft Dynamics CRM 

record to store the 

documents. 

-  OR - 

Click or tapCreate a new 

folder. In the Parent Site or 

Location box, click or tap the 

Lookup button  to select 

an existing document location 

record under which the folder 

will be created on SharePoint. 

In the Folder Name box, verify 

or change the name, and click 

or tapOK. A folder with this 

name is created in SharePoint. 

3. Click or tapSave. 
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Scenario What appears  Next steps 

There is one site record in 

Microsoft Dynamics CRM but 

the List component is 

installed check box is not 

selected. 

Add Document Location 

appears with only the absolute 

URL option. 

1. In the Name box, verify or 

type a name. The 

document location record 

is created in Microsoft 

Dynamics CRM with this 

name.  

2. In the Document 

Location box, enter the 

URL of the SharePoint 

folder to which the location 

record points. This location 

record is associated with 

the Microsoft Dynamics 

CRM record to store the 

documents. 

3. Click or tapSave. 

There is no existing location 

associated with the record, the 

URL specified in the 

Document Management 

Settings wizard is for a site 

collection on SharePoint 

Server 2010 or SharePoint 

Server 2013, and this site 

record has the List 

component is installed check 

box selected. 

Create SharePoint Location 

appears. 

Microsoft Dynamics CRM tries 

to automatically create a folder 

in SharePoint. If the folder is 

created successfully, Microsoft 

Dynamics CRM opens Create 

SharePoint Location with the 

URL of the new folder. 

Microsoft Dynamics CRM 

creates a document location 

record that contains the URL of 

this new folder and associates 

the document location record 

with the Microsoft Dynamics 

CRM record. 

Click or tapOK. 

 

A new document location record is created in Microsoft Dynamics CRM that contains the links to 

the folders in SharePoint. The location that you just associated is added to the Document 

Locations list. 

See Also 

Manage SharePoint documents from within Microsoft Dynamics CRM 

Create or edit document location records 
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Edit existing SharePoint site records 

Store documents related to your Microsoft Dynamics CRM records in Microsoft SharePoint 

folders and manage the folders and documents from within Microsoft Dynamics CRM. Integrating 

SharePoint document management with CRM makes it easy to access and share documents 

associated with your Microsoft Dynamics CRM records. 

If you’re using CRM 2013 SP1 or later, you can take advantage of server-based 

SharePoint integration between CRM Online and SharePoint Online. Server-based 

SharePoint integration provides an immersive document management experience 

consistent with the look and feel of Microsoft Dynamics CRM.  

If you’re using CRM Online or Microsoft Dynamics CRM 2016, you can use server-based 

SharePoint integration for on-premises and hybrid SharePoint deployments. For 

information about setting up server-based SharePoint integration using a wizard, see 

TechNet: Set up SharePoint integration with Microsoft Dynamics CRM 

If you have already set up SharePoint document management, and want to edit your site records, 

use the following procedure.  

Edit site records 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role  

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Document Management. (How do I get there?) 

 

3. Click SharePoint Sites. 

4. Select the site record you want to modify, and then click Edit. 

5. Modify any of the following settings:  

 Name. Add or change the name for the site.. 

 Owner. By default, the person who created the site is listed as the owner of the site 

record. 

 Description. Add or change the description for the site. For example, specify what 

documents the site contains. 

 URL Type. Specify whether you want to add an absolute (full) or relative URL for the 

site. 

 Absolute URL. To point this site record to a site collection or site in SharePoint, 

Tip  

 

https://technet.microsoft.com/library/dn531154.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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specify the fully qualified URL of the site collection or site. You can use this 

record as a parent site to create other site records with relative URLs for sites 

inside the site collection or sites on the same SharePoint site. 

 Relative URL. Use this option when you have at least one site record pointing to 

a site collection in SharePoint. In the Parent Site box, select an existing 

Microsoft Dynamics CRM site record. If the site record that you selected as a 

parent site points to a site collection on SharePoint, specify the name of an 

existing site in the second box. If the site record that you selected as a parent 

site points to a site on SharePoint, specify the name of an existing subordinate 

site on SharePoint. 

 List component is installed. Select this check box if the URL that you specified is a 

site collection on SharePoint Server 2010 or SharePoint Server 2013 and if the site 

collection has the Microsoft Dynamics CRM List component installed. This check box 

is available only if you use the Absolute URL option. 

Tip  

The List component has been deprecated in Microsoft Dynamics CRM. For 

information on switching from the List component to server-based integration, 

see TechNet: Switching from the list component or changing the deployment 

6. Click Save. 

7. Click Save and Close. 

To activate or deactivate a site record, on the SharePoint Sites page, select the site 

record, and then in the Records group, click Activate or Deactivate. 

 

See Also 

TechNet: Set up SharePoint integration with Microsoft Dynamics CRM 

TechNet: Switching from the list component or changing the deployment 

Create or edit document location records 

SharePoint document locations are records in Microsoft Dynamics CRM that point to a 

SharePoint document library or folder.  

To store documents for Microsoft Dynamics CRM records, the document libraries or folders must 

be in place. If Microsoft Dynamics CRM is unable to create the document libraries and folders 

automatically, you can manually create these in SharePoint. After you create the document 

libraries and folders in SharePoint, you must create document location records in Microsoft 

Dynamics CRM to point to these SharePoint document libraries and folders.  

 

1. Go to Settings > Document Management. (How do I get there?) 

Note  

 

https://technet.microsoft.com/library/dn946910.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn946910.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. Choose SharePoint Document Locations. 

3. Choose New. 

4. Specify the following information as required: 

 Name. Type a name for the document location. This name displays in the location list 

in the entity record. 

 Owner. By default, you are added as the owner of this location record. 

 Description. Type a description for the document location. 

 URL Type. Select whether you want to create the location with an absolute URL or 

relative URL. 

 Select Absolute URL, and in the Absolute URL box, specify the fully qualified 

URL of the location of the folder in SharePoint. 

-  OR - 

 Select Relative URL. In Relative URL, to create a relative document location to 

the existing site or document location record, select the existing SharePoint site 

or document location record. In the second box, enter the name of the 

SharePoint folder. 

 Regarding. Choose the Lookup button . In the Look Up Record dialog box, in the Look 

for list, select the type of records you want to find. Search and select the record for which you 

want to create the location record in Microsoft Dynamics CRM, and choose OK.  

5. Choose Save and Close. 

To activate or deactivate a document location, on the Document Locations page, select 

the document location record, and choose Activate or Deactivate. 

See Also 

Set up SharePoint document management 

Create or add a location for the first time 

Microsoft Social Engagement (social data) 

 

Add Social Engagement visuals to a dashboard or account 

Set up your own searches for Social Engagement 

Disable or enable social data for an organization 

Connect your organization to Microsoft Social Engagement 

Note  
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Add Social Engagement visuals to a dashboard or account 

Microsoft Social Engagement scours social networks like Facebook and Twitter to help you 

monitor what people are saying about your products or brand, and then analyzes the data and 

presents it to you in easy-to-read charts and graphs.  

These visuals help you spot emerging trends in people’s comments, respond to service issues 

before they escalate, track marketing campaigns, gain insights about your competitors, and more. 

Microsoft Dynamics CRM Online users can add Microsoft Social Engagement charts and visuals 

to dashboards, or you can add them to account, contact, or competitor screens. You can also add 

Microsoft Social Engagement charts and visuals to other types of records. 

To help you get up and running quickly with Microsoft Social Engagement, a system administrator 

sets up lists of common search terms for your organization in advance. Everyone shares and can 

select from the same pre-set lists of search terms to listen for on social networks like Facebook 

and Twitter.  

Or, you can Set up your own searches for Social Engagement for Microsoft Social Engagement 

to monitor on social networks.  

Create a Social Engagement dashboard 

You’ll use a wizard to set up the search terms to listen for on social networks like Facebook and 

Twitter, and to select the charts or visuals you want to include on a dashboard. 

People in sales, service, or marketing can create their own dashboards. CRM admins can create 

dashboards to share with the entire organization. 

1. To start the Social Engagement wizard, follow the steps for your role. 

If you’re creating a dashboard for yourself 

a. Go to Sales > Dashboards. (How do I get there?) 

 

If you’re an admin creating a dashboard for your whole organization 

a. Go to Settings > Customizations. (How do I get there?)  

b. Choose Customize the System > Dashboards. 

 

 

2. Choose New. 

3. Choose the layout to use for the dashboard, and then choose Create. 

Tip  

The 2-column regular dashboard layout is a good place to start because it gives 

you a simple design for up to four different charts. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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4. Type a name for the dashboard. 

5. To start the wizard, choose the Social Engagement button ( ) on the dashboard layout. 

6. On the Set up Social Insights page, choose Search topic, and then choose Next. 

7. In the Search topics list, select the list of terms to listen for, and then choose Next. 

8. From the Visual name drop-down list, select the name of the chart or visual. Each one 

includes a brief description to help you select the one you want.  

Tip  

To add more than one chart or visual, choose Add visual, and then select 

another chart or visual from the list. 

9. Choose Finish. 

10. Choose Save, and then choose Close. If you’re the CRM admin, on the command bar, 

choose Publish so that other people can use the dashboard. 

Add a Social Engagement chart or visual to an account or other type of record 

You’ll use a wizard to set up the search terms to listen for on social networks like Facebook and 

Twitter, and to select the charts or visuals you want to include for an account. 

You can also add Social Engagement charts or visuals to contacts, competitors, or other types of 

records. 

1. Go to Sales > Accounts. (How do I get there?) 

 

2. You’ll see a list of accounts. You may need to scroll to see the whole list. 

3. Choose the account you want. 

4. To start the Social Engagement wizard, choose Configure Social Insights. 

5. On the Set up Social Insights page, choose Search topic, and then choose Next. 

6. In the Search topics list, select the list of terms to listen for, and then choose Next. 

7. From the Visual name drop-down list, select the name of the chart or visual. Each one 

includes a brief description to help you find the one you want.  

Tip  

To add more than one chart or visual, choose Add visual, and then select 

another chart or visual from the list. 

8. Choose Finish. 

See Also 

Get ready for the next release 

Set up your own searches for Social Engagement 

To help you get up and running quickly with Microsoft Social Engagement, a system administrator 

sets up lists of common search terms (also referred to as “search topics”) for your organization in 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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advance. Everyone shares and can select from the same pre-set lists of search terms to listen for 

on social networks like Facebook and Twitter.  

However, if you want Microsoft Social Engagement to monitor different search terms, you can use 

a wizard to set up your own searches.  

Set up your own search on a social Engagement dashboard 

You’ll use a wizard to set up your own search terms to monitor on social networks, and to select 

the charts or visuals you want to include on a dashboard. 

1. Go to Sales > Dashboards. (How do I get there?) 

2. Choose New. 

3. Choose the layout to use for the dashboard, and then choose Create. 

Tip  

The 2-column regular dashboard layout is a good place to start because it 

gives you a simple design for up to four different charts. 

4. Type a name for the dashboard. 

5. To start the wizard, choose the Social Engagement button ( ) on the dashboard. 

6. On the Set up Social Insights page, choose Search topic > Create a new search 

topic. Complete the fields on the screens. 

To group this search by the type of record (for example, accounts, competitors, or 

contacts), in the Select a category for this search topic drop-down list, select the 

record type. 

In the Keywords to search for field, enter the terms to search for, separated by 

commas. Social Engagement finds exact matches, but the terms aren’t case-

sensitive. For best results, include variations on the terms (for example, “phone” and 

“phones”). 

In the Keywords that must be INCLUDED in results field, enter additional terms that 

are required in results. These additional terms will narrow your search (think “AND”). 

In the Keywords that must be EXCLUDED from results field, enter terms you don’t 

want in results. Use exclusions to avoid overwhelming your results with irrelevant 

keywords (think “NOT”). 

 

7. Choose Next. 

8. From the Visual name drop-down list, select the name of the chart or visual. Each one 

includes a brief description to help you find the one you want.  

Tip  

To add more than one chart or visual, choose Add visual, and then select 

another chart or visual from the list. 

9. Choose Finish. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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10. Choose Save, and then choose Close. 

Set up your own search for an account or other type of record 

If you want to monitor emerging trends on social media for an account, you can use a wizard to 

set that up. 

You can also add Social Engagement charts or visuals to contacts, competitors, or other types of 

records. 

1. Go to Sales > Accounts. (How do I get there?) 

 

2. You’ll see a list of accounts. You may need to scroll to see the whole list. 

3. Choose the account you want. 

4. To start the wizard, choose Configure Social Insights. 

5. On the Set up Social Insights page, choose Search topic, and then choose Create a 

new search topic. Complete the fields on the screens. 

To group this search by the type of record (for example, accounts, competitors, or 

contacts), in the Select a category for this search topic drop-down list, select the 

record type. 

In the Keywords to search for field, enter the terms to search for, separated by 

commas. Social Engagement finds exact matches, but the terms aren’t case-

sensitive. For best results, include variations on the terms (for example, “phone” and 

“phones”). 

In the Keywords that must be INCLUDED in results field, enter additional terms that 

are required in results. These additional terms will narrow your search (think “AND”). 

In the Keywords that must be EXCLUDED from results field, enter terms you don’t 

want in results. Use exclusions to avoid overwhelming your results with irrelevant 

keywords (think “NOT”). 

 

6. Choose Next. 

7. From the Visual name drop-down list, select the name of the chart or visual. Each one 

includes a brief description to help you find the one you want.  

Tip  

To add more than one chart or visual, choose Add visual, and then select 

another chart or visual from the list. 

8. Choose Finish. 

See Also 

Add Social Engagement visuals to a dashboard or account 

Get ready for the next release 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Disable or enable social data for an organization 

With Microsoft Dynamics CRM, you can receive social data in CRM to track what people are 

saying about your company, product, or brand across social channels like Facebook or Twitter. 

More information: TechNet: Control social data 

See Also 

TechNet: Control social data 

Automatically create a case from an email 

Connect your organization to Microsoft Social Engagement 

You can monitor—right on a Microsoft Dynamics CRM screen—what people are saying on 

Facebook, Twitter, or blogs. 

TechNet: Connect to Microsoft Social Engagement 

eBook: Microsoft Social Engagement for CRM 

Add Social Engagement visuals to a dashboard or account 

Set up your own searches for Social Engagement 

Microsoft Social Engagement Help Center 

Microsoft Social Engagement Forum 

Parature, from Microsoft (knowledge base) 

 

Set up knowledge management in CRM 

Add a Knowledge Base search pane to a CRM form 

Find knowledge articles from within a record in CRM 

Unified Service Desk – Knowledge Management package 

Set up knowledge management in CRM 

Make important information about your products and services available to your Microsoft 

Dynamics CRM users in the form of knowledge articles. 

 

We now support a native knowledge solution in Microsoft Dynamics CRM, in addition to the 

knowledge base in Parature, from Microsoft. The CRM knowledge solution guides users through 

the process of creating rich articles and publishing them. For more information, see Reduce call 

handling times with rich knowledge articles in the User's guide for the new interactive service hub.  

For Microsoft Dynamics CRM Online organizations, the native knowledge solution feature 

is only available if you've installed the CRM Online 2016 Update. For on-premises CRM 

organizations, this feature is only available if you've updated to CRM 2016. Interested in 

getting this feature? Find your CRM administrator or support person. 

Important  

https://technet.microsoft.com/library/dn659849.aspx
https://technet.microsoft.com/library/dn659849.aspx
https://technet.microsoft.com/library/dn659847.aspx
http://go.microsoft.com/fwlink/p/?LinkID=393642
http://go.microsoft.com/fwlink/p/?LinkID=394325
http://go.microsoft.com/fwlink/p/?LinkID=510293
http://go.microsoft.com/fwlink/p/?LinkID=513070
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While setting up knowledge management in CRM, you can select the types of records users can 

search for knowledge articles. You can also define the knowledge solution to use for your 

organization. 

To learn more about setting up knowledge management, see TechNet: Connect Microsoft 

Dynamics CRM to Parature knowledge base. 

See Also 

Knowledgebase module in Parature, from Microsoft 

TechNet: Connect Microsoft Dynamics CRM to Parature knowledge base 

Add a Knowledge Base search pane to a CRM form 

Make the knowledge articles (KB) available to your Microsoft Dynamics CRM users in the records 

they’re working on. When you add the knowledge base search pane to a CRM form, users will be 

able to search for relevant knowledge articles from CRM, and also quickly share the right 

information with customers.  

To learn more about adding the knowledge base search pane, and setting its properties, see 

TechNet: Add the Knowledge Base Search control to Microsoft Dynamics CRM forms. 

 

See Also 

What’s new 

TechNet: What's new for administrators and customizers in Microsoft Dynamics CRM 2015 and 

CRM Online 

Find knowledge articles from within a record in CRM 

For any customer service team, it’s important to give their customers the right information at the 

right time. After your administrator sets up knowledge management for your organization, you can 

search for articles while working on a customer’s case or other records in Microsoft Dynamics 

CRM, give customers accurate and consistent information, and also deflect frequently-asked 

questions. With rich knowledge at your fingertips, you’re likely to spend less time finding 

information, potentially reducing issue handling time and increasing customer satisfaction.  

Microsoft Dynamics CRM supports two knowledge management solutions: 

 Native CRM knowledge management: This option is available for both CRM Online and on-

premises users. For Microsoft Dynamics CRM Online organizations, the native CRM 

knowledge solution is only available if you've installed the CRM Online 2016 Update. For on-

premises CRM organizations, this feature is only available if you've updated to CRM 2016.  

 Parature knowledgebase: This option is available only for CRM Online users. This feature 

was introduced in CRM Online 2015 Update 1. 

Interested in getting this feature? Find your CRM administrator or support person. 

Depending on the knowledge solution your organization chooses, you’ll see knowledge articles 

residing either in Microsoft Dynamics CRM or in Parature. 

 

https://technet.microsoft.com/library/dn946909.aspx
https://technet.microsoft.com/library/dn946909.aspx
http://go.microsoft.com/fwlink/p/?LinkID=524816
https://technet.microsoft.com/library/dn946909.aspx
https://technet.microsoft.com/library/dn946902.aspx
what-s-new.aspx
https://technet.microsoft.com/library/dn531078.aspx#BKMK_SetupKM
https://technet.microsoft.com/library/dn531078.aspx#BKMK_SetupKM
http://go.microsoft.com/fwlink/p/?LinkID=513070
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The search options that you get while you search for knowledge articles will differ based on the 

knowledge management solution your organization is using.  

1. Go to Service > Cases. (How do I get there?) 

2. Open a case record. 

3. On the Activity wall, click KB Records. 

You’ll see a list of suggested knowledge articles based on the case title. You’ll also see a 

short blurb of the article along with its rating and number of views the article had.  

If an article is still in draft or is expired, you’ll see its status before the title, so you know if 

you really want to share the article with the customer. 

Important  

 If your organization uses the Parature knowledgebase, the search results are filtered 

and shown based on the default language of your Parature department. To view or 

edit the default language of your Parature department, in Parature Service Desk, go 

to Setup > Department Management > Department Profile. 

 If you see a message that Knowledge Management hasn’t been set up, ask your 

system administrator to set it up for you.  

4. If you want to search the knowledge articles for a different keyword, start typing the 

keyword in the Search box and you’ll start seeing matching results as you type.  

5. To sort articles in the search results, in the Select how to sort results drop-down list, 

select a sort order. If your organization is using the Parature knowledgebase, you can 

sort the search results based on relevance, rating, number of views, or modified date. 

If your organization is using the native CRM knowledge management solution, the option 

to sort results based on rating is not available.  

 

 

 

6. To filter the search results, in the Filter Result By drop-down list, select a filter.  

If you’re using the Parature knowledgebase, you can filter the search results to show all 

articles, all draft articles, or all published articles. 

 

 

 

If you’re using the native CRM knowledge management solution, you can filter the search 

results to show all draft articles, all approved articles, or all published articles. 

7. To see the full content of the article, select the article name link. 

You’ll be able to see the full content of the article along with images and videos, if the 

article has any. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
523 

8. You can take the following actions on the search results: 

a. To associate a knowledge article with the current case, select a knowledge article, and click 

the Link the KB article to the current case button . Microsoft Dynamics CRM adds the 

associated knowledge article to the Associated Knowledge Base records section. This 

association helps customer service managers determine which knowledge articles were 

effective in resolving cases. 

You can also choose to disassociate the article from the case by clicking the Unlink the KB 

article from the current record button . 

b. To copy the external URL of the article so you can share it with your customers over 

channels like chat or email, click the Copy Link button . This option is available only if you 

are using Internet Explorer. 

Note  

If you don’t see a URL when you try to paste it, it could be because the 

article is still in draft state or is expired. 

If you’re using the native CRM knowledge management solution, the Copy Link 

option is available only for published articles. 

c. To associate an article with a case and share the article link with the customer through email, 

click the Link the KB article to the case and email the link to the customer button . An 

email form opens with the To field automatically filled with the customer’s informaton and the 

link added to the email body. Fill in any additional details, and then click Send.  

This action also associates the knowledge article with the case automatically. 

If you’re using the native CRM knowledge management solution, the Email Link 

option is available only for published articles. 

For published articles, an external link is copied to the email body.  

If you’re using the native CRM knowledge management solution, and if your 

administrator has not selected the Use an external portal option when setting up 

knowledge management, the Email Link option will insert the content of the article 

into the email body instead of inserting the link. 

If you’re using the native Parature knowledgebase, and if the article is a draft, an 

internal Parature Service Desk link will be copied into the email. The customer may 

not be able to view this knowledge article. 

d. To open the article in a new window, click the Pop Out button .  

See Also 

Create and manage a case 

Unified Service Desk – Knowledge Management package 

Unified Service Desk for Microsoft Dynamics CRM provides a configurable framework for quickly 

building applications for call centers so the customer service reps get a unified view of the 

customer data stored in Microsoft Dynamics CRM or any other application.  
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If you’re a service rep, you can use Unified Service Desk to offer your customers a reliable and 

consistent experience across a number of different channels including phone, email, and chat, 

and can also serve multiple customers simultaneously through sessions. A system administrator 

in your organization can integrate Unified Service Desk with many other applications that you use 

on a day-to-day basis so you can get your work done from your desktop without switching to 

different applications. 

The Unified Service Desk Knowledge Management sample application package provides a 

configuration for integrating Microsoft Dynamics CRM with the Parature knowledge base that lets 

you easily search for articles from your desktop and share them with customers right away, 

reducing call handling times and improving customer satisfaction. 

The sample applications are not supported for production use. 

This sample application is useful only if you have set up knowledge management for 

Microsoft Dynamics CRM. More information:  TechNet: Connect Microsoft Dynamics 

CRM to Parature Knowledge Base 

 

With the Unified Service Desk Knowledge Management package, the following components are 

installed: 

 User Interface Integration Solution 

 Unified Service Desk Solution 

 Data required for Microsoft Dynamics CRM and customizations 

 Configurations for integrating Unified Service Desk with knowledge management 

For more information on how to set up and administer Unified Service Desk, see the 

TechNet:Administration Guide for Unified Service Desk.  

 

Here’s what you’ll see when you install Unified Service Desk: 

1. Dashboards: Opens the CRM customer service dashboard. 

2. My Work: Shows a list of all the active cases assigned to a service rep. 

3. Search: Opens search for navigating through various entities. For this package you can 

search for accounts contacts, cases, activities, and queues. 

4. Session tabs: Each tab shows a different session when you have multiple customer 

sessions open. The tabs make it easy for  reps to work on multiple customer cases. 

5. Left pane: When you open any session, the left pane area automatically opens and shows 

the call script for the session. You can open or collapse this pane. 

6. Right pane: When you open any session, the right pane automatically opens and lets you 

search for knowledge base articles. 

7. Call Script: Shows call scripts that the service rep can use when they’re working on a case. 

The scripts help guide the rep by giving them step-by-step instructions on how to handle the 

case. 

8. Notes: Shows an area to take notes in regarding the case. 

Important  

https://technet.microsoft.com/library/dn946909.aspx
https://technet.microsoft.com/library/dn946909.aspx
https://technet.microsoft.com/library/dn499779.aspx
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9. Session timer: Shows how long a service rep has been on the session. 

 

  

View your cases 

 

 From the toolbar, click My Work to see all of your cases. 

Create a case 

Look up the contact information. 

1. From the toolbar, click Search. 

An application tab opens with a list of records. 

2. In the Search for records box, enter the account or contact information. 

3. When you find the information, click the record to open a new session. 

4. In the left nav Call Script area, use the list of call scripts to guide you through the support 

case.   

When you open a call script, a green check mark displays to indicate that the action has been 

performed. 

5. Enter your case notes in the Notes area. To attach your notes to the case, click Update 

notes from call scripts. 

Search for solutions 

To help you resolve a case, use knowledge base articles to find a solution. 

1. From the Call script area, click Search for a solution. 

The KB Records pane shows search results based on the title of the case. By default, the 

pane is configured to open in the right panel, but you can talk to your administrator to open 

this pane in the left or main panel.  

2. To do a different search, use the Search box to type a keyword and search for other articles. 

3. In the search results, select the article by choosing the article blurb, and do one of the 

following: 

 To copy the URL of the article, click the Copy Link button . You can then paste it in the chat 

session with customers or in the email body.  

If you don’t see a URL when you try to paste it, it could be because the article is 

still in the draft state or is expired. 

 To send the link of the article to a customer, click the Send Email  button .  

An email template opens with data populated in it. 

 To link the article with the case, click the Link Article button .  

Linking articles to cases helps in determining what articles were effective in resolving cases. You 

can also dissociate the article from the case by clicking the Remove Link button . 

Note  
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 To open the article in a new tab in the main panel and read its content, click the title of 

the article.  

All actions like Copy Link or Send Email are available on this new tab.  

 Additionally, to open the article in a new browser window, click the Pop Out button . This 

button is available only in the main panel and is particularly useful when you’re using multiple 

monitors. You can pop out an article and view it on a second monitor so that you can continue to 

use the first monitor to work on the case or take notes. While going through the article, you can 

click a link to go to a different page, and use the Back button   to go back to the original article.  

Your system administrator can also set up the Search control to search automatically 

based on certain criteria as soon as you open a session. To know more about this, 

talk to your system administrator. 

Send an email 

 

 From the list of call scripts, select the Send email call script, and then select a template that 

automatically populates the body of the email. 

Update the notes 

 

 Enter your case notes in the Notes area.  

 From the list of call scripts, select the Update the notes call script. This will attach the notes 

you’ve taken during your conversation with the customer to the Notes tab of the case record 

in Microsoft Dynamics CRM. 

Close the session 

From the list of call scripts, select the Close the session call script. This will close the open 

session and collapse the left panel that shows the call script and right panel that lets you search 

KB articles. 

See Also 

TechNet: Administration Guide for Unified Service Desk 

OneNote 

 

Set up and use OneNote in CRM 

Set up and use OneNote in CRM 

Gather your thoughts, ideas, plans and research in one single place with OneNote in Microsoft 

Dynamics CRM. 

When you turn on Microsoft OneNote integration in Microsoft Dynamics CRM Online, you have 

the benefits of using OneNote to take or review customer notes from within your CRM records.  

Tip  

https://technet.microsoft.com/library/dn499779.aspx
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You can configure OneNote in CRM Online when you’re also using SharePoint Online. You must 

have a subscription to Office 365 to use OneNote in CRM Online. 

Step 1: Turn on server-based SharePoint integration 

Before you can enable OneNote integration, you need to turn on server-based SharePoint 

integration. 

Make sure you have the System Administrator security role or equivalent permissions in Microsoft 

Dynamics CRM. Or, make sure that you have Read and Write privileges on all record types that 

are customizable. 

 Follow the steps in View your user profile. 

 Don’t have the correct permissions? Contact your system administrator. 

 

 

 
 

Step 2: Turn on OneNote integration 

When server-based SharePoint integration is turned on, OneNote integration is listed in 

Document Management.  

1. Go to Settings > Document Management. (How do I get there?) 

2. Choose OneNote Integration. 

 

Check your security role 

https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Follow the instructions in the wizard to turn on OneNote integration for selected entities. 

Choose entities that need a full notebook per record. Only entities that are already enabled 

for document management are listed. Choose Finish. 
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4. You can also enable OneNote integration for an entity from the customization form, as long 

as document management has been enabled for that entity. 
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5. A OneNote notebook is automatically created for a record the first time you select the 

OneNote tab in the activities area in Microsoft Dynamics CRM Online. Once the dedicated 

OneNote notebook is created for that CRM record, you can view and navigate to that 

notebook from any CRM client. 

 

 
 

 

Step 3: Use OneNote in CRM Online 

You can easily access a notebook directly from the activities area in CRM Online. This doesn’t 

replace the current Notes feature, but gives you another way to access notes stored in OneNote. 
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When you add a OneNote section to a notebook, it’s shown individually within CRM and in order 

of last modified time. 

 

 If you aren’t signed in to Office 365, you’ll go to the Office 365 sign-in page when you 

select the title of the OneNote notebook. When you sign in, you’ll go directly to the 

notebook. 

 

1. In the activities area of a record, select OneNote. 

 
 

 

2. Select a notebook to make entries. 

Note  
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3. The notebook is stored in the associated SharePoint folder for the record. If there is more 

than one associated folder, the notebook is created in the first folder. 
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Note  

 You can’t edit the OneNote file from within CRM. This can be done only from the 

OneNote app that opens when you choose the OneNote link. 

 Don’t delete any OneNote. onetoc2 or .one file types in the OneNote section in CRM. 

If you do, you won’t be able to access your CRM OneNote notebook. 

 Sections groups that keep related sections together in OneNote aren’t supported in 

CRM.  

 You can only rename a section in the desktop version of OneNote. If you rename a 

section in OneNote online, you won’t see the updated section name in CRM. 

Optional: Turn off OneNote integration 

4. 0.1. Go to Settings > Document Management. (How do I get there?) 

2. Choose OneNote Integration. 

 

 
 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. In the OneNote Integration Setting dialog box, uncheck all the entities and then choose 

Finish. 

See Also 

OneNote in CRM FAQs 

Turn on server-based SharePoint integration 

Blog post: OneNote in CRM 

Skype or Skype for Business 

 

Set up Microsoft Dynamics CRM to make calls with Skype or Skype for Business 

Set up Microsoft Dynamics CRM to make calls with Skype or Skype for Business 

If your organization is set up to use Skype or Skype for Business (formerly Lync), you can call 

your contacts from within Microsoft Dynamics CRM by clicking the person’s phone number. This 

capability is called “click to call.” 

Lync has been rebranded as Skype for Business. Currently, you’ll still see references to 

“Lync” in Microsoft Dynamics CRM, but CRM will work with Skype for Business. 

There are a few areas where system administrators configure settings for this feature. 

Users install Skype themselves. You set up Skype for Business and make it available to users. 

For more information, see TechNet: Skype for Business and Skype integration with Microsoft 

Dynamics CRM and TechNet: Set up CRM Online to use Skype or Skype for Business 

Supported versions of Skype and Skype for Business 

These versions of  and Skype, Lync, and Skype for Business are supported: 

 Microsoft Lync 2010 or Microsoft Lync 2013 

 Skype 6.0 

 Skype for Business 

Set whether your organization uses Skype or Skype for Business 

You can configure which telephony provider your organization uses for click to call. 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

Note  

 

https://technet.microsoft.com/library/dn531154.aspx
http://blogs.technet.com/b/lystavlen/archive/2015/03/31/make-a-note-of-this.aspx
http://go.microsoft.com/fwlink/p/?LinkID=246141
http://go.microsoft.com/fwlink/p/?LinkID=526645
https://technet.microsoft.com/library/hh699721.aspx
https://technet.microsoft.com/library/hh699721.aspx
https://technet.microsoft.com/library/jj863703.aspx
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2. Go to Settings > Administration. (How do I get there?) 

 

3. Click System Settings. 

4. On the General tab, under Set the telephony provider, for Select provider for Click to 

call, select Skype or Skype for Business/Lync. 

5. Click OK. 

 

Set your organization’s prefix for phone numbers 

For people to place Skype or Skype for Business calls from within Microsoft Dynamics CRM, the 

phone numbers must be entered and stored in a valid number format: <country/region 

code><area code><number>. However, when entering data in Microsoft Dynamics CRM, users 

may not include the required country or region prefix in a phone number.  

To solve this, you can enable country/region code prefixing, and the system will prefix the code to 

the number that you are trying to call. This prefixing can be done for the entire organization, or 

users can set the country or region code in their personal options. If a user has specified a 

different code than what is set for the organization, the user’s setting overrides the organization’s 

setting.  

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Click System Settings. 

4. On the General tab, in the Set the default country/region code section, select the 

Enable country/region code prefixing check box, and then in the Country/Region 

Code Prefix, specify the country/region code, such as +01181 (81 is the country code for 

Japan). 

5. Click OK. 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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See Also 

TechNet: Skype for Business and Skype integration with Microsoft Dynamics CRM 

TechNet: Set up CRM Online to use Skype or Skype for Business 

Set up an activity feed or Yammer 

 

Administer the activity feed 

Connect Microsoft Dynamics CRM to Yammer 

Administer the activity feed 

Enable Activity Feeds to let users see their most recent activities on the wall. When you first 

install Microsoft Dynamics CRM, Activity Feeds is available and turned on by default, though it is 

a solution and you’ll administer it as you would any other solution. 

Your organization also can use Yammer, which is an alternative to using activity feeds—you can 

use either one, but not both. 

Many record types allow for activities to be associated with them. For example, for an opportunity, 

you might have an associated phone call activity. If you want to stay up to date with what's 

happening in your organization, viewing all the activities you and your colleagues have recorded 

in the system is an effective way to do that. With activity feeds, you'll see the most recent news 

about everything you're interested in—colleagues and records alike—in one single-page view. 

You can do the following in Activity Feeds:  

 Create a personal page. Here, you can post a profile picture along with other personal data 

about you and the work you do. 

 View recent news in one view. On your personal page, you'll see a feed of updates from 

colleagues as well as updates about records. 

 Follow your colleagues. When a colleague you follow posts a comment, you'll see it on your 

feed page. If the colleague changes a record, you'll see that on your feed page as well. 

 Follow records. You can stay up to date on records by following them in activity feeds. Even if 

you're not following the user who changes them, your feed page will display posts about 

opportunities, leads, and cases that you follow. 

See Also 

Stay up-to-date with customer news with the activity feed 

Display your picture on the activity feed 

Connect Microsoft Dynamics CRM to Yammer 

Yammer is a private social network that gives colleagues at your organization a central place to 

post conversations, create and edit documents, and share information without sending a single 

email or attending any meetings.  

https://technet.microsoft.com/library/hh699721.aspx
https://technet.microsoft.com/library/jj863703.aspx
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After you set up your organization to work with Yammer, employees will see posts in a newsfeed 

on their Microsoft Dynamics CRM dashboard whenever people update customer info, and they’ll 

be able to join in the conversation with their own posts. 

Before your organization can use Yammer in CRM, your organization needs to buy 

Yammer enterprise licenses, and then connect your organization to Yammer. More 

information:  TechNet: Connect Microsoft Dynamics CRM to Yammer 

Visit the Yammer website 

Enable Office Delve 

Office Delve in CRM is a new way to find and discover relevant and trending documents across 

your organization. Delve searches across your company and uses Azure Machine Learning to 

provide a view of the documents you’re most interested in based on who created, viewed, edited, 

or shared the documents. Delve is a new dashboard component that can be added to any user or 

system dashboard so you can see trending information from within CRM. 

To use Delve, your system administrator must first enable it. For more information about enabling 

and using Delve, see:  

 TechNet: Enable Office Delve 

 View relevant and trending information with Office Delve 

Insights for Microsoft Dynamics CRM - powered by InsideView 

Boost your sales close rates with information that will help you find, understand, and engage 

more qualified buyers. The Insights pane lives on your Microsoft Dynamics CRM accounts, 

contacts, leads, and opportunities forms, where it pulls in company, contact, and social data from 

thousands of constantly-updated sources.  

Insights helps you make quick work of prospecting, connecting, and best of all closing, because 

you can: 

 Instantly qualify prospects with high quality company data. 

 Save hours of research time with up-to-the-minute company news and social media buzz at 

your fingertips.  

 Start a conversation with a target buyer by noting mutual acquaintances, past employers you 

have in common, or schools you both attended. 

 Learn about your prospects and customers through 360-degree profiles and real-time 

updates from LinkedIn, Twitter, Blogs, and other social media.  

Insights is available as a preferred provider solution that your administrator can add from the 

Office 365 CRM Online Administration Center. It’s included at no additional charge in all Microsoft 

Dynamics CRM Online Professional and Enterprise paid licenses in North America. Mexico is not 

supported. 

Important  

https://technet.microsoft.com/library/dn850385.aspx
http://go.microsoft.com/fwlink/p/?LinkID=272440
https://technet.microsoft.com/library/4c8755d3-dd1e-480e-b077-88b45c787b92
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Get started 

 CRM Insights user guide  

 Install Insights for Dynamics CRM  

For Sales reps 

 Effective B2B selling with Insights  

More info 

 InsideView home page  

Insights training 

FantasySalesTeam from Microsoft 

FantasySalesTeam, from Microsoft is a simple yet powerful sales gamification application that 

has helped hundreds of companies boost sales productivity, drive revenue, and improve 

Microsoft Dynamics CRM adoption through collaboration and team-based competition. 

FantasySalesTeam goes beyond basic gamification by providing a platform that allows anyone in 

an organization to “draft” a team of players, for example, a group of employees, across specific 

positions. Each employee on the team earns points for the metrics that their manager selects, 

such as making calls, finding leads, creating new opportunities, or closing deals.  

FantasySalesTeam creates a fun environment that keeps sales reps engaged, helping to 

increase overall CRM adoption and drive greater results.  

Here’s why FantasySalesTeam works: 

 Team-based competition gets reps pushing on each other and investing in the success of 

those around them through team-based competition. 

 Measurable goals and clearly-defined metrics drive activity, performance, and behavior by 

setting goals and defining metrics. 

 Multiple and multi-tiered awards you create keep your sales reps engaged. 

 Results are highly visible through leaderboards, dashboards, TV monitors, and emails. 

 The concept of “fans” gets executives, managers, marketing, operations and other non-sales 

employees involved. 

FantasySalesTeam, from Microsoft is a preferred provider solution. Ask your 

administrator to add it from the Office 365 admin center page. 

 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=328957
https://technet.microsoft.com/library/dn878909.aspx
http://go.microsoft.com/fwlink/p/?LinkId=524621
http://go.microsoft.com/fwlink/p/?LinkId=524622
http://go.microsoft.com/fwlink/p/?LinkId=524623
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Get started 

 Case Study for FantasySalesTeam  

Acquisition Announcement 

Install FantasySalesTeam 

More info 

 FantasySalesTeam website  

Forum support 

FieldOne from Microsoft 

FieldOne, from Microsoft empowers customers to execute their field service management 

strategy by enhancing the efficiency and effectiveness of valuable resources. Its set of 

configurable tools includes centralized scheduling and dispatching, native mobile apps, and 

integrated back-office functions. The FieldOne solution improves customer satisfaction rates, 

enhances productivity, and drives revenue. 

Why FieldOne works: 

 Improves customer experience by giving users quick and reliable access to customer 

information. 

 Provides mobile field resources to enhance your total value and create new revenue 

opportunities. 

 Facilitates more work orders and resources with fewer dispatchers while empowering users 

to act quickly upon changing schedules, demand changes, and emergencies.  

 Increases first time fix rates and on-time delivery performance.  

This solution is available as a preferred provider solution that your administrator can 

add from the Office 365 CRM Admin Center. 

 

 

Get started 

 eBook: Overview of FieldOne  

 eBook: FieldOne for Mobile   

 eBook: Business Intelligence with FieldOne  

Customer Experience Story (2:38) 

More info 

 FieldOne Website  

Sign-up for Training 

Forum Support 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=623243
http://go.microsoft.com/fwlink/p/?LinkId=623292
http://go.microsoft.com/fwlink/p/?LinkId=624842
http://go.microsoft.com/fwlink/p/?LinkId=623293
http://go.microsoft.com/fwlink/p/?LinkId=623839
http://go.microsoft.com/fwlink/p/?LinkID=623846
http://go.microsoft.com/fwlink/p/?LinkID=623847
http://go.microsoft.com/fwlink/p/?LinkID=623848
http://go.microsoft.com/fwlink/p/?LinkId=623845
http://go.microsoft.com/fwlink/p/?LinkId=623841
http://go.microsoft.com/fwlink/p/?LinkId=623843
http://go.microsoft.com/fwlink/p/?LinkId=623840


 

 
540 

Partner Portal 

Create dashboards, charts, and reports 

 

Dashboards and charts [folder] 

Reports 

Manage data 

 

Manage your data (for admins) 

Add or remove sample data 

Set up duplicate detection rules to keep your data clean 

Turn duplicate detection rules on or off for the whole organization 

Run bulk system jobs to detect duplicate records 

Delete bulk records 

View and take action on bulk deletion jobs 

Monitor and manage system jobs 

Check for duplicate contacts, accounts, or leads 

Perform key business calculations with rollup fields 

Automate manual operations with calculated fields 

Create formulas for calculated fields 

Manage your data (for admins) 

Select the data management topic you’re interested in: 

Turn duplicate detection rules on or off for the whole organization 

Set up duplicate detection rules to keep your data clean 

Run bulk system jobs to detect duplicate records 

Delete bulk records 

Import accounts, leads, or other data 

Download a template for data import 

Add or remove sample data 

Add ready-to-use business processes 

Secure sensitive data by enabling encryption 

Export customized entity and field text for translation 

http://go.microsoft.com/fwlink/p/?LinkId=623842
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Import translated entity and field text 

Add or remove sample data 

Sample data gives you something to experiment with as you learn Microsoft Dynamics CRM, and 

helps you see how data is organized in the system. At some point, you’ll probably want to remove 

the sample data. 

Or, if sample data isn’t installed on your system, you may want to add it for training purposes. 

Later, when you’re ready, you can remove it.    

Use sample data to learn and play around with system features. However, to avoid 

unwanted results, don’t associate it with any data you actually need. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role  

a. Follow the steps in View your user profile. 

b.  Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Data Management. (How do I get there?) 

 

3. Click Sample Data. You’ll see a message that tells you whether the sample data is 

currently installed. 

4. Do one of the following:  

Click Remove Sample Data, and then click Close. 

-OR- 

Click Install Sample Data, and then click Close. 

See Also 

Create or edit a contact 

Create or edit an account 

Create or edit an opportunity 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Set up duplicate detection rules to keep your data clean 

To maintain the integrity of your data, it’s a good idea to have rules in place to reduce duplicate 

records in the system. Microsoft Dynamics CRM includes default duplicate detection rules for 

accounts, contacts, and leads, but not for other types of records. If you want the system to detect 

duplicates for other record types, you’ll need to create a new rule. 

After you’ve created duplicate detection rules, you need to turn duplicate detection on. 

 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Data Management. (How do I get there?) 

3. Choose Duplicate Detection Rules. 

4. To create a new duplicate detection rule, choose New. Type a name and description. 

–OR– 

To edit an unpublished existing duplicate detection rule, choose the duplicate detection 

rule. 

–OR– 

To edit a published duplicate detection rule, select the rule. On the Actions menu, 

choose Unpublish, and then choose the rule. 

5. Select the criteria to be used to identify a record as a duplicate. 

a. If you are creating a new rule: 

 In the Duplicate Detection Rule Criteria section, in the Base Record Type list, 

choose the type of record that this rule applies to. For example, select Contacts.  

 In the Matching Record Type box, choose the type of record to compare. In 

most cases, you’ll probably want to use the same record type for Base Record 

Type and Matching Record Type. It’s also useful to be able to compare 

different record types. For example, you might want to compare the Email field in 

Contacts to the Email field in Leads. 

b. If you want the rule to consider only active records while detecting duplicates, select 

the Exclude inactive matching records check box. You should also select this 

check box if your duplicate detection rule criteria are based on a status field.  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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c. If you want the rule to be case-sensitive, select the Case-sensitive check box. 

d. If you selected different record types for the base and matching record types, for 

each new criterion, in the Base Record Field column, choose Select, and then 

choose a field name. In the same row, in the Matching Record Field column, 

choose Select, and then choose a field name. 

-  OR - 

If you selected the same record types for the base and matching record types, for 

each new criterion, in the Field column, choose Select, and then choose a field. 

e. In the same row, in the Criteria column, choose Select, and then choose an 

operator. For example, select Exact Match. 

f. If you specified Same First Characters or Same Last Characters, in the No. of 

Characters column, choose Enter Value, and then enter the number of characters to 

compare. 

g. If you don’t want the rule to consider blank fields (null values) as equal while 

identifying duplicates, select the Ignore Blank Values check box.  

 

Important  

If the duplicate detection rule contains only one condition, blank values are 

ignored during duplicate detection job. 

The number of criteria that you can select is limited by the number of characters that can 

be stored in the matchcode for the record. As you add criteria, watch the Current 

matchcode length value shown at the bottom of the criteria list.  
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6. When you’re finished adding criteria, choose Save and Close. 

7. To make the new or changed duplicate detection rule usable, select the rule, and then 

choose Publish. 

When you publish a duplicate detection rule, a matchcode is created for every record in 

the matching record type for that rule. You can publish only five rules for the same base 

record type (Account, for example) at a time. You might need to delete or unpublish an 

existing rule if you bump up against this limit. 

 We recommend that you set the duplicate detection criteria on a field that has unique values, 

for example, Email.  

 You can have more than one duplicate detection rule for each record type.  

See Also 

Turn duplicate detection rules on or off for the whole organization 

Run bulk system jobs to detect duplicate records 

 

Note  
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Turn duplicate detection rules on or off for the whole organization 

To maintain the integrity of your data, it’s a good idea to set up duplicate detection rules to reduce 

duplicate records in the system. Remember that after you create duplicate detection rules, you 

need to turn them on. 

 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions. 

Check your security role  

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Data Management. (How do I get there?) 

 

3. Choose Duplicate Detection Settings. 

4. Select or clear the Enable duplicate detection check box.  

Note  

If your system contains a large number of records, checking for duplicates can 

impact performance. 

5. If you’re turning duplicate detection on, select or clear the check boxes to set when 

duplicates are detected: 

 When a record is created or updated 

 

The system checks for duplicates when a user enters or updates records. 

 

Important  

Duplicates aren’t detected when a user merges two records, activates or 

deactivates a record, or saves a completed activity. 

 When Microsoft Dynamics CRM for Outlook goes from offline to online 

 

For users of Microsoft Dynamics CRM for Outlook, the system detects duplicates 

when the user synchronizes their data after working offline, as long as users have 

enabled duplicate detection in Outlook. To enable duplicate detection in Outlook, 

choose File > CRM > Options. Choose the Local Data tab, and then select the 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Enable duplicate detection during offline to online synchronization check box. 

 

 During data import 

 

When you use the Import Data wizard to bring in contacts, leads, accounts, or other 

types of data, the wizard detects any duplicate records as long as you enable 

duplicate detection in the wizard. More information:  Import accounts, leads, or other 

data 

 

6. Choose OK. 

See Also 

Set up duplicate detection rules to keep your data clean 

Synchronizing data with Outlook or Exchange FAQ 

Run bulk system jobs to detect duplicate records 

Run bulk system jobs to detect duplicate records 

To maintain the integrity of system data, you should check for duplicates regularly to make sure 

that users don’t inadvertently create duplicate contacts, accounts, leads, or other types of 

records.  

The Check for Duplicates wizard helps you set up a bulk “job” that finds and cleans up duplicate 

records. You can schedule the job to run daily, and you can receive an email confirmation when 

the job finishes. 

If you haven’t already done so, create and publish duplicate detection rules, and turn 

duplicate detection on before you run the wizard. More information:  Set up duplicate 

detection rules to keep your data clean 

 

1. Go to Settings > Data Management. (How do I get there?) 

 

2. Click Duplicate Detection Jobs. 

3. Click New, or select the name of the duplicate detection job you want to run. 

You’ll see the Duplicate Detection wizard, which helps you create a job to check for 

duplicates. 

4. Click Next. 

5. In the Look for drop-down list, select the record type that you want to check for 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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duplicates. 

Note  

What you see in this list depends on which duplicate detection rules are 

published. More information: Set up duplicate detection rules to keep your data 

clean 

6. In the Use Saved View drop-down list, select a view if you want to limit the records 

searched to records in that view. For example, select Active Accounts. When you select a 

view, CRM adds the criteria to search on. 

7. To further limit the records searched, click Select and then enter the criteria you want. 

 
 

8. Click Next. 

9. Accept the default name for the job, or type a different name. 

10. Enter the start time for the job, and enter how often to run the job in days. (To run the job 

daily, type 1.) 

11. If you want to receive an email confirmation when the job is completed, select the Email 

options check box. Enter an additional email address, if desired. 

12. Click Next, and then click Submit. 

See Also 

Set up duplicate detection rules to keep your data clean 

Turn duplicate detection rules on or off for the whole organization 

View and take action on bulk deletion jobs 

TechNet: Detect duplicate data 

Delete bulk records 

It’s a good idea to occasionally do bulk deletions to maintain data quality and manage system 

storage in Microsoft Dynamics CRM. For example, do bulk deletions to remove: 

https://technet.microsoft.com/library/dn531094.aspx
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 Stale data 

 Data that’s irrelevant to the business 

 Unneeded test or sample data 

 Data that was incorrectly imported from other systems 

For more information, see TechNet: Delete bulk records. 

View and take action on bulk deletion jobs 

You can view the status of, pause, postpone, and resume a system job that you created using 

Bulk Record Deletion. 

 

1. Go to Settings > Data Management. (How do I get there?) 

 

2. Choose Bulk Record Deletion. 

3. In the Bulk Record Deletion window, you can perform the actions described in the 

following table. 
 

To Do this 

View status Look in the Status Reason column. 

View detailed status, including success 

and failure information 

Select the bulk-deletion job. 

View queries submitted for deletion Select the bulk-deletion job, and then 

under Information, choose Properties. 

Review the errors  Select the bulk-deletion job, and then 

under Related, choose Failures. 

Pause a bulk-deletion job a. Select the bulk-deletion job, and 

then on the Actions menu, choose 

Pause. 

b. When the confirmation message 

appears, choose OK. 

 

Note  

Bulk deletion jobs of fewer 

than 1,000 records cannot be 

paused.  

Postpone a bulk-deletion job a. Select the bulk-deletion job, and 

 

https://technet.microsoft.com/library/dn531072.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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then on the Actions menu, choose 

Postpone. 

b. When the confirmation message 

appears, choose OK. 

Resume a bulk-deletion job a. Select the bulk-deletion job, and 

then on the Actions menu, choose 

Resume. 

b. When the confirmation message 

appears, choose OK. 

Cancel a bulk-deletion job a. Select the bulk-deletion job, and 

then on the Actions menu, choose 

Cancel. 

b. When the confirmation message 

appears, choose OK. 

Modify recurrence of a bulk-delete job a. Select the bulk-deletion job, and 

then on the Actions menu, choose 

Modify Recurrence. 

b. If you select the Run this job after 

every check box, specify the 

interval after which you want the 

bulk-deletion job to run, and then 

choose OK. 

 

If you select the Run this job after every 

check box when you create a bulk-deletion 

job, the job becomes recurring and is 

moved to the Recurring Bulk Deletion 

System Jobs view. You can only change 

the recurrence for these recurring bulk-

deletion jobs. 
 

See Also 

Manage your data (for admins) 

Delete bulk records 

Monitor and manage system jobs 

Several Microsoft Dynamics CRM features use system jobs to perform tasks automatically, 

including workflows, import, and duplicate detection, running independently or in the background. 

You can monitor them to ensure that they run smoothly or have completed successfully.  
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Monitoring system jobs 

If there is a problem with a system job, you can cancel, postpone, pause, or resume it. 

 Canceling system jobs 

You cannot resume a canceled system job. 

 Postponing completion of system jobs 

Postponing an active system job stops any current and subsequent actions. You can specify 

a later time when you want the system job to restart. 

 Pausing system jobs 

You can resume a paused system job. 

 Resuming paused system jobs 

Resuming restarts a system job that was paused. 

a. If a system job fails, you can view the details about what steps failed and what the 

problems may have been.  First, open the system job record.  To display details about 

system job failures, move your pointer over the warning symbols. 

b. To view system job failures in a format that you can print or copy and paste, click the  

Print button. 

You cannot make changes to the status of a system job that has been completed or 

canceled. 

 

Check for duplicate contacts, accounts, or leads 

Microsoft Dynamics CRM includes duplicate detection rules for accounts, contacts, and leads. 

These rules are automatically turned on, so you don’t have to do anything to set up duplicate 

detection for these record types. 

If available on your system, you may also be able to check for duplicates of other record 

types, in addition to contacts, accounts, and leads. Check with your system administrator. 

Find your CRM administrator or support person 

See Also 

Merge duplicate records for accounts, contacts, or leads 

Perform key business calculations with rollup fields 

“Rollup fields” show calculations based on how records are related in a hierarchy. Rollup fields 

can help you answer these types of questions: 

 How many sub-accounts are there under one big account?  

Tip  

Note  

Note  
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 How much annual revenue is there for all the sub-accounts under an account hierarchy?  

 How many opportunities or leads is your team working for a big account, and what is the net 

open revenue for all the related accounts in the hierarchy?  

 How much time have we spent working a big account and all its sub-accounts? 

With Microsoft Dynamics CRM, you can set up rollup fields to perform calculations across related 

records without writing code or involving a developer. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

For more information on rollup fields, see TechNet: Define rollup fields. 

Automate manual operations with calculated fields 

“Calculated fields” allow you to build formulas and set conditions that allow you to perform 

calculations across one or more fields. For example, you can use calculated fields to determine 

things like:    

 Total net worth of an account by subtracting liabilities from assets 

 Estimated revenue for an opportunity multiplied by the probability of closing the deal 

 The quality of leads based on revenue and type of license (for example, whether a lead is 

hot, warm, or cold) 

With Microsoft Dynamics CRM, you can set up calculations across multiple records without 

writing code or involving a developer. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

For more information, see TechNet: Define calculated fields 

Create formulas for calculated fields 

You can use calculated fields to automate manual calculations in your business processes. For 

example, you can automatically apply a discount if an order is greater than $500. A calculated 

field can contain values resulting from simple math operations, or conditional operations (such as 

greater than or if-else), and many others. For information on the syntax to use with calculated 

fields, see TechNet: Calculated field functions syntax. 

Enable or manage auditing 

 

Audit data changes 

View the audit history of individual records 

Note  

Note  

http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/dn832162.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/dn832103.aspx
https://technet.microsoft.com/library/dn832103.aspx
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Recover database space by deleting audit logs 

View the audit summary 

Audit data changes 

Track changes made to your business data by enabling auditing. Analyze the history of a 

particular record, view a summary of everything that changed, or track when a user accesses 

Microsoft Dynamics CRM. Keep track of the changes done to a record, a field, or by a user. 

Microsoft Dynamics CRM automatically creates logs for the changes that are tracked. 

More information about how to view what changed in a record: View the audit history of individual 

records 

View the audit history of individual records 

Organizations often need to be in compliance with various regulations to ensure availability of 

customer interaction history, audit logs, access reports, and security incident tracking reports. 

You may want to track changes in Microsoft Dynamics CRM data for security and analytical 

purposes.  

You can view the audit history of records only when auditing is enabled for the organization and 

enabled for the record types and fields. 

 

1. Make sure that you have the System Administrator, System Customizer, Sales Manager, 

Vice President of Sales, Vice President of Marketing, or CEO-Business Manager security 

role or equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Open a record type you want to audit (for example, open Accounts or Contacts).  

3. Open a record in the list. 

4. Do one of the following: 

 In CRM: On the nav bar, beside the record name, click the down arrow  > Audit History. 

 In CRM for Outlook: Under Related, click Audit History. 

5. Use the Filter on drop-down box to select the field that you want to see the audit history 

for. 

6. To open the change list for an item, double-click the item. 
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See Also 

Audit data changes 

System Settings dialog box - Auditing tab 

View the audit summary 

Log changes made to customer records and user access so that you can review the activities 

later. The auditing feature is designed to meet the auditing, compliance, security, and governance 

policies of many regulated enterprises. 

Audit logs help administrators answer questions such as: 

 Which user was accessing the system and when? 

 Who updated this field value on this record and when? 

 What was the previous field value before it was updated? 

 What actions has this user taken recently? 

 Who deleted this record? 

 What locale was used to make the update? 

For more information on auditing, see TechNet: Audit data and user activity 

Recover database space by deleting audit logs 

When you enable auditing, Microsoft Dynamics CRM stores the change history for transactions in 

the form of audit logs in the database. You can delete the old or unwanted logs to clean up the 

database space. 

When you delete an audit log, you can no longer view the audit history for the period 

covered by that audit log. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Auditing. (How do I get there?) 

 

Caution  

 

https://technet.microsoft.com/library/dn887214.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Choose Audit Log Management 

4. Select the oldest audit log. Then, on the command bar, choose Delete Logs. 

5. In the confirmation message, choose OK. 

Note  

You can only delete the oldest audit log in the system. To delete more than one 

audit log, continue to delete the oldest audit log until you have deleted enough 

logs. 

See Also 

View the audit history of individual records 

System Settings Dialog Box Reference 

 

System Settings dialog box - General tab 

System Settings dialog box - Sales tab 

System Settings dialog box - Marketing tab 

System Settings dialog box - Service tab 

System Settings dialog box - Reporting tab 

System Settings dialog box - Formats tab 

System Settings dialog box - Email tab 

System Settings dialog box - Customization tab 

System Settings dialog box - Outlook tab 

System Settings dialog box - Auditing tab 

System Settings dialog box - Goals tab 

System Settings dialog box - Calendar tab 

View system status and notifications 

On/off switch for guided help 

Broadcast announcements to an entire organization 

System Settings dialog box - General tab 

Use the settings on this page to change general system-level settings like preferences for saving, 

decimal and currency precision, and other default settings for Microsoft Dynamics CRM. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

Open the System Settings dialog box (if it isn’t already open) 
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equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Click the System Settings > General tab. 

  
 

Settings Description 

Select the default save option for forms  

Enable auto save on all forms If Yes, which is the default, after a record is 

created (initially saved), any changes made to a 

form will automatically be saved thirty seconds 

after the change is made. The 30-second 

period starts again after a change is made. If no 

changes are made, the automatic save doesn’t 

happen. More information:  TechNet: Manage 

auto-save 

Set the IM presence option  

Enable presence for the system If Yes, which is the default, instant messaging 

will display the current status for users, 

contacts, opportunities, or leads. This only 

applies to lists and sub-lists for entities with an 

updated user interface. 

Set the full-name format  

Name Format Select the order in which you want customer 

and user names to be displayed. The default is 

First Name Last Name. 

Set the currency precision that is used for 

pricing throughout the system 

 

Pricing Decimal Precision Select how many decimal points to use for a 

currency. The default is 2. 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531073.aspx
https://technet.microsoft.com/library/dn531073.aspx
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Settings Description 

Set whether reassigned records are shared 

with the original owner 

 

Share reassigned records with original owner Select whether a record is shared with the 

original owner of the record, or completely 

reassigned to another user. The default is No. 

Set blocked file extensions for attachments Prevent users from attaching files with specific 

file name extensions. 

 

Set the currency display option 

 

Display currencies by using Set how to display currencies, either by a 

currency symbol, which is the default setting, or 

by currency code. For example, a currency 

symbol could be $, and the currency code could 

be USD. 

Set up search  

Enable Quick Find record limits If Yes, which is the default, if more than 10,000 

records are found, a message will be displayed 

that suggests a more selective search.  

Select entities for search Click Select to choose the entities to include 

when users do a search in Microsoft Dynamics 

CRM for tablets. 

Enable Bing Maps  

Show Bing Maps on forms If Yes, which is the default, Microsoft Dynamics 

CRM on-premises users will need to enter a 

Bing Maps key. CRM Online users don’t need 

to enter a key. 

Please enter Bing Maps  key On-premises users can obtain a Bing Maps key 

from: Bing Maps Dev Center 

Set the default country/region code  

Enable country/region code prefixing If enabled, which is the default, CRM will prefix 

the country/region code to numbers that users 

are trying to call. 

Country/Region Code Prefix The default is+1, which is the country/region 

calling code for North America.  

https://www.bingmapsportal.com/
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Settings Description 

Set the telephony provider  

Select provider for Click to call Choose which provider to enable outbound 

calls from within CRM. This setting doesn’t 

apply to CRM for tablets or Microsoft Dynamics 

CRM for phones. 

Set whether users see CRM for tablets 

message 

 

Users see app download message If Yes, which is the default, users will see a 

message regarding downloading the Microsoft 

Dynamics CRM for tablets app. 

  

  

Set custom Help URL  

Use custom Help for customizable entities If you want to replace the default Help content 

with custom Help designed for your users, click 

Yes. After you enable custom Help, you can 

enter a Global Custom Help URL. 

This feature was introduced in CRM Online 

2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your 

CRM administrator or support person.  

Global custom Help URL To replace the default Help with a single URL 

for all customizable record types (entities), 

enter the URL here. You also have the option of 

entering override URLs for each record type 

(entity) for customizable record types. More 

information: TechNet: Customize the Help 

experience 

Append parameters to URL If you click Yes to append parameters to the 

URL, you can make your Help content more 

dynamic. For example, you can access 

parameters for User Language Code, Entity 

Name, Entry Point, and Form ID. More 

information: TechNet: Customize the Help 

experience 

Disable Social Engagement  

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/dn832079.aspx
https://technet.microsoft.com/library/dn832079.aspx
https://technet.microsoft.com/library/dn832079.aspx
https://technet.microsoft.com/library/dn832079.aspx
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Settings Description 

Prevent feature from receiving social data in 

CRM 

Defaults  to No. If you don’t want to receive 

social data in CRM, select Yes. If you disable 

social engagement, your organization will not 

be able to receive social data in CRM. Users 

can continue to work with existing social data, 

however. 

Set whether users see welcome screen  

Display welcome screen to users when they 

sign in 

When users start CRM, they’re presented with 

a welcome screen (navigation tour) that 

provides a quick overview of CRM. Click No to 

disable this tour for all users in your 

organization. 

This feature was introduced in CRM Online 

2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your 

CRM administrator or support person.   

Use legacy form rendering  

For compatibility, use the legacy form rendering 

engine. Note that performance may be 

adversely affected. 

In CRM Online 2015 Update 1 and CRM 2016 

on-premises, we made enhancements to 

Microsoft Dynamics CRM forms so that they 

load faster.  

However, if you have forms that include 

unsupported customizations, these 

enhancements can cause compatibility 

problems. To avoid this, you can temporarily 

turn the form enhancements off by choosing 

Yes. We recommend that you reset this setting 

to No after addressing scripting problems so 

you can take advantage of optimized forms. 

Note  

When a form that includes unsupported 

customizations is used, such as 

unsupported JavaScript, the form may 

fail to load or the user will receive an 

error message.  

 If the form just fails, set the Use legacy 

form rendering option to Yes. If the form 

loads after you select this option, you may 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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Settings Description 

have unsupported customizations. 

 If the user receives an error, click "View the 

data that will be sent to Microsoft" and see 

the details in the <CrmScriptErrorReport> 

tags. More information: TechNet: What kind 

of customizations aren’t supported? 

 

 

See Also 

TechNet: Manage auto-save 

TechNet: Customize the Help experience 

TechNet: What kind of customizations aren’t supported? 

System Settings dialog box - Sales tab 

Use the settings on this page to configure system-level settings for the sales area of Microsoft 

Dynamics CRM. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

 

2. Go to Settings > Administration. (How do I get there?) 

3. Click System Settings and then select the Sales tab. 

4. Fill in the information: 
 

Settings Description 

Create products in 

active state 

To set the products to active state by default after creation, click 

Yes. This option applies only to products that don’t have a parent 

product family. To create products in the Draft state, click No. 

Important  

 

https://technet.microsoft.com/library/dn531193.aspx#BKMK_Unsupported
https://technet.microsoft.com/library/dn531193.aspx#BKMK_Unsupported
https://technet.microsoft.com/library/dn531073.aspx
https://technet.microsoft.com/library/dn832079.aspx
https://technet.microsoft.com/library/dn531193.aspx#BKMK_Unsupported
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Allow selection of 

default pricelist for 

opportunity via 

inbuilt rule 

Click Yes if you want the default price list to be selected for an 

opportunity based on the inbuilt rule (based on the default price 

lists defined for territories). Otherwise, click No. 

Maximum number 

of products in a 

bundle 

Type the maximum number of products a bundle can have. 

Use system 

pricing 

calculations 

Click Yes to use the pricing calculations of Microsoft Dynamics 

CRM. To use custom pricing by using a plug-in, click No. When 

set to No, the default pricing calculations won’t be done on 

opportunity, quote, order and invoice records. 

Discount 

calculation method 

Select Per unit if you want the pricing engine to calculate the 

discount based on the prices per unit instead of a line item. By 

default, the calculations are done on a line item-basis. The 

following table shows the difference between the two calculations 
 

Discount 

method 

Product Price 

per 

unit 

Quantity Discount Amount 

Line 

item 

Product 

1 

100 11 10 (100*11)-

10=1090 

Per unit Product 

2 

100 11 10 (100-

10)*11=990 

 

 

Maximum number 

of properties that 

are allowed for a 

product or bundle 

Type the maximum number of properties (specifications) a 

product or bundle can have. Product properties are added to a 

product family record, and all the child products and bundles 

under the product family inherit the properties added to the parent 

product family. The number specified in this setting is applied only 

when you publish a product or a bundle with the associated 

properties. 
 

See Also 

Set up a product catalog: Walkthrough 

Create price lists and price list items to define pricing of products 

Set up a discount list 

Create product bundles to sell multiple items together 

Use properties to describe a product 
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System Settings dialog box - Marketing tab 

Use the settings on this page to configure marketing settings for Microsoft Dynamics CRM. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose System Settings > Marketing tab. 

  
 

Settings Description 

Set whether direct email through mail merge 

is enabled in campaigns 

 

Enable Direct Email via Mail Merge Default: Yes. If Yes, users can send email as a 

campaign activity using the mail merge feature. 

Note  

To enable this option, the security role 

assigned to users for whom you want 

to enable mail merge must also include 

the Mail Merge privilege. 

Set whether campaign responses are 

created for incoming campaign activity 

email (Available only if Email tracking is 

enabled) 

 

Create campaign responses for incoming email Default: Yes. If Yes, Microsoft Dynamics CRM 

creates campaign response records 

automatically when email messages are 

received in response to a specific marketing 

campaign. 

Open the Marketing System Settings dialog box (if it isn’t already open) 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Settings Description 

Set the auto-unsubscribe options (Available 

only if Email tracking is enabled) 

 

Set "Do Not Send Marketing Material" option 

when unsubscribe email is received 

Default: No. If Yes, when an unsubscribe email 

is received, the preference setting for the 

account, contact, or lead from the marketing list 

gets updated automatically to not send 

marketing materials. 

Send acknowledgement to customers when 

they unsubscribe 

If the previous setting Set “Do Not Send 

Marketing Material” is Yes, you can use this 

setting to send a response to customers when 

they unsubscribe. 

Template for Acknowledgement Email If the two previous settings are Yes, you must 

specify an email template to use to respond to 

customers when they unsubscribe. 

 

System Settings dialog box - Service tab 

Use the Service tab in System Settings to set preferences for the customer service area, such as 

service level agreements and entitlements in Microsoft Dynamics CRM. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Click the System Settings > Service tab. 

4. Fill in the information using the following table for guidance. 
 

Settings Description 

Disable SLAs  

Disable Service Level Agreements(SLAs) 

on case records 

SLAs are enabled by default. You can 

enable or disable them for cases in your 

organization. For example, you might 

want to disable SLAs during maintenance 

activities or when you're importing cases 

and you don't want the SLAs to apply to 

the cases. To disable, click Yes. To 

enable, click No. 

Note  

When SLAs are disabled, 

SLA records can still be 

created or modified. SLAs 

won’t be applied to case 

records, however. 

 Apply SLA after manual override 

Important  

For Microsoft Dynamics CRM 

Online organizations, this 

feature is available only if your 

organization has installed 

Microsoft Dynamics CRM 

Online 2016 Update. For on-

premises CRM organizations, 

this feature is only available if 

you've updated to Microsoft 

Dynamics CRM 2016.  

Interested in getting this 

feature? Find your CRM 

administrator or support 

person. 

This setting determines if an SLA should 

be automatically applied on a case record 

when an SLA is manually selected in the 

SLA field of the case. The automatic SLA 

application can either be through the 

entitlement applied to the case or with the 

default SLA.  

In any case, the manual SLA takes 

precedence over any other way of SLA 

application. 

When set to No, SLAs won’t be applied 

automatically to cases after an SLA is 

manually applied.   

Note  

When both entitlement and 

customer, and manual SLA 

are changing, the manual 

SLA is used regardless of this 

setting.  

Select On Hold Case Status Select the case statuses for which the 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
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SLA calculation should be paused. View 

(double-click) the statuses in the 

Available Values column. When a 

service rep sets a case to one of the On 

Hold status values you set here, CRM 

pauses the SLA calculation. When the 

service rep changes the status of the 

case back to a status other than an On 

Hold status, CRM updates the failure and 

warning time in the enhanced SLA service 

KPIs. It also tracks the total time for which 

a case record is on hold.  

 

Automatically apply entitlement  Select whether to automatically 

apply the default customer 

entitlement when a case is 

created. 

 Select whether to automatically 

apply the default customer 

entitlement when a case is 

updated and the customer, 

contact, or product field has 

changed. 

 
 

See Also 

Define service level agreements (SLAs) 

System Settings dialog box - Reporting tab 

Use the settings on this page to configure reporting settings for Microsoft Dynamics CRM. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

Open the Reporting System Settings dialog box (if it’s not already open) 
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2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose System Settings > Reporting tab. 

  
 

Settings Description 

Specify report categories Default categories: 

 Sales Reports 

 Service Reports 

 Marketing Reports 

 Administrative Reports 

Note  

If you add a new category or change 

existing categories, you should also 

change the default views available for 

the Report record type. Otherwise, 

users won't have a way to see all 

reports in the new categories. 

Default Value Default: Unassigned Value. Select the default 

report category. 

 

System Settings dialog box - Formats tab 

You can control how Microsoft Dynamics CRM displays numbers, currencies, times, and dates for 

your organization. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

Open the Formats System Settings dialog box (it it isn’t already open) 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose System Settings > Formats tab. 

  
 

Settings Description 

Organizational Standards and Formats  

Current Format Default: your organization’s language and 

locale. Choose Customize to customize 

number, currency, time, and date formats for 

your organization. 

Format Preview Preview the settings for the selected language 

and locale. 

 

See Also 

Customize regional options (admins) 

System Settings dialog box - Email tab 

Use the settings on this page to set up email processing in Microsoft Dynamics CRM.  

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Email Configuration. (How do I get there?)  

3. Choose Email Configuration Settings. 

 

 

 
 

Open the System Settings dialog box (if it isn’t already open) 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Settings Description 

Configure email processing 

 

Process Email Using Select whether you want to process email by 

using server-side synchronization or the Email 

Router. Server-side synchronization is the 

preferred synchronization method. 

More information: TechNet: Integrate your 

email system with Microsoft Dynamics CRM 

Configure default synchronization method For any mailbox that is automatically created in 

CRM when a user or queue is created, the 

default email settings as defined in this section 

will be applied. 

Server Profile For server-side synchronization, select the 

email server profile that you want to use. The 

email server profile holds the configuration data 

that enables CRM to connect to Microsoft 

Exchange. If you’re connecting CRM Online 

with Exchange Online, the email server profile 

is automatically created for you. 

Incoming Email Select whether you want to use Dynamics CRM 

for Outlook, the Email Router, server-side 

synchronization, or a forward mailbox for 

processing incoming email. More information: 

TechNet: Create forward mailboxes or edit 

mailboxes 

Outgoing Email Select whether you want to use Dynamics CRM 

for Outlook, the Email Router, or server-side 

synchronization for processing outgoing email. 

Appointments, Contacts, and Tasks Select whether you want to use Dynamics CRM 

for Outlook or server-side synchronization to 

synchronize appointments, contacts, and tasks 

between Outlook and CRM.  

Note  

You can’t synchronize appointments, 

contacts, and tasks if you’re 

synchronizing with a POP3 email 

server. 

https://technet.microsoft.com/library/6804d996-86b2-4fb0-aed9-21fbdde0bab5.aspx
https://technet.microsoft.com/library/6804d996-86b2-4fb0-aed9-21fbdde0bab5.aspx
https://technet.microsoft.com/library/dn832085.aspx
https://technet.microsoft.com/library/dn832085.aspx
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Settings Description 

Email processing for unapproved users and 

queues 

Select these check boxes if you want to allow 

email processing only for users and queues 

whose email addresses have been approved by 

the system administrator. 

 Process email only for approved users 

 Process email only for approved queues 

Configure folder-level tracking and email 

correlation 

 

Use folder-level tracking for Exchange folders 

(server-side synchronization must be enabled) 

Users can set up Exchange tracking folders, 

and then move messages to those folders to 

track them automatically on virtually any device. 

More information: Track Outlook email by 

moving it to a tracked Exchange folder 

Folder-level tracking provides 100% tracking 

accuracy. To use folder-level tracking: 

 You must select this check box. 

 Your organization must synchronize email 

through server-side synchronization. More 

information: TechNet: Set up server-side 

synchronization 

This feature was introduced in CRM Online 

2015 Update 1 and CRM 2016 (on-premises).  

 

 Interested in getting this feature? Find your 

CRM administrator or support person 

Use correlation to track email conversations Select this check box if you want to link email 

activities with other related records using the 

information in the email headers. This method 

uses email properties for correlation and is 

more accurate than smart matching, but less 

accurate than folder-level tracking or tracking 

tokens. More information: TechNet: Email 

message filtering and correlation 

Note  

Email correlation using email headers 

works best when email is processed 

using server-side synchronization. If 

you’re using the Email Router to 

https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/dn531109.aspx
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
https://technet.microsoft.com/library/hh699705.aspx
https://technet.microsoft.com/library/hh699705.aspx
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process email, you can use tracking 

tokens or smart matching to correlate 

email activities with related records. 

 

Use tracking tokens Select this check box to use tracking tokens 

and to configure how CRM displays them in the 

Subject line of the email messages.  

Tracking tokens provide 100% tracking 

accuracy. If you don’t want to see tokens in 

Subject lines, however, consider folder-level 

tracking, which also provides 100% tracking 

accuracy.  

You can configure prefixes and other sections 

of tracking tokens. Long prefixes or too many 

prefix changes may cause lost data in history, 

however. More information: TechNet: Email 

message filtering and correlation 

Use smart matching Select this check box to use smart matching to 

correlate email based on the similarity between 

email messages. Smart matching isn’t as 

accurate as tracking tokens or folder-level 

tracking. More information: TechNet: Email 

message filtering and correlation 

Set tracking options for emails between 

CRM users 

 

Track email sent between two CRM users as 

two activities 

Select this option to create two email activities 

between CRM users, one for the sender and 

one for the recipient. 

Set email form options  

Use secure frames to restrict email message 

content 

If this is set to Yes, you may see the following 

error message when you’re reading email: “This 

content cannot be displayed in a frame”. 

Although this can make sending sensitive 

content in email less secure, changing the 

setting to No typically eliminates this error. 

Allow messages with unresolved recipients to 

be sent 

Set this to Yes if you want to send email 

messages that have unresolved recipients. 

https://technet.microsoft.com/library/hh699705.aspx
https://technet.microsoft.com/library/hh699705.aspx
https://technet.microsoft.com/library/hh699705.aspx
https://technet.microsoft.com/library/hh699705.aspx


 

 
570 

Settings Description 

Set file size limit for attachments  

Maximum file size (in Kilobytes) Increase or decrease the maximum file size for 

attached files. The default size is 5120K. The 

maximum size is 32768K. 

Configure alerts Select check boxes for the type of alerts that 

must be sent to CRM users: 

 Error (default) 

 Warning 

 Information (default) 

Tip  

Select Warning if you’re 

troubleshooting or testing or want to get 

more detailed messages on the alert 

wall. 

Notify mailbox owner By default, the system administrator is notified 

of any error that occurs for an email server 

profile.  

Select this check box if you also want to notify 

the mailbox owner. 

 

See Also 

Track Outlook email by moving it to a tracked Exchange folder 

Synchronizing data with Outlook or Exchange FAQ 

TechNet: Set up email through server-side synchronization 

TechNet: Install the Email Router for Microsoft Dynamics CRM 2016 and CRM Online 

System Settings dialog box - Customization tab 

Use the Customization tab in System Settings to set preferences for plug-in and workflow tracing 

and also the use of application mode.. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

Open the System Settings dialog box (if it isn’t already open) 

https://technet.microsoft.com/library/dn531109.aspx
https://technet.microsoft.com/library/hh699800.aspx
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a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose System Settings and then choose the Customization tab. 

 

Settings Description 

Application mode  

Set whether Microsoft Dynamics CRM can be 

opened in a browser window without menu, 

navigation, and command bars. 

 

Open Microsoft Dynamics CRM in Application 

mode 

Select this check box to enable application 

mode. When this mode is enabled, Microsoft 

Dynamics CRM can be opened in a browser 

without menus, navigation, or toolbars. Hiding 

these parts of the browser causes Microsoft 

Dynamics CRM to appear like a separate 

application rather than a website. By default, 

application mode isn’t enabled. 

Plug-in and custom workflow activity 

tracing 

 

Enable logging to plug-in trace log You can now store detailed information about 

an exception or trace event raised by a custom 

code to help developers debug plug-ins or 

custom workflow activity that they develop 

using the customization methods supported by 

Microsoft Dynamics CRM.  

 To capture trace logs only for exceptions, 

select Exception. 

 To capture logs for all errors and general 

trace events, select All.  

 To disable capturing trace logs, select Off. 

More information:  MSDN: Debug a plug-in 

Warning  

We recommend that you don’t keep 

this option enabled for an extended 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://msdn.microsoft.com/library/gg328574.aspx
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Settings Description 

period because it may have 

performance implications in your 

organization. 

 

See Also 

MSDN: Debug a plug-in 

System Settings dialog box - Outlook tab 

Use the settings on this page to configure how Microsoft Outlook interacts with Microsoft 

Dynamics CRM. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose System Settings > Outlook tab. 

 
 

Settings Description 

Set email promotion options for Microsoft 

Dynamics CRM for Outlook 

 

Perform checks as new email is received Default: Yes. If Yes, email is checked for 

tracking as soon as it arrives. 

Promote incoming email every Default: 10 minutes. Looks for and links 

incoming email on the specified interval. 

Send pending CRM email every Default: 10 minutes. Sends pending Microsoft 

Dynamics CRM email on the specified interval. 

Open the System Settings dialog box (if it’s not already open) 

https://msdn.microsoft.com/library/gg328574.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Settings Description 

Set whether users can schedule 

synchronization in Microsoft Dynamics CRM 

for Outlook 

 

Users can schedule synchronization Default: Yes. If Yes, users can set whether or 

not Dynamics CRM for Outlook synchronizes 

with Microsoft Dynamics CRM. 

Minimum Time between synchronizations Default: 15 minutes. Synchronizes Dynamics 

CRM for Outlook and Microsoft Dynamics CRM 

on the specified interval. 

Set whether users can update their local 

data in the background in Microsoft 

Dynamics CRM for Outlook 

 

Users can schedule background local data 

synchronization 

Default: Yes. If Yes, users can update the data 

that is stored on their computer to use offline. 

Minimum time between background local data 

synchronizations 

Default: 15 minutes. Local data is synchronized 

with Microsoft Dynamics CRM on the specified 

interval. 

Set schedule for address book 

synchronization in Microsoft Dynamics CRM 

for Outlook 

 

Users can schedule background address book 

synchronization 

Default: Yes. If Yes, users can update the 

address book that is stored on their computer 

to use offline. 

Minimum time between address book 

synchronizations 

Default: 1 hour. The local address book is 

synchronized with Microsoft Dynamics CRM on 

the specified interval. 

Set whether users see  Dynamics CRM for 

Outlook message 

 

Users see “Get Dynamics CRM for Outlook” 

option displayed in the message bar 

Default: Yes. If Yes, the Get CRM for Outlook 

button is displayed in Microsoft Dynamics 

CRM. 

 

System Settings dialog box - Auditing tab 

Enable auditing to track changes to your organization’s data and maintain a log of changes. 
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1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Choose System Settings > Auditing tab. 

4. Under Audit Settings, you can start auditing and specify whether or not to audit user 

access. You can also stop auditing if it is currently enabled. 

If you enable auditing and audit user access, CRM tracks when the user started 

accessing CRM and whether or not the user accessed the application by using the web 

application or Dynamics CRM for Outlook. 

5. Under Enable Auditing in the following areas, you can specify to audit specific areas 

of the product, as described in the following table. 

 

 

Auditing area Enable the start of auditing for these entities 

Common Entities Account, Contact, Lead, Marketing List, 

Product, Quick Campaign, Report, Sales 

Literature, Security Role, and User 

Sales Entities Competitor, Invoice, Opportunity, Order, and 

Quote 

Marketing Entities Campaign 

Customer Service Entities Article, Case, Client Feedback, Contract, and 

Service 

 

See Also 

Audit data changes 

View the audit history of individual records 

Open the System Settings dialog box (if it’s not already open) 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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System Settings dialog box - Goals tab 

Set the duration and frequency of the automatic rollup of goals. These settings only affect the 

automatic handling of all goals set in Microsoft Dynamics CRM. You can always perform a 

manual rollup for any goal at any time. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Click the System Settings > Goals tab. 

  
 

Settings Description 

Set the roll-up expiration time and the roll-

up frequency. 

 

Days after the goal end date when the rollup 

will stop 

Default: 30 days. Set the number of days after 

the ending date of a goal for Microsoft 

Dynamics CRM to stop including a goal in a 

rollup. 

Roll-up recurrence frequency Default: 24 hours. Set the number of hours 

between each Microsoft Dynamics CRM goal 

rollup. 

 

See Also 

Progress Against Goals report 

System Settings dialog box - Calendar tab 

Use the settings on this page to configure calendar settings for Microsoft Dynamics CRM. 

Open the System Settings dialog box (if it isn’t already open) 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Go to System Settings > Calendar tab. 

  
 

Settings Description 

Set scheduling options  

Maximum duration of an appointment in days CRM users can create appointments to meet or 

talk to customers. Users create these 

appointments on the Service Calendar or in the 

Activities area.  

You can use this setting to control the 

maximum number of days that your users can 

schedule an appointment for. The default is 10 

days. 

 

See Also 

Create or edit an appointment 

View system status and notifications 

Use this page to view current notifications from Microsoft Dynamics CRM about your organization 

and subscription. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

Open the Calendar System Settings dialog box (if it isn’t already open) 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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equivalent permissions.   

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?) 

 

3. Click System Notifications. 

 

On/off switch for guided help 

Guided help is turned on by default, but is easy to turn off.  

 

 

Turn guided help on or off for an individual user 

This setting affects only the person who makes this change. 

 To turn guided help off: On the nav bar, click the Options  icon  > Opt out of guided help. 

 To turn guided help on: On the nav bar, click the Options  icon  > Opt in for guided help. 

Turn guided help on or off for an entire organization 

This setting changes access to guided help for an entire organization. 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Administration. (How do I get there?). 

3. On the Administration page, click System Settings. 

4. On the General tab, scroll down to the Set custom Help URL section. Next to Enable 

Guided Help, select Yes or No.  

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Broadcast announcements to an entire organization 

Circulate information quickly to a wide set of users at one go by using Announcements in 

Microsoft Dynamics CRM. Announcements can also serve as message boards, where you can 

post topics of your interest that you wish to share, or get answers to. 

Create an announcement 

Use the Announcements page to create and broadcast an announcement.  

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > System. (How do I get there?) 

 

3. Choose Administration > Announcements . 

4. On the command bar, choose New.  

5. Fill in the information, as required. Use the handy tooltips as a guide. 

 Title - Type a title for the announcement that clearly and unambiguously states the 

purpose and nature of the announcement. 

 

 Body - Type the text for the announcement that you want to broadcast.  

 

Tip  

You can copy and paste an announcement text from another application. 

However, formatting might be lost. 

 More Information URL - Type the address of the website that provides detailed 

information about the announcement. (Optional) 

 

Note  

A web address that does not contain "http://" is automatically expanded to a 

full web address. In the announcement, the web address will appear as an 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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active external link. 

 Expiration Date - Type the date on which you want to stop the broadcast and the 

announcement should expire.  

 

Note  

You can’t edit/extend this date after expiry. Microsoft Dynamics CRM  

deletes the announcement after the expiration date. 

6. When you’re done, on the command bar, choose Save or Save and Close to begin the 

broadcast.  

Broadcast an announcement 

Make the announcements available to other users in your organization by using web resources 

and dashboards.  

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. In a text editor, type the following code, and save the file as 

“announcementsondashboard.htm”. 

<html> 

<body> 

<script 

type="text/javascript">window.location.href="/home/homepage/home_news.aspx?pagemod

e=iframe";</script> 

</body> 

</html> 

 

3. In CRM, go to Settings > Customization > Customize the System. 

4. Under Components, choose Web Resources > New. 

5. Type the name as “announcements” and display name as “Announcements”.  

6. In the Type drop-down list, select Web Page (HTML). 

7. In the Upload File box, choose Browse and select the 

“announcementsondashboard.htm” file that you created earlier. 

Create a web resource 
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8. Choose Save. 

9. Add this new web resource to any existing or new dashboard.  

More information:  eBook: Create or customize CRM system dashboards 

See Also 

MSDN: Understand dashboards: Dashboard components and FormXML 

Customize CRM 

 

Create or customize entities 

Create or customize forms 

Create or customize views 

Export and import entity and field text for translation 

Create business processes and other processes 

Create and manage a product catalog 

Work with templates 

Create or edit a solution 

View or download developer resources 

Add or edit an image web resource 

Create or customize entities 

 

View or edit entity information 

Create a new entity 

Create or edit entity fields 

Map entity fields 

Configure date fields to store fixed dates across time zones 

Create or edit N-N relationships between entities 

Create or edit N-1 relationships between entities 

Create or edit 1-N relationships between entities 

Create connections to view relationships between records 

Set up a relationship role to define family, social, or business relationships 

Change custom entity icons 

Enable an entity to display data as a hierarchy 

http://go.microsoft.com/fwlink/p/?LinkID=400662
https://msdn.microsoft.com/library/gg334200.aspx
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View or edit entity information 

You can view all the information, or properties, associated with an entity, but you can only edit 

selected properties. This is because many of the properties associated with an entity are set 

when it is created. The editable properties associated with an entity vary depending on the type of 

entity you are working with. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.   

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Choose Customize the System. 

4. Under Components, expand Entities, and then click or tap the entity you want to view or 

edit information for. 

Information about that entity is displayed, and it appears on two tabs: 

 General. Use this tab to edit some or all of the properties (depending on the entity) 

listed in the following table. 
 

Option Comments 

Note (includes attachments) Select this to create a relationship with 

the Note entity, and add a note control 

to the entity form. This allows users to 

make annotations for each record.   

Activities Select this to create a relationship with 

activity entities, and add an associated 

view to the entity. This allows you to 

track activities like phone calls, emails, 

and tasks. 

Connections Select this to permit ad hoc connections 

between a record in this entity and 

records in other entities.   

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Sending email (if an email field does 

not exist, one will be created) 

Select to add the Send Direct E-mail 

button to the main ribbon tab for the 

entity.  

Mail merge Select this to allow this entity to be used 

in a mail merge. 

Document management This allows you to track documents on 

SharePoint that are associated with a 

record in Microsoft Dynamics CRM.  

More information: TechNet: Set up 

SharePoint integration with Microsoft 

Dynamics CRM 

Queues Select this to use this entity in queues. 

Duplicate detection Select this to detect duplicates for this 

entity. This feature notifies you of 

identical records in Microsoft Dynamics 

CRM, and allows you to resolve them.  

Auditing Select this to track changes made to 

your business data. 

CRM for phones Select this to display and use this entity 

in Microsoft Dynamics CRM for phones.  

Reading pane in Dynamics CRM for 

Outlook 

Select this to display records in the 

reading pane in Microsoft Dynamics 

CRM for Microsoft Office Outlook.  

Offline capability for Dynamics CRM 

for Outlook 

Select this to let users create, read, 

update, or delete records while offline.   

 

 

 Primary Field. On this tab, the only editable property is Description. 

 

5. Publish your customizations: 

 To publish customizations for only the component you are currently editing, on the 

nav bar or in the Navigation Pane, click or tap the entity you have been working on, 

and then click or tap Publish. 

 To publish customizations for all unpublished components at one time, in the 

Navigation Pane, click or tap Entities, and then on the Actions toolbar, click or tap 

Publish All Customizations. 

 

https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
https://technet.microsoft.com/library/dn531154.aspx
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Important  

Any time you change user interface elements or implement form scripts for an 

entity, you must publish changes to apply them. Any customizations that change 

the data schema of Microsoft Dynamics CRM such as custom entities, 

relationships, or fields are applied immediately.  

Installing a solution or publishing customizations can interfere with normal 

system operation. We recommend that you schedule a solution import when it’s 

least disruptive to users. 

See Also 

TechNet: Customize your system 

TechNet: Create and edit entities 

Create a new entity 

You can create new entities for your Microsoft Dynamics CRM implementation to address specific 

business requirements. After you create a custom entity, additional tasks are required to ensure 

that the entity is accessible to your users. 

By default, when an entity is created, only the System Administrator and System 

Customizer security roles have any privileges to read or change data in the custom entity. 

You must add privileges explicitly to all security roles that need to use the new entity. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. Click Entities, and then on the command bar, click New. 

5. Specify the Display Name and Plural Name that will be used for this entity throughout 

Microsoft Dynamics CRM. 

6. In the Name box, view the name that Microsoft Dynamics CRM will use for this entity. 

Security  

 

https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/dn531052.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636


 

 
584 

Note  

When you specify the display name, a default value for the Name field is 

provided. If you change the display name before you save, the value in the Name 

field will not change. You can also modify the value in the Name field 

independently of the display name. 

7. The Primary Image list only has the option [None] when you create a custom entity. 

After you create the entity you can create a new image field. Each entity can have only 

one image field. After you create a new image field, that field will be available for 

selection. After you change this setting you must save the entity and publish the 

customizations. 

8. In the Ownership list, select one of the following: 

 User or Team. Records for this entity can be owned by individual users or by teams. 

Security can be defined according to the business unit with which the current owner 

is associated. For example, contact records are set to User or Team. 

 

 Organization. Records for this entity are used for reference by all Microsoft 

Dynamics CRM users. Individual users or teams can’t own these records. For 

example, product records are set to Organization. 

 

9. Under Areas that display this entity, select the areas where this entity will be displayed 

in the Microsoft Dynamics CRM user interface. 

Note  

All new entities are displayed in Advanced Find. 

10. Under Options for Entity, select the appropriate options for your scenario based on the 

detail provided in the following table. 
 

Option Comments 

Business process flows (fields will be 

created) 

Select this to enable creating business 

process flows for this entity. 

Note (includes attachments)  Select this to create a relationship with the 

Note entity, and add a note control to the 

entity form. This allows users to make 

annotations for each record.  

Activities Select this to create a relationship with the 

activity entities, and add an associated 

view to the entity. This allows you to track 

activities such as phone calls, emails, and 

tasks. 

Connections Select this to permit connections between 
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a record in this entity and records in other 

entities.  

Sending email (if an email field does not 

exist, one will be created)  

Select to add the Send Direct Email 

button to the main ribbon tab for the entity.  

Mail merge Select this to allow this entity to be used in 

a mail merge. 

Document management Select this to track documents on 

SharePoint that are associated with a 

record in Microsoft Dynamics CRM. More 

information:  Managing Documents 

Stored in SharePoint from Microsoft 

Dynamics CRM[CRM] 

Access Teams Select this to enable this entity for access 

teams. 

Queues Select this to use this entity in queues. 

More information:  Find what's assigned to 

you in a queue 

Allow quick create When this is enabled, and after you have 

created and published a Quick Create 

Form for this entity, people will have the 

option to create a new record using the 

Create button in the navigation pane. 

Duplicate detection Select this to detect duplicates for this 

entity. This feature notifies you of identical 

records in Microsoft Dynamics CRM, and 

allows you to resolve them. 

Auditing Select this to track changes made to your 

business data. 

CRM for phones Select this to display and use this entity in 

Microsoft Dynamics CRM for phones.  

CRM for tablets When this is enabled this entity will be 

available using Microsoft Dynamics CRM 

for tablets. You also have the option to 

make this entity Read-only in CRM for 

tablets. 

If the forms for an entity require an 

extension that is not supported by CRM 

for tablets, such as I-frame or web 
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resource controls, use this setting to 

ensure that the data for these entities is 

not editable by people using CRM for 

tablets. 

Reading pane in Dynamics CRM for 

Outlook 

Select this to display records in the 

reading pane in Microsoft Dynamics CRM 

for Microsoft Office Outlook.  

Offline capability for Dynamics CRM for 

Outlook 

Select this to let users include records for 

this entity with those they can work with 

while offline. 

 

 

11. To ensure that an easily recognizable name is used to reference this entity, on the 

Primary Field tab, enter a descriptive Display Name, and then verify that Requirement 

Level set to Business Required. 

The primary field is displayed when relationships to this entity are created or displayed, 

such as in the Look Up Records dialog box. 

Note  

The default Display Name for the primary field is Name. The Name will be 

“new_name” if you use the default publisher customization prefix of “new”. If this 

is not the name you want to use, you must set the name when you create the 

entity. You can edit the display name after you save the entity. 

12. Click Save. 

When a new entity is created, the following items are created also: 

 A default public view showing active records and a view showing inactive records. 

 An Advanced Find View, a Quick Find View, an associated view, and a lookup view. 

 The primary attribute you defined and the standard attributes. To see a list of them, 

navigate to the new entity you created, and under it, click Fields. They are displayed 

in the main pane. 

 For entities that have Ownership set to User or Team, the creation of the Owner 

and Owning Business Unit attributes. For entities that have Ownership set to 

Organization, the creation of the Organization ID attribute. 

 A filtered view is created in the CRM Online database for the entity. This filtered view 

can be used to write reports using data from this entity. 

 

Note  

Relationships are created with the User entity to resolve user names for the 

Created By and Modified By attributes. 

13. Change the icon for the new entity. More information:  Change custom entity icons. 
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14. For any security roles that need access to the new entity, add the needed privileges. 

 

a. Go to Settings > Administration. (How do I get there?) 

 

b. Click Security Roles. 

c. Open a security role, and then on the Custom Entities tab, specify the level 

of privileges that you want users with that security role to have. 

d. Click Save and Close to save the changes to the security role. 

Note  

When adding privileges, you can follow the pattern for the privileges 

that are used on the Marketing, Sales, or Service tabs for the 

security role to provide users the same level of access to the custom 

entity that they have to other entities. 

 

15. Publish your customizations: 

 To publish customizations for only the component that you’re currently editing, select 

the entity you’ve been working on, and then click Publish. 

 To publish customizations for all unpublished components at one time, click Entities, 

and then on the command bar, click Publish All Customizations. 

 

Important  

Any time you change user interface elements or implement form scripts for an 

entity, you must publish changes to apply them. Any customizations that change 

the data schema of Microsoft Dynamics CRM such as custom entities, 

relationships, or fields are applied immediately. 

Installing a solution or publishing customizations can interfere with normal 

system operation. We recommend that you schedule a solution import when it’s 

least disruptive to users. 

See Also 

TechNet: Create and edit entities 

Create or edit entity fields 

Create new fields to capture data when existing system entities don’t have fields that meet your 

requirements. 

After you create new fields, be sure to include them on the forms and views for the entity so that 

they are available from the Microsoft Dynamics CRM user interface. You can also add the new 

fields to relevant reports with the following restrictions: 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531052.aspx
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 Some system entities or custom entities that are included in a managed solution may not 

allow you to add new fields.  

 Some system fields or custom fields that are included in a managed solution may not allow 

you to edit them.  

 The default solution is a special unmanaged solution which shows you all solution 

components from any managed or unmanaged solutions. You can’t edit ANYTHING in the 

context of a managed solution. But all the things you find there are in your default solution 

anyway, so you don’t need to. 

For more information, see TechNet: Create and edit fields. 

Remember to add a description of the field – this provides instructions to your users on 

how to use the new field. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. Choose Customize the System. 

4. Under Components, expand Entities, and then expand the entity you want. 

5. Click Fields. 

 To add a new field, on the Actions toolbar, click New, and enter a Display Name to 

generate the Name. 

- OR - 

 To edit a field, select it in the list, and then on the Actions toolbar, click Edit. You can 

make changes to the following fields: 

i. For Field Requirement, select whether it’s optional, recommended, or required. 

ii. In Searchable, select whether to include this field in the list of fields shown in 

Advanced Find for this entity and also in the field available for customizing the 

find columns in the Quick Find view and the Lookup view. 

iii. For Field Security, enable or disable the feature for this field. More information:  

Enable or disable security for a field 

iv. For Auditing, enable or disable the feature for this field.  

6. For new fields, select the Type, and then enter required information for the specified 

type. For existing fields, you cannot modify the type, but you can modify the settings for 

Tip  

 

https://technet.microsoft.com/library/dn531187.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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the type. For more information, see TechNet: Types of fields. 

Possible data types for a field 
 

Data Type Notes 

Single Line of Text The following formats are available: 

 E-mail. This opens a new e-mail 

message in the default e-mail 

software when clicked and also 

validates an email address. 

 Text. This creates a text box. 

 Text area. This creates a scrolling 

text box. 

 URL. This opens the URL in the 

user's default browser when clicked 

and validates (or adds) a valid 

protocol (HTTP, HTTPS, FTP, 

FTPS, OneNote, and TEL) are 

allowed. 

 Ticker Symbol. This creates a 

stock ticker symbol in all capital 

letters. Click the symbol to open 

information about the stock in the 

user's default browser. By default, 

the MSN website opens. 

 Phone. This creates a link that 

enables Skype or Microsoft Lync 

users to initiate a call by using the 

linked number. 

Important  

Lync has been rebranded 

as Skype for Business. 

Currently, you’ll still see 

references to “Lync” in 

Microsoft Dynamics CRM, 

but CRM will work with 

Skype for Business. 

Option Set Select an existing option set, or define a 

new one.  

Two Options After creating this field, configure it in the 

form to which it was added. In the form, 

select whether the field is displayed as 

https://technet.microsoft.com/library/dn531187.aspx#BKMK_TypesOfFields
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option buttons (also known as radio 

buttons), a check box, or a list. 

 

Image Each entity can have one image field. When 

an entity has an image field it can be 

configured to display the image for the 

record in the application. 

 

Whole Number The following formats are available for this 

field: 

 None. The defaults are integer 

values between -2,147,483,648 and 

2,147,483,648, although you can 

set different minimum and 

maximum values. 

 Duration. This creates a drop-down 

list box with values in minutes, 

hours, and days. 

 Time Zone. This creates a drop-

down list box with options for every 

available time zone. 

 Language. This creates a drop-

down list box with options for every 

language that your organization has 

made available for users. 

Floating Point Number Select up to 5 precision points. You can set 

the minimum and maximum values. 

Decimal Number Select up to 10 decimal points. You can set 

the minimum and maximum values. 

Currency When you add a currency field to an entity, 

a corresponding (Base) field is also created. 

The (Base) field also has a currency data 

type. 

If the entity does not already have a field 

with a currency data type, two additional 

fields are created: 

 Currency. A lookup data type 

whose value must be set before 

you can set the value of a field with 

a currency data type. 
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 Exchange Rate. This has a 

decimal number data type. 

Multiple Lines of Text This is a scrolling text box. You can set the 

maximum number of characters for this 

field. 

Date and Time There are two formats: date only, or date 

and time. 

More information:  TechNet: Behavior of 

Date and Time data type 

Lookup You can create a lookup field using an 

entity relationship that has already been 

created, but not yet used with another 

lookup field. If you create a lookup field in 

an entity form, the relationship is 

automatically generated. A lookup field is 

created as a relationship field. 

 

7. Select the Field type, Format, and Maximum length of the field. 

8. Select the IME mode for this attribute. 

Note  

This specifies whether the active state of an Input Method Editor (IME) is 

enabled. An IME lets you enter and edit Chinese, Japanese, and Korean 

characters. IMEs can be in an active or inactive state. The active state accepts 

Chinese, Japanese, or Korean characters. The inactive state behaves like a 

regular keyboard and uses a limited set of characters. 

9. Click Save and Close to close the form editor. 

10. Publish your customization. 

 To publish customizations for just one entity, under Components, click Entities. 

Then, on the Actions toolbar, click Publish. 

 To publish all customizations you have made to any entities or components, on the 

Actions toolbar, click Publish All Customizations . 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution publish when it’s least disruptive 

to users. 

See Also 

TechNet: Types of fields 

TechNet: Create and edit business rules 

Note  

https://technet.microsoft.com/library/73d691c7-344e-4c96-8979-c661c290bf81.aspx
https://technet.microsoft.com/library/73d691c7-344e-4c96-8979-c661c290bf81.aspx
https://technet.microsoft.com/library/dn531187.aspx#BKMK_TypesOfFields
https://technet.microsoft.com/library/dn531086.aspx
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TechNet: Create and edit fields 

Map entity fields 

Mapping streamlines data entry when you create new records that are associated with another 

record. When two entities have an entity relationship, you can create new related entity records 

from the associated view that is visible on the primary entity. When the user creates a new record 

from an associated view, mapped data from the primary entity record is copied to the form for the 

new related entity record. You control what data is copied by adding new mappings in the 

relationship between the two entities. If a record is created any way other than from the 

associated view of the primary entity, data is not mapped. 

Mapping only applies just before a new record is created from an associated view. Users are able 

to make changes before saving the record. Later changes to the data in the primary record are 

not applied to the related record. 

Mapping picklists 

If the field is an option set (picklist), make sure the option values are identical between the two 

option sets. When values are added to an option set, the values are assigned an integer based 

on the order in which they were added. If they were not added in the same order, you can edit the 

labels for the option values on the target field so they represent a valid mapping, as long as this 

does not affect existing data. If you later modify either option set, you need to also remember to 

modify the other option set to keep them synchronized. Any invalid option set mappings will 

cause the target field to use the default option set value. 

 

Generate mappings automatically 

You can automatically create mappings for the relationship but this usually is not recommended. 

This process maps any mappable fields based only on the data type and name of the field. All 

existing mappings are removed. 

 

See Also 

TechNet: Create and edit entity relationships 

Configure date fields to store fixed dates across time zones 

You can use the Behavior property of a date and time field to specify a date with a time value, a 

date without a time value (useful for birthdays and anniversaries, for example), or date and time 

values independent of the user's local time zone (useful for hotel check-ins in a different time 

zone, for example). For more information, see TechNet: Behavior and format of date and time 

fields 

See Also 

TechNet: Behavior and format of date and time fields 

https://technet.microsoft.com/library/dn531187.aspx
https://technet.microsoft.com/library/dn531171.aspx
https://technet.microsoft.com/library/73d691c7-344e-4c96-8979-c661c290bf81.aspx
https://technet.microsoft.com/library/73d691c7-344e-4c96-8979-c661c290bf81.aspx
https://technet.microsoft.com/library/73d691c7-344e-4c96-8979-c661c290bf81.aspx
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Create or edit N-N relationships between entities 

Entity relationships define how records can be related to each other in a database. A N:N (Many-

to-Many) relationship depends on a special Relationship entity, sometimes called an intersect 

entity, so that many records of one entity can be related to many records of another entity.When 

viewing records of either entity in a N:N relationship you can see a list of any records of the other 

entity that are related to it. 

More information: TechNet: Create and edit N:N (Many-to-Many) relationships    

See Also 

Map entity fields 

Create or edit N-1 relationships between entities 

Entity relationships define how records can be related to each other in a database. N:1 (Many-to-

one) relationships exist between entities and refer to each entity as either a Primary Entity or 

Related Entity. The related entity, sometimes called the child entity, has a lookup field that 

allows storing a reference to a record from the primary entity, sometimes called the parent entity. 

An N:1 relationship is just a 1:N relationship viewed from the related entity. 

More information: Create and edit entity relationships   

Create or edit 1-N relationships between entities 

Entity relationships define how records can be related to each other in a database. A 1:N (One-to-

Many) relationship is when one entity record for the Primary Entity can be associated to many 

other Related Entity records because of a lookup field on the related entity. When viewing a 

primary entity record you can see a list of the related entity records that are associated with it. 

More information: Create and edit 1:N relationships   

Create connections to view relationships between records 

In Microsoft Dynamics CRM, you can create and view the relationships between records for many 

entities using Connect. Connections enable you to easily associate users, contacts, quotes, 

sales orders, and many other entity records with each other. When you open a record and select 

Connections, you can view all of the connections between it and other records. 

When you create a connection, you assign it a role. There are many different roles you can use to 

identify your connections, such as Account Manager or Colleague. Connection roles define how 

records are related to you, to your organization, or to one another, such as manager to employee. 

There are three types of connection roles: business, family, and social. Your system administrator 

can add new connection roles. 

 

On this page: 

Create a connection 

View connections for a record 

Deactivate or delete a connection 

Create a connection 

https://technet.microsoft.com/library/dn531171.aspx#BKMK_CreateEditNNRelationships
https://technet.microsoft.com/library/dn531171.aspx
https://technet.microsoft.com/library/dn531171.aspx#BKMK_CreateEditN1Relationships
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1. Open a record, and then on the command bar, click Connect > To Another. 

The record you start with is known as the source record. 

2. In the New Connection dialog box, enter a Name and As this role to identify the 

connection role for the record you want to connect to, called the target record. Optionally, 

enter a description. 

The role of the target record can be the same as the source record, it can be different, or 

you can leave the target record role blank. 

3. If needed, you can select a different owner for the connection. Select Details, and then 

fill in the fields. 

4. Click Save, Save and Close, or Save & New to save the newly created connection and 

open the form to create another connection. 

 

View connections for a record 

1. Open the record that you want to view connections for. 

2. To view all the connections, select the related records drop-down menu next to the 

record name, and then click Connections. 

 

 
 

 

Deactivate or delete a connection 
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If you no longer need a connection for a record, you can deactivate it or delete it to permanently 

remove the connection. 

1. Open the record that you want to deactivate or delete the connection from. 

2. Select the related records drop-down menu next to the record name, and then click 

Connections. 

3. Select the connection you want to deactivate or delete, and then click Deactivate or 

Delete. 

See Also 

Set up a relationship role to define family, social, or business relationships 

Set up a relationship role to define family, social, or business relationships 

Identifying informal kinds of relationships between records that include family, social, or business 

contacts can be useful. For example, it may be helpful to know if two contacts are married, or if a 

contact used to work for another account. These types of relationships were known as customer 

relationship entities and are now called connections. To create these types of relationships, see 

Create connections to view relationships between records. 

See Also 

Create connections to view relationships between records 

Change custom entity icons 

When you create a custom entity, it is automatically assigned a default icon, and all custom 

entities by default use the same icon. If your organization has several custom entities, it can be 

helpful to change the icon associated with one or more custom entities to help users differentiate 

them.  

You can’t modify the icons assigned to system entities. 

You can upload two types of entity icons for each custom entity: 

 Icon in web application. This icon should be: 

 16 x 16 pixels in size. 

 In .gif, .png, or .jpg format. 

 No larger than 10 kilobytes. 

 

 Icon for entity forms. This icon should be: 

 32 x 32 pixels in size. 

 16 colors. 

 In .ico format. 

 No larger than 10 kilobytes. 

 

Note  
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Before you begin this task, be sure that you have uploaded as web resources any custom 

icons that you intend to assign. More information:  Add or edit a form web resource 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. Expand Entities if necessary, select the custom entity you want to update the icon for, 

and then on the command bar, click Update Icons. 

5. In the Select New Icons dialog box, under Icon in Web application or Icon for Entity 

Forms, to the right of New Icon, click the Browse button , select the appropriate image 

file, and then click OK. 

6. On the command bar, on the File menu, click Save.  

7. When your customizations are complete, publish them: 

 To publish customizations for only the component that you are currently editing, in 

the Navigation Pane, select the entity you have been working on, and then click 

Publish. 

 To publish customizations for all unpublished components at one time, in the 

Navigation Pane, click Entities, and then on the command bar, click Publish All 

Customizations. 

 

New icons might not display in Microsoft Dynamics CRM until you close and reopen the 

Microsoft Dynamics CRM client. 

Publishing customizations can interfere with normal system operation. We recommend 

you schedule publishing when it’s least disruptive to users. 

See Also 

TechNet: Create and edit entities 

Important  

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531052.aspx
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Enable an entity to display data as a hierarchy 

You can gain valuable insights by visualizing your data as a hierarchy. For example, the following 

screenshot shows accounts displayed in Microsoft Dynamics CRM as a hierarchical visualization: 

 
 

 

 

For some entities (record types), such as account and user, hierarchies are enabled by default. 

Other entities, including case, contact, opportunity, order, quote, campaign, and team can be 

enabled for a hierarchy, and all custom entities can be enabled for a hierarchy. For more 

information, see TechNet: Query and visualize hierarchical data. 

Create or customize forms 

 

Change the color scheme or add a logo to match your organization's brand 

Create and configure forms- default solution 

Create or edit the main form for an entity 

Add a field to a form 

Edit form field properties 

Create or edit a drop-down list (option set) for a form 

Add or edit form navigation for related entities 

Add or edit a form web resource 

Create a team template and add to an entity form 

Test an event script 

Change the color scheme or add a logo to match your organization's brand 

horizontaltabbed 

Overview 

https://technet.microsoft.com/library/dn832068.aspx
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Personalize your Microsoft Dynamics CRM applications and create a uniform look and feel that 

matches your organization’s brand by creating a custom theme. For example, without writing any 

code, you can add a company logo or change default colors for the CRM masthead, menus, 

entities, or links. Preview your custom theme, and then publish it for the whole team when you’re 

ready.  

 

 
 

 

 

For in-depth information on creating custom themes, see TechNet: Change the color scheme or 

add a logo to match your organization’s brand 

Watch this video 

 

Want to see themes in action? Watch this short video (2:45). 

<iframe width="500" height="364" src="https://www.youtube.com/embed/MdT1yE9CW5U" 

frameborder="0" allowfullscreen></iframe> 

To see video captions, choose the Closed Caption (CC) button  in the lower-right corner of 

the YouTube window. 

 

Video transcript 

Have you ever wanted to add your logo or change the colors of the CRM interface to better fit 

your brand? Many companies use Microsoft Dynamics CRM in conjunction with other systems 

and want a uniform look and feel across all other business applications. Using the new theming 

https://technet.microsoft.com/library/21a166a0-d25e-4260-a1e4-2ddc528787c2
https://technet.microsoft.com/library/21a166a0-d25e-4260-a1e4-2ddc528787c2
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feature, you can now style CRM for a more customized user interface that better suits your 

branding goals.  

To get started with theming, navigate to the Customization area under Settings. You’ll find 

Themes as an option there.  

You’ll see that the default color is the CRM blue theme.  

To start setting up a customized theme, you can clone an existing theme or create one from 

scratch.  

From the Theming record you can upload logos and set colors for many different areas.  

We primarily allow customizations for accent colors in CRM. Some examples of accent colors are 

links, hover effects, and selected effects. Other items such as backgrounds, fonts, and icons can’t 

be changed at this time.  

Also note that legacy areas in the CRM application do not fully support theming.  

A logo can also be set from the Theming record by selecting an existing web resource or 

uploading a logo from your local computer.  

As you work on your custom theme, you may also want to take a look at the work in progress. To 

do that without affecting users, choose Preview Theme. This will refresh the page and reload 

your CRM system with the current theme and it will only apply to you. While previewing, you may 

realize some additional work needs to be done. If so, choose Exit Preview to revert to the 

original theme. Otherwise, we can publish the theme and push it out to all users.  

Themes aren’t solution aware, so to move themes across systems, a theme record needs to be 

exported, re-imported into the target system, and then published.  

In addition to theming, customizers can now adjust entity colors. To do that, navigate to the 

Customize the System dialog box. From there, you'll see a new field per entity, allowing you to 

set the color. This entity color will be applied to areas such as the navigation bar.  

We hope you like the new theming feature and look forward to seeing some creative and colorful 

CRM instances! 

See Also 

TechNet: Change the color scheme or add a logo to match your organization’s brand 

What’s new in Microsoft Dynamics CRM 

What’s new for administrators and customizers in Microsoft Dynamics CRM 

Create and configure forms- default solution 

In the default solution or an unmanaged solution you can create new forms or edit existing forms 

for all entities that allow form customization.  

In an unmanaged solution, you can edit the managed properties for an unmanaged custom entity 

that was created for the solution. 

If you’re viewing a managed solution, you can’t create new forms or edit existing forms for 

entities. However, if the managed properties for an entity in the managed solution are set to allow 

customization, you can add or edit forms to that entity in the Customization area of Microsoft 

Dynamics CRM. 

https://technet.microsoft.com/library/21a166a0-d25e-4260-a1e4-2ddc528787c2
what-s-new.aspx
https://technet.microsoft.com/library/dn531078.aspx
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Customization tasks can be performed only while you’re online.  

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile.. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Choose Customize the System. 

4. Under Components, choose Entities, and then expand the required entity. 

5. Choose Forms, and then select the form.  

6. On the command bar, choose Managed Properties. 

7. In the Set Managed Properties dialog box, if Customizable is set to True, you can add 

or edit forms. 

Tip  

You can also navigate to the form editor from a list in the Sales, Marketing, or 

Service areas. For example, to edit an account form, go to Accounts, choose 

the More (…) button, and then choose Customize Entity.  

See Also 

Create or edit the main form for an entity 

Assign security roles to a form 

TechNet: Create and design forms 

Create or edit the main form for an entity 

When you create a new form for an entity, its form type is Main. When the new form opens, it is 

identical to the form named Information. You can add or edit fields, sections, tabs, navigation, and 

properties associated with the form, and then save the form. 

This procedure applies to any form with a form type  of Main. Each main form is composed of one 

or more tabs. Each tab can have one or more sections. Each section contains one or more fields 

or IFRAMES. 

If you want to base your new form on an existing one, you can clone a form.  

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531143.aspx
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1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

 

3. Choose Customize the System. 

4. Under Components, expand Entities, expand the entity you want to modify the Main 

form for, and then click Forms. 

5. To create a new form, on the command bar, click New. 

- OR - 

To edit an existing form, double-click or tap any form with a form type of Main. 

6. Change the form design in any of the following ways, as needed: 

 Add a tab to a form 

 Add a section to a form 

 Add a field to a form 

 Add or edit a form IFRAME 

 Add or edit a sub-grid on a form 

 Add or edit a form web resource 

 Add or edit form navigation for related entities 

 Edit form headers and footers 

 Remove a tab section field or IFRAME 

 Enable or disable the Form Assistant 

For more information, see TechNet: Customize your CRM system. 

7. Edit the properties for parts of the form, as needed: 

 Edit form properties 

 Edit form field properties 

 Edit tab properties 

 Edit section properties 

For more information, see the TechNet: Customize your CRM system. 

8. Add event scripts, as needed.  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/dn531158.aspx
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9. Determine which security roles will be able to see the form. More information: Assign 

security roles to a form 

10. Preview how the main form appears and how events function: 

a. On the Home tab, click Preview, and then select Create Form, Update Form, or 

Read-Only Form. 

b. To close the Preview form, on the File menu, click Close. 

 

11. When you finish editing the form, click Save As, enter a name for the form, and then click 

OK. 

12. When your customizations are complete, publish them: 

 To publish customizations for only the component you are currently editing, under 

Components, click the entity you have been working on, and then click Publish. 

 To publish customizations for all unpublished components at one time, under 

Components, click Entities, and then on the command bar, click Publish All 

Customizations. 

 You cannot apply a requirement level to a field using this form. Requirement level constraints 

are applied to the attribute. 

 Before deleting a field from a form, make sure the field is not required by other components 

or custom scripts. For example, the Opportunity form requires the Price List field to determine 

the pricing to use when adding a product to that opportunity. Removing the Price List field 

would prevent adding a new product to an opportunity. 

 Any time you change user interface elements or implement form scripts for an entity, you 

must publish changes to apply them. Any customizations that change the data schema of 

Microsoft Dynamics CRM, such as custom entities, relationships, or fields, are applied 

immediately. 

 You cannot use the form editor to modify the visual style of forms, such as the font style, font 

size, or colors used in the form. Modification of the Cascading Style Sheets (CSS) pages in 

the web application or style properties of the form through scripts is not supported. 

 Installing a solution or publishing customizations can interfere with normal system operation. 

We recommend that you schedule a solution import when it’s least disruptive to users. 

See Also 

Create or edit entity fields 

TechNet: Customize your CRM system 

TechNet: Create and design forms 

Add a field to a form 

If a Microsoft Dynamics CRM form doesn’t meet your organization’s business requirements, you 

can customize the form by changing existing fields or by adding new fields. While it might be 

simpler to edit the existing fields on a form, sometimes it’s better to add a field to address a 

specific business scenario. 

Note  

https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/dn531143.aspx
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1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. Under Components, expand Entities, expand the entity you want to customize, and 

then click Forms. 

5. In the list, find an entry with the form type of Main, and then double-click or tap to edit it. 

6. In the form, click the section you want to add a field to, and then in the Field Explorer 

pane, double-click the field you want added to the form. 

7. To preview how the form appears and how events function: 

a. On the Home tab, click Preview, and then select Create Form, Update Form, or 

Read-Only Form. 

b. To close the preview form, click Close  . 

 

c. To publish customizations for the form that you’re editing, with the form open, click 

Publish. 

8. When you’re done editing the form, click Save and Close. 

9. To publish customizations for all unpublished components at one time, click File, and 

then click Publish All Customizations. 

Publishing customizations can interfere with normal system operation. We recommend 

that you publish when it’s least disruptive to users. 

See Also 

Edit form field properties 

TechNet: Create and design forms 

Edit form field properties 

 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531143.aspx
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1. Go to Settings > Customizations. (How do I get there?) 

 

2. Choose Customize the System. 

3. Under Components, expand Entities, expand the entity you want to work with, and then 

choose Forms. 

4. In the list, locate an entry with the Form Type of Main, and then double-click or tap to 

edit it. 

5. On the form body, double-click or tap the field you want to edit. 

6. In the Field Properties dialog box, you can access and edit a variety of the properties 

associated with the field by using a series of tabs: 

 Display. Use this tab to perform the following tasks: 

 Change or hide the label used for this field in this form. The field display name 

remains unchanged. 

 Specify whether the field is read-only by selecting or clearing the Field is read-

only check box. 

 In the Locking section, specify whether to lock the field to the form and prevent 

anyone from removing it by selecting or clearing the Lock the field on the form 

check box. 

 Specify whether a field is visible in the default view by selecting or clearing the 

Visible by default check box. If the check box is cleared, the field will not display 

in the Reading Pane in Microsoft Dynamics CRM for Microsoft Office Outlook. 

However, the field will display in the Microsoft Dynamics CRM web application 

unless you use JavaScript to define other behavior. In the web application, 

JavaScript overrides the value set by this check box. 

 

For lookup fields, this tab displays extra properties: 

 

 In the Related Records Filtering section, to filter the list of displayed 

records in the lookup, select the Only show records where check box. 

 

The relationship combinations that are possible when you filter related records 

are listed in the following table. 

 

First list relationship Second list relationship Available?  

N:1 1:N Yes 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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N:1 N:1 Yes 

N:1 N:N Yes 

1:N 1:N Yes 

1:N N:1 No 

1:N N:N No 

N:N 1:N Yes 

N:N N:1 No 

N:N N:N No 
 

 

The first list is populated with all the potential relationships you can use to filter 

this lookup. Click one. 

 

The second list is then populated with all relationships that connect the related 

entity (selected in first list) to the target entity. Click one. 

 

Select the Allow users to turn off filter check box to give users the option of 

turning off the filter you define here. This makes it possible for them to view a 

wider range of records. If you want to make sure that users only see the limited 

range of records defined by this filter, clear this check box. 

 

 Also, for lookup fields, the tab displays the Additional Properties section. 

Here, select the Display Search box in lookup dialog check box if you 

want a search box to be available in the lookup. 

 

In the Default View list, click the default view for which results will be displayed 

in the lookup. 

 

If you want users to also have the option of selecting other views, select the 

Enable the View selection in lookup dialog check box. 
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 Formatting. The formatting options displayed vary based on the which options are 

set for the section of the form that the field appears within. 

 Details. This tab provides access to the basic properties associated with the field. 

Choose Edit to modify them. 

 Events. This tab includes two sections:  

 Form Libraries. In this section, you can add or remove the available JavaScript 

libraries for form or field events. You can edit the listed custom libraries if 

necessary. 

 Event Handlers. In this section, you can add a JavaScript library (a script web 

resource) authored by a developer and associate a function within that library to 

an event. 

i. In the Events list, choose onChange, and then choose Add. 

ii. In the Handler Properties dialog box, supply the requested information. Select 

the Enabled check box to make the function available to be called by a field 

event. 

iii. Choose OK. 

 Business Rules. Use this tab to create or edit the process components of business 

rules. 

 

7. When you finish modifying the properties for the field, in the Field Properties dialog box, 

choose OK. 

8. To preview how the form appears and how events function: 

a. On the Home tab, choose Preview, and then select Create Form, Update Form, or 

Read-Only Form. 

b. To close the Preview form, on the File menu, choose Close. 

 

9. When you finish editing the form, on the Home tab, choose Save and Close to close the 

form. 

10. When your customizations are complete, publish them: 

 To publish customizations for only the component that you are currently editing, on 

the nav bar or in the Navigation Pane, choose the entity you have been working on, 

and then choose Publish. 

 To publish customizations for all unpublished components at one time, in the 

Navigation Pane, choose Entities, and then on the Actions toolbar, choose Publish 

All Customizations. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

See Also 

Note  
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Add a field to a form 

TechNet: Create and design forms 

Create or edit a drop-down list (option set) for a form 

An option set is a type of field, included in a record type (entity), that defines a set of options. 

When an option set is displayed in a form, it uses a drop-down list control. When displayed in 

Advanced Find, it uses a picklist control. Sometimes option sets are called picklists by 

developers. For information on creating and editing option sets, see TechNet: Create and edit 

global option sets. 

 

 

Add or edit form navigation for related entities 

In the form Navigation Pane, you can add links to related entities. When a user clicks one of 

these links in a record, the associated view for the entity is displayed. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Choose Customize the System. 

4. Under Components, expand Entities, expand the entity you want to work with, and then 

choose Forms. 

5. In the list, locate an entry with the form type of Main, and then double-click or tap to edit 

it. 

6. To add a link to a related entity, on Home tab, in the Select group, choose Navigation. 

The Relationship Explorer pane displays on the right side of the form editor. 

7. In the Relationship Explorer pane, in the Filter list, select one of the following options: 

 Available Relationships. Lists all the entities that can be related to the entity the 

form is associated with. 

 1:N Relationships. Lists entities that can be related in a 1:N relationship to the entity 

the form is associated with. 

 

https://technet.microsoft.com/library/dn531143.aspx
https://technet.microsoft.com/library/dn531201.aspx
https://technet.microsoft.com/library/dn531201.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 N:N Relationships. Lists entities that can be related in a N:N relationship to the 

entity the form is associated with. 

 

Note  

If no related entities show up in the Relationship Explorer pane, you cannot 

create a link on this form to a related entity. 

8. Select the related entity you want to link to, drag it to the Navigation Pane, and then drop 

it where you want it to be displayed. 

Tip  

You can also create a new relationship by choosing New 1:N or New N:N in the 

Relationship Explorer pane. For more information, see TechNet: Create and 

edit entity relationships 

9. To edit the properties for this or any other related entity link, in the Navigation Pane, 

select the link, and then on the Home tab, choose Change Properties. 

10. In the Relationship Properties dialog box, on the Display tab, type a new display label. 

11. On the Name tab, choose Edit to view or edit the details associated with the relationship 

record. 

12. Choose OK. 

13. Preview how the main form will appear and how events will function: 

a. On the Home tab, choose Preview, and then select Create Form, Update Form, or 

Read-Only Form. 

b. To close the Preview form, on the File menu, choose Close. 

 

14. When you finish editing the form, choose Save and Close to close the form. 

15. When your customizations are complete, publish them: 

 To publish customizations for only the component that you are currently editing, in 

the Navigation Pane, choose the entity you have been working on, and then choose 

Publish. 

 To publish customizations for all unpublished components at one time, in the 

Navigation Pane, choose Entities, and then on the command bar, choose Publish 

All Customizations. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

See Also 

TechNet: Create and edit entity relationships 

Note  

https://technet.microsoft.com/library/dn531171.aspx
https://technet.microsoft.com/library/dn531171.aspx
https://technet.microsoft.com/library/dn531171.aspx
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Add or edit a form web resource 

You can add or edit web resources on a form to make it more appealing or useful to users. The 

types of web resources that you can add or edit on a form are images, HTML files, or Silverlight 

controls. 

You can’t include a web resource in a form header or footer. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. Under Components, expand Entities, and then expand the entity you want to work with. 

5. Click Forms, in the list locate a form of type Main, and then double-click or tap the entry 

to open and edit the form. 

6. To add an existing web resource, click the tab (for example, General or Notes) you 

would like to insert it on, and then on the Insert tab, click Web Resource. 

- OR - 

To edit a Web resource, select a form tab and the web resource that you want to edit, 

and then on the Home tab, click Change Properties. 

7. In the Add Web Resource or Web Resource Properties dialog box, on the General 

tab, enter the appropriate information in the required fields.  

In particular, note the following: 

a. In the Web resource box, select the image, HTML, or Silverlight web resource that 

you want to use. 

 

Note  

After you specify a web resource, the Web Resource Properties section 

appears at the bottom of this tab, providing options that vary based on the 

type of web resource you are adding. These options include specifying 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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custom parameters, passing a record object-type code as a parameter, or 

specifying alternative text that describes the resource or, for images, that 

makes the image more accessible to all users. 

b. In the Name box, enter a unique name for the field. The name can contain only 

alphanumeric characters and underscores. 

c. The Label field is automatically populated with a variation of the name you specify, 

but ensure that the proposed label meets your needs or update it accordingly. 

 

8. On the Formatting tab, the options that display vary based on the type of web resource 

inserted. These options include specifying the number of columns and rows display, 

whether a border displays, and the scrolling behavior. 

9. If the Dependencies tab displays in the Add Web Resource or Web Resource Properties 

dialog box, from the Available fields list, select the fields that are required by the Web 

resource, click the Add Selected Records button  to move the selected fields to the 

Dependent fields list, and then click OK to close the dialog box. 

10. When you finish editing the form, on the Home tab, click Save and Close to close the 

form. 

11. To preview how the main form will appear and how events will function: 

a. On the Home tab, click Preview, and then select Create Form, Update Form, or 

Read-Only Form. 

b. To close the Preview form, on the File menu, click Close. 

 

12. When your customizations are complete, publish them: 

 To publish customizations for only the component that you are currently editing, in 

the Navigation Pane, select the entity you have been working on, and then click 

Publish. 

 To publish customizations for all unpublished components at one time, in the 

Navigation Pane, click Entities, and then on the Actions toolbar, click Publish All 

Customizations. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

See Also 

TechNet: Create and edit web resources 

Create a team template and add to an entity form 

A team template can be used for the entities that are enabled for automatically created access 

teams. In the team template, you have to specify the entity type and the access rights on the 

entity record. For example, you can create a team template for an account entity and specify the 

Read, Write, and Share access rights on the account record that the team members are granted 

Note  

https://technet.microsoft.com/library/dn660983.aspx
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when the team is automatically created. After you create a team template, you have to customize 

the entity main form to include the new team template. After you publish customizations, the 

access team template is added in all record forms for the specified entity in a form of a list. For 

example, you created a team template called “Sales team” for the account entity. On all account 

record forms you’ll see the list called “Sales team”. You can add or remove team members using 

this list. 

On this page: 

Enable an entity for access teams 

Create a team template 

Add a team template to the entity form 

Enable an entity for access teams 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. In the Customization window, choose Customize the System. 

4. In the navigation pane, expand Entities, and then choose the entity you want to use in 

the team template.  

5. On the Entity Definition form, in the Communication & Collaboration section, select 

the Access Teams checkbox. 

6. On the Actions toolbar, choose Save. 

Create a team template 

1. Go to Settings > Security. (How do I get there?) 

2. Choose Access Team Templates 

3. On the Actions toolbar, choose New, complete the required fields, and then choose 

Save. 

Add a team template to the entity form 

 

 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. In the Customization window, choose Customize the System. 

4. In the navigation pane, expand Entities, expand the entity you want to use in the team 

template, and then choose Forms. 

5. In System Forms, select Active Forms > Main form. 

6. On the Main form, open the Insert tab. 

7. On the ribbon, choose Sub-Grid. 

The Set Properties dialog box appears. 

8. In Set Properties, complete the required fields, and then select the Display label on the 

Form check box. 

9. In the Records drop-down list, select All Record Types.  

10. In the Entity drop-down list, select Users. 

11. In the Default View drop-down list, select Associated Record Team Members. 

12. In the Team Template drop-down list, select the desired template and choose Set.  

The team template you selected now appears on the Main form. 

13. On the Actions toolbar, click or tap Save, and then choose Publish. 

See Also 

TechNet: Manage teams 

About team templates 

Print leads, quotes, and other records 

Test an event script 

Before you publish any customizations, you should thoroughly test your scripts. You can perform 

customization tasks only while you’re online. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531089.aspx
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a. Follow the steps in View your user profile.. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Choose Customize the System. 

4. Choose Components > Entities, and then expand the entity you want. 

5. Choose Forms. In the list, choose a form to edit if it has a form type of Main. 

6. On the Home tab, choose Preview, and then select Create Form, Update Form, or 

Read-Only Form. 

a. If you have added an OnLoad event for the form, open the form in each mode, and 

verify that your event executed as expected. 

b. If your code depends on data existing in the form when it loads, test your script in an 

OnChange or OnSave event to enter sample data into the form. The Update Form 

will open with no data. 

i. If you have added an OnChange event for a field, for create and update modes, 

enter the data in the field and verify that your event executed as expected. 

ii. If you have added an OnSave event for a field, for create and update modes, 

choose Simulate Form Save and verify that your event executed as expected. 

7. Choose File > Close. 

 

Create or customize views 

 

Create or edit views 

Create or edit a public view for an entity 

Edit the quick find view 

Set the default view for an entity 

Create or edit views 

In the default solution or an unmanaged solution, you can create new public views or edit existing 

views of all types for entities that allow view customization.  

In a managed solution, you can’t create new views or edit existing views for entities. However, if 

the managed properties for an entity in the managed solution are set to allow customization, you 

can create new public views or edit existing views of all types in the Customization area of 

Microsoft Dynamics CRM. 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile.. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. Click Customize the System. 

4. Under Components, expand Entities, and then expand the entity you want. 

5. Click Views, and then select the view. 

6. On the Actions toolbar, click More Actions, and then select Managed Properties. 

7. You can edit the view if the entity is unmanaged. In the Set Managed Properties dialog 

box, set Customizable to allow editing or creating views. 

8. Click Set. 

See Also 

Create or edit a public view for an entity 

Edit the quick find view 

Understand security roles 

TechNet: Create and edit views 

Create or edit a public view for an entity 

If you edit a public view, the changes are visible to everyone who has permission to view records 

for the entity. Besides public views, the following views are provided for all entities and can’t be 

deleted or shared: Quick Find Views, Advanced Find Views, associated views, and lookup views. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn509578.aspx
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b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. Under Components, expand Entities, and then expand the entity you want. 

5. Click Views. 

6. To create a new public view, on the Actions toolbar, click New. On the View Properties 

dialog box, in the Name box, type a name for the new view, and then click OK. 

If the New button does not appear, you can’t add views for the entity you selected. 

-  OR - 

To edit a view, double-click a Public View in the list. The view type is specified in the 

Type column. 

7. Modify the columns that are displayed. 

 Add a column: 

a. In the Common Tasks area, for Quick Find Views, click Add View Columns, or for 

other types of views, click Add Columns. 

- OR -  

For other types of views, click Add Columns. 

b. Select the check boxes for the columns you want to add, and then click OK. 

 Move a column: 

a. Select the column you want to move. 

b. In the Common Tasks area, use the arrows to move the column left or right. 

 Change the width of a column: 

a. Select the column you want to change. 

b. In the Common Tasks area, click Change Properties. 

c. In the  Change Column Properties dialog box,  click an option to set the column 

width, and then click  OK. 

 Remove a column: 

a. Select the column you want to remove. 

b. In the Common Tasks area, click   Remove. 

c. In the confirmation message, click  OK. 

 Change the sort order of a column: 

a. In the Common Tasks area, click Configure Sorting. 

b. In the  Configure Sort Order  dialog box, in the  Column  list, select the column you 

want to sort, then click   Ascending Order or  Descending Order, and then click   

OK. 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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 Enable online presence for instant messaging: 

a. In the View form for the selected entity, select the column you want to change. 

b. In the Common Tasks area, click  Change Properties. 

c. In the Change Column Properties dialog box, select the  Enable presence for this 

column, and then click  OK. 

 

8. Click  Save and Close. 

9. Set any public view as the default view for an entity. 

Note  

Every entity in Microsoft Dynamics CRM must have a default public view. This is 

the view that is displayed for a list of entities, such as Appointment, Account, or 

Contact. For example, if your organization is set up so that users manage their 

own appointments, you can change the default view for Appointments from All 

Appointments to My Appointments. 

a. In the list of views, select the public view that you want to set as the default. The view 

type is indicated in the Type column. 

b. On the Actions toolbar, click  More Actions, and then click  Set Default. 

 

10. Click  Save and Close to close the view. 

11. Publish view customization. 

Important  

Any time you change user interface elements or implement form scripts for an 

entity, you must publish changes to apply them. Any customizations that change 

the data schema of Microsoft Dynamics CRM such as custom entities, 

relationships, or fields are applied immediately.  

Installing a solution or publishing customizations can interfere with normal 

system operation. We recommend that you schedule a solution import when it’s 

least disruptive to users. 

 To publish view customizations for just one entity, under Components, click  

Entities, and select the entity. Then, on the Actions toolbar, click the Publish button. 

 To publish all customizations you have made to any entities or components, on the 

Actions toolbar, click  Publish All Customizations. 

 

Tip  

To create views that appear in the Service calendar, create views in the 

Service Activity, Appointment, User, or Facility/Equipment entities. To 

see views created in these entities from the Service calendar, users select 

the view type from the Type list. 

See Also 
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Create and configure views 

TechNet: Create and edit views 

Edit the quick find view 

You can edit an entity’s Quick Find view (the view used to display results of searches performed 

using the Search box), for example to change the fields that are searched and which columns 

display, or to specify the width and sort order of the columns displayed. 

Changes to the Quick Find view associated with an entity set the default view for 

everyone who uses the search box for that entity. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. Under Components, expand Entities, expand the entity you want to modify, and then 

click Views. 

5. In the list of views, in the Type column, locate Quick Find View, and then double-click 

the view. 

6. Modify the fields that are searched: 

a. In the Common Tasks pane, click Add Find Columns. 

b. Select the check boxes for the columns you want to add, and then click OK. 

 

7. Change the columns that are displayed. 

 To add a column: 

i. In the Common Tasks area, for Quick Find Views, click Add View Columns. 

 

- OR - 

Important  

 

https://technet.microsoft.com/library/dn509578.aspx
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ii. Select the check boxes for the columns you want to add, and then click OK. 

 

 To move a column: 

i. Click the column that you want to move. 

ii. In the Common Tasks area, use the arrows to move the column left or right. 

 

 To change the width of a column: 

i. Click the column that you want to change the width for. 

ii. In the Common Tasks area, click Change Properties. 

iii. In the Change Column Properties dialog box, click an option to set the column 

width, and then click OK. 

 

 To remove a column: 

i. Click the column that you want to remove. 

ii. In the Common Tasks area, click Remove. 

iii. In the confirmation message, click OK. 

 

 To change the sort order of a column: 

i. In the Common Tasks area, click Configure Sorting. 

ii. In the Configure Sort Order dialog box, in the Column list, select the column 

you want to sort, click Ascending Order or Descending Order, and then click 

OK. 

 

 To enable online presence for instant messaging: 

i. In the View form for the selected entity, click the column you want to change. 

Only some columns have presence such as Primary Contact or Potential 

Customer. 

ii. In the Common Tasks area, click Change Properties. 

iii. In the Change Column Properties dialog box, select the Enable Presence for 

this column, and then click OK. 

 

8. Click Save or Save and Close. 

9. On the command bar, click Publish. 

When the customizations are published, a confirmation message appears. 
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A customized business entity might have different properties than those described in 

Help; Help does not contain content that is specific to the custom entities your 

organization creates. However, Help does describe how to create and use custom 

entities. 

Publishing customizations can interfere with normal system operation. We recommend 

publishing when it’s least disruptive to users. 

See Also 

TechNet: Create and edit views 

TechNet: Configure Quick Find options for the organization 

Set the default view for an entity 

In Microsoft Dynamics CRM, every entity, such as Appointment, Account, or Contact, requires 

a default public view. However, you can change the default view for an entity to accommodate the 

specific needs of your business. For example, if your organization is set up so that users manage 

their own appointments, you can change the default view for the Appointment entity from All 

Appointments to My Appointments. 

You can make any public view the default public view for an entity. 

The default view for some entities isn’t configurable. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.   

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Choose Customize the System. 

4. Under Components, expand Entities, and then expand the entity you want to work with. 

5. Choose Views, and then in the list, select the Public View you want to set as the default 

for that view. 

6. On the command bar, choose More Actions, and then choose Set Default. 

Note  

Important  

 

https://technet.microsoft.com/library/dn509578.aspx
https://technet.microsoft.com/library/dn919650.aspx
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7. When your customizations are complete, publish them: 

 To publish customizations for only the component that you’re currently editing, under 

Components, choose the entity you have been working on, and then choose 

Publish. 

 To publish customizations for all unpublished components at one time, under 

Components, choose Entities, and then on the command bar, choose Publish All 

Customizations. 

Publishing customizations can interfere with normal system operations. We recommend 

you publish customizations when it’s least disruptive to your users. 

See Also 

Create and configure views 

TechNet: Create and edit views 

Export and import entity and field text for translation 

 

Export customized entity and field text for translation 

Import translated entity and field text 

Export customized entity and field text for translation 

After you create customized entity and field text, you may want to translate it into other 

languages. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile.. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. Choose Customize the System. 

4. On the Actions toolbar, click or tap Export Translations. 

 

5. After completing the export, open or save the compressed (.zip) file that contains the 

exported labels to your local computer or network. 

Note  

 

https://technet.microsoft.com/library/dn509578.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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6. Extract the XML file from the compressed (.zip) file and translate it. 

See Also 

Import translated entity and field text 

Import translated entity and field text 

If you have customized entity or field text, such as field labels or drop-down list values, you can 

provide the users in your organization who are not working with the base language version of 

your Microsoft Dynamics CRM implementation with this customized text in their own languages. 

To do so, you export the text strings for all your customizations so that they can be translated into 

the languages you use in your organization. 

After the translation, you need to import the translated text strings into your Microsoft Dynamics 

CRM implementation before users can take advantage of the changes. 

 The file that you import must be a compressed file that contains the CrmTranslations.xml and 

the [Content_Types].xml file at the root. 

 Microsoft Dynamics CRM can’t import translated text that is over 500 characters long. If any 

of the items in your translation file are longer than 500 characters, the import process will fail. 

If the import process fails, review the line in the file that caused the failure, reduce the 

number of characters, and try to import again. Also note that after you import translated text, 

you must republish customizations. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. In the solution explorer, on the Actions toolbar, click Import Translations. 

5. In the Import Translated Text dialog box, specify the file that contains the translated 

text, and then click Import. 

6. When Microsoft Dynamics CRM finishes importing the translated text, click Close. 

Important  

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Publishing customizations can interfere with normal system operation. We recommend 

you schedule publishing when it’s least disruptive to users. 

See Also 

Export customized entity and field text for translation 

Create business processes and other processes 

 

Guide staff through common tasks with processes 

Create a new business process 

Preview feature: Create a new task flow 

Activate a business process or task flow 

Assign a security role to a business process 

Add ready-to-use business processes 

Business process templates for CRM 

Import business process templates from Microsoft PinPoint 

Use a dialog to create an interactive process like a wizard 

Create a business rule to apply logic in a form 

Guide staff through common tasks with processes 

To help you automate common business tasks and ensure that people handle customers 

consistently, Microsoft Dynamics CRM includes processes. 

There are four types of processes, each designed for a different purpose: 

 Business process flow. Use when you want staff to move through the same stages and 

follow the same steps to interact with a customer. For example, use a business process flow 

if you want everyone to handle customer service requests the same way, or to require staff to 

gain approval for an invoice before submitting an order. 

Microsoft Dynamics CRM includes several ready-to-use business process flows for common 

sales, service, and marketing tasks that you can use with little or no changes required. Or, 

you can create your own. 

You can also design a type of business process flow called a task flow in CRM for phones or 

CRM for tablets based on common tasks your users perform. For example, if they need to 

regularly perform a series of follow-up steps after client meetings, create a task flow. When 

users tap the new task in their mobile app, it will lead them through from start to finish so they 

don't forget an important step. 

Task flows are a preview feature in Microsoft Dynamics CRM Online 2016 Update. A 

preview feature is a feature that is not complete, but is made available before it’s 

officially in a release so customers can get early access and provide feedback. 

Preview features aren’t meant for production use and may have limited or restricted 

Important  
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functionality.  To use this feature, it must be turned on and the license terms must be 

accepted. Enable or disable Preview features.  Microsoft doesn't provide support for 

this preview feature. Microsoft Dynamics CRM Technical Support won’t be able to 

help you with issues or questions. Preview features aren't meant for production use 

and are subject to a separate supplemental terms of use. 

 

More information:  

 Create a new business process 

 Preview feature: Create a new task flow 

 Activate a business process or task flow 

 Add ready-to-use business processes 

 Import business process templates from Microsoft PinPoint 

 Assign a security role to a business process 

 eBook: Intro to business processes 

 eBook: Customize a business process 

 Dialog. Use when you have a step-by-step script you want staff to read through when talking 

to customers. For example, create a dialog to guide customer service reps through a 

customer call to resolve a case. 

More information:  TechNet: Dialogs 

 Workflow. Use when you want to automate common tasks, such as automatically sending a 

confirmation email to a customer when an order ships. 

More information:  TechNet: Workflow processes 

 Action. Use when you want to automate a series of commands in the system.  

More information:  TechNet: Actions 

See Also 

TechNet: Create and edit processes 

Create a new business process 

You can help ensure that people enter data consistently and follow the same steps every time 

they work with a customer by creating a business process in Microsoft Dynamics CRM. For 

example, you might want to create a business process to have everyone handle customer service 

requests the same way, or to require people to gain approval for an invoice before submitting an 

order. 

CRM comes with several ready-to-use business processes for common business scenarios. All 

you have to do is add them to your system. To find out how to add ready-to-use business 

processes to CRM, see Add ready-to-use business processes. 

 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

 

http://go.microsoft.com/fwlink/p/?LinkId=511446
http://go.microsoft.com/fwlink/p/?LinkID=321480
http://go.microsoft.com/fwlink/p/?LinkID=386368
https://technet.microsoft.com/library/dn531092.aspx
https://technet.microsoft.com/library/dn531067.aspx
https://technet.microsoft.com/library/dn531060.aspx
https://technet.microsoft.com/library/dn531144.aspx
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Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Processes. (How do I get there?) 

3. On the Actions toolbar, click New. 

4. Complete the required fields.  

For the Category, select Business Process Flow from the drop-down list. 

For the Entity, select the type of record from the drop-down list. 

5. Select New blank process. 

6. Choose OK. 

7. Type a description for the process. You can use up to 2000 characters. 

8. If people will progress from one type of record to another in order, click the Plus/Minus 

button , and then select the next type of record in the process. Select more types of 

records to use in the process, if desired. 

9. Type a name for the stage in the process. 

10. If desired, select a category for the stage, either Qualify, Develop, Propose, Close, 

Identify, Research, or Resolve. 

11. Type a name for the first step in the stage. To add more steps, click the Add button , and 

then type a name. 

12. If you want people to enter data to complete a step, select the field from the drop-down 

list. Select Required if people must fill in the field to complete the step and move to the 

next stage of the process. 

13. If desired, click the Add button  to add another stage. Repeat steps 9 through 12 until 

you have added all the stages and steps to the process. 

14. To save the process as a draft, click Save at the top of the screen. (As long as a process 

is a draft, people won’t be able to use it.) To activate it so that people can use it, click 

Activate. 

See Also 

Activate a business process or task flow 

Assign a security role to a business process 

Add ready-to-use business processes 

Customize a business process 

Preview feature: Create a new task flow 

Design a flow in Microsoft Dynamics CRM for phones or Microsoft Dynamics CRM for tablets 

based on common tasks your users perform. For example, if they need to regularly perform a 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkID=386368
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series of follow-up steps after client meetings, create a task flow. When users tap the new task in 

their mobile app, it will lead them through from start to finish so they don't forget an important 

step. 

Task flows can use multi-entity forms and logic, and can have form logic that runs across the task 

flow pages. 

Task flows are a preview feature in Microsoft Dynamics CRM Online 2016 Update.  A 

preview feature is a feature that is not complete, but is made available before it’s officially 

in a release so customers can get early access and provide feedback. Preview features 

aren’t meant for production use and may have limited or restricted functionality.  To use 

this feature, it must be turned on and the license terms must be accepted. Enable or 

disable Preview features.  Microsoft doesn't provide support for this preview feature. 

Microsoft Dynamics CRM Technical Support won’t be able to help you with issues or 

questions. Preview features aren't meant for production use and are subject to a 

separate supplemental terms of use. 

 

1. Follow the steps in View your user profile. 

2. Don’t have the correct permissions? Contact your system administrator. 

 

3. Go to Settings > Processes. (How do I get there?) 

4. On the Actions toolbar, click New. 

5. In Process Name, enter a name for your task flow 

6. For the Category, select Business Process Flow from the drop-down list. 

7. Select Run process as a task flow (Mobile only). 

8. For the Entity, select the type of record from the drop-down list. 

9. Click OK. 

10. Type a description for your task flow. You can use up to 2000 characters. 

11. To set an image to use as the task flow’s launch icon and background image, click Set 

image. In the pop-up window, either upload a picture or select the default image and click 

OK. 

12. Fill in the information for the first page in your task flow: 

 Type a name for the page. 

 Select the entity to base it on. 

 For each item on the page, enter a label and select the source and field. Also select 

whether that item is required or not. 

13. Continue editing your task flow: 

 To add another page in your task flow, click Insert page. 

Important  

Check your security role 

http://go.microsoft.com/fwlink/p/?LinkId=511446
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 To add a branch in your task flow, click Add branch, set the conditions for when you 

want the branch to appear, and click the checkmark. Then click Insert page to add a 

page in the branch. 

 To set business rules for this task flow, click Business Rules. For more information 

about using business rules, see TechNet: Create and edit business rules. 

14. When you’re done editing your task flow, click Save. 

15. When you’re ready to make your task flow available for use, click Activate. 

See Also 

Activate a business process or task flow 

Assign a security role to a business process 

Activate a business process or task flow 

Before people can follow the stages and steps in a business process or task flow, you need to 

activate it. 

If the business process includes workflows or portable business logic rules, you’ll need to 

activate those separately. For more information about business processes, see TechNet: 

Create and edit processes. 

Task flows are a preview feature. To use this feature, it must be turned on and the 

license terms must be accepted. Enable or disable Preview features. 

 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Processes. (How do I get there?) 

3. On the list of processes, select the process or task flow you want to activate. 

4. Click Activate. 

See Also 

Create a new business process 

Preview feature: Create a new task flow 

Note  

Important  

 

https://technet.microsoft.com/library/dn531086.aspx
https://technet.microsoft.com/library/dn531144.aspx
https://technet.microsoft.com/library/dn531144.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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Assign a security role to a business process 

Add ready-to-use business processes 

eBook: Customize a business process 

Assign a security role to a business process 

After you create a business process, you need to enable the security roles of those who are going 

to use it. This allows people with the security role to assign the process to new and existing 

records. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Processes. (How do I get there?) 

3. On the list of your processes, choose the process name. 

4. Click Enable Security Roles. 

5. Select Enable for everyone, or select Enable only for the selected security roles and 

then select the security role. 

6. Click OK. 

See Also 

Activate a business process or task flow 

Create a new business process 

Add ready-to-use business processes 

eBook: Customize a business process 

Add ready-to-use business processes 

Microsoft Dynamics CRM includes several ready-to-use business processes for common sales, 

service, and marketing scenarios – to help you ensure that staff follow consistent steps every 

time they work with customers.  

Before you can use these processes, you need to add them to the system.  

Ready-to-use business processes are activated automatically when you add them. If a 

ready-to-use business process includes workflows or portable business logic rules, you’ll 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=386368
http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkID=386368
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need to activate those separately. For more information about business processes, see 

Create and edit processes. 

The following table shows a list of ready-to-use business processes and what they help you do. 
 

This ready-to-use process Helps you… 

Phone sales campaign Call prospects, create and qualify leads, 

develop opportunities, and then close deals. 

Email sales campaign Email prospects, create and qualify leads, 

develop opportunities, and then close deals. 

Multichannel sales campaign Contact prospects by phone and email, create 

and qualify leads, and then close deals. 

Marketing list builder Create targeted marketing lists for accounts, 

contacts, or leads, add prospects, and gain 

manager approval. 

Service appointment scheduling Schedule service appointments, set up 

reminders, and make sure service activities are 

completed. 

Service case upsell Upsell additional products or services while 

resolving a customer’s service request. 

Guided service case Make sure that data is entered consistently for 

service cases, and that required activities are 

completed to resolve a case. 

Opportunity to invoice (Business-to-Business) Follow a standard process for assessing needs, 

negotiating outcomes, fulfilling orders, and 

closing opportunities when selling to other 

businesses. 

Contact to order Target sales by using a consistent method to 

interact with customers. 

Upsell after service interaction Turn a good service experience into an 

opportunity to upsell more products and 

services to the customer. 

In store excellence  Suggest orders for store owners and field 

personnel and gain acceptance from store 

managers for those orders. 

 

Add ready-to-use business processes 

https://technet.microsoft.com/library/dn531144.aspx
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1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role  

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Data Management. 

3. Select Add Ready-to-Use Business Processes. 

4. Choose Add.  

See Also 

Create a new business process 

Assign a security role to a business process 

Guide staff through common tasks with processes 

eBook: Customize a business process 

Business process templates for CRM 

Check out Microsoft Dynamics Labs for business process templates that help organizations like 

yours follow best practices for common scenarios in your industry. These templates help you 

save time by giving you a great starting point for creating business processes that match the way 

you do business. They were developed by Microsoft employees from Research & Development, 

Support, Microsoft Consulting Services, and other teams within Microsoft. 

You can find additional business process templates offered by Microsoft Partners on Microsoft 

PinPoint. 

Before you can use these processes, you need to download them from the Microsoft Dynamics 

Marketplace, and then import the template into your Microsoft Dynamics CRM system. Many 

templates include demo data so that you can experiment with them and see how they work. To 

find out how to import business process templates and demo data, see Import business process 

templates from Microsoft PinPoint. 

Please note that these templates aren’t supported by Microsoft. The global community 

facilitated by the Microsoft Dynamics Marketplace provides a place for you to discuss and 

exchange ideas and questions. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. For more information about how to import templates, see Import, update, and 

export solutions on TechNet. 
 

 

Important  

http://go.microsoft.com/fwlink/p/?LinkID=386368
http://pinpoint.microsoft.com/Companies/4297440805
http://go.microsoft.com/fwlink/p/?LinkID=389745
http://go.microsoft.com/fwlink/p/?LinkID=389745
https://technet.microsoft.com/library/dn531198.aspx#BKMK_ImportUpgradExportSolutions
https://technet.microsoft.com/library/dn531198.aspx#BKMK_ImportUpgradExportSolutions
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Industry Business process template Description 

Financial Services Deal, On-boarding, and Account 

Planning Process 

Follow best practices through 

the complete client lifecycle for 

new and existing customers, 

from initial data gathering and 

on-boarding to account 

planning and running. 

 Life Insurance Sales Template Helps insurance companies 

sell life insurance policies from 

start to finish, including from 

prospecting for clients to 

quote, application, 

underwriting, and policy 

issuance. Helps agents, 

customer service reps (CSRs), 

and district managers capture 

information from prospects, 

convert leads into 

opportunities, send price 

quotes, and create the policy. 

Customer service reps can 

also follow the process to 

cross-sell insurance products 

during service calls. Doesn't 

include demo data. 

 Coming Soon: Property and 

Casualty (P&C) Insurance 

Template 

Help property and casualty 

insurers and agents uncover 

new opportunities, streamline 

the sales process, manage 

claims, and more effectively 

serve customers. 

 Coming Soon: Retail Banking 

Template 

Manage and leverage 

customer interactions, provide 

the right products and 

services, and streamline 

processes across the branch. 

 Wealth Management Process Gather required information 

from clients, develop 

investment proposals, and 

close transactions 

https://pinpoint.microsoft.com/Applications/12884966166
https://pinpoint.microsoft.com/Applications/12884966166
https://pinpoint.microsoft.com/Applications/12884966164
https://pinpoint.microsoft.com/Applications/12884966167
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Industry Business process template Description 

successfully. Doesn't include 

demo data. 

Manufacturing and 

Distribution 

Coming Soon: Automotive Lead 

Qualification and Management 

Template 

Improve the lead qualification 

and nurturing process to 

increase the quality of leads 

passed from OEM to dealer. 

 Automotive Warranty Claims 

Management Template 

Simplify handling of warranty 

claims, including capturing key 

information from the customer, 

creating work orders for 

repairs, coordinating OEM 

review and approval of claims, 

and submitting required 

documentation. 

 Connected Marketing, Sales, 

and Service Template 

View information from a 360 

degree view, make impactful 

decisions, and act effectively 

on those decisions across 

multiple industry channels 

(Manufacturing, Distribution, 

and Retail). 

 Sales Targeting in New Markets 

for Manufacturing Process 

Create targeted marketing 

campaigns for products, and 

nurture campaign responses 

through the sales cycle to 

shipping an order. Guide sales 

representatives through each 

step to collaborate with the 

engineering team to create 

prototypes and manage 

change orders. 

 Service Call—Repair and 

Return Template 

Standardize how customer 

service reps (CSRs) assist 

customers with product fixes 

by phone, and manage 

product returns, replacements, 

and repairs. 

Nonprofit Organizations Donor and Volunteer 

Management Template for 

Manage the donor 

management process in 

https://pinpoint.microsoft.com/Applications/12884966940
https://pinpoint.microsoft.com/Applications/12884966940
https://pinpoint.microsoft.com/Applications/12884981609
https://pinpoint.microsoft.com/Applications/12884981609
https://pinpoint.microsoft.com/Applications/12884967367
https://pinpoint.microsoft.com/Applications/12884967367
https://pinpoint.microsoft.com/Applications/12884966168
https://pinpoint.microsoft.com/Applications/12884966168
https://pinpoint.microsoft.com/Applications/12884981634
https://pinpoint.microsoft.com/Applications/12884981634
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Industry Business process template Description 

Large Organizations collecting contributions by 

volunteers. 

 Coming Soon: Donor and 

Volunteer Management 

Template for Small 

Organizations 

Manage and improve 

interactions with donors and 

volunteers using the power of 

CRM combined with Microsoft 

Office applications. 

Professional Services Event Management Template Plan, manage, and review 

events. Track event venues 

and sessions, internal and 

external team members, event 

packages, and group 

allocations. The web portal 

handles web registrations for 

events. 

 Government Contractor Capture 

Management Template 

Helps contractors for the 

United States federal 

government apply rigorous 

business development 

practices, scoping, estimation 

methods, and proactive risk 

management protocols to 

pursue and win the right 

contracts at the right price. 

 Service Appointment Booking 

Template 

Provide services by booking 

appointment for standardizing 

how customer service reps 

(CSRs) handle service 

appointment booking through 

phone. This template helps 

CSRs provide customers 

discounts and specialized 

services based on their profile 

while booking a service 

appointment. 

 Service Offering Innovation and 

Sales Template 

Turn innovation challenges to 

craft new service offering ideas 

using a CRM-based variant of 

the Microsoft Innovation 

https://pinpoint.microsoft.com/Applications/12884981634
https://pinpoint.microsoft.com/Applications/12884985852
https://pinpoint.microsoft.com/Applications/12884985849
https://pinpoint.microsoft.com/Applications/12884985849
https://pinpoint.microsoft.com/Applications/12884981635
https://pinpoint.microsoft.com/Applications/12884981635
https://pinpoint.microsoft.com/Applications/12884981818
https://pinpoint.microsoft.com/Applications/12884981818
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Industry Business process template Description 

Management Framework. 

Guide development and 

marketing of top-rated ideas. 

Coordinate every step of the 

pursuit process from 

opportunity identification to 

proposal creation, risks 

assessment, and escalation for 

go/no-go decisions. Develop, 

test, and drive new revenue 

and growth initiatives. 

 Sports Management Template Designed for professional 

sports teams. Manage the sale 

of tickets and merchandise, 

and track players and teams, 

including injuries, scouting 

reports, drug testing results, 

and contracts. Doesn't include 

demo data. 

Public Sector Citizen Services Template Manage incoming service 

requests from citizens. Local, 

regional, or state governments 

can prioritize and assign 

service requests, estimate time 

and costs, and track progress 

until resolution. 

 Elected Official Transition 

Template 

Manage the recruiting and 

hiring process of staff by the 

transition team. Guides 

transition staff through 

standardized steps to help in 

the review, vetting, and 

investigation of new 

applicants. Dashboards 

provide visual status of 

applicants and where they are 

in the process. 

 Grant Management Template Manage and track grant 

awards to individuals, 

businesses, or other 

https://pinpoint.microsoft.com/Applications/12884981603
https://pinpoint.microsoft.com/Applications/12884966084
https://pinpoint.microsoft.com/Applications/12884985846
https://pinpoint.microsoft.com/Applications/12884985846
https://pinpoint.microsoft.com/Applications/12884981819
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Industry Business process template Description 

governments from application 

to the allocation of funds. 

 Healthcare Management 

Process 

Screen patients, provide 

appropriate counseling, and 

schedule follow-up 

appointments for patients. 

Doesn't include demo data. 

 Health Plan Sales Template Designed for organizations 

that sell health insurance, this 

template helps agents, 

customer service reps, and 

district managers capture 

information from a campaign 

response, convert leads into 

opportunities, send price 

quotes, and create the policy. 

Customer service reps can 

also follow the process to 

cross-sell insurance products 

during service calls. Doesn’t 

include demo data. 

 Higher Education Admissions 

Sample Process 

Manage admissions and 

enrollment for prospective 

students, including collecting 

student information, tracking 

receipt of application 

documents, and monitoring 

applications under 

consideration. Doesn't include 

demo data. 

 Coming Soon: Patient 

Relationship Management 

Template 

Healthcare providers track and 

manage their patient 

engagement lifecycle. With a 

patient data model and 

business processes, staff can 

store patient information, 

communicate via email, track 

these communications and set 

up automated workflows, for 

https://pinpoint.microsoft.com/Applications/12884966313
https://pinpoint.microsoft.com/Applications/12884966313
https://pinpoint.microsoft.com/Applications/12884966267
https://pinpoint.microsoft.com/Applications/12884966938
https://pinpoint.microsoft.com/Applications/12884966938
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Industry Business process template Description 

targeted outreach. 

 Public Sector Case 

Management Template 

Follow standardized steps to 

assess cases, define and 

approve mitigation plans, 

provide management reports, 

and ensure all required 

activities are completed to 

close a case. 

 Tax, Permitting, and License 

Compliance Template 

Oversee the collection of 

licensing and permitting fees 

from businesses and citizens. 

Retail Coming Soon: Retail Customer 

Service Template 

Gives retail organizations the 

ability to have a scripted 

workflow of activity when 

dealing with retail problem 

scenarios. Helps retail 

customer support operations to 

effectively walk through 

customer transactional 

problems in a structured, 

repeatable way. 

 Coming Soon: Selling to 

Business Accounts Template 

Use salesforce automation to 

manage retail business 

customer accounts, expand on 

their footprint, and sell new or 

additional products. 

Sales & Service Methodology Solution Selling – Short Sales 

Cycle 

Guide sales representatives 

through a simple sales cycle 

with two or three meetings with 

prospective customers or 

decision makers. 

 Solution Selling – 

Strategic/Complex Sales Cycle 

Guide sales representatives 

through a complex sales cycle 

with five or more meetings with 

prospective customers, 

decision makers, or sponsors. 

 Solution Selling – Transactional 

Cycle 

Guide sales representatives 

through a highly scripted, “one 

https://pinpoint.microsoft.com/Applications/12884966089
https://pinpoint.microsoft.com/Applications/12884966089
https://pinpoint.microsoft.com/Applications/12884966088
https://pinpoint.microsoft.com/Applications/12884966088
https://pinpoint.microsoft.com/Applications/12884966210
https://pinpoint.microsoft.com/Applications/12884966210
https://pinpoint.microsoft.com/Applications/12884966169
https://pinpoint.microsoft.com/Applications/12884966169
https://pinpoint.microsoft.com/Applications/12884966212
https://pinpoint.microsoft.com/Applications/12884966212
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Industry Business process template Description 

call” sales cycle. Covers 

inbound and outbound calling 

scenarios. 

 Integrated Sales and Service 

Template 

Cross sell and upsell product 

and service offers through your 

customer service channel. 

Standardize how customer 

service representatives 

provide customers with 

product and service offers 

based on their interest and 

profile, and create leads for 

their sales team. 

 Service Appointment Booking 

Template 

Standardize how customer 

service representatives handle 

service appointment bookings. 

Provide customers with 

discounts and specialized 

services based on their profile 

during the booking process. 

 Service Management with 

Entitlements Template 

Provide differentiated services 

to customers based on their 

entitlements levels. This 

template provides a step–by–

step visualization of the 

process to be followed by 

customer service 

representatives and helps 

customer service organizations 

provide premium service to 

their customers based on their 

entitlements. 

Other Cable and Telco Customer 

Service Template 

Respond to customer inquiries 

with more contextually relevant 

and insightful answers that 

nurture the customer 

relationship and proactively 

introduce upsell and cross-sell 

conversations that boost 

https://pinpoint.microsoft.com/Applications/12884981636
https://pinpoint.microsoft.com/Applications/12884981636
https://pinpoint.microsoft.com/Applications/12884981635
https://pinpoint.microsoft.com/Applications/12884981635
https://pinpoint.microsoft.com/Applications/12884981637
https://pinpoint.microsoft.com/Applications/12884981637
https://pinpoint.microsoft.com/Applications/12884985847
https://pinpoint.microsoft.com/Applications/12884985847
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Industry Business process template Description 

revenue growth. 

 Coming Soon: Connected 

Devices (IoT) Template 

The Internet of Things (IoT) 

with the ability to connect 

computing devices to offer 

advanced machine 

communications and learnings, 

is changing the way 

organizations think about 

engaging with customers and 

partners. This template takes 

the Connected Marketing, 

Sales, and Service template to 

the next level by enhancing it 

with machine network 

integration and enabling CRM 

users to leverage machine 

data that is proactively sent 

from sensors to engage in rich 

marketing, sales, and 

customer service scenarios. 

 Customer Portal Deliver portal capabilities to 

customers while tracking and 

managing interactions. 

Includes lead generation, 

service scheduling, case 

management, event calendar, 

product registration, self-help 

knowledge base, and content 

management. 

 Partner Relationship 

Management Portal 

Distribute sales leads and 

centrally manage sales 

opportunities across channel 

partners. 

 

See Also 

TechNet: Create and edit processes 

Activate a business process or task flow 

Create a new business process 

Assign a security role to a business process 

https://pinpoint.microsoft.com/Applications/12884981638
https://pinpoint.microsoft.com/Applications/12884981639
https://pinpoint.microsoft.com/Applications/12884981639
https://technet.microsoft.com/library/dn531144.aspx
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Import business process templates from Microsoft PinPoint 

eBook: Customize a business process 

Import business process templates from Microsoft PinPoint 

Get innovative solutions for your Microsoft Dynamics CRM system from the Microsoft Dynamics 

Marketplace. These include business process solutions from Microsoft Partners, as well as 

Microsoft Dynamics Labs solutions developed by Microsoft employees from Research & 

Development, Support, Microsoft Consulting Services, and other teams within Microsoft. 

If your solution is from a Microsoft Partner, you’ll need to work with the Partner to purchase and 

get the files you need to download. 

Please note that these solutions aren’t supported by Microsoft. The global community 

facilitated by the Microsoft Dynamics Marketplace provides a place for you to discuss and 

exchange ideas and questions. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. For more information about how to import solutions, see Import, update, and 

export solutions on TechNet. 

Download your industry template 

1. Select your industry template from Microsoft Dynamics Labs. 

2. Choose Try It, choose I agree, and then save the file to the location you want. 

3. Right-click the cabinet (.cab) file you just downloaded, choose Extract, and save the 

extracted file to the same folder. 

4. Right-click the compressed (.zip) file you just extracted, choose Extract, and save the 

extracted file to the same folder. 

5. Open the folder you just extracted, open the PackageDeployer folder, and double-click 

PackageDeployer.exe. 

6. Choose Continue to start Package Deployer for Microsoft Dynamics CRM. 

7. On the next screen, select your deployment type and region, type in your credentials, and 

choose Login. 

8. Choose Next on the next four screens, then choose Finish on the last screen. 

See Also 

Create a new business process 

Activate a business process or task flow 

Add ready-to-use business processes 

Assign a security role to a business process 

Business process templates for CRM 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=386368
https://technet.microsoft.com/library/dn531198.aspx#BKMK_ImportUpgradExportSolutions
https://technet.microsoft.com/library/dn531198.aspx#BKMK_ImportUpgradExportSolutions
https://pinpoint.microsoft.com/Companies/4297440805
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eBook: Customize a business process 

Use a dialog to create an interactive process like a wizard 

Dialogs are a type of process in Microsoft Dynamics CRM. A dialog is an input form, similar to a 

wizard, that prompts users for information. You can use dialogs to help users follow complex 

processes. A dialog can include branching logic that’s based on input from the person stepping 

through a case, phone call, or other customer interaction. Dialogs are frequently used in call 

centers to provide scripts that allow customer-facing staff to apply consistent interactions with 

customers.  

For more information, see TechNet: Dialogs. 

 

 

See Also 

Create a new business process 

Create a business rule to apply logic in a form 

Not every organization has a developer readily available to apply changes when the rules in an 

organization change. With Microsoft Dynamics CRM, you can create business rules to apply form 

logic without writing JavaScript code.  

Business rules provide a simple interface to implement and maintain fast-changing and 

commonly used rules. Business rules can be applied to Main and Quick Create forms for both the 

web application and Microsoft Dynamics CRM for tablets. 

To learn more about business rules, see TechNet: Create and edit business rules 

See Also 

TechNet: Create and edit processes 

Create and manage a product catalog 

 

Set up a product catalog: Walkthrough 

Classify products and bundles into product families 

Product lifecycle--publish to retire 

Translate product names and properties into multiple languages 

Set up a product catalog: Walkthrough 

Make it easier for your sales reps to increase their sales by creating a product catalog. The 

product catalog is a collection of products and their pricing information. To set up pricing, you 

need to define the units in which your products are sold, the amount to charge for each unit, and 

the discounts you want to offer based on volume purchased.  

Other than setting up the pricing for products, product catalog also supports product taxonomy 

that lets you create a rich classification of products. This helps ensure that your customers 

http://go.microsoft.com/fwlink/p/?LinkID=386368
https://technet.microsoft.com/library/dn531092.aspx
https://technet.microsoft.com/library/dn531086.aspx
https://technet.microsoft.com/library/dn531144.aspx
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receive the most appropriate and complete solution. More information:   Classify products and 

bundles into product families 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 Because of how units, discounts, and prices are tied together, it’s important that you create each 

of these components in a product catalog in the following sequence: 
 

Step Description Related topics 

 Create discount lists to offer your 

products and services at different 

prices, depending on the quantity 

purchased. 

Set up a discount list 

 Define the measurements or 

quantities your products will be 

available in. 

Create a unit group and add 

units to that group 

 Create products for the items you 

sell. You can create a standalone 

product or a product inside a 

family depending on how you 

want to organize and classify 

your products. Each product you 

create will be linked to a unit 

group and default unit. You can 

also create a standalone bundle 

or a bundle inside a product 

family. 

Classify products and bundles 

into product families 

 Define pricing for your products. Create price lists and price list 

items to define pricing of 

products 

 Add price list items. A price list 

item defines the price per unit of 

a product. Add each new product 

to one or more price lists as price 

list items. You can do this either 

from the product form or the price 

list form. 

Classify products and bundles 

into product families 

- OR - 

Create price lists and price list 

items to define pricing of 

products 

 Select one of the price lists to 

which you added the product as 

Classify products and bundles 

into product families 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=513070
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Step Description Related topics 

the default price list for the 

product. Microsoft Dynamics 

CRM uses the default price list 

for calculations when the 

associated price list in the 

opportunity or order for the 

product doesn’t contain a price 

definition of the product. 

 

    

 

 

Set up a discount list 

Motivate customers to buy more by offering them discounts on bulk purchases. To offer 

discounts, you need to set up a discount list. 

 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

3. Choose Discount Lists. 

4.  

To create a new discount list, choose New.  

-OR- 

To edit a discount list, open it. 

5. Fill in the information: 

 Name. Type a name that provides a good description of the kind of discount this list 

will include. 

 Type. To calculate the discount as a percentage of the price of the item, choose 

Percentage or to give discount as a fixed amount, choose Amount. 

 Currency. If you chose to give discount as a fixed amount, select the currency. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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6. Choose OK. 

7. To set volume discounts, in the left pane, under Common, choose Discounts, and then 

on the Discounts tab, in the Records group, choose Add New Discount. 

8. Fill in the information: 

Here’s how: 

 

This discount list will offer a discount of 5% whenever the customer purchases between 3 

– 5 boxes. 

9. Choose Save or Save and Close. 

Typical next steps 

 Create a unit group and add units to that group 

 Set up a product catalog: Walkthrough 

See Also 

System Settings dialog box - Sales tab 

Create a unit group and add units to that group 

Units are the quantities or measurements that you sell your products or services in. For example, 

if you sell gardening supplies, you might sell seeds in units of packets, boxes, and pallets. A unit 

group is a collection of these different units. 

In CRM, you first create a unit group and then create units within that group. Let’s look at both of 

these tasks, using seeds as our example. 

On this page: 

 Step 1: Create a unit group 

 Step 2: Create units in a unit group 

Step 1: Create a unit group 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

3. Choose Unit Groups. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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4.  

To create a new unit group, choose New. 

-OR- 

To edit a unit group, open a unit group from the list. 

5. Fill in your information: 

 Name. Type a meaningful name for the unit group. In our example, you would type 

“Seeds.” 

 Primary Unit. Type the lowest common unit of measure that the product will be sold 

in. In our example, you would type “packet.” Other examples could include ounces, 

hours, or tons, depending on your product or service. 

 

6. Choose OK. 

You cannot delete the primary unit in a unit group. 

Step 2: Create units in a unit group 

1. In the unit group you want to add the units to, in the left pane, under Common, choose 

Units, and then on the Units tab, in the Records group, choose Add New Unit. 

The unit that you specified as the primary unit earlier is already in the list of units. 

2. Fill in your information: 

a. Name. Type a meaningful name for the unit. In our example, you would type “box.” 

b. Quantity. Type the quantity that this unit will contain. For example, if a box contains 

12 packets, you would type “12.” 

c. Base Unit. Select a base unit. The base unit will establish the lowest unit of 

measurement for the unit you’re creating. Using our example, you would select 

“packet.” 

If you then create a unit called “pallet,” and one pallet contains 48 boxes, you would 

type “48” in Quantity and select “box” in Base Unit. 

Here’s how: 

 

 

3. Choose Save or Save and Close. 

Typical next steps 

 Create a product 

- OR - 

 Create product bundles to sell multiple items together 

 Set up a product catalog: Walkthrough 

Note  
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Create price lists and price list items to define pricing of products 

Price lists tell your sales agents what to charge for your products or services. You can create 

multiple price lists so that you can maintain separate price structures for different regions you sell 

your products in or for different sales channels.  

Price lists tie the unit, product, and pricing details together, so before you create a price list, make 

sure the units and products are in place.  

On this page: 

 Step 1: Create a price list 

 Step 2: Add items to the price list 

 Step 3: Define default price list for territories 

Step 1: Create a price list 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2.  

Go to Settings > Product Catalog. (How do I get there?) 

3. In the Product Catalog area, click Price Lists. 

4.  

To create a new price list, click New.  

-OR- 

To edit a price list, open a price list from the list. 

5. Fill in your information. Use the handy tooltips as a guide. 

6. Click Save. 

You must create at least one price list for each of the currencies that your organization 

does business in. 

Step 2: Add items to the price list 

Create a price list item for each unit in which the product is available. For example, if the product 

is available as a single item (each), in a dozen, and in a gross, create three list items. This lets 

you order the product in any quantity you want, using the same price list. You can add price list 

items from the product form also.  

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. In the price list record, in the Price List Items section, click the Add Record button . 

2. Fill in your information. Use the handy tooltips as a guide. 

 In the Product and Unit box, select the product and unit for which you’re creating this 

price list item.  

 To offer a discount on the combination of the product and unit, select a discount list.  

 In the Quantity Selling Option drop-down box, select whether the product or service 

can be ordered in whole, partial, or both types of quantities. This information is used 

in the Quantity field of Quote Product, Order Product, and Invoice Product 

records: 

No Control. Microsoft Dynamics CRM doesn’t enforce a quantity selling option. 

Whole. Selling a partial product isn’t allowed. For example, digital cameras cannot be 

sold in fractions. 

Whole and Fractional. The product can be sold both in whole and fractional units. 

For example, wood chips can be sold in cubic yards, or in fractions of a cubic 

yard. 

 

 In the Pricing Method drop-down box, select an option that determines how the 

pricing will be calculated. It could be a certain amount, or a percentage of the current 

or standard cost. 

 If you selected Currency Amount as the pricing method, in the Amount box, type 

the amount at which the product will be sold.  

-OR- 

If you selected any value other than Currency Amount as the pricing method, type 

the percentage for the pricing method that you want. 

 If you selected a pricing method other than Currency Amount, you can set up a 

rounding policy. For example, if you want per unit prices to be in the form of $0.99, 

you can select a rounding policy where all prices per unit automatically have a price 

that ends in 99 cents. To do this, you select the rounding policy to round the price up, 

and then set the price to end in a certain amount, such as 99 cents. 

 None. Prices are not rounded. 

 Up. Prices are rounded up to the nearest rounding amount. 

 Down. Prices are rounded down to the nearest rounding amount. 

 To Nearest. Prices are rounded to the nearest rounding amount. 

 In the Rounding Option drop-down box, select Ends in or Multiple of if you want 

the price to end in a certain amount or multiples of a certain amount.  

 In the Rounding Amount box, enter the amount. 

3. Click Save.  

Step 3: Define default price list for territories 
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Make sales agents' job easier by adding default pricelists for territories or customer segments the 

agents are managing. When sales agents are working on opportunities, they see the default price 

list. Sales agents can later select other price list that they’ve permission on. You can have one 

price list as the default for multiple territories. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

1. In the price list record, in the Territory Relationships section, click the Add Record button 

. 

2. In the Connection form, in Name, click the Lookup button, and select a territory.  

3. Click Save & Close. 

4. In the price list form, click the Auto Save button . 

When the sales agents set or change the customer for an opportunity, if a default price 

list is added to their territory (customer segment), it is shown.  

Typical next steps 

 Publish a product or bundle to make it available for selling 

 Set up a product catalog: Walkthrough 

See Also 

System Settings dialog box - Sales tab 

Classify products and bundles into product families 

Classify products and bundles into product families 

A product catalog is a collection of products and their pricing information.   

The product catalog in Microsoft Dynamics CRM also supports product taxonomy that lets sales 

managers: 

 Hierarchically organize products and product bundles into product families. 

 Define configurable properties for products to reduce the number of individual product 

records or stock keeping unit (SKUs) they would need to manage. The sales people can pick 

from these properties when they’re working on opportunities, quotes, orders, or invoices. 

 Group products and services into bundles to create attractive packages for customers 

 Define product relationships such as upsell and cross-sell products so sales people can see 

these products as recommendations at the time of building orders. 

All these capabilities will help your sales agents quickly find products, see their properties, and 

also suggest other products to the customers, and consequently increase sales.  

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

Important  

 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070


 

 
647 

 

Follow these links to learn more: 

 Create a product family 

 Create a product 

 Create product bundles to sell multiple items together 

 Use properties to describe a product 

 Define related products to increase chances of sales 

 Publish a product or bundle to make it available for selling 

 View product hierarchy 

 Translate product names and properties into multiple languages 

 Clone a product 

 Delete a family, product, or bundle 

See Also 

Set up a product catalog: Walkthrough 

Create a product family 

Make it easier for sales agents to find products and services in a product catalog by creating a 

product family and classifying similar products in it. A product family lets you group and 

categorize products, making it easier for you to manage them. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

With product families, you can: 

 Categorize your products in whichever way is most meaningful for your organization.  

 Create child products and product bundles within a product family. Product bundles allow you 

to sell multiple items together. 

 Create as many levels of product families as you want by creating a family within a family. 

 

The product family that you use for creating a product, bundle, or another product family 

becomes the parent family. You can’t change the parent family for the child products, 

bundles, or families. In the preceding example, “Televisions” is the parent family for “LED 

TVs” and “Plasma TVs,” and you can’t change these to have a different parent family.  

 

 

1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

Note  

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
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President of Marketing, or CEO-Business Manager.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

3. In the Product Catalog area, click Families & Products. 

4. To create a family, click Add Family. 

-OR- 

To create a child product family under an existing family, select the family, and click Add 

Family. The selected family becomes the parent family of the new family you’re creating. 

If you want to see your current product family levels, see View product hierarchy. 

5. Fill in your information. Use the handy tooltips as a guide.  

Note  

The Valid From and Valid To fields define the duration that a product is valid for. 

There’s no business logic associated with these fields except that the Valid To 

date must be later than the Valid From date. If required, you can implement your 

own business logic in these fields with a workflow, plug-in, or by using the 

Microsoft Dynamics CRM SDK. For example, you could run a scheduled job to 

automatically retire last season’s products using the date selected in the Valid 

To field. 

6. Click Save.  

7. In the list of products, families, and bundles, open the family that you just created.  

8. In the Product Properties section, click the Add Properties button , and add the required 

properties. More information:   Use properties to describe a product 

Typical next steps 

   Use properties to describe a product 

   Create a product 

  Classify products and bundles into product families 

See Also 

Set up a product catalog: Walkthrough 

Clone a product 

Create a product 

Products are the backbone of your business. They can be physical products or services—

whatever your organization sells. Your sales reps use the products you create in Microsoft 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Dynamics CRM to generate sales quotes, marketing campaigns, orders, and invoices. Your 

customer service reps might also use them when they create customer service cases.  

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

President of Marketing, or CEO-Business Manager. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

3. In the Product Catalog area, click Families & Products. 

4. If you want to create a child product to an existing product family, select the family in the 

list, and then click Add Product. The selected family becomes the parent family of the 

new product you’re creating. You can’t change the parent of a product after the product is 

created. More information:   Create a product family 

-OR- 

If you want to create an independent product, simply click Add Product. 

5. Fill in your information: 

 Unit Group. Select a unit group. A unit group is a collection of various units a product 

is sold in and defines how individual items are grouped into larger quantities. For 

example, if you’re adding seeds as a product, you may have created a unit group 

called ”Seeds,” and defined its primary unit as ”packet.”  

 Unit. Select the most common unit in which the product will be sold. Units are the 

quantities or measurements that you sell your products in. For example, if you’re 

adding seeds as a product, you can sell it in packets, boxes or pallets. Each of these 

becomes a unit of the product. If seeds are mostly sold in packets, select that as the 

unit.  

More information:  Create a unit group and add units to that group 

 

Note  

The Valid From and Valid To fields define how long a product is valid for. 

There’s no business logic associated with these fields except that the Valid To 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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date must be later than the Valid From date. If required, you can implement your 

own business logic in these fields with a workflow, plug-in, or by using the 

Microsoft Dynamics CRM SDK. For example, run a scheduled job to 

automatically retire last season’s products using the date selected in the Valid 

To field. 

6. Click Save.  

7. In the Price List Items section, click the Add a Record button , and create a price list item 

for each unit the product is available in. More information:  Create price lists and price list 

items to define pricing of products 

8. In the Default price list box, select a default price list. Microsoft Dynamics CRM uses 

this price list for calculations when the associated price list in the opportunity or order for 

the product does not contain a price definition of the product. 

Note  

A price list will be available for selection only when the product you’re creating is 

added to it as a price list item (as described in Step 7).  

9. If you’re creating this product under a family, the product will inherit the properties from its 

parent family. To change a product’s property, in the Product Properties section, open the 

property by clicking the name, and click Override. More information:  Use properties to 

describe a product 

Note  

You can’t add properties to an independent product. 

10. In the Product Relationships  section, click the Add a Record button , and select a 

related product. More information: Define related products to increase chances of sales 

11. Click the Save button in the bottom-right corner. 

12. After you’re done adding all the details, make sure to review everything and ensure it’s 

correct. On the command bar, click Preview. The Properties Preview dialog box lets 

you verify how the product properties will appear to sales agents when they’re selling the 

product or bundle.  

After you’re done verifying, click Done. 

Typical next steps 

  Create price lists and price list items to define pricing of products 

  Classify products and bundles into product families 

See Also 

Set up a product catalog: Walkthrough 

Create product bundles to sell multiple items together 

Encourage customers to buy more products instead of a single product by combining products in 

a bundle. Bundles replace the older kit functionality in Microsoft Dynamics CRM. Kits have been 

deprecated, so we recommend that you start using bundles instead. 

This list highlights the differences between kits and bundles: 
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 You can’t sell the products in a kit individually or separately, but you can mark certain 

products in a bundle as optional, and sell them individually. 

 You can’t see individual products added in a kit when you create an opportunity or order, but 

you can see the products in a bundle. 

 You can create nested kits (kits within a kit), but you can only add products to a bundle; you 

cannot add product families, kits, or other bundles to a bundle.  

Similar to a kit, a bundle is a collection of products that is sold as single unit. Product bundling is 

useful in cases like: 

 Pairing a top-selling product with a less popular product 

 Grouping products in a way that customers get more benefit from the full line of products, for 

example Microsoft Office Suite or a digital camera with lenses 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

On this page: 

 Create a product bundle 

 Pricing of bundles 

Create a product bundle 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

3. Click Families & Products. 

4. To add a standalone product bundle, click Add Bundle. 

-OR- 

To add product to an existing family, select the family in the list, and then click Add 

Bundle. 

5. Enter information, noting any restrictions or requirements as needed. 

6. Click Save. 

7. In the Bundle Products section, click , and select products that you want to add to the 

bundle. 

The Product Association page opens. 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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8. Fill in your information. Use the handy tooltips as a guide. 

 Bundle. The bundle you’re adding the products to is selected by default. 

 Product. Click the Lookup button and select a product you want to add to the 

bundle. 

 Quantity. Specify the quantity of product you want to add to the bundle.  

 Required. Specify whether this product is required or optional. If you select a product 

as optional, you can sell the bundle without the product.  

 Unit. Select the unit in which you want to sell the product. 

  

Note  

The Valid From and Valid To fields define the duration for which a product is 

valid. There’s no business logic associated with these fields except that the Valid 

To date must be later than the Valid From date. If required, you can implement 

your own business logic in these fields with a workflow, plug-in or Microsoft 

Dynamics CRM SDK. For example, run a scheduled job to automatically retire 

last season’s products using the date selected in the Valid To field. 

9. Click Save and Close.  

10. To change properties of an individual product in the bundle, click Customize 

corresponding to the product, and change the values as required. 

11. If you’ve added this bundle to a family, the bundle will inherit the properties from its 

parent family. To change the bundle’s property, open the property and click Override. 

More information:  Use properties to describe a product 

12. In the Additional Details section, click , and add a price list item. More information: Create 

price lists and price list items to define pricing of products 

13. In the Product Relationships section, click , and select a related product. More 

information:  Define related products to increase chances of sales 

Pricing of bundles 

Typically, the pricing of products in bundles is different than the individual products. You can set a 

total and potentially discounted price for the bundle or if the bundle has optional products, add 

those products to the price list as price list items. Then the total for a bundle in an opportunity is 

calculated by adding up the prices for each price list item, including optional bundle products that 

your customer selects. If you don’t add an optional product in the price list, its price will be 

considered as zero. 

 

 After you’re done adding all the details, click Preview on the command bar to look through 

the properties of the product bundle. 

 To create a new product bundle based on an existing one, on the command bar, click Clone. 

This opens a new product bundle record with the same information as the original product 

bundle record, except for the name and ID. 

Tip  
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Typical next steps: 

  Create price lists and price list items to define pricing of products 

 Classify products and bundles into product families 

See Also 

Set up a product catalog: Walkthrough 

System Settings dialog box - Sales tab 

Use properties to describe a product 

Simplify product management and classification by adding properties that help distinguish 

products from one another. Adding well-defined properties to products cuts down on the time 

spent by your agents trying to find products with the right specifications or properties for your 

customers when they’re building orders. 

A property of a product could be its size, color, or component and so on. Properties are added at 

the family level. You can add properties only to a family, and only when it is in a draft or under 

revision state. The child products, bundles, and families inherit the properties from their parent 

family.  

You can’t set different prices for the different properties you define for a product unless 

you’re using a custom pricing engine.  

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

On this page: 

Add properties to product families 

Change properties of product family, products, or bundles 

Product versioning 

Add properties to product families 

1. Go to Settings > Product Catalog. (How do I get there?)  

2. Click Families & Products. 

3. Click the product family you want to add properties for.  

4. In the product form, in the Product Properties section, click . 

5. Fill in your information. Use the handy tooltips as a guide. 

Note  

You can hide a property by setting Hidden to Yes. When you hide a property, 

you block the child families or products from inheriting that property. 

Important  

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
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The following table shows a list of properties that you might want to add for a shirt 

product family: 
 

Property name Data type Values 

Color Option Set red, blue, yellow, green 

Size Option Set small, medium, large 

 

6. Click the Save button in the bottom right corner, and close the form. 

Repeat the steps to add multiple properties. 

Change properties of product family, products, or bundles 

You can make changes to the inherited properties of an individual product or family by overriding 

its properties. For example, for a shirt family, the size can vary between small, medium, and 

large. A product inside this family will inherit the same property. You can override the property to 

define the actual size of an individual shirt to medium.  

1. Open the product you want to override the property of.   

2. Click the property you want to override. 

3. In the Product Properties form, on the command bar, click Override. 

4. Change the details as required, and save the properties record. 

You can override properties only for products and families that have inherited properties 

from the parent family.  

In the following cases, you’ll see the Overwrite option instead of the Override option: 

 You’re trying to change non-inherited properties of a product family that’s in the Under 

Revision status. 

 You’re trying to change the inherited and already overridden properties of a child product 

family or product. If the inherited properties of the child product or family weren’t overridden, 

you’ll see the Override option. 

Child families can have their own properties in addition to inherited ones. 

Product versioning 

At times, opportunities run for extended period. During this period, the associated product may 

change or retire. In such cases, the opportunity must still be taken through to completion.  

When you revise a product and change the properties, CRM automatically creates a new version 

of the product and copies the product details from the existing product to the newer version. The 

new product version has all the details including price lists, product relationships, and properties. 

The already-created opportunities with the older version of product can continue to refer to the 

 

Note  

Note  
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older version of the product. The opportunities that are created after the product is revised or 

retired will refer to the current (newer) version. 

See Also 

Set up a product catalog: Walkthrough 

System Settings dialog box - Sales tab 

Classify products and bundles into product families 

Define related products to increase chances of sales 

Improve your opportunities to increase sales by adding related products as suggestions for up-

sell, cross-sell, accessories, or substitutes. Defining related products will help your sales agents 

with their recommendations to customers. You can add related products to a product or product 

bundle, but not to product families. 

The related products are displayed as suggestions to your sales agents during opportunity or 

order management. These suggestions help your sales agents recommend related products and 

bundles/kits to the customers, and increase product sales. You can define the following 

relationships for a product: Accessory, cross-sell, substitute, and up-sell. For example, for a 

Microsoft Surface RT product, you can add Microsoft Surface Pro as an up-sell product so that 

when your sales agent is adding Surface RT to any opportunity, quote, order, or invoice, Surface 

Pro is suggested as the up-sell option. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Go to Settings > Product Catalog. (How do I get there?) 

2. Click Families & Product. 

3. Open a product you want to define related products for. The product must be in the Draft, 

Active or Under Revision state.  

4. In the Product Relationships section, click the Add Product Relationship button . 

5. In the quick form, enter the following details: 

 Related Product. Select a product that you want to add as a related product to the 

existing product record you’re working on. 

 Sales Relation Type. Select whether you want to add the product as an up-sell, 

cross-sell, accessory, or substitute product. 

 Direction. Select whether the relationship between the products will be uni-

directional or bi-directional. When you select Uni-Directional, the product that you 

select in Related Product will be shown as a recommendation for the existing 

product but not vice-versa. 

6. Click Save.  

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
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When you add a product to an opportunity, the sales agents can see the related product as 

suggestions for an opportunity. The Suggestions dialog box on the opportunity record suggests 

only those products that are related to the main product and have the same price list as the one 

associated with the opportunity.  

 

 

 

Typical next steps 

 Publish a product or bundle to make it available for selling 

 Set up a product catalog: Walkthrough 

See Also 

Classify products and bundles into product families 

View product hierarchy 

A product hierarchy gives you a visual snapshot of the products your organization sells. It makes 

it easy to see what products are available to sell and how they are connected. With this 

information at your fingertips, you can take whatever actions you need to on any product from a 

single place and improve your chances of a sale. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Go to Sales > Products. (How do I get there?) 

 

2. In the list of products, open a product, product family, or bundle whose hierarchy you want to 

see, and on the command bar, click View Hierarchy . 

 

You’ll see the product in a tree structure and a visual organization of all products in the 

hierarchy. 

 

 

3. To find out more about a product, family, or bundle, click its corresponding Open this 

record button.  

Tip  

You can also select a product and use one of the common command bar actions 

on the product, family, or bundle such as Email a link or Edit.  

See Also 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
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Set up a product catalog: Walkthrough 

Classify products and bundles into product families 

Product lifecycle--publish to retire 

It is important to understand the complete cycle a product goes through. First you create a 

product and add details to it in the Draft state. When the product is ready for selling, you publish 

it, which puts the product in the Active state. Then, if the product changes for any reason, you can 

revise it so that sales agents see updated product information. When you do this, the product is 

set to Under Revision status. After you’ve made the required changes, publish the product 

again. When your organization decides to stop selling a certain product, you retire it. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

You can also activate a product or a kit. More information:: MSDN: Publish, revise, revert, retire, 

and activate products (product lifecycle) 

 

Typical next steps 

 

 Publish a product or bundle to make it available for selling 

 Revise a product 

 Retire a product 

 Set up a product catalog: Walkthrough 

See Also 

Classify products and bundles into product families 

Publish a product or bundle to make it available for selling 

When you’re ready to sell a product or bundle, publish it to make it available to the sales agents 

so they can build orders or create opportunities orders for customers. By default, product records 

are created in a draft state, and are available to your sales agents only after you publish it. For 

products that don’t have a parent product family, you can create them directly in an active state 

using a system setting, so that you don’t have to publish them after creation. More information:   

System Settings dialog box - Sales tab 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

Note  

Important  

 

http://go.microsoft.com/fwlink/p/?LinkID=513070
https://msdn.microsoft.com/library/dn817887.aspx
https://msdn.microsoft.com/library/dn817887.aspx
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President of Marketing, or CEO-Business Manager.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

 

3. In the Product Catalog area, click Families & Products. 

4. Open the product, bundle, or family you want to publish, and on the command bar, click 

Publish.  

This will change the product status to Active and make it available for selling. 

You can’t publish multiple product records at the same time. To publish all child products 

and families of a parent family at once, open the family, and choose Publish > Publish 

Hierarchy. For product records that don’t belong to a product family, publish them 

individually after creating or editing them to make them available to your sales agents. 

You can only publish a product or bundle with a parent family if the parent product family 

is active. 

Typical next steps 

 Revise a product 

 Retire a product 

 Product lifecycle--publish to retire 

See Also 

Set up a product catalog: Walkthrough 

Revise a product 

Keep the product inventory updated by quickly revising properties for the products as required, 

and republishing the information so that your sales agents can see the latest changes to the 

inventory. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

Tip  

Note  

Important  
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1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

President of Marketing, or CEO-Business Manager.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

 

3. In the Product Catalog area, click Families & Products. 

4. Open an active product, bundle, or family you want to change, and on the command bar, 

click Revise.  

This will change the product status to Under Revision. 

5. Change the product properties, as required. More information:   Use properties to 

describe a product 

6. Once you’re done making the changes, on the command bar, click Publish or Publish 

Hierarchy. 

Tip  

If some of the information that you changed doesn’t align with the customer or 

business needs, revert the changes and continue with the last active version of 

the product. To do this, click Revert. This changes the status of the product back 

to Active. 

Revising a family sets all the products and bundles under it to the Under Revision state. 

Typical next steps 

 Retire a product 

 Product lifecycle--publish to retire 

See Also 

Set up a product catalog: Walkthrough 

Clone a product 

When you're creating a new product, family or bundle, save time by cloning an existing one. This 

creates a copy of the original record with all the details except for the name and ID. If the product, 

bundle or family has any properties, they’re also copied to the cloned record.  

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
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1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

President of Marketing, or CEO-Business Manager.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

 

3. In the Product Catalog area, click Families & Products. 

4. Select a product family, product, or bundle record that you want to clone, and on the 

command bar, click Clone. A new product record will open with the same details as the 

original one except for the name and ID. 

The new record is created under the same parent node as the original one. 

 

 

 

See Also 

Set up a product catalog: Walkthrough 

Classify products and bundles into product families 

Retire a product 

If your organization doesn’t sell a product anymore, retire it so that the product is no longer 

available to your sales agents. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

President of Marketing, or CEO-Business Manager.  

Check your security role 

a. Follow the steps in View your user profile. 

 

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

3. Click Families & Products. 

4. Open an active product, bundle, or family that you want to retire, and on the command 

bar, click Retire. 

Typical next steps 

 Product lifecycle--publish to retire 

See Also 

Set up a product catalog: Walkthrough 

Delete a family, product, or bundle 

To stop selling a product, delete it. If you delete a parent family, its child products, families, and 

bundles are also deleted. 

You can’t recover a deleted record. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

 

1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

President of Marketing, or CEO-Business Manager.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Product Catalog. (How do I get there?) 

3. In the Product Catalog area, click Families & Products. 

4. Select a product family, product, or bundle record you want to delete, and on the 

command bar, click Delete. 

See Also 

Set up a product catalog: Walkthrough 

Classify products and bundles into product families 

Warning  

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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Translate product names and properties into multiple languages 

When you sell your products in different regions, it is important that you translate significant 

product details into multiple languages. Help sales agents find things they need easily by making 

all the relevant details like cross-sell or upsell suggestions, or properties, available to them in their 

preferred language. 

This feature was introduced in CRM Online 2015 Update and CRM 2015 (on-premises).  

 Interested in getting this feature?  Find your CRM administrator or support person.  

On this page: 

 Step 1: Export data for translation 

 Step 2: Import translated data 

 Selection of language in different scenarios 

Step 1: Export data for translation 

 

1. Make sure that you have one of the following security roles or equivalent permissions: 

System Administrator, System Customizer, Sales Manager, Vice President of Sales, Vice 

President of Marketing, or CEO-Business Manager. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Data Management. (How do I get there?) 

3. Click Export Field Translations. 

4. In the Export Field Translations dialog box, click OK.  

All product fields that are marked as localizable by default will be exported. Your internal 

developers can mark the fields as localizable. More information: Work with localizable 

attributes. 

5. Save the .zip file to your local computer.  

Exported text is saved as a compressed file that contains a CrmFieldTranslations.xml 

that you can open by using Microsoft Excel. You can send this file to a linguistic expert, 

translation agency, or localization firm. 

Step 2: Import translated data 

When you get the localized data back from translation, import it into Microsoft Dynamics CRM. 

Important  
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It is important to provision the language packs first. If you import translated values for 

languages that aren’t provisioned in the organization, they’ll be discarded. More 

information:   TechNet: Install or upgrade Language Packs for Microsoft Dynamics CRM 

1. Make sure that you have the Manager, Vice President, CEO-Business Manager, System 

Administrator, or System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Data Management. (How do I get there?) 

3. Click Import Field Translations. 

4. In the Field Translation Import Jobs page, on the Action toolbar, click Import Field 

Translations. 

5. In the Import Translated Text dialog box, click Browse, and select the file that you’ve 

received from your translation agency. 

6. Click Import. 

This starts the import job. You can check the status to see if the import has succeeded or 

failed.  

After you’ve imported the translated text, users in your organization will see the data in their 

preferred language. If a value for the preferred language does not exist, the results will be shown 

in the user’s base language. 

Selection of language in different scenarios 

This section explains how the duplicate detection and workflow logic affect translation in Microsoft 

Dynamics CRM: 

 Calculated fields logic, including conditional clauses, uses only the base language. The 

behavior of workflows and portable business logic is similar to Microsoft 

Dynamics CRM SDK. The label for the user’s preferred language (user interface language) is 

used if present. Otherwise, the base language is used.  

 When a record is created or updated, duplicates are detected from the localizable fields 

(attributes) that are in the base language. Creating or updating a localizable field is not 

applicable in a non-base language. 

 During data import,  

 For updating or creating records through import, when import is executed in base 

language, only the labels in the base language are used for duplication detection.  

Important  

 

https://technet.microsoft.com/library/hh699674.aspx
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 When import is executed in non-base language, import fails because update can’t be 

performed in a non-base language. 

 When you run duplicate detection in the base language, only the base language is used in 

conditional clauses. 

 When you run duplicate detection job in the preferred language, label in the preferred 

language is used first. When preferred language is not available, it uses the base language. 

See Also 

Set up a product catalog: Walkthrough 

Set up duplicate detection rules to keep your data clean 

Work with templates 

Save time by creating templates for commons tasks like email, KB articles, and contracts. 

Templates contain prefilled data that you specify, so you don’t have to re-enter the same 

information. 

Create templates for articles 

Create templates for contracts 

Create templates for email 

Work with mail merge templates 

Create or edit a campaign template in the CRM marketing work area 

Set up entitlements quickly with templates 

Analyze your data with Excel templates 

Using Word templates in CRM 

Create Word and Excel templates from CRM data 

See Also 

eBook: What’s new in customer service 

eBook: Use KB articles to help your customers 

Create templates for articles 

Article templates help you create new articles for your organization's knowledge base library. You 

can also create templates with boilerplate text to help article writers use consistent language and 

messaging. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 
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a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Service Management. (How do I get there?) 

 

3. Click or tap Article Templates. 

4. To create a new article template, choose New. 

5. In the Article Template Properties dialog box, type the new article title, select the 

language, and then click OK. 

6. To add a section, in the Common Tasks area, choose Add a Section, and specify the 

following: 

a. In the Title box, type a title. 

b. In the Instructions box, type a description of the information that users should 

provide in this section when they use this template. 

 

When a user creates a new article with this template, these instructions appear in the 

body text for this section, and disappear when the user starts typing. 

 

7. To reposition a section from the template, select the section you want to reposition, and 

in the Common Tasks area, click the green arrows to move the section to the position 

you want. 

When you select a section, its border turns green and the border lines become solid. 

8. To remove the section, select the section you want to remove, and in the Common 

Tasks area, click Remove a Section. 

9. To edit a section, select the section you want to edit, and in the Common Tasks area, 

click Section Properties. Edit the title and description. 

10. To format the text, font, and color of the article title, headings, and body text of each 

section, use the tools on the Modify toolbar. 

11. When you’re done, choose Save or Save and close. 

After you save the template, it is immediately available for use. If the template is not 

complete and you want to finish it later, you can save the template, deactivate it (make it 

ready-only), and then complete it later. When the template is complete, you can 

reactivate it. 

If you need to back up your templates, or export them for use in a different 

implementation of Microsoft Dynamics CRM, you can export them as part of exporting 

customizations. More information: Export your customizations as a solution. 

See Also 

Note  
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Create or edit a contract 

eBook: Use KB articles to help your customers 

Create templates for contracts 

Quickly create consistent contracts prefilled with basic information like the service level and 

discount, and the time and days when you’ll provide support, by using a contract template in 

Microsoft Dynamics CRM. For example, create a template for gold members, and then use this 

template to create contracts for every gold customer in your organization.  

After a contract template is saved, the template is read-only and cannot be changed. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Service Management. (How do I get there?) 

 

3. Choose Contract Templates. 

4. To create a new contract template, choose New. 

5. Type information in the fields: 

a. Name:  Enter a name. When you create a new contract, this name will appear in the 

list of available contract templates. 

b. Abbreviation: Enter an abbreviated name. The name will be displayed as the 

abbreviated contract template name. 

c. Billing Frequency: Select how often the customer should be billed. 

d. Allotment Type: Select the criteria needed to track the cases. You cannot change 

the allotment type for contract lines in contracts that are created from a contract 

template. 

e. Calendar: Mark the days and times your organization offers customer support. Green 

dots indicate when the support is offered. 

f. Contract Service Level: Select the service level that will be allocated to the 

customer. 

g. Description: Enter a description of the template or any notes about how this 

template is to be used. 

h. Use Discount as Percentage: If you want the discount to be calculated in a 
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percentage, select Yes. 

6. Choose Save or Save and Close. 

If you need to back up your templates, or export them for use in a different 

implementation of Microsoft Dynamics CRM, you can export them as part of exporting 

customizations. More information: Export your customizations as a solution. 

See Also 

Create or edit a contract 

Create templates for email 

Save time when creating multiple email messages by making email templates. Email templates 

contain prefilled data that you specify, so you don’t have to reenter the same information for each 

article.  

An email template is attached to an email activity after the activity is created. Typically, each type 

of email activity has its own email template type; for example, an email activity created from a 

case record would use a case email template. You can also create global templates that are 

available for any record type, or personal templates available only to you, or organizational 

templates available to anyone in your organization. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Templates. (How do I get there?) 

3. Choose Email Templates. 

4. On the Actions toolbar, click or tap New. 

5. In the  Email Template Type dialog box, in the Template Type list, select the type, and 

then click or tap OK.  

Important  

If you choose a specific record type, such as lead or opportunity, the template is 

available only for that record type. This cannot be changed. To use the same 

content for another record type, create a new template. 

Note  
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6. On the Email Templates form, enter a Title and Subject. 

7. You can type a description of the template. This is not displayed to the recipient. 

8. Type the text you want to send in this message. Use the Formatting toolbar to edit the 

text.  

Tip  

 Although you cannot insert images or HTML directly into Microsoft Dynamics CRM 

email messages or email templates, you can use the copy feature in Internet Explorer 

to copy an image from a website and paste it into the email message or email 

template.  The image is available as long as the website is accessible. 

 To include a hyperlink in an email template, type the URL including the http://, for 

example, http://www.microsoft.com, and then press Enter. Do not include a period or 

comma or a space after the URL or the link will break. A link is automatically added to 

the  URL and the text is underlined and changed to blue. 

 There is no spell check built into Microsoft Dynamics CRM. There might be third-

party solutions available. For more information, visit Microsoft Dynamics CRM 

Solution Finder. 

 The Formatting toolbar has limited fonts and font sizes. However, you can copy and 

paste content from Microsoft Office Word. This allows you to take advantage of 

features such as spell checking and some advanced text formatting. To single-space 

a line of text, at the end of the line press Shift+Enter. 

9. To insert data fields to display information such as a customer's name or data from a 

quote, from a Microsoft Dynamics CRM record, click or tap Insert/Update, and then in 

the Data Field Values dialog box, click or tap Add.  

10. In the Add Data Value dialog box, select the Record type and Field, and then click or 

tap OK.  

11. Click or tap OK again to insert the data. 

12. To enter customers' first and last names, you'll need to repeat these three data-insertion 

steps; first and last names are separate data values. 

Tip  

Use the Default Text box to define what text is displayed if the record does not 

have data for the field. 

13. Click or tap Save or Save and Close. 

 To change a shared template to a personal one or a personal template to a shared one, on the 

template form, on the Actions  menu, click or tap Revert to Personal Template, or click or 

tap Make Template Available to Organization. 

 If you use an email template as a signature in another template, insert the signature template 

first. Otherwise, the Subject line will be overwritten. 

 If you need to back up your templates, or export them for use in a different implementation of 

Microsoft Dynamics CRM, you can export them as part of exporting customizations. More 

information: Export your customizations as a solution. 

Note  
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See Also 

Work with templates 

Work with mail merge templates 

You can use mail merge templates with Microsoft Office Word to create customer-ready letters, 

faxes, e-mail messages, and quotes. 

Microsoft Office Word templates are created and edited in Word, but can be uploaded to 

Microsoft Dynamics CRM to use with mail merge and share with other users. Only Word .xml 

documents can be used as templates. To learn more about how to create mail merge templates, 

see the online Help Microsoft Office Word. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Templates. (How do I get there?) 

 

3. Click Mail Merge Templates. 

4. To create a new mail merge template, click New. 

5. In the Mail Merge Templates form, enter a Name and an Associated Entity (record 

type). 

6. You can enter a description of the template. This is not displayed to the recipient. 

7. Enter the Ownership and Owner information. Use the handy tooltips as a guide. 

8. If you have enabled additional languages, you can select one for the template. 

9. To attach the template, click Browse, search for the template on your computer, and 

then click Attach. Only .xml documents can be uploaded. 

10. When you’re done, click Save and close. 

To change a personal template to a shared one, after you save the record on the 

template form, on the More Actions menu, click Make Available to Organization. To 

revert the template to a personal one, click Make Personal. 

See Also 

Work with templates 

 

Note  
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Create or edit a campaign template in the CRM marketing work area 

Save time when creating multiple campaigns by creating a campaign template. Campaign 

templates contain prefilled data that you specify, so you don’t have to reenter the same 

information for each campaign. You can either create a new campaign template or copy an 

existing campaign to use as a template.  

Create a campaign template 

1. Go to Marketing > Campaigns. (How do I get there?) 

2. Click New Template. 

- OR - 

Open the campaign you want to edit. 

3. Add information in the template form just as you do when creating a campaign. In the 

template form, enter the information you want to appear in campaigns based on this 

template, and add items such as planning tasks, campaign activities, and marketing lists. 

4. Click Save or Save and Close. 

Copy an existing campaign as a template 

 Open the campaign that you want to copy. Click Copy as Template, type a name for the 

template, and click Save. 

 

If you need to back up your templates, or use them in a different implementation of Microsoft 

Dynamics CRM, you can export them as part of exporting customizations. More information: 

Export your customizations as a solution 

 

This topic applies to the Marketing work area within Microsoft Dynamics CRM. The 

Dynamics CRM Marketing work area provides a way for your sales force to run sales-

driven marketing activities. If you use Microsoft Dynamics Marketing along with Dynamics 

CRM, you might be looking for a similar topic for that product. Dynamics Marketing 

provides a full-scale set of functionality, automation, and analytical insights for multistage 

and multichannel campaigns.  More information: Microsoft Dynamics Marketing Help 

Center 

See Also 

Get started with CRM marketing 

Create a marketing list in the CRM marketing work area 

Create or edit a campaign in the CRM marketing work area 

Create a quick campaign in the CRM marketing work area 

 

 

Note  

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=394794
http://go.microsoft.com/fwlink/p/?LinkId=394794
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Add an activity to a campaign in the CRM marketing work area 

Add a marketing list, sales literature, or product to a campaign in the CRM marketing work area 

Track a campaign response in the CRM marketing work area 

Microsoft Dynamics Marketing Help Center 

Set up entitlements quickly with templates 

Quickly create other entitlements prefilled with the basic information like the start and end date, 

service level agreement (SLA), allocation type, and total term by using an entitlement template in 

Microsoft Dynamics CRM. For example, create a template for a standard entitlement, and then 

apply this template for every standard customer in your organization. 

This feature was introduced in CRM Online Spring '14 update and in CRM 2013 Service 

Pack 1 (on-premises). 

 

 Interested in getting this feature? More information:  Find your CRM administrator or 

support person  

Create an entitlement template 

1. Make sure that you have the Customer Service Manager, System Administrator, or 

System Customizer security role or equivalent permissions. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Service Management. (How do I get there?) 

3. Choose Entitlement Templates. 

4. To create a new entitlement template, choose  + New.  

-OR- 

To edit an entitlement template, in the list of records, select the template, and on the 

command bar, choose Edit.  

5. Type or modify information in the text boxes. 

Hovertips provide hints about what to enter. 

 Entitlement Template Name 

 Start Date. Select the date from which the entitlement will be valid. 

 End Date. Select the date until which the entitlement will be valid. 

 Restrict based on entitlement terms. To restrict creating case when the entitlement 

term is over, select Yes. Otherwise, Select No.  

Note  

 

http://go.microsoft.com/fwlink/p/?LinkId=394794
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkID=513070
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 SLA. Select an SLA record to associate the service levels or key performance 

indicators for the support you are providing with this entitlement. 

 

Under Entitlement Terms, specify the term details for the entitlement.  

 Allocation Type. Select whether the entitlement is for number of hours or number of 

cases. 

 Decrease Remaining On. Select whether to decrease the remaining term on case 

creation or resolution. 

 Total Term. Specify the total amount of support the customer is entitled for with 

respect to the allocation type. For example, if the allocation type is number of cases 

and you specify 100 in Total term, then the customer is entitled for support up to 100 

cases. 

6. Click Save. 

Add entitlement channels 

Use the Entitlement Channels section to define the channels your customers are entitled to, and 

track the customer support term for each channel separately. For example, to use phone and 

email as support channels, and restrict them to 80 and 20 hours respectively, create an 

entitlement channel for each of them. 

You must save the template record before you can add entitlement channels to the 

template. 

1. In the Entitlement Channel section, choose +. 

2. Specify the total terms that you want to allot to the particular channel. 

The remaining term is auto-calculated and shows the total number of hours or cases 

remaining for the customer’s entitlement. 

Associate a product with the entitlement template 

If you want the entitlement template to be applicable to specific products for an individual 

customer, associate a product to the template.  

1. While in the template record, in the Products section, choose +. 

2. In the Search box, type the first few letters of the name of the product that you want to 

associate with the template. 

If a product isn’t available, choose New to create a new product record. 

See Also 

Define service level agreements (SLAs) 

Create an entitlement to define the support terms for a customer 

Note  
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Analyze your data with Excel templates 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

Microsoft Excel provides powerful ways to analyze and present your CRM data. With Excel 

templates, you can easily create and share your customized analysis with others in your 

organization.  

Use Excel templates for: 

 Sales Forecasting 

 Pipeline Management 

 Leads Scoring 

 Territory Planning 

 And much more… 

You can try out the Excel templates included with CRM 2016 to get a quick view of what kind of 

analysis is possible. 

3470efe5-88ad-4d33-9401-82af06fa063e 
 

Create a new Excel template 

The process for creating an Excel template is as follows: 

  

 
 

  

Step 1: Create a new template from existing data 

There are two places in CRM where you can create an Excel template: 

http://go.microsoft.com/fwlink/p/?LinkID=513070
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 From the Settings page. Go to Settings > Templates > Document Templates > New ( ). 

You must have sufficient permissions to access to the Settings page, such as System 

Administrator or System Customizer. 

 From a list of records. For example, go to Sales > Opportunities > My Open 

Opportunities. On the menu bar, click Excel Templates > Create Excel Template.  

  

 
 

  

The Create template from CRM data page appears. 

  

 
 

  

1. Select an entity (record type) to include that CRM data. The views you can select in the 

next field depend on the entity you select. 

2. Select a view. 

3. Click Edit Columns to add, remove, and adjust properties for the columns to be included 

in the template.  

4. Click Download File to create the template file. 

Select the data to include in the template 
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You can also download a template containing no data except for the columns associated 

with the record type (entity) using Settings > Data Management > Templates for Data 

Import. For more information, see: Download a template for data import. 

Step 2: Customize the data in Excel 

Open the newly created template in Excel to customize the data. 

  

 
 

  

Let’s walk through a simple example of customizing an Excel template using CRM sample data. 

1. Click Enable Editing to allow customization of the Excel spreadsheet. 

2. Add a new column and name it “Expected Revenue”. 

  

Warning  

Example customization of Opportunities data 
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3. Create a formula for expected revenue. Don’t refer to cells using their addresses; define 

and use names instead.  

  

9777a950-a39e-4c33-bdee-137e89def532 
 

  

4. Create a pivot table and chart. These and other demo steps will be covered in an 

upcoming document. 

User added content should be placed above or to the right of the existing data table. This 

will prevent the content being overwritten if you add new data in CRM later and you 

create a new Excel template. For more information, see: Best practices and 

considerations for using Excel templates 

  

3eaba552-a2b5-4d81-973c-cc81cb0ae74b 
 

  

5. Save the spreadsheet. 

  

  

You’re now ready to upload the Excel template into CRM. 

Step 3: Upload the template and share with others 
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Once you have your Excel template customized the way you want, you can upload it into CRM. 

Where the template is uploaded determines its availability. 

CRM administrators can use the Settings page to upload the Excel template into CRM. A 

template uploaded in Settings is available to all users in your CRM organization. 

1. In CRM, go to Settings > Templates > Document Templates. 

2. Click Upload Template. 

3. Drag the Excel file in the dialog box or browse to the file. 

  

 
 

  

4. Click Upload. 

Non-admin users can upload a template for their own use from a list of records. 

1. In CRM, open a page with a list of records, for example, the list of Sales Opportunities. 

Go to Sales > Opportunities > My Open Opportunities. 

2. On the menu bar, click Excel Templates > Create Excel Template. 

3. Click Excel Template > Upload 

  

For admins: Upload the Excel template into CRM 

For non-admins or admins wanting to create a personal template: Upload the Excel 
template into CRM 
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4. Drag the file in the dialog box or browse to the file. 

5. Click Upload. 

Step 4: Choose who can use the new template 

Access to the newly created Excel template depends on how you uploaded it and to the access 

granted to the security role. Be sure to check out Use Security Roles to control access to 

templates. 

If you uploaded the template using the Settings page 

The Information page for the uploaded Excel template will look like the following: 
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Templates uploaded from the Settings page are available to all users in your CRM organization. 

You don’t need to take any further action. 

If you uploaded the template from a list of records 

The Information page for the uploaded Excel template will look like the following: 
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Templates uploaded from a list of records are available to the user who uploaded the template. 

To share the template with others, do the following: 

1. From the template Information page, click Share. 

2. Use the Share personal document template page to share the Excel template with others 

and to set permissions.  
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Export and analyze data using the new template  

The process for using an Excel template is as follows: 

  

 
 

  

Step 1: Select an entity to analyze 
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In CRM, select an entity (record type) to analyze with the Excel template you created. For 

example, go to Sales > Opportunities > My Open Opportunities. Two new opportunities were 

added since the template was created. 

  

 
 

Step 2: Export CRM data using your new Excel template 

Choose the Excel template you created. 

  

 
 

  

This template was created from the Settings page so it will appear on the menu under Excel 

Templates. If it had been created from a records list, it would appear under Personal Excel 

Templates. 

If you have Excel Online, you can choose to view the data in place in an Excel window in CRM. If 

not, or if you’d rather create the Excel file, click Download <the template name>. 



 

 
683 

Step 3: Analyze your CRM data in Excel 

What you see in the Excel spreadsheet is based on two things: 

 CRM records: The view you choose to do the export from determines what CRM records you 

see in the exported Excel file. For example, if you the view you selected was Closed 

Opportunities, you will see those records even if you used the template created with My Open 

Opportunities.   

 Columns: The template you used determines what columns appear in the table in the 

exported Excel file. For example, the Closed Opportunities view has: Potential Customer, 

Status, Actual Revenue, and Actual Close Date. But if the template you used was based on 

My Open Opportunities, you’d see columns associated with that view and any column filtering 

done when you created the template. 

Step 4: Share the results with others 

If you’re using Excel Online, save a copy either online or to your computer. Send the file to others 

for their review and input. 

Try out the sample Excel templates 

There are four Excel templates included with CRM 2016. 

  

 
 

  

The sample Excel templates were created with a particular record type (entity). You’ll only be able 

to apply the template to records of the same record type. 
 

Name Entity 

Pipeline Management Opportunity (Sales area) 
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Name Entity 

Campaign Overview Campaign (Marketing area) 

Cases SLA Status Case (Service area) 

Case Summary Case (Service area) 

 

1. Open a list of records with information with the entity type that matches the sample 

template. For example, open a list of Sales opportunities to apply the Pipeline 

Management template. 

2. Click > Excel Templates, and then under Excel Templates select the sample template. 

3. Download the template or open it in place in Excel Online. 

You can export the templates that are included in CRM 2016, modify them, and then 

reimport them as new templates. This could give you a running start on creating your own 

custom Excel templates. 

Best practices and considerations for using Excel templates 

Here are things you need to be aware of to create and make best use of Excel templates in CRM. 

Test your Excel templates 

Excel has lots of features. It’s a good idea to test your customizations to see that all Excel 

features work as expected in your templates. 

Privacy and Pivot Charts 

By default Pivot Charts do not update their data when a spreadsheet is opened. This can create a 

security issue if certain Pivot Chart data should not be seen by users with insufficient 

permissions.  

Consider the following scenario: 

 A CRM administrator creates a template with sensitive data in Pivot Charts and uploads the 

template into CRM. 

 A salesperson who should not have access to the sensitive data in the Pivot Charts uses the 

template to create an Excel file to do some data analysis. 

The outcome: The salesperson might be able to see the Pivot Chart data as uploaded by the 

CRM administrator including access to views the salesperson does not have permissions. 

In addition: iOS does not support updating Pivot Data and Pivot Charts when using the Microsoft 

Excel app on iOS devices.  

Recommendation: Sensitive data should not be included in Pivot Tables and Pivot Charts. 

Set Pivot Chart data to automatically refresh 

To apply a sample Excel template 

Tip  
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Be default, Pivot Chart data does not automatically refresh when you open the spreadsheet. 

Regular charts automatically update. 

In Excel, right-click the Pivot Chart, and then click PivotChart Options > Refresh data when 

opening the file. 

  

7765e801-6bb2-4c7b-bb1c-b2355375cff0 
 

Placing new data 

If you want to add content to the Excel template, place your data above or to the right of the 

existing data. A second option is to place your new content on a second sheet.  

Excel templates with images may cause an error 

If you attempt to analyze CRM data with an Excel template that has an image saved in it, you 

may receive the following error: “An error occurred while attempting to save your workbook. As a 

result, the workbook was not saved.” Try removing the image from the template and reloading it 

into CRM. 

Excel templates and Office Mobile app in Windows 8.1 

Excel templates will not open in Windows 8.1 devices with Office Mobile app. You’ll get the 

following error message: “We’ve recovered as much of your document as we could, but you can’t 

edit it. Try to open and repair the document on your PC to fix the problem.” 

This is a known issue. 

Use table column names and range names in formulas 

When you create Excel formulas, don’t use column titles or cell numbers. Instead, use the table 

column names, and define names for cells or cell ranges.  

Use Security Roles to control access to templates 

CRM administrators can control access to Excel templates with some granularity. For example, 

you can give salespeople Read but not Write access to an Excel template.  

1. In CRM, click Settings > Security > Security Roles. 

2. Select a role, and then click the Business Management tab. 

3. Select Document Template to set access for templates available to the entire organization. 

Select Personal Document Template for templates shared to individual users. 

4. Click the circles to adjust the level of access. 

  

ff722ebd-b1d2-44f8-90b2-68de5de622f4 
 

To view and delete personal document templates: 

To delete personal document templates, do the following: 

1. Click Advanced Find ( ). 

2. For Look for, select Personal Document Templates. 

3. Click Results (!). 
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4. Select the personal document template to delete and then click Delete ( ). 

Excel template does not upload in Microsoft Edge 

If your Excel template does upload in CRM when using Microsoft Edge as your browser, update 

Microsoft Edge and try again. 

 

 

Privacy notice 

If you use Microsoft Dynamics CRM Online, exporting data to a static worksheet creates a local 

copy of the exported data and stores it on your computer. The data is transferred from CRM 

Online to your computer by using a secure SSL connection, and no connection is maintained 

between this local copy and CRM Online. 

 

 When you export to a dynamic worksheet or PivotTable, a link is maintained between the Excel 

worksheet and CRM Online. Every time a dynamic worksheet or PivotTable is refreshed, you’ll be 

authenticated with CRM Online using your credentials. You’ll be able to see the data that you 

have permissions to view. 

 

 An administrator determines whether or not an organization’s users are permitted to export data 

to Excel by using security roles.  

 

See Also 

Download a template for data import 

Using Word templates in CRM 

Using Word templates in CRM 

This feature was introduced in CRM Online 2016 Update and CRM 2016 (on-premises).  

  

Interested in getting this feature?  Find your CRM administrator or support person.  

After you create and import Microsoft Office Word templates into Microsoft Dynamics CRM, with 

one click users can generate standardized documents automatically populated with CRM data. 

This feature has some special considerations you should know about to successfully create Word 

templates. 

There is a known issue when creating templates in Word. This topic contains information 

on how to prevent interactions that could potentially destabilize Word. See: Important! A 

known issue and how to avoid it 

Follow the steps in this topic to successfully create and use Word templates in CRM. 

Step 1: Create a Word template 

Where you can create a template 

There are three places in CRM where you can create a Word template: 

Warning  

http://go.microsoft.com/fwlink/p/?LinkID=513070
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 From the Settings page. Go to Settings > Templates > Document Templates > New( ). 

You’ll need sufficient permissions to access to the Settings page, such as System Administrator 

or System Customizer.  

 From a record. Open a record such as an account in Sales. Go to Sales > Client_Accounts 

> My Active Accounts. Click an account to open it, and then click More (…) > Word 

Templates > Create Word Template. Templates created here are personal and available 

only to the user creating the template. 

 From a list of records. For example, go to Sales > Client_Accounts > My Active 

Accounts. Select a single account, and then click More (…) > Word Templates > Create 

Word Template.  

  

 
 

  

To delete personal document templates, do the following: 

1. Click Advanced Find ( ). 

2. For Look for, select Personal Document Templates. 

Tip  
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3. Click Results (!). 

4. Select the personal document template to delete and then click Delete ( ). 

After clicking Create Word Template, select an entity to filter with, and then click Word 

Template > Select Entity. 

  

 
 

  

The relationship selection page appears. 

  

 
 

What are 1:N, N:1, and N:N relationships? 
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This screen requires an understanding of your CRM data structure. Your CRM administrator or 

customizer can provide information about entity relationships. For admin content, see: TechNet: 

Create and edit entity relationships. 

Here are some example relationships for the Account entity. 
 

Relationship Description 

 
 

 

An account can have multiple contacts. 

https://technet.microsoft.com/library/dn531171.aspx
https://technet.microsoft.com/library/dn531171.aspx
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Relationship Description 

 
 

 

A lead, account, or contact can have multiple 

accounts. 
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Relationship Description 

 
 

 

An account can have multiple marketing lists. 

A marketing list can have multiple accounts. 

 

The relationships you select on this screen determine what entities and fields are available later 

when you define the Word template. Only select relationships you need to add CRM data to the 

Word template. 

To ensure documents download in a timely matter, there is an upper limit of 100 for the 

number of related records returned for each relationship. For example, if you’re exporting 

a template for an account, and you want to include a list of its contacts, the document will 

return at most 100 of the account’s contacts. 

Download the template 

Click Download Template on the Select Entity page to create a Word file on your local 

computer with the exported entity included as XML data. 

Step 2: Enable the Developer tab 

Open the Word template file. At this point, the document appears to be blank. 

  

Note  
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To see and add CRM XML data, you need to enable the Word Developer tab. 

1. Go to File > Options > Customize Ribbon, and then enable Developer. 
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2. Click OK. 

Developer now appears in the Word ribbon. 

  

 
 

Important! A known issue and how to avoid it 

There’s a known issue with CRM-generated Word templates and Microsoft Office Word. In the 

next section, you’ll be adding XML content control fields to the Word template.  

A few things  can cause Word to freeze, requiring you to use Task Manager to stop 

Word: 

 You insert a content control other than Picture or Plain Text. 

 You make a textual change, such as changing the capitalization or adding text, to a content 

control. These changes can occur through AutoCorrect as well as user edits. By default, 

Warning  
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Microsoft Word AutoCorrect capitalizes sentences. When you add a content control field, 

Word sees it as a new sentence and will capitalize it when focus shifts away from the field. 

To prevent issues with control fields, do the following: 

1. You use the XML Mapping Pane to add CRM entity fields to your Word template. Be sure 

to only add fields as Plain Text or Picture. 

  

 
 

  

1. You can make formatting changes to content control fields, such as bolding the text, but 

no other textual changes, including capitalization changes.  

Only add fields as Plain Text or Picture 

Do not make any textual changes to the added content control 
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If you experience Word freezing or performance degradation, try turning off AutoCorrect. 

1. With the template file open in Word, go to File > Options > Proofing > AutoCorrect 

Options. 

  

 
 

  

2. Deselect Capitalize first letter of sentences and Automatically use suggestions from 

the spelling checker. 

  

Turn off AutoCorrect 
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3. Deselect Hyphens (--) with dash (-) on the AutoFormat and AutoFormat as You Type 

tabs. 

4. Click OK. 

If you followed the above recommendations, you’re ready to define the Word template.  

Step 3: Define the Word template 

Use the XML Mapping Pane to define the Word template with CRM entity fields. 

5. 0.1. In your Word template, click Developer > XML Mapping Pane. 

  

 
 

  

The default XML schema is selected. 
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2. Select the CRM XML schema. It will begin with “urn:microsoft-crm/document-template/”. 

  

 
 

  

If you have frequent accidental edits that cause Word to freeze or have performance 

degradation, be sure to turn off the AutoCorrect options according to the section: “A 

known issue and how to avoid it”. 

Important  
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3. Expand the CRM entity, right-click the entity field, and then click Insert Content Control > 

Plain Text. 

  

 
 

  

The CRM entity field is added to the Word template. 
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Add additional entity fields, add descriptive labels and text, and format the document. 

A completed template might look like this: 
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Some content control fields you entered likely have multiple lines of data. For example, accounts 

have more than one contact. To include all the data in your Word template, set the content control 

field to repeat. 

1. Put fields with repeating data in a table row. 

2. Select the entire table row in the template. 

  

 

Set content control fields to repeat 
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3. In the XML Mapping Pane, right-click the relationship containing the content control 

fields, and then click Repeating. 

  

 
 

  

When you use the Word template in CRM to create a document, the table will populate with 

multiple rows of data. 

When the template has the fields and formatting you want, save it and upload it into CRM. 

Step 4: Upload the Word template back into CRM 

‘When you have your Word template built the way you want, save it so you can upload it into 

CRM. 

Access to the newly created Word template depends on how you uploaded it and to the access 

granted to the security role. Be sure to check out Use Security Roles to control access to 

templates. 

CRM administrators can use the Settings page to upload the Word template into CRM. A 

template uploaded in Settings is available to all users in your CRM organization. 

For admins: Upload the Word template into CRM 
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1. In CRM, go to Settings > Templates > Document Templates. 

2. Click Upload Template. 

3. Drag the Word file in the dialog box or browse to the file. 

  

 
 

  

4. Click Upload. 

Non-admin users can upload a template for their own use from a list of records. 

1. In CRM, open a page with a list of records, for example, the list of customer accounts in 

Sales. 

2. Select a single item such as an account, click More (…) > Word Templates > Create 

Word Template. 

3. Click Word Template > Upload. 

  

For non-admins or admins wanting to create a personal template: Upload the Word 
template into CRM 



 

 
703 

 
 

  

4. Drag the Word file in the dialog box or browse to the file. 

5. Click Upload. 

Step 5: Generate a document from the Word template 

To use the Word template you’ve created, do the following: 

1. Open a record with information you want to create a document. For example, open a 

customer account record in Sales. 

2. Click More (…) > Word Templates, and then under Word Templates select the template 

you created. 

  

If the template you created is not visible, there are two possibilities: 

a. Only templates built for the selected record type (entity) will be displayed. For example, if 

you open an opportunity record, you will not see a template you created with the Account 

entity. 

b. You need to refresh CRM to see the template. Either refresh your browser or close and 

reopen CRM. 

After you select your Word template, CRM creates a Word document from the record you 

selected. 

Try out the sample Word templates 

There are five Word templates included with Microsoft Dynamics CRM 2016. 
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The sample Word templates were created with a particular record type (entity). You’ll only be able 

to apply the template to records of the same record type. 
 

Name Entity 

Opportunity Summary Opportunity (Sales area) 

Campaign Summary Campaign (Marketing area) 

Case Summary Case (Service area) 

Invoice Invoice (Sales area) 

Account Summary Client_Account (Sales, Service, and Marketing 

areas) 

 

1. Open a record with information with the entity type that matches the sample template. For 

example, open a customer account record in Sales to apply the Account Summary 

template. 

2. Click More (…) > Word Templates, and then under Word Templates select the sample 

template. 

Open the newly-created Word template and give it a look.  

To apply a sample Word template 

Note  



 

 
705 

You can review but not edit templates that are included in Microsoft Dynamics CRM 

2016. 

Additional considerations 

 

Use Security Roles to control access to templates 

CRM administrators can control access to Word templates with some granularity. For example, 

you can give salespeople Read but not Write access to a Word template.  

1. In CRM, click Settings > Security > Security Roles. 

2. Select a role, and then click the Business Management tab. 

3. Select Document Template to set access for templates available to the entire organization. 

Select Personal Document Template for templates shared to individual users. 

4. Click the circles to adjust the level of access. 

  

ff722ebd-b1d2-44f8-90b2-68de5de622f4 
 

See Also 

Analyze your data with Excel templates 

Create Word and Excel templates from CRM data 

You can take CRM data and create Word and Excel templates to provide standardized 

documents or customized data analysis for your organization  

For more information, see: 

1. Using Word templates in CRM 

2. Analyze your data with Excel templates 

Create or edit a solution 

 

Customize your system 

Create, edit, and delete solutions 

Edit a solution publisher 

View or edit default solution components 

Add a solution component 

Create a managed solution 

Edit or view managed properties 

Import a solution 

Export your customizations as a solution 
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Customize your system 

The way your organization works is unique. For example, you may need to create your own 

custom record types (entities) forms, and views, or set up new workflows or other business 

processes. With Microsoft Dynamics CRM, you can customize your system to fit the needs of 

your business. To understand what’s possible, and how to customize your system, see TechNet: 

Customize your CRM system. 

 

 

Create, edit, and delete solutions 

If you want to share or transport customizations from one organization to another, you can use 

solutions. For more information on creating, editing, and deleting solutions, see TechNet: Use 

solutions for your customizations. 

Edit a solution publisher 

Every solution has a publisher. Information about the publisher (for example, address and support 

contact info) is stored in a record. Each solution has a look-up field that associates the solution 

with the appropriate publisher record for that solution.  

The default solution has a publisher named “Default Publisher for <your organization name>”. 

The publisher record contains a prefix value. The default value of this prefix is “new”. When you 

create a new solution component, this prefix is appended to the name. This is a quick way to 

indicate the solution that the components belong to. Before you start customizing your system, 

we recommend that you change the prefix value for the default publisher to something that 

identifies your company.  

You can edit some of the properties in the publisher record of an unmanaged solution or the 

Microsoft Dynamics CRM default solution. You can’t edit any properties for a publisher record that 

was imported as part of a managed solution. Customization tasks can be performed only while 

you are online. 

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/dn531158.aspx
https://technet.microsoft.com/library/dn531198.aspx
https://technet.microsoft.com/library/dn531198.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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3. Choose Publishers. 

4. In the list, double-click the row for the publisher record that you want to edit. 

5. Modify the Display Name for the publisher. The name that you enter here is added as an 

option to the Publisher list in a solution record. When someone creates a new solution, 

that person can select this publisher. 

Note  

The value in the Name box is created with the record and can’t be edited.  

6. In the Prefix box, edit the text prefix that you want added to any entity or field created for 

a solution that has this publisher. This text prefix, plus an underscore, is added before the 

value in Name. 

7. In the Option Value Prefix text box, edit the set of integers that are a prefix for any 

option set created in a solution for this publisher.  

8. Choose Save and Close. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

See Also 

TechNet: Use solutions for your customizations 

View or edit default solution components 

All components that make up a default solution or an unmanaged solution are listed in the 

window for that solution.  

All components that comprise the managed solution are listed in the solution explorer. You can 

view all components and properties for a managed solution, but you can’t edit the properties or 

perform any actions on the components. More information: TechNet: Use solutions for your 

customizations 

If you attempt to install some solutions without first installing product updates, you’ll 

receive a warning. This warning will give you the option to install a solution without the 

components that depend on product updates, but it’s very likely the solution may not 

function as designed. When a solution import is complete, you can check the import log 

to see which components were imported successfully.  

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

 

Note  

Warning  

https://technet.microsoft.com/library/dn531198.aspx
https://technet.microsoft.com/library/dn531198.aspx
https://technet.microsoft.com/library/dn531198.aspx
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1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. Click Solutions. 

 

1. Go to Settings > Customizations. (How do I get there?) 

2. Click Solutions. 

3. In the Solution window, click Components to see a list of all default solution components 

in the main pane. To see components for an individual type, select a type from the 

Component Type list.  

The component type and the properties set by the creator of the component determines 

whether a component is customizable. This is indicated in the Customizable column. 

The following table lists actions that you can perform on some components. These 

actions are available on the command bar. 
 

Actions Comments 

New Create a new component. You can create 

new components for most types. The 

exceptions are SDK message processing 

steps, client extensions, plug-in 

assemblies, and service endpoints. 

Add Existing (Applies to an unmanaged solution only.) 

Add a component from the default solution 

or other unmanaged solution to this 

solution.  

Delete Delete an existing component. You can 

delete unmanaged components or 

managed components that are 

customizable. You cannot delete any 

system entities. If the component has 

View a managed solution in the solution explorer 

Edit a customizable component for the default solution or an unmanaged solution 

http://go.microsoft.com/fwlink/p/?LinkId=525636
http://go.microsoft.com/fwlink/p/?LinkId=525636
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dependencies such as relationships, you 

must remove the dependencies before 

you can delete the component. See Show 

Dependencies. 

Remove Remove a component from the solution. 

The component will still be available in the 

default solution after you remove it here.  

Publish This action applies to the entity 

component. Publish customizations to 

your Microsoft Dynamics CRM 

organization, including changes to forms, 

fields, views, charts, and relationships.  

Activate or Deactivate Do this for workflows, dialogs, and SDK 

message processing steps. 

Show Dependencies Open a dialog box that lists the other 

components that are dependent on this 

component. If you want to delete this 

component, you must remove the 

dependencies first. 

Managed Properties This action lists the managed properties 

settings for the component. 

Add Required Components (Applies to an unmanaged solution only.) 

Add required components to your solution. 

This helps you avoid an error when you 

export the unmanaged solution. 
 

See Also 

Edit or view managed properties 

Export your customizations as a solution 

Export customized entity and field text for translation 

Import translated entity and field text 

TechNet: Use solutions for your customizations 

Add a solution component 

Adding a component to a solution extends the functionality or usefulness of that solution for 

users. You can add a component to an existing unmanaged solution, or you can create a new 

unmanaged solution and add a component to it. This procedure guides you through the process 

of creating an unmanaged solution and adding new or existing components. While you can add 

new or existing components for most component types, for the following types you can only add 

components that already exist in Microsoft Dynamics CRM: 

https://technet.microsoft.com/library/dn531198.aspx
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 Client extensions 

 Plug-in assemblies 

 SDK message processing steps 

 Service endpoints 

Components can be created in the Customization area of Microsoft Dynamics CRM, or they can 

be developed outside of Microsoft Dynamics CRM. More information:  MSDN: Introduction to 

Solutions 

Customization tasks can be performed only while you’re online.  

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Solutions. (How do I get there?) 

 

3. On the command bar, choose New. 

4. Complete the required fields, and then choose Save. 

By default, this saves an unmanaged solution. 

5. To add a new or existing component to a solution, in the Component Type list, choose 

the type you want to add, and then, on the command bar choose New or Add Existing. 

The steps required for adding each type of component are available in the Help on This 

Page topic associated with the type of component you’re adding. 

6. After specifying the necessary details for the component, choose Save and close the 

window, or choose Save and Close (depending on the type of entity you created or 

added). 

7. To set the managed properties for each component that you’re adding, on the command 

bar, choose Managed Properties. More information:  Edit or view managed properties 

8. Choose Save and Close to save your unmanaged solution and any components that you 

added to it. 

9. When your customizations are complete, publish them: 

 To publish customizations for only the component that you’re currently editing, 

choose the entity you’ve been working on, and then choose Publish. 

Important  

 

https://msdn.microsoft.com/library/gg334576.aspx
https://msdn.microsoft.com/library/gg334576.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 To publish customizations for all unpublished components at one time, choose 

Entities, and then on the command bar, choose Publish All Customizations. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

See Also 

MSDN: Introduction to Solutions 

Create a managed solution 

Customizers and developers use solutions to author, package, and maintain units of software that 

extend the functionality of Microsoft Dynamics CRM. Solutions are distributed so that 

organizations can use Microsoft Dynamics CRM to install and uninstall the business functionality 

defined by the solution. A managed solution is a completed solution that is intended to be 

distributed and installed. An unmanaged solution is one that is still under development or is not 

intended to be distributed. 

Installing a solution or publishing customizations can interfere with normal system 

operation. We recommend that you schedule a solution import when it’s least disruptive 

to users. 

You create a managed solution by exporting an unmanaged solution as a managed solution. The 

organizations that use your managed solution will install it and any updates that you create for it.  

 

1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.   

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Solutions. (How do I get there?) 

 

3. On the Actions toolbar, click the New icon . 

4. Complete the required fields, and then on the File menu, click Save. 

By default, this saves an unmanaged solution. 

5. To add a new or existing component to your solution, in the Component Type list, select 

Note  

Note  

 

https://msdn.microsoft.com/library/gg334576.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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the type you want to add, and then click New or Add Existing. 

6. If you create a new component, fill in the required information, and then click Save or OK 

(depending on the type of component you are creating) to save the component. 

7. On the File menu, click Save and Close 

Your new unmanaged solution displays in the Solutions list. 

8. Choose the solution you want to export. 

 

9. Select the options you want in the Export wizard. When you get to the Package Type 

page, select Managed. 

10. Click Export. 

11. In the File Download dialog box, click Save, specify a location for the solution .zip or 

.cab file, and then click Save again. 

Note  

The regular scenario is for you to create a solution in a test Microsoft Dynamics 

CRM organization, export it, and then import it into a production Microsoft 

Dynamics CRM organization. If you want to import your managed solution into 

the same organization in which you created and exported it, you have to delete 

the unmanaged version and any components you created. You also have to 

delete child components, such as field relationships, that you created. 

You now have a managed solution that you can import into another Microsoft Dynamics CRM 

organization. 

See Also 

TechNet: Create, install, and update a managed solution 

Edit or view managed properties 

All solution components, except for plug-in assemblies, have an IsCustomizable managed 

property. This property appears in the interface with the label Can be customized. Managed 

properties only become effective after their associated components are installed as part of a 

managed solution. 

While an entity has managed properties in addition to IsCustomizable, the value or the 

IsCustomizable property, the type of entity, and the type of solution all have an impact on the 

behavior of an entity, as follows: 

 If the entity is part of a managed solution and the IsCustomizable managed property is set to 

False, you can’t edit any of the managed properties. 

 If the entity is part of a managed solution and the IsCustomizable managed property is set to 

True, you can edit the managed properties. 

 If the entity is part of the default solution or an unmanaged solution and it is a business entity, 

you can edit all managed properties except for IsCustomizable. 

 If the entity is part of the default solution or an unmanaged solution and it is a custom entity, 

you can edit all managed properties including IsCustomizable. 

https://technet.microsoft.com/library/gg309325.aspx
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1. Make sure that you have the System Administrator or System Customizer security role or 

equivalent permissions.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

 

2. Go to Settings > Customizations. (How do I get there?) 

 

3. Click Customize the System. 

4. Under Components, select the component and the record that you want to edit or view 

managed properties for. 

5. On the command bar, click Managed Properties. 

Note  

If Managed Properties doesn’t appear on the command bar, you can’t edit or 

view the managed properties for that component and record. 

6. In the Set Managed Properties dialog box, you can view all of the properties associated 

with the component, and you can edit selected properties based on the behaviors listed 

previously. 

7. Click Set to save the settings. 

See Also 

TechNet: Customization concepts 

Import a solution 

 

To learn how to import solutions, see TechNet: Use solutions for your customizations. 

Export your customizations as a solution 

If you want to export customizations you make to a Microsoft Dynamics CRM system, you export 

those customizations as a solution. For example, you might want to create a backup of all your 

customizations in case anything happens. To create a backup of your customizations, you export 

a special solution called the Default Solution. The Default Solution contains all the components in 

your system. 

You might also want to export a solution if you’re an ISV and you want to distribute CRM 

customizations as a package. 

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://technet.microsoft.com/library/dn531193.aspx
https://technet.microsoft.com/library/dn531198.aspx
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Export the Default Solution to create a backup 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. Click Customize the System. 

4. In the solution explorer, click Export Solution. 

 
 

5. When you’re prompted to open or save Default_1_0.zip, click Save. 

Some user information may be exported when exporting workflows, for example, the 

domain logon, the forms authentication user name, or the Microsoft account unique user 

identifier (PUID) value. 

Export a solution to create a custom package 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM.  

Check your security role 

 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=525636
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a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Solutions. (How do I get there?) 

3. In the list, select the solution you want to export, and then click Export. 

4. In the Publish Customizations step of the Export Solution wizard, you have the option 

to Publish All Customizations. Note that only published customizations are exported. 

When you’re ready to proceed, click Next.  

Note  

Installing a solution or publishing customizations can interfere with normal 

system operation. We recommend that you publish customizations when it’s least 

disruptive to users. 

5. If your solution contains any missing components that are required, you’ll see the 

Missing Required Components step. Disregard this warning only if you intend to import 

the solution as an unmanaged solution back into the original organization. Otherwise, 

follow the instructions in the dialog box to cancel the export, and then add the required 

components. More information: MSDN: Managed and unmanaged solutions. 

6. In the Export System Settings (Advanced) step, you can specify certain system 

settings to include in your solution. If your solution depends on any of the groups of 

system settings, select them, and then click Next. More information: TechNet: Settings 

options for solution export. 

7. In the Package Type step, specify whether to export the solution as an Unmanaged or 

Managed solution, and then click Next. 

Note  

Export a solution as a managed solution only when it’s complete and you’re 

ready to distribute it. After exporting a managed solution, you can’t import it back 

into the organization it was exported from; you can only import it into a different 

organization. More information: MSDN: Managed and unmanaged solutions. 

8. In the Source CRM Version step, select the CRM version you want to export to. For 

example, you might want to test a solution that you intend to distribute to organizations 

using an earlier version of CRM. Note that if you install Microsoft Dynamics CRM 2013 

Service Pack 1 (SP1) (version 6.1), and you specify version 6.0 as the target for your 

solution export, solution components dependent on features added in Microsoft 

Dynamics CRM 2013 Service Pack 1 (SP1) will be removed. More information: MSDN: 

Exporting a solution for a specific CRM version. 

9. Click Export to download the solution file. 

10. When prompted to open or save the compressed (.zip) file, click Save As. 

11. Specify a location to save your solution, and then click Save. 

Important  

http://go.microsoft.com/fwlink/p/?LinkId=525636
https://msdn.microsoft.com/library/gg334576.aspx
https://technet.microsoft.com/library/dn531198.aspx#BKMK_SettingsOptionsOnSolutionExport
https://technet.microsoft.com/library/dn531198.aspx#BKMK_SettingsOptionsOnSolutionExport
https://msdn.microsoft.com/library/gg334576.aspx
https://msdn.microsoft.com/library/dn689055.aspx
https://msdn.microsoft.com/library/dn689055.aspx
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 Don’t add files to a compressed (.zip) file that contains customizations and settings exported 

from Microsoft Dynamics CRM. CRM will attempt to import the first file in the compressed 

(.zip) file. If it’s not a valid file, the import will fail. 

 Some user information may be exported when exporting workflows, for example, the domain 

logon, the forms authentication user name, or the Microsoft account unique user identifier 

(PUID) value. 

Privacy notice 

You can import and export solutions to and from Microsoft Dynamics CRM Online. When you do 

so, the solutions, which may contain personal information, are transferred over a Secure Sockets 

Layer (SSL) connection between your computer and Microsoft servers. In turn, third-party code 

imported to CRM Online could eventually transmit Customer Data to an external system (i.e. 

InsideView) or configure/expand entities that get synchronized (i.e. exported) to other external 

systems that are controlled by a party other than Microsoft. 

If a solution to be imported is meant to transmit Customer Data outside of the security boundaries 

of CRM Online, Administrators are invited to verify the types of Customer Data that will be called 

by the service/software/application prior to uploading third-party code to their CRM Online 

instance. 

 Extraction of Customer Data by third party services/software/applications or solutions is 

controlled by the customer, not Microsoft. The final destiny and privacy policies applicable to the 

data points extracted by these external solutions are controlled by the Administrator; adequate 

review of the policies applicable by the third parties operating these services/software/apps is 

recommended. 

See Also 

MSDN: Introduction to solutions 

MSDN: Package and distribute extensions with solutions 

View or download developer resources 

This page is designed for developers who want to link to the Microsoft Dynamics CRM SDK, 

developer tools, or want to know the service endpoint URLs. 

Organization Unique Name 

You need the unique name for your organization when you interact with the Discovery Service.   

Windows Azure AppFabric Issuer Certificate 

This is the public certificate that is required to configure  Microsoft Azure Active Directory Access 

Control Service (ACS) for Microsoft Dynamics CRM integration. 

Developer Center 

The Microsoft Dynamics CRM Developer Center on MSDN contains a wealth of information to 

help developers. Here you will find the SDK, which includes documentation, samples, and tools, 

as well as technical articles, ramp-up kits, videos, blogs, forums, and more. For more information 

about using each item on the developer resources page, see MSDN: Download the endpoints 

using the Microsoft Dynamics CRM Developer resources page. 

https://msdn.microsoft.com/library/gg334576.aspx
https://msdn.microsoft.com/library/gg334530.aspx
http://www.crmdevelopercenter.com/
https://msdn.microsoft.com/library/gg309401.aspx
https://msdn.microsoft.com/library/gg309401.aspx
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Discovery Service 

This is a Web service that provides information about the organizations that are available on the 

Microsoft Dynamics CRM server using the SOAP protocol. This information includes the URL for 

each organization. 

Organization Service 

This is a Web service that provides access to the business data and metadata for your 

organization using the SOAP protocol.  

Organization Data Service 

An Open Data (OData protocol) Web service that provides access to the business data for your 

organization using a RESTful API. This link opens the Conceptual Schema Definition Language 

(CSDL) document, which describes how to access your data using this API. 

See Also 

MSDN: Write applications and server extensions 

MSDN: Write client application extensions 

Add or edit an image web resource 

Web resources are virtual files in multiple formats, such as html files, JavaScript, and Silverlight 

applications, that are stored in the Microsoft Dynamics CRM database and can be retrieved by 

using a unique URL address. 

 

1. Make sure you have the System Administrator security role or equivalent permissions in 

Microsoft Dynamics CRM. 

Check your security role 

a. Follow the steps in View your user profile. 

b. Don’t have the correct permissions? Contact your system administrator. 

 

2. Go to Settings > Customizations. (How do I get there?) 

3. Choose Customize the System. 

4. To create a new web resource, choose Components > Web Resources, and then on 

the Actions toolbar, choose New. 

5. Type or modify information in the text boxes. 

 The name entered in the Name text box, plus the file extension will become its file 

name. 

 The name entered in the Display Name text box will be displayed in the Display 

Name. 

 

https://msdn.microsoft.com/library/gg334357.aspx
https://msdn.microsoft.com/library/gg309637.aspx
http://go.microsoft.com/fwlink/p/?LinkId=525636
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 In the Type drop-down box, select the file type you want. 

6. Choose Browse to select and upload the file from your local machine.  

 To preview an uploaded image web resource: Choose Web Resource>Preview. 

 To edit a text web resource: Choose Text Editor. 

 To preview a text web resource: Choose Web Resource> Preview. 

7. When you’re ready to save your data, choose Save and Close. 

8. Publish your customization.   

  For only the edited component: Choose Save > Publish on the Home. 

  For all unpublished components at one time, choose Publish All Customizations. 

Publishing customizations can interfere with normal system operations. We recommend 

you publish customizations when it’s least disruptive to users. 

See Also 

TechNet: Create and edit web resources 

Training 

 

Training & Adoption Kit for Microsoft Dynamics CRM 

Microsoft Dynamics CRM User Guides 

Check out these online help resources 

Check out these online help resources 

Microsoft Dynamics CRM Help & Training provides a central location where you can find help and 

videos to get the most out of Microsoft Dynamics CRM. Check out the Help & Training site 

whenever you need information about doing sales, service, or marketing tasks in Microsoft 

Dynamics CRM.  

In addition to the Help & Training site, there are more resources to help you achieve your goals 

with Microsoft Dynamics CRM, no matter who you are, or what your role is: 
 

If you want to… Go here… 

Get info about planning and deploying 

Microsoft Dynamics CRM 

Deploying and Administering Microsoft 

Dynamics CRM 

Find everything you need to know to manage 

the system every day 

Administering CRM 2015 

Customize Microsoft Dynamics CRM to match Customize your CRM system 

Note  

https://technet.microsoft.com/library/dn660983.aspx
http://go.microsoft.com/fwlink/p/?LinkID=309289
https://technet.microsoft.com/library/hh699811.aspx
https://technet.microsoft.com/library/hh699811.aspx
https://technet.microsoft.com/library/dn531101.aspx
https://technet.microsoft.com/library/dn531158.aspx
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If you want to… Go here… 

your business needs 

Get info designed for people who administer 

Microsoft Dynamics CRM  

CRM Setup & Administration 

Get developer resources and see sample code CRM Developer Center 

 

Support and billing 

 

Product Support 

Support 

Contact Technical Support 

Find your CRM administrator or support person 

Non-profit pricing 

Volume licensing FAQ for Microsoft Dynamics CRM Online 

Billing and subscription support 

For partners -- Get the credit when your customers subscribe to CRM 

Troubleshoot sign-in problems 

Product Support 

Contact product support for technical issues or questions about how to use the product.  

For CRM Online 

You have to be an Office 365 administrator to contact technical support. If you aren’t an 

administrator, contact your local administrator. 

 Web support: Sign in to your work or school account and then download this guide to learn 

how to submit a web ticket.  

 Phone: 1-800-865-9408 in North America or find the number for your country/region. 

For CRM on-premises 

Microsoft Dynamics CRM Volume Licensing 

Microsoft Dynamics CRM sold through Microsoft Dynamics 

See Also 

Billing and subscription support 

http://www.crmitprocenter.com/
http://go.microsoft.com/fwlink/p/?LinkId=517249
http://go.microsoft.com/fwlink/p/?LinkId=616973
http://go.microsoft.com/fwlink/p/?LinkId=517251
http://go.microsoft.com/fwlink/p/?LinkId=517250
http://go.microsoft.com/fwlink/p/?LinkId=517248
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Troubleshoot sign-in problems 

TechNet: Check the status of your CRM Online and Office 365 services 

Office 365 Troubleshooter 

Support 

Support 

 
 

0fb5b855-1553-4711-97e9-3663caec0709  

Product Support 

For how-to questions or if you encounter 

technical issues or error messages, see this 

page: Product Support. 

cad9f05e-ac79-48c9-8ceb-f5c6364c1869  

Billing and subscription support 

For trial extensions, account activation, 

subscription issues, license adjustments, 

charges or credits, and questions about your 

service level agreement (SLA), see this page: 

Billing and subscription support.  

 

Contact Technical Support 

You have to be a Microsoft Dynamics CRM administrator to contact technical support. If you are 

not an administrator, contact your local administrator.  
 

For Microsoft Dynamics CRM Online, Microsoft 

Social Engagement, Microsoft Dynamics 

Marketing, and Parature, from Microsoft 

For on-premises CRM 

Web support (recommended): Sign in to your 

work or school account and then submit a 

web ticket. 

Phone: 1-800-865-9408 (North America) or 

Other countries/regions 

Important: You have to be a CRM administrator 

to contact technical support. If you are not an 

administrator, contact your local administrator.  

Learn more about working with Microsoft 

support for Dynamics CRM Online. 

Microsoft Dynamics CRM Volume Licensing 

Microsoft Dynamics CRM sold through 

Microsoft Dynamics 

 

 

For trial extensions, account activation, subscription issues, license adjustments, charges or 

https://technet.microsoft.com/library/mt210421.aspx
http://community.office365.com/en-us/p/troubleshooting
http://go.microsoft.com/fwlink/p/?LinkId=517249
http://go.microsoft.com/fwlink/p/?LinkId=517251
http://www.microsoft.com/download/details.aspx?id=40283
http://www.microsoft.com/download/details.aspx?id=40283
http://go.microsoft.com/fwlink/p/?LinkId=517250
http://go.microsoft.com/fwlink/p/?LinkId=517248
http://go.microsoft.com/fwlink/p/?LinkId=517248
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credits, and questions about your service level agreement (SLA) see, Billing and subscription 

support. 

Find your CRM administrator or support person 

You may occasionally run across issues that require consultation with your Microsoft Dynamics 

CRM administrator. If you don’t know who your administrator is, you can use the Advanced Find 

feature to find your administrator. 

 

1. Sign in to your CRM organization. 

2. Do one of the following: 

 In the latest version of Microsoft Dynamics CRM, on the global nav bar, choose the 

Advanced Find button .  

 In earlier versions of Microsoft Dynamics CRM, go to a work area (Sales, Service, or 

Marketing), and then choose Advanced Find on the command bar. 

 
 

3. On the Advanced Find page, in the Look for list, select Users. 

4. Point to Select, and then select Security Roles from the list. 

5. Under Fields, select Names. 

6. Enter System Administrator in the box that says Enter Text. At this point, your screen 

should look like this: 
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7. Choose the Results button on the ribbon. 

You should see a list of one or more system administrators. 

 

 

See Also 

Product Support 

Get Help from the Microsoft Dynamics CRM Community 

Non-profit pricing 

Your service relies on support from a variety of contributors and you need to make the most of 

donations and time. Microsoft Dynamics CRM Online is a cost-effective solution that’s easy to 

customize and use. Qualified non-profit organizations can obtain a Microsoft Dynamics CRM 

Online license at non-profit pricing.  

Non-profit pricing for Microsoft Dynamics CRM Online 

As a non-profit organization, you may be entitled to Microsoft Dynamics CRM Online non-profit 

pricing. In order for Microsoft to validate and approve your organization as non-profit, please 

follow the guidelines outlined here. 

1. Please review the non-profit guidelines in advance and make sure your organization meets 

the criteria. 

2. Start a FREE CRM Online trial. 

3. Once your trial commences, please contact the Billing Support Team to provide them with the 

required information to validate you as a non-profit organization. 

4. During your 30-day free trial, your company will be reviewed to see if it can be validated as a 

non-profit organization. Microsoft may contact your organization during your trial for further 

information. 

http://go.microsoft.com/fwlink/p/?LinkID=511675
http://go.microsoft.com/fwlink/p/?LinkId=526504
https://portal.microsoftonline.com/Signup/MainSignUp15.aspx?OfferId=E070C229-C45D-433d-874A-6B5B3C54B291&dl=CRMSTANDARD&ali=1&alo=1&lc=1033
http://go.microsoft.com/fwlink/p/?LinkId=390611
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5. You will need to provide the following information when you contact Billing support: 

 Company, domain, and contact name. 

 Address including city, state, zip code, and country/region. 

 Phone number and email address. 

6. After your organization has been validated, Microsoft will inform you by email and you can 

convert your trial to a paid subscription. 

7. Microsoft Dynamics CRM Online non-profit pricing is available only in Australia, Canada, 

Germany, Hong Kong SAR, India, Japan, Korea, Malaysia, New Zealand, Singapore, United 

Kingdom and United States Any customers outside of these countries/regions need to work 

through a local Microsoft representative for specific pricing. 

See Also 

Billing and subscription support 

Volume licensing FAQ for Microsoft Dynamics CRM Online 

. 

 

Do you offer volume discounts to businesses? 

Yes. Discounts are available for Microsoft Dynamics enterprise agreement customers (typically 

250+ licenses) who want to purchase through volume licensing. A Microsoft expert can help you 

explore the purchasing options for large enterprises and help you determine which is best for you. 

More information: Enterprise Agreements 

Which volume licensing programs apply to Microsoft Dynamics CRM Online? 

Microsoft Dynamics CRM Online is available through the Enterprise Agreement, Enterprise 

Subscription Agreement, and Campus and School Agreement volume licensing programs. The 

agreement you select will be on the same billing and contract schedule as any existing volume 

licensing agreements that you might have.  

Can I move existing licenses from a direct purchase subscription to an enterprise 
agreement? 

Yes. If you who purchased Microsoft Dynamics CRM Online with a credit card or through 

invoicing, you can move to an enterprise agreement by following these steps: 

1. Place an order through a Microsoft Licensing Solutions Partner for Microsoft Dynamics CRM 

Online licenses. 

It is important to order (at minimum) the same number of licenses and add-ons that 

you currently have to ensure that you do not lose data. For example, if you have 50 

Important  

http://go.microsoft.com/fwlink/p/?LinkId=390598
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Professional licenses, 3 additional production instances, and 5 GB of storage, be 

sure to order the same number of licenses and add-ons (or more). 

2. Once the order has been invoiced, the Online Service Manager (OSM) identified on the 

enterprise agreement will receive an activation email, which allows the OSM to sign in to the 

existing CRM Online account and associate the new licenses to it. The new order will pool 

with your existing licenses, but does not cancel the direct purchase subscription. 

If the purchase was made on an enterprise agreement that already includes Microsoft 

Online Services licenses, for example Microsoft Office 365 or Intune, then the CRM 

Online licenses will automatically attach to that Microsoft Online Services account 

and cannot be associated to your existing CRM Online account. If the licenses need 

to be separated, this requires a special amendment from your Microsoft Licensing 

Sales Specialist. 

3. To cancel the direct purchase subscription, open a Service Request through the Admin Portal 

to contact Billing Support and inform them that you have purchased a license through volume 

licensing and request them to cancel the direct purchase subscription. This step is required in 

order to discontinue the credit card or invoice billing. 

How can I have the activation email resent? 

The activation email is sent to the Online Services Manager (OSM), who is a participant identified 

on the enterprise agreement. If the activation email needs to be resent, call Billing Support to 

make the request. Please be prepared to provide company information to verify personally 

identifiable information (PII). 

The activation email can only be resent to the OSM. If the OSM is unavailable and the 

email needs to be sent to a different contact, please contact your Microsoft Licensing 

Solutions Partner to request that the OSM information be changed. Once the information 

is changed, you will need to make a new request to Billing Support to resend the 

activation email to the new OSM. 

How do I add more licenses or add-ons, such as additional instances or storage when I 
have purchased through volume licensing? 

Microsoft Dynamics CRM Online customers that purchased their subscription through volume 

licensing have two options to add more licenses or purchase add-ons: 

 Add them through the Volume Licensing Service Center using the License Reservation 

feature, which allows you to immediately add licenses or add-ons and then pay for them at 

the agreement anniversary time as a True-Up. Licenses are accessible within hours. 

 Place an order through the standard Purchase Order process through the Microsoft Licensing 

Solutions Partner. Licenses are accessible in up to 12 hours after the order is processed by 

Microsoft. 

Note  

Warning  

http://go.microsoft.com/fwlink/p/?LinkId=390611
http://go.microsoft.com/fwlink/p/?LinkId=390611
http://go.microsoft.com/fwlink/p/?LinkId=390612
http://go.microsoft.com/fwlink/p/?LinkId=390598
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If I accidentally attach the volume licensing licenses by signing in to the wrong account, 
how can I move the licenses to the correct account? 

To reassign the account to which your volume licensing agreement licenses are attached, contact 

Billing Support and request to have your agreement remapped to a new account. 

The licenses cannot be remapped to a different account if you already own Microsoft 

Online Services licenses (Office 365 or Intune) on the same agreement, because all 

Microsoft Online Services licenses are attached to the same account. 

Where do I find support for my CRM Online volume licensing invoice? 

For assistance with a volume licensing invoice, contact your Microsoft Licensing Solutions 

Partner. 

See Also 

Enterprise Agreements 

Frequently Asked Questions About Product Licensing 

CRM Online Fall '13 FAQs 

Billing and subscription support 

 

 

verticaltabbed 

450 

Hot topics 

Billing FAQs for CRM Online 

Platform transitions for CRM Online 

 Microsoft Online service portal how-to tasks 

Microsoft Commerce transaction platform how-to tasks 

CRM on-premises 

Your support options depend on how you purchased Microsoft Dynamics CRM (on-premises): 

 If you purchased through volume licensing, see  Volume licensing. 

 If you purchased through Microsoft Dynamics, see  Microsoft Dynamics. 

CRM Online 

For billing support for Microsoft Dynamics CRM Online: 

 Find your local Microsoft Dynamics CRM Online   billing support number. 

 Or, sign in to your work or school account and submit a web ticket.  

Note  

http://go.microsoft.com/fwlink/p/?LinkId=390611
http://go.microsoft.com/fwlink/p/?LinkId=390598
http://go.microsoft.com/fwlink/p/?LinkId=390610
http://go.microsoft.com/fwlink/p/?LinkId=396469
http://go.microsoft.com/fwlink/p/?LinkId=397880
http://go.microsoft.com/fwlink/p/?LinkId=397881
http://go.microsoft.com/fwlink/p/?LinkId=396468
http://go.microsoft.com/fwlink/p/?LinkId=396467
http://go.microsoft.com/fwlink/p/?LinkID=278814
http://go.microsoft.com/fwlink/p/?LinkId=396466
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If you still have to transition from CTP to the Microsoft Online Services environment, 

visit the Transition Center. 

 Social Engagement  

For billing support for Microsoft Social Engagement: 

 Find your local Microsoft Dynamics CRM Online   billing support number. 

 Or, sign in to your work or school account and submit a web ticket.  

Microsoft Dynamics Marketing  

For billing support for Microsoft Dynamics Marketing: 

 Find your local Microsoft Dynamics CRM Online   billing support number. 

 Or, sign in to your work or school account and submit a web ticket.  

Parature, from Microsoft  

For billing support for Microsoft Dynamics Marketing: 

 Find your local Microsoft Dynamics CRM Online   billing support number. 

 Or, sign in to your work or school account and submit a web ticket.  

Product support  

If you have questions on how to use or technical issues using Microsoft Dynamics CRM, 

Microsoft Social Engagement, or Microsoft Dynamics Marketing, see: Product Support.  

 

 

 

 
 

 

Community forum 

 

Support blog  

 

Contact technical support 

 

Billing FAQs for CRM Online 

Billing support agents for Microsoft Dynamics CRM often hear similar questions from our 

customers. To help answer your billing and subscription management questions as quickly as 

possible, we’ve put together this list of the most frequently asked questions. 

Note  

http://go.microsoft.com/fwlink/p/?LinkID=396399
http://go.microsoft.com/fwlink/p/?LinkID=278814
http://go.microsoft.com/fwlink/p/?LinkId=396466
http://go.microsoft.com/fwlink/p/?LinkID=278814
http://go.microsoft.com/fwlink/p/?LinkId=396466
http://go.microsoft.com/fwlink/p/?LinkID=278814
http://go.microsoft.com/fwlink/p/?LinkId=396466
http://go.microsoft.com/fwlink/p/?LinkId=396462
http://go.microsoft.com/fwlink/p/?LinkId=396463
http://go.microsoft.com/fwlink/p/?LinkId=396589
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How do I find the correct CRM Online billing and subscription support 
team? 

Before contacting Microsoft Dynamics CRM Online services billing support, you’ll need to 

determine which platform your CRM Online account is hosted on because each platform has its 

own billing and subscription management support team. The simplest way to do this is to match 

your CRM Online account sign-in to one of the formats listed here: 

Microsoft online services platform 

If you sign in to your CRM Online account with a user name that follows this format, 

email@contoso.onmicrosoft.com, you’re on the Microsoft Online Services environment. To find a 

contact in billing and subscription support, you can: 

 Find your local CRM Online  billing support number. 

 Or, submit a billing support query. 

Microsoft commerce transaction platform 

If you sign in to your CRM Online account with a user name that follows this format, 

email@live.com, you’re on the Microsoft commerce transaction platform. To find a contact in 

billing and subscription support, you can submit a query to CRMAOC@microsoft.com. 

What billing activities do I need to contact CRM Online Billing Support to 
manage? 

The instructions in this section apply equally to subscriptions purchased for Microsoft Dynamics 

CRM Online, Microsoft Dynamics Marketing, Microsoft Social Engagement, Parature, from 

Microsoftas well as Microsoft Office 365.  

You can resolve many billing-related issues by yourself, but there are some requests that only 

billing support can resolve. Please refer to the CRM Online tab on the Billing and subscription 

support page if you want to do any of the following:   

1. Make a change to billing frequency. 

2. Make a change to payment method, that is, change from invoicing to credit card payments 

outside of subscription renewal. If you want to change your payment method during 

subscription renewal, see the next question for more information.  

3. Reactivate an expired account. 

4. Cancel a subscription or reduce the number of seats on a subscription. This can also be 

managed in the Office 365 admin portal, without having to contact Support. 

5. Dispute a charge or clarify a subscription discrepancy. 

6. Request a service level agreement (SLA) billing credit. 

7. Correct or change a Partner of Record attachment. This can also now be self-managed 

through the Office 365 admin portal. 

http://go.microsoft.com/fwlink/p/?LinkID=278814
http://go.microsoft.com/fwlink/p/?LinkId=396466
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When I renew my subscription, can I change my payment method? 

During subscription renewal, you can move from credit card to invoice payment, but not from 

invoice to credit card. Please refer to the CRM Online tab on the Billing and subscription support 

page if you wish to change from invoice to credit card payments at subscription renewal time. 

How do I purchase CRM Online through Volume Licensing? 

If you're interested in placing an order for Microsoft Dynamics CRM Online through Volume 

Licensing, you can find more information on what the best option is for you by reviewing How 

Volume Licensing Works.  For detailed information, see Purchase Microsoft Dynamics CRM 

through Volume Licensing. 

How do I extend my CRM Online trial? 

You can now extend your free trial on a self-serve extension on the Admin portal for a one-time 

extension of 30 days. Alternatively, you can submit a service request via the portal or call the 

Billing Support toll free numbers. Please note that for self-serve extensions you’re required to 

enter your credit card information, but your credit card won’t be charged for trial extensions. 

How do I migrate from CRM Online to the on-premises version of CRM? 

If your organization is considering changing from Microsoft Dynamics CRM Online to the on-

premises (server-based) version of Microsoft Dynamics CRM, you will need to work with 

Technical support. 

How do I cancel my CRM Online subscription? 

The instructions in this section apply to subscriptions made through Microsoft Dynamics CRM 

Online as well as through Microsoft Office 365. 

You’ll need to contact billing support to cancel your subscription. To contact billing support, 

please refer to the CRM Online tab on the Billing and subscription support page. 

Before you call, have the following information ready: 

1. Billing administrator’s Microsoft account and password. 

2. Organization URL and name. 

3. The day that you want your subscription to CRM Online terminated. 

You should have also made the following decisions: 

1. Do you want to keep your existing data? If so, you can export it to Microsoft Office Excel. For 

more information, see Export Data to Excel. 

2. Do you want to keep any Internet Marketing service campaigns running? If you’re not the 

person who signed up for the marketing service, you must work with that person to cancel or 

maintain it. 

In addition, you can now do a self-serve cancellation of your subscription form the Admin 

portal. 

http://www.microsoft.com/licensing/online-services/how-to-buy.aspx
http://www.microsoft.com/licensing/online-services/how-to-buy.aspx
https://portal.office.com/default.aspx
http://go.microsoft.com/fwlink/p/?LinkId=526506
http://go.microsoft.com/fwlink/p/?LinkID=324008
https://portal.office.com/default.aspx
https://portal.office.com/default.aspx
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If you cancel today, this subscription will remain active until the end of the billing cycle. 

How do I reactivate my expired CRM Online account? 

The instructions in this section apply to subscriptions made through Microsoft Dynamics CRM 

Online as well as through Microsoft Office 365. 

To reactivate an expired Microsoft Dynamics CRM Online account, you’ll need to contact billing 

and subscription support. Please refer to the CRM Online tab on the Billing and subscription 

support page. 

If you saved your data to a Microsoft Office Excel workbook before canceling your CRM Online 

account, you should be able to import the saved data. 

How do I apply for a credit due to a CRM Online service outage? 

The instructions in this section are common for subscriptions made through Microsoft Dynamics 

CRM Online as well as through Microsoft Office 365.  

You may be eligible for a billing credit if your online service level falls below 99.9% availability. 

For complete details, including a critical list of exclusions, see the Microsoft Dynamics CRM  

Service Level Agreement. 

Submit a claim by contacting Billing and subscription support. To contact billing support, please 

refer to the  CRM Online tab on the Billing and subscription support page. 

How do I apply for non-profit pricing? 

Please refer to the Non-profit pricing page for more information on how to apply. 

How to change the Bill to country/region 

You need to create a new tenant and the desired bill-to-country/region and purchase the desired 

offer on the new tenant. You’ll have to manually export data from the old tenant and import into 

the new tenant. Finally, you’ll contact Billing Support to cancel your subscription. To contact 

billing support, please refer to the CRM Online tab on the Billing and subscription support page. If 

you require assistance with migrating the data, contact Technical support. 

I'm a CRM Online customer and I have learned there is a minimum of 5 
Professional users that I need to purchase. What if I only require 3 
Professional users? 

That is correct. Microsoft Dynamics CRM Online customers need to buy a minimum of 5 paid 

Professional users. The Microsoft Online Services environment enforces this for new customers. 

See Also 

Billing and subscription support 

Important  

http://go.microsoft.com/fwlink/p/?LinkID=272903
http://go.microsoft.com/fwlink/p/?LinkId=526506
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Non-profit pricing 

Find your CRM administrator or support person 

For partners -- Get the credit when your customers subscribe to 
CRM 

As a Microsoft Dynamics CRM partner, you can help your customer sign up for a Microsoft 

Dynamics CRM Online subscription. You can customize and set up their organization for them, 

and reduce their effort to get started. After signing up, you can designate your company as the 

customer’s partner of record. As the partner of record, you can help to ensure that your customer 

has a great trial experience and start them down the path toward success with Microsoft 

Dynamics CRM. 

This document describes in detail the tasks you must complete to sign up for Microsoft Dynamics 

CRM on behalf of your customer. It also describes the tasks a customer must do to remove your 

administrative privileges from the customer's company to ensure that they won’t be charged for 

your access after the trial is complete. 

Sign up for a free trial subscription 

Using a Microsoft account, which can be your ID or your customer’s, sign up for a free trial of 

Microsoft Dynamics CRM. The free 30-day trial subscription includes 20 user licenses and 5 

gigabytes (GB) of storage. You can activate your customer’s trial subscription as a paying 

subscription at any time during the first 30 days. If you sign up for the trial subscription using your 

customer's Microsoft account, you won't need to worry about transferring ownership of the 

account later on. 

When signing up for the free trial, note the following: 

Make sure to select the correct country/region for your customer. The country/region is important 

for setting up your customer's billing.  

If the customer doesn’t have a billing address in the country/region you select, their account 

can’t be activated later. 

When you accept the terms of service, youre accepting it on behalf of your customer and 

representing their agreement to our terms. 

1. Go to Microsoft Dynamics CRM. 

  

– OR -  

If you received an email with the customer’s invitation, click the link.  

2. Click Take the TestDrive and then fill in the information to start a TestDrive. 

Important  

 

http://go.microsoft.com/fwlink/p/?LinkId=204374
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Soon after you complete the sign up, you’ll be notified by email that the Microsoft Dynamics CRM 

trial subscription is ready. You’ll also receive email messages that provide help for new 

organizations during the first 30 days of their subscription. Forward these email messages to your 

customer. 

Designate yourself as the partner of record 

After completing the trial sign up, designate your company as the partner of record who is 

responsible for the customer. As the partner of record, you can help Microsoft provide our 

partners and customers with the best service and support. After the trial subscription becomes a 

paid subscription, your partner company can also claim the CRM Software Advisor (CSA) fee for 

the subscription. For information about the CSA fee program, visit the Microsoft Partner Network 

site, where you can download the Microsoft Dynamics CRM Software Advisor Operations Guide 

and FAQ, which provides detailed instructions for the fee claim process.  

If your customer has already signed up for a Microsoft Dynamics CRM Online subscription, or 

prefers to sign up for the trial subscription themselves, they can still designate your company as 

the partner of record. 

1. Go to the Partner of Record Designation page in CustomerSource. 

2. Sign in with the same Microsoft account  that you used to sign up for the trial 

subscription. 

If this Microsoft account  is associated with more than one Microsoft Dynamics CRM 

Online subscription, select your customer’s organization. 

3. Search for your partner company’s account, and then select Microsoft Dynamics CRM 

as the product line from the drop-down list. 

Tip  

You can search for your partner company by company name, phone number, or 

their 10-digit partner MBS authorization number. 

4. Select your company from the search results, and then click Associate.  

Transfer ownership after completing the trial 

After the trial period is complete and your customer is ready to start their subscription, there are a 

few steps you need to complete in order to transfer ownership of the Microsoft Dynamics CRM 

instance. If you signed up for the Microsoft Dynamics CRM Online subscription on behalf of the 

customer by using a Microsoft account other than your customer’s, call Microsoft Dynamics CRM 

Customer Service and Support to request a transfer of ownership of the subscription to your 

customer and designate him or her as the billing administrator of the customer’s Microsoft 

Dynamics CRM organization. The billing administrator can take actions that have financial 

implications to the Microsoft Dynamics CRM Online subscription, such as: 

 Upgrading to a different subscription 

 

http://go.microsoft.com/fwlink/p/?LinkId=532917
http://go.microsoft.com/fwlink/p/?LinkId=204192
http://go.microsoft.com/fwlink/p/?LinkId=204192
http://go.microsoft.com/fwlink/p/?LinkId=204179
http://go.microsoft.com/fwlink/p/?LinkId=204189
http://go.microsoft.com/fwlink/p/?LinkId=204189
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 Upgrading to a different release 

 Purchasing additional licenses 

 Purchasing additional storage 

If you used a Microsoft account that belongs to someone in your customer’s 

organization, or that can be transferred to your customer, skip this task. Give the 

email address and its password to your customer.  

To transfer the ownership of the Microsoft Dynamics CRM trial subscription, you’ll need the 

following: 

 The email address of the person from your customer’s organization who will act as a system 

administrator and the billing administrator for the subscription. 

Each organization must have a billing administrator. 

 The Microsoft account that was used to sign up for the subscription. 

 The name of the company used to create the trial subscription. 

You’ll need this name to identify your customer's company if there is more than one account 

registered at the Microsoft Billing and Account Management site. 

 If the free trial subscription has already been activated to a paying subscription, you’ll also 

need the credit card number used to pay for the subscription. 

1. Sign in to Microsoft Dynamics CRM using the Microsoft account that you used to sign up 

for the trial. 

2. Follow the steps in TechNet: Create users and assign Microsoft Dynamics CRM Online 

security roles to create a user and assign the system administrator security role. This 

user will also function as the billing administrator. 

3. Make sure the new billing administrator has successfully signed in to your organization 

before transferring ownership. 

1. Go to the Microsoft Billing and Account Management site. 

2. Sign in with the same Microsoft account that you used to sign up your customer for the 

trial subscription. 

3. Under Billing account overview, select the company account where you want to add a 

delegate. 

4. Click View or add account delegates. 

5. On the Manage account delegates page:  

a. Click Add an account delegate. 

b. Enter the Microsoft account of the new billing administrator. 

Tip  

Important  

Add a system administrator 

Add an account delegate 

http://go.microsoft.com/fwlink/p/?LinkId=204182
https://technet.microsoft.com/library/jj191623.aspx
https://technet.microsoft.com/library/jj191623.aspx
http://go.microsoft.com/fwlink/p/?LinkId=204182
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c. Click Add delegate. 

1. Contact Microsoft Dynamics CRM Customer Service and Support. 

2. Give the customer service representative the Microsoft account that was used to sign up 

for the subscription and the account ID number. 

3. Give the customer service representative the Microsoft account of the new billing 

administrator. 

4. Ask the customer service representative to promote the new billing administrator to initial 

user, and primary administrator. 

Important  

Make sure that the new billing administrator has accepted the invitation to 

become a system administrator. The Microsoft account that was used to sign up 

for the trial subscription will be demoted to an account delegate. 

Remove the partner's administrative privileges 

These tasks are optional. After you sign up your customer and register yourself as the partner of 

record, you will have access to your customer's subscription and billing account for the 

subscription. The following tasks are performed by the customer. 

If you or your customer do not remove your privileges, the customer will be charged the 

standard monthly user fee for your access. 

If your customer wants to remove your access to the billing account for the subscription, they 

must complete the following steps: 

1. Go to the Microsoft Billing and Account Management site. 

2. Sign in with the Microsoft account you use for the billing administrator at your company. 

3. If the service name displayed under Billing account overview is not Microsoft Dynamics 

CRM, select the account from the menu that corresponds to the Microsoft Dynamics 

CRM Online subscription. 

4. Click View or add account delegates. 

5. Next to the names of account delegates you want to remove, click Remove. 

6. In the next window, click Yes to confirm the removal. 

Important  

We strongly recommend that at least two people in the organization have access 

to the Billing and Account Management site. To add someone, click Add an 

account delegate, and then follow the online instructions. 

Request an ownership transfer 

Important  

Remove partner access to the billing account 

http://go.microsoft.com/fwlink/p/?LinkId=204189
http://go.microsoft.com/fwlink/p/?LinkId=204182
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Tip  

To verify that the information on the personal information page is correct, click 

Go to Account Information. 

If your customer wants to disable your access to the subscription, they must complete the 

following steps in Microsoft Dynamics CRM: 

1. Sign in to the Microsoft Dynamics CRM Online subscription with the Microsoft account 

you use for the billing administrator at your company. 

2. Follow the steps in Create users and assign Microsoft Dynamics CRM Online security 

roles to disable the user from the partner company. 

 

Troubleshoot sign-in problems 

Having trouble signing in to Microsoft Dynamics CRM Online or another CRM Online service, 

such as Microsoft Dynamics Marketing or Microsoft Social Engagement? Here’s what you need to 

know about passwords, signing in, and common error messages. 

If you’re an administrator, make sure to check the Service Health Dashboard for 

maintenance issues.  

Password issues 

 

If you’re an administrator 

If you forget your administrator password, you can reset it by going to the sign-in page, and 

choosing Can’t access your account? at the bottom of the page. 

 
 

Disable partner access to the Microsoft Dynamics CRM Online subscription 

Important  

http://go.microsoft.com/fwlink/p/?LinkID=321112
http://go.microsoft.com/fwlink/p/?LinkID=321112
https://portal.office.com/ServiceStatus/ServiceStatus.aspx
https://portal.office.com/
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To enable your users to be able to reset their passwords themselves, you’ll need to 

purchase an Azure Active Directory subscription and configure it for password self-

service. More information: Self-service password reset in Azure AD: how to enable, 

configure, and test self-service password reset 

To reset user passwords, you use the Office 365 admin center. More information: Reset a user's 

password 

If you’re not an administrator 

If you’re not an administrator, and you forgot your password, you’ll need to contact your 

administrator and ask for a password reset. Once your administrator resets your password, you’ll 

receive an email with instructions on how to sign in and enter a new password. More information: 

Find your CRM administrator or support person 

Signing in 

 

If you’re an administrator 

You can sign in by going to the Office 365 admin center at: https://portal.office.com. In the Office 

365 admin center, you can sign in to all the online services associated with your account. You 

can also check service health, manage users, manage licenses, and more. More information: 

About the Office 365 admin center  

If you’re not an administrator 

You can sign in directly to CRM Online, Microsoft Social Engagement, or Microsoft Dynamics 

Marketing. You can also sign in at https:/portal.office.com.  

Sign in directly to CRM Online 

Your CRM administrator provides the direct CRM Online URL in an email invitation. This URL will 

be in the following format:  https://<yourorganization>.crm.dynamics.com. For example, enter 

https://contoso.crm.dynamics.com. If you can’t find the email that contains the URL, contact your 

CRM administrator. More information: Find your CRM administrator or support person 

If you’re in a region other than North America, substitute “crm” in the URL with:  

 .crm2 for South America (LATAM/SAM) 

 .crm4 for Europe, Middle East, Africa (EMEA) 

 .crm5 for Asia Pacific (APAC) 

 .crm6 for Oceania (OCE) 

 .crm7 for Japan (JPN) 

 .crm9 for United States of America Government 

Tip  

Note  

https://msdn.microsoft.com/library/azure/dn683881.aspx
https://msdn.microsoft.com/library/azure/dn683881.aspx
https://support.office.com/article/Reset-a-users-password-7a5d073b-7fae-4aa5-8f96-9ecd041aba9c
https://support.office.com/article/Reset-a-users-password-7a5d073b-7fae-4aa5-8f96-9ecd041aba9c
http://go.microsoft.com/fwlink/p/?LinkID=404045
http://go.microsoft.com/fwlink/p/?LinkID=532687
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After entering your URL, you’ll be prompted for your user name. Your user name will be in one of 

the following formats: 

 username@contoso.onmicrosoft.com (standard Office 365 domain) 

 username@contoso.com (custom domain) 

 

 

What if I’m still using a Microsoft account to sign in to CRM Online? 

Use the email address provided by your CRM administrator (sent in an email invitation). Verify 

that you’re using the same Microsoft account email address that the email invitation was sent to. 

Note that you can’t sign in to Microsoft Social Engagement or Microsoft Dynamics Marketing with 

a Microsoft account. Troubleshoot problems with your Microsoft account user name or password. 

Sign in directly to Microsoft Social Engagement 

Your administrator provides the direct URL for Microsoft Social Engagement in an email 

invitation. This URL will be in the following format: https://listening.microsoft.com/app/<appID>/. If 

you can’t find the URL, contact your administrator. 

After entering your URL, you’ll be prompted for your user name. Your user name will be in one of 

the following formats: 

 username@contoso.onmicrosoft.com (standard Office 365 domain) 

 username@contoso.com (custom domain) 

Sign in directly to Microsoft Dynamics Marketing 

Use the following direct URL for Microsoft Dynamics Marketing: 

https://<yourorganization>.marketing.dynamics.com. Please contact your administrator if you 

have trouble signing in.  

After entering your URL, you’ll be prompted for your user name. Your user name will be in one of 

the following formats: 

 username@contoso.onmicrosoft.com (standard Office 365 domain) 

 username@contoso.com (custom domain) 

Sign in at https://portal.office.com 

You can also sign in to https://portal.office.com. What you see depends on what user account 

licenses you have. 

In the following table, X indicates that the user has a license for that service. 
 

   User 

Licenses 

   

CRM Online X X X X   

Office 365 X X   X  

http://go.microsoft.com/fwlink/p/?LinkId=225672
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   User 

Licenses 

   

Enterprise Plan 

Microsoft Social 

Engagement or 

Dynamics 

Marketing 

X  X  X X 

Page that 

opens if you 

have this 

combination 

of licenses: 

Get 

started 

with Office 

365 page 

for 30 

days, then 

Outlook on 

the web 

Get 

started 

with Office 

365 page 

for 30 

days, then 

Outlook on 

the web 

CRM 

Online 

CRM 

Online 

Get 

started 

with Office 

365 page 

for 30 

days, then 

Outlook on 

the web 

Microsoft 

Social 

Engagement or 

Dynamics 

Marketing 

 

 

 

For example: 

 Users with only a CRM Online license will sign in to CRM Online. 

 Users with an Office 365 license and any other service license will see the “Get started with 

Office 365” page for 30 days, and then Outlook on the web after 30 days. 

 Users licensed for Microsoft Social Engagement or Microsoft Dynamics Marketing will sign in 

to CRM Online if they have a CRM Online license and no Office 365 license. 

Note: In Outlook on the web, you can use the Office 365 app launcher to open CRM Online. 
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Common error messages 

I receive this license error: “The selected user or the user trying to log on has not been 
assigned a security role, and does not have sufficient privileges for this action” 

This error must be fixed by someone that has permissions to add security roles to users in 

Microsoft Dynamics CRM, such as your system administrator. To learn how to add security roles, 

see TechNet: Manage users. 

When I try to sign in, Internet Explorer continues to redirect to another web page and gets 
into a loop until I choose the Internet Explorer window. 

To avoid this error, add the URLs used for Microsoft Dynamics CRM to trusted sites in Internet 

Explorer:  

1. In Internet Explorer, on the Tools menu, select Internet Options. 

2. On the Security tab, in the Select a zone to view or change security settings section, 

click or tap Trusted sites. 

3. Click or tap Sites. 

4. In the Trusted sites dialog box, type the following URLs in the Add this website to the 

zone text box:  

 http://*.dynamics.com  

 http://*.live.com  

After you add each URL, click or tap the Add button. 

5. If you receive a dialog box that states Sites added to this zone must use the https:// 

prefix, clear the Require server verification (https:) for all sites in this zone check box. 

6. Click or tap Close, and then click or tap OK. 

Why do I have to sign in again? Can I change the amount of time I'm signed in? 

Microsoft Dynamics CRM keeps you signed in for 8 hours. When you've been signed in for 7 

hours and 40 minutes, a message will appear warning that your session is about to expire, and 

you then have 20 minutes to respond. Click or tap OK, sign in again, and then click the back 

button on your browser to return to the area of CRM in which you were working. You can’t change 

the amount of time you’re signed in. 

See Also 

Service Health Dashboard 

TechNet: Get started administering Microsoft Dynamics CRM Online 

Product Support 

 

https://technet.microsoft.com/library/dn531106.aspx
https://portal.office.com/ServiceStatus/ServiceStatus.aspx
https://technet.microsoft.com/library/jj191622.aspx

